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ChartingCharting
This section describes the capabilities provided by Charts.

 

Topics in this section:

Chart Designer
Chart Wizard
Highlighting and Selection Chart Elements
Zoom a Chart
Scroll a Chart
Rotate a Chart



Chart DesignerChart Designer
Use the Chart Designer dialog to quickly and easily customize a chart, or create a new one.

The Chart Designer is organized into three main areas, which are represented below.



Chart Elements Tree
The Chart Elements Tree allows you to quickly select chart elements, change the structure of a chart (add or delete elements and
change their visibility) and also represent chart structure. When you locate an element in the tree, it is highlighted in the central
area. If you click the element, then its settings will be displayed in the Customization Tabs area.

Chart Control Appearance
The Chart Control Appearance area allows you to see how the chart looks. Moreover, it allows you to select an item, whose
settings will be displayed in the Customization Tabs area.



Customization Tabs
The Customization Tabs area allows you to customize chart element settings. Settings are separated by three tabs.

The Options Tab contains commonly used element settings.

The Properties Tab contains all settings of a chart element.



The Data Tab contains settings, which allow you to specify data source members used to plot series or other data settings
of a chart element (for example, the series points values if the series is not assigned with data).
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For several chart elements, the Customization Tabs area may not contain all tabs from the Tabs list represented above.



Chart WizardChart Wizard
Use the chart wizard dialog to quickly and easily create a new chart, or modify an existing one.

The Chart Wizard contains the following pages.

Construction group

Chart Type Page
Appearance Page
Series Page
Data Page

Presentation group

Chart Page
Diagram Page
Panes Page
Axes Page
Series Views Page
Point Labels Page
Chart Titles Page
Legend Page
Annotations Page



To navigate through the Chart Wizard's pages, use the navigation bar or the  and  buttons.

To complete the chart, use the  button, or the  button, to cancel all changes.

Use the "Display a wizard every time a new chart is added" option to specify whether or not a chart wizard should appear when
you add a new chart to the windows form.



Chart Type PageChart Type Page
Tasks

Choose a chart type.

Page Elements

Chart type selector

Contains icons representing chart types. Click an icon to choose the appropriate chart type.

Chart type filter

Filters chart types available in the Chart type selector. The following chart filters are available:

All Chart Types.
Bar Series (Bar, Stacked Bar, 100% Stacked Bar, Side-By-Side Stacked Bar, 100% Side-By-Side Stacked Bar, 3D Bar, 3D
Stacked Bar, 3D 100% Stacked Bar, 3D Side-By-Side Stacked Bar, 3D 100% Side-By-Side Stacked Bar and Manhattan Bar).
Point and Line Series (Point, Bubble, Line, Stacked Line, 100% Stacked Line, Step Line, Spline, Scatter Line, Swift Plot, 3D
Line, 3D Stacked Line, 3D 100% Stacked Line, 3D Step Line and 3D Spline).
Pie Series (Pie, Doughnut, 3D Pie and 3D Doughnut).
Funnel Series (Funnel and 3D Funnel).
Area Series (Area, Stacked Area, 100% Stacked Area, Step Area, Spline Area, Spline Area Stacked, 100% Stacked Spline
Area, 3D Area, 3D Stacked Area, 3D 100% Stacked Area, 3D Step Area, 3D Spline Area, 3D Spline Stacked Area and 3D 100%
Stacked Spline Area).



Range Series (Range Bar, Side-By-Side Range Bar, Range Area, 3D Range Area).
Radar and Polar Series (Radar Point, Radar Line, Radar Area, Polar Point, Polar Line and Polar Area).
Advanced Series (Stock, Candle Stick, Gantt, Side-By-Side Gantt).



Appearance PageAppearance Page
Tasks

Choose a palette to color a series.
Choose the style specifying the chart's appearance.

Page Elements

Chart preview area

Previews a chart's layout.

Palette Editor

Specifies a palette to color a series.

Style Editor



Specifies the style determining the chart's appearance, depending on the selected palette.



Series PageSeries Page
Tasks

Create or remove a series of points.
Define the series name, visibility and view type.
Customize additional series options and legend point options.
Enable and customize the Top N Values feature.

Page Elements

Series List

This list displays all available series. You can click list entries to access properties of the corresponding series. To switch between
series, use the ∧∧  and ∨∨  buttons.

Series management buttons

Use the Add, Copy and Remove buttons to manage the series collection.

Options tabs



The following tabs are available on this page:

General

Choose whether the selected series should be visible, define its name, and select a view type.

Series Options

Specifies argument and value scale types, the point sort order, visibility in the legend, whether the legend is checked, and
legend text.

Top N Options

Specifies whether the Top N Values feature is enabled, and allows you to control this feature's options.

Legend Text Pattern

Specifies the format of values displayed in the chart legend.



Data PageData Page
Tasks

Provide data for a chart;
Bind a chart or individual series to a data source;
Customize an argument and a value scale type;
Customize the view type of auto-generated series;
Apply data filtering and sorting;
Adjust the Pivot Chart settings.

Page Elements

You can provide data for a chart using the following tabs.

Points tab
Series Binding tab
Auto-created Series tab

Points Tab
Use it to manually enter data points for series.

Note that valid Argument and Value entries must correspond to the Argument scale type and the Value scale type selected
for the appropriate series on the Series Page. Otherwise, an error message will be invoked.



Series Binding Tab
Use it to provide specific data binding options for each series.

The following illustration demonstrates how it works.

Auto-created Series Tab
Use it to specify data columns used to generate series, as well as the series view type and other options like sorting, filtering and
name template.



The following illustration demonstrates how it works.

For familiar data sources (such as Pivot Grid), you can choose to automatically adjust the binding and layout settings of your
Chart.

And when you set a Pivot Grid as a Chart's data source, the Pivot Grid Data Source tab becomes available.

On this tab you can adjust various Pivot Chart options.





Chart PageChart Page
Tasks

Define a chart's background color and background image.

Page Elements

Chart preview area

Previews a chart's layout.

Options tabs

The following tabs are available on this page.

General

Specifies a chart's automatic layout, chart background color, fill style and background image.

Border

Specifies a border's color, thickness and visibility.

Padding



Specifies the diagram's inner indents.

Empty Chart Text

Specifies the message displayed in the chart when there's no data to display.

Small Chart Text

Specifies the message displayed in the chart, when the chart size is too small to fit the diagram.



Diagram PageDiagram Page
Tasks

Rotate a diagram;
Define a diagram's padding;
Add or remove secondary axes;
Add or remove panes;
Define panes' layout direction;
Enable or disable a diagram's scrolling and zooming.

Page Elements

Chart preview area

Previews a chart's layout.

Options tabs

The following tabs are available on this page.



General

Choose whether a diagram should be rotated, set its padding values, and (if it contains several panes) define the panes'
layout direction.

Elements

Add or remove secondary axes and panes.

Scroll & Zoom

Enable or disable a diagram's scrolling and zooming, and specify the scrolling and zooming options.



Panes PagePanes Page
Tasks

Customize panes properties.

Page Elements

Chart preview area

Previews a chart's layout.

Pane selector

Specifies a pane to be customized.

Options tabs

The following tabs are available on this page.

General

Determines whether the selected pane should be visible, specifies its name, size mode and size value.

Appearance

Specifies a pane's background color and fill style, and its background image.

Border



Determines whether a pane's border should be visible, and defines its color.

Shadow

Determines whether a pane's shadow should be visible, and defines its color and size.

Scroll & Zoom

Enable or disable a pane's scrolling and zooming for specific axes.

Scroll Bars

If scrolling and/or zooming is enabled for an axis, adjust the scroll bars visibility, position and appearance.



Axes PageAxes Page
Tasks

Customize axes properties;
Customize the appearance of axis labels;
Add a constant line and a strip to an axis;
Enable automatic and manual scale breaks.

Page Elements

Chart preview area

Previews a chart's layout.

Note that you can select an axis to be modified on the chart preview area directly.

Axis selector

Specifies an axis to be customized.

Options tabs



The following tabs are available on this page.

General

Specifies visibility, position, range and format properties.

Appearance

Defines color, thickness and interlacing options.

Elements

Customizes title, tickmarks and grid line properties.

Labels

Specifies position and text for automatically created labels, or allows custom labels to be defined.

Strips

Allows you to create strips, define their visibility, name, limits, appearance, etc.

Constant Lines

Allows you to create constant lines, specify whether the constant line should be checkable or checked in a legend, define
their visibility, name, value, legend text, appearance, title, etc.

Scale Breaks

Allows you to enable automatic and / or create custom scale breaks, and define their appearance.



Series Views PageSeries Views Page
Tasks

Customize the view-type-specific properties of series;
Customize the appearance and border settings of series;
Add or remove financial indicators (Fibonacci indicators, trendlines and regression lines).

Page Elements

Chart preview area

Previews a chart's layout.

Note that you can select a series to be modified directly in the chart preview area.



Series selector

Specifies a series to be customized.

Options tabs

The following tabs are available on this page.

General

Specifies a series bar's width, distance, color, transparency, etc.

Appearance

Specifies a series color, transparency and fill style. Additionally, determines whether series points should be painted
individually.

Border

Determines whether a series border should be visible, and defines its color and thickness.

Shadow

Specifies whether a series' shadow should be visible, determines its color and size.

Indicators

Allows you to add or remove indicators of a required kind (Regression Line, Trend Line, Fibonacci Arcs, Fibonacci Fans,
Fibonacci Retracement and many others).



Point Labels PagePoint Labels Page
Tasks

Resolve overlapping of point labels;
Customize the appearance of point labels.

Page Elements
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The point labels are hidden in the chart control by default. To show series point labels, check the Visibile check box.

Chart preview area

Previews a chart's layout.

Note that you can select point labels to be modified directly in the chart preview area.

Series selector

Specifies a series to be customized.

Options tabs



The following tabs are available on this page.

General

Specifies whether labels should be visible and shown for zero values, determines their text and resolves overlapping
settings.

Text Pattern

Specifies a text pattern to format series point labels.

Line

Determines whether label lines should be visible, and specifies their appearance.

Appearance

Specifies the background color and fill style of labels.

Border

Determines whether label borders should be visible, and defines their color and thickness.

Shadow

Specifies whether a label's shadow should be visible, and defines its color and size.



Chart Titles PageChart Titles Page
Tasks

Create chart titles;
Enable the word-wrapping for lengthy chart titles;
Customize the appearance and position of chart titles.

Page Elements

Chart preview area

Previews a chart's layout.

Note that you can select chart titles to be modified in the chart preview area directly.

Titles management section



Allows you to add or remove titles from the titles list, and choose a title to be customized.

Options tabs

The following tabs are available on this page.

Text

Sets a text for the selected chart title. Note that the basic HTML formatting is supported for chart titles.

General

Specifies a title's visibility, alignment and font options, and determines whether the word-wrapping is enabled for a title.



Legend PageLegend Page
Tasks

Customize chart legend's properties.

Page Elements

Chart preview area

Previews a chart's layout.

Note that you can select the legend directly on the chart preview area.

Options tabs

The following tabs are available on this page.



General

Specifies legend visibility, direction, alignment, spacing, limits and margins.

Appearance

Specifies legend background color and background image.

Marker

Specifies visibility and dimensions of legend markers.

Text

Specifies legend text antialiasing, color and font.

Border

Specifies visibility, color and thickness of legend borders.

Shadow

Specifies visibility, color and size of the legend shadow.



Annotations PageAnnotations Page
Tasks

Create and customize image and text annotations.

Page Elements

Chart preview area

Previews a chart's layout.

Annotation selector

Specifies an annotation to be created and/or customized.

Note that you can select an annotation directly on the chart preview area.

Options tabs

The following tabs are available on this page.

General



Specify an annotation's name, adjust its visibility, z-order and layout.

Anchor Point

Choose an element to anchor to (chart, pane, or series point), and adjust the corresponding options.

Shape Position

Choose an annotation's shape position type (free or relative), and adjust the corresponding options.

Content

Depending on an annotation's type (text or image), specify its content.

Padding

Specify an annotation's inner indents.

Appearance

Adjust an annotation's background color, fill style, shape and connector options.

Border

Specify visibility, color and thickness of an annotation's borders.

Shadow

Specifies visibility, color and size of an annotation's shadow.



Highlighting and Selection Chart ElementsHighlighting and Selection Chart Elements
If you are working with 2D charts, you can highlight and select different chart elements via the mouse or using different gestures
on your touchscreen device.

Highlighting
Any chart element that can be selected supports highlighting.

An end user can highlight a chart's area using either the drag gesture on your touchscreen device or via the mouse pointer by
hovering over a particular chart element, as shown in the image below.
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Chart element highlighting and selection is available only for 2D Chart Types.

Selection
To select a particular chart element, an end user should tap it on a device supporting touchscreen or click this element using the
left mouse button. The following image demonstrates how a constant line and a single series are painted if selected by an end
user with the mouse pointer.



Selectable Elements
Chart elements which can be highlighted or selected are shown in the following illustration.



Zoom a ChartZoom a Chart
If you are working with 2D XY-charts (Bar, Line, Point, etc.) or 3D charts, you can zoom in or out of a chart. This allows you to see
some of the chart's data in greater detail, or get a more general picture of your data.

Note that zooming is unavailable for 2D Pie, 2D Doughnut, Radar, and Polar charts.

Zoom In a Chart
To zoom in a chart, do one of the following.

Hold down SHIFT and click.

After you press SHIFT, the mouse pointer is changed to . Then, move the mouse pointer to the chart region to be zoomed
into, and click (while holding SHIFT). The magnification factor is 300%.

Press SHIFT and select a region on a diagram.

After you press SHIFT, the mouse pointer is changed to . Then, select a zoomed region by dragging the mouse pointer.

After releasing the left mouse button, a chart is zoomed into the bounds of the selected region on a diagram.
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This feature is available for 2D charts only.

if you press SHIFT and can't zoom in anymore (the mouse pointer is changed to ), then a chart is already zoomed in by
100 times (10000%). This is the maximum possible zoom factor allowed.

Use CTRL+PLUS SIGN.

In this case, the magnification factor is 120%.

Use the spread gestures on a touchscreen device.

An end-user can zoom in a chart's diagram performing spread gestures on any device supporting touchscreen.

Use the mouse wheel.

In this case, the magnification factor is 120%.

Zoom Out of a Chart
To zoom out of a chart, do one of the following.



Hold down ALT and click.

After you press ALT, the mouse pointer is changed to . Then, move the mouse pointer to the region to be zoomed out, and
click (while holding ALT). The magnification factor is 300%.

Use CTRL+MINUS SIGN.

In this case, the magnification factor is 120%.

Use the pinch gestures on a touchscreen device.

A chart's diagram can be zoomed out by performing pinch gestures on any device supporting touchscreen.

Use the mouse wheel.

In this case, the magnification factor is 120%.

Undo Zooming
Press CTRL+Z to return to the state before the first zoom operation in a series.



Scroll a ChartScroll a Chart
You can scroll a chart if either the axis visible range is reduced or a chart is already zoomed in (its zoom factor is more than
100%). Since the entire chart is not visible at one time, it's possible to scroll a chart.

Scroll a 2D Chart
To scroll a 2D chart, do one of the following:

Hold down the left mouse button, and drag it.

After you hold down the left mouse button, the mouse pointer is changed from  to . Then drag the mouse pointer to
scroll the diagram.

Use scrollbars.

An end-user is able to click a scrollbar arrow, click the scrollbar near the thumb, or drag the thumb and move it.

In this instance, a chart's diagram is scrolled in the same way as controls in used Windows applications.

Use flick gestures on a touchscreen device.

An end-user can scroll a diagram using flick gestures on a touchscreen device.

Use CTRL+ARROW combinations.

When an end-user presses CTRL + LEFT, a chart's diagram is moved to the left.

When an end-user presses CTRL + UP, a chart's diagram is moved to the top.

When an end-user presses CTRL + RIGHT, a chart's diagram is moved to the right.

When an end-user presses CTRL + DOWN, a chart's diagram is moved to the bottom.



Scroll a 3D Chart
An end-user can perform chart scrolling doing one of the following:

Hold down the mouse wheel button on a chart and drag it.

After you hold down the mouse wheel, the mouse pointer is changed from  to . Then drag the mouse pointer to scroll
a chart's diagram.

Use CTRL+ARROW combinations.

Use flick gestures on a touchscreen device.

An end-user can scroll a diagram using flick gestures.



Rotate a ChartRotate a Chart
If you are working with 3D charts, you can rotate a chart's diagram. This may be required if a chart displays multiple series or data
points, and it's required to change the current rotation angle to view the chart data in detail.

To rotate a chart control, do one of the following:

Hold down the left mouse button on the diagram and drag the mouse pointer.

After holding down the left mouse button, the mouse pointer is changed from  to . Then, drag the mouse pointer to
rotate the chart.

Use rotation gestures on a touchscreen device.

Touch a 3D chart's area with two fingers and move them in a clockwise or counterclockwise direction.



DockingDocking
In the Docking section, you will learn about the main runtime capabilities of the DocumentManager and DockManager, which
can be combined to create traditional docking UI applications (see the image below).

The main elements of the DocumentManager and DockManager components are Documents and Dock panels, respectively.
These objects are containers that display content and provide docking functionality – you can drag Documents and Dock Panels
into a tab group, dock them to different application dock zones, make them floating or auto-hidden, etc.

This section consists of the following topics.

Dock Panels
Documents



Dock PanelsDock Panels
This topic describes the most common runtime operations for dock panels.

Docking Hints
Dock panels can be docked, floating or auto-hidden. To dock or undock a panel, simply click its header and drag the panel. As you
drag the panel over an application form, docking hints appear (see the figure below). Use these hints to dock the panel to the
desired position.

Docking hints are semi-transparent square elements that allow you to dock a panel to a form's edges, or to an existing container
as a tab, or between other docking elements. These hints are displayed separately or grouped in a docking guide (e.g., in the
form's central area). Finally, a docking zone is a semi-transparent preview of exactly where your panel will be docked. This zone is
displayed when you drag a panel into a docking hint, but before you drop it.

Buttons
Dock panels have multiple state change buttons in their top right corner.

Close - closes the current panel.
Maximize/Restore - maximizes the panel to full-screen size, or restores it back to its original size. Available only for
floating panels.
Auto-hide/Dock - hides the panel, leaving only its header visible, or restores an auto-hidden panel back to the docked
state. Depending on the application settings, hidden panels are displayed either on mouse hover or on click only. Available
only for docked panels.
Pin - places the panel in the first tab position. Available only for panels docked as tabbed documents.

Context Menu



Most docking operations are available from the panel's context menu, displayed on right-click. The figure below illustrates the
context menu for a docked panel.

For dock panels docked as tabbed documents, the context menu displays multiple additional items, which allow you to pin the
panel or start a new horizontal or vertical group within the docked area (see the image below).

Interoperability with Documents and Other Dock Panels
When dragging a dock panel, you can dock it to other dock panels. This will create a dock panel container that presents both
panels as tabs. Note that in addition to docking panels via docking hints, you can also drag them to the tab header area. This
allows you to instantly rearrange panels within the container (see the animation below).



Dock panels can be docked to both the dock panel docking areas (the form's edges) as well as to the tabbed View. Documents,
however, can only be docked within the tabbed View, and not to the docking areas.

Mouse Operations and Hotkeys
Double-click a docked panel's caption - undocks the panel and makes it floating. This does not work with auto-hide panels.
Ctrl+Double-click a floating panel's caption - docks the floating panel to its previous docking position.
Esc while dragging a panel - cancels the dock operation and drops the panel at the current position.
Ctrl+Tab or Crtl+Shift+Tab - shows the Document Selector. See the Dock Panels topic to learn more about the Document
Selector.



DocumentsDocuments
Document objects resemble dock panels and serve the very same goal - to host content within floating or tabbed MDI windows.
You can click a document’s caption, and drag this document to dock or undock it in the same manner as dock panels. However,
there are certain differences between documents and dock panels.

View
While dock panels can be docked to any form’s edge, documents can only be docked in a special area called a tabbed View. When
you drag a document, docking hints will tell you where this area is. The image below illustrates a tabbed View within a tabbed
MDI application.

Dock panels can also be docked into this area, but documents cannot be docked to auto-hide containers and form edges.

Floating Document Container
As you can see from the image above, documents can be nested into a floating document container. If this feature is enabled, it
allows you to organize all of your floating documents in a single floating container (and avoid a cluttered UI with multiple floating
windows). If you want to dock your floating documents once again, simply drag this container in the same manner in which you
drag documents. Docking a floating container into a tabbed View will dock all of the container's documents into this View. You
can also rearrange within or drag individual documents out of this container.

Tabbed Groups
Documents within a tabbed View can be docked to vertical or horizontal document groups. To do so, use the side docking hint
when dragging a document, or right-click the document header and select the New Tab Group item in the invoked context menu



(see the figure below).

Document groups are divided by splitters. You can drag the splitter to resize the groups, as shown in the figure below.

Document groups can display Next and Previous buttons, which allow you to scroll through tab headers when there is not
enough free space within the group to display all of the headers.

Document groups within a View can either be arranged horizontally (side-by-side), or vertically (one above another), but not in
both directions simultaneously. If only one tabbed group exists, the View does not yet have an orientation setting. After you start a
new horizontal tab group, for example, the View becomes vertically oriented, which means that all subsequent tab groups can
only be arranged vertically. You can reverse the current View orientation by right-clicking any tab group header and selecting the
Arrange Tab Groups Vertically (Horizontally) context menu item.

Navigation
To navigate through documents (and dock panels, if any exist), you can use the Document Selector, invoked via the CTRL+Tab
keyboard hotkey. This tool displays a small preview of each focused document (dock panel) and its short description. You can see
the Document Selector in the next image.



To quickly navigate through documents, you can also use the button in the group's top right corner.

Finally, you can right-click a document group's header and select the Windows... item to display the Windows dialog, which lists
all currently opened documents and their paths (see the image below).



Mouse Operations and Keyboard Shortcuts
Double-click a docked document's caption - undock the document and make it floating.
Ctrl+Double-click a floating document's caption - docks the floating document to its previous docking position.
Ctrl+Tab or Ctrl+Shift+Tab - shows the Document Selector.



EditorsEditors
This section describes the capabilities provided by the editor controls:

 

Topics in this section:

Working with Dropdown Editors
Editing Values, Selecting Text and Using the Clipboard
Editor Context Menu
Image Editor
Manipulating Tokens



Working with Dropdown EditorsWorking with Dropdown Editors
Open Editor's Dropdown
Do one of the following:

Focus the editor and press ALT+DOWN ARROW or F4.

Click the editor's dropdown button:

Close Editor's Dropdown
For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW, ESC or F4.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with the keyboard
and pressing ENTER.



Editing Values, Selecting Text and Using the ClipboardEditing Values, Selecting Text and Using the Clipboard
Select and Deselect Editor's Contents
To select all text within an editor, you can invoke the Editor Context Menu and choose Select All. To select a part of the edit value,
click on a position where the selection should start, drag the pointer to the end position and then release the mouse button.

Additionally, the following keyboard shortcuts allow you to manage selections.

S HOR TCU T D ES CR IPTION

CTRL+A or F2 Selects all within an editor.

SHIFT+ARROW Extends or shrinks the selection by one character.

CTRL+SHIFT+ARROW Extends or shrinks the selection by one word.

Clipboard Operations
Clipboard operations are supported for editors that support caret moving.

To copy selected text into the clipboard, do one of the following.

Press CTRL+C or CTRL+INSERT.
Open the Editor Context Menu and select Copy.

To paste text from the clipboard, do one of the following.

Press CTRL+V or SHIFT+INSERT.
Open the Editor Context Menu and select Paste.

To cut text from an editor into the clipboard, do one of the following.

Press CTRL+X or SHIFT+DELETE.
Open the Editor Context Menu and select Cut.

Delete Selected Text
To delete the selected text within an editor, do one of the following.

Press DELETE or BACKSPACE.
Open the Editor Context Menu and select Delete.

Undo
To undo the last text editing operation, do one of the following.

Press CTRL+Z.
Open the Editor Context Menu and select Undo.

�� N o t eN o t e

After you've undone an operation, you can return to the previous edit value by executing the Undo command once again.

Change Date/Time Values



You can edit these values without opening the dropdown calendar. Position the caret at the portion of a date/time value that
needs to be changed. To increment the value, press the UP ARROW. To decrement the value, press the DOWN ARROW. Or use the
mouse wheel.

Change Numeric Values

To increment a value, press the UP ARROW. To decrement the value, press the DOWN ARROW. Alternatively, rotate the wheel
button.

Change Binary Values

Click a check box or a toggle switch to change its value.

Change Values of Editors That Display Items in the Dropdown

To select the previous value, press the UP ARROW. To select the next value, press the DOWN ARROW. Alternatively, rotate the
wheel button.

To learn how to open and close dropdown windows, see Working with Dropdown Editors.

Navigate hyperlinks



Hover the mouse pointer over a hyperlink to display a tooltip. Click a hyperlink to navigate it.

Edit Images
To copy, cut, paste, load and save images in image editors, select the required command from the image menu. To access the
image menu, do one of the following.

Right click the image editor.
Hover the mouse pointer over the image editor.

To learn more about image editors, see Image Editor.



Editor Context MenuEditor Context Menu
Text editors support a context menu providing common commands. To open the menu, right-click an editor.



Image EditorImage Editor
An image editor allows you to load and display images.

�� N o t eN o t e

The following steps may vary depending on application vendor.

Built-in menu
To access the built-in menu, do one of the following.

Hover the mouse pointer over the image editor.
Right-click the image editor.

Open an image
To load a new image, click the Open(Load)  button from the built-in menu.

In the invoked dialog, choose an image file and click Open.

Save an image
To save the currently displayed image, open the built-in menu and click the Save  button.

In the invoked dialog, locate the folder where you want to store your image, enter the file name and click Save.



Using the clipboard

To cut the currently displayed image and copy it to the clipboard, click the Cut  button.
To copy the currently displayed image to the clipboard, click the Copy  button.
To retrieve the image from the clipboard, click the Paste  button.

Clear the editor
Click the Clear(Delete)  button to clear editor contents.



Manipulating TokensManipulating Tokens
Add a Token

To add a new token, do any of the following.

Click an item from the dropdown.
Type the item name in the text field and press ENTER.

Rotate the wheel button to scroll through items. Press the UP ARROW or DOWN ARROW to navigate the items one by one.

Remove a Token

To remove a token, click the Remove Token  button.

Clipboard Operations

To select multiple tokens, click each token you want to select while holding down the CTRL button.

To copy selected tokens to the clipboard, press CTRL+C.

To paste the tokens from the clipboard, click within a token editor and press CTRL+V.



Expression EditorExpression Editor
The Expression Editor allows you to edit various Boolean or regular expressions in controls:

In this editor, you can type an expression manually, or select functions, operators and operands using the editor's controls.

An expression is a string that, when parsed and processed, evaluates some value. Expressions consist of column/field names,
constants, operators and functions. Column/field names must be wrapped with brackets. The following are examples of regular
expressions:

"[Quantity] * [UnitPrice] * (1 - [BonusAmount])"

Boolean expressions:

"[Country] == 'USA'"

For more information about syntax you can use in expressions, see Expression Operators, Functions and Constants

The Expression Editor supports numerous standard functions, allowing you to easily perform different string, date-time, logical
and math operations over data. You can access the available functions by selecting the Functions category.



Expression Operators, Functions and ConstantsExpression Operators, Functions and Constants
This topic lists operators and functions supported by the Expression Editor. It also provides information on how constants can be
specified in expressions.

The following DevExpress products extend and/or override this syntax. The table below lists the articles that explain how to use
expressions in these products.

PR OD U CT AR TICLE

Reporting Expression Constants, Operators, and Functions

Pivot Grid Pivot Grid Expression Syntax

Operators

OPER ATOR D ES CR IPTION E X AMPLE

X LS(X)
FOR MAT
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FR IEND LY
*S EE NOTE

+ Adds the value of one numeric expression to another, or concatenates two strings.
[FirstName] + ' '
+ [LastName];
[UnitPrice] + 4

Yes

- Finds the difference between two numbers. [Price1] - [Price2] Yes

* Multiplies the value of two expressions.
[Quantity] *
[UnitPrice] * (1 -
[BonusAmount])

Yes

/ Divides the first operand by the second. [Quantity] / 2 Yes

% Returns the remainder (modulus) obtained by dividing one numeric expression into
another. [Quantity] % 3 Yes

|
Compares each bit of its first operand to the corresponding bit of its second
operand. If either bit is 1, the corresponding result bit is set to 1. Otherwise, the
corresponding result bit is set to 0.

[Number] |
[Number] Yes

& Performs a bitwise logical AND operation between two integer values. [Number] & 10 Yes

^ Performs a logical exclusion on two Boolean expressions, or a bitwise exclusion on
two numeric expressions.

[Number1] ^
[Number2] Yes

== (as well
as =) Returns true if both operands have the same value; otherwise, it returns false.

[Quantity] == 10
(as well as [ID] =
11)

Yes

!= Returns true if the operands do not have the same value; otherwise, it returns false. [Country] !=
'France' Yes

< Less than operator. Used to compare expressions. [UnitPrice] < 20 Yes



<= Less than or equal to operator. Used to compare expressions. [UnitPrice] <= 20 Yes

>= Greater than or equal to operator. Used to compare expressions. [UnitPrice] > 30 Yes

> Greater than operator. Used to compare expressions. [UnitPrice] >= 30 Yes

In (,,,) Tests for the existence of a property in an object. [Country] In
('USA', 'UK', 'Italy') Yes

Like
Compares a string against a pattern. If the value of the string matches the pattern,
result is true. If the string does not match the pattern, result is false. If both string
and pattern are empty strings, the result is true.

[Name] Like 'An%' Yes

Between (,) Specifies a range to test. Returns true if a value is greater than or equal to the first
operand and less than or equal to the second operand.

[Quantity]
Between (10, 20) Yes

And Performs a logical conjunction on two expressions.
[InStock] And
([ExtendedPrice]>
100)

Yes

Or Performs a logical disjunction on two Boolean expressions.
[Country]=='USA'
Or
[Country]=='UK'

Yes

Not Performs logical negation on an expression. Not [InStock] Yes

+ Returns a numeric expression's value (a unary operator). +[Value] = 10 Yes

- Returns the negative of a numeric expression's value (a unary operator). -[Value] = 20 Yes

~ Performs a bitwise negation on a numeric expression. ~[Roles] = 251 -

Is null Returns true if an expression is a null reference, the one that does not refer to any
object. [Region] is null yes

OPER ATOR D ES CR IPTION E X AMPLE
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Functions
Aggregate Functions
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X LS(X)
FOR MAT
E X POR T-
FR IEND LY
*S EE
NOTE

Avg(Value) Evaluates the average of the values in the collection. [Products].Avg([UnitPrice]) -

Count() Returns the number of objects in a collection. [Products].Count() -



Exists() Determines whether the object exists in the collection. [Categories][[CategoryID] ==
7].Exists() -

Max(Value) Returns the maximum expression value in a collection. [Products].Max([UnitPrice]) -

Min(Value) Returns the minimum expression value in a collection. [Products].Min([UnitPrice]) -

Single()

Returns a single object from a collection that contains no more than one
object. If the collection contains more objects, use the Condition property to
specify a condition. The collection must contain only one object that satisfies
the condition; otherwise, the function's behavior is undefined (the function
may return an unexpected value or throw an exception). You can pass an
expression as a parameter: [Collection][Condition].Single(Expression). The
function returns the Expression value evaluated on an object that meets the
specified Condition (optional).

[Accounts].Single() is not null
[Collection].Single([Property1])
- returns the found object's
property value.

-

Sum(Value) Returns the sum of all the expression values in the collection. [Products].Sum([UnitsInStock]) -

A custom
aggregate
function

Returns a custom expression value for a collection, according to a custom
aggregate function. You can call the function directly or pass it as a
parameter.

Call a Custom Aggregate
Function -
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Date-time Functions

FU NCTION D ES CR IPTION E X AMPLE

X LS(X)
FOR MAT
E X POR T-
FR IEND LY
*S EE
NOTE

AddDays(DateTime, DaysCount)
Returns a date-time value that is the
specified number of days away from
the specified DateTime.

AddDays([OrderDate], 30) Yes

AddHours(DateTime, HoursCount)
Returns a date-time value that is the
specified number of hours away from
the specified DateTime.

AddHours([StartTime], 2) Yes

AddMilliSeconds(DateTime,
MilliSecondsCount)

Returns a date-time value that is the
specified number of milliseconds
away from the specified DateTime.

AddMilliSeconds(([StartTime], 5000)) -

AddMinutes(DateTime,
MinutesCount)

Returns a date-time value that is the
specified number of minutes away
from the specified DateTime.

AddMinutes([StartTime], 30) Yes

AddMonths(DateTime,
MonthsCount)

Returns a date-time value that is the
specified number of months away
from the specified DateTime.

AddMonths([OrderDate], 1) Yes



AddSeconds(DateTime,
SecondsCount)

Returns a date-time value that is the
specified number of seconds away
from the specified DateTime.

AddSeconds([StartTime], 60) Yes

AddTicks(DateTime, TicksCount)
Returns a date-time value that is the
specified number of ticks away from
the specified DateTime.

AddTicks([StartTime], 5000) -

AddTimeSpan(DateTime,
TimeSpan)

Returns a date-time value that is
away from the specified DateTime for
the given TimeSpan.

AddTimeSpan([StartTime], [Duration]) -

AddYears(DateTime, YearsCount)
Returns a date-time value that is the
specified number of years away from
the specieid DateTime.

AddYears([EndDate], -1) Yes

DateDiffDay(startDate, endDate)
Returns the number of day
boundaries between two non-
nullable dates.

DateDiffDay([StartTime], Now()) Yes

DateDiffHour(startDate, endDate)
Returns the number of hour
boundaries between two non-
nullable dates.

DateDiffHour([StartTime], Now()) Yes

DateDiffMilliSecond(startDate,
endDate)

Returns the number of millisecond
boundaries between two non-
nullable dates.

DateDiffMilliSecond([StartTime], Now()) -

DateDiffMinute(startDate,
endDate)

Returns the number of minute
boundaries between two non-
nullable dates.

DateDiffMinute([StartTime], Now()) Yes

DateDiffMonth(startDate,
endDate)

Returns the number of month
boundaries between two non-
nullable dates.

DateDiffMonth([StartTime], Now()) Yes

DateDiffSecond(startDate,
endDate)

Returns the number of second
boundaries between two non-
nullable dates.

DateDiffSecond([StartTime], Now()) Yes

DateDiffTick(startDate, endDate)
Returns the number of tick
boundaries between two non-
nullable dates.

DateDiffTick([StartTime], Now()) -

DateDiffYear(startDate, endDate)
Returns the number of year
boundaries between two non-
nullable dates.

DateDiffYear([StartTime], Now()) Yes

GetDate(DateTime) Extracts a date from the defined
DateTime. GetDate([OrderDateTime])
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GetDay(DateTime) Extracts a day from the defined
DateTime. GetDay([OrderDate]) Yes

GetDayOfWeek(DateTime) Extracts a day of the week from the
defined DateTime. GetDayOfWeek([OrderDate]) Yes

GetDayOfYear(DateTime) Extracts a day of the year from the
defined DateTime. GetDayOfYear([OrderDate]) Yes

GetHour(DateTime) Extracts an hour from the defined
DateTime. GetHour([StartTime]) Yes

GetMilliSecond(DateTime) Extracts milliseconds from the
defined DateTime. GetMilliSecond([StartTime]) -

GetMinute(DateTime) Extracts minutes from the defined
DateTime. GetMinute([StartTime]) Yes

GetMonth(DateTime) Extracts a month from the defined
DateTime. GetMonth([StartTime]) Yes

GetSecond(DateTime) Extracts seconds from the defined
DateTime. GetSecond([StartTime]) Yes

GetTimeOfDay(DateTime) Extracts the time of the day from the
defined DateTime, in ticks. GetTimeOfDay([StartTime]) -

GetYear(DateTime) Extracts a year from the defined
DateTime. GetYear([StartTime]) Yes

IsApril(DateTime) Returns True if the specified date falls
within April. IsApril([OrderDate]) Yes

IsAugust(DateTime) Returns True if the specified date falls
within August. IsAugust([OrderDate]) Yes

IsDecember(DateTime) Returns True if the specified date falls
within December. IsDecember([OrderDate]) Yes

IsFebruary(DateTime) Returns True if the specified date falls
within February. IsFebruary([OrderDate]) Yes

IsJanuary(DateTime) Returns True if the specified date falls
within January. IsJanuary([OrderDate]) Yes

IsJuly(DateTime) Returns True if the specified date falls
within July. IsJuly([OrderDate]) Yes

IsJune(DateTime) Returns True if the specified date falls
within June. IsJune([OrderDate]) Yes
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IsLastMonth(DateTime) Returns True if the specified date falls
within the previous month. IsLastMonth([OrderDate]) Yes

IsLastYear(DateTime) Returns True if the specified date falls
within the previous year. IsLastYear([OrderDate]) Yes

IsMarch(DateTime) Returns True if the specified date falls
within March. IsMarch([OrderDate]) Yes

IsMay(DateTime) Returns True if the specified date falls
within May. IsMay([OrderDate]) Yes

IsNextMonth(DateTime) Returns True if the specified date falls
within the next month. IsNextMonth([OrderDate]) Yes

IsNextYear(DateTime) Returns True if the specified date falls
within the next year. IsNextYear([OrderDate]) Yes

IsNovember(DateTime) Returns True if the specified date falls
within November. IsNovember([OrderDate]) Yes

IsOctober(DateTime) Returns True if the specified date falls
within October. IsOctober([OrderDate]) Yes

IsSameDay(DateTime)
Returns True if the specified
date/time values fall within the same
day.

IsSameDay([OrderDate]) Yes

IsSeptember(DateTime) Returns True if the specified date falls
within September. IsSeptember([OrderDate]) Yes

IsThisMonth(DateTime) Returns True if the specified date falls
within the current month. IsThisMonth([OrderDate]) Yes

IsThisWeek(DateTime) Returns True if the specified date falls
within the current week. IsThisWeek([OrderDate]) Yes

IsYearToDate(DateTime)

Returns True if the specified date falls
within the year-to-date period. This
period starts from the first day of the
current year and continues to the
current date (including the current
date).

IsYearToDate([OrderDate]) Yes

IsThisYear(DateTime) Returns True if the specified date falls
within the current year. IsThisYear([OrderDate]) Yes

LocalDateTimeDayAfterTomorrow()
Returns a date-time value
corresponding to the day after
Tomorrow.

AddDays(LocalDateTimeDayAfterTomorrow(),
5) Yes
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LocalDateTimeLastMonth()
Returns the DateTime value
corresponding to the first day of the
previous month.

AddMonths(LocalDateTimeLastMonth(), 5) Yes

LocalDateTimeLastWeek()
Returns a date-time value
corresponding to the first day of the
previous week.

AddDays(LocalDateTimeLastWeek(), 5) Yes

LocalDateTimeLastYear()
Returns the DateTime value
corresponding to the first day of the
previous year.

AddYears(LocalDateTimeLastYear(), 5) Yes

LocalDateTimeNextMonth()
Returns a date-time value
corresponding to the first day of the
next month.

AddMonths(LocalDateTimeNextMonth(), 5) Yes

LocalDateTimeNextWeek()
Returns a date-time value
corresponding to the first day of the
following week.

AddDays(LocalDateTimeNextWeek(), 5) Yes

LocalDateTimeNextYear()
Returns a date-time value
corresponding to the first day of the
following year.

AddYears(LocalDateTimeNextYear(), 5) Yes

LocalDateTimeNow()
Returns a date-time value
corresponding to the current
moment in time.

AddDays(LocalDateTimeNow(), 5) Yes

LocalDateTimeThisMonth()
Returns a date-time value
corresponding to the first day of the
current month.

AddMonths(LocalDateTimeThisMonth(), 5) Yes

LocalDateTimeThisWeek()
Returns a date-time value
corresponding to the first day of the
current week.

AddDays(LocalDateTimeThisWeek(), 5) Yes

LocalDateTimeThisYear()
Returns a date-time value
corresponding to the first day of the
current year.

AddYears(LocalDateTimeThisYear(), 5) Yes

LocalDateTimeToday() Returns a date-time value
corresponding to Today. AddDays(LocalDateTimeToday(), 5) Yes

LocalDateTimeTomorrow() Returns a date-time value
corresponding to Tomorrow. AddDays(LocalDateTimeTomorrow(), 5) Yes

LocalDateTimeTwoMonthsAway()
Returns the DateTime value
corresponding to the first day of the
following month.

AddMonths(LocalDateTimeTwoMonthAway(),
5) Yes
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LocalDateTimeTwoWeeksAway()
Returns the DateTime value
corresponding to the first day of the
following week.

AddDays(LocalDateTimeTwoWeeksAway(), 5) Yes

LocalDateTimeTwoYearsAway()
Returns the DateTime value
corresponding to the first day of the
following year.

AddYears(LocalDateTimeTwoYearsAway(), 5) Yes

LocalDateTimeYearBeforeToday()
Returns the DateTime value
corresponding to the day one year
ago.

AddYears(LocalDateTimeYearBeforeToday(),
5) Yes

LocalDateTimeYesterday() Returns a date-time value
corresponding to Yesterday. AddDays(LocalDateTimeYesterday(), 5) Yes

Now() Returns the current system date and
time. AddDays(Now(), 5) Yes

Today()
Returns the current date. Regardless
of the actual time, this function
returns midnight of the current date.

AddMonths(Today(), 1) Yes

UtcNow()
Returns the current system date and
time, expressed as Coordinated
Universal Time (UTC).

AddDays(UtcNow(), 7) -
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Logical Functions
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Iif(Expression1,
True_Value1, ...,
ExpressionN,
True_ValueN,
False_Value)

Returns one of several specified values depending upon the
values of logical expressions. The function can take 2N+1
arguments (N - the number of specified logical expressions): each
odd argument specifies a logical expression; each even argument
specifies the value that is returned if the previous expression
evaluates to true.

Iif(Name = 'Bob', 1, 0) Iif(Name
= 'Bob', 1, Name = 'Dan', 2,
Name = 'Sam', 3, 0)

Yes

IsNull(Value) Returns True if the specified Value is NULL. IsNull([OrderDate]) Yes

IsNull(Value1, Value2) Returns Value1 if it is not set to NULL; otherwise, Value2 is
returned.

IsNull([ShipDate],
[RequiredDate]) -

IsNullOrEmpty(String) Returns True if the specified String object is NULL or an empty
string; otherwise, False is returned. IsNullOrEmpty([ProductName]) Yes

Math Functions



FU NCTION D ES CR IPTION E X AMPLE
X LS(X) FOR MAT E X POR T-
FR IEND LY *S EE NOTE

Abs(Value) Returns the absolute, positive value of the given numeric
expression.

Abs(1 -
[Discount]) Yes

Acos(Value) Returns the arccosine of a number (the angle, in radians, whose
cosine is the given float expression). Acos([Value]) Yes

Asin(Value) Returns the arcsine of a number (the angle, in radians, whose
sine is the given float expression). Asin([Value]) Yes

Atn(Value) Returns the arctangent of a number (the angle, in radians,
whose tangent is the given float expression). Atn([Value]) Yes

Atn2(Value1,
Value2)

Returns the angle whose tangent is the quotient of two
specified numbers, in radians.

Atn2([Value1],
[Value2]) Yes

BigMul(Value1,
Value2)

Returns an Int64 containing the full product of two specified
32-bit numbers.

BigMul([Amount],
[Quantity]) -

Ceiling(Value) Returns the smallest integer that is greater than or equal to the
given numeric expression. Ceiling([Value]) Yes

Cos(Value) Returns the cosine of the angle defined in radians. Cos([Value]) Yes

Cosh(Value) Returns the hyperbolic cosine of the angle defined in radians. Cosh([Value]) Yes

Exp(Value) Returns the exponential value of the given float expression. Exp([Value]) Yes

Floor(Value) Returns the largest integer less than or equal to the given
numeric expression. Floor([Value]) Yes

Log(Value) Returns the natural logarithm of a specified number. Log([Value]) Yes

Log(Value, Base) Returns the logarithm of a specified number in a specified Base. Log([Value], 2) Yes

Log10(Value) Returns the base 10 logarithm of a specified number. Log10([Value]) Yes

Max(Value1,
Value2) Returns the maximum value from the specified values. Max([Value1],

[Value2]) Yes

Min(Value1,
Value2) Returns the minimum value from the specified values. Min([Value1],

[Value2]) Yes

Power(Value,
Power) Returns a specified number raised to a specified power. Power([Value], 3) Yes

Rnd() Returns a random number that is less than 1, but greater than
or equal to zero. Rnd()*100 Yes

Round(Value) Rounds the given value to the nearest integer. Round([Value]) Yes

Sign(Value) Returns the positive (+1), zero (0), or negative (-1) sign of the
given expression. Sign([Value]) Yes



Sin(Value) Returns the sine of the angle, defined in radians. Sin([Value]) Yes

Sinh(Value) Returns the hyperbolic sine of the angle defined in radians. Sinh([Value]) Yes

Sqr(Value) Returns the square root of a given number. Sqr([Value]) -

Tan(Value) Returns the tangent of the angle defined in radians. Tan([Value]) Yes

Tanh(Value) Returns the hyperbolic tangent of the angle defined in radians. Tanh([Value]) Yes

ToDecimal(Value) Converts Value to an equivalent decimal number. ToDecimal([Value]) -

ToDouble(Value) Converts Value to an equivalent 64-bit double-precision
floating-point number. ToDouble([Value]) -

ToFloat(Value) Converts Value to an equivalent 32-bit single-precision floating-
point number. ToFloat([Value]) -

ToInt(Value) Converts Value to an equivalent 32-bit signed integer. ToInt([Value]) -

ToLong(Value) Converts Value to an equivalent 64-bit signed integer. ToLong([Value]) -
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String Functions
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Ascii(String) Returns the ASCII code value of the leftmost character in a character
expression. Ascii('a') -

Char(Number) Converts an integerASCIICode to a character. Char(65) + Char(51) Yes

CharIndex(String1,
String2)

Returns the starting position of String1 within String2, beginning
from the zero character position to the end of a string.

CharIndex('e',
'devexpress') -

CharIndex(String1,
String2,
StartLocation)

Returns the starting position of String1 within String2, beginning
from the StartLocation character position to the end of a string.

CharIndex('e',
'devexpress', 2) -

Concat(String1, ... ,
StringN) Returns the result of concatenating two or more string values. Concat('A', ')',

[ProductName]) Yes

Contains(String1,
SubString1)

Returns True if SubString1 occurs within String1; otherwise, False is
returned.

Contains([ProductName],
'dairy') Yes

EndsWith(String1,
SubString1)

Returns True if the end of String1 matches SubString1; otherwise,
False is returned.

EndsWith([Description],
'The end.') Yes



Insert(String1,
StartPosition,
String2)

Inserts String2 into String1 at the position specified by StartPositon Insert([Name], 0, 'ABC-') -

Len(Value) Returns an integer containing either the number of characters in a
string or the nominal number of bytes required to store a variable. Len([Description]) Yes

Lower(String) Returns String in lowercase. Lower([ProductName]) Yes

PadLeft(String,
Length)

Left-aligns characters in the defined string, padding its left side with
white space characters up to a specified total length. -

PadLeft(String,
Length, Char)

Left-aligns characters in the defined string, padding its left side with
the specified Char up to a specified total length. PadLeft([Name], 30, '<') -

PadRight(String,
Length)

Right-aligns characters in the defined string, padding its left side
with white space characters up to a specified total length. PadRight([Name], 30) -

PadRight(String,
Length, Char)

Right-aligns characters in the defined string, padding its left side
with the specified Char up to a specified total length. PadRight([Name], 30, '>') -

Remove(String,
StartPosition,
Length)

Deletes a specified number of characters from this instance,
beginning at a specified position. Remove([Name], 0, 3) -

Replace(String,
SubString2,
String3)

Returns a copy of String1, in which SubString2 has been replaced
with String3. Replace([Name], 'The ', '') -

Reverse(String) Reverses the order of elements within String. Reverse([Name]) -

StartsWith(String1,
SubString1)

Returns True if the beginning of String1 matches SubString1;
otherwise, False.

StartsWith([Title], 'The
best') Yes

Substring(String,
StartPosition,
Length)

Retrieves a substring from String. The substring starts at
StartPosition and has the specified Length..

Substring([Description],
2, 3) Yes

Substring(String,
StartPosition)

Retrieves a substring from String. The substring starts at
StartPosition.

Substring([Description],
2) -

ToStr(Value) Returns a string representation of an object. ToStr([ID]) -

Trim(String) Removes all leading and trailing SPACE characters from String. Trim([ProductName]) Yes

Upper(String) Returns String in uppercase. Upper([ProductName]) Yes
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String
constants String constants must be wrapped in apostrophes. [Country] ==

'France' Yes

String
constants
(with
apostrophe)

If a string contains an apostrophe, the apostrophe must be doubled. [Name] == 'O''Neil' Yes

Date-time
constants Date-time constants must be wrapped in '#'. [OrderDate] >=

#1/1/2009# Yes

True Represents the Boolean True value. [InStock] == True Yes

False Represents the Boolean False value. [InStock] == False Yes

?
Represents a null reference that does not refer to any object. We recommend
using the IsNull unary operator (for example, "[Region] is null") or the IsNull
logical function (for example, "IsNull([Region])") instead.

[Region] != ? Yes

Enumeration Specify an enumeration value using its underlying integer value. [Status] == 1

Guid Wrap a Guid constant in curly braces. Use Guid constants in a relational
operation with equality or inequality operators only.

[OrderID] ==
{513724e5-17b7-
4ec6-abc4-
0eae12c72c1f}

Yes

Numeric

Specify different numeric constant types in a string form using suffixes: 
* Int32 (int) - 1 
* Int16 (short) - 1s 
* Byte (byte) - 1b 
* Double (double) - 1.0 
* Single (float) - 1.0f 
* Decimal (decimal) - 1.0m 

[Price] == 25.0m Yes

You can build parameterized criteria using any number of positional parameters. To do this, add parameter placeholders
(question mark characters) to a criteria expression to identify parameter positions and provide a list of parameter values. When
building criteria, parameter placeholders are substituted with parameter values in values in the order they are listed.

CriteriaOperator.Parse("[Name] == ? and [Age] == ?", "John", 33)

The following two examples are identical, but the second one allows you to avoid formatting errors.

CriteriaOperator.Parse("[OrderDate] >= #1/1/2009#")

CriteriaOperator.Parse("[OrderDate] >= ?", new DateTime(2009, 1, 1))

When parameters are not specified, a parameter placeholder is substituted with null.

CriteriaOperator.Parse("[Region] != ?")

Collection Elements Verification
Use brackets "[]" to check if a collection contains an element that satisfies a condition. The following expression returns true if the



Accounts collection contains at least one element that satisfies the [Amount] == 100 condition:

[Accounts][[Amount] == 100]

The following expression returns false if the Accounts collection is empty:

[Accounts][]

Parent Relating Operator
Use the parent relating operator ('^' character) to refer to a parent in expressions written in the context of a child. You can apply
this operator successively to navigate multiple parent relationships. In the expression below, the "RegistrationDate" field refers to
a Customer (Orders' parent) and the "Date" field refers to Orders. This expression returns true if there is at least one Order that is
made on the day the parent Customer is registered:

"[Orders][[^.RegistrationDate] == Date]"

Grouping Clauses with Brackets
It is important to use brackets to ensure that your expression returns the intended results. For instance, the following expression
for objects of the Customer type returns all of the Customers where an Account exists with a Date of 8/25/2006 and where an
account exists with an Amount of 100:

[Accounts][[Date] == #8/25/2006#] && [Accounts][[Amount] == 100]

Construct the expression as in the following example to search for all Customers that have an Account with both a Date of
8/25/2006 and an Amount of 100:

[Accounts][[Date] == #8/25/2006# && [Amount] == 100]

Operator Precedence
When an expression contains multiple operators, their precedence controls the order in which expression elements are evaluated.

Literal values
Parameters
Identifiers
OR (left-associative)
AND (left-associative)
'.' relationship qualifier (left-associative)
==, !=
<, >, <=, >=
-, + (left-associative)
*, /, % (left-associative)
NOT
unary -
In
Iif
Trim(), Len(), Substring(), IsNull()
'[]' (for set-restriction)
'()'

The default precedence can be changed by grouping elements with parentheses. For instance, the operators are performed in a
default order in the first of the following two code samples. In the second code sample, the addition operation is performed first,
because its associated elements are grouped with parentheses, and the multiplication operation is performed last.



Accounts[Amount == 2 + 48 * 2]

Accounts[Amount == (2 + 48) * 2]

Case Sensitivity
Operators are case insensitive. Although field values’ case sensitivity depends on the data source.
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A data source affects certain operators' behavior. For instance, a data source can be configured as case insensitive. In this case, the
following expression always evaluates to true: Lower(Name) == Upper(Name)

Escaping Keywords
You can mark a keyword-like field name with an escape character (@ sign). In the expression below, the CriteriaOperator.Parse
method interprets @Or as the field named "Or", not the logical operator OR.

@Or = 'value'

Escape Characters
Use a backslash (\) as an escape character for characters in expressions. Examples:

\[
\\
\'

Retrieving Reference Properties
Note that while a criteria expression can return an object reference, this is not supported in all scenarios. Returning an object
reference by directly referencing a property, as in the following code snippet, is fully supported.

"Iif(Part is null, MyCustOrderLine.Part, Part)"

In this code snippet, the Part object, which the Part or MyCustOrderLine.Part property references, is returned correctly. However,
retrieving reference properties from functions is not supported. So, the following expression does not work.

"Iif(Part is null, MyCustOrderLine, MyCustOrderLine2).Part"

Note - Restrictions
Note the following restriction when exporting DevExpress Data Grid and Tree List controls (WinForms and WPF) to the XLS(X)
format in Data-Aware Export Mode:

Only expressions that contain export-friendly functions are exported to XLS(X) format. Refer to the XLS(x) Format Export-
Friendly column in the tables above to find out if a function can be exported to XLS(x) format.



Filter EditorFilter Editor
This section describes the capabilities provided by the Filter Editor, which allows users to visually build filters:

 

Topics in this section:

Filter Data via the Filter Editor
Examples of Using the Filter Editor



Filter Data via the Filter EditorFilter Data via the Filter Editor
Filter Editor
The Filter Editor is used to edit filter criteria. To create and customize filter criteria, use the  and  buttons embedded into the
control and context menus supported by the editor's elements:

Remarks

A filter condition group is a set of conditions combined by the same logical operator. The following filter expression contains two
groups combined by the logical OR operator: "([Product] = 'Chang' And [Quantity] > 20) Or ([Product] In ('Tofu', 'Konbu') And
[Quantity] < 100)". In the Filter Editor it's represented as follows:

For step-by-step examples of creating filter criteria, see Examples of Using the Filter Editor.

Add Conditions
To add a condition to a logical group, do one of the following:

Focus any condition within the group or the group's logical operator and then press INSERT or ADD on the keyboard.
Click the  button for the group.
Click the group's logical operator and select Add Condition.



To add a condition or a group of conditions that have been copied to the clipboard, press CTRL+V or SHIFT+INSERT. The new
condition will be added to the focused group.

Delete Conditions
To delete a condition, do one of the following:

Focus the condition and press DELETE or SUBTRACT.
Click the  button.

To delete a group of conditions, do one of the following:

Focus the group's logical operator and press DELETE or SUBTRACT
Click the group's logical operator and select Remove Group.

To delete all conditions, do one of the following:

Focus the topmost logical operator and press DELETE or SUBTRACT.
Click the topmost logical operator and select Clear All.

To cut a condition/group of conditions to the clipboard, focus this condition or the group's logical operator and press CTRL+X or
SHIFT+DELETE.

Clipboard Operations
To copy a condition or a group of conditions to the clipboard, focus this condition or the group's logical operator and press
CTRL+C or CTRL+INSERT.

To cut a condition or a group of conditions to the clipboard, focus this condition or the group's logical operator and press CTRL+X
or SHIFT+DELETE.

To paste a condition or a group of conditions from the clipboard to the focused group, press CTRL+V or SHIFT+INSERT.

Change a Column in a Filter Condition
To change a condition's column, invoke the column list by doing one of the following:

Click the current column.
Focus the current column via the keyboard and press SPACE or ALT+DOWN ARROW.

Then, choose the required column from the list that will be invoked

Change an Operator in a Filter Condition
To change a condition's operator, invoke the operator list by doing one of the following:

Click the condition's current operator.
Focus the current operator via the keyboard and press SPACE or ALT+DOWN ARROW

Then, choose the required operator from the list that will be invoked

Edit a Condition's Value
To edit a condition's value, click the operand value and type text.

To activate the operand value's edit box without changing the value, click the value or focus the operand value via the keyboard
and press F2, SPACE, ENTER or ALT+DOWN



To close the active edit box, press ENTER.

To discard changes to the value and close the active edit box, press ESC.

Navigation
To focus a specific filter condition or a group's operator within the Filter Editor, do one of the following:

Click the target element.
Use arrow keys to move focus via the keyboard.



Examples of Using the Filter EditorExamples of Using the Filter Editor
The Filter Editor allows you to filter data (display those records that meet specific requirements), by visually constructing filter
criteria in a straightforward graphical form.

The following sections demonstrate how to construct filter criteria using the Filter Editor.

How to Construct a Simple Filter Condition
Basically, filter conditions specify what data to select from a data source and display in a data-bound control. A typical simple filter
condition consists of three parts: the column/field name, operator and a value(s). For instance, '[Discount] >= 0.05' is a simple
filter condition, where '[Discount]' is a field name, '>=' is an operator and '0.05' is a value. This condition when applied to a data-
aware control will display records that have values in the Discount column greater than or equal to 0.05. Here is how to create this
condition via the Filter Editor (it's assumed that the underlying data source contains the Discount column, otherwise, this column
will not be accessible in the Filter Editor's column list):

1. Invoke the Filter Editor.

To invoke the Filter Editor in a grid control, right-click any grid column's header and select the Filter Editor option.

To learn how to invoke the Filter Editor for other controls, see corresponding sections in this documentation.

2. Select a column.

To filter against the Discount column, click the column name field. This will display the list of available columns. Select the
Discount column in this list:

3. Select a comparison operator.

Click the operator field to choose the required operator.



The comparison operator list displays only those operators that are supported by the current column's data type. For
instance, the Discount column is of the numeric type, and the operator list doesn't display the 'Begins with' operator and
other operators that are related to strings.

4. Enter a value.

Now, click the value box and enter a comparison value ('0.05'):

5. Save changes.

Click OK or Apply, to filter data using the created filter condition. The grid will show the filter panel displaying the current
filter criteria:

The filter panel will contain the 'Edit Filter' button, which also allows you to invoke the Filter Editor.

How to Construct Filter Criteria with Multiple Conditions Joined by One
Logical Operator
Filter criteria typically consist of two or more simple filter conditions combined by logical operators (AND, OR, NOT AND, NOT



OR). The following example shows how to construct filter criteria in the Filter Editor that consist of multiple conditions combined
by one logical operator. The "[ProductName] = 'Tofu' AND [Discount] >= 0.1 AND [Quantity] > 99" filter expression contains
three simple filter conditions combined by the AND operator. To construct it, do the following:

1. Invoke the Filter Editor. When the Filter Editor is invoked for a grid control, the Filter Editor may display an unfinished new
filter condition:

2. Set the condition's operator to Equals and operand value to 'Tofu' (as described in the previous section):

3. To add one more condition, press the  button next to the group's AND operator. This will create a new condition under the
current one:

4. For the second condition, set the column to 'Unit Price', operator to '>=' and operand value to '100':

5. To add a third condition to the same group, click the  button again. Set the condition's column to 'Units in Stock', operator
to '>' and operand value to '50'. Below is the result:



6. Click OK or Apply, to apply the created filter criteria.

How to Construct Filter Criteria Involving Different Logical Operators
Some filter criteria contain multiple logical (Boolean) operators combining simple filter conditions. For instance, you want to see
items whose price is under 10, and at the same time, the available quantity is also less than 10. At the same time, you may also
want to see those items whose price is over 10, while the available quantity is also greater than 10.

The resulting condition will look like this:

(Price is less than 10 AND Quantity is less than 10) OR (Price is greater than 10 AND Quantity is greater than
10)

This is how you can do this:

1. Invoke the Filter Editor.

2. Clear existing filter conditions (if any) by clicking the  button:

3. Change the root logical operator to OR. To do this, click the current AND operator and select OR:

4. Add a new filter condition group by clicking the OR operator and selecting Add Group.



5. For the created condition, set the column to 'UnitPrice', operator to '<' and operand value to '10':

6. Click the  button to add a new condition to the current group:

7. For the new condition, set the column to 'Quantity', operator to '<' and operand value to '10':

8. Add a new filter condition group. To do this, click the root OR operator and select Add Group.

9. For the condition within the created group, set the column to 'UnitPrice', operator to '>' and operand value to '10':

10. Click the  button to add a new condition to the new group. For the new condition, set the column to 'Quantity', operator to
'>' and operand value to '10':



11. Click OK or Apply, to apply the created filter criteria.



GridGrid
This section describes the capabilities provided by the Grid control, which represents data in a tabular or card form, supports data
editing, sorting, grouping, filtering, summary calculation and many other features:

 

Data Editing

Edit Grid Cells
Add and Delete Grid Records

 

Data Presentation

Sort Grid Rows
Group Grid Rows
Fix Grid Rows

 

Data Analysis

Filter Grid Data
Show Summaries (Totals) in Grids
Apply Cell Conditional Formatting

 

Layout Customization

Expand and Collapse Rows and Cards in Grids
Hide and Display Grid Columns, Bands and Card Fields
Rearrange Grid Columns, Bands and Card Fields
Resize Cards in Grids
Resize Grid Columns, Bands and Card Fields

 

Selection and Navigation

Locate Grid Records
Navigate Through Grid Records
Select Grid Rows and Cards



Edit Grid CellsEdit Grid Cells
Activate Cell Editor
Do one of the following:

Click a cell.
Focus a cell (for instance, via the keyboard), and press ENTER or F2.
Focus a cell and press any alpha-numeric key. The editor will be invoked and its contents will be replaced with the pressed
character.

Focus a cell and click the Navigator control's Edit button:

If a cell editor provides a dropdown, you can activate the editor and open its dropdown by pressing ALT+DOWN ARROW or F4.

Select and Deselect Cell Text
Press F2 or CTRL+A.

Close Cell Editor and Accept Changes Made
Do one of the following:

Press ENTER.

Click the End Edit button within the Navigator control:

Click any other grid cell.
Focus any other control.

Discard Changes
To discard changes made in a cell press ESC.

To discard changes made in all cells in a row/card, do one of the following:.

Press ESC twice.

Click the Cancel Edit button within the Navigator control:

Open Cell Editor's Dropdown
Do one of the following:

Press ALT+DOWN ARROW or F4.



Click the editor's dropdown button:

Close Cell Editor's Dropdown
For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with the keyboard
and pressing ENTER.

Change Values
Change D ate/T ime ValuesChange D ate/T ime Values

You can edit these cell values without opening the dropdown calendar. Position the caret at the portion of a date/time value that
needs to be changed. To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Numeric ValuesChange Numeric Values

To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Values of Cells That P rovide D ropdown I temsChange Values of Cells That P rovide D ropdown I tems

To select the previous value, press CTRL+UP ARROW. To select the next value, press CTRL+DOWN ARROW.

Note: this feature is not applicable to all editors.

Edit ImagesEdit Images

To copy, cut, paste, load and save images in image editors, right click the image and select the required command via the context
menu:



Add and Delete Grid RecordsAdd and Delete Grid Records
Add Records
Click the Append button within the Navigator control:

Delete Records
Click the Delete button within the Navigator control:



Sort Grid RowsSort Grid Rows
Sort Data in Grid Views
To sort records by a column's values and replace existing sort conditions that are applied to the current or other columns, click the
target column's header, until an Up or Down Arrow icon is displayed within the header. The Up and Down Arrows indicate
ascending and descending sort orders respectively.

To sort records by a column's values while preserving existing sort conditions, do one of the following:

Click a column header while holding the SHIFT key down, until an Up or Down Arrow icon is displayed within the header.

Right-click a column header and select Sort Ascending or Sort Descending from the context menu that appears:

To remove sorting by a column, click a column header while holding the CTRL key down. You can also select Clear Sorting from
the column header context menu.

Sort Data in Card Views
To sort records by a card field's values and replace existing sort conditions that are applied to the current or other fields:

1. Click the Customize button:

2. In the Customization window that opens, click the Sort button that corresponds to the target card field:



To sort records by a card field's values while preserving existing sort conditions:

1. Click the Customize button.
2. In the Customization window that opens, click the Sort button that corresponds to the target card field, while holding the

SHIFT key down.

To remove sorting by a card field:

1. Click the Customize button.
2. In the Customization window that opens, click the Sort button that corresponds to the target card field, while holding the

CTRL key down.

Sort Data in Layout Views
To sort records by a card field's values and replace existing sort conditions that are applied to the current or other fields, do the
following:

1. Hover over the target card field within any card. The sort ( ) and filter buttons will appear.

2. Click the sort button until its image changes to a black arrow (  or ). These images indicate ascending and descending
sort orders respectively.

To sort records by a card field's values while preserving existing sort conditions:

1. Hover over the target card field within any card. The sort and filter buttons will appear.
2. Hold the SHIFT key down and click the sort button until its image changes to a black arrow (  or ).

To remove sorting by a card field:

1. Hover over the target card field within any card. The sort and filter buttons will appear.
2. Hold the CTRL key down and click the sort button until its image changes to two arrows ( ).



Group Grid RowsGroup Grid Rows
Group Data
To group by a specific column, do one of the following:

Drag a column header from the column header panel to the group panel:

Right-click a column header and select Group By This Column from the context menu:

Ungroup Data
To ungroup data by a grouping column, do one of the following:

Drag a column header from the group panel to the column header panel:



Right-click a grouping column's header and select UnGroup from the context menu:

To remove grouping by all columns, right click the group panel and select Clear Grouping from the context menu:

Change Group Order
To change group order, move a grouping column header to another position within the group panel:



Fix Grid RowsFix Grid Rows
Some applications allow you to fix grid rows at the top or at the bottom of the grid. Fixed rows remain visible while the grid
content is scrolled vertically.

�� N o t eN o t e

The following steps may vary depending on an application vendor.

Fix a Row
To fix a grid row, do one of the following.

Click the Fix Row  button located at the left side of a grid row.

Choose the required fixed row position from the popup menu.

Right-click a grid row.

Choose the required fixed row position from the context menu.

Change a Fixed Row's Position
To unfix a row or change a fixed row's position, do one of the following.

Click the Unfix Row  button located at the left side of a fixed grid row.

From the popup menu, choose the required fixed row position. Select None to unfix a grid row.



Right-click a fixed grid row.

Choose the required fixed row position from the context menu. Select Unfix to unfix a row.



Filter Grid DataFilter Grid Data
Invoke the Filter Dropdown List

In Grid Views, hover over the column header. Click the filter button ( ) within the column header that appears.

In Card Views, click the Customize button and then click the Filter button corresponding to the target column.

In Layout Views, hover over the target card field within any card. Click the filter button ( ) that appears.

Create a Simple Filter Condition
To select records that contain a specific value in a specific column/card field, do the following:

1. Invoke the filter dropdown list containing available filter values.

By default, if filtering is applied, the filter dropdown will only display the values which match the current filter criteria. If the
SHIFT key is pressed while opening the filter dropdown, all values will be listed (not only those that match the current filter
criteria).

2. Select the required filter value in the filter dropdown list:



The filter dropdown list will be immediately closed, and the control will display the records which contain the specified value
in the specified column/card field.

If the filter dropdown list provides check boxes to the left of filter values, multiple values can be selected (checked)
simultaneously:

In this mode, click OK to close the filter dropdown list and apply the filter.

You can sequentially filter data against multiple columns using the method described above.

Use Microsoft Excel Style Custom Filter Dialog
To construct filter criteria involving up to two conditions, do the following:

Invoke the filter dropdown list (see above) and click Custom. This will invoke the Custom Filter Dialog, allowing you to
compare a column with one or two values:

Use Advanced Filter Editor Dialog
To invoke an advanced Filter Editor dialog, do one of the following:

Right-click any column's header and select Filter Editor:



If the filter panel at the bottom of the grid control is visible, click the Edit Filter button:

To learn how to work with the Filter Editor, refer to Filter Data via the Filter Editor.

Clear the Filter
To clear the filter applied to a specific column, do one of the following:

Invoke the filter dropdown list (see below) and click (All).
In Grid Views, right-click the column header and select Clear Filter:

To clear all filter criteria, click the Close Filter button within the Filter Panel:

Disable/Enable the Filter
Click the Enable Filter button within the Filter Panel:



Filter Grid Data via Find PanelFilter Grid Data via Find Panel
The Find Panel provides an easy way of searching against visible columns/card fields. Displayed above the grid, the panel contains
a search box where you can type a search string.

Invoke the Find Panel
Ensure that no cell editor is active and press Ctrl+F.

or

In Grid Views, choose the Show Find Panel command from a column menu.

Search
Enter a search string in the search box. In most cases, rows are filtered automatically after a short while.
In some cases (mostly when the grid is bound to a large amount of data), you need to press the Find button to manually
start the search.

The search syntax is described below.

Clear the Search Box
Press ESC or click the Clear button.

Close the Find Panel
Click the 'x' button to the left of the search box or:



If the search box is empty, press ESC (the shortcut is in effect if the search box has focus);
If the search box is not empty, press ESC twice (the shortcut is in effect if the search box has focus).

Search Syntax
In its simplest form, a search criterion consists of a single word. If you want to search for a string containing a space character,
specify this string in quotation marks. Without quotation marks, words separated by the space character are treated as individual
conditions.

You can search against a specific column by preceding a search string with the column's display name plus a colon character.

ColumnDisplayName:SearchString

Instead of the complete name, it is possible to partially specify the display name, using the initial characters of a column's display
name. A search will be performed against the first column whose display name starts with the specified substring. If you want to
search against a column whose display caption contains space characters, specify the column's display caption in quotation
marks.

If the search string contains multiple conditions separated by space characters, and at least one condition defines a search against
a specific column, only records that match all of these conditions are shown (i.e., the conditions are combined by the AND logical
operator). If there is no column specification, records that match at least one of these conditions are shown (i.e., the conditions are
combined by the OR logical operator).

Precede a condition with "+" to display only records that match this condition. The "+" specifier allows you to implement the
logical AND operator. There should be no space character between the "+" sign and the condition.

Precede a condition with "-" to exclude records that match this condition from the result set. There should be no space between
the "-" sign and the condition.

Examples

S E AR CH CR ITER IA D ES CR IPTION

register Selects records that contain the "register" string in any search column.

check register Dave Selects records that contain either "check" OR "register" OR "Dave" strings in any search column.

"check register" Selects records that contain "check register" in any search column.

screen +"Richard
Fisher" Selects records that contain both "screen" AND "Richard Fisher" in search columns.

Product:Tofu Seattle Selects records that contain "Tofu" in the column that starts with "Product", AND also contain "Seattle" in
any search column.

data +entry -mark Selects records that contain both "data" AND "entry" in search columns, excluding records that contain
"mark".

menu mask -file Selects records that contain "menu" OR "mask", excluding records that contain "file".

From:Roller
Subj:"currency mask"

Selects records that contain "Roller" in the column that starts with "From", AND also contain "currency
mask" in the column that starts with "Subj".

import -From:Steve Selects records that contain "import" in any search column, excluding records that contain "Steve" in the
column that starts with "From".
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Searches performed using a Find Panel are case insensitive.



Show Summaries (Totals) in GridsShow Summaries (Totals) in Grids
To change the type of summary for a specific column or apply a summary, do the following:

1. Right-click a region within a group footer or grid footer under a specific column:

A context menu displaying a list of supported summary types will be displayed:

2. Select the required option from the context menu.



Apply Cell Conditional FormattingApply Cell Conditional Formatting
You can highlight certain column cells that meet a specific condition using the Conditional Formatting menu. To invoke this
menu, right-click the column to which a formatting rule should be applied and select Conditional Formatting.

Available format rules are displayed when expanding the Conditional Formatting menu. Different options are supported for
different columns (depending on the type of data a clicked column displays).

Highlighting Cells that Meet a Specific Condition
Choose the Highlight Cell Rules menu item.

Select the condition type. You can use one of the predefined conditions (the Greater Than..., Less Than.., Between... and
Equal To... menu items), provide a custom condition (the Custom Condition.. item) or format cells that contain the
specified text (Text that Contains...) or refer to a certain date interval(s) (A Date Occurring...).

Based on the selected condition type, an appropriate dialog window is invoked. You need to either enter a constant to be
compared with the column's values, or select desired check boxes related to dates, or construct a custom condition in the
dedicated editor. After that, choose a format style in the dropdown list, and click the OK button. To apply formatting to an
entire row instead of a single cell, select the corresponding check box.



Highlighting Top or Bottom Cell Values
Choose the Top/Bottom Rules menu item.

Select the rule type. You can highlight cells that contain the highest or lowest values (the Top 10%..., Bottom 10%..., Top
10 Items... and Bottom 10 Items... menu items), and values that are above or below the column's average (Above
Average and Below Average).

According to the selected rule type, an appropriate dialog window is invoked. Enter a cutoff value (where required), choose a
format style in the dropdown list, and click the OK button. To apply formatting to an entire row instead of a single cell, select
the corresponding check box.

Highlighting Unique or Duplicate Cell Values
Choose the Unique/Duplicate Rules menu item.

Select the rule type.

In the invoked dialog window, choose a format style in the dropdown list, and click the OK button. To apply formatting to an



entire row instead of a single cell, select the corresponding check box.

Highlighting Cells Using Data Bars
A data bar fills a cell according to the ratio of the cell's value to the highest and smallest column values. A longer bar corresponds
to a higher value, and a shorter bar corresponds to a lower value.

To apply a data bar format, do the following:

Choose the Data Bars menu item.

Select the bar style format. Solid bars and bars with gradient fills are available in various colors.

Applying Color Scales
This format shows data distribution and variation using color scales. A cell is filled with the background color that is calculated
according to the ratio of the cell's value to the highest and smallest column values. A two-color scale specifies two colors, which
represent the minimum and maximum column values. Cell values residing between the minimum and maximum values are
painted using a shade of these colors. A three-color scale additionally defines a color for the middle value and so, uses a gradation
of three colors.

Choose the Color Scales menu item.



Select one of the predefined two or three-color scales.

Highlighting Cells Using Predefined Icons
Icon sets allow you to classify column values into several ranges separated by threshold values, and display a specific icon in a
column cell according to the range to which this cell value belongs. In the Positive/Negative group, the available icon sets divide
column values into three ranges: positive values, negative values and values equal to zero.

Other icon sets divide column values into three, four or five ranges, displaying a specific icon for each range. If an icon set
contains three icons, the ranges are as follows: [0%-33%), [33%-67%) and [67%-100%], where 0% corresponds to the smallest
column value and 100% corresponds to the largest column value. The icon sets with four icons classify column values into four
ranges: [0%-25%), [25%-50%), [50%-75%) and [75%-100%]. For the icon sets that contain five icons, the target ranges are: [0%-
20%), [20%-40%), [40%-60%), [60%-80%) and [80%-100%].

Choose the Icon Sets menu item.

Select one of the predefined icon sets.

Deleting Rules
If you have already applied one or more rules to columns, the additional Clear Rules item is displayed at the second level of the
Conditional Formatting menu.

You can do one of the following.



To delete conditional formatting rules from the target column, click the Clear Rules from This Column menu item. If the
column has no rules applied to it, this item is not shown.

or

To delete formatting rules from all columns, click the Clear Rules from All Columns menu item .



Expand and Collapse Rows and Cards in GridsExpand and Collapse Rows and Cards in Grids
Expand/Collapse Group Rows in Grid Views
To expand/collapse a group row, do one of the following:

Click the row's expand button:

Double-click the group row.

Double-click the indicator cell corresponding to the group row:

Focus the group row and press PLUS (to expand the row) or MINUS (to collapse the row).
Focus the group row and press RIGHT ARROW (to expand the row) or LEFT ARROW (to collapse the row).

To expand or collapse all group rows, right-click the group panel at the top of the control. This opens the group panel context
menu. Then select Full Expand or Full Collapse respectively:

Expand/Collapse Master Rows in Grid Views
To expand/collapse a master row, do one of the following:

Click the master row's expand button:

Double-click the indicator cell corresponding to the master row:



Focus the master row and press CTRL+PLUS (to expand the row) or CTRL+MINUS (to collapse the row).

Expand/Collapse Cards in Card and Layout Views
Do one of the following:

Click a card's Expand button:

Click a card's caption and press PLUS (to expand the card) or MINUS (to collapse the card).



Hide and Display Grid Columns, Bands and Card FieldsHide and Display Grid Columns, Bands and Card Fields
Hide Columns/Bands in Grid Views
Do one of the following:

Click a column header/band header and drag it onto the grid control's cell area, until the cursor changes its image to a big
'X'. Then drop the header.

Drag and drop a column/band header onto the Customization Form if it's open:

Display Hidden Columns/Bands in Grid Views
1. Open the Customization Form by right-clicking a column header and selecting Column Chooser:

The Customization Form will be displayed listing hidden columns and bands (if any):



2. Drag the required column/band from the Customization Form onto the column/band header panel and drop it at a specific
position.

�� N o t eN o t e

When a band is hidden together with its child bands and columns, headers of hidden children are not displayed within the
Customization Form.

Change the Visibility of Fields in Card Views
1. Click the Customize button:

2. To hide specific fields, clear corresponding check boxes in the opened window. To display hidden items, enable
corresponding check boxes:

Change the Visibility of Fields in Layout Views
1. Click the Customization button within the header panel:



2. To hide a field, in the Layout View Customization Window, drag and drop the field from the Template Card onto the Hidden
Items list. To display a hidden field, drag it from the Hidden Items list onto the Template Card at the required position:

3. Click OK or Apply.



Rearrange Grid Columns, Bands and Card FieldsRearrange Grid Columns, Bands and Card Fields
Reorder Columns and Bands in Grid Views
To reorder columns, drag and drop a column header to a new position:

To reorder bands, drag and drop a band header to a new position:

Rearrange Card Fields in Layout Views
Do the following:

1. Click the Customization button displayed within the header panel:

The LayoutView Customization window will open:



2. Rearrange fields using drag and drop, as required.
3. Close the Customization window to apply the changes.



Resize Cards in GridsResize Cards in Grids
Resize Cards in Card Views
In Card Views, to resize cards horizontally, drag card separators (if they are visible):

Resize Cards in Layout Views
In Layout Views, to resize cards do the following:

1. Click the Customization button displayed within the header panel:

The LayoutView Customization window will open:

2. Resize the template card as required.



3. Close the Customization window to apply the changes.



Resize Grid Columns, Bands and Card FieldsResize Grid Columns, Bands and Card Fields
Resize Columns and Bands in Grid Views
To resize columns and bands, drag the right edge of the target column/band header:

To change a column's width so that it displays its contents compactly in their entirety, do one of the following:

Double-click the right edge of the column header.

Right-click the column's header and select Best Fit:

To change the widths of all columns so that they display their contents in the best possible way, right-click the header of any
column and select Best Fit (all columns).

Resize Card Fields in Layout Views
To resize cards or card fields do the following:

1. Click the Customization button displayed within the header panel:



The LayoutView Customization window will open:

2. Resize the template card and/or fields within the template card as required.
3. Close the Customization window to apply the changes.



Locate Grid RecordsLocate Grid Records
In Grid Views, you can locate a data row by typing the initial characters of the values contained in this row.

To locate the nearest row that contains a specific value in a specific column, do the following:

Focus any cell in the column, against which a search will be performed.
Type the initial character(s) of the value to be located. The nearest row that contains the specified value in the clicked
column will be located.

To proceed with the search in the forward direction, press CTRL+DOWN ARROW.

To proceed with the search in the backward direction, press CTRL+UP ARROW.

To erase the previously typed characters in the search string, press BACKSPACE.



Navigate Through Grid RecordsNavigate Through Grid Records
Move Focus Between Rows and Cards
To move focus between cells and rows use the ARROW, TAB, HOME, END, PAGE UP and PAGE DOWN keys. Note that the
ARROW, HOME and END keys are used for navigation between rows/cards only when the focused cell is not being edited.
Othewise, these keys affect focus movement within the currently edited cell.

To focus the next cell, do one of the following:

Press TAB.
In Grid Views, press RIGHT ARROW. In Card Views and Layout Views, press DOWN ARROW. If a cell editor is active,
pressing RIGHT ARROW moves focus to the next cell if the caret is positioned at the end of the current cell's text, or if the
cell's text is selected in its entirety.

To focus the previous cell, do one of the following:

Press SHIFT+TAB.
In Grid Views, press LEFT ARROW. In Card Views and Layout Views, press UP ARROW. If a cell editor is active, pressing LEFT
ARROW moves focus to the previous cell if the caret is positioned at the beginning of the current cell's text, or if the cell's
text is selected in its entirety.

To focus the first cell within the current row in Grid Views, press HOME.

To focus the last cell within the current row in Grid Views, press END.

To focus the first row/card:

press CTRL+HOME in Grid Views.
press HOME or CTRL+HOME in Card Views and Layout Views.

To focus the last row/card:

press CTRL+END in Grid Views.
press END or CTRL+END in Card Views and Layout Views.

To move focus to the Auto Filter Row displayed at the top of a Grid View, do one of the following:

Click this row.
If a top data row is focused, press CTRL+UP ARROW.

Move Focus Away From the Grid Control
Press CTRL+TAB or CTRL+SHIFT+TAB.



Select Grid Rows and CardsSelect Grid Rows and Cards
Select Individual Rows/Cards
To select a row/card and clear the existing selection, do one of the following:

In Grid Views, click the row's indicator cell or any of its data cells:

In Card and Layout Views, click the card's caption or any of its data cells.
Select the row/card using the ARROW keys.

Select Multiple Rows or Cards
To select a row/card while preserving the current selection, do one of the following:

In Grid Views, click the row's indicator cell or any of its data cells, while holding the CTRL key down.
In Card and Layout Views, click the card's caption or any of its data cells, while holding the CTRL key down.

To toggle the focused row's/card's selected state, do one of the following:

Press CTRL+SPACE.
Click the row/card while holding the CTRL key down.

To move focus between rows and cards while preserving the current selection, use CTRL+ARROW keyboard shortcut (supported
by Grid and Card Views).

Select a Range of Rows/Cards
To select all rows/cards, press CTRL+A (supported by Grid and Layout Views). Before pressing this shortcut, ensure that the
focused cell is not being edited

To select a continuous range or rows/cards, you can do the following

Use ARROW, PAGE UP, PAGE DOWN keys while holding the SHIFT key down.

To select all rows/cards between the currently focused row/card and another one, click the target row/card while holding
the SHIFT key down.

�� N o t eN o t e

If the SHIFT key is combined with CTRL, the previously selected rows/cards, if there are any, are not unselected. If you use
the SHIFT key alone, the previously selected rows/cards are unselected.

To select a continuous range of cards in Layout Views, drag with the mouse around cards that are to be selected (marquee
selection).

Copy Selected Records to the Clipboard



Press CTRL+C or SHIFT+INS.



Layout ManagerLayout Manager
This section describes the capabilities provided by the Layout Manager. It maintains a consistent layout of controls within a form
for you, so whenever you resize the form, the controls do not overlap. You can invoke customization mode to temporarily hide
specific editors, and then show them again, resize the controls, save and then restore the layout, etc.

 

Layout Customization

Start Layout Customization
Finish Layout Customization
Hide and Display Elements using a Layout Manager
Change Element Layout
Resize Interface Elements
Add Empty Regions, Separators, Splitters and Labels
Change Text Label Options
Work with Interface Element Groups
Create and Delete Tabbed Groups

 

Save and Restore Layout

Save and Restore Interface Layout



Start Layout CustomizationStart Layout Customization
The layout of controls can be modified in customization mode. To invoke customization mode, right-click an empty space within
the Layout Manager and select Customize Layout:

As a result, the Customization Form opens a list of service items and currently hidden elements:

Now, you can modify the current layout using drag-and-drop and resizing operations and commands provided by context menus.
Context menus that can be invoked by right-clicking within the Layout Manager provide various customization commands.
Different commands are available depending upon the type of a layout item which has been right-clicked (a regular control, a
group or tabbed group).



Finish Layout CustomizationFinish Layout Customization
To finish customization, do one of the following:

Close the Customization form by clicking on its close button.

Right-click the form and select Hide Customization Form.



Hide and Display Elements using a Layout ManagerHide and Display Elements using a Layout Manager
To perform layout customization, first invoke Customization Mode. After customization has been completed, exit customization
mode.

Hide an Element
Do one of the following:

Right-click on the layout item and select Hide Item from the context menu:

Drag the layout item onto the Hidden Items list of the Customization Form.

Display a Hidden Element
Drag the required item from the Customization form's Hidden Items list onto the main form.



Change Element LayoutChange Element Layout
To perform layout customization, first invoke Customization Mode. After customization has been completed, exit customization
mode.

Change Element Layout
To rearrange items within the form, use drag-and-drop operations.



Resize Interface ElementsResize Interface Elements
To perform layout customization, first invoke Customization Mode. After customization has been completed, exit customization
mode.

Resize Layout Items
To resize a layout item, drag the layout item's edge:

Lock Size
To lock a layout item's size, and prevent it from being resized (for instance, when the size of the container changes), right-click on
a layout item and select the Size Constraints | Lock Size menu command:



Add Empty Regions, Separators, Splitters and LabelsAdd Empty Regions, Separators, Splitters and Labels
To perform layout customization, first invoke Customization Mode. After customization has been completed, exit customization
mode.

Add Empty Regions
Empty regions enable greater control over element layout. They can be used, for example, if you want elements to be aligned to
the right or bottom edge of a resizeable container. To add an empty region, do one of the following:

Drag the Empty Space Item from the Customization form and drop at the required position on the form.

Right-click the Layout Control and select Create EmptySpace Item from the context menu:

A new empty region will be added at the bottom of the Layout Control. Then, drag this item to the required position.

Add Splitters
To allow controls to be resized even when no customization is being performed, you can add a splitter between these controls. To
add a splitter, drag the Splitter item from the Customization form onto the main form.

Add Separators
A separator is just a line that allows you visually separate the Layout Control's areas. To add a separator, drag the Separator item
from the Customization form onto the main form.

Add Labels
To add a static text label to the Layout Control, do the following:

1. Drag the Label item from the Customization form onto the main form.
2. To rename the label, right-click the created label and select Rename from the context menu.



Change Text Label OptionsChange Text Label Options
To perform layout customization, first invoke Customization Mode. After customization has been completed, exit customization
mode.

Rename Labels
To rename a layout item's text label, right-click the item and select Rename from the context menu.

To rename a group, right-click the group's caption and select Rename.

Change a Label's Visibility
To hide a layout item's text label or a group's caption, right-click the item/group and select Hide Text from the context menu.

To display a layout item's hidden text label or a group's hidden caption, right-click the item/group and select Show Text.

Change a Label's Position
To change the position of an item's label or a group's caption, right-click the item/group to open the context menu. Then, select
Text Position and the required command from this submenu.



Work with Interface Element GroupsWork with Interface Element Groups
To perform layout customization, first invoke Customization Mode. After customization has been completed, exit customization
mode.

Combine Layout Items into Groups
1. Select a layout item that is to be added to a new group by clicking it.

You can select multiple items simultaneously by clicking them while holding the SHIFT key down.

2. Right-click any of the selected layout items and select Group from the context menu:

Note that only adjacent selected layout items can be combined into a group, and only if the region occupied by them forms
a rectangle. Otherwise, the Group command is not available when right-clicking the selection.

As a result, a new group is created:

You can subsequently rename the group and customize its contents using drag-and-drop and context menus if required.

Rename Groups
Do the following:

1. Right-click the group's caption and select Rename:



2. Type a new name and press ENTER.

Change Group Content
To customize the layout of controls within a group, use drag-and-drop.

Ungroup Elements
To ungroup elements, right-click the group's caption and select Ungroup:



Create and Delete Tabbed GroupsCreate and Delete Tabbed Groups
To perform layout customization, first invoke Customization Mode. After customization has been completed, exit customization
mode.

Combine Layout Items into a Tab Control
1. Select a layout item that is to be added to a tab control by clicking it.

You can select multiple items simultaneously by clicking them while holding the SHIFT key down.

2. Right-click any of the selected layout items and select Group from the context menu:

Note that only adjacent selected layout items can be combined into a group, and only if the region occupied by them forms
a rectangle. Otherwise, the Group command is not available when right-clicking the selection.

As a result, a new group is created:

3. Right-click the group's caption and select Create Tabbed Group.

This creates a tab control with one tab displaying the contents of the original group.



You can subsequently rename the created tab and customize the contents of tab pages using drag-and-drop and context menus,
if required.

Combine Groups into a Tab Control
To transform a group into a tab control, right-click the group's caption and select Create Tabbed Group.

To add a group as a tab page to an existing tab control, drag the group's caption onto the tab control's header area.

Rename Tab Pages
Do the following:

1. Right-click a tab header and select Rename:

2. Type a new name and press ENTER.

Customize Tabbed Groups
To customize the layout of controls and the order of tab pages within a tab control , use drag-and-drop.

Ungroup Tabbed Groups



To disassemble a tab control into regular groups, right-click the tab control's header area and select Ungroup Tabbed Group.

As a result, the tab control will be destroyed and all its tab pages will be displayed as regular groups, one below another.



Save and Restore Interface LayoutSave and Restore Interface Layout
You can save the current layout of controls to an XML file, and subsequently, restore it.

Save the Layout of Controls
1. Invoke Customization mode.
2. In the Customization form that opens, click the Save Layout button ( ).
3. The Save As dialog will appear. It allows you to specify the XML file to which the layout is to be saved.

Load a Layout of Controls
1. Invoke Customization mode.
2. In the Customization form that opens, click the Load Layout button ( ).
3. The Open File dialog will appear. It allows you to specify the XML file from which the layout is to be loaded.



MapMap
The section describes the Map control's features and consists of the following topics:

Scrolling
Zooming
Selection
Using the Search Panel
Mini Map
Map Editor



ScrollingScrolling
The following operations can be performed by end-users to scroll a map.

ACTION E X AMPLE D ES CR IPTION

Hold down
the left mouse
button and
drag it.

When an end-user holds down the left mouse button, the mouse pointer changes from 
to . Move the mouse pointer by holding down the left mouse button. The map is
scrolled in the same direction as the mouse pointer is moved.

Use the
arrows in the
map
navigation
panel.

An end-user can scroll a map in four directions by clicking the arrows in the map navigation
panel. For example, to move east, use the right arrow in the navigation panel.

Use the
"Arrow" keys
(LEFT, UP,
RIGHT or
DOWN).

If an end-user presses the LEFT arrow key, the map is moved west; if an end-user presses
the UP arrow key, the map is moved north; if an end-user presses the RIGHT arrow key, the
map is moved east; if an end-user presses the DOWN arrow key, the map is moved south.

Use flick
gestures on a
touchscreen
device.

An end-user can scroll a map using flick gestures on a touchscreen device.



ZoomingZooming
The following operations can be performed by end-users to zoom in to or out of a map.

ACTION E X AMPLE EFFECT

Use the Plus
or Minus
symbols in the
map
navigation
panel

Click the Plus or Minus symbols in the map navigation panel.

Use the track
bar slider in
the map
navigation
panel.

Select the track bar slider in the map navigation panel by hovering the mouse cursor over the
slider. Drag the track bar slider to the right (zoom in) or to the left (zoom out) in the map
navigation panel. To stop zooming, release the left mouse button. Note that a tooltip that
displays the current zoom level appears below the track bar slider.

Drag an area
on the map
while holding
the Shift and
Ctrl keys.

Hold the Shift and Ctrl keys, and the left mouse button. Then, drag the mouse pointer. This
draws a rectangle on the map that corresponds to the map zoom region. To zoom into the
specified rectangular area, release the left mouse button.

Use the + or -
keys.

If the "+" key is pressed, the map is zoomed in. If the "-" key is pressed, the map is zoomed
out.

Use the
mouse wheel Scroll the mouse wheel to zoom in to and out of a map.

Use the
spread or
pinch gesture
on a
touchscreen
device

 Zoom in to or out of a map by performing a spread or pinch gesture on any touchscreen
device.



SelectionSelection
To select a map item, do one of the following:

Tap a map item on a touchscreen device;
Hover over a map item with the mouse pointer and click it.

To select multiple map items, do the following:

Hold the Shift key and the left mouse button;
Drag the mouse pointer, to mark an area that includes the desired map items;
Release the left mouse button. All map items within the area will be selected.



Using the Search PanelUsing the Search Panel
This document explains how to use a search panel in the Map control.

The Search Panel is a UI element that accepts text input and displays the results of a search request returned by the search
service.

The Search Panel allows you to find a location on the map and see the search results for a request in the panel.

To start a search, type a place name ("Texas", for example) in the panel. The result is shown in the image below.

To cancel a request, click the delete ( ) icon on the right side of the panel.

Notice that the map pushpin only shows the "Houston, TX" location on the map. Note, however, that the search result also
displays the Show others… item, which means that the Microsoft Bing Search service found alternative results for this request.

Click the Show others... option to see the other search results.

Other search results ("Texas, Heard Co., GA", "Texas, QLD, Australia", etc.) will be displayed along with the Show best result…
option.



To see only "Houston, TX", click Show best result… in the Search panel.



Mini MapMini Map
The Mini Map provides a complete overview of the map, as well as additional information about the current map viewport, and
allows you to navigate to different map regions.

The mini map supports the following behavior modes.

Fixed

When a mini map operates in fixed behavior mode, its center point and zoom level are fixed. The following image demonstrates
fixed behavior mode.

Note that center point of the mini map stays the same when the map's center point changes, as well as the zoom level.

Dynamic

In a dynamic behavior mode, mini map settings are changed according to the zoom level and center point of the owner map. The
following image demonstrates dynamic behavior mode.

Note that center point of the mini map is changing depending on the map's center point, as well as the zoom level.





Map EditorMap Editor
The Map Editor is a built-in tool that allows you to create and modify map items. You can also relocate map items on the map
surface, rotate them using a rotation handle, and resize items using the sizing handles. The Map Editor's active mode determines
which actions you can perform while editing the map. Use the corresponding editor panel buttons to switch between the Default,
Transform, Edit and Create modes.

Map Editor's Panel
The Map Editor's panel consists of the following elements:

 - Cancels the last action.
 - Restores the last canceled action.
 - Enables Default mode.
 - Activates Transform mode.
 - Turns on Edit mode.
 - Enables "Create Pushpin" mode to create pushpins.
 - Enables "Create Path" mode to create map paths.
 - Activates "Create Polyline" mode to create map polylines.
 - Enables "Create Dot" mode to create map dots.
 - Enables "Create Ellipse" mode to create ellipses.
 - Turns on "Create Rectangle" mode to create map rectangles.
 - Enables "Create Line" mode to create map lines.

Map Editor Modes
The Map editor provides the following modes that define the available actions when editing a map:

D efault ModeD efault Mode

You can only view the map in Default mode. You can use the  button to turn on this mode.

Transform ModeTransform Mode

Select the  symbol to enable the Transform mode. This mode allows you to resize and rotate the selected map items using the
sizing and rotation handles. You can also move map items by dragging them.



Edit ModeEdit Mode

Use the  button to enable the Edit mode. It allows you to move, add, and remove item vertices to change vector map shapes. To
edit a map item in this mode, select an item to display its points and perform one of the following actions:

ACTION ANIMATION D ES CR IPTION

Moving
vertices Relocate a shape's point by dragging it.

Adding
vertices

Hover the mouse pointer over the item's edge between two neighboring points and
click where you want to insert a new vertex.

Removing
vertices Remove a shape's point by double-clicking it.

Note that you can only edit the following map vector items:

Map line
Map path
Map polygon
Map polyline

Create ModeCreate Mode

Create mode allows you to add new items to the map. Select one of the following symbols to create map items:       

You can add dots and pushpins by clicking on the required location. To create a complex map item, add points sequentially to
form a map item. The following animation shows how to create a map path:





Navigation BarsNavigation Bars
This section describes the capabilities provided by the Navigation Bars.

 

Topics in this section:

Navigation Pane
Navigation Bar



Navigation PaneNavigation Pane
Expand Groups
A Navigation Pane displays only one group at a time. Other groups are collapsed and their buttons are displayed at the bottom or
in the Overflow panel. You can use the horizontal splitter to control the number of group buttons shown outside of the Overflow
panel.

To activate a group, click its caption button.

Minimize the Navigation Pane
To minimize the Navigation Pane, click the Minimize button:

Display the Contents of the Minimized Navigation Pane
To display the contents of a minimized Navigation Pane, you can restore it to its normal state, or display its contents while it's in
the minimized state.

To restore the minimized Navigation Pane to its normal size, click the Maximize button:



To display the contents of the Navigation Pane when it's in the minimized state, click the current group's button:

To display the contents of the group that is currently hidden, do the following:

1. Click the dropdown button at the bottom of the Navigation Pane:

2. Select the required group in the menu that opens:

3. Click the current group's button:





Navigation BarNavigation Bar
Expand Groups in the Navigation Bar That Can Display Multiple Groups
at One Time
Windows Explorer Bar style navigation bars can display multiple groups at one time, as in the image below:

To collapse a specific expanded group, click the expand button within the group's header:

To expand a specific collapsed group, click the collapse button:

Expand Groups in the Navigation Bar That Displays One Group at a Time
To expand a specific collapsed group, click the group's button. The previously opened group will be collapsed.



PDF ViewerPDF Viewer
This section describes the capabilities of the PDF Viewer.

The PDF Viewer used to displaying PDF files and supports various document content such as text, images, vector graphics, etc.

The following sections are available in this guide.

Manage Documents and Files
Print Documents
Navigate and View a Document
Adjust the Document View
Select and Copy the Document Content
View Document Properties
Thumbnails
Bookmarks
File Attachment
Export and Import the AcroForm Data



Manage Documents and FilesManage Documents and Files
This document describes how to open and save PDF files using the PDF Viewer.

This topic consists of the following sections.

Open a PDF File
Save a PDF File

Open a PDF File
To open a document for viewing, click the Open button, or press Ctrl+O.

In the invoked dialog, choose a PDF file and click Open.



Save a PDF File
If you need to save your PDF file to disk, click the Save As button, or press Ctrl+S.

In the invoked Save As dialog, locate the folder where you want to store your file, enter the document's name and click Save.



Your document will be saved with the .pdf file extension.



Print DocumentsPrint Documents
To print the current document, click the Print command located on the File toolbar button group, or press CTRL+P.

In the invoked standard Print dialog, choose the printer, specify the printing parameters and click Print.

Alternatively, to invoke the Print dialog, right-click the document area and select the Print...  item in the context menu.



Navigate and View a DocumentNavigate and View a Document
This document provides information on using the PDF Viewer user interface to navigate through the document content.

The topic consists of the following sections.

Navigate Between Pages
Navigate Between Viewes
Search for a Specific Text

Navigate Between Pages
To navigate between pages, use one of the following.

The scrollbars.

Previous and Next navigation buttons.

These buttons allow you to switch to the previous or next page of a document.

The Pager that is used to show the current page number and the total number of pages in a document.

To change the page number in the Pager, type a new page number and press ENTER.

The Bookmarks panel located on the Navigation pane.

To jump to a topic, click a bookmark.

The Page Thumbnails panel located on the Navigation pane.



To jump to the page in a document, click a page thumbnail in the Page Thumbnails panel.

Navigate Between Views
To change the page view, use one of the following.

Right-click this document and select the Previous View  or Next View  item in the invoked context menu.

or...

press Alt+Left or Alt+Right.

Move a page with the Hand tool.

The Hand tool enables you to scroll content by dragging the document instead of using scrollbars.

To activate the Hand tool, right-click the viewing document and select the Hand Tool  item in the context menu.



Then, after you click the document's page, the mouse pointer is changed from  to . Drag the mouse pointer to scroll
the document.

Use zoom toolbars to change page magnification. For more details, see the Adjust the Document View topic.

Search for a Specific Text
To search for a specific text within a document, click the Find button on the toolbar.

To invoke the Find dialog using the context menu, right-click the document and select the Find  item in the context menu.

In the Find dialog, type the text you want to search for and specify the following settings (if required):

The Case Sensitive option specifies whether to ignore the letter case when searching text.

The Whole Words Only option only considers whole words when searching text. For example, it does not find the word
types when you search for type.



To start searching, click the Next button in the Find dialog, or press the ENTER key when the PDF Viewer shows the Find
dialog.

The PDF Viewer stops searching when it finds the first occurrence of the search text, highlights the occurrence and navigates to
the highlighted text.

To search for the next match, click the Next button in the Find dialog, or press the ENTER key again when the PDF Viewer shows
the Find dialog.

To go to the previous match, click the Previous button.

The PDF Viewer shows the following message when it finds the final occurrence of the search text or there were no results that
match the search text.



Adjust the Document ViewAdjust the Document View
This topic describes the features that adjust the view in the PDF Viewer.

The document consists of the following sections.

Rotate a Document
Zoom In and Out of a Document
Using Marquee Zoom Tool
Use a Specific Zoom Factor

Rotate a Document
To rotate a document, use the following commands.

Rotate Clockwise

Rotates the document clockwise through 90 degrees. To perform this command, right-click the viewed document, choose
the Rotate Clockwise  item, or press Ctrl + Shift + Add.

Rotate Counterclockwise

Rotates the document counterclockwise through 90 degrees. To do this, invoke the context menu by right-clicking the
document, choose the Rotate Counterclockwise  item, or press Ctrl + Shift + Subtract.

Zoom In and Out of a Document
Use buttons from the Zoom button group of the PDF Viewer tab.



To zoom in a document, click the Zoom In button on the toolbar, or press Ctrl+Plus sign.

To zoom out of a document, click the Zoom Out button on the toolbar, or press Ctrl+Minus sign.

To zoom in or out of a document, you can also hold down Ctrl and rotate the mouse wheel.

Using Marquee Zoom Tool
The Marquee Zoom tool allows end users to zoom in a particular part of the page.

To activate the Marquee Zoom tool:

right-click the viewing document;

select the Marquee Zoom item in the context menu.

You can perform the following actions:

zoom in on a portion of a page by dragging a rectangle around it;

increase the zoom level by clicking;
decrease the zoom level by clicking while pressing the Ctrl key.

Use a Specific Zoom Factor
To zoom to a specific zoom factor, click the Zoom dropdown list button. The following list will be invoked.



Choose the percentage value of the zoom factor or one of the following zoom factor presets.

Actual Size

Sets the document zoom factor value to 100%.

Zoom to Page Level

Sets the document zoom factor value to fit to the widest or highest page in a document.

Fit to Width

Sets the document zoom factor value to fit to the width of the widest page in a document.

Fit to Visible

The document zoom factor is calculated to fit to the width of the visible content of a page. The region of the visible page
content is defined by the bleed box. If the bleed box is not defined, the Fit to Visible mode operates the same as Fit to Width
mode.



Select and Copy the Document ContentSelect and Copy the Document Content
The PDF Viewer provides for selecting and copying text from the selectable document to the clipboard.

To enable the selection mode, invoke the context menu and choose the Select Tool item. This mode is active by default.

To copy an image:

select the image or any part of an image;

right click the image and select the Copy command in the context menu, or press Ctrl+ C;

paste the image into a desired application by choosing the Past command in the context menu, or pressing Ctrl+V.

To copy text:

highlight the text you desire;

choose the Copy command in the context menu, or press Ctrl+C;



paste the content into an application.

To select all the text in a document for copying, invoke the context menu and choose the Select All  command, or press Ctrl+A.



View Document PropertiesView Document Properties
To view information related to the currently opened document, invoke the context menu by right-clicking this document and
selecting Document properties... item.

The dialog displaying the standard set of the PDF file properties is invoked.



ThumbnailsThumbnails
This document introduces page thumbnails and describes their capabilities on a Navigation pane.

This document consists of the following sections.

Overview
Customization

Overview
A thumbnail provides a miniature preview of a document page. The PDF Viewer shows page thumbnails of an active PDF
document in the Page Thumbnails panel. The panel is located on the Navigation pane.

When a thumbnail is selected, the PDF Viewer shows the corresponding page.

You can navigate through a document by selecting the page thumbnails.

The Page Thumbnails panel provides thumbnail options that can be accessed using one of the following ways:



click the Options drop-down button;

use the right click menu of the Page Thumbnails panel.

Customization
The Page Thumbnails panel provides the following options.

Print Pages... - invokes the Print dialog in which you can print pages that correspond to the selected thumbnails.

Use this option after a thumbnail is selected. If there are no selected thumbnails in the panel, the Page range option in the
Print dialog is set to All. This means that all pages in a document can be printed.

Enlarge Page Thumbnails - increases the page thumbnails size.
Reduce Page Thumbnails - decreases the page thumbnails size.

You can also enlarge/reduce thumbnail size using one of the following ways:

press Ctrl on the keyboard and scroll the mouse wheel when the Page Thumbnails panel is focused;

use the zoom slider which is placed on the Page Thumbnails panel.





BookmarksBookmarks
The document describes the PDF Viewer bookmarks capabilities and customization options on a navigation pane.

This topic consists of the following sections.

Overview
Customization

Overview
Bookmarks (outlines) are used to navigate quickly from one part of a document to another. The PDF Viewer can show
bookmarks on the navigation pane for a PDF document that contains them.

Click on a bookmark to display a page linked to the bookmark in the Viewer. Bookmarks can also open web pages.

Bookmarks are displayed in a hierarchical tree providing a convenient document overview. They can show or hide the document
hierarchy in the navigation pane.

To open (or close) a bookmark item, click it with the mouse.



After the bookmark item is open, you can see its children in the pane.

Customization
To customize the bookmarks behavior, click the Options drop-down button in the Bookmarks panel, as shown below.

The available options are:

Expand Current Bookmark

Shows all lower-level bookmarks in the Bookmarks panel.

Collapse Top-Level Bookmarks

Collapses nested bookmarks.

Text Size

Sets the text size of nodes located in the PDF navigation pane to Small, Medium or Large.

Go to Bookmark

Goes to a bookmark.



Print Page(s)

Prints only pages to which selected bookmarks are linked in the document.

Print Section(s)

Prints a document section corresponding to selected bookmarks.

Wrap Long Bookmarks

Wraps long lines in the outline node text if the option is checked. If the Wrap Long Bookmarks option is unchecked, shows
the outline node text unwrapped in the PDF Viewer.



File AttachmentFile Attachment
This document describes actions that can be performed on attachments in the PDF Viewer.

An attachment is a file that is attached to a PDF document. The PDF Viewer shows the file attachments in the Attachments panel
of the navigation pane.

Open an attachment
To open a file attachment for viewing, you need an application which supports the corresponding file format to be installed in
your computer. To view an attachment, do one of the following.

double click the attached file;

or

select the file and click the "Open file in its native application" icon in the Attachments panel.

The Security Warning message appears. It warns you that the PDF Viewer will be use an external application to open the
attached file.

Click Yes to open the attached file, otherwise click No.

Save an attachment
The file attachment can be saved to your disk. To do this, select the file and click the "Save attachment" icon, as shown below.



The Save As dialog appears.

Choose the file attachment location on the disk, specify the file name, and click Save.



Export and Import the AcroForm DataExport and Import the AcroForm Data
This document describes how to export and import a document with AcroForm data.

Export

To export a PDF document with interactive forms to supported formats (FDF, XFDF, XML or TXT).

Click the Export button on the PDF Viewer's toolbar (if you use a Ribbon toolbar, you can find this button in the Interactive
Form tab).

The Save As dialog appears.



In this dialog you specify a file name, and the format in which the document should be exported (FDF, XFDF, XML or TXT). To
save a document, click Save, as shown above.

Import

To import a document that contains interactive forms from FDF, XFDF, XML or TXT:

Click the Import button on the PDF toolbar (in the Ribbon toolbar you can find this button in the Interactive Form tab).



This invokes the Open dialog box, where you can choose a file with interactive forms (e.g., in the FDF format) to import data.
To perform import, click Open.

The imported document is shown below.





Pivot TablePivot Table
This section describes the capabilities provided by the Pivot Table, which represents data in a cross-tabulated form.

 

Data Editing

Edit Data in Pivot Tables

Describes how to edit cell values and regular expressions used to calculate these values.

Edit Unbound Expression

Describes how to edit the unbound field's expression.

 

Data Presentation

Sort Data in Pivot Tables

Describes how you can sort field values alphabetically or by summary values displayed in a particular column or row.

Filter Data in Pivot Tables

Provides information on how to filter data by hiding specific rows or columns via filter drop-down lists, and how to provide
more advanced filtering by building a complex filter condition.

Apply Conditional Formatting

Describes how to change the appearance of individual cells based on specific conditions.

Change Summary Type in Pivot Tables

Describes how to specify which calculations the Pivot Table should perform against its data.

 

Layout Customization

Expand and Collapse Groups in Pivot Tables

Provides information on how to expand and collapse field values and field headers.



Hide Pivot Table Fields

Guides you through the process of hiding Pivot Table fields.

Display Hidden Pivot Table Fields

Describes how to display fields that have previously been hidden.

Reorder Pivot Table Fields

Provides information on how to reorder Pivot Table fields.

 

Selection and Navigation

Select Cells in Pivot Tables

Describes how to select a single or multiple cells, and copy their contents to the clipboard.

 

Field List

Field List Overview

Provides basic information about Field Lists.

Invoke a Field List

Describes how to invoke a Field List.

Defer Pivot Table Updates

Describes how to prevent automatic Pivot Table updates and force it to update manually.

Change Field List Layout

Provides information on how to change the layout of an advanced Field List.



Edit Data in Pivot TablesEdit Data in Pivot Tables
Edit Cell Values
To edit a cell value, click the cell and specify a new value:

Cell values are specified via editors of different types (e.g. text editor, calculator, etc.), depending on the cell data type and pivot
table settings.

Edit Expressions
Specific columns allow you to set a regular or Boolean expression which will be used to calculate their values. Clicking the column
header invokes the Expression Editor used to specify the expression:



To learn more about using the Expression Editor, see Expression Editor.



Edit Unbound ExpressionEdit Unbound Expression
To edit the unbound field's expression, use the Expression Editor. Select the Expression Editor menu command to invoke it.

Expressions allow you to calculate values based on values of other fields.

An expression is a string that, when parsed and processed, evaluates a value. Expressions consist of field names, constants,
operators, and functions. Field names must be wrapped in brackets. Here are examples of expressions:

"[Quantity] * [UnitPrice] * (1 - [BonusAmount])"

"[FirstName] + ' ' + [LastName]"

"[Country] == 'USA'"

"[OrderDate] > #8/16/1994# AND [Quantity] > 20"

For more information about syntax you can use in expressions, see Pivot Grid Expression Syntax.



Pivot Grid Expression SyntaxPivot Grid Expression Syntax
The following topic contains constants, operators, and functions you can use in Pivot Grid expressions.

�� N o t eN o t e

Refer to Criteria Language Syntax for a list of basic constants, operators, and functions DevExpress products support.

Constants
CONS TANT D ES CR IPTION E X AMPLE

String Wrap string constants in apostrophes. [Country] = 'France'

constants If a string contains an apostrophe, use double apostrophes. [Name] = 'O''Neil'

Date-time
constants Wrap date-time constants in hash symbol '#'. [OrderDate] >= #2018-03-

22 13:18:51.94944#

Represents the
'True' Boolean
value.

[InStock] = True [InStock] = True

False Represents the 'False' Boolean value. [InStock] = False

Enumeration To specify an enumeration value, use its underlying integer value. Do not use an
enumeration's qualified name in an expression.

Correct: [Status] = 1 
Incorrect: [Status] =
Status.InProgress

GUID Wrap a GUID constant in curly braces. Use GUID constants only with equality and
inequality operators.

[OrderID] = {513724e5-
17b7-4ec6-abc4-
0eae12c72c1f}

Numeric

Add suffixes to literals to specify a numeric type: 
* Int32 (int) 
* Int16 (short) 
* Byte (byte) 
* Double (double) 
* Single (float) 
* Decimal (decimal) 

* [ID] = 25 
* [Qty] = 25s 
* [ByteField] = 201b 
* [Price] = 25.0 
* [Price] = 25.0f 
* [Price] = 25.0m 

? A missing, invalid or unknown value. We recommend using the IsNull unary operator
("[Region] Is Null") or the IsNull logical function ("IsNull([Region])") instead. [Region] != ?

Operators
OPER ATOR D ES CR IPTION E X AMPLE

+ Calculates the sum of two numeric operands. Concatenates the string representations of
operands, if one of them is a string.

[UnitPrice] + 4 
[FirstName] + ' ' +
[LastName] 

- Subtracts the second operand from the first operand. [Price1] - [Price2]

* Multiplies operands. [Quantity] * [UnitPrice]



/ Divides the first operand by the second operand. [Quantity] / 2

% Returns the remainder after division of the first operand by the second operand. [Quantity] % 3

|
Performs a bitwise inclusive OR on two numeric expressions. Compares each bit of its first
operand to the corresponding bit of its second operand. If either bit is 1, the
corresponding resulting bit is set to 1. Otherwise, the corresponding resulting bit is set to
0.

[Number] | [Number]

&
The bitwise AND operator. Compares each bit of its first operand to the corresponding bit
of its second operand. If both bits are 1, the corresponding resulting bit is set to 1.
Otherwise, the corresponding resulting bit is set to 0.

[Number] & 10

^ Performs a bitwise exclusive OR on two numeric expressions. [Number] ^ [Number]

= 
== Returns true if operands are equal; otherwise, it returns false. [Quantity] = 10

!= Returns true if operands are not equal; otherwise, it returns false. [Country] != 'France'

< Relational 'less than' operator. [UnitPrice] < 20

<= Relational 'less than or equal' operator. [UnitPrice] <= 20

>= Relational 'greater than or equal' operator. [UnitPrice] >= 30

> Relational 'greater than' operator. [UnitPrice] > 30

And 
&& Performs a logical conjunction on two Boolean expressions.

[InStock] And
([ExtendedPrice]> 100) 
[InStock] &&
([ExtendedPrice]> 100) 

Or 
|| Performs a logical disjunction on two Boolean expressions.

[Country]=='USA' Or
[Country]=='UK' 
[Country]=='USA' ||
[Country]=='UK' 

~ Performs a bitwise negation on a numeric expression. ~[Roles] = 251

Not 
! Performs a logical negation on a Boolean expression. Not [InStock] 

![InStock] 

+ Returns a numeric expression's value (a unary operator). +[Value] = 10

- Returns the negative of a numeric expression's value (a unary operator). -[Value] = 20

Is Null Returns true if an expression is a null reference, the one that does not refer to any object. [Region] is null

In
(value1,value2,...)

Specifies a list of values to test. Returns true if an operand is equal to a value contained in
a list.

[Country] In ('USA', 'UK',
'Italy')

OPER ATOR D ES CR IPTION E X AMPLE



Between
(value1,value2)

Specifies a range to test. Returns true if an operand is greater than or equal to the value1
and less than or equal to the value2.

[Quantity] Between(10,
20) 
[Product Name]
Between('Ikura','Pavlova')

OPER ATOR D ES CR IPTION E X AMPLE

Aggregate Functions
FU NCTION D ES CR IPTION E X AMPLE

Avg(Value)

Returns the
average of the
values. 

 

Avg([Quantity]) returns an average quantity of goods in an order, if the pivot table is built upon the
data table where each row is an order. The Quantity values are summarized for all orders in the
underlying data table, and the result is divided by the total number of orders.

Count()
Returns the
number of records
in the underlying
data table.

Count()

Exists()
Not supported in
Pivot Grid
expressions.

Max(Value) Returns the
maximum value.

Max([Quantity]) returns the maximum quantity of goods in a single order among all orders in the
underlying data table, if the pivot table is built upon the data table where each row is an order.

Min(Value) Returns the
minimum value.

Min([Quantity]) returns the maximum quantity of goods in a single order among all orders in the
underlying data table, if the pivot table is built upon the data table where each row is an order.

Single()
Not supported in
Pivot Grid
expressions.

Sum(Value) Returns the sum of
all values.

Sum([Quantity]) returns the number of all items in all orders in the underlying data table, if the pivot
table is built upon the data table where each row is an order.

Date-time Functions
FU NCTION D ES CR IPTION E X AMPLE

AddDays(DateTime, DaysCount) Returns a date-time value that adds the specified
number of days to the specified DateTime. AddDays([OrderDate], 30)

AddHours(DateTime, HoursCount) Returns a date-time value that adds the specified
number of hours to the specified DateTime. AddHours([StartTime], 2)

AddMilliSeconds(DateTime,
MilliSecondsCount)

Returns a date-time value that adds the specified
number of milliseconds to the specified DateTime. AddMilliSeconds(([StartTime], 5000))

AddMinutes(DateTime,
MinutesCount)

Returns a date-time value that adds the specified
number of minutes to the specified DateTime. AddMinutes([StartTime], 30)



AddMonths(DateTime,
MonthsCount)

Returns a date-time value that adds the specified
number of months to the specified DateTime. AddMonths([OrderDate], 1)

AddSeconds(DateTime,
SecondsCount)

Returns a date-time value that adds the specified
number of seconds to the specified DateTime. AddSeconds([StartTime], 60)

AddTicks(DateTime, TicksCount) Returns a date-time value that adds the specified
number of ticks to the specified DateTime. AddTicks([StartTime], 5000)

AddTimeSpan(DateTime,
TimeSpan)

Returns a date-time value that adds the specified
TimeSpan to the specified DateTime. AddTimeSpan([StartTime], [Duration])

AddYears(DateTime, YearsCount) Returns a date-time value that adds the specified
number of years to the specified DateTime. AddYears([EndDate], -1)

DateDiffDay(startDate, endDate) Returns the number of day boundaries between
two non-nullable dates. DateDiffDay([StartTime], Now())

DateDiffHour(startDate, endDate) Returns the number of hour boundaries between
two non-nullable dates. DateDiffHour([StartTime], Now())

DateDiffMilliSecond(startDate,
endDate)

Returns the number of millisecond boundaries
between two non-nullable dates. DateDiffMilliSecond([StartTime], Now())

DateDiffMinute(startDate,
endDate)

Returns the number of minute boundaries between
two non-nullable dates. DateDiffMinute([StartTime], Now())

DateDiffMonth(startDate,
endDate)

Returns the number of month boundaries between
two non-nullable dates. DateDiffMonth([StartTime], Now())

DateDiffSecond(startDate,
endDate)

Returns the number of second boundaries between
two non-nullable dates. DateDiffSecond([StartTime], Now())

DateDiffTick(startDate, endDate) Returns the number of tick boundaries between two
non-nullable dates. DateDiffTick([StartTime], Now())

DateDiffYear(startDate, endDate) Returns the number of year boundaries between
two non-nullable dates. DateDiffYear([StartTime], Now())

GetDate(DateTime) Returns the date component of the specified
DateTime. GetDate([OrderDateTime])

GetDay(DateTime) Returns an integer that is the day of the month in
the specified DateTime. GetDay([OrderDate])

GetDayOfWeek(DateTime) Returns the day of the week in the specified
DateTime. GetDayOfWeek([OrderDate])

GetDayOfYear(DateTime) Extracts the day of the year from the defined
DateTime. GetDayOfYear([OrderDate])

GetHour(DateTime)
Returns an integer that is the hour component of
the specified DateTime, expressed as a value
between 0 and 23.

GetHour([StartTime])

FU NCTION D ES CR IPTION E X AMPLE



GetMilliSecond(DateTime) Returns an integer that is the millisecond
component of the specified DateTime. GetMilliSecond([StartTime])

GetMinute(DateTime) Returns an integer that is the minute component of
the specified DateTime. GetMinute([StartTime])

GetMonth(DateTime) Returns an integer that is the month component of
the specified DateTime. GetMonth([StartTime])

GetSecond(DateTime) Returns an integer that is the second component of
the specified DateTime. GetSecond([StartTime])

GetTimeOfDay(DateTime) Returns an integer that is the number of ticks that
have elapsed since midnight. GetTimeOfDay([StartTime])

GetYear(DateTime) Returns an integer that is the year component of
the specified DateTime. GetYear([StartTime])

IsApril(DateTime) Returns True if the specified date falls within April. IsApril([OrderDate])

IsAugust(DateTime) Returns True if the specified date falls within August. IsAugust([OrderDate])

IsDecember(DateTime) Returns True if the specified date falls within
December. IsDecember([OrderDate])

IsFebruary(DateTime) Returns True if the specified date falls within
February. IsFebruary([OrderDate])

IsJanuary(DateTime) Returns True if the specified date falls within
January. IsJanuary([OrderDate])

IsJuly(DateTime) Returns True if the specified date falls within July. IsJuly([OrderDate])

IsJune(DateTime) Returns True if the specified date falls within June. IsJune([OrderDate])

IsLastMonth(DateTime) Returns True if the specified date falls within the
previous month. IsLastMonth([OrderDate])

IsLastYear(DateTime) Returns True if the specified date falls within the
previous year. IsLastYear([OrderDate])

IsMarch(DateTime) Returns True if the specified date falls within March. IsMarch([OrderDate])

IsMay(DateTime) Returns True if the specified date falls within May. IsMay([OrderDate])

IsNextMonth(DateTime) Returns True if the specified date falls within the
next month. IsNextMonth([OrderDate])

IsNextYear(DateTime) Returns True if the specified date falls within the
next year. IsNextYear([OrderDate])

IsNovember(DateTime) Returns True if the specified date falls within
November. IsNovember([OrderDate])

FU NCTION D ES CR IPTION E X AMPLE



IsOctober(DateTime) Returns True if the specified date falls within
October. IsOctober([OrderDate])

IsSameDay(DateTime, DateTime) Returns True if the specified DateTime values fall
within the same day. IsSameDay([OrderDate], [ShipDate] )

IsSeptember(DateTime) Returns True if the specified date falls within
September. IsSeptember([OrderDate])

IsThisMonth(DateTime) Returns True if the specified date falls within the
current month. IsThisMonth([OrderDate])

IsThisWeek(DateTime) Returns True if the specified date falls within the
current week. IsThisWeek([OrderDate])

IsYearToDate(DateTime)
Returns True if the specified date falls within the
year-to-date period. This period starts from the first
day of the current year and continues up to the
current date including today.

IsYearToDate([OrderDate])

IsThisYear(DateTime) Returns True if the specified date falls within the
current year. IsThisYear([OrderDate])

LocalDateTimeDayAfterTomorrow() Returns a date component of the DateTime value
which is the day after tomorrow.

AddDays(LocalDateTimeDayAfterTomorrow(),
5)

LocalDateTimeLastMonth() Returns the date which is the first day of the
previous month. AddMonths(LocalDateTimeLastMonth(), 5)

LocalDateTimeLastWeek() Returns the date which is the first day of the
previous week. AddDays(LocalDateTimeLastWeek(), 5)

LocalDateTimeLastYear() Returns the date which is the first day of the
previous year. AddYears(LocalDateTimeLastYear(), 5)

LocalDateTimeNextMonth() Returns the date which is the first day of the next
month. AddMonths(LocalDateTimeNextMonth(), 5)

LocalDateTimeNextWeek() Returns the date which is the first day of the next
week. AddDays(LocalDateTimeNextWeek(), 5)

LocalDateTimeNextYear() Returns the date which is the first day of the next
year. AddYears(LocalDateTimeNextYear(), 5)

LocalDateTimeNow() Returns the current date and time. AddDays(LocalDateTimeNow(), 5)

LocalDateTimeThisMonth() Returns the date which is the first day of the current
month. AddMonths(LocalDateTimeThisMonth(), 5)

LocalDateTimeThisWeek() Returns the date which is the first day of the current
week. AddDays(LocalDateTimeThisWeek(), 5)

LocalDateTimeThisYear() Returns the date which is the first day of the current
year. AddYears(LocalDateTimeThisYear(), 5)

FU NCTION D ES CR IPTION E X AMPLE



LocalDateTimeToday() Returns the current date. AddDays(LocalDateTimeToday(), 5)

LocalDateTimeTomorrow() Returns the tomorrow's date. AddDays(LocalDateTimeTomorrow(), 5)

LocalDateTimeTwoMonthsAway() Returns the date which is the first day of the next
month.

AddMonths(LocalDateTimeTwoMonthAway(),
5)

LocalDateTimeTwoWeeksAway() Returns the date which is the first day of the next
week. AddDays(LocalDateTimeTwoWeeksAway(), 5)

LocalDateTimeTwoYearsAway() Returns the date which is the first day of the next
year. AddYears(LocalDateTimeTwoYearsAway(), 5)

LocalDateTimeYearBeforeToday() Returns the date which is the day one year ago. AddYears(LocalDateTimeYearBeforeToday(),
5)

LocalDateTimeYesterday() Returns the yesterday's date. AddDays(LocalDateTimeYesterday(), 5)

Now() Returns the current system date and time. AddDays(Now(), 5)

Today()
Returns a DateTime value that is the today's date
with the time component set to 00:00:00
(midnight).

AddMonths(Today(), 1)

UtcNow() Returns the current system date and time,
expressed as the Coordinated Universal Time (UTC). AddDays(UtcNow(), 7)

FU NCTION D ES CR IPTION E X AMPLE

Logical Functions
FU NCTION D ES CR IPTION E X AMPLE

Iif(Expression1, True_Value1,
..., ExpressionN,
True_ValueN, False_Value)

Returns one of several specified values depending upon the values of
logical expressions. The function can take 2N+1 arguments (N - the
number of specified logical expressions): 
* Each odd argument specifies a logical expression; 
* Each even argument specifies the value that is returned if the previous
expression evaluates to true 

Iif(Name = 'Bob', 1, 0) 
Iif(Name = 'Bob', 1, Name =
'Dan', 2, Name = 'Sam', 3, 0) 

IsNull(Value) Returns True if the specified Value is NULL. IsNull([OrderDate])

IsNull(Value1, Value2) Returns Value1 if it is not set to NULL; otherwise, Value2 is returned. IsNull([ShipDate],
[RequiredDate])

IsNullOrEmpty(String) Returns True if the specified String object is NULL or an empty string;
otherwise, False is returned. IsNullOrEmpty([ProductName])

Math Functions
FU NCTION D ES CR IPTION E X AMPLE

Abs(Value) Returns the given numeric expression's absolute, positive value. Abs(1 - [Discount])



Acos(Value) Returns a number's arccosine (the angle in radians, whose cosine is the given float
expression). Acos([Value])

Asin(Value) Returns a number's arcsine (the angle in radians, whose sine is the given float
expression). Asin([Value])

Atn(Value) Returns a number's arctangent (the angle in radians, whose tangent is the given float
expression). Atn([Value])

Atn2(Value1,
Value2) Returns the angle whose tangent is the quotient of two specified numbers in radians. Atn2([Value1], [Value2])

BigMul(Value1,
Value2) Returns an Int64 containing the full product of two specified 32-bit numbers. BigMul([Amount],

[Quantity])

Ceiling(Value) Returns the smallest integer that is greater than or equal to the numeric expression. Ceiling([Value])

Cos(Value) Returns the angle's cosine, in radians. Cos([Value])

Cosh(Value) Returns the angle's hyperbolic cosine, in radians. Cosh([Value])

Exp(Value) Returns the float expression's exponential value. Exp([Value])

Floor(Value) Returns the largest integer less than or equal to the numeric expression. Floor([Value])

Log(Value) Returns a specified number's natural logarithm. Log([Value])

Log(Value, Base) Returns the logarithm of a specified number in a specified Base. Log([Value], 2)

Log10(Value) Returns a specified number's base 10 logarithm. Log10([Value])

Max(Value1,
Value2) Returns the maximum value from the specified values. Max([Value1], [Value2])

Min(Value1, Value2) Returns the minimum value from the specified values. Min([Value1], [Value2])

Power(Value,
Power) Returns a specified number raised to a specified power. Power([Value], 3)

Rnd() Returns a random number that is less than 1, but greater than or equal to zero. Rnd()*100

Round(Value) Rounds the given value to the nearest integer. Round([Value])

Round(Value,
Precision)

Rounds the given value to the nearest integer, or to a specified number of decimal
places. Round([Value], 2)

Sign(Value) Returns the positive (+1), zero (0), or negative (-1) sign of the given expression. Sign([Value])

Sin(Value) Returns the sine of the angle defined in radians. Sin([Value])

Sinh(Value) Returns the hyperbolic sine of the angle defined in radians. Sinh([Value])
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Sqr(Value) Returns the square root of a given number. Sqr([Value])

Tan(Value) Returns the tangent of the angle defined in radians. Tan([Value])

Tanh(Value) Returns the hyperbolic tangent of the angle defined in radians. Tanh([Value])

ToDecimal(Value) Converts Value to an equivalent decimal number. ToDecimal([Value])

ToDouble(Value) Converts Value to an equivalent 64-bit double-precision floating-point number. ToDouble([Value])

ToFloat(Value) Converts Value to an equivalent 32-bit single-precision floating-point number. ToFloat([Value])

ToInt(Value) Converts Value to an equivalent 32-bit signed integer. ToInt([Value])

ToLong(Value) Converts Value to an equivalent 64-bit signed integer. ToLong([Value])
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String Functions
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Ascii(String) Returns the ASCII code value of the leftmost character in a character expression. Ascii('a')

Char(Number) Converts an integerASCIICode to a character. Char(65) + Char(51)

CharIndex(String1,
String2)

Returns the starting position of String1 within String2, beginning from the zero
character position to the end of a string.

CharIndex('e',
'devexpress')

CharIndex(String1,
String2, StartLocation)

Returns the starting position of String1 within String2, beginning from the
StartLocation character position to the end of a string.

CharIndex('e',
'devexpress', 2)

Concat(String1, ... ,
StringN)

Returns a string value containing the concatenation of the current string with any
additional strings.

Concat('A', ')',
[ProductName])

Contains(String1,
SubString1) Returns True if SubString1 occurs within String1; otherwise, False is returned. Contains([ProductName],

'dairy')

EndsWith(String1,
SubString1)

Returns True if the end of String1 matches SubString1; otherwise, False is
returned.

EndsWith([Description],
'The end.')

Insert(String1,
StartPosition, String2) Inserts String2 into String1 at the position specified by StartPositon Insert([Name], 0, 'ABC-')

Len(Value) Returns an integer containing either the number of characters in a string or the
nominal number of bytes required to store a variable. Len([Description])

Lower(String) Returns String in lowercase. Lower([ProductName])

PadLeft(String, Length) Left-aligns the defined string's characters, padding its left side with white space
characters up to a specified total length. PadLeft([Name], 30)



PadLeft(String, Length,
Char)

Left-aligns the defined string's characters, padding its left side with the specified
Char up to a specified total length. PadLeft([Name], 30, '<')

PadRight(String, Length) Right-aligns the defined string’s characters, padding its left side with empty space
characters up to a specified total length. PadRight([Name], 30)

PadRight(String, Length,
Char)

Right-aligns the defined string’s characters, padding its left side with the specified
Char up to a specified total length. PadRight([Name], 30, '>')

Remove(String,
StartPosition) Deletes all the characters from this instance, beginning at a specified position. Remove([Name], 3)

Remove(String,
StartPosition, Length)

Deletes a specified number of characters from this instance, beginning at a
specified position. Remove([Name], 0, 3)

Replace(String,
SubString2, String3) Returns a copy of String1, in which SubString2 has been replaced with String3. Replace([Name], 'The ', '')

Reverse(String) Reverses the order of elements within String. Reverse([Name])

StartsWith(String1,
SubString1) Returns True if the beginning of String1 matches SubString1; otherwise, False. StartsWith([Title], 'The

best')

Substring(String,
StartPosition, Length)

Retrieves a substring from String. The substring starts at StartPosition and has a
specified Length.

Substring([Description],
2, 3)

Substring(String,
StartPosition) Retrieves a substring from String. The substring starts at StartPosition. Substring([Description],

2)

ToStr(Value) Returns a string representation of an object. ToStr([ID])

Trim(String) Removes all leading and trailing SPACE characters from String. Trim([ProductName])

Upper(String) Returns String in uppercase. Upper([ProductName])
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Operator Precedence
When an expression contains multiple operators, their precedence determines the order in which expression elements are
evaluated.

Literal values
Parameters
Identifiers
OR (left-associative)
AND (left-associative)
'.' relationship qualifier (left-associative)
==, !=
<, >, <=, >=
-, + (left-associative)
*, /, % (left-associative)
NOT
unary -



In
Iif
Trim(), Len(), Substring(), IsNull()
'[]' (for set-restriction)
'()'

You can group elements with parentheses to change the default precedence. For instance, the operators are performed in the
default order in the first code sample below. In the second code sample, the addition operation is performed first because its
associated elements are grouped with parentheses, and the multiplication operation is performed last.

Accounts[Amount == 2 + 48 * 2]

Accounts[Amount == (2 + 48) * 2]

Case Sensitivity
Operators are case insensitive.
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A data source affects certain operators' behavior. For instance, SQL Server Express 2005 is configured as case insensitive. In this
case, the following expression always evaluates to true:

Lower(Name) == Upper(Name)

Escape Characters
Use a backslash () as an escape character for characters in expressions, for example:

\[
\\
\'

Export to XLS and XLSX
The Pivot Grid does not export expressions to XLS and XLSX format.



Data PresentationData Presentation
This section describes how you can customize data presentation in Pivot Tables.

The following sections are available.

Sort Data in Pivot Tables

Describes how you can sort field values alphabetically or by summary values displayed in a particular column or row.

Filter Data in Pivot Tables

Provides information on how to filter data by hiding specific rows or columns via filter drop-down lists, and how to provide
a more advanced filtering by building a complex filter condition.

Apply Conditional Formatting

Describes how to change the appearance of individual cells based on specific conditions.

Change Summary Type in Pivot Tables

Describes how to specify which calculations Pivot Table should perform against its data.



Sort Data in Pivot TablesSort Data in Pivot Tables
This section describes the Pivot Table capabilities used to sort its data by field and summary values.

Topics in this section:

Simple Sorting

Provides information on how to sort data by field values.

Sort Data Using the Context Menu

Describes how to use the context menu to sort data.

Sort Data Using a Field List

Describes how to use a Field List to sort data.

Sort Data by Summaries

Describes how to sort data by column or row values.



Simple SortingSimple Sorting
Values of dimension fields are always arranged in ascending or descending order. The sort order is indicated by an Up or Down
arrow displayed within a corresponding dimension field's header.

To toggle the sort order for a dimension field, click this field's header.

You can also sort field values using a Field List or context menu. To learn more, see Sort Data Using a Field List and Sort Data
Using the Context Menu.



Sort Data Using the Context MenuSort Data Using the Context Menu
Depending on the Pivot Table settings made by your application vendor, you may be able to sort data using the context menu.

If the corresponding functionality is enabled, the context menu invoked when you right-click a field header contains the Sort A-Z,
Sort Z-A and Clear Sorting items.

Select Sort A-Z to set ascending sort order, and Sort Z-A to set descending order.

To reset sort order to the default one, select Clear Sorting.



Sort Data Using a Field ListSort Data Using a Field List
You can use an advanced Field List to sort field values (to learn more about Field Lists, see Field List Overview).

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To toggle the sort order of a field, click its header.

You can sort data without using a Field List. To learn more, see Simple Sorting and Sort Data Using the Context Menu.



Sort Data by SummariesSort Data by Summaries
You can sort values of a particular dimension field by summary values calculated against a specific data field. To do this, right-
click a column or row header, and choose a dimension field whose values should be sorted by column/row summary values. A
specific indicator marks the column/row whose summary values are used to define the sort order.

You can sort values of multiple dimension fields against a single column/row. To cancel this sorting, click the same item again, or
'Remove All Sorting' to cancel sorting for all dimension fields.



Filter Data in Pivot TablesFilter Data in Pivot Tables
By default, the Pivot Table processes all records when calculating its values. Data filtering allows you to process only those records
that meet your requirements.

Topics in this section describe three ways of filtering data in Pivot Tables - filtering by field values, filtering by cell values and
building complex filter criteria.

The following sections and topics are available.

Filter Data by Field Values

Contains topics that describe how to specify simple filter conditions via Filter Windows.

Filter Data by Cell Values

Contains topics that describe how to specify which cell values to display and which to hide.

Build Complex Filter Criteria

Describes the Filter Editor that allows you to build complex filter criteria.



Filter Data by Field ValuesFilter Data by Field Values
Filter Popup Windows allow you to configure and apply simple filtering conditions by selecting which values you wish to view,
and which you do not.

Topics in this section describe how to invoke, use and customize Filter Windows.

The following topics are available:

Invoke a Filter Popup Window

Shows how to invoke Filter Windows from the Pivot Table and a Field List.

Using Filter Popup Windows

Describes how to build filter conditions in Filter Popup Windows.

Filtering Options

Introduces Pivot Table filtering options and describes a specially designed toolbar to access them.



Invoke a Filter WindowInvoke a Filter Window
You can invoke a Filter Window from the Pivot Table or from a Field List (to learn about Field Lists, see Field List Overview).

Invoke a Filter Window from the Pivot Table
Field headers display special buttons used to invoke a Filter Window. Follow the steps below:

1. Hover over the header of a field whose data you need to filter. A filter button (the  icon) will be highlighted.

2. Click this filter button to display a Filter Window. Filter windows can be Classic or Excel-style:

CL AS S IC E X CEL- S T YLE

Invoke a Filter Window from a Field List
You can use an advanced Field List to filter field values.



First, invoke a Field List. For information on how to do this, see Invoke a Field List. To open a Filter Window, click the filter button
displayed in the field header.



Using Filter WindowsUsing Filter Windows
Depending on the settings made by your application vendor, the Pivot Table can display an individual Filter Window for each field,
or an integrated Filter Window for a group of fields.

This topic describes how to filter data using both types of Filter Windows.

Excel-style Filter Window
The Excel-style filter popup's content depends on the type of data the related field displays.

In the "Values" tab, end-users can select specific field values from the Pivot Grid.

The "Filters" tab supplies users with additional options related to the field type. For example, when filtering a string field, you can
show only those records that begin with 'C':

Filters applied using the Excel-style filter popup are displayed in the Filter Panel and can be changed in the Filter Editor dialog,
which allows end-users to apply complex filter conditions.

The Excel-style filter cannot be used to apply filtering in OLAP mode.

Simple Filter Window
A simple Filter Window allows you to hide visible and show previously hidden values of a particular field.



In the Filter Window, uncheck field values that should be hidden and check values that should be visible. Then, click OK to close
the window and apply the filtering.

Note that you can customize Filter Window settings using the toolbar displayed at the top of the window. To learn how to do this,
see Filtering Options.

Hierarchical Filter Window
A hierarchical Filter Window displays values of several fields, arranged in a tree-like manner.

In the Filter Window, uncheck field values that should be hidden and check values that should be visible.

Use the  buttons to expand field values and access their child values. To collapse an expanded field value and hide its child
values, use the  button.

You can also expand and collapse all values on a particular level. To do this, right-click any field value and select Collapse All or
Expand All from the context menu.

For instance, to expand all quarters and display months, right-click any quarter value and select Expand All from the context
menu as shown on the image below.

Click OK to close the window and apply the filtering.

Note that you can customize Filter Window settings using the toolbar displayed at the top of the window. To learn how to do this,



see Filtering Options.

Filtering Indication
You can determine whether a field is filtered by looking at its header. Filter buttons for these fields are visible even when you are
not hovering over their headers.

Removing Filtering
To remove filtering against a specific field, invoke its Filter Window and select (Show All).



Filtering OptionsFiltering Options
The Pivot Table allows you to customize its filtering mechanism according to your needs.

If the corresponding functionality is enabled by your application vendor, Filter Windows display toolbars where you can access
various filtering options.

Use the toolbar buttons to enable or disable particular options.

The following table describes the available toolbar buttons.

ICON
B U T TON
TOOLTIP D ES CR IPTION

Show Only
Available
Items

If this button is pressed, values that cannot be displayed because of filtering applied to other fields are hidden
from Filter Windows. Note that this button is not available for Hierarchical Filter Windows.

Show New
Field Values

If this button is pressed, field values that have appeared in the database after the field's filtering was configured
are shown by default. If this button is released, new field values are hidden by default. To view these values, check
them manually in the corresponding Filter Window.

Incremental
Search

If this button is pressed, the Incremental Search feature is enabled. This feature allows you to locate a value in the
Filter Window by typing its initial characters.

Multi-
Selection

If this button is pressed, you can select multiple values by sequentially clicking them with the CTRL key held down
(or the SHIFT key to select a continuous range of values). In this instance, a field value is selected when you click
its name, and checked (or unchecked) when you click a corresponding check box. When you click a check box with
multiple values selected, this changes the checked state of all selected values. If this button is released, you cannot
select multiple values. In this instance, a field value is selected and checked (or unchecked) when you click either its
name or a corresponding check box.

Radio
Mode

If this button is pressed, Filter Windows hide check boxes and display field values in a simple list. In this instance,
you can select and view only one value from each field in the Pivot Table.

Invert Filter Inverts the checked state for all values.



Filter Data by Cell ValuesFilter Data by Cell Values
The Pivot Table allows you to filter data by specifying a range of cell values that should be displayed. Values that do not fall into
this range will be hidden.

Topics in this section describe how to configure filtering by cell values (or summary filtering).

The following topics are available.

Invoke a Summary Filter Window

Describes how to invoke a Summary Filter Window used to enable and configure filtering by cell values.

Select a Range of Values

Shows how to specify a range of cell values that should be displayed.

Move the Selected Range

Demonstrates how to select another range with the same length by moving the selection.

Zoom and Move the Viewport

Describes how to zoom and scroll the range selector.

Specify Target Cells

Shows how to enable filtering by Total and Grand Total cells.

Remove Filtering

Describes how to disable filtering.



Invoke a Summary Filter WindowInvoke a Summary Filter Window
To enable and configure filtering by cell values, use the Summary Filter Window.

You can invoke a Summary Filter Window from the Pivot Table or from a Field List (to learn about Field Lists, see Field List
Overview).

Invoke a Summary Filter Window from the Pivot Table
Field headers located in the Data Area display special buttons used to invoke a Summary Filter Window. Follow the steps below.

1. Hover over the header of a field whose data you need to filter. A filter button ( ) will be highlighted.

2. Click this filter button to display a Summary Filter Window.

Invoke a Summary Filter Window from a Field List
You can use an advanced Field List to filter field values.



First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To open a Summary Filter Window, click the filter button displayed in the field header.



Select a Range of ValuesSelect a Range of Values
You can select a range of cell values to be displayed in any of the following ways.

Enter the bounds of the range into the appropriate text editors.

Drag selection thumbs in the range selector.

If a range is already selected, you can select a different range with the mouse.



Move the Selected RangeMove the Selected Range
To move a selection, do the following.

Drag the selection by any point within it.

Drag a selection scroll thumb displayed within the Zoom & Scroll Bar.



Zoom and Move the ViewportZoom and Move the Viewport
Zoom
You can zoom in or out by shrinking or enlarging a viewport scroll thumb displayed within the Zoom & Scroll Bar.

To zoom in, drag a zoom grip inwards. To zoom out, drag a zoom grip outwards.

Move Viewport
To move the viewport, drag a viewport scroll thumb.



Specify Target CellsSpecify Target Cells
Filtering by cell values is applied only to regular cells by default. You can change this behavior and apply it to Total or Grand Total
cells. To do this, check the Apply to specific level check box, and select column and row fields that identify the desired Total or
Grand Total cells.



Remove FilteringRemove Filtering
To remove filtering, click the Clear button.



Build Complex Filter CriteriaBuild Complex Filter Criteria
To build complex filter criteria consisting of multiple filter clauses using various filter operators, you can use a Filter Editor:

To invoke a Filter, click an empty space within the Pivot Table header region and select Show Filter from the context menu.

After you have built and applied a filter condition, a filter panel appears at the Pivot Table bottom. This panel displays the filter
condition.

To modify a filter condition, open a Filter. You can now do it by clicking the Edit Filter button.

To temporarily disable filtering, uncheck the  button.

To remove filtering, click the  button.

See also:

Filter Data via the Filter Editor
Examples of Using the Filter Editor



Apply Conditional FormattingApply Conditional Formatting
You can change the appearance of individual cells based on specific conditions using Format Rules context menu. This feature
helps to highlight important information, identify trends and exceptions, and compare data.

To invoke the menu, do the following.

Right-click the data cell corresponding to the intersection of the required data, row and column field.
Select the required rule from the list.

Available format rules are displayed when expanding the Format Rules menu.

Highlighting Cells that Meet a Specific Condition
This rule formats cells if values matches one of the predefined conditions, custom condition or contain the specified text.

To apply this format, do the following:

Choose the Highlight Cell Rules menu item and select the rule type.

According to the selected rule type, an appropriate dialog window is invoked.



Specify the rule value(s), choose a format style in the dropdown list, and click the OK button. To apply formatting to all data
cells instead of an intersection, clear the Apply only to specific level check box.

Highlighting Top or Bottom Cell Values
This rule formats cells that contain the highest or lowest values, and values that are above or below the average of the field
intersection data cells value.

To apply this format, do the following:

Choose the Top/Bottom Rules menu item and select the rule type.

According to the selected rule type, an appropriate dialog window is invoked.

Specify the rule value if it is necessary, choose a format style in the dropdown list, and click the OK button.

Highlighting Cells Using Data Bars
A data bar fills a cell according to the ratio of the cell's value to the highest and smallest field intersection data cells values. A
longer bar corresponds to a higher value, and a shorter bar, to a lower value.

To apply this format, choose the Data Bars menu item and select the bar style format.



Solid bars and bars with gradient fills are available in various colors.

Applying Color Scales
This format shows data distribution and variation using color scales. A cell is filled with a background color that is calculated
according to the ratio of the cell's value to the highest and smallest field intersection data cells values.

To apply this format, choose the Color Scales menu item and select one of the predefined two or three-color scales.

Highlighting Cells Using Predefined Icons
Icon sets allow you to classify data cells values into three, four or five ranges separated by threshold values, and display a specific
icon in a cell according to the range to which this cell value belongs. In the Positive/Negative group, the available icon sets divide
column values into three ranges: positive values, negative values and values equal to zero.

To apply this format, choose the Icon Sets menu item and select one of the predefined icon sets.



Conditional Formatting Rules Manager
You can create, sort and modify the created rules using the Conditional Formatting Rules Manager. To invoke this manager,
select the Manage Rules... item from the Format Rules context menu.

To create a new rule, click the New Rule... button, select a rule type and specify its parameters. Depending on rule type,
you can set maximum and minimum values, specify format, colors or icon style, etc.



To edit the existing rule, click the Edit Rule... button and change the rule parameters. Besides that, you can see the rule's
format preview and specify row, measure and column in the list of rules in the main window.
To delete the rule, select the rule and click the Delete Rule button.
To reorder rules, select the rule and click Up or Down button.

Deleting Rules
If you have already applied one or more rules to data cells, the additional Clear Rules item is displayed in the Conditional
Formatting menu.

You can select one of the following items.

Click the Clear Rules from This Intersection menu item to delete conditional formatting rules from the target fields
intersection.
Click the Clear Rules from This Measure menu item to delete conditional formatting rules from the target data field.
Click the Clear Rules from All Measures menu item to delete formatting rules from all data cells.



Change Summary Type in Pivot TablesChange Summary Type in Pivot Tables
Pivot Tables can perform different calculations against data (for instance, calculating sums, averages, maximum and minimum
values, etc.).

To specify which calculations Pivot Table should do against its data, left-click a data header and choose the appropriate function
type.



Exporting and PrintingExporting and Printing
The Pivot Grid control allows its data to be printed and exported.

Export
The Pivot Grid control allows you to export Pivot Grid data to a file or stream in various formats - HTML, MHT, PDF, RTF, TXT, CSV,
XLS or XLSX. When you export, you copy data from a pivot grid into a new file formatted for use in another application.

Expor t ModesExpor t Modes

Two export modes are supported when exporting data from a Pivot Grid control to table formats (*.xls(x), *.csv).

Data-aware Export - The export mode, optimized for subsequent analysis of pivot grid data within Microsoft Excel. Various
data shaping options that are applied within the pivot grid are retained in the output XLS(X) and CSV documents.

WYSIWYG Export - In this export mode, the layout of pivot grid cells is retained in resulting XLS(X) and CSV documents.
Specific data shaping options are not retained compared to data-aware export. Data exported using other formats (PDF, RTF,
TXT, etc.) is always exported in the WYSIWYG mode.

D ata-Aware Expor tD ata-Aware Expor t

Data-aware is the default export mode for XLS and XLSX formats, and is optimized for subsequent analysis of pivot grid data
within Microsoft Excel.



The following data shaping options, which are applied within the pivot grid control, are retained in the output XLS-XLSX
documents.

Data Grouping - with the capability to collapse/expand groups within a worksheet.
Fixed Columns – allow column and row areas to stay in sight.
Cell Formatting – allows you to export the number format.
Display Text/Value export - allows you to select whether to export display text or values.

Printing
The Pivot Grid Control allows to print its data by the Print Preview form.



Layout CustomizationLayout Customization
This section describes how to customize the Pivot Table layout by expanding and collapsing field values, as well as hiding,
displaying and reordering fields.

The following sections are available.

Resizing Columns

Describes how to resize columns displayed within the Pivot Table.

Expand and Collapse Groups in Pivot Tables

Provides information on how to expand and collapse field values and field headers.

Hide Pivot Table Fields

Guides you through the process of hiding Pivot Table fields.

Display Hidden Pivot Table Fields

Describes how to display fields that have previously been hidden.

Reorder Pivot Table Fields

Provides information on how to reorder Pivot Table fields.



Resizing ColumnsResizing Columns
You can resize columns within the Pivot Table by dragging their borders.
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Regular, Total and Grand Total columns are resized independently. This means that resizing a regular column changes the width
of all regular columns but does not affect Total and Grand Total columns, and vice versa.

Double-click a column border to automatically resize the column to the minimum width required to completely display its
content.



Expand and Collapse Groups in Pivot TablesExpand and Collapse Groups in Pivot Tables
Expand/Collapse Groups of Values
To expand/collapse groups of values, do one of the following:

Click a corresponding expand button:

Right-click a value that has nested values, and select the required Expand or Collapse command from the menu that opens:

Expand/Collapse Fields
To expand/collapse a group of fields, click a corresponding field expand button:



Hide Pivot Table FieldsHide Pivot Table Fields
This section describes the Pivot Table capabilities to hide fields.

Topics in this section:

Hide Fields Using the Context Menu

Provides information on how to use context menus to hide fields.

Hide Fields Using a Field List

Describes how to hide fields using a Field List.



Hide Fields Using the Context MenuHide Fields Using the Context Menu
To hide a field, right-click its header and choose Hide from the context menu.

You can also use a Field List to hide fields. To learn more, see Hide Fields Using a Field List.



Hide Fields Using a Field ListHide Fields Using a Field List
You can use a simple or an advanced Field List to hide fields (to learn more about Field Lists, see Field List Overview).

  

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

Then do one of the following:

Drag a field away from the header panel, until the cursor changes its image to the big 'X'. Then drop the header.

Drag and drop a field onto the Field List form.



If you are using an advanced Field List, you can hide a field by dragging its header to the hidden fields area displayed on the Field
List top.

You can also hide fields using the context menu. To learn more, see Hide Fields Using the Context Menu.



Display Hidden Pivot Table FieldsDisplay Hidden Pivot Table Fields
To display hidden fields, use a simple or advanced Field List (to learn more about Field Lists, see Field List Overview).

  

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To display a hidden field, drag-and-drop the field from the Field List onto the required area of Pivot Table. This works for both
simple and advanced Field Lists.

If you are using a simple Field List, you can display the required field as follows.

1. Click the required field in the Field List.
2. In the drop-down combo box, select a Pivot Table area within which this field should be displayed.
3. Click the Add To button.



If you are using an advanced Field List, you can display a hidden field by dragging its header from the hidden fields section to the
section corresponding to the required Pivot Table area.



Reorder Pivot Table FieldsReorder Pivot Table Fields
This section describes the Pivot Table capabilities to reorder fields.

The following topics are available:

Simple Fields Reordering

Describes how to reorder fields via drag-and-drop and context menus.

Reorder Fields Using a Field List

Provides information on how to use a Field List to reorder fields.



Simple Fields ReorderingSimple Fields Reordering
To move a field to another position, use drag-and-drop operations.

To move a field to a different position within the same area, you can also use a field context menu.

Right-click the field header to activate the context menu.

Select the required command from the Order menu.

You can also use a Field List to reorder fields. For more information, see Reorder Fields Using a Field List.



Reorder Fields Using a Field ListReorder Fields Using a Field List
You can use an advanced Field List to reorder fields (to learn more about Field Lists, see Field List Overview).

First, invoke a Field List. For information on how to do this, see Invoke a Field List.

To reorder fields, drag their headers within or between Field List sections that correspond to different Pivot Table areas.

You can also reorder fields via simple drag-and-drop operations (without invoking a Field List), or using a context menu. To learn
more, see Simple Fields Reordering.



Select Cells in Pivot TablesSelect Cells in Pivot Tables
Multiple cells can be selected simultaneously, and their contents can then be copied to the clipboard. This topic shows how.

Select Cells and Clear the Current Selection
To select a single cell, do one of the following:

Click the cell.

Focus the cell using the ARROW keys.

To select a row or column of cells, click the appropriate header:

To select a continuous range of cells, do one of the following:

Use ARROW, PAGE UP, PAGE DOWN keys while holding the SHIFT key down.

Press the mouse button over the starting cell and drag the mouse cursor towards the ending cell. Then release the mouse
button.

Click the starting cell. Then click the ending cell while holding the SHIFT key down.

To select a continuous range of columns or rows, do one of the following:

Press the mouse button over the starting column/row header and drag the mouse cursor towards to the ending column or



row header. Then release the mouse button.

Click the starting column or row header. Then click the ending column/row header while holding the SHIFT key down.

To select all the cells, press CTRL+A.

Select Cells While Preserving the Current Selection
Hold the CTRL key down while selecting cells.

Copy Selected Cells to the Clipboard
Press CTRL+C or SHIFT+INS.



Field List OverviewField List Overview
Pivot Table provides a Field List form used to reorder and hide fields, sort and filter data, etc. For more information on how to
invoke a Field List, see Invoke a Field List.

This topic describes Field List visual elements and layout.

Depending on Pivot Table settings made by your application vendor, Pivot Table can display either a simple or advanced Field List.

Simple Field List
The following picture shows a simple Field List.

A simple Field List contains the following visual elements:

Hidden Fields Section - contains headers of fields hidden from Pivot Table. Use it to display hidden fields.
Add Button - used to display a selected field in a specified Pivot Table area.
Pivot Table Area Combo Box - used to choose a Pivot Table area where the selected field will be displayed after you click
the Add button.

Use a simple Field List to hide fields from Pivot Table and display hidden fields again.

For more information on operations available in a simple Field List, refer to the following topics:

Hide Fields Using a Field List
Display Hidden Pivot Table Fields

Advanced Field List
The following picture shows an advanced Field List.



An advanced Field List contains the following visual elements:

Hidden Fields Section - contains headers of fields hidden from Pivot Table. Use it to display hidden fields.
Filter, Column, Row and Data Area Sections - contains headers located in respective Pivot Table areas.
Defer Updates Check Box - used to enable/disable automatic Pivot Table updates (see Defer Pivot Table Updates).
Update Button - used to force Pivot Table to update (see Defer Pivot Table Updates).
Layout Button - used to invoke the Layout menu and change the Field List layout (see Change Field List Layout).

Use an advanced Field List to sort and filter data, reorder and hide visible fields, and show fields that have been hidden.

For more information on operations available in an advanced Field List, refer to the following topics:

Sort Data Using a Field List
Invoke a Filter Popup Window
Hide Fields Using a Field List
Display Hidden Pivot Table Fields
Reorder Fields Using a Field List



Invoke a Field ListInvoke a Field List
To invoke a Field List, right-click on an empty space within the Pivot Table header region, and select Show Field List from the
context menu.

A simple or advanced Field List (similar to one of those shown below) will be displayed.

  

To learn more about Field Lists, see Field List Overview.



Defer Pivot Table UpdatesDefer Pivot Table Updates
When you perform several sequential operations like hiding, displaying or reordering fields using an advanced Field List, Pivot
Table is updated after each operation.

You can disable automatic Pivot Table updates by checking the Defer Layout Update check box. In this instance, use the Update
button to force Pivot Table to update.

Note that if the Defer Layout Update check box is checked, you cannot sort or filter data in the Field List.

To learn more about Field Lists, see Field List Overview.



Change Field List LayoutChange Field List Layout
By default, an advanced Field List displays a hidden fields section on the top, and four sections that correspond to Pivot Table
areas at the bottom (see Field List Overview for details).

You can use the Layout menu to control which sections are displayed and where they are displayed. To do this, click the  button
and select the required layout from the drop-down menu.

To learn more about Field Lists, see Field List Overview.



Print PreviewPrint Preview
The Print Preview user interface may vary depending on your application platform.

The following topics are available in this section.

Print Preview for WinForms
Print Preview for WPF



Print Preview for WinFormsPrint Preview for WinForms
This section describes the capabilities provided by the Print Preview form.

 

File Management

Save a Print Preview to a File
Load a Print Preview from a File

 

Printing and Page Setup

Print a Document via the Print Dialog
Print a Document Using Default Settings
Change Printing Settings via the Page Setup Dialog
Specify Page Margins in Print Preview

 

Headers and Footers

Insert Page Header and Page Footer into Printed Documents
Insert Page Numbers into Printed Documents
Insert Date and Time into Printed Documents
Insert the User Name into Printed Documents
Insert a Logo into Printed Documents

 

Scaling

Scale Print Preview by Entering a Zoom Factor
Scale Print Preview by Specifying Width in Pages



 

Zooming

Zoom Print Preview In or Out
Zoom Print Preview by Entering a Zoom Factor
Zoom Print Preview to Show Whole Pages or Fit Content
Show Two or More Pages in Print Preview

 

Viewing and Navigating

Navigate Between Pages in Print Preview
Use the Hand Tool in Print Preview
Navigate in Print Preview Using Bookmarks
Navigate in Print Preview Using Thumbnails
Search for a Specific Text in Print Preview
Switch Print Preview Display Mode

 

Interactivity

Content Editing in Print Preview

 

Watermark and Background

Change Watermark and Background Settings in Print Preview
Remove a Watermark in Print Preview

 

Exporting

Exporting from Print Preview
PDF-Specific Export Options
HTML-Specific Export Options
MHT-Specific Export Options
RTF-Specific Export Options
DOCX-Specific Export Options
XLS-Specific Export Options
XLSX-Specific Export Options
CSV-Specific Export Options
TXT-Specific Export Options
Image-Specific Export Options

 

Passing Parameters

Passing Parameters in Print Preview

 

Miscellaneous



Customize Printing Settings of Charts
Customize Printing Settings of Grids
Customize Printing Settings of Pivot Tables
Customize Printing Settings of Tree Views

 

Warnings and Error Messages

Warnings and Error Messages in Print Preview



Save a Print Preview to a FileSave a Print Preview to a File
If you've modified your document, and there's a chance you'll need to print out this document version more than once, you can
save the document to a file on disk. After that, you can simply load your document and print it out, without having to apply the
same changes again.

To save a document to the file, click the Save  button on the toolbar, or press CTRL+S.

On the invoked Save As dialog, locate a folder where you want to store your file, enter the document's name and click Save.

Your document will be saved with the .prnx file extension. Note that this extension will be added to the file name even if you
enter another one.

�� N o t eN o t e

If you open a document which was previously saved to the hard drive, it is impossible to change its page settings (e.g. page size,
orientation, margins, etc.). So, the Page Setup and the Scale buttons will be disabled.



Load a Print Preview from a FileLoad a Print Preview from a File
To open a previously saved document, click the Open  button on the toolbar, or press CTRL+O.

On the invoked Open dialog, define the file and click Open.

�� N o t eN o t e

If you open a document previously saved to the hard drive, it is impossible to change its page settings (e.g. page size, orientation,
margins, etc.). So, the Page Setup and Scale buttons will be disabled.



Print a Document via the Print DialogPrint a Document via the Print Dialog
To print a document, do one of the following.

Click the Print  button on the toolbar, or press CTRL+P.
On the File menu, click Print....

The Print dialog will be invoked.

Specify the necessary settings and click Print.

To print a document without invoking the Print dialog, see the Print a Document Using Default Settings topic.

�� N o t eN o t e

If you try to print a document whose margins are outside of the printable area, you'll see a warning message. Click Yes to print
the document anyway, if you are sure that your printer supports the specified page margins.



Print a Document Using Default SettingsPrint a Document Using Default Settings
To send a document directly to the default printer without customizing print settings, do one of the following.

Click the Quick Print  button on the toolbar.
On the File menu, click Print.

To learn how to select a printer, number of copies, and other printing options, refer to the Print a Document via the Print Dialog
topic.

�� N o t eN o t e

If you try to print a document whose margins are outside of the printable area, you'll see a warning message. Click Yes to print
the document anyway, if you're sure that your printer supports the specified page margins.



Change Printing Settings via the Page Setup DialogChange Printing Settings via the Page Setup Dialog
To start the page setup dialog box, do one of the following.

Click the Page Setup  button on the toolbar.
On the File menu, click Page Setup...

The following dialog will be invoked.

This dialog allows you to do the following:

Change page orientation (choose Portrait or Landscape).
Select paper size.
Change page margins. (This can also be done in the Print Preview dialog)

�� N o t eN o t e

If you're working with a document that was loaded from file, the Page Setup commands on the toolbar and main menu will be
disabled.



Specify Page Margins in Print PreviewSpecify Page Margins in Print Preview
To set document page margins, do one of the following.

Use the Page Setup dialog

In the Page Setup dialog, enter the required top, left, bottom and right page margins' values into the appropriate editors.

Then, click OK to save changes.

Use drag-and-drop in the Print Preview window

To use this approach, point to the dotted line indicating the margin's border. When the pointer changes to , drag the
pointer to move the margin.

�� N o t eN o t e

If you're working with a document that was loaded from file, it is impossible to change its page settings (e.g. page size,
orientation, margins, etc.).



Print SelectionPrint Selection
To print only the selected content of the previewed document, do the following.

1. Select the content of the previewed document by holding the left mouse button and dragging the mouse pointer to create a
selection box. Expand the selection box to fit all of the content you wish to print. The selected document elements are
highlighted.

2. Right-click anywhere within the highlighted area of the document and select Print... in the context menu.

3. In the invoked Print dialog, specify the required settings and click Print.





Insert Page Header and Page Footer into Printed DocumentsInsert Page Header and Page Footer into Printed Documents
To insert a page header and page footer into a document, click the Header and Footer  button on the toolbar. This will invoke
the Header and Footer dialog.

Specify header and footer content using the appropriate text boxes, depending on the required alignment.

If needed, you can also adjust vertical alignment and font settings.

Click OK to save changes and close the dialog.



Insert Page Numbers into Printed DocumentsInsert Page Numbers into Printed Documents
To insert or remove page numbers from a document, first invoke the Header and Footer dialog.

Focus a text box, depending on the required alignment, and do one of the following:

If you need to simply display the current page number, click the Page Number  button.
If you need to display the page number out of the total number of pages, click the Page # of Pages #  button.

When you click one of these buttons, the dialog adds an alias within square brackets at the current cursor position. You can
surround this alias with any text you like. If you no longer need page numbers in your document, delete this alias.

Click OK to save changes and close the dialog.



Insert Date and Time into Printed DocumentsInsert Date and Time into Printed Documents
If you need to display the date and time when a document is printed, first invoke the Header and Footer dialog.

Then, click on the appropriate text box, depending on the required alignment, and do the following:

To add a date stamp, click the Date Printed  button.
To add a time stamp, click the Time Printed  button.

When you click one of these buttons, the dialog adds an alias within square brackets at the current cursor position. You can
surround this alias with any text you like. If you no longer need to display date and time in your document, delete this alias.

Click OK to save changes and close the dialog.



Insert the User Name into Printed DocumentsInsert the User Name into Printed Documents
To insert user name into a document's header or footer, first invoke the Header and Footer dialog.

Then, focus an appropriate text box, depending on the required alignment, and click the User Name  button.

When you click this button, the dialog adds an alias within square brackets at the current cursor position. You can surround this
alias with any text you like. If you no longer need to display user name in your document, delete this alias.

Click OK to save changes and close the dialog.



Insert a Logo into Printed DocumentsInsert a Logo into Printed Documents
To insert a logo into a document's header or footer, first invoke the Header and Footer dialog.

Then, focus an appropriate text box, depending on the required alignment, and click the Image  button.

Select the image from the dropdown list.

Click OK to save changes and close the dialog.

�� N o t eN o t e

If the Image button is disabled, then logo insertion is not supported by your software vendor.



Scale Print Preview by Entering a Zoom FactorScale Print Preview by Entering a Zoom Factor
To scale a document, click the Scale  button on the toolbar. The Scaling dialog will be invoked.

Set the required percentage value in the editor.

Click OK to save changes and close the dialog.

�� N o t eN o t e

If you're working with a document loaded from file, you cannot use scaling.



Scale Print Preview by Specifying Width in PagesScale Print Preview by Specifying Width in Pages
To scale a document to fit into X pages, click the Scale  button on the toolbar. The Scaling dialog will be invoked.

Set the required number of pages in the editor.

Click OK to save changes and close the dialog.

�� N o t eN o t e

If you're working with a document loaded from file, you cannot use scaling.



Zoom Print Preview In or OutZoom Print Preview In or Out
Zoom In and Out of a Document

To zoom in a document, click the Zoom In  button on the toolbar, or press CTRL+PLUS SIGN.
To zoom out of a document, click the Zoom Out  button on the toolbar, or press CTRL+MINUS SIGN.

To zoom in or out of a document, you can also hold down CTRL and rotate the mouse wheel.

Use the Magnifier Tool
Use the Magnifier Tool  to switch between 100% and "fit whole page" views. Simply click anywhere in the document, to toggle
views.



Zoom Print Preview by Entering a Zoom FactorZoom Print Preview by Entering a Zoom Factor
To zoom to a specific zoom factor, do one of the following.

Click the Zooming dropdown list button. The following list will be invoked.

Choose one of the zoom factor presets.

You can manually enter any value into the Zooming box.



Zoom Print Preview to Show Whole Pages or Fit ContentZoom Print Preview to Show Whole Pages or Fit Content
Zoom Documents to Fit Page Content
To zoom to the page or text width, click the Zooming box. The following list will be invoked.

To zoom to the page width, click Page Width.
To zoom to the text width, click Text Width.

�� N o t eN o t e

If the preview window will be resized later, the current zoom factor will also be changed, to fit the current page or text width.

Zoom Documents to Display Whole Pages
First, invoke the zooming dropdown (see above).

To display one whole page at a time, click Whole Page.
To fit two pages into the current view, click Two Pages.

�� N o t eN o t e

If the preview window will be resized later, the current zoom factor will be also changed in order to fit one or two pages.

If you want to preview more pages simultaneously, refer to the Show Two or More Pages in Print Preview topic.



Show Two or More Pages in Print PreviewShow Two or More Pages in Print Preview
To preview two or more pages at one time, click the Multiple Pages  button on the toolbar.

Then, in the invoked dialog, hover over the page icons, depending on the required number of pages to preview.

When the required number of pages has been selected, click the popup window to close it and apply changes to the document
view.



Navigate Between Pages in Print PreviewNavigate Between Pages in Print Preview
To navigate between pages, use the scrollbars or navigation buttons    on the toolbar. These buttons allow you to
switch to the first, previous, next, or last page of a document.



Use the Hand Tool in Print PreviewUse the Hand Tool in Print Preview
The Hand Tool enables you to scroll content by dragging the document instead of using scrollbars.

To activate the Hand Tool, click the Hand Tool  button on the toolbar.

Then, after you click a document's page, the mouse pointer is changed from  to . Drag the mouse pointer to scroll the
document.



Navigate in Print Preview Using BookmarksNavigate in Print Preview Using Bookmarks
If a document contains bookmarks, you can use the Document Map panel for navigation purposes.

To toggle this panel's visibility, use the Docuemnt Map  button on the toolbar. To go to a specific bookmark, click it in the
Document Map. As a result, the Print Preview navigates to a document element associated with the bookmark.



Navigate in Print Preview Using ThumbnailsNavigate in Print Preview Using Thumbnails
You can use thumbnails to quickly navigate between document pages.

To show report thumbnails, click the Thumbnails button on the toolbar.

Click a thumbnail to navigate to the corresponding document page.



Search for a Specific Text in Print PreviewSearch for a Specific Text in Print Preview
To search for a specific text throughout a document, click the Search  button on the toolbar, or press CTRL+F. This invokes the
Search panel.

To start searching for the terms, click Next or press ENTER. To find the next occurrence of the terms, do the same. To find the
previous occurrence of the terms, click Previous.

The Search panel also provides the settings button, which invokes the dedicated submenu allowing you to specify whether or not
to use a case-sensitive search and whether or not you need to match the whole word during the search.



Switch Print Preview Display ModeSwitch Print Preview Display Mode
Enable the Facing Layout View
To enable the facing layout view, on the View menu, point to Page Layout, and then click Facing.

This allows you to preserve an entire page view, whether you resize the preview window, scroll a document or choose a multiple
page view mode.

Enable the Continuous Layout View
To enable the continuous layout view, on the View menu, point to Page Layout, and then click Continuous.

This allows you to continuously scroll a page layout view.



Content Editing in Print PreviewContent Editing in Print Preview
If content editing is enabled for document elements, it is possible to customize the corresponding field values in Print Preview.

To highlight all editing fields available in the document, click the Editing Fields  button on the toolbar. This button is not
available when there are no such fields in the document.

Clicking a field will invoke an appropriate editor. To apply the entered values and navigate between editing fields, use the TAB and
SHIFT+TAB keys. In addition to editing text, you can switch check box states.



Change Watermark and Background Settings in Print PreviewChange Watermark and Background Settings in Print Preview
Invoke the Watermark Dialog
To add a watermark to a document, click the Watermark  button on the toolbar, or click Watermark... on the Background
menu. The Watermark dialog will be invoked.

Add a Text Watermark
To add a text watermark, open the Text Watermark tab.

Input the required text, or choose one from the provided options. If required, define other text properties, such as direction, color,
font, size, transparency, etc.

Add an Image Watermark
To add a picture watermark, open the Picture Watermark tab.



Load the image and customize its properties, such as size mode, horizontal and vertical alignment, tiling, transparency, etc.

Specify the Pages Where you will Display Your Watermark
Specify the required pages to apply a watermark in the Page Range section of the dialog.

Separate page numbers with commas, or specify page ranges using a dash.

Add a Background Color to a Document
To add a background color to a document, click the Background Color  button on the toolbar, or click Color... on the
Background menu. The Background Color dialog will be invoked.

Then, choose a color from the Custom, Web or System palettes.



Remove a Watermark in Print PreviewRemove a Watermark in Print Preview
To remove a watermark from a document, invoke the Watermark dialog. Click Clear All, then click OK to save changes and close
the dialog.



Exporting from Print PreviewExporting from Print Preview
There are two options available for a document being exported to.

Export Document to a File on Disk
Send Exported File via E-Mail

Export Document to a File on Disk
To export a document and save the resulting file on your hard drive, do one of the following.

On the toolbar, click the arrow near the Export Document... button .
On the File menu, choose the Export Document... item.

Choose the required format from the invoked list.

Then, you may be prompted to define format-specific options. See corresponding help topics in this documentation for details,
e.g. PDF-Specific Export Options.

Once you've specified exporting options, the Save As dialog appears, allowing you to enter the file name. Then, the following
message will be invoked.

Click Yes, if you want to preview the exported file.

Send Exported File via E-Mail
To send the resulting PDF file via e-mail, do one of the following.

On the toolbar, click the arrow near the Send via E-Mail... button .
On the File menu, choose the Send via E-Mail... item.

Choose the required format in the invoked list.



Then, you may be prompted to define format-specific options. See corresponding help topics in this documentation for details,
e.g. PDF-Specific Export Options.

Once you've specified exporting options, the Save As dialog appears, allowing you to enter the file name.

Finally, the created document will be attached to a new empty message, created in your default mail program.



Copy to the ClipboardCopy to the Clipboard
Aside from exporting a document to a third-party formatted file, you can copy a portion of the document content to the clipboard,
and paste it into an editor compatible with one of the supported third-party formats.

To copy document content to the clipboard, do the following.

1. Select the content of the previewed document by holding down the left mouse button and dragging the mouse pointer, to
create a selection box. Expand the selection box to fit all of the content you wish to print. The selected document elements
are highlighted.

2. To copy the selected content, press CTRL + C or right-click anywhere within the highlighted area of the document, and
select Copy in the context menu.



When pasted to a third-party editor from the clipboard, the report content will automatically be converted to the target format.



PDF-Specific Export OptionsPDF-Specific Export Options
When exporting a document, you can define PDF-specific exporting options using the following dialog.

General Options

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Don't embed these fonts

Specifies font names which should not be embedded into the resulting file to reduce the file size. To separate fonts, use
semicolons.

Convert Images to Jpeg

Specifies whether all bitmaps contained in the document should be converted to JPEG format during export to PDF.

Images quality

Specifies the document's image quality level. The higher the quality, the bigger the file, and vice versa.

Compressed

Specifies whether the resulting file should be compressed.

PDF/A-2b

Specifies whether to enable document compatibility with the PDF/A-2b specification.

Password Security Options



These options allow you to adjust the security options of the resulting PDF file (e.g. enable open document, editing, printing and
copying protection, and specify which changes are allowed).

Signature Options

If an X.509 certificate is applied to your report, you can maintain its options using the Signature Options property of the report
PDF Export Options.

Additional Options

You can also fill the Application, Author, Keywords, Subject, and Title fields. These options specify the Document Properties
of the created PDF file.



HTML-Specific Export OptionsHTML-Specific Export Options
When exporting a document, you can define HTML-specific exporting options using the following dialog.

Export Mode

Specifies how a document is exported to HTML. The following modes are available.

The Single file mode allows export of a document to a single file, without preserving the page-by-page breakdown.
The Single file page-by-page mode allows export of a document to a single file, while preserving page-by-page
breakdown. In this mode, the Page range, Page border color and Page border width options are available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range, Page border color and Page border width options are available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Page border color

Specifies the color of page borders from the available palettes.

Page border width

Specifies the width (in pixels) of page borders.

Title

Specifies the title of the created document.

Character set

Specifies the character set for the HTML document.

Remove carriage returns

Specifies whether to remove carriage returns.

Table layout

Specifies whether to use table or non-table layout in the resulting document.



Export watermarks

Specifies whether to export watermarks to HTML along with the rest of the document content.

Embed images in HTML

Specifies whether to embed images in HTML content.



MHT-Specific Export OptionsMHT-Specific Export Options
When exporting a document, you can define MHT-specific exporting options using the following dialog.

Export mode

Specifies how a document is exported to MHT. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range, Page border color and Page border width options are available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range, Page border color and Page border width options are available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Page border color

Specifies the color of page borders from the available palettes.

Page border width

Specifies the width (in pixels) of page borders.

Title

Specifies the title of the created document.

Character set

Specifies the character set for the HTML document.

Remove carriage returns

Specifies whether to remove carriage returns.

Table layout

Specifies whether to use table or non-table layout in the resulting document.



Export watermarks

Specifies whether to export watermarks to HTML along with the rest of the document content.



RTF-Specific Export OptionsRTF-Specific Export Options
When exporting a document, you can define RTF-specific export options using the following dialog.

Export mode

Specifies how a document is exported to RTF. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range option is available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Export watermarks

Specifies whether the exported document should include watermarks (if they exist).



DOCX-Specific Export OptionsDOCX-Specific Export Options
When exporting a document, you can define DOCX-specific export options using the following dialog:

Export mode

Specifies how a document is exported to DOCX. The following modes are available.

The Single file mode allows export of a document to a single file without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file divided into pages. In this mode, the
Page range option is available.

Page range

Specifies a range of pages which will be included in the resulting file. Use commas to separate page numbers. Use hyphens
to set page ranges.

Export watermarks

Specifies whether the exported document should include watermarks (if they exist).



XLS-Specific Export OptionsXLS-Specific Export Options
When exporting a document, you can define XLS-specific export options using the following dialog.

Export mode

Specifies how a document is exported to XLS. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages.
The Different files mode allows export of a document to multiple files, one for each document page.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Sheet name

Specifies the name of the sheet in the created XLS file.

Text export mode

Specifies whether value formatting should be converted to the native XLS format string (if it is possible), or embedded into
cell values as plain text.

Show grid lines

Specifies whether grid lines should be visible in the resulting XLS file.

Export hyperlinks

Specifies whether hyperlinks should be exported to the XLS document.

Raw data mode

Specifies whether to enable the raw data export mode. In this mode, only a document's actual data is exported to XLS,
ignoring non-relevant elements, such as images, graphic content, font and appearance settings.



XLSX-Specific Export OptionsXLSX-Specific Export Options
When exporting a document, you can define XLSX-specific export options using the following dialog.

Export mode

Specifies how a document is exported to XLSX. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, with each shown in a separate
sheet.
The Different files mode allows export of a document to multiple files, one for each document page.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Sheet name

Specifies the name of the sheet in the created XLSX file.

Text export mode

Specifies whether value formatting should be converted to the native XLSX format string (if it is possible), or embedded into
cell values as plain text.

Show grid lines

Specifies whether grid lines should be visible in the resulting XLSX file.

Export hyperlinks

Specifies whether to include hyperlinks into the resulting file.

Raw data mode

Specifies whether to enable the raw data export mode. In this mode, only a document's actual data is exported to XLSX,
ignoring non-relevant elements, such as images, graphic content, font and appearance settings.



CSV-Specific Export OptionsCSV-Specific Export Options
When exporting a document, you can define CSV-specific exporting options using the following dialog.

Encoding

Specifies the encoding used in the exported document.

Text export mode

Specifies whether to use the formatting of data fields in the bound data source for cells in the exported document. If this
option is set to Text, all data fields are exported to the CSV file as strings with the corresponding formatting embedded into
those strings. If the option is set to Value, all formatting will be lost in the resulting document.

Text separator

Specifies a symbol used to separate text elements (comma by default).

Quote strings with separators

Specifies whether strings with separators should be placed in quotation marks in the exported document.



TXT-Specific Export OptionsTXT-Specific Export Options
When exporting a document, you can define TXT-specific exporting options using the following dialog.

Encoding

Specifies the encoding used in the exported document.

Text export mode

Specifies whether to use the formatting of data fields in the bound data source for cells in the exported document. If this
option is set to Text, all data fields are exported to the text file as strings with the corresponding formatting embedded into
those strings. If the option is set to Value, all formatting will be lost in the resulting document.

Text separator

Specifies a symbol to separate text elements (TAB by default).

Quote strings with separators

Specifies whether strings with separators should be placed in quotation marks in the exported document.



Image-Specific Export OptionsImage-Specific Export Options
When exporting a document, you can define image-specific exporting options using the following dialog.

Image format

Specifies an image format to export a document. Available formats are BMP, GIF, JPEG, PNG, EMF, WMF and TIFF.

Resolution (dpi)

Specifies the required image resolution (in dpi).

Export mode

Specifies how a document is exported to an image. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing the output into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range, Page border color and Page border width options are available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range, Page border color and Page border width options are available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Page border color

Specifies the color of page borders.

Page border width

Specifies the width (in pixels) of page borders.



Passing Parameters in Print PreviewPassing Parameters in Print Preview
Some documents or reports allow you to control data display, and what data is to be displayed by specifying parameter values.

To show the Parameters window, click the Parameters  button on the main toolbar. A window allowing you to change
parameter values will be invoked.

Enter the required values and click Submit. After changing the current values, you can revert back the previously selected values
by clicking Reset.



Customize Printing Settings of ChartsCustomize Printing Settings of Charts
If allowed by your application vendor, you can customize additional print settings of a document. For example, if you are about to
print out a chart, you may be able to customize the chart's printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

None

A chart is printed in the same size identical to that shown on the form.

Stretch

A chart is stretched or shrunk to fit the page on which it is printed.

Zoom

A chart is resized proportionally (without clipping), so that it best fits the page on which it is printed.



Customize Printing Settings of GridsCustomize Printing Settings of Grids
If allowed by your application vendor, you can customize additional print settings of a document. For example, if you are about to
print out a grid, you may be able to customize grid printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

Options tab

Allows you to uncheck elements that you don't want to print.

Behavior tab

Allows you to pre-process a grid before printing it. For instance, you can enable automatic column width calculation, or
automatic group row expansion.



Customize Printing Settings of Pivot TablesCustomize Printing Settings of Pivot Tables
If allowed by your application vendor, you can customize additional print settings of a document. For example, if you are about to
print out a Pivot Table, you may be able to customize its printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

Options tab

Allows you to specify which elements are to be printed.

Behavior tab

Allows you to pre-process a Pivot Table before printing it. For instance, you can enable field value merging.



Customize Printing Settings of Tree ViewsCustomize Printing Settings of Tree Views
If allowed by your application vendor, you can customize additional print settings of a document. For example, if you are about to
print out a tree view, you may be able to customize its printing options.

To do this, click the Customize  button on the toolbar. The Print Options dialog will be invoked.

Options tab

Allows you to specify which elements are to be printed.

Behavior tab

Allows you to pre-process a tree view before printing it. For instance, you can enable automatic column width or row height
calculation.



Warnings and Error Messages in Print PreviewWarnings and Error Messages in Print Preview
Warnings

One or more margins are set outside the printable area of the page.

This message is invoked when you try to print a document whose margins are outside of the printable area of the page.

Click Yes if you are sure that your printer supports the specified page margins. Otherwise, click No.

Errors
The specified file cannot be loaded, because it either does not contain valid XML data or exceeds the allowed
size.

This message is invoked if you try to open a file with an incompatible markup or a file whose size exceeds the allowed size.

These files cannot be loaded in the Print Preview. Try to open a file with a compatible markup and/or a smaller size.



Print Preview for WPFPrint Preview for WPF
The documents in this section provide information on the capabilities of the Print Preview, which is used to display an interactive
document preview.

The Print Preview provides a toolbar and menu that contain commands related to document viewing, navigating, exporting and
printing. It also provides the Document Map for navigating throughout a document using bookmarks, the Parameters panel for
editing report parameters, the Search panel for locating required data, etc.

 

File Management

Save a Print Preview to a File
Load a Print Preview from a File

 

Printing and Page Setup

Print a Document Using the Print Dialog
Print a Document Using Default Settings
Change Print Settings Using the Page Setup Dialog
Scaling

 

Navigating

Navigate Between Pages
Navigate Using Bookmarks
Navigate Using Thumbnails
Navigate Using the Hand Tool
Search for a Specific Text

 

Interactivity



Content Editing in Print Preview

 

Zooming

Zooming

 

Passing Parameters

Passing Parameter Values

 

Watermark

Changing a Watermark

 

Exporting

Exporting
Copying to the Clipboard
PDF-Specific Export Options
HTML-Specific Export Options
MHT-Specific Export Options
RTF-Specific Export Options
DOCX-Specific Export Options
XLS-Specific Export Options
XLSX-Specific Export Options
CSV-Specific Export Options
Text-Specific Export Options
Image-Specific Export Options



Save a Print Preview to a FileSave a Print Preview to a File
If you've modified your document, and there's a chance you'll need to print out this document version more than once, you can
save the document to a file on disk. After that, you can simply load your document and print it out, without having to apply the
same changes again.

To save a document to the file, do one of the following.

Click the Save  button on the toolbar.

On the menu, click Save.

Press CTRL+S.

In the invoked Save As dialog, locate a folder where you want to store your file, enter the document name and click Save.

The document is saved with the .prnx file extension. Note that this extension will be added to the file name even if you enter
another one.

�� N o t eN o t e

If you open a document that was previously saved to the hard drive, it is impossible to change its page settings (e.g., page size,
orientation, margins, etc.). So, the Page Setup and the Scale buttons will be disabled.



Load a Print Preview from a FileLoad a Print Preview from a File
To open a previously saved document, do one of the following.

Click the Open  button on the toolbar.

On the menu, click Open.

Press CTRL+O.

In the invoked Open dialog, select the required file and click Open.

�� N o t eN o t e

If you open a document which was previously saved to the hard drive, it is impossible to change its page settings (e.g., page size,
orientation, margins, etc.). So, the Page Setup and the Scale buttons will be disabled.



Print a Document Using the Print DialogPrint a Document Using the Print Dialog
To print a document, do one of the following.

Click the Print...  button on the toolbar.

On the menu, click Print...

Press CTRL+P.

In the invoked Print dialog, specify the necessary settings (the printer name, number of copies, page range, etc.) and click OK.

To learn how to print the document without invoking the Print dialog, see the Print a Document Using Default Settings topic.



Print a Document Using Default SettingsPrint a Document Using Default Settings
To send a document directly to the default printer without customizing print settings, click the Quick Print  button on the
Preview's toolbar.

To learn how to select a printer, number of copies and other printer options, refer to the Print a Document Using the Print Dialog
topic.



Change Print Settings Using the Page Setup DialogChange Print Settings Using the Page Setup Dialog
To invoke the Page Setup dialog, click the Page Setup...  button on the Print Preview's toolbar.

The Page Setup dialog allows you to do the following.

Change the paper size using the dedicated drop-down.
Select page orientation (Portrait or Landscape).
Specify page margins by entering the required top, left, bottom and right page margin values into the appropriate editors.

�� N o t eN o t e

If you're working with a document that was loaded from a file, the Page Setup button on the toolbar is disabled.



ScalingScaling
To scale a document, click the Scale  button on the Print Preview's toolbar. This invokes the Scale dialog.

The dialog provides two ways for scaling the document.

Scaling by entering a zoom factor.

Select the first option and set the required percentage value in the dedicated editor.

Scaling to fit into X pages.

Choose the second option and specify the required number of pages.

Click OK to save changes and close the dialog.

�� N o t eN o t e

If you're working with a document loaded from a file, you cannot use scaling.



Navigate Between PagesNavigate Between Pages
To navigate between document pages, use the scrollbars or navigation buttons on the Print Preview's toolbar. These buttons
allow you to switch to the first, previous, next, or last page of a document.

To navigate to a specific page of a document, enter the required page in the dedicated editor in the Print Preview's status bar.



Navigate Using BookmarksNavigate Using Bookmarks
If a document contains bookmarks, you can use the Document Map panel for navigation purposes.

To switch to this panel, click the Document Map  button on the Print Preview's toolbar. To go to a specific bookmark, click it
in the Document Map. As a result, the Print Preview navigates to a document element associated with the bookmark.



Navigate Using ThumbnailsNavigate Using Thumbnails
You can use thumbnails to quickly navigate between document pages.

To show thumbnails, click the Thumbnails  button on the Print Preview's toolbar. Click a thumbnail to navigate to the
corresponding document page.



Navigate Using the Hand ToolNavigate Using the Hand Tool
The Hand Tool enables you to scroll content by dragging the document instead of using scrollbars.

To activate the Hand Tool, right-click anywhere within the document, and in the invoked context menu, select Hand Tool.

Then, after you click a document's page, the mouse pointer is changed from  to . Drag the mouse pointer to scroll the
document.



Search for a Specific TextSearch for a Specific Text
To search for a specific text throughout a document, click the Search  button on the Print Preview's toolbar, or press CTRL+F.
This invokes the Search panel.

In the search box on the left, input the text to find. Click the Settings button to invoke the dedicated submenu allowing you to
specify whether or not to use a case-sensitive search, and specify if you are required to match the whole word during the search.

To start searching, or search down again, click Next, or press ENTER or CTRL+G. To search backward, click Previous or press
CTRL+SHIFT+G.



Content Editing in Print PreviewContent Editing in Print Preview
If content editing is enabled for document elements, it is possible to customize the corresponding field values in Print Preview.

To highlight all editing fields available in the document, click the Editing Fields  button on the toolbar. This button is not
available when there are no such fields in the document.

Clicking a field will invoke an appropriate editor. To apply the entered values and navigate between editing fields, use the TAB and
SHIFT+TAB keys. In addition to editing text, you can switch check box states.



ZoomingZooming
To zoom in or out a document, click the Zoom In  or Zoom Out  button on the Print Preview's toolbar. The alternative
way to zoom in and out the document is to hold down CTRL and rotate the mouse wheel.

You can also zoom the document to a specific zoom factor. To do this, click the Zoom button and choose one of the zoom factor
presets from the invoked list.

In addition, this list provides items allowing you to display one whole page at a time and fit the document to the page width. If the
preview window will be resized later, the current zoom factor will also be changed in order to fit one page or the current page
width, respectively.



Passing Parameter ValuesPassing Parameter Values
Certain documents or reports allow you to control what data is to be displayed by specifying parameter values.

To show the Parameters panel, click the Parameters  button on the Print Preview's toolbar. This panel allows you to specify
parameter values before document preview generation is started.

Enter the required values using the corresponding parameter editors and click Submit. After changing the current values, you can
revert back the previously selected values by clicking Reset.



Changing a WatermarkChanging a Watermark
With the Print Preview, you can add a text watermark in a document, or turn a picture into a document's background. It is also
possible to use both textual and image watermarks simultaneously.

To invoke the Watermark dialog, click the Watermark  button on the toolbar.

Adding a Text Watermark
To add a text watermark, open the Text Watermark tab. Input the required watermark's text or choose one of the provided
options in the Text drop-down list. Then, define other text properties, such as direction, color, font, size, transparency, etc.

Adding an Image Watermark
To add a picture watermark, switch to the Picture Watermark tab. To load the image to be used as a watermark, click the ellipsis
button for the Image property. In the invoked dialog, select the file containing the image that you wish to load and click Open.



Then, you can specify the picture's properties, such as the size mode, alignment, transparency, etc.

Specifying Watermark Properties
At the bottom of the Watermark dialog, you can select a watermark position behind or in front of the document, and specify the
page range in which the watermark will be printed.

These settings are in effect both for text and image watermarks.

Removing a Watermark
To remove watermarks from a document, click Clear All in the Watermark dialog. Then, click OK to save changes and close the
dialog.



ExportingExporting
There are two options available for exporting a document to one of the supported third-party formats.

Export Document to a File on Disk
Send Exported File Using E-Mail

Export Document to a File on Disk
To export a document and save the resulting file on your hard drive, click the arrow for the Export... button and select the
required format from the list.

This invokes the Export Document... dialog with options for the selected format.

If you simply click the Export... button, the dialog will provide settings for the PDF format. Then, you can always change the
export format directly in the dialog using the dedicated Export format drop-down list.

In the Export Document... dialog, you should specify the path where the resulting file should be saved and choose whether or
not to open the file after exporting.

To access and customize advanced export options for the selected format, click the More Options link.



Specify the required format-specific options and click OK to initiate export of a report and save the resulting file.

Send Exported File Using E-Mail
To export a document and send the resulting file using e-mail, click the arrow for the Send... button and select one of the
supported formats.

This invokes the Send via E-Mail... dialog with options for the selected format.

If you simply click the Send... button, the dialog will provide settings for the PDF format. Then, you can always change the export
format directly in the dialog using the dedicated Export Format drop-down list.

In the Send via E-Mail... dialog, you should specify the path where the resulting file should be saved. The dialog also allows you
to specify advanced export options for the selected format. To access and customize these format-specific options, click the More
Options link.

Specify the required options and click OK to initiate export of a report and save the resulting file. The saved file will be then
attached to a new empty message in the default mail program.



Copying to the ClipboardCopying to the Clipboard
Besides exporting a document to a third-party formatted file, you can copy a portion of the document content to the clipboard,
and paste it into an editor compatible with one of the supported third-party formats.

To copy document content to the clipboard, do the following.

1. Select the content of the previewed document by holding down the left mouse button and dragging the mouse pointer. The
selected document elements are highlighted.

2. To copy the selected content, press CTRL+C or right-click anywhere within the highlighted area of the document, and select
Copy in the context menu.

When pasted to a third-party editor from the clipboard, the report content will automatically be converted to the target format.



PDF-Specific Export OptionsPDF-Specific Export Options
When exporting a document, you can define the following PDF-specific export options.

General Options

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Don't embed these fonts

Specifies font names which should not be embedded into the resulting file to reduce the file size. To separate fonts, use
semicolons.

Convert Images to Jpeg

Specifies whether all bitmaps contained in the document should be converted to JPEG format during export to PDF.

Images quality

Specifies the document's image quality level. The higher the quality, the bigger the file, and vice versa.

Compressed

Specifies whether the resulting file should be compressed.

PDF/A-2b

Specifies whether to enable document compatibility with the PDF/A-2b specification.



Password Security Options

These options allow you to adjust the security options of the resulting PDF file (e.g. enable open document, editing, printing and
copying protection, and specify what changes are allowed).

Signature Options

If an X.509 certificate is applied to your report, you can maintain its options using the Signature Options property of the report
PDF Export Options.

Additional Options

You can also fill the Application, Author, Keywords, Subject, and Title fields. These options specify the Document Properties
of the created PDF file.



HTML-Specific Export OptionsHTML-Specific Export Options
When exporting a document, you can define the following HTML-specific export options.

Export Mode

Specifies how a document is exported to HTML. The following modes are available.

The Single file mode allows export of a document to a single file, without preserving the page-by-page breakdown.
The Single file page-by-page mode allows export of a document to a single file, while preserving page-by-page
breakdown. In this mode, the Page range, Page border color and Page border width options are available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range, Page border color and Page border width options are available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Page border color

Specifies the color of page borders from the available palettes.

Page border width

Specifies the width (in pixels) of page borders.

Title

Specifies the title of the created document.

Character set

Specifies the character set for the HTML document.

Remove carriage returns



Specifies whether to remove carriage returns.

Table layout

Specifies whether to use table or non-table layout in the resulting document.

Export watermarks

Specifies whether to export watermarks to HTML along with the remaining document content.

Embed images in HTML

Specifies whether to embed images in HTML content.



MHT-Specific Export OptionsMHT-Specific Export Options
When exporting a document, you can define the following MHT-specific export options.

Export mode

Specifies how a document is exported to MHT. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range, Page border color and Page border width options are available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range, Page border color and Page border width options are available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Page border color

Specifies the color of page borders from the available palettes.

Page border width

Specifies the width (in pixels) of page borders.

Title

Specifies the title of the created document.

Character set

Specifies the character set for the HTML document.

Remove carriage returns



Specifies whether to remove carriage returns.

Table layout

Specifies whether to use table or non-table layout in the resulting document.

Export watermarks

Specifies whether to export watermarks to HTML along with the remaining document content.



RTF-Specific Export OptionsRTF-Specific Export Options
When exporting a document, you can define the following RTF-specific exporting options.

Export mode

Specifies how a document is exported to RTF. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range option is available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Export watermarks

Specifies whether the exported document should include watermarks (if they exist).



DOCX-Specific Export OptionsDOCX-Specific Export Options
When exporting a document, you can define DOCX-specific export options using the following dialog:

Export mode

Specifies how a document is exported to DOCX. The following modes are available.

The Single file mode allows export of a document to a single file without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file divided into pages. In this mode, the
Page range option is available.

Page range

Specifies a range of pages which will be included in the resulting file. Use commas to separate page numbers. Use hyphens
to set page ranges.

Export watermarks

Specifies whether the exported document should include watermarks (if they exist).



XLS-Specific Export OptionsXLS-Specific Export Options
When exporting a document, you can define the following XLS-specific exporting options.

Export mode

Specifies how a document is exported to XLS. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range option is available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range option is available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Sheet name

Specifies the name of the sheet in the created XLS file.

Text export mode

Specifies whether value formatting should be converted to the native XLS format string (if possible), or embedded into cell
values as plain text.

Show grid lines

Specifies whether grid lines should be visible in the resulting XLS file.

Export hyperlinks

Specifies whether hyperlinks should be exported to the XLS document.

Raw data mode

Specifies whether to enable the raw data export mode. In this mode, only a document's actual data is exported to XLS,
ignoring non-relevant elements, such as images, graphic content, font and appearance settings.



XLSX-Specific Export OptionsXLSX-Specific Export Options
When exporting a document, you can define the following XLSX-specific exporting options.

Export mode

Specifies how a document is exported to XLSX. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing it into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range option is available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range option is available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Sheet name

Specifies the name of the sheet in the created XLSX file.

Text export mode

Specifies whether value formatting should be converted to the native XLSX format string (if it is possible), or embedded into
cell values as plain text.

Show grid lines

Specifies whether grid lines should be visible in the resulting XLSX file.

Export hyperlinks

Specifies whether to include hyperlinks into the resulting file.

Raw data mode

Specifies whether to enable the raw data export mode. In this mode, only a document's actual data is exported to XLSX,
ignoring non-relevant elements, such as images, graphic content, font and appearance settings.



CSV-Specific Export OptionsCSV-Specific Export Options
When exporting a document, you can define the following CSV-specific exporting options.

Encoding

Specifies the encoding used in the exported document.

Text export mode

Specifies whether to use the formatting of data fields in the bound data source for cells in the exported document. If this
option is set to Text, all data fields are exported to the CSV file as strings with the corresponding formatting embedded into
those strings. If the option is set to Value, all formatting will be lost in the resulting document.

Text separator

Specifies a symbol used to separate text elements (comma by default).

Quote strings with separators

Specifies whether strings with separators should be placed in quotation marks in the exported document.



Text-Specific Export OptionsText-Specific Export Options
When exporting a document, you can define the following TXT-specific exporting options.

Encoding

Specifies the encoding used in the exported document.

Text export mode

Specifies whether to use the formatting of data fields in the bound data source for cells in the exported document. If this
option is set to Text, all data fields are exported to the text file as strings with the corresponding formatting embedded into
those strings. If the option is set to Value, all formatting will be lost in the resulting document.

Text separator

Specifies a symbol to separate text elements (TAB by default).

Quote strings with separators

Specifies whether strings with separators should be placed in quotation marks in the exported document.



Image-Specific Export OptionsImage-Specific Export Options
When exporting a document, you can define the following Image-specific exporting options.

Image format

Specifies an image format to export a document. Available formats are BMP, EMF, WMF, GIF, JPEG, PNG, and TIFF.

Resolution (dpi)

Specifies the required image resolution (in dpi).

Export mode

Specifies how a document is exported to an image. The following modes are available.

The Single file mode allows export of a document to a single file, without dividing the output into pages.
The Single file page-by-page mode allows export of a document to a single file, divided into pages. In this mode,
the Page range, Page border color and Page border width options are available.
The Different files mode allows export of a document to multiple files, one for each document page. In this mode, the
Page range, Page border color and Page border width options are available.

Page range

Specifies a range of pages which will be included in the resulting file. To separate page numbers, use commas. To set page
ranges, use hyphens.

Page border color

Specifies the color of page borders.

Page border width

Specifies the width (in pixels) of page borders.



Report DesignerReport Designer
This documentation section contains information about the basic principles of creating reports with Report Designers.

The Report Designer user interface may vary depending on your application platform.

The following topics are available in this section.

Report Designer for WinForms
Report Designer for WPF



Report Designer for WinFormsReport Designer for WinForms
The Report Designer allows you to create data-bound reports and provides a rich set of tools to construct report layouts that meet
your requirements.

First Look at the Report Designer
Add New Reports
Open Reports
Save Reports
Introduction to Banded Reports
Bind to Data
Create Popular Reports
Configure Design Settings
Use Report Elements
Shape Report Data
Lay out Dynamic Report Content
Customize Appearance
Add Navigation
Provide Interactivity
Add Extra Information
Use Expressions
Use Report Scripts
Report Designer Tools
Preview, Print and Export Reports

�� N o t eN o t e

Specific features described in this guide may differ from what you see in your application. This depends on your application



vendor.



First Look at the Report DesignerFirst Look at the Report Designer

The design surface displays a report's structure and contents. You can use the tools on the Report Designer's panels to design the
report:

access the report's data source schema in the Field List;

drop report controls from the Toolbox to the design surface;

use the Ribbon toolbar and Property Grid to set up the report controls;

access the report's elements in the Report Explorer;

use the Group and Sort panel to manage the report's group and sort settings.

A blank report's design surface displays page margins and an empty detail band.



Use the zoom panel to change the Report Designer's default zoom factor.

Switch to the Preview tab. This opens a Print Preview and displays the generated report document with the data source's data.



Switch to the Scripts tab to manage and customize report scripts.



Add New ReportsAdd New Reports
This topic explains how to create a new report in the Report Designer.

 T i pT i p

Before you start, make sure to back up the current report.

Create a New Blank Report
You can use one of the following commands to create a new report. The created report contains three bands - Top Margin,
Detail, and Bottom Margin. Refer to the Use Report Elements section for information on how to add controls to the report.

Use the R ibbon's Home TabUse the R ibbon's Home Tab

Click New Report.

Use the R ibbon Application MenuUse the R ibbon Application Menu

Click the application button and then New Report.

Use a Shor tcutUse a Shor tcut

You can also use the CTRL+N shortcut to create a new report.

Create a New Report Using the Report Wizard
The following commands run the Report Wizard. Go through the wizard's pages to get a predesigned report.



Use the R ibbon's Home TabUse the R ibbon's Home Tab

Click New Report and then New Report via Wizard....

Use the R ibbon Application MenuUse the R ibbon Application Menu

Click the application button and then choose New Report | New Report via Wizard....

Use a Shor tcutUse a Shor tcut

You can also use the CTRL+W shortcut to run the Report Wizard.



Open ReportsOpen Reports
You can use different commands to open a report. The Open dialog displays saved report files with the REPX extension. These
files store information about the report's layout. Select a report file and press Open.

Use the R ibbon Application MenuUse the R ibbon Application Menu

Click Open....

Use the R ibbon Application MenuUse the R ibbon Application Menu

Click the application button and then Open... in the invoked application menu.

Use a Shor tcutUse a Shor tcut

You can also use the CTRL+O shortcut to open a report.



Save ReportsSave Reports
Reports are saved as a file with an REPX extension. This file stores information about the report layout.

You can use one of the following commands to save reports:

Use the Ribbon's Home Tab
Click Save| Save As to save a copy of the report.

Specify the folder and file name in the invoked Save As dialog.

Click Save or press CTRL+S to save the report's layout in the application's folder.

Use the Ribbon Application Menu
You can use the Save or Save As command in the application's menu to save the report's current layout or save a copy of the
report.



Introduction to Banded ReportsIntroduction to Banded Reports
Banded reports provide a generalized report layout notion. When you preview a banded report, a report document is generated
based on the report layout and data source.

Report Bands
A report layout consists of bands that contain report controls and define their location on document pages. A blank report
contains the following bands:

The Detail Band is printed for every record in a data source unless you filtered the data.

Every report should have a detail band, and you cannot delete it.

The Top Margin and Bottom Margin bands. These bands are repeated once on every document page.

You can also add the following bands:

Report Header and Report Footer

The Report Header is the report's first band (margins are "out-of-page" zones). Use this band to display the report's name,
company logo, date of creation, username, etc.

The Report Footer is placed before the Page Footer and Bottom Margin on the report's last page. You can use the Report
Footer band for report summaries or conclusions.

Page Header and Page Footer

These bands are at the top and bottom of every page in a report. They display information that should be printed on every
page.

Group Header and Group Footer

These bands are above and below each group. The Group and Sort Panel create these bands automatically.
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Only the detail and group bands can be used to display dynamic data source contents. Other bands display titles, summaries, and



extra information.

The following image illustrates a sample report layout and the Report Explorer that reflects the report's structure:

Add a Detail Band to a Master-Detail Band
Use the Detail Report band to create hierarchical master-detail reports. Detail report bands provide detailed information about
each record in the master report's detail band (for example, orders shipped to each customer). You can create such reports when
master-detail relationships are defined between data source tables:

The Detail Report band is a separate report (subreport) with its own data source and different bands. A report can have any
number of detail reports that can also be nested.

The following image illustrates a master-detail report and the Report Explorer that reflects the report's structure:



Vertical Bands
You can replace the Detail band with the Vertical Header, Vertical Detail and Vertical Total bands to display record fields vertically
and print data records horizontally - from left to right (and vise versa if the report's RTL mode is enabled).

To add vertical bands to your report, right-click the report in the Report Designer and choose Insert Vertical Band in the invoked
context menu.



�� N o t eN o t e

If your report's Detail band contains report controls, this band and all these controls are lost when you add a vertical band (the
same behavior takes place in the opposite situation).

The following vertical bands are available:

Vertical Header
Contains headers of the report's data fields. These headers are arranged vertically.
Vertical Details
This band is printed for every record in a data source unless you filtered the data. The records are displayed one after
another in a horizontal direction.
Vertical Total
This band is placed at the rightmost position (leftmost when RTL is enabled). You can use the Vertical Total band for report
summaries or conclusions.

You can use the Report Wizard to create a report with vertical bands. Refer to the Create a Vertical Report topic for instructions on
how to create a report with vertical bands.

Create Band Copies
You can create functional copies of a band, for example, to display different contents based on a specific condition. To do this, add
sub-bands to bands.
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See Lay out Dynamic Report Content for details on how to specify the location of bands' content on document pages.

Manage Report Bands
H ide B ands in the Repor t D esignerH ide B ands in the Repor t D esigner

Click the arrow button on the band's title to collapse or expand the band.

H ide B ands in the Repor t D ocumentH ide B ands in the Repor t D ocument

You can avoid printing band content in a document. To do this, select the band and set the band's Height property to zero or
disable its Visible property in the Property Grid.



Remove B andsRemove B ands

Select a band on the report design surface and press DELETE. This removes the band and all its content.

Add B andsAdd B ands

To add a band, right-click a report's design surface, and in the invoked context menu, choose Insert Band.

You can insert a detail report band if the report's data source has master-detail relations.

Access the B ands Collect ionAccess the B ands Collect ion



Click the Edit and Reorder Bands context link in a report's smart tag to access the report's bands collection.

This command is also available in a band's context and smart tag menus.

The invoked editor allows you to reorder bands and change their properties.

Alternatively, use the Report Explorer to edit and reorder bands. Select a band and edit its properties in the Property Grid.

Drag a band to change its order or move inside/outside of another band. The drop targets are highlighted when you drag a band
over them.



You can drag bands to the following targets:

D R AG G ED  B AND D R OP TAR G E TS

SubBand All bands except TopMargin and BottomMargin

GroupHeader, GroupFooter XtraReport (root node), DetailReport

DetailReport XtraReport (root node), DetailReport

Apply Styles to Bands
Select a band and switch to the Property Grid. Expand the Styles group and set the Style property to the style name.

As an alternative, you can drag a style from the Report Explorer onto a band. This is applicable to all bands except DetailReport.





Bind to DataBind to Data
The following tutorials illustrate how to bind a report to various data sources:

Bind a Report to a Database
Bind a Report to a Stored Procedure
Bind a Report to an XML File
Bind a Report to an Entity Framework Data Source
Bind a Report to an Object Data Source
Bind a Report to an Excel Workbook
Bind a Report to a CSV File
Bind a Report to JSON Data
Bind a Report to XPO Persistent Object
Bind a Report to a Join-Based Federated Data Source
Bind a Report to a Union-Based Federated Data Source
Bind a Report to a Federated Master-Detail Data Source

The following topics describe how to bind report controls to data:

Data Binding Modes
Bind Report Controls to Data (Expression Bindings)
Bind Report Controls to Data (Data Bindings)
Use Embedded Fields (Mail Merge)
Update Report Data Bindings



Bind a Report to a DatabaseBind a Report to a Database
This tutorial demonstrates how to bind a report to a hierarchical data source and specify a master-detail relationship between
data source queries:

1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the first page of the invoked Data Source Wizard, select Database and click Next to proceed.

4. The next page allows you to specify whether you want to use an existing data connection or create a new data connection
from scratch. Select the first option to create a new connection and click Next.



5. On the next page, you can define a custom connection string, or select one of the supported data providers.

Depending on the data provider selected, it may be necessary to specify additional connection options (such as the
authentication type and database name) on this page.

To proceed to the next wizard page, click Next.

6. On the next page, you can choose which tables, views and/or stored procedures to add to the report.

To create a master-detail report, select two or more tables and click Manage Relations.



In the invoked editor, connect the required key fields (columns) using drag and drop.

Click OK to close the editor.

�� N o t eN o t e

When you are required to shape data at the level of a data source, you can create custom queries by expanding the Queries
category and clicking the plus button.

This will invoke the Query Builder where you can create complex queries by joining multiple tables, filtering, sorting and
grouping their data, as well as calculating various aggregate functions.

Although it is also possible to join different tables within a single query, creating hierarchical data sources is preferred in
most cases to provide better performance (in general, master-detail reports are generated faster than similar-looking
reports created by grouping "flat" data sources).

Click Finish to complete the Data Source Wizard. If the selected queries or stored procedures contain any parameters, you can
go to the next wizard page and define their values.

The newly created SQL data source will be displayed in the Components node of the Report Explorer. Additionally, the hierarchy



of the data source will be reflected by the Field List. In both panels, you can right-click the data source to access its settings.



Bind a Report to a Stored ProcedureBind a Report to a Stored Procedure
This tutorial demonstrates how to bind a report to a stored procedure provided by an SQL data source:

1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the first page of the invoked Data Source Wizard, select Database and click Next.

4. The next page allows you to specify whether you want to use an existing data connection or create a new data connection
with custom parameters. Select the first option to create a new connection and click Next.



5. On the next page, you can define a custom connection string or select from the list of supported data providers. Depending
on the data provider selected, it may be necessary to specify additional connection options (such as authentication type and
database name) on this page.

To proceed to the next wizard page, click Next.

6. On the next page, you can choose which tables, views and/or stored procedures to add to the report. Expand the Stored
Procedures category, select the required stored procedure from the list of available stored procedures and click Next.



7. Then, the wizard generates query parameters for each stored procedure parameter. The next wizard page presents the
generated query parameters. You can assign a static value or an expression to a parameter. In addition, you can map a
report parameter to a query parameter. This is helpful when you specify parameter values in the report's Preview. For
details on how to configure query parameters, refer to the Use Query Parameters topic.

Click the Preview button and select a query to preview the result of the stored procedure execution with the specified
parameters.

The following image demonstrates the Data Preview displaying the resulting data sample. Click Close to exit the preview.

Click Finish to exit the wizard.



Bind a Report to an XML FileBind a Report to an XML File
This tutorial demonstrates how to bind a report to data stored in an external XML file.

1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the first page of the invoked Data Source Wizard, select Database and click Next.

4. The next page allows you to specify whether you want to use an existing data connection or create a new data connection.
Select the first option and click Next.



5. On the next page, specify the data provider (XML file) and the path to the database file.

To proceed to the next wizard page, click Next.

6. On the next page, you can choose which tables, views and/or stored procedures to add to the report. You can also construct
custom queries using the Query Builder. Click Finish to exit the wizard.

�� N o t eN o t e

Some of the data shaping capabilities available to SQL data sources (such as sorting, grouping and filtering data, as well as
using aggregate functions) are not supported for XML files.

The newly created SQL data source will be displayed in the Components node of the Report Explorer. Additionally, the hierarchy



of the data source will be reflected by the Field List.



Bind a Report to an Entity Framework Data SourceBind a Report to an Entity Framework Data Source
This document describes how to use an Entity Framework data source to bind a report to data provided by an Entity Framework
data context:

1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the first page of the invoked Data Source Wizard, select the Entity Framework and click Next.

4. On the next page, select the required data context. You can bind it to an Entity Framework data context that is contained in
either the current project assembly or a separate assembly.

To use a data context that exists in the current project assembly, select it in the Choose Context list and click Next.



Select the required data context and click Next.

5. On the next page, specify a connection string to be used to establish a data connection using one of the following two
options.

Use an existing connection string available in the current project. To do this, select Yes, let me choose from the list.
Next, select the required connection string from the list of the available connection strings.

Specify a connection string manually. To do this, select No, specify a custom connection string and click Next. On
the next page, specify a connection string. You can choose to use the default connection string or specify a custom
connection string.



6. The next wizard page is available only if the current entity data model contains stored procedures. This page allows you to
add stored procedures to the data source and configure their parameters. Click Finish to exit the wizard.

The newly created data source will be displayed in the Components node of the Report Explorer. Additionally, the hierarchy of
the data source will be reflected by the Field List.



Bind a Report to an Object Data SourceBind a Report to an Object Data Source
This tutorial describes how to bind a report to an object data source:

1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the next wizard page, choose the Object Binding option and click Next.

4. The following wizard page allows you to select an assembly that contains the data source's class type definition. Use the
Show only highlighted assemblies checkbox to exclude irrelevant assemblies from this list.



5. On the next wizard page, select a data source type. Enable the Show only highlighted types checkbox to hide irrelevant
classes from this list.

6. The next wizard page enables you to select whether to obtain the data source schema (enabling you to edit the report layout
without having access to the actual underlying data) or retrieve the actual data from the data source. Choose the second
option and click Next.

7. On the following wizard page, select a data source constructor and click Next. Use the Show only highlighted
constructors checkbox to exclude irrelevant constructors from this list.



8. The next wizard page allows you to specify the constructor parameters.

Enabling the checkbox in the Expression column allows you to specify the parameter expression (using the Expression
Editor), as well as pass an existing report parameter to the constructor (or create a new report parameter using the in-place
editor).

Click Finish to complete the wizard.

The newly created data source will be displayed in the Components node of the Report Explorer. Additionally, the hierarchy of
the data source will be reflected by the Field List.



Bind a Report to an Excel WorkbookBind a Report to an Excel Workbook
This tutorial describes how to bind a report to data obtained from a Microsoft Excel workbook:

1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the first page of the invoked Data Source Wizard, select Excel File and click Next.

4. On the next wizard page, select a required Excel workbook. To do this, click the ellipsis button and locate the source file or
enter the full path to this file. The XLS, XLSX and XLSM formats are supported.



Click Next to proceed to the next wizard page.

5. The next wizard page allows you to specify import settings.

Enable the first check box to use values of the first row as field names. If you disable this option, values of the first row will
be imported as data and field names will be generated automatically. You can also specify whether to include empty rows to
the result data source and whether to skip hidden rows and columns.

Specify required settings and click Next.

6. On the next wizard page specify from which part of the workbook to extract data. All worksheets, tables and named regions
existing in the workbook are listed here.



7. The next wizard page allows you to select required columns and specify their settings.

To include a column to the resulting data source, enable the corresponding Selected check box. Use Name to specify the
custom column name and Type to choose the column type.

On this page, you can also preview the resulting data by clicking the Preview... button.



Click Finish to complete the wizard.

The created data source becomes displayed in the Report Explorer's Components node. The Field List reflects the data source's
hierarchy.



Bind a Report to a CSV FileBind a Report to a CSV File
This tutorial describes how to bind a report to data obtained from a CSV file:

1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the first page of the invoked Data Source Wizard, select Excel File and click Next.

4. On the next wizard page, click the ellipsis button and locate the required CSV file or enter the full path to the file.



Click Next to proceed to the next wizard page.

5. The next wizard page allows you to specify the import settings.

Enable the first check box to use values of the first row as field names. If you disable this option, values of the first row will
be imported as data and field names will be generated automatically. The Skip empty rows option specifies whether to
include empty rows to the result data source.

This page also provides the Encoding, Newline type and Value separator settings that specify the character encoding,
the line break type and a character used to separate values in the CSV document. To automatically determine values of
these settings, enable the corresponding Detect automatically check boxes. You can also disable these check boxes and
manually choose desired values in the drop-down lists.

Use the Culture option to specify the culture information. The Text Qualifier setting allows you to select the character that
encloses values in the source file.

Enable the Trim Blanks check box to delete all leading and trailing empty spaces from each value in the CSV file.



Specify required settings and click Next.

6. The next page allows you to select required columns and specify their settings.

To include a column to the result data source, enable the corresponding Selected check box. Use Name to specify the
custom column name and Type to choose the column type.

On this page, you can also preview the result data by clicking the Preview button.



Click Finish to complete the wizard.

The created data source becomes displayed in the Report Explorer's Components node. The Field List reflects the data source's
hierarchy.



Bind a Report to JSON DataBind a Report to JSON Data
This topic describes how to bind a report to JSON data at design time.

Create JsonDataSource
1. Create a new report.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the DataSource property and click
Add New Data Source...

This invokes the Data Source Wizard.

3. Choose the JSON option and click Next.



�� N o t eN o t e

The Report Designer's Report Wizard provides the JSON option if the application has a reference to the open-source
Newtonsoft.Json library.

4. The next wizard page allows you to specify the location of the JSON-formatted data:

Web Service Endpoint URI

File Name



String with JSON Content

If you choose the Web Service Endpoint option, you can configure a connection string on the next wizard pages.

4.1. Specify request parameters.
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Specify the Basic HTTP Authentication parameters or header parameters to access JSON data.

5. On the next page, the wizard shows the specified JSON data's structure. You can choose all nodes or a subset of nodes.



Uncheck the data fields that your report does not require.

You can rename data fields if necessary.

After you finish the wizard, it creates the JsonDataSource component. This component retrieves the checked data fields that the
selected JSON element includes. The Field List reflects the data source structure.

Customize the JSON Data Source
Right-click the JsonDataSource component in the Field List or Report Explorer and choose Edit.... Specify another JSON data
location and reconfigure data fields in the invoked wizard.

Customize the JSON Data Source Schema
Right-click the JsonDataSource component in the Report Explorer and choose Edit Schema.... Reconfigure data fields in the
invoked wizard page.





Bind a Report to an XPO Persistent ObjectBind a Report to an XPO Persistent Object
This topic describes how to bind a report to XPO data at design time.

Create XPObjectSource
1. Create a new report.

2. Click the report's smart tag. In the invoked action list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

This invokes the Data Source Wizard.

3. Choose the XPO option and click Next.



4. The following wizard page lists your application project's persistent object classes. Choose one entity type.

5. On the next page, specify whether to use an existing data connection or create a new data connection.

6. To create a new data connection, select a data provider or define a custom connection string.

Specify provider-specific connection options (for example, the authentication type and database name).



Finish the wizard. At this step, the wizard creates an XPObjectSource component. This component retrieves all the properties the
chosen entity type includes. The Field List reflects the data source structure.

You can customize the field list and set up the component's settings after you finish the wizard.

Customize Data Source Settings
You can customize the created XPObjectSource component's settings. To do this, select this component in the Report Explorer
and switch to the Property grid.



These settings allow you to specify which data to retrieve from the data source.

�� N o t eN o t e

Group/filter combinations and complex expressions support depends on the data source.

Change the Connection ParametersChange the Connection Parameters

Use the ConnectionStringName property to change the connection string name only or the ConnectionString property to
reconfigure a connection string. These properties are available in the Property Grid.

You can also right-click the XPObjectSource component in the Report Explorer and choose Configure Connection... to invoke
the wizard and reconfigure the connection string.



Change the Entity TypeChange the Entity Type

Use the EntityType property to specify another persistent object class.

This reloads the Field List. It displays the fields that correspond to the the newly specified type. You can bind report elements to
these fields.

Change the P roper ty SetChange the P roper ty Set

XPO loads all the persistent properties that the specified entity type exposes. You can use the XPObjectSource component's
Properties property to customize the properties set.



Click the Properties property's ellipsis button. This invokes the Properties Collection Editor.

You can specify the following options for the newly added properties:

Name
The name that you use to access the property in the report.

PropertyExpression
The entity's persistent property or an expression that you can construct using several properties. The expression is
calculated on the server.

Group
Indicates whether to use this property to group data that XPO retrieves from the server.

Fetch
Indicates whether to retrieve data for this property from the server.

�� N o t eN o t e

At least one property in the Properties collection must have an enabled Fetch property.



Use the Clear Properties command to clear the Properties collection and the Populate Properties command to add all the
properties the entity type exposes.

The Field List contains the fields that correspond to the Properties collection's properties. If this collection is empty, the Field List
reflects the data source structure.

Retrieve Filtered D ataRetrieve Filtered D ata

Use the XPObjectSource's Filter property to specify a filter expression for the data XPO retrieves from the data source.

Retrieve Sor ted D ataRetrieve Sor ted D ata

Use the XPObjectSource's Sorting property to specify sort settings for the retrieved data.



The XPObjectSource supports multiple column sorting. You can also specify a sorting expression for the data XPO retrieves from
the data source.

Retrieve Filtered G roupsRetrieve Filtered G roups

Use the XPObjectSource's **GroupFilter property to filter data on the server against values of the grouped properties.

�� N o t eN o t e

The Group Filter property is available when the Properties collection in not empty and has at least one property with an enabled
Group flag.

Limit the Retrieved Records' NumberLimit the Retrieved Records' Number

Use the following properties to limit the number of records XPO retrieves from the server:



Top Returned Records
Specifies the number of the top records in the data source XPO retrieves for the report.

Skip Returned Records
Specifies the number of top records in the data source XPO skips when it retrieves data for the report.

�� N o t eN o t e

The XPObjectSource does not process the zero value.

Specify Query ParametersSpecify Query Parameters

You can define parameters and use them in Properties, Filter, Sorting and GroupFilter expressions.

The following properties are available for each query parameter:

Name
Specifies the parameter's name.
Type
Specifies the parameter value's data type.
Expression
Determines whether the actual parameter value is static or generated dynamically.
Value
Specifies the query parameter's actual value (a static or dynamically calculated). If the Expression option is enabled, you
can assign a report parameter or an expression that can also include a report parameter.

You can set a parameter to a static value or generate it dynamically based on an associated expression.



Specify a static value

Choose a query parameter's value type and set a static value to the Value property according to the selected type.

Provide a dynamic value

Activate the Expression checkbox for a parameter.

The following three options are available to dynamically calculate the parameter's actual value:

Select Expression Editor to construct an expression in the invoked Expression Editor.

Selecting New Report Parameter to create a new report parameter and map it to the query parameter. Ensure the
report parameter's type corresponds to the query parameter's type.

Select an existing report parameter and map it to the query parameter.



Bind a Report to a Join-Based Federated Data SourceBind a Report to a Join-Based Federated Data Source
This topic describes how to create a federated data source that joins data from multiple data sources into a single query.

Create a Report and Data Sources
1. Create a new blank report.

2. Add a SQL data source that provides one data table.

3. Add an Excel data source that provides the other data table.

Create Data Federation and Bind the Report to It
1. Click the report's smart tag, expand the Data Source property's drop-down menu, and click Add New DataSource.

2. In the invoked Data Source Wizard, select Data Federation and click Next.



3. On the next page, click Add Query.

4. In the invoked Query Builder, drag and drop the table from the SQL data source onto the design surface.



5. Drag and drop the Excel data source onto the design surface. In the invoked Join Editor, select the Inner join type and
create a relationship based on the key field.

6. Enable checkboxes for the data fields you want to include in the query result set.



7. Click OK to close the Query Builder. Click Finish to complete the Data Source Wizard.

The Wizard creates a new FederationDataSource that includes the single query. This data source becomes available in the
Report Explorer's Components node. The Field List reflects the data source structure.

The federated query's default name is the same as the main table's name. To rename this query, right-click the data source in the
Field List or Report Explorer and select Manage Queries in the context menu.

Once you rename the query, update the report's Data Member property.



Design the Report Layout
1. Click the report's smart tag and select Design in Report Wizard.

2. In the invoked Report Wizard, select Table Report and click Next.



3. Select data fields to display in the report and click Finish. You can also go to the next page to create the layout.

The resulting layout looks similar to the following image:

Switch to the Preview mode to see the report document.





Bind a Report to Union-Based Federated Data SourceBind a Report to Union-Based Federated Data Source
You can create a federated data source for your report to display data combined from several sources. This topic demonstrates
how to use the Union and UnionAll operations to combine data into a single query.

Create a Report and Data Sources
1. Create a new blank report.

2. Add a SQL data source that provides one data table.

3. Add an Excel data source that provides the other data table.

Create Data Federation and Bind the Report to It
1. Click the report's smart tag, expand the DataSource property's drop-down menu and click Add Report Data Source.

2. In the invoked Data Source Wizard, select Data Federation and click Next.



3. On the next page, click Add Query.

4. In the invoked Query Builder (adapted to federated data sources), choose Union as a query type.

Or you can choose Union All.



5. Double-click the Customers table and the Excel data source. The two sources are added to the query.

The query includes only fields that have identical names and types in the origin sources.

6. Enable check boxes for the data fields you want to include in the query result set.

7. Rename fields.



8. Click OK to close the Query Builder. Click Finish to complete the Data Source Wizard.

The Wizard creates a new FederationDataSource that includes the single Customers query. This data source becomes available
in the Report Explorer's Components node. The Field List reflects the data source structure.

The federated query's default name equals to the first source's name (the Customers table in this tutorial). You can rename this
query in the Manage Queries dialog. To invoke it, right-click the data source in the Field List or Report Explorer and select
Manage Queries in the context menu.

Once you rename the query, update the report's DataMember property.



Design the Report Layout
1. Click the report's smart tag and select Design in Report Wizard.

2. In the invoked Report Wizard, select Table Report and click Next.



3. Select data fields to display in the report and click Finish. You can also go to the next page to continue layout creation.

The resulting layout looks similar to the following image:



Switch to the Preview tab to see the report document. It displays contacts from the Customers and Suppliers tables.

�� N o t eN o t e

Duplicate contacts from the Customers and Suppliers tables are not removed in the Union All mode.



Bind a Report to a Federated Master-Detail Data SourceBind a Report to a Federated Master-Detail Data Source
This topic describes how to create a federated data source that retrieves data from multiple data sources. The topic also shows
how to specify a master-detail relationship between these queries.

Create a Report and Data Sources
1. Create a new blank report.

2. Add a SQL data source that provides one data table.

3. Add an Excel data source that provides the other data table.

Create Data Federation and Bind the Report to It
1. Click the report's smart tag, expand the Data Source property's drop-down menu, and click Add New DataSource.

2. In the invoked Data Source Wizard, select Data Federation and click Next.



3. On the next page, enable check boxes for the SQL data source's table and the Excel data source. The selected items are
included in data federation as separate queries.

Click Manage Relations to specify a master-detail relationship between these queries.

4. In the invoked editor, drag and drop the key field from the master query to the detail query.



5. Click OK to close the editor. Click Finish to complete the Data Source Wizard.

The Data Source Wizard creates a new FederationDataSource that includes two queries with a master-detail relationship. This
data source becomes available in the Report Explorer's Components node. The Field List reflects the data source's structure.

The Data Source Wizard specifies query names as follows:

If the initial data source contains data at the root level (as the Excel data source), the federated query's name equals to the
data source name.
If the initial data source contains one or more queries (as the SQL data source), the federated query's name consists of the
data source name and query name separated by an underscore.

You can rename queries in the Manage Queries dialog. To invoke it, right-click the data source in the Field List or Report
Explorer and select Manage Queries in the context menu.



The master-detail relationship's name changes accordingly.

Once you rename the query, update the report's Data Member property.

Design the Report Layout
1. Click the report's smart tag and select Design in Report Wizard.



2. In the invoked Report Wizard, select Table Report and click Next.

3. Select data members for the report and its detail reports. Select data fields to display in the report and click Finish. You can
also go to the next page to continue layout creation.



The resulting layout looks similar to the following image:

Switch to the Preview mode to see the report document.





Data Binding ModesData Binding Modes
The Report Designer uses one of the following modes to provide dynamic content to your reports: expression bindings or
standard data bindings.

Expression Bindings
Expression bindings enable you to use complex expressions that include two or more fields and various functions. Expressions
also allow you to calculate complex summaries without scripts and conditionally shape your data without formatting rules.

This mode is enabled in the Report Designer if a control's smart tag includes the Expression property.

Data Bindings
Standard data bindings enable you to assign a single data field to a report control or use report scripts to provide custom logic.

This mode is enabled in the Report Designer if a control's smart tag includes the Data Binding property.

Conversion Dialog
The following dialog appears only when expression bindings are enabled in the Report Designer, and you open an existing report
that uses standard data bindings:



This dialog prompts you to convert your report to use expressions (the new binding mechanism). Click Yes to run the report
conversion, click No to open the report without changes.

See the section below for information on how to use expressions instead of data bindings.

Binding Mode Comparison
B ind to a S ingle D ata FieldB ind to a S ingle D ata Field

The Field List panel allows you to drop fields onto the design surface or existing report controls. All binding ways are
identical in the data bindings and expression bindings modes.

The control's smart tag enables you to select the target data field in the corresponding drop-down list.

E X PR ES S ION B IND ING S D ATA B IND ING S

You can select a report control and bind it to data in the Property Grid.

E X PR ES S ION B IND ING S D ATA B IND ING S



Click the Text property's marker and choose the Text Expression item.
Specify an expression in the invoked Expression Editor.

Expand the (Data Bindings) group in the Data tab and
assign a data field to the Text property.

See the following topics for more information:

Bind Report Controls to Data (Expression Bindings)
Bind Report Controls to Data (Data Bindings)

B ind to Mult iple D ata FieldsB ind to Mult iple D ata Fields

E X PR ES S ION B IND ING S D ATA B IND ING S

Use the mail merge functionality.

Click the Expression property's ellipsis button and specify the expression.

Use the mail merge functionality.

Calculate SummaryCalcu late Summary

E X PR ES S ION B IND ING S D ATA B IND ING S



Select the summary function in the Expression Editor's Summary
section.

All functions has the 'sum' prefix.

See Calculate a Summary for more information.

Select the summary function in the Summary Func drop-down list.

See Calculate a Summary for more information.

Complex B indings,  Custom SummaryComplex B indings,  Custom Summary

E X PR ES S ION B IND ING S D ATA B IND ING S

Use the Expression Editor to construct an expression of any complexity.

Refer to Calculate an Advanced Summary for an example.

Use report scripts.

Refer to Calculate a Custom Summary for an
example.

Condit ionally Customize AppearanceCondit ionally Customize Appearance

E X PR ES S ION B IND ING S D ATA B IND ING S



Use the Expression Editor to construct expressions for a control's
appearance and style properties.

Refer to Conditionally Change a Control Appearance for an example.

Create formatting rules and assign them to report controls.

Refer to Conditionally Change a Control Appearance for an
example.



Bind Report Controls to Data (Expression Bindings)Bind Report Controls to Data (Expression Bindings)
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Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Bind Report Controls to Data (Data Bindings) topic to learn about an alternative approach.

You can use the following approaches to include a data source's information in your report:

Use the Field List
Use the Smart Tag
Use the Property Grid

Use the Field List
After you bind your report to data, the Field List panel displays the data source's hierarchy and provides access to the available
data fields.

Drop a data field from this panel onto a report's surface to create a new report control bound to the corresponding field.

Drop a data field onto an existing control to bind this control to the corresponding field.



You can do one of the following to create a data-bound control of a specific type:

Hold down the SHIFT key and drop a data field onto a report's surface.
Right-click a corresponding data field and drop it onto a report's surface.

This invokes a context menu that enables you to select which control to create.

You can also drop an entire data table onto a report to create a Table control with its cells bound to the corresponding data table
fields.

To select multiple fields in the Field List, hold CTRL or SHIFT and click the fields. Drop these fields onto a report to create a new
table.

Use the Smart Tag
Click a control's smart tag, expand the Expression drop-down list and select a data field.



You can also click the Expression option's ellipsis button to invoke the Expression Editor. This editor allows you to construct a
complex binding expression with two or more data fields and various functions. See Expression Syntax for more information.

Use the Property Grid
Click a property marker to see whether the invoked context menu has the PropertyName Expression item.

Click this item to specify an expression in the invoked Expression Editor.



You can use the same approach to specify expressions for all the control properties. See Shape Report Data for more tutorials.



Bind Report Controls to Data (Data Bindings)Bind Report Controls to Data (Data Bindings)
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Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Bind Report Controls to Data (Expression Bindings) topic to learn about an alternative approach.

You can use the following approaches to include a data source's information in your report:

Use the Field List
Use the Smart Tag
Use the Property Grid

Use the Field List
After you bind your report to data, the Field List panel displays the data source's hierarchy and provides access to the available
data fields.

Drop a data field from this panel onto a report's surface to create a new report control bound to the corresponding field.

Drop a data field onto an existing control to bind this control to the corresponding field.



You can do one of the following to create a data-bound control of a specific type:

Hold down the SHIFT key and drop a data field onto a report's surface.
Right-click a corresponding data field and drop it onto a report's surface.

This invokes a context menu that enables you to select which control to create.

You can also drop an entire data table onto a report to create a Table control with its cells bound to the corresponding data table
fields.

To select multiple fields in the Field List, hold CTRL or SHIFT and click the fields. Drop these fields onto a report to create a new
table.

Use the Smart Tag
Click a control's smart tag, expand the Data Binding drop-down list and select a data field.



Use the Property Grid
In the Property Grid, expand the (Data Bindings) category and specify a data field for a required property (for instance, Text).



Use Embedded Fields (Mail Merge)Use Embedded Fields (Mail Merge)
This topic describes how to provide data to report controls using the advanced Mail Merge binding method. This feature allows
you to create templates in which data source values populate specific fields while other text remains constant (that is, allows you
to combine static and dynamic content within the same control).

Embed Fields in a Control Text
You can apply mail merge to the control's Text property only. Double-click the required control on the design surface to invoke
the in-place editor. Insert data field names with square brackets to create embedded fields and use any prefixes or postfixes.

You can embed a parameter's value into a control's content using the [?ParameterName] syntax.

A database barrel icon is displayed above the control if embedded fields are valid in the current data context (specified by the
report's Data Source and Data Member properties).

For the Rich Text control, you can select any text part and adjust its color and font options using the Toolbar's Font group.

Embedded fields are replaced with values obtained from an assigned data source when previewing or exporting a report:

Consider the following specifics and limitations when using embedded fields:

Field names should not use dots and spaces to be interpreted correctly.
Mail Merge is not available for a table's nested fields in a master-detail hierarchy.
Embedded fields cannot be exported to XLS and XLSX as values; they are always exported as plain text. We recommend
using text formats instead if you need to accompany dynamic data with static text.



Format Embedded Fields
The mail merge feature enables you to apply formats to embedded field values. Select a required data field and click the control's
smart tag. Click the Format String property's ellipsis button, and in the invoked Format String Editor, choose a built-in format
pattern.

This adds the selected format to the target data field by separating it from the field name with the ! symbol and applies this
format to field values when previewing a document.

Supported Controls
You can apply the mail merge feature to the Text of the following report controls:

Bar Code
Character Comb
Check Box
Label
Rich Text
Table Cell



Update Report Data BindingsUpdate Report Data Bindings
After you assign a new data source to a loaded report, the report tries to automatically resolve all data bindings. When the field
names of your data source do not coincide with the report controls' bindings, you can maintain them yourself.

To do this, click the report's smart tag and in the invoked actions list, select the Edit Bindings link.

In the invoked Edit Bindings dialog, you can view the bindings that are currently assigned to every report control (in the
Control, Property Name and Source Binding columns).

Enable the Show only invalid bindings option to exclude properly bound controls from this list.

To update a control's data bindings, enable the corresponding check box in the first column and assign the required bindings
from the report's data source (in the Destination Bindings column).

After you have finished updating the bindings, click OK to close the dialog and apply the changes.



Create Popular ReportsCreate Popular Reports
The following tutorials illustrate how to create table and invoice reports:

Create a Table Report
Create a Vertical Report
Create an Invoice Based on a Template
Create an Invoice Manually

The following topics describe how to display hierarchical data in your reports:

Create a Master-Detail Report (Use Detail Report Bands)
Create a Master-Detail Report (Use Subreports)
Create a Hierarchical Report

The tutorials listed below demonstrate various layout options available for reports:

Create Labels and Badges
Create a Multi-Column Report
Create a Report with Cross-Band Content and Populated Empty Space

The following tutorial illustrates interactive report features:

Create an Interactive E-Form

�� N o t eN o t e

See the Provide Interactivity documentation section to learn about providing a drill-down functionality to your reports.

See Use Report Parameters to learn how to customize reports by submitting parameter values in Print Preview.

The following tutorials explain how to use the Cross Tab control in your reports:

Create a Cross-Tab Report
Create a Balance Sheet



Create a Table ReportCreate a Table Report
This tutorial describes how to create a data-bound report displaying information in a tabular format. Table reports should not be
confused with hierarchical master-detail reports, nor with cross-tab reports.

1. Create a new report or open an existing one.

2. Bind the report to a required data source.

3. Add the Page Header band to the report to print the column headers at the top of every document page. To do this, right-
click the report's surface, and select Insert Band | PageHeader in the context menu.

4. Switch to the Field List and select the required fields by clicking them while holding the CTRL or SHIFT key. Then, drop them
onto the Page Header band with the right mouse button to quickly create column headers.

This creates a Table in which each cell shows a field name.

5. To provide dynamic content to the report, switch to the Field List again and select the same fields. Click the selected fields
and drag-and-drop them onto the Detail band.



This creates a table with the same number of cells as the number of fields selected with each cell bound to the appropriate
data field.

6. Select a table by clicking its handle, which appears when you hover the table with the mouse cursor. To select both tables
simultaneously, click their handles while holding the CTRL key.

7. Use the Toolbar's Font, Alignment and Borders sections to customize the tables' appearance.

8. Define a currency format for the UnitPrice cell. Click the cell's smart tag, and then, click the Format String property's
ellipsis button. Select the appropriate format in the invoked Format String Editor editor and click OK.



9. To further improve the table readability, you can apply different visual styles to its odd and even rows. See Report Visual
Styles to learn more.

See the Use Tables section to learn how to add or remove the table's rows and cells, as well as convert the table's cells to
separate label controls.

Switch to Print Preview to see the resulting report.





Create an Invoice Based on a TemplateCreate an Invoice Based on a Template
This document describes how to create an invoice report based on a predefined template using the Report Wizard.
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See the Create an Invoice Manually topic to learn how to create an invoice report with a custom layout from scratch.

Do the following to select an invoice template and configure its settings:

1. Click New Report via Wizard in the Toolbar's Home tab.

2. On the first wizard page, select Template and click Next.

3. On the next wizard page, choose the report template that specifies elements' arrangement and appearance settings.



Click Next to proceed to the next wizard page.

4. The following page allows you to select a data source's type that provides data to your report. Choose Database and click
Next.



5. On the next wizard page, specify whether you want to use an existing data connection or create a new one. For this tutorial,
select an existing connection and click Next.

6. The following wizard page has a list on the right-hand side displaying the selected template's available fields. On the left-
hand side, you can choose a table, view or stored procedure containing the data fields corresponding to the template fields.
You do not need to provide data to all template fields.

You can combine several different tables' or views' data fields by creating a custom query. Click the Queries category's plus
button, and in the invoked Query Builder, join data tables and views based on key columns.

Click Next on the wizard page to continue report creation.

7. The next wizard page enables you to specify the relationships between the data source' s fields and predefined template
fields.

Drag and drop the required data field form the tree on the left-hand side onto the corresponding template field's column.



You can also select a data field from the Template Field Value drop-down list or manually enter a static field value in this
column.

If you do not provide values to specific template fields, the corresponding elements are automatically added to the resulting
report.

Click Next to proceed.

8. On the last wizard page, select the currency symbol and price values' format.

You can also specify the following discount/tax options:

Range - Defines whether the discount/tax value should not be taken into account (None), or should be used for
individual items (Unit) or the entire order (Total).
Value- Specifies the discount/tax value that can be static or bound to the data source field.
Type - Specifies the type of the discount/tax value (flat, fixed or percentage).

Inclusive (for the tax only) - Indicates whether the tax value is included in product prices.



Click Finish to complete the wizard and get the report layout according to the selected template and specified options.

Switch to Print Preview to see the result.





Create an Invoice ManuallyCreate an Invoice Manually
This tutorial describes how to create a simple invoice report displaying information about customers and their orders. You can
perform similar steps to create various invoice layouts depending on your requirements.
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See the Create an Invoice based on a Template topic to learn how to create an invoice report based on a predefined layout.

Create a Report and Bind It to Data
1. Create a new report or open an existing one.

2. Click the report's smart tag. In the invoked actions list, expand the drop-down menu for the Data Source property and click
Add New DataSource.

3. On the first page of the invoked Data Source Wizard, you can choose the required data source type. Select Database and
click Next to proceed.



4. The following page allows you to specify whether you want to use an existing data connection or create a new one. For this
example, select an existing connection and click Next.

5. On the next page, you can choose which tables, views and/or stored procedures to add to the report.

Obtain data from two different tables to display information about customers and orders at the same hierarchical level in
the report. Click the plus button for the Queries category to create a custom query. In the invoked Query Builder, add the
required data tables to a query and join them based on a key column.



6. On the same wizard page, select the data view providing order details for listing products included in each order in the
invoice. Click the Manage Relations button to specify a master-detail relationship between the queries. In the invoked
dialog, connect the required key columns using drag-and-drop.



7. Click Finish to complete the wizard.

After these steps, make sure that an appropriate data member is assigned to the report.

Prepare the Master Report Layout
Create the master report layout to display basic information about customers and their orders.

1. Switch to the Field List and drop the required data fields onto the Detail band. New controls of appropriate types are
automatically created and bound to the corresponding fields.



2. Drop Label controls from the Toolbox onto the band to display static captions for specific data fields.

3. Double-click the added labels one after another and enter the required text.

4. Use the Line control to separate data.

Prepare the Detail Report Layout
Perform the following steps to create a detail report and construct its layout to show the order details in a tabular form:

1. Create a Detail Report Band by right-clicking the report's surface. In the invoked context menu, select Insert Detail Report,
and then, select the master-detail relationship's name.



2. Add dynamic content to the detail report. Go to the Field List, select the data fields while holding down CTRL or SHIFT and
drag-and-drop them onto the Detail band. This automatically creates a Table control with table cells bound to the
corresponding fields.

You should drag-and-drop fields from the category corresponding to the master-detail relationship to correctly generate
the detail report's data.

3. Add the Group Header band to the detail report to display captions for table columns. Right-click the detail report, and in
the context menu, select Insert Band | GroupHeader.

4. To create column headers, select the same data fields in the Field List and drag-and-drop them onto the Group Header
band using the right mouse button.



5. Click the Detail Report band's smart tag, and in the invoked actions list, set the band's Page Break property to After the
Band to print each order on a separate page.

Create a Calculated Field
This section demonstrates how to create a custom field whose values are calculated using a pre-defined expression.

Do the following to evaluate an extended price based on the price, quantity and discount values obtained from a database:

1. In the Field List, right-click any item inside the data relationship node, and in the invoked context menu, select Add
Calculated Field.

2. Select the created calculated field, and in the Property Grid, change its name to ExtendedPrice. Click the Expression
property's ellipsis button, and in the invoked Expression Editor, construct the expression based on the UnitPrice,
Quantity and Discount fields.



3. You can use the created calculated field as an ordinary data field. Add a cell to a table in the Detail band and drop the
calculated field onto this cell. Additionally, create one more table cell in the Group Header for displaying the corresponding
caption.

Format Data
The next step is to specify report elements' value formatting to improve displaying their incoming data.

1. In the master report's Detail band, select controls bound to date fields while holding down CTRL or SHIFT. Switch to the
Property Grid and click the Text Format String property's ellipsis button. In the invoked Format String Editor, activate the
DateTime category and select the format, for example, display dates as a month (name) followed by the day (number) and
year (four digits).



2. Select the table cell bound to the Discount data field in the detail report's Detail band and click its smart tag. Click the
Format String property's ellipsis button, and in the invoked Format String Editor, apply the Percent format. In this case,
field values are multiplied by 100 and displayed with a percent symbol.

3. In the detail report's Detail band, select the cells bound to the UnitPrice and ExtendedPrice fields. Invoke the Format
String Editor once again and choose the format preset from the Currency category (for instance, c2).

Calculate a Summary
Do the following to calculate a total price for each order as a sum of Extended Price values:



1. Add the Group Footer band to the detail report in the same way as the Group Header.

2. Drop the Label control onto the added band and click its smart tag. In the invoked Label Tasks window, click the Summary
field's ellipsis button.

In the Summary Editor window:

Set the Summary running property to the Report value to calculate the summary for the entire detail report.
Set the Summary function property to Sum.

Set the Argument Expression property to the field you want to sum up.

1. Back in the Label Tasks window, use the Format String property to format the summary's value (for instance, set it to
Total: {0:c2}).

Sort Data
Perform the following steps to sort data in the detail report:



1. Select the Detail band in the detail report and switch to the Group and Sort Panel. Click Add a Sort, and in the invoked
drop-down window, select the required data field.

2. Use the Sort Order drop-down list to define the sort order.

Customize the Report Appearance
Do the following to customize the report and its elements' appearance:

1. Click the gray area around the design surface to select the report, and in the Property Grid, specify the font settings. These
settings are distributed to all report elements.

2. You can adjust a control's font independently from its parent (for instance, make summary values bold).

3. Change specific controls' (bound to date fields, price fields, etc.) text alignment using the Text Alignment property.



4. Create a global visual style to apply it afterwards to multiple controls. Click the caption button in the Toolbar's Styles
section.

5. In the invoked Styles Editor, click the plus button and specify appearance properties for the newly created style.

6. Apply a style to report elements by selecting them and clicking the created style in the Styles gallery.



7. You can provide different appearances to alternating (odd and even) table rows in the detail report. Select the table and
expand the Styles property in the Property Grid. Invoke the drop-down list for the EvenStyle property and select New.

Specify the created style's appearance settings (for example, background color).

Add Additional Information
Do the following to provide additional information to your invoices, such as the report name and current date:

1. Add the Page Header band to the master report to display the required information on each invoice page.

2. Drop the Label control from the Toolbox onto the Page Header, double-click the control and type "Invoice". Specify the
required appearance settings (font, foreground color, etc.).

3. Add the Page Info control to the Page Header band to display system date in the report.

4. Click the control's smart tag, and in the invoked actions list, set the Page Information property to Current Date and
Time.

5. Click the Text Format String property's ellipsis button, and in the invoked Format String Editor, select a date format as in



the Format Data section above.

View the Result
The invoice report is now ready. Switch to Print Preview to see the result.



Create a Master-Detail Report (Use Detail Report Bands)Create a Master-Detail Report (Use Detail Report Bands)
This tutorial illustrates how to display hierarchical data in a master-detail report using nested Detail Report bands. This approach
is effective if your data source contains master-detail relationship. Another way is described at Create a Master-Detail Report (Use
Subreports).

1. Create a new report or open an existing one.

2. Bind the report to a required data source and provide it with a master-detail relationship as described in the Bind a Report
to a Database topic.

3. Drop the required data fields from the Field List onto the Detail band.

4. Create a Detail Report Band by right-clicking the report's surface. In the invoked context menu, select Insert Detail Report,
and then, select the master-detail relationship's name.

This sets the detail report's Data Source and Data Member properties automatically.



5. Switch to the Field List, select the data fields while holding down CTRL or SHIFT and drag-and-drop them onto the Detail
band.
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You should drag-and-drop fields from the category corresponding to the master-detail relationship to correctly generate
the detail report's data. Otherwise, the report will display only the first record of the detail table as many times as there are
records in this table.

6. If required, customize the report's appearance and format values.

Switch to Print Preview to see the resulting report.



Create a Master-Detail Report (Use Subreports)Create a Master-Detail Report (Use Subreports)
This tutorial demonstrates how to create a master-detail report using the Subreport control. This approach is useful if your data
source does not contain master-detail relationship or you prefer to store master and detail reports in different files. Another
approach is described at Create a Master-Detail Report (Use Detail Report Bands).

Create a Master Report
1. Create a new report or open an existing one to use it as a master report.

2. Bind the report to a required data table.

3. Drop the required data fields from the Field List onto the Detail band.

Create the Detail Report
1. Add one more blank report to use it as a detail report.

2. Bind it to data. For instance, use another table of the same database as for the master report.

3. Switch to the Field List, select the data fields while holding down CTRL or SHIFT and drag-and-drop them onto the Detail
band.

4. Add parameter to the detail report. Right-click the Parameters section in the Field List and choose Add Parameter in the
context menu.

5. In the invoked Add New Parameter dialog, specify the parameter's Name and Type as well as disable the Show in the
parameters panel option.



6. Click the report's smart tag, and in its actions list, click the Filter String property's ellipsis button.

In the invoked FilterString Editor, construct an expression where the required data field is compared to the created
parameter. To access the parameter, click the icon on the right until it turns into a question mark.

7. Save the detail report by selecting Save | Save As in the toolbar. In the invoked standard Save dialog, specify the folder and
file name.



Embed the Subreport
1. Switch back to the master report and drop the Subreport control from the Toolbox onto the Detail band.

2. Click the subreport's smart tag and clcik the Report Source URL property's ellipsis button. In the invoked Open dialog,
select the previously saved detail report.

3. Bind the subreport's parameter used as a filter criterion to the master report's corresponding data field, which serve as a
source of the parameter value. To do this, click the subreport's smart tag and select Edit Parameter Bindings in the
invoked actions list.

4. In the invoked Parameter Binding Collection Editor, click Add to add new binding. In the property list, specify the data



field to which you want to bind a subreport parameter and the name of the parameter that you want to bind.

5. If required, customize the report's appearance and format values.

View the Result
Switch to Print Preview to see the resulting report.



Create a Hierarchical ReportCreate a Hierarchical Report
This tutorial describes how to use the detail band's Hierarchy Print Options property to create a hierarchical report.

1. Create a new report or open an existing one.

2. Bind the report to a required data source.

The following image demonstrates an empty report bound to an ObjectDataSource.

Each record in this data source includes the "parent ID" field that defines the parent-child relationship and thus builds the
hierarchy.

3. Arrange controls on the report.

Add the Report Header and Page Header bands (see the Manage Report Bands | Add Bands section in the
Introduction to Banded Reports document for details)



Add data-bound labels to the Detail band.

Switch to the Preview tab to see an intermediate result.

4. Specify the Detail band's Hierarchy Print Options property.



Set the following options:

Key Field Name and Parent Field Name, or Child List Field Name
Set the Key Field Name and Parent Field Name properties if your report's data has the Id-ParentID related fields.
Set the Child List Field Name property if your report's data is recursive. Assign the collection of child objects
(records) if they have the same type as the parent objects (records).

Indent
Specify the child level node offset.

Keep Together with First Child
Specify whether to print a parent node together with its first child node on the next page if these nodes do not fit at
the end of a page.

As you can see in the image above, the Detail band that contains child rows is printed with the specified indent.
However, the row (the sum of the label widths) does not fit the page now.

5. Align labels.

Anchor the first data-bound label to the Detail band's left and right edges. Set the label's Anchor Horizontally
property to Both.



Anchor the rest of the data-bound labels to the right edge of the Detail band (their container). Set their Anchor
Horizontal property to Rignt.

6. Add a drill-down control to expand/collapse child rows.

Add the Check Box control to the Detail band at the left-most position.



Set the Check Box control's glyph options. Use custom glyphs for the checked and unchecked checkbox states.

Set the Detail band's Drill Down Control property to the added Check Box control.

Set the Check Box's Check State property to the following expression: [ReportItems].[Detail].[DrillDownExpanded]
(in the control's Smart Tag or the Property Grid's Expressions tab).



7. Sort report data.

Use the Detail band's Sort Fields property to sort data on each hierarchy level.



8. Highlight root nodes.

To format rows based on their nesting level, use the Current Row Hierarchy Level variable in expressions. For example,
specify the Detail band's appearance properties as listed below:

Set the Back Color property to iif([DataSource.CurrentRowHierarchyLevel] == 0, Rgb(231,235,244), ?)

Set the Font | Bold property to [DataSource.CurrentRowHierarchyLevel] == 0





Create a Vertical ReportCreate a Vertical Report
This tutorial describes how to use vertical bands to create a report where record fields are arranged vertically and data records are
printed horizontally.

1. Create a new report or open an existing one.

2. Bind the report to a required data source.

3. Click the report's smart tag and choose Design in Report Wizard....

4. In the invoked Report Wizard, select Vertical Report and click Next.



5. Select the data fields that should be included in the report.

6. Specify group data fields to create a report with grouped data (the report in this tutorial does not have group fields).

7. Add summary fields to the report.



8. Change the report page layout to landscape so that the vertical table fit the report.

9. You can set the report's color scheme.



10. Specify the report's title.

Click Finish and the generated report opens in the Report Designer.



The wizard adds report controls to the following bands:

Vertical Header band
Contains a table with a single column that displays headers of the report's data fields.
Vertical Details band
Contains a table with a single column that is printed so many times as there are records in the report's data source.
Vertical Total band
Contains a table with a single column that has so many labels in cells as there are summary functions you specified for each
field in the Report Wizard (only the sum function for each field in this demo).

Switch to the Preview tab to see the result.
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You can create a vertical report without using the Report Wizard. Right-click the report in the Report Designer and choose Insert



Vertical Band in the invoked context menu. Refer to the Introduction to Banded Reports topic for more information.

Set Vertical Table Options
You can set the following options in the Property Grid to modify the vertical table:

Disable the Vertical Header band's Repeat Every Page property to display field headers once - on the first report page.

Set the Vertical Detail band's Band Layout property to Across Then Down to print the data records that do not fit a page on
the same page, otherwise, they are printed on the next page (as in this demo).

Specify the Vertical Detail band's Sort Fields property to sort the report's data.



Create Labels and BadgesCreate Labels and Badges
This tutorial describes the steps to create a label report that contains employee badges.

1. Create a new report and bind it to a required data source (for instance, to a table that contains information about
employees).

2. Click the report's smart tag, and in the invoked actions list, click Design in Report Wizard.

3. The wizard guides you through the process of creating a label report. Refer to Label Report for detailed instructions on the
wizard's steps.

4. After performing the above steps you will see that the report's Detail band is now divided into three differently colored
areas. The first area at the left-hand side indicates the actual available band area for controls to be placed within it. The gray
area at the right-hand side is intended for the columns in which labels will be displayed, so it cannot be occupied by
controls. Finally, the white area specifies an indent between the available and reserved areas.



5. Drop the required fields from the Field List onto the available Detail band's area and adjust the layout.

If required, you can apply mail merge to combine several fields within the same Label control.

For the Picture Box control, you can set its Sizing property to Zoom Image.

Switch to Print Preview to see the resulting report.



Create a Multi-Column ReportCreate a Multi-Column Report
This document describes how to arrange report data in multiple columns, which can be used to create mailing labels, business
cards or multi-column directories.

Settings
To access the multi-column settings of a report's Detail band, use its smart tag or the Property Grid.

Multi-Column Mode

Enables you to select one of the following modes:

None

Disables the multi-column layout.

Use Column Count

Makes the report display a specific number of columns based on the Column Count value. When this property is set to 1,
the report looks as though its multi-column layout is disabled.

Use Column Width

Makes the report columns have a specific width based on the Column Width value. With this setting, the report displays as
many columns as it is possible according to the specified column width, column spacing and report page size.

Column Spacing

Specifies the distance between adjacent columns. This value is measured in report units.

Multi-Column Layout

Specifies the preferred direction for arranging report data within columns.

First Across, then Down

The report data is arranged horizontally and is wrapped to the next row on reaching the right page margin.



When the report data is grouped, the multi-column layout is applied to each group individually.

First Down, then Across

The report data is arranged vertically and is wrapped to the next column on reaching the bottom page margin.



When the report data is grouped, you can make each group start on a new column by setting the Page Break property of
the Group Footer to After the Band.

How It Works
The following image illustrates a report designer with a multi-column layout applied to the report:



In multi-column mode, the report's design surface is limited to the area defined by the column width. This is the only area
intended to contain report controls.

The rest of this surface defines the space on a page remaining for printing columns and column spacing area.

In the above image, the report data in the Detail band is contained within a Panel that provides borders around the enclosed
content.

You can also specify a custom background color for the Panel. To learn how to change this color dynamically (based on the
report's underlying data), see Conditionally Change a Control's Appearance.

When the report data is grouped (as in the above image), and the First Down, then Across multi-column layout is used, you can
make each group start on a new column. To do this, set the Page Break property of the Group Footer to After the Band or After
the Band, Except for the Last Entry. When there is no data to display in the Group Footer, set the band height to zero.



Create a Report with Cross-Band Content and PopulatedCreate a Report with Cross-Band Content and Populated
Empty SpaceEmpty Space
This document describes how to create a report with the following layout options:

Print part of the content across bands (the blue panel);
Populate the empty space between the detail and footer information with blank rows.

Initial Report
In this tutorial, the report groups data by a data source field (the report's group field).



The GroupFooter band is displayed at the bottom of the page (the Print At Bottom property is enabled). There is an empty space
between the Detail band's data and the footer.

Add Line Numbers
1. Right-click the first cell in the Detail band's table and select Insert / Column to Left from the context menu.



2. Select the new cell and specify the following property values:

Summary: Group

Expression: sumRecordNumber()

Each row now includes a number.



Populate the Empty Space
Populate the empty space between the Detail band's data and footer.

Click the Detail band's smart tag and enable the Fill Empty Space property.

The empty space is now populated with numbered lines.
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Set the Text properties of the Detail band's controls to display static text within the added lines.

Add Cross-Band Content to Report Groups
1. Right-click the design surface. Select Insert Band / GroupHeader from the context menu.
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Choose a PageHeader band instead to display the cross-band content on an entire page.



2. Click the added band's smart tag and enable the Print Across Bands property. This displays the band content on the
background of the GroupHeader1, Detail, and GroupFooter1 bands.

3. The report's group field is in the GroupHeader1 band's Group Fields collection. The new band is above GroupHeader1 and
does not participate in the report's group. Move the group field to the new band.

Click GroupHeader1's smart tag, click the Group Fields property's ellipsis button and remove the group field from
the invoked Group Field Collection Editor.

Click the new band's smart tag, click the Group Fields property's ellipsis button and add the group field in Group
Field Collection Editor.



4. Add a Panel control to the GroupHeader. Specify the panel's Background Color and drop fields onto the panel.

5. Adjust the panel's width and height. The height should match the page height, as the footer is printed at the bottom of the
page (the GroupFooter's Print At Bottom property is enabled).



6. Switch to Print Preview. The panel is printed on the background of the group content.



7. Resize the content in other bands to print it side-by-side with the panel.

See the final report in Print Preview.





Create an Interactive E-FormCreate an Interactive E-Form
This tutorial describes how to create a form that is fillable in Print Preview.

To get started with this tutorial, create a new report or open an existing one.

Add Form Fields
Add the Label report controls to the report and arrange them according to the form's template. Set the labels' Text property to
the form's field names.

Add Fillable Cells
Use the Character Comb control for the form's text fields. This control displays letters in individual cells and allows you to fill
these cells in Print Preview.

1. Drop the Character Comb item from the Toolbox onto the report.



2. Select all the added Character Combs and set their properties in the Property Grid:

Cell Size Mode
Cell Height,
Cell Width,

and other cell settings.

3. Enable the Character Combs' Edit Options | Enabled property.

4. Choose editors for the Character Comb controls' edit mode.

Controls that allow you to enter letters
Invoke a drop-down list for the Editor Name property and select the Only Uppercase Letters item in the Letters
category.



Controls that allow you to enter integers
Invoke a drop-down list for the Editor Name property and select the Positive Integer item in the Numeric category.

Add Check Box Editors
Add Check Box controls for the Male/Female fields.

Use the following properties to set up these controls:

Set the Text property.



Set appearance properties.

Enable the Edit Options | Enabled property switch check box states in Print Preview.

Set the Edit Options | Group ID property to the same value to combine these two check boxes into a logical group. This
allows you to select only one option at a time.

Add the Signature Editor
Add the PictureBox report control for the form's Signature field.

Do the following to enable drawing in Print Preview:

1. Enable the control's Edit Options | Enabled property.

2. Set the Edit Options | Editor Name property to Signature.



Get the Result
Switch to the Preview tab to see the result.

Click the  button on the Print Preview toolbar to highlight all the editable fields on the form.

Click a field to invoke its editor.



Use TAB and SHIFT+TAB to navigate between editable fields.



Create a Cross-Tab ReportCreate a Cross-Tab Report
This tutorial describes how to use the Cross Tab control to create a Sales Summary report.
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This tutorial demonstrates how to use the Cross-Tab Report Wizard. See Create a Balance Sheet for information on how to
configure a Cross Tab on the Design Surface.

Add a Cross-Tab Report
1. Invoke the Report Wizard.

2. Select Cross-Tab Report and click Next.



3. Bind the report to a data source as described in the Bind to Data section.

4. Select a data member that stores data for each sales person's sales. Click Next.

5. Drop data fields onto cross-tab areas to define row/column headers and data.



The field order defines the hierarchy in the resulting cross-tab report. The higher the field on the list, the higher the level in
the field hierarchy.

6. Change the report page layout to landscape to ensure the cross-tab content fits the report well. Click Next.

7. Set the report's color scheme and click Next.



8. Specify the report's title and click Finish.

The generated report contains a Cross Tab that is configured based on the specified settings. The Cross Tab calculates automatic
totals and grand totals across row and column fields.
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Ensure that the report's Data Source property is not set if you place the Cross Tab into the Detail band. Otherwise, the Cross Tab
data is printed as many times as there are rows in the report data source.

Switch to the Preview tab to see an intermediate result.

As you can see in the image above, the Cross Tab displays data for individual days. The next section shows how you can adjust the
report so that it summarizes values by quarters.

Specify Group Settings
Select the row header cell and click its smart tag. Specify the Group Interval property to group data.



Format Data
Apply data formatting to cells. Hold down SHIFT or CTRL to select multiple cells, then go to the Properties window and specify
the Text Format String property.

Customize Appearance
1. Select the Cross Tab, switch to the Properties window and expand the Styles property. Expand the General Style property

and set Border Color to ControlDark. This value applies to all Cross Tab cells.



2. Expand the Header Area Style property and set the following properties:

Background Color to Control

Font to Calibri 9 Bold

3. Expand the Total Area Style property and set Font to Calibri 9 Bold.



4. Expand the Data Area Style property and set Font to Calibri 9.

5. Hold down SHIFT or CTRL, and select the cells that display the grand total values. Go to the Properties window and set
Background Color to ControlDark. This value applies to the selected cells only and overrides the value specified at the
area level.



6. Select the row header cell and set Text Alignment to Top Left.

Adjust the Content Size
1. Use a cell's Column Auto Width Mode property to specify a cell width calculation method. The Report Wizard sets this

property to Shrink And Grow for row headers and to None for other cells.

2. Resize the Cross Tab. You can also resize the individual rows and columns.



3. Move the report title to the Top Margin band to repeat the title on each page and make the Cross Tab occupy the entire
page area.





Create a Balance SheetCreate a Balance Sheet
This tutorial describes how to use the Cross Tab control to create a Balance Sheet report.
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This tutorial shows how to configure a Cross Tab using the Report Wizard. See Create a Cross-Tab Report for information on how
to use the Cross-Tab Report Wizard.

Add a Cross Tab and Bind It to Data
1. Invoke the Report Wizard and add a blank report to your application.

2. Drop the Cross Tab control from the Toolbox onto the report's Detail band.



3. Click the Cross Tab's smart tag, expand the Data Source property's drop-down menu and click Add New Data Source.

4. Use the invoked Data Source Wizard to bind the Cross Tab to a data source.

Click Finish to complete the Data Source Wizard and assign the created data source to the Cross Tab.

The data source structure becomes available in the Field List.
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Ensure that the report's Data Source property is not set if you place a Cross Tab into the Detail band. Otherwise, the Cross Tab
data is printed as many times as there are rows in the report data source.

Define the Cross Tab Layout
1. Drop data fields from the Field List onto the Cross Tab's areas to define the Cross Tab's rows, columns, and data.

A row is added to the bottom of the Cross Tab to display grand total values calculated against the added row or column
header.



Drop nested row headers next to the parent header cells to create a hierarchy.

Switch to Print Preview to see the Cross Tab populated with data.

Specify Group Settings
As you can see in the image above, the Cross Tab displays data for individual days.

Select the column header cell and click its smart tag. Set the Group Interval property to group data.



Specify Layout Options
1. The Cross Tab control stacks row headers horizontally. You can change the view so that parent values span the entire row

header panel width.

Select the Cross Tab and switch to the Property Grid. Expand the Layout Options group and enable the Hierarchical Row
Layout property.

2. Set the Corner Header Display Mode property to None to merge cells in the top-left corner into a single empty cell.



Switch to Print Preview to see the result.

Hide Grand Totals
1. Select the bottom right cell and click its smart tag. Disable the Row Visible and Column Visible properties to hide the row

and column that display grand total values. Invisible cells are filled with a hatch brush.



2. Resize the Cross Tab. You can also resize individual rows and columns.

The Cross Tab control no longer displays grand total values.

Sort and Format Data
1. Select the row sub-header cell and change its sort order. The Cross Tab sorts row and column field values in ascending

order. Set the Sort Order property to None to restore the original data source order.



2. Format the data. Hold down SHIFT or CTRL and select cells. Specify the cells' Text Format String property.



Customize Appearance
1. Select the Cross Tab, switch to the Properties window and expand the Styles property. Use the General Style property to

specify common appearance settings that apply to all Cross Tab cells. Set the following properties:

Background Color to White
Border Color to SlateGray
Font to Tahoma 8.25

Foreground Color to SlateGray



2. Expand the Header Area Style property and do the following:

reset the Background Color property value to inherit the color from the general style;
set the Foreground Color property to MidnightBlue to override the general foreground color;

set the Font property to Tahoma 8.25 to override the general font.

3. Expand the Total Area Style property and set the following properties to override general settings:

Font to Tahoma 8.25 Bold

Foreground Color to MidnightBlue

4. Select the row sub-header cell and set the following appearance properties:



Foreground Color to SlateGray

Font to Tahoma 8.25

These values apply to the selected cell only and override values specified for the entire header area.

1. Select the cells in the top row and in the rows with total values. Set the Borders property to Bottom and Border Width
property to 2.

2. Select the cells you did not customize in the previous step and set the Borders property to None.



3. Select the cells in the top row and set the Background Color property to LightSteelBlue.

4. Select the row sub-header cell and the next cell in the data area. Set their Background Color property to AliceBlue.



Apply Odd and Even Row Styles
Use the GroupRowIndex variable in expressions to identify odd and even rows.

Select the row sub-header cell and the next cell in the data area. Go to the Properties window and open the Expressions tab.
Click the Background Color property's marker, select Background Color Expression and specify the following expression:

iif([Arguments.GroupRowIndex] % 2 == 1, Rgb(235, 241, 252), ?)



As you can see, the row backgrounds do not start from the page's left border, but have indents. These indents correspond to
auxiliary cells in a tree.

Select these auxiliary cells and disable the Column Visible property.

To add indents to row field values and imitate a tree-like view, set the Padding property for the Cross Tab's cells.



Add a Report Title
1. Right-click the report and select Insert Band / ReportHeader from the context menu.

2. Drop a Label from the Toolbox onto the created Report Header.

3. Double-click the label and type the report title. Specify appearance settings.

Switch to Print Preview to see the final result.





Configure Design SettingsConfigure Design Settings
The documents in this section describe how to specify a report's various design settings:

Change a Report's Measurement Units

Learn how to switch your reports between using the imperial or metric system for specifying the size and location of report
elements, or use pixels as a measurement.

Change a Report's Page Settings

Learn how to specify the settings of the default printer or page settings that affect the layout of the report's design surface.

Right-To-Left Support

Learn how to mirror your reports' layout for audiences using a right-to-left writing system.



Change a Report's Measurement UnitsChange a Report's Measurement Units
Most metrics of report elements (i.e., element locations, dimensions and margins) can be expressed in units that correspond to
one of the following systems of measurement.

Imperial system (in hundredths of an inch)

This is the default system that is assigned to each new report.

Metric system (in tenths of a millimeter)
Screen coordinates (in pixels)

To assign a system of measurements to a report, use its Measure Units property. You can specify this property either in the
report's smart tag...

... or in the Property Grid's Behavior tab.

Changing the system of measurement results in converting the corresponding property values and updating the layout of all
report elements in the Report Designer. Notably, the system of measurement determines the minimum increment with which an
element's location and size can be changed.



Change a Report's Page SettingsChange a Report's Page Settings
In the Report Designer, page settings of a report can be specified in one of two ways. The first approach forces the default printer
settings to be used when the report is printed, while the other one enables you to alter page settings independently.

Use Settings of the Default Printer
For the orientation and paper size, you can specify a requirement that applies the corresponding printer settings instead of the
report's. In this instance, the page properties in the Property Grid are disabled and displayed as grayed out. This may be useful
when the report is printed in several places with different printers and printer settings.

Specify the Report's Page Settings
While designing the report, you can specify the report's page settings in the Property Grid's Miscellaneous tab:

You can set the page orientation and modify the margins. The margin values are expressed in the report's measurement units.
You can select from the predefined paper sizes (Paper Kind property), choose Custom and create your own paper size, or select
one which is already defined for this printer (Paper Name property).

These settings affect the layout of the report's design surface. After their modification, you may notice red warning marks,
indicating that the controls go beyond the page width. These warnings can be switched off by setting the Show Printing
Warnings property of the report to No.



You can also modify the page settings in Print Preview using the Page Setup dialog.



Enable the Right-To-Left LayoutEnable the Right-To-Left Layout
The report and most of the report controls provide the Right to Left property.

This property specifies content layout within a control (for most controls, this property affects the direction of their text, and for
the Check Box, this property also affects the check box position within the control).

Left-To-Right

Right-To-Left

By default, all report controls have this property set to Inherit, so enabling it for a report will apply this setting to all its controls.

The following controls support this feature:

Label



Check Box
Page Info
Panel
Pivot Grid
Table
Table of Contents

For the Panel and Table, this option only affects the controls contained in them.

When the Right to Left property of a report is set to Yes, you can also enable the Right To Left Layout property that specifies
the position of controls within report bands. Enabling the right-to-left layout will also swap the page margins of a document (it
will become impossible to place controls outside the right page margin).

The controls' coordinates will remain unchanged and only the point and direction of reference will change (the X coordinate will
be calculated starting with the top right corner).

The right-to-left layout is preserved when exporting a report to any of the supported formats (e.g., PDF, Excel, or RTF).



Use Report ElementsUse Report Elements
The documents in this section describe how to use various controls in a report, manipulate report elements and customize the
report layout:

Manipulate Report Elements
Use Basic Report Controls
Use Tables
Use Bar Codes
Use Charts and Pivot Grids
Use Gauges and Sparklines
Draw Lines and Shapes



Manipulate Report ElementsManipulate Report Elements
The following topics describe how to add various controls to a report, manipulate report elements and customize the report
layout:

Add Controls to a Report
Select Report Elements and Access Their Settings
Move and Resize Report Elements
Apply Styles to Report Elements
Copy Report Controls
Reuse Report Controls
Arrange Report Controls
Add Report Controls to Containers
Validate the Report Layout



Add Controls to a ReportAdd Controls to a Report
This document describes how to add controls to a report.

Add Controls from the Standard Controls Bar
Use the End-User Designer's Toolbox to add controls to your report.

Add Data-Bound Controls from the Field List
You can drag fields from the Field List onto your report to add data-bound controls, after you bound your report to a data source.

Add a ControlAdd a Control

Drag a field from the Field List and drop it onto the report's surface.

To add a control of specific type, do either of the following:

Hold down the SHIFT key and drop a data field onto a report's surface.
Right-click a data field and drop it onto a report's surface.

This invokes a context menu where you can select which control to add.



Add a TableAdd a Table

Hold the CTRL or SHIFT key and click several fields. Drop them onto the report's surface to add a table with its cells bound to
these fields.

Drop an entire data table from the Field List to add a report table with columns bound to the data table's fields.

To add column headers, do either of the following:

Select the fields and hold the CTRL or SHIFT key when you drop them onto a report surface.
Drag and drop fields with the right mouse button.

This adds a new table whose cells display the field names.

Add Content from External Sources



You can add text and graphics from external applications to your reports:

Drag a file, text or image from an external application onto your report.

Copy a file, text or image from an external application, and paste it into your report.

The following table shows which file types transform into report controls:

FILE T YPE CONTR OL

.TXT A Label control that contains file contents.

.DOC, .DOCX, .RTF, .HTM, .HTML A Rich Text control that contains file content.

.JPG, .PNG, .BMP, .GIF, .TIF, .SVG A Picture Box control that contains the image.



Select Report Elements and Access Their SettingsSelect Report Elements and Access Their Settings
You can click a report control or band to select it, and press TAB/SHIFT+TAB to select the next/previous control.

Do one of the following to select multiple report controls:

Press and hold the SHIFT or CTRL key and click the controls.
Click an empty place on a report's surface and draw a rectangle around the controls.

Click the gray area around the design surface to select a report.

You can use smart tags to access the most commonly used element properties. Smart tags are available for reports and most
report controls and bands.

Smart tags can also contain context links that enable you to perform various actions.

The Toolbar provides a corresponding contextual tab when you select a report control. This tab allows you to specify settings and
perform actions applicable to the selected element's type.



You can use the Property Grid to access the whole set of settings that the selected element supports.



Move and Resize Report ElementsMove and Resize Report Elements
You can use the mouse or keyboard to move a report control to a new location.

You can select multiple controls and move them in the same way as individual report controls.

You can also use the Report Explorer to move a control. You can move controls to other bands (except the DetailReport band), or
into a Panel or TableCell controls. Select a control and drag it (either within the Report Explorer or to the design surface). The
drop targets are highlighted when you drag the control over them.
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You can drag the TableOfContents control only to the ReportHeader and ReportFooter bands.

To resize a control, select it and then drag a rectangle drawn on its edge or corner.

Drag a band's header strip to resize the band.

You can also press SHIFT+ARROW or CTRL+SHIFT+ARROW to resize a selected element.



See Arrange Report Controls for information about tools that help you align report controls to each other and layout edges.



Apply Styles to Report ElementsApply Styles to Report Elements
Select a control and switch to the Property Grid. Expand the Styles group and set the Style property to the style name.

As an alternative, you can drag a style from the Report Explorer onto a control.



Copy Report ControlsCopy Report Controls
You can clone an existing report control by selecting it using the mouse, holding the CTRL key and moving the mouse to the
required location. A cloned control has the same settings as the initial control.

You can also copy report controls to the clipboard using CTRL + C or the Copy command, and then paste these controls to a new
container or band.

The original control positions are preserved when you use the CTRL + V hotkey or the Paste toolbar command to insert
controls.

The pasted controls are repositioned by an offset of 10 units on both axes if another control already occupies the target
position.

When you use the Paste context menu item, controls are inserted at the position where you invoked the context menu.



Reuse Report ControlsReuse Report Controls
You can add selected controls to the Report Gallery and reuse them later in other reports. Select one or multiple controls while
holding down the SHIFT or CTRL key and choose Add To Gallery in the context menu.

To add a selected template to a report, drag it from the Report Gallery onto a report's surface.

A template stores various settings related to its controls, such as binding information and appearance options. All these settings
are restored after you add controls to a report.



Arrange Report ControlsArrange Report Controls
The following tools allow you to control report element size, location, alignment, and to maintain the distance between them:

Rulers

The Report Designer provides horizontal and vertical rulers to help you determine report elements' size and location.

Layout Toolbar

Use the Layout Toolbar commands to align report controls.

Snapping

Use the Snapping toolbar group or a report's Snapping Mode property to enable automatic report control snapping to a
grid and/or snap lines.

Snap Grid

The design surface displays a visual grid that allows you to determine elements' size and location in a report. Use the
Snap Grid Size and Snap Grid Step Count properties to customize the grid's settings.

To hide the grid, disable the Grid Lines option in the toolbar's View tab or disable a report's Draw the Grid property.



A report control is aligned to the nearest grid cell when moved with the mouse or ARROW keys.

You can use the Align to Grid toolbar button or context menu item to align the selected controls to the grid cells.

You can temporarily ignore snapping when you move and resize controls:

hold down ALT if you move or resize controls using the mouse;
hold down CTRL if you move or resize controls using the keyboard.

Snap Lines

The Report Designer displays snap lines when you move or resize report controls. These lines appear around the
report controls and indicate the distance to other report elements (controls and bands).

When you use the ARROW keys to move a report control or press SHIFT+ARROW to resize the control, it is aligned to
the nearest report element in that direction based on snap lines.

A report control's Snap Line Margin property and a band's or panel's Snap Line Padding property allows you to
maintain a uniform distance between elements in a report.



To avoid snapping controls, do the following:

hold down ALT if you move or resize controls using the mouse;
hold down CTRL if you move or resize controls using the keyboard.



Add Report Controls to ContainersAdd Report Controls to Containers
The Panel control allows you to place various report controls on it to combine them into a group.

You can use this panel to move, copy, change appearance settings, etc. instead of adjusting individual controls.

A table cell can also act as a container for other controls.

Both panel and table cells cannot contain the following report controls:

Pivot Grid
Subreport
Page Break
Table of Contents
Cross-Band Line and Box

If a panel or table cell includes only one control, you can use the Fit Bounds to Container command in the context menu to
position the control within the container. This command resizes the control so that it occupies all the available space (except
borders).





Validate the Report LayoutValidate the Report Layout
Your report layout should meet the following requirements to correctly print and export it:

Avoid overlapping controls

The Report Designer highlights intersecting report controls to warn you that the report layout can be exported incorrectly to
HTML, RTF, DOCX, XLS, XLSX, CSV and TXT formats.

Disable the Export Warnings option in the toolbar to ignore this rule and not highlight intersecting controls.

Do not place controls outside page margins

The Report Designer highlights report controls that do not fit into the printable page area and overlap the right page
margin. This warns you that extra pages can appear when document is printed.

Disable the Printing Warnings option in the toolbar to hide these warnings.



Use Basic Report ControlsUse Basic Report Controls
The following documents describe the basic controls that display data in a report:

Label
Character Comb
Rich Text
Check Box
Picture Box

The controls below allow you to embed other reports and customize the report layout:

Subreport
Panel
Page Break

Use the following controls to display auxiliary information in a report:

Table of Contents
Page Info



LabelLabel
Label Overview
The Label control displays plain text in a report. Drag the Label item from the Toolbox onto the report's area to add a Label
control to it.

Double-click the label to invoke its in-place editor and enter the static text.

Press CTRL+Enter to submit text changes and exit the label's in-place edit mode.

Bind to Data
D isplay Field ValuesD isplay Field Values

You can bind the label's Text property to a data field obtained from a report's data source. Click the control's smart tag, expand
the Expression drop-down list and select the data field.

Click the Expression option's ellipsis button to invoke the Expression Editor. You can use this editor to construct a complex
binding expression from two or more data fields.



You can also drag and drop a numeric or text field from the Field List to create a new label bound to this field.

See the Bind Controls to Data topic for more information.

The Process Duplicates Mode, Process Duplicates Target and Process Null Values options enable you to hide a control
when a duplicated or null value appears in an assigned data source.

You can also use the Format String property to specify output values' format.



D isplay SummariesD isplay Summaries

Specify a data range in the Summary Running property and select the summary function in the Summary Expression Editor
to make the label display a summary function's result.

Adjust the Label Size and Content
S tatic ContentS tatic Content

You can change label size at design time to fit its static text. Right-click the label and select the Fit Bounds To Text toolbar button:

If the Word Wrap option is enabled, the command displays control content on multiple lines. It reduces control height and



adjusts its width to fit its content.

If the Word Wrap option is disabled and the control's content is partially visible, the command adjusts the control size to
display this content.

The command's result also depends on the control's Text Alignment and Right To Left settings.

Use the Fit Text To Bounds button to adjust the control's font size to fit its area. The Word Wrap option defines whether the text
can occupy multiple lines or should be in a single line.

These commands are not available in the following cases:

A label's text is an empty string;
A label's text is bound to data;
A label's Angle property is specified.

D ata-B ound LabelsD ata-B ound Labels

The Can Grow and Can Shrink properties allow you to increase or decrease the control's height according to its content in Print
Preview mode.



CAN G R OW  IS  ENAB LED CAN G R OW  IS  D IS AB LED

CAN S HR INK IS  ENAB LED CANS HR INK IS  D IS AB LED

The Auto Width property specifies whether to adjust a data-bound label's width to its content.

You can also use the opposite Text Fit Mode property to adjust a control's font size to fit its boundaries in Print Preview. This
property is not available if the Can Grow, Can Shrink or Auto Width option is enabled.

TE X T FIT MOD E =
NONE

TE X T FIT MOD E = G R OW
ONLY

TE X T FIT MOD E = S HR INK
ONLY

TE X T FIT MOD E = S HR INK AND
G R OW

See the Arrange Dynamic Report Content topic for more information.

Interactivity
Check the Enabled option in the Edit Options category to allow users to edit a label's content in Print Preview mode.

Click this label in a previewed document to invoke the editor.



Use the label's Interactive Sorting option to allow users to click this label in Print Preview to sort report data. Set the Target
Band property to the Group Header or Detail band, and specify the data field in the Field Name property.

Refer to Sort a Report in Print Preview for a step-by-step tutorial.

Markup Text
Enable the Allow Markup Text property to format the label's text with markup tags.

Label supports the following tags:

TAG END  TAG D ES CR IPTION

<br> Inserts a single line break. Enable the WordWrap property to use this tag.

<nbsp> - Inserts a space.

<color=value> </color> Specifies the text color.

<backcolor=value> </backcolor> Specifies the background color.

<size=value> </size> Specifies the font size.

<b> </b> Defines bold text.

<i> </i> Defines italic text.

<s> </s> Defines strikethrough text.

<u> </u> Defines underlined text.



<image=value> -

Inserts an image from the report's named image collection. Supports both raster images and
SVG images. Use the report's Image Resources property to provide images and reference
them by their Id. The image tag's size attribute sets the image display pixel size. If the specified
width/height exceeds the label's width/height, it is reduced to display the entire image. Specify
the size attribute after the tag's value followed by the ";" character.

<href=value> </href> Displays a hyperlink. The value string specifies the hyperlink source, and the string between the
opening and closing tags is the text to display.

TAG END  TAG D ES CR IPTION



Character CombCharacter Comb
Overview
The Character Comb control displays text so that each character is printed in an individual cell.

To add a Character Comb to the report, drag the Character Comb item from the Toolbox onto the report's area.

The number of cells displayed by the control in Print Preview depends on the Can Shrink and Auto Width settings.

If both these properties are enabled, the number of cells corresponds to the number of characters in the control's text.
Otherwise, the number of cells corresponds to the specified cell size and the control size.

See the Content Layout and Position section to learn more on using these properties.

You can also adjust the character comb's size to match its characters using the Fit Bounds To Text toolbar button or context
menu command:

If the Word Wrap option is enabled, the command keeps control content displayed in multiple lines. It decreases the
control's height and adjusts the width to fit this content.

If the Word Wrap option is disabled, the command adjusts the control's height and width to completely display the
control's content in a single line. As a result, the number of cells corresponds to the number of characters.



When exporting this control to third-party formats, consider the following

When a report is exported to an XLS or XLSX file, the cells of the Character Comb correspond to the cells of a resulting Excel
sheet.
When a report is exported to a CSV (or TXT) file, the content of individual cells is separated (or spaced) by a specified
Separator character.

In most aspects, the Character Comb is similar to the Label control from which it inherits most of its properties and its basic
behavior. For general information about binding these controls to data and display summary function results, see the Label topic.
To learn about Character Comb specifics, see the following sections in this document.

Main Options
The following properties are specific to the Character Comb control:

Cell Vertical Spacing and Cell Horizontal Spacing

Specify the spacing between adjacent cells (measured in report units). These values do not depend on the specified border
width of a control.

The following image illustrates a Character Comb with Cell Vertical Spacing set to 15 and Cell Horizontal Spacing set to
5.

Border Width

Specifies the width of cell borders in pixels, as a floating point value.

When the cell spacing is set to zero, the borders of adjacent cells are merged (i.e., the actual border width is not doubled).

The following images illustrate how cell spacing affects the Border Width property behavior:

CELL S PACING  = 0 CELL S PACING  = 1



When the control's content is to be printed on multiple pages, a page break horizontally splits the cell border based on the
cell spacing setting, as shown below.

CELL S PACING  = 0 CELL S PACING  > 0

Cell Size Mode

Specifies whether or not the cell size should depend on the current font size of a control. The following cell size modes are
supported:

Custom

The cell size is determined by the Cell Height and Cell Width property values and does not depend on the assigned
font size.

With this setting, the actual cell size is less than the specified Cell Height and CellWidth by the Border Width value.

Auto Size

The cell size depends on the current font size of a control (the Cell Height and Cell Width properties are ignored).

With this setting, the actual cell size does not depend on the specified border width of a control.

Auto Height

Only the cell height depends on the current font size of a control (the Cell Height property is ignored), and the Cell
Width value is specified manually.

With this setting, the following behavior is expected:

The actual cell height does not depend on the specified border width of a control.
The actual cell width is the difference between the specified Cell Width and Border Width values.

Auto Width

Only the cell width depends on the current font size of a control (the Сell Width property is ignored), and Cell
Height value is specified manually.

With this setting, the following behavior is expected:

The actual cell width does not depend on the specified border width of a control.
The actual cell height is the difference between the specified Cell Height and Border Width values.

Content Layout and Position



This section describes the Character Comb properties that affect the control's position on a page and content layout.

The following image illustrates the behavior of the Auto Width property that specifies whether or not the width of a control
depends on its text.

AU TOW ID TH = TR U E AU TOW ID TH = FALS E

The following image illustrates the behavior of the Can Shrink property that specifies whether or not the height of a control
depends on its text.

CANS HR INK = TR U E CANS HR INK = FALS E

The Text Alignment property specifies the alignment of text within a control.

TE X TALIG NMENT = TOP LEF T TE X TALIG NMENT = MID D LE CENTER TE X TALIG NMENT = B OT TOM R IG HT



Rich TextRich Text
Overview
The Rich Text control displays formatted text (static, dynamic or mixed) in your report.

To add this control to a report, drag the Rich Text item from the Toolbox onto the report's area.

You can load RTF or HTML content from an external file. Click the control's smart tag and select Load File.

In the invoked Open dialog, use the drop-down list to define the file's extension (.rtf, .docx, .txt, .htm or .html), select the file
and click Open.

You can double-click the Rich Text to invoke its in-place editor and enter static text. Use the Toolbar's Font group to format the
text.

Press CTRL+Enter to submit changes and exit the in-place editor.

�� N o t eN o t e

The Rich Text's content is exported as plain text only when exporting to XLS or XLSX format.

Bind to Data
You can bind the control's RTF property to a data field obtained from a report's data source. Click the control's smart tag, expand



the Rtf Expression's drop-down list and select the data field.

You can bind the control to a data field that provides HTML content in the same way. To do this, click the control's smart tag and
use the Html Expression's drop-down list.

Click the Rtf Expression or Html Expression option's ellipsis button to invoke the Expression Editor. This editor allows you to
construct a complex binding expression with two or more data fields.

You can also drag and drop any field from the Field List with the right mouse button and select the Rich Text menu item. This
creates a new Rich Text control bound to this field.

The Rich Text also enables you to merge data fields and static content in its text.

See the Bind Controls to Data and Use Embedded Fields topics for more information.



Check BoxCheck Box
The Check State property specifies the checkbox's state.

The Checked property indicates whether the checkbox is checked (displays a check mark) or not (is empty).

The Text property specifies the checkbox's caption. Double-click the checkbox to invoke its in-place editor and type the caption
text.

Bind to Data
Drag a Boolean field from the Field List onto your report. This adds a new checkbox to your report and binds its Check State
property to the dragged field.

If you add a checkbox from the Toolbox, click the control's smart tag, expand the CheckState property's Expression drop-down
list and select a data field. This binds your control's CheckState property to a data source field.



The data field value specifies the checkbox's state:

True or 1 - activates the Checked state;
False or 0 - activates the Unchecked state;
Any other value - activates the Indeterminate state.

You can bind your control's CheckState the checkbox caption to a data source field. Click the control's smart tag, expand the
Expression drop-down list and select the data field.

The Expression option's ellipsis button invokes the Expression Editor. This Editor allows you to construct a complex binding
expression with two or more fields.

Refer to the Bind Controls to Data (Expression Bindings) topic for more information about the available data binding modes and
how to create data-aware controls.

Interactivity



Change the Enabled checkbox within the Edit Options group to specify if users can change the checkbox state in Print Preview.

You can create checkbox groups to make them behave like radio lists. To group checkboxes, set their Group ID option within the
Edit Options group a group ID value.

Customization
The Glyph Options property provides access to glyph settings.

Style - specifies a predefined glyph style.



Alignment - specifies the glyph's alignment within the control.

Size - specifies the glyph size.

Custom Glyphs - specifies a custom glyph image for each checkbox state (Checked/Unchecked/Indeterminate).

The Open File dialog is invoked when you specify custom glyphs.

The selected glyph image is saved to the report definition .repx file.



Picture BoxPicture Box
Overview
Use the Picture Box control to add images to a report. The images can have one of the following formats: BMP, JPG, JPEG, GIF,
TIF, TIFF, PNG, ICO, DIB, RLE, JPE, JFIF, EMF, WMF, SVG.

To add the Picture Box control to a report, drag the Picture Box item from the Toolbox onto the report's area.

Specify one of the following properties to set an image:

Image Source
Save the image to the report definition.
Image Url
Only save a path to the image.

Assign an External Image
Click the Image Source / Image URL property's ellipsis button to invoke the Open File dialog.



The selected image or its URL is saved to the report definition .repx file.

Assign an Image from the Report's Image Collection
Set the report's Image Resources property.



Click the Picture Box's smart tag. In the invoked menu, click the Expression option's ellipsis button to open the Expression
Editor. Choose an image from the Images collection:



Bind a Picture Box to Data
Use one of the following techniques to add the Picture Box control that obtains an image from a data source.

Click the control's smart tag. In the invoked menu, expand the Expression drop-down list for the Image Source property
and select a data field.

You can bind the Image Url property to data in a similar way. In this instance, the URL that specifies the image location is
obtained from the data source.

Click the Expression option's ellipsis button to invoke the Expression Editor. Use this editor to construct a binding
expression that can include two or more data fields.

Drag an image data field from the report's Field List and drop it onto a report band.

Right-click a data field in the Field List and drop it onto a report band. Select the Picture Box item in the invoked context



menu.

See the Bind Report Controls to Data topic for more information about how to create data-aware controls.

SVG Support Limitations
The Picture Box control does not support the following SVG content:

Gradient colors
Text (you can convert text to curves as a workaround)
Animations
External .css styles

Export (except for PDF) has the following limitations:

SVG images are converted to metafiles because document viewers may not support SVG format.

SVG images are exported as PNG in the Microsoft Azure environment.

The Medium Trust permission level does not support SVG.

Image Size Modes
Use the Sizing property to specify an image's position in the Picture Box.



This control supports the following image size modes:

Normal

The image is displayed at the top left corner with its original dimensions. The image is clipped if it does not fit the control's
boundaries.

Stretch Image

The image is stretched or shrunk to fill the control's width and height.

Auto Size

The control's dimensions are adjusted to the image's size.

Zoom Image

The image is resized proportionally without clipping it to fit the control dimensions.

Squeeze

The image is centered and shown full-size if the control dimensions exceed the image size. Otherwise, the image is resized
to fit the control's boundaries.



Tile

The original image is replicated within the control starting from the top left corner. The replicated image is clipped if it does
not fit the control's boundaries.

You can also use the Image Alignment property in the Normal, Squeeze and Zoom Image modes to specify the alignment in
relation to the control's boundaries.

Interactivity
You can add a possibility to load/change an image and/or draw a signature in a picture box when it is displayed in Print Preview.
To do this, enable the Edit Options | Enabled property.

Click the picture box in a previewed document and an editor invokes.

 T i pT i p

You can draw borders for the picture box to make the editor visible in Print Preview, if an image is not specified.

Refer to the Content Editing in Print Preview topic for details and to the Create-an-Interactive-E-Form tutorial to see how the E-
Form demo report uses this picture box mode.



SubreportSubreport
The Subreport control is used to embed other reports into the current report.

To add this control to a report, drag the Subreport item from the Toolbox onto the report's area.

The Subreport control allows you to solve the following tasks:

Reuse reports, if there is a particular report structure (template) that needs to be included in many reports; for instance, a
report header that always contains the same information (the company information, logo, date, etc.).

Create master-detail reports

Merge reports

Use one of the following properties to provide the report source:

Report Source

Determines a report to be included as a subreport.

If report classes of the application that invoked the Report Designer are compiled into one assembly, then they are available
as items in this combo box.

Report Source URL

Defines a URL of a report file (*.REPX), to use as a report source.

Double-click a subreport to open its associated report in a new Report Designer tab.



PanelPanel
The Panel control is a container that frames separate report controls and allows you to move, copy and paste them. The panel
also visually unites report controls in Print Preview (for instance, with borders or a uniform color background).

To add a panel to a report, drag the Panel item from the Toolbox and drop it onto the required report band.

Drop the desired report controls onto the panel to combine them to a group.

You can use this panel to move, copy, change appearance settings, etc. instead of adjusting individual controls.

The Report Explorer displays controls placed onto a panel as its subordinate nodes.

The panel cannot contain the following report controls:

Pivot Grid
Subreport
Page Break



Table of Contents
Cross-Band Line and Box

If a panel includes only one control, you can use the Fit Bounds to Container command in the context menu or in the Layout
toolbar tab. This command resizes the control so that it occupies all the available container space (excluding borders).

You can also enable the panel's Can Shrink property to automatically adjusts the panel's size to fit all the inner controls. For
instance, this allows preventing blank areas when you conditionally hide specific controls.

�� N o t eN o t e

The Panel control cannot span several report bands as cross-band controls can.



Page BreakPage Break
The Page Break control's sole purpose is to insert a page delimiter at any point within a report.

You can add this control by dragging the Page Break item from the Toolbox onto the report's area.

This control is visually represented by a short line attached to the report's left margin.

The Page Break control is useful when you need to insert a page break between controls within a report band (for example, to
divide subreports so that the second subreport starts printing on a new page).

You can also insert a page break before or after a specific report band using the band's Page Break property.



Table of ContentsTable of Contents
Overview
Once bookmarks have been assigned to specific report elements, you can generate a table of contents that displays page
numbers containing the elements included into the document map.

To implement a table of contents, drop the Table Of Contents control from the Toolbox onto the report's area. If the report does
not contain a Report Header at the moment, it is created automatically so that the table of contents can be added to it.

The following image illustrates the difference in displaying information by a table of contents within a report and in a published
document.

Table of Contents Structure
The table of contents contains the following elements:



1. A title that displays text and formatting options specified by the Level Title property.

2. One or more document levels that provide individual formatting settings to specific nodes of a document map's tree. To
access the collection of levels, use the Levels property.

Unless levels have been added to a table of contents, a single default level is used to provide common settings to the
elements of a document map for which no specific level has yet been assigned.

Refer to the Add a Table of Contents topic for a step-by-step tutorial.



Page InfoPage Info
The Page Info control is used to display auxiliary information on report pages, such as date, time, page numbers or user name.

To add a new Page Info control to a report, drag the Page Info item from the Toolbox and drop it onto the required report band.

Use the Page Information property to define the kind of information the control displays: page numbers, system date-time, or
user name.

For examples of different uses of this control, see the corresponding tutorials:

Add Page Numbers
Display the User Name in a Report
Display the Current Date and Time in a Report

�� N o t eN o t e

Because usually this information is displayed in the Page Header/Footer and Top/Bottom Margin bands, you cannot bind the
Page Info property to a field from a data source. So, in order to display dynamic information, use the Label or Rich Text controls
instead.

In addition, a format string can be applied to a control's contents. For example, you can change the control's format to Page {0}
of {1} using the Text Format String property.

When a report contains at least one group, you can specify individual page numbers for report groups by setting the Running
Band property to the name of the required group.



Use TablesUse Tables
The documents in this section describe the Table control and illustrate its main features:

Table Overview
Bind Table Cells to Data
Manage Table Structure
Manipulate Table Elements
Hide Table Cells

�� N o t eN o t e

Refer to Create a Table Report for a step-by-step tutorial on creating a data-bound table report.



Table OverviewTable Overview
The Table control displays information in a tabular format and allows you to create table reports.

You can add a table control by dragging the Table item from the Toolbox onto the report's area.

You can also create two tables simultaneously, for instance, one that shows column titles in the Page Header and one that shows
regular information in the Detail band. Select the Table item in the Toolbox and draw a rectangle across these bands.

The table control contains one or more rows. Each row contains one or more cells. See the Report Explorer for a table structure
example.

You can double-click the cell to invoke its in-place editor and type the desired static text.



You can adjust the font size of a cell's static text to fit into the cell's boundaries. Use the Fit Text to Bounds button in the
toolbar's Text contextual tab, or right-click this cell and select Fit Text to Bounds in the context menu.

Refer to Bind Table Cells to Data to learn about providing dynamic content to table cells.

A table cell is like an Label control - it provides the same options for text formatting, alignment, appearance, interactivity, etc.

You can also make a table cell act as a container for other report controls by dropping the required control from the toolbox on
this cell.

If a table cell includes only one control, you can right-click this control and use the Fit Bounds to Container command in the
context menu. The same command is available in the toolbar's Layout tab. This command resizes the control so that it occupies
all the available cell space (excluding borders).

To transform a table into a set of Label controls, right-click a table or any of its cells and select Convert To Labels. Table cells
containing other controls are converted to Panel controls.



You can assign different visual styles for even and odd table rows to improve readability.



Bind Table Cells to DataBind Table Cells to Data
You can create a table control with cells bound to data fields obtained from a report's data source using the Field List. Select data
fields by clicking them while holding the CTRL or SHIFT key and drop them onto the Detail band.

Drag and drop the same fields with the right mouse button to create column headers with the corresponding field names.

You can bind individual table cells to data in the same ways as Label controls. Dropping a data field onto an existing cell binds this
cell to a corresponding field.

Alternatively, click the cell's smart tag, expand the Expression drop-down list and select the required data field

Clicking the Expression option's ellipsis button invokes the Expression Editor. This allows you to construct a complex binding
expression involving two or more data fields.

See the Bind Report Controls to Data topic to learn more about creating data-aware controls.

The Process Duplicates Mode and Process Duplicates Target options enable you to merge cells with identical values.





Manage Table StructureManage Table Structure
Insert Table Rows and Columns
You can use the Insert group in the toolbar's Table Tools contextual tab or the Insert context menu items to add new rows and
columns. The added cells inherit the source cells' size and appearance settings.

Insert Row Above

Inserts a row above the current cell and shifts the existing rows up if there is enough space above the table (otherwise, shifts
the existing rows down).

Insert Row Below

Inserts a row below the current cell and shifts the existing rows down. This command increases the band height to
accommodate all the rows if there is not enough space under the table.

Insert Column to Left

Inserts a new column to the left of the current cell and shifts the leftmost columns to the left (otherwise, shifts these
columns to the right).

Insert Columns to Right

Inserts a new column to the right of the current cell and shifts the rightmost columns to the right. This command decreases
all columns' width proportionally to accommodate all the columns if there is not enough space to the right of the table.



Insert, Split and Merge Table Cells
Insert Cell (context menu item)

Divides the current cell width in half and inserts a new cell to the right. The added cell copies the source cell's appearance
settings.

Merge Cells

Merges the selected cells. This command is available if the selection has a rectangle form.

Split Cells

Invokes the Split Cells dialog where you can specify the number of columns and rows to split the selected cells. You can
apply this change to each selected cell individually, or merge the cells and then split the resulting cell.



Delete Table Elements
Use the Delete group in the toolbar's Table Tools contextual tab or the Delete context menu items to remove table elements.

Delete Cell

Deletes a table cell and stretches the previous cell to occupy the remaining space. If this cell is the first in the row, the next
cell is stretched.

Delete Row

Deletes a row and shifts the existing rows up.

Delete Column

Deletes a column and shifts the existing columns to the left.



Delete Table

Deletes the entire table.



Manipulate Table ElementsManipulate Table Elements
Select Table Elements
You can click a table cell to select it and access its settings. To select multiple cells, hold the SHIFT or CTRL key and click cells.

Use the arrow that appears when a mouse cursor hovers over the table edges to select an entire row or column.

Click the  button at the table's left bottom corner to select the whole table. You can also use this button to move the table.

The Select group in the toolbar's Table Tools contextual tab also enables you to select the current row, the current column or the
entire table.

Resize Table Elements
You can resize a table or its cell by dragging the rectangle drawn on its edge or corner.

The following column resizing modes are supported:

Resizing a column changes the next column's width without affecting the other columns (keeps the table dimensions intact).

Resizing a column while holding the CTRL key changes the next columns' width while maintaining their proportion to the
overall table (keeps the table dimensions intact).



Resizing a column while holding the SHIFT key shifts the next columns without changing their size.

The following row resizing modes are supported:

Resizing a row changes the next row's width without affecting the other rows (keeps the table dimensions intact).

Resizing a row while holding the SHIFT key shifts the next rows without changing their size.

You can set the same size for multiple table columns or rows. Select the required rows or the whole table, right-click the selected
area and choose Distribute Rows Evenly.

If the cell's content is partially visible in the resulting row, this row automatically increases its height to fit its content and also
adjusts the other rows accordingly.

You can resize columns equally in a similar way by selecting the columns or the table itself and choosing Distribute Columns
Evenly in the context menu.



Reorder Table Rows and Cells
You can change the order of table rows and cells. Switch to the Report Explorer window, select a row or cell and drag it to a new
position.

The Report Explorer highlights the possible drop targets when you drag an element over them.
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You can move table rows and cells only within the same parent control.

Apply Styles to Table Elements
Select a table element and switch to the Property Grid. Expand the Styles group and set the Style property to the style name.

As an alternative, you can drag a style from the Report Explorer onto an element.



Stretch Table Cells
You can stretch a cell so that it occupies several rows and columns.

Stretch a cell across several columns
Remove a neighboring cell by pressing DELETE or selecting Delete | Cell in the context menu and resize the remaining cells.

Stretch a cell across several columns
Use a table cell's Row Span property to specify the number of rows the table cell spans.
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For the RowSpan property to work properly, the spanned cells should have the same width.



Hide Table CellsHide Table Cells
You can hide a specific table cell conditionally, for instance, based on a report parameter value.

Right-click the Parameters section in the Field List and select Add Parameter.

In the invoked Add New Parameter dialog, specify the parameter's name and description for Print Preview, and set the type to
Boolean.

�� W ar n i n gW ar n i n g

Use the approach below if expression bindings are enabled in the Report Designer (the Property Grid provides the
PropertyName Expression item in the property marker's context menu).

Specify an expression for the cell's Visible property to define a logical condition for displaying or hiding this cell.

The image below demonstrates how to provide the visibility expression for the cell bound to the CategoryID field. For a
report to display correctly, you should specify the same expression for the cell that displays the field caption in the Page
Header.
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Use the approach below if expression bindings are not enabled in the Report Designer (the Property Grid does not provide
the PropertyName Expression item in the property marker's context menu).

Create a formatting rule, specify a logical condition to hide a cell and set the Visible property to False as shown below. For
a report to display correctly, apply the created rule to the cells in the Detail band and the Page Header band.

The Process Hidden Cell Mode property allows you to define how to distribute the remaining space between the table's visible
cells.



The image below illustrates how the original table looks like:

The following modes are available to process hidden cells:

StretchPreviousCell - A cell to the left of the hidden cell is stretched to occupy the available space. If the hidden cell is the
first in the row, the next cell is stretched.

StretchNextCell - A cell to the right of the hidden cell is stretched to occupy the available space. If the hidden cell is the last
in the row, the previous cell is stretched.

ResizeCellsEqually - All visible cells are resized to divide the space that a hidden cell reserved equally.

ResizeCellsProportionally - All visible cells are resized to proportionally divide the space that a hidden cell reserved based
on their weights in the whole table width.



DecreaseTableWidth - The table width is decreased, and visible cells are shifted to a hidden cell's location without
changing their size.

LeaveEmptySpace (the default mode) - A space remains at a hidden cell's location, and other cells are not affected.



Use Bar CodesUse Bar Codes
The following topics provide basic information about using bar codes:

Add Bar Codes to Reports
Bar Code Recognition Specifics

See the following topics to learn about the supported one-dimensional bar codes:

Codabar
Code 11 (USD-8)
Code 128
Code 39 (USD-3)
Code 39 Extended
Code 93
Code 93 Extended
EAN 8
EAN 13
GS1-128 - EAN-128 (UCC)
GS1 - DataBar
Industrial 2 of 5
Intelligent Mail Package
Interleaved 2 of 5
Matrix 2 of 5
MSI - Plessey
PostNet
UPC Shipping Container Symbol (ITF-14)
UPC Supplemental 2
UPC Supplemental 5
UPC-A
UPC-E0
UPC-E1

See the following topics to learn about the supported two-dimensional bar codes:

ECC200 - Data Matrix
GS1- Data Matrix
Intelligent Mail
PDF417
QR Code



Add Bar Codes to a ReportAdd Bar Codes to a Report
Overview
To insert a bar code into a report, drag the Bar Code item from the Toolbox onto the report's area.

After creating the bar code, select the bar code type (symbology) in the Bar Code Tools toolbar tab's Symbology gallery.

After specifying the symbology, you can customize the type-specific options of the bar code, which are listed in the Property Grid
under the Symbology property.

Main Options
You can use the Binary Data property to supply the data that a bar code should encode.

To specify the bar width (a bar code's resolution), use the following options:

Automatically calculate the bar width according to a bar code's dimensions by enabling the Auto Module option;
Provide a fixed bar width value using the Module property.

The following are some additional bar code options:

Use the bar code's Text property to provide accompanying text. The Show Text property allows you to show or hide this
text.

Use the Orientation property to rotate a bar code.



Use the Padding property to specify the indent between bars and the bar code's inner boundaries.

Bind to Data
You can bind the bar code's Text property to a data field obtained from a report's data source. Click the control's smart tag,
expand the Expression drop-down list and select the data field.

You can also click the Expression option's ellipsis button to invoke the Expression Editor. This editor allows you to construct a
complex binding expression with two or more data fields.

Common Errors
The following section explains how to work around the most frequently encountered errors related to the incorrect use of bar
codes.

The following error message is shown in place of the bar code if the control's dimensions are too small to fit the bar code
with its specified resolution.

To get rid of this error, enable the Auto Module property and/or increase the bar code's dimensions.

The following error message appears when the data supplied to a bar code contains characters that are not supported by
this bar code type.

To avoid this error, supply data that applies to a particular bar code specification.



Bar Code Recognition SpecificsBar Code Recognition Specifics
This document describes the main specifics of bar code recognition and how to resolve the most frequently encountered issues
when working with bar codes.

Choose an Appropriate Bar Code Type
Selecting an appropriate bar code type (symbology) depends on your specific business requirements and the applied industrial
standards.

In general, consider using Bar Code 2 of 5 Interleaved for encoding digits and Bar Code 39 for encoding the full range of ASCII
characters.

Insert the Function Code One Character (FNC1) or the Application
Identifier into a Bar Code
Some encodings enable you to insert a special FNC1 character for separating application identifiers from the rest of the bar code.

According to the GS1 specification, the FNC1 character is always inserted at the first position of the encoded data. Other
identifiers can be inserted manually using the default "#" character.

Although you can use any ASCII character as the FNC1 placeholder, it will not be a part of the encoded data as it does not have
any direct ASCII representation.

�� N o t eN o t e

For the Code 128 symbology, only FNC1 characters are currently supported. At present, there is no way to define FNC2 - 4
characters for this bar code.

For the list of the available application identifiers, refer to the official documentation at www.gs1.org.

Specify the Bar Code Resolution on Export to Third-Party Formats
At present, only export to PDF preserves the original bar code in its vector form. Export to other formats will keep only the
rasterized version of a bar code (with the default DPI set to 96).

For XLSX and XLS export, the output resolution can be set up manually using the Rasterization Resolution property.

Common Issues
This document section provides solutions to the most common issues that you may encounter when creating bar codes.

The bar code is too "dense"

The more information you wish to encode, the more bars should be drawn and the larger the bar code should become.

The bar code's Module property specifies the width of the narrowest bar in a bar code. Although you can set this property
to a very small value, the actual value is determined by the maximum resolution of your bar code printer device.
Alternatively, consider using the Auto Module option to automatically calculate the optimal bar size based on the current
bar code dimensions.

�� N o t eN o t e

When bar codes are "dense" and you are manually specifying the Module value, make sure that multiplying this value by
the bar code printer resolution results in an integer number. Otherwise, rounding errors may occur on calculating the
resulting bar width.

http://www.gs1.org/


For example, when the Module is set to 0.015 inches and the printer resolution is 300 DPI, their product equals 4.5, which
may be rounded to 4 or 5 pixels for different bars and result in bar code recognition errors. In this case, the Module
property should be set to 0.01333 (to make the bar width equal to 4 pixels) or to 0.01667 (to make the bar width equal to 5
pixels).

The bar code is correctly displayed on the preview but it is not scanned

Make sure that your scanner has been correctly set up to be able to recognize a specific kind of a bar code. If you are not
certain about how to operate the scanner properly, please refer to its product manual.

Avoid scanning bar codes from the monitor screen (e.g., using an application installed on your smartphone), because the
screen DPI may not be sufficient to effectively recognize each particular bar.

The bar code is correctly displayed on the preview but it is scanned incorrectly

The cause for this problem may be an encoding issue specific to the "binary" input mode.

By default, the UTF-16 encoding is used. However, your scanner device may use a different encoding model or even a
codepage (i.e., a specific table that maps abstract values to real human-understandable characters). For additional
information on this subject, please refer to the specification of your scanner device.

The "There are invalid characters in the text" error occurs

Different bar code symbologies define different ranges of allowed characters under different character sets. To avoid this
error, please check the bar code specification.



CodabarCodabar
The Codabar is a discrete, self-checking symbology that may encode 16 different characters, plus an additional 4 start/stop
characters. This symbology is used by U.S. blood banks, photo labs, and on FedEx air bills.

The following properties are specific to the Codabar type and listed in the Property Grid under the Symbology property:

StartSymbol

Gets or sets the first (start) symbol used to code the bar code's structure.

StopSymbol

Gets or sets the last (stop) symbol used to code the bar code's structure.

Wide Narrow Ratio

Specifies the density of a bar code's bars.



Code 11 (USD-8)Code 11 (USD-8)
Code 11, also known as USD-8, was developed as a high-density numerical-only symbology. It is used primarily in labeling
telecommunications equipment.

The symbology is discrete and is able to encode the numbers 0 through to 9, the dash symbol (-), and start/stop characters.

The are no properties specific to the Code 11 bar code type.



Code 128Code 128
Code 128 is a very effective, high-density symbology which permits the encoding of alphanumeric data. The symbology includes
a checksum digit for verification, and the bar code can also be verified character-by-character, allowing the parity of each data
byte to be verified.

This symbology has been widely implemented in many applications where a relatively large amount of data must be encoded in a
relatively small amount of space. Its specific structure also allows numerical data to be effectively encoded at double-density.

The following property is specific to the Code 128 type and available in the Property Grid under the Symbology property:

Character Set

Specifies the set of symbols which can be used when setting the bar code's text.



Code 39 (USD-3)Code 39 (USD-3)
Code 39, the first alpha-numeric symbology to be developed, is still widely used, particularly in non-retail environments. It is the
standard bar code used by the United States Department of Defense, and is also used by the Health Industry Bar Code Council
(HIBCC). Code 39 is also known as "3 of 9 Code" and "USD-3".

The following properties are specific to the Code 39 type and listed in the Property Grid under the Symbology property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

Wide Narrow Ratio

Specifies the density of a bar code's bars.



Code 39 ExtendedCode 39 Extended
Using Code 39's "Full ASCII Mode", it is possible to encode all 128 ASCII characters. This is accomplished by using the ($), (/), (%),
and (+) symbols as "shift" characters. These characters combined with the single character that follows indicate which Full ASCII
character is to be used.

The following properties are specific to the Code 39 Extended type and listed in the Property Grid under the Symbology
property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

Wide Narrow Ratio

Specifies the density of a bar code's bars.

The Code 39 Extended bar code, as opposed to Code 39, automatically replaces all necessary characters with special symbols,
when required. This means that you do not need to do this manually, otherwise, the result will be incorrect.

For example, if you want to insert a "TAB" character into a bar code's text, use "\t", which will be replaced by "$I" for coding, and
then into "TAB" after scanning:

PR OPER T Y V ALU E

Bar code's text: "12345\t678"

Coded text: "12345$I678"

Scanned text: "12345[TAB]678"

The checksum is not considered to be part of a bar code's text and checksum characters are never replaced. When the bar code's
Show Text and Calculate a Checksum properties are enabled, the bar code will not display a checksum character. This is
required to avoid mistakenly treating a checksum as part of bar code text.



Code 93Code 93
Code 93 was designed to supplement and improve upon Code 39.

Code 93 is similar in that, like Code 39, can represent the full ASCII character set by using combinations of 2 characters. It differs
in that Code 93 is a continuous symbology and produces denser code. It also encodes 47 characters (compared to Code 39's 43
characters).

The following property is specific to the Code 93 type and available in the Property Grid under the Symbology property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

�� N o t eN o t e

A checksum of a Code 93 bar code can contain characters that are not supported by this bar code symbology. For this
reason, the checksum is not included in the Code 93 bar code's displayed text.



Code 93 ExtendedCode 93 Extended
Using Code 93's "Full ASCII Mode", it is possible to encode all 128 ASCII characters. This is accomplished by using the ($), (/), (%),
and (+) symbols as "shift" characters. These characters combined with the single character that follows indicate which Full ASCII
character is to be used.

The following property is specific to the Code 93 Extended type and available in the Property Grid under the Symbology
property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

�� N o t eN o t e

A checksum of a Code 93 Extended bar code can contain characters that are not supported by this bar code symbology.
For this reason, the checksum is not included in the Code 93 Extended bar code's displayed text.



EAN 13EAN 13
EAN-13, based upon the UPC-A standard, was implemented by the International Article Numbering Association (EAN) in Europe.
At present, the GS1 organization is responsible for the maintenance of bar code standards.

The EAN-13 bar code contains 13 digits, no letters or other characters. The first two or three digits represent the country. The
leading zero actually signifies the USA, and UPC-A coding. The last digit is the "check digit", the checksum. The check digit is
calculated using the first twelve figures when the bar code is constructed. So, for the correct EAN-13 code, you should specify
only the first 12 digits.

The recommended dimensions are shown in the following image. The standard allows magnification up to 200%, and reduction
of up to 80% of the recommended size.

There should be two quiet zones before and after the bar code. They provide reliable operation of the bar code scanner. The quiet
zone recommended length is 3.63 mm for the left zone and 2.31 mm for the right zone.

The are no properties specific to the EAN 13 bar code type.



EAN 8EAN 8
EAN-8 is the EAN equivalent of UPC-E in the sense that it provides a "short" bar code for small packages.

The are no properties specific to the EAN 8 bar code type.



ECC200 - Data MatrixECC200 - Data Matrix
Data Matrix code (ISO/IEC 16022 international standard) is a two-dimensional matrix bar code consisting of black and white
"cells" arranged in a rectangular pattern. The information to be encoded can be text or raw data.

Every Data Matrix is composed of two solid adjacent borders in an "L" shape (called the "finder pattern"), and two other borders
consisting of alternating dark and light cells or modules (called the "timing pattern"). Within these borders are rows and columns
of cells that encode information. The finder pattern is used to locate and orient the symbol, while the timing pattern provides a
count of the number of rows and columns in the symbol.

The following properties are specific to the ECC200 - Data Matrix type and available in the Property Grid under the Symbology
property:

Compaction Mode

Specifies whether textual information or a byte array should be used as the bar code's data, as well as its encoding.

Matrix Size

Specifies the bar code matrix size.



GS1 - DataBarGS1 - DataBar
The GS1 DataBar bar code is based on a family of symbols often used in the GS1 DataBar Coupon (coupon codes commonly
used in retail).

These bar codes can encode up to 14 digits, which makes them suitable for GTIN 8, 12, 13 and 14.

GS1 DataBar Expanded and GS1 DataBar Expanded Stacked can encode up to 74 numeric or 41 alphanumeric characters,
and provide the capability to utilize all GS1 Application Identifiers (e.g., expiration date, batch and serial number). These bar
codes are often used in manufacturer coupons.

The following properties are specific to the GS1 DataBar type and available in the Property Grid under the Symbology property:

FNC1 Functional Character

Specifies the symbol (or set of symbols) in the bar code text that will be replaced with the FNC1 functional character when
the bar code's bars are drawn.

Segments In Row

Specifies the number of data segments per row in the Expanded Stacked type of a GS1 DataBar bar code.

Type

Specifies the type of a GS1 DataBar bar code.



GS1- Data MatrixGS1- Data Matrix
The GS1 Data Matrix uses a special start combination to differentiate the GS1 DataMatrix symbol from other Data Matrix ECC
200 symbols. This is achieved by using the Function 1 Symbol Character (FNC1) in the first position of the encoded data. It
enables scanners to process the information according to the GS1 System Rules.

The following properties are specific to the GS1 DataMatrix type and available in the Property Grid under the Symbology
property:

FNC1 Functional Character

Specifies the symbol (or set of symbols) in the bar code text that will be replaced with the FNC1 functional character when
the bar code's bars are drawn.

Human-Readable Text

Specifies whether or not parentheses should be included in the bar code's text to improve the readability of the bar code's
text.

Matrix Size

Specifies the bar code matrix size.



GS1-128 - EAN-128 (UCC)GS1-128 - EAN-128 (UCC)
GS1-128 (EAN-128) was developed to provide a worldwide format and standard for exchanging common data between
companies.

While other bar codes simply encode data with no respect for what the data represents, GS1-128 encodes data and encodes what
that data represents.

The following properties are specific to the GS1-128 (EAN-128) type and available in the Property Grid under the Symbology
property:

Character Set

Specifies the set of symbols which can be used when setting the bar code's text.

FNC1 Functional Character

Specifies the symbol (or set of symbols) in the bar code text that will be replaced with the FNC1 functional character when
the bar code's bars are drawn.

Human-Readable Text

Specifies whether or not parentheses should be included in the bar code's text to improve the readability of the bar code's
text.



Industrial 2 of 5Industrial 2 of 5
Standard 2 of 5 is a low-density numerical bar code that is used in the photofinishing and warehouse sorting industries, as well
as to sequentially number airline tickets.

The following properties are specific to the Industrial 2 of 5 type and available in the Property Grid under the Symbology
property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

Wide Narrow Ratio

Specifies the density of a bar code's bars.



Intelligent MailIntelligent Mail
The Intelligent Mail (IM) code is a 65-bar code for use on mail in the United States. This bar code is intended to provide greater
information and functionality than its predecessors POSTNET and PLANET.

The Intelligent Mail bar code has also been referred to as One Code Solution and 4-State Customer bar code abbreviated
4CB, 4-CB or USPS4CB.

The are no properties specific to the Intelligent Mail bar code type.



Intelligent Mail PackageIntelligent Mail Package
The Intelligent Mail Package Barcode (IMPB) was developed for the use on mail in the United States. Bar codes of this
symbology are used only for packages as opposed to Intelligent Mail bar codes, which are used for postcards, letters, and flats.

This bar code is capable of encoding package tracking information required for more efficient sorting and delivering of packages
with the capability of piece-level tracking.

The following property is specific to the Intelligent Mail Package type and available in the Property Grid under the Symbology
property:

FNC1 Functional Character

Specifies the symbol (or set of symbols) in the bar code text that will be replaced with the FNC1 functional character when
the bar code's bars are drawn.



Interleaved 2 of 5Interleaved 2 of 5
Interleaved 2 of 5 is a higher-density numerical bar code based upon the Standard 2 of 5 symbology. It is used primarily in the
distribution and warehouse industry.

The following properties are specific to the Interleaved 2 of 5 type and available in the Property Grid under the Symbology
property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

Wide Narrow Ratio

Specifies the density of a bar code's bars.



Matrix 2 of 5Matrix 2 of 5
Matrix 2 of 5 is a linear one-dimensional bar code. Matrix 2 of 5 is a self-checking numerical-only bar code.

Unlike the Interleaved 2 of 5, all of the information is encoded in the bars; the spaces are of a fixed width and used only to
separate the bars. Matrix 2 of 5 is used primarily for warehouse sorting, photo finishing, and airline ticket marking.

The following properties are specific to the Matrix 2 of 5 type and available in the Property Grid under the Symbology property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

Wide Narrow Ratio

Specifies the density of a bar code's bars.



MSI - PlesseyMSI - Plessey
MSI was developed by the MSI Data Corporation, based on the original Plessey Code. MSI, also known as Modified Plessey, is
used primarily to mark retail shelves for inventory control.

MSI is a continuous, non-self-checking symbology. While an MSI bar code can be of any length, a given application usually
implements a fixed-length code.

The following property is specific to the MSI type and available in the Property Grid under the Symbology property:

MSI Checksum

Specifies the bar code's checksum type, which defines the appearance of checksum bars added to the bar code.



PDF417PDF417
PDF417 (Portable Data File) is a stacked linear two-dimensional bar code used in a variety of applications; primarily transport,
postal, identification card and inventory management. It has spawned an Open Source decoder project together with an Open
Source encoder.

The PDF417 bar code is also called a symbol bar code and usually consists of 3 to 90 rows, each of which is like a small linear bar
code.

The following properties are specific to the PDF417 type and available in the Property Grid under the Symbology property:

Columns

Specifies the number of bar code columns, which allows you to control the logic width of the bar code.

Compaction Mode

Specifies whether textual information or a byte array should be used as the bar code's data.

Error Correction Level

Specifies the amount of redundancy built into the bar code's coding, to compensate for calculation errors.

Rows

Specifies the number of bar code rows, which allows you to control the logic height of the bar code.

Truncate Symbol

Specifies whether the special end-symbol should be appended to the bar code.

Y to X Ratio

Specifies the height-to-width ratio of a logical unit's graphic representation.



PostNetPostNet
PostNet was developed by the United States Postal Service (USPS) to allow faster mail sorting and routing. PostNet codes are
the familiar and unusual looking bar codes often printed on envelopes and business return mail.

Unlike most other bar codes, in which data is encoded in the width of the bars and spaces, PostNet actually encodes data in the
height of the bars. That's why all the bars are of the same width, but not the same height.

The are no properties specific to the PostNet bar code type.



QR CodeQR Code
A QR Code (QR is the abbreviation for Quick Response) is a two-dimensional code, readable by QR scanners, mobile phones
with a camera, and smartphones. QR Code can encode textual, numeric and binary data.

The following properties are specific to the QR type and available in the Property Grid under the Symbology property:

Auto Module Gets or sets whether the Module property value should be calculated automatically based upon the
barcode's size.

Compaction Mode

Specifies whether numeric, alpha-numeric or byte information should be used as the bar code's data.

Error Correction Level

Specifies the amount of redundancy built into the bar code's coding, to compensate for calculation errors.

Version

Specifies the bar code's size.

Logo

Specifies the image that overlays the QR code.



UPC Shipping Container Symbol (ITF-14)UPC Shipping Container Symbol (ITF-14)
The UPC Shipping Container Symbol (ITF-14) bar code is used to mark packaging materials that contain products labeled with
a UPC or EAN product identification number.

This bar code provides a GS1 implementation of an Interleaved 2 of 5 bar code for encoding a Global Trade Item Number (an
identifier for trade items developed by GS1). This bar code always uses a total of 14 digits.

The thick black border around the symbol (the Bearer Bar) is intended to improve bar code reading reliability.

The following properties are specific to the ITF-14 type and listed in the Property Grid under the Symbology property:

Calculate a Checksum

Specifies whether to calculate a checksum for the bar code.

Wide Narrow Ratio

Specifies the density of a bar code's bars.



UPC Supplemental 2UPC Supplemental 2
2-digit supplemental bar codes should only be used with magazines, newspapers and other periodicals.

The 2-digit supplement represents the issue number of the magazine. This is useful so that the product code itself (contained in
the main bar code) is constant for the magazine, so that each issue of the magazine doesn't have to have its own unique bar code.
Nevertheless, the 2-digit supplement can be used to track which issue of the magazine is being sold, for example, for sales
analysis or restocking purposes.

The are no properties specific to the UPC Supplemental 2 bar code type.



UPC Supplemental 5UPC Supplemental 5
5-digit supplemental bar codes are used on books to indicate the suggested retail price.

The are no properties specific to the UPC Supplemental 5 bar code type.



UPC-AUPC-A
The UPC-A bar code is by far the most common and well-known symbology, especially in the United States. A UPC-A bar code is
the bar code you will find on virtually every consumer item on the shelves of your local supermarket, as well as books, magazines,
and newspapers. It is called simply, a "UPC bar code" or "UPC Symbol."

The UPC-A bar code contains 12 digits, no letters or other characters. The first digit is the prefix signifying the product type. The
last digit is the "check digit". The check digit is calculated using first eleven figures when the bar code is constructed. So, for the
correct UPC-A you should specify only the first 11 digits.

The recommended dimensions are shown in the picture. The standard allows magnification up to 200%, and reduction of up to
80% of the recommended size.

There should be two quiet zones before and after the bar code. They provide reliable operation of the bar code scanner. The quiet
zone recommended length is 2.97 mm for the bar code of standard width and height.



UPC-E0UPC-E0
UPC-E is a variation of UPC-A which allows for a more compact bar code by eliminating "extra" zeros. Since the resulting UPC-E
bar code is about half the size as an UPC-A bar code, UPC-E is generally used on products with very small packaging, where a full
UPC-A bar code could not reasonably fit.

The UPC-E0 is a kind of UPC-E code with the number system set to 0. In the human readable string of the bar code the first digit
signifies the number system (always 0 for this code type), and the last digit is the check digit of the original UPC-A code.

In the example below, the original UPC-A code is "04210000526". We should remove the leading zero when assigning the string
to the control's property, since the code format itself implies its presence. The checksum digit (4) is calculated automatically, and
the symbology algorithm transforms the rest of the numeral string. The result is 425261, and it is encoded along with the number
system prefix and the check digit into the scanner-readable form.

Not every UPC-A code can be transformed into the UPC-E0 (it must meet special requirements).



UPC-E1UPC-E1
UPC-E is a kind of UPC-A, which allows a more compact bar code by eliminating "extra" zeros. Since the resulting UPC-E bar
code is about half the size of the UPC-A bar code, UPC-E is generally used on products with a very small packaging where a full
UPC-A bar code does not fit.

The UPC-E1 is a variation of UPC-E code with the number system set to "1". In the human readable string of the bar code the first
digit signifies the number system (always 1 for this code type), the last digit is the check digit of the original UPC-A code.

In the example below, the original UPC-A code is "14210000526". We should remove the leading "1" when assigning the string
to the control's property, since the code format itself implies its presence. The checksum digit (1) is calculated automatically, and
the symbology algorithm transforms the rest of the numeral string. The result is 425261, and it is encoded along with the number
system prefix and the check digit into the scanner-readable form.

Not every UPC-A code can be transformed into the UPC-E1 (it must meet special requirements).



Use Charts and Pivot GridsUse Charts and Pivot Grids
Refer to the following topics for instructions on how to add charts and pivot grids to reports:

Chart
Use the Chart control to add a chart to a report.

Use Charts in Reports
Add a Chart (Set Up Series Manually)
Add a Chart (Use a Series Template)
Use Charts to Visualize Grouped Data

Use Chart and Pivot Grid Linked Together
Link a Chart and a Pivot Grid

Convert a Pivot Grid to a Cross Tab
To migrate an existing Pivot Grid control to a new Cross Tab control, click the Pivot Grid's smart tag and select Convert to Cross
Tab.

Note that the Cross Tab does not support specific Pivot Grid functionality:

The Cross Tab cells cannot display pictures (both static and dynamic);
The Chart control cannot use the Cross Tab as a data source;
The Cross Tab does not support data headers that are used to manage location of data field headers;
The Cross Tab does not support the Pivot Grid's predefined aggregate functions.

If the conversion result does not suit your requirements, you can restore the Pivot Grid. Click the Cross Tab's smart tag and select
Revert to Original Pivot Grid.



Use Charts in ReportsUse Charts in Reports
Overview
You can use the Chart control to add a chart to a report. This control provides 2D or 3D views to visualize data series (for
instance, Bar, Point, Line, Pie and Doughnut, Area, etc.).
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The Chart control can display multiple series.

B AR AND  POINT S ER IES NES TED  D OU G HNU T S ER IES

The Chart control contains various visual elements (diagrams, series, legends, primary and secondary axes, titles and labels, etc.).
You can select these elements in the Report Designer and customize their settings in the Property Grid.

The Report Designer provides the Chart Designer that allows you to create and customize charts.



Bind to Data
To provide data to a chart, use the Data Source property.

You can assign a Pivot Grid to a chart's data source. This allows the Pivot Grid to supply data to the chart. Refer to the Link a
Chart and a Pivot Grid topic for details.

When the chart data source is not assigned, the chart obtains data from the report's data source

A chart can display report data in the following ways:

Place a chart on the report header/footer band to display a summary for the detail report data.



Place a chart on a group header/footer to visualize data in each report group. Refer to the Use Charts to Visualize Grouped
Data step-by-step tutorial for more information.



The chart in the Detail band is printed as many times as there are records in the report's data source.

Specify the following settings to provide data to a chart's series.

The Argument Data Member property specifies the data field that provides point arguments.
The Value Data Members property specifies the data fields that supply point values.

You can specify these settings in the following ways:

Bind each series individually

Add a new series to the chart and specify the argument and value data members. Refer to the Add a Chart (Set Up Series
Manually) step-by-step tutorial for details.

Create series dynamically

Assign the data field that contains series names to the chart's Series Data Member property and specify the argument and
value data members using the series template. Refer to the Add a Chart (Use a Series Template) step-by-step tutorial for
more information.



Add a Chart (Set Up Series Manually)Add a Chart (Set Up Series Manually)
This document demonstrates how to add a chart to a report, provide data for chart series, and set up chart elements. This topic
shows two chart series based on the same data source. You can use different data sources for different series.

Add a Chart to a Report
1. Drop the Chart control from the Toolbox onto the Detail band.

The Chart Designer wizard is invoked. Disable the Display the designer every time a new chart is added option if you
do not want to trigger the wizard the next time you create a chart.



Close the wizard at this stage.

2. Click the chart's smart tag to bind the chart to data. Expand the Data Source property's drop-down and click Add New
Data Source.

3. The invoked Data Source Wizard enables you to create a data source and bind the chart to it.

�� N o t eN o t e

Ensure that the report's Data Source property is set to None when you place a chart into the Detail band. Otherwise, the chart is
repeated as many times as there are records in the report's data source.

Add Series to the Chart
1. Select the chart. Switch to the Chart Tools toolbar tab and click Run Designer.

2. Add a new series to the chart.

Locate Series in the chart elements tree and click the plus button.

Select the series type (for example, Bar) from the invoked list.



3. Populate the created series with points.

Switch to the Data tab.
Select a data source from the drop-down list.

Drop data fields onto the Argument and Value cells to define the series' points.

4. Filter series data.

Switch to the Properties tab.
Click the Filter String property's ellipsis button.



Construct filter criteria in the invoked FilterString Editor and click OK.

5. Create another series with the same settings. Select the Point view type for this series.

Customize the Chart
Improve the chart's appearance:

Remove the chart legend, because the chart series are bound to the same data. Select Legend in the chart elements tree
and disable the Visibility check box in the Options tab.



Select the Label node under Series 1 and disable the Visibility check box to hide point labels.

Customize the Series 2 markers' appearance. Set Size to 12 and Kind to Inverted Triangle to replace the default circle
with an upside down triangle.

Customize the chart's appearance settings. For instance, select Nature Colors from the drop-down Palette list.



View the Result
Switch to Print Preview to preview your report.



Add a Chart (Use a Series Template)Add a Chart (Use a Series Template)
This document describes how to create a report with a Chart control bound to data and generate all series automatically based on
a common template.

Add a Chart to a Report
1. Drop the Chart control from the Toolbox onto the Detail band.

After you drop the chart, the Chart Designer is automatically invoked if its Display the designer every time a new chart
is added option is enabled. Close the designer at this step.

2. Open the Toolbar's Chart Tools contextual tab and click Add Data Source to bind the chart to data.

3. The invoked Data Source Wizard enables you to assign a data source to the chart. Bind the chart to a data source as
described in the Bind to Data section.

4. Click the chart's smart tag and make sure that the Data Source and Data Member properties were specified correctly.



�� N o t eN o t e

The report's Data Source property should be set to None because the Chart is in the Detail band. When a report has its Data
Source property specified, the Chart is repeated in preview as many times as there are records in the report data source.

Adjust the Series Template
1. Switch to the Chart Tools toolbar tab and click Run Designer.

2. In the invoked Chart Designer, go to the Data tab to the right of the designer's window. Select a data source in the
corresponding drop-down list and drag-and-drop the data fields onto the corresponding cells.

The Series cell specifies a data field that should provide data for series names. A new series should be created for each
record in this data field. Use the Argument and Value cells to define where to get data for point arguments and values.



3. Switch to the Properties tab and expand the Series Template option. The Argument Data Member and Value Data
Members properties are automatically assigned to the corresponding data fields. Make sure that the Argument Scale
Type and Value Scale Type properties are set to appropriate values.

Customize the Chart
Perform the following customization to improve the chart's appearance:



Use the chart's Series Name Template property to add text to the beginning or end of each series name. For example, set
the Begin Text inner property to "GSP in ".
Set the Labels Visibility property to False to avoid overlapping series labels.
Specify the color settings used to draw the chart's series. For instance, select Nature Colors in the Palette's drop-down list.

View the Result
Switch to Print Preview to see the resulting report.



Use Charts to Visualize Grouped DataUse Charts to Visualize Grouped Data
This topic describes how to use charts to visualize grouped data in a report.

In this tutorial, the report data is grouped against a data field (the report's group field). A chart is placed in the Group Footer band
and is not bound to data. The report's data source is used to populate the chart with data.



Follow the steps below to make each chart instance display data for its group.

1. Select the chart. Open the Toolbar's Chart Tools contextual tab and click Run Designer.

2. Add a new series. Click the plus button next to the Series item in the Chart Designer.

Select a series type.

3. Provide data for the argument and value axes.

Switch to the created series' Data tab. Drop fields onto the Argument and Value areas.



4. Filter the chart. Go to the Properties tab. Click the Filter String property's ellipsis button to invoke the FilterString Editor.

Add a filter condition. On the left side, specify the field by which chart data should be filtered.



On the right side, use a chart parameter to obtain a group value from the report's group field. Click the right side's icon until
it turns into a question mark and select Add Parameter from the context menu to invoke the Add New Parameter dialog.

Set the Binding property to the report's group field and click OK.



Click OK in the FilterString Editor and in the Chart Designer to apply changes.

Switch to Print Preview to see the result.



Link a Chart and a Pivot GridLink a Chart and a Pivot Grid
This tutorial demonstrates how to use the Chart control to visualize the Pivot Grid control's data.

Create a Pivot Grid
1. Drop the Pivot Grid control from the Toolbox onto the Detail band.

2. Open the Toolbar's Pivot Grid Tools contextual tab and click Add Data Source to bind the pivot grid to data.

3. Navigate through the invoked Data Source Wizard's pages to set up the data source. See the Bind to Data section for more
information.

After the data source is created, the Pivot Grid's Data Source and Data Member properties are assigned automatically.

4. Switch the Pivot Grid Tools toolbar tab and click Run Designer. In the invoked Designer, click Retrieve Fields to obtain
fields from the control's data source.



5. Switch to the Layout page and drag-and-drop the data fields onto the Row Fields, Column Fields and Data Items areas
to define the Pivot Grid's layout.

Click Apply and close the Designer.

Link a Chart with the Pivot grid
1. Drop the Chart control from the Toolbox onto the Detail band below the Pivot Grid.



2. The Chart Designer is invoked automatically after you drop the Chart onto the Detail band. Switch to the Data tab at the
right of the Designer's window and choose the Pivot Grid in the drop-down list.

This adjusts all the Chart's binding and layout settings automatically. Make sure that Series, Argument and Value cells are
filled with the corresponding fields. Note that field values are generated based on the Pivot Grid's columns, rows, and data
items.



3. Select the Label node under auto-generated series in the chart elements tree and switch to the Options tab. Disable the
Visibility check box to avoid overlapping series labels.

4. (optionally) You can customize various settings that determine a linked Chart and Pivot Grid pair's common behavior. To do
this, use the Chart's Pivot Grid Data Source Options property. This property is synchronized with the Pivot Grid's
Options Chart Data Source property.



View the Result
Switch to Print Preview to see the resulting report.



Use Cross TabsUse Cross Tabs
The Cross Tab control displays data in rows and columns. You can specify what data to use as row/column headers, and what data
should be shown at row and column intersections. You can also determine how to group, sort, format and lay out data.

Refer to the following topics for instructions on how to use cross tabs in reports:

Cross Tab Overview

Explains how to add a Cross Tab to a report and bind a Cross Tab to data.

Cross Tab Fields

Describes the Cross Tab row fields, column fields, data fields, and how to format field values.

Data Shaping

Demonstrates how to group, sort and filter a Cross Tab.

Layout and Print Options

Shows how to adjust Cross Tab size, change header text, and specify how the control is printed.

Cross Tab Appearance

Explains how to change Cross Tab element appearance settings.



Cross Tab OverviewCross Tab Overview
Use the Cross Tab control to display multi-dimensional data, such as summary statistics, surveys, and market research
information.

Add a Cross Tab to a Report
Drag the Cross Tab item from the Toolbox onto a report.

You cannot place the Cross Tab in another report control (Table Cell or Panel) because its width cannot be determined at design
time.



Bind to Data
Use the Cross Tab's Data Source and Data Member properties to bind this control to data.

1. Click the Cross Tab's smart tag.
2. Expand the Data Source property's drop-down list and click Add New Data Source.
3. Follow the steps in the invoked Data Source Wizard to configure a data source.

If these properties are not set, the Cross Tab uses its parent report's data source (the report's Data Source and Data Member
properties).
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If you place a Cross Tab in the Detail band, ensure that the report's Data Source property is not set. Otherwise, the Cross Tab
data is printed as many times as there are rows in the report data source.

The following step-by-step tutorials describe how to create reports that use the Cross Tab control:

Create a Cross-Tab Report - Use the Cross-Tab Report Wizard to create a report.
Create a Balance Sheet - Configure a Cross Tab on the design surface.



Cross Tab FieldsCross Tab Fields
Drop data fields from the Field List onto cross-tab areas to define the control layout. The Cross Tab supports three field types
(areas):

Rows (the Row Fields collection) - displays field values as row headers.

Columns (the Column Fields collection) - displays field values as column headers.

Data (the Data Fields collection) - uses field values to calculate summaries at row and column intersections.
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You can also use calculated fields if data source fields do not suit your requirements and you need to pre-process data before it is
shown in the Cross Tab.

Row and Column Fields
You can drop two or more data fields onto the same area to create a hierarchy. The first field's values are displayed at the root
level (the first column/row), the second field's values are grouped by the first field's values and displayed at the second hierarchy
level (the second column/row), and so on.

Specify Row Fields

Specify Column Fields

Cross Tab cells marked with a database icon become bound to the dropped fields. The corresponding rows/columns are printed
in the document as many times as there are field values in the data source. The top left corner displays headers for row data
fields.

Additional rows/columns are added to the Cross Tab to display total values calculated against these fields. The last row/column



displays grand total values calculated against all the rows/columns.

Data Fields
You can add two or more data fields and arrange them in two ways:

in a column, one under the other (field headers are displayed as row headers);

in a row, one after the other (field headers are displayed as column headers);

When the data area contains only one field, the field header is not displayed.
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You cannot bind the top left corner, row/column totals, and row/column grand totals;
You cannot bind Cross Tab cells to report parameters;
You can only bind Cross Tab cells to fields from a data source and data member assigned to the Data Source and Data
Member properties.

Format Field Values
Use a cell's Text Format String property to format output data.



You can also use the Null Value Text property to specify the text shown when a data field's value is null or empty.



Data ShapingData Shaping
Calculate Totals
The Cross Tab calculates the following automatic totals:

Row Totals - against outer row fields;
Row Grand Totals - against all the rows;
Column Totals - against outer column fields;
Column Grand Totals - against all the columns.

You can use the layout options to move rows and columns that display total values.

If you want to hide specific totals, select any cell in the row/column and disable the Row Visible/Column Visible property.

Change the Summary Type
The Cross Tab summarizes values of data fields and displays the results "as is" at the intersection of the corresponding rows and
columns.



Use the Summary Type property to specify the summary function calculated against a data field.

Use the Summary Display Type property to display results' contribution to other cell values, for example, as a percentage of
grand total values.

Sort Data



The Cross Tab displays row and column field values in the ascending order. Use the Sort Order property to change the current
sort order. Set this property to None to keep the same order as records in the Cross Tab's data source.

You can also use the Sort By Summary Info property to arrange row/column field values based on grand totals values.

1. Select a cell you want to sort and expand the Sort By Summary Info property in the Property Grid.
2. Set the Field Name property to the name of an assigned data source's field. You can also define a field that is not currently

displayed in the Cross Tab.
3. Use the Summary Type property to specify which summary function to calculate. The summary type can differ from the

summary type currently used in the Cross Tab.

4. Use the Sort Order property to define the sort order.



Group Data
The Cross Tab displays unique values of column and row fields and does not group their values.

Use the Group Interval property to combine original field values into categories (groups). For instance, you can group date-time
values by year, month, quarter, day, hour.



To group numeric values, set the Group Interval property to Numeric and use the Group Interval Numeric Range property to
specify the interval length. For instance, set the range to 100 to group records by 100 orders.

Use Parameters
The Cross Tab uses and displays values of data fields from an assigned data source. To provide values outside the data source, use
internal Cross Tab parameters. Each parameter is stored in the Parameters collection.

You can access the Parameters property in the Cross Tab's smart tag or in the Properties window.



Click this property's ellipsis button and add parameters in the invoked Collection Editor. You can bind a Cross Tab parameter to a
report parameter or to any data field available in a report.

You can then use the created parameters to filter the Cross Tab.

Filter Data
Use the Cross Tab's Filter String property to invoke the FilterString Editor and specify the filter criteria.

You can use the Cross Tab's parameters in filter criteria.



Layout and Print OptionsLayout and Print Options
Use the Layout Options property to change the cells' order and location.

Column Total Header Position, Row Total Header Position
Specifies where to display column/row total headers:

show in the same row/column as column/row field values against which totals are calculated (Inner);
span across two rows/columns (Outer).

Column Totals Position, Row Totals Position
Specifies the position of the column/row totals and column/row grand totals:

after column/row field values (After Data);
before column/row field values (Before Data).

Corner Header Display Mode
Specifies what data the Cross Tab should display in the top left corner:

split the corner into columns and display row field names (Row Field Names);
split the corner into rows and display column field names (Column Field Names);
do not split the corner and do not display any text (None).

Data Field Layout
Specifies how to arrange two or more data fields in the Cross Tab layout:

in a row one after another (InRow);
in a column one under another (InColumn).

Hierarchical Row Layout
Specifies how to display row headers:

in a tree-like view one under another (checked)
in a single line (unchecked).

Hide Specific Rows and Columns
Use a cell's Row Visible and Column Visible properties to specify row and column visibility. For instance, select the bottom



right cell and disable these options to hide grand totals. At design time, invisible cells are filled with a hatch brush.

Print Options
Use the Print Options property to specify print options and define which Cross Tab elements to print.

Print Layout
Specifies how to print the Cross Tab content that does not fit the page's width:

on the next page (Across Only);
on the same page below the previous content (Across Then Down).

Across Then Down Offset
Specifies the vertical distance between parts of the Cross Tab content in the Across Then Down print layout.

Print Totals For Single Values
Specifies when to print totals:



for any field value even when it contains one nested value (checked);
for the field values that contain two and more nested values (unchecked).

Repeat Row Headers, Repeat Column Headers Specifies whether to repeat row/column headers when the Cross Tab
content is split horizontally/vertically or print them only once.
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Cross tab cells are split between pages if they do not fit the page's width or height. Set the report's Vertical Content Splitting
and Horizontal Content Splitting properties to Smart Smart to move cells to the next page (or to the Cross Tab's next part
shown on the same page.

Adjust Control Size
Drag the Cross Tab's handlers to change its size. You can also resize individual rows and columns.

Use a cell's Column Auto Width Mode property to specify a cell width calculation method.

Adjust Header Text
You can double-click any cell that displays the header and use the in-place editor to enter text.

Each Cross Tab cell provides the Angle property that allows you to rotate the cell's text.





Cross Tab AppearanceCross Tab Appearance
Customize Appearance
After you drop the Cross Tab from the Toolbox onto a report or finish the Cross-Tab Report Wizard, 4 predefined report styles are
created and assigned to the Cross Tab's Styles.

Use the General Style property to specify common appearance settings that apply to all Cross Tab cells.

Use the Header Area Style, Data Area Style and Total Area Style properties to customize appearance settings of specific areas
shown below.

If an area's appearance option is not set, its value is inherited from the general style.

You can also override appearance settings of each Cross Tab cell. These settings have a higher priority over style settings.



Customize Appearance Conditionally
Specify expression bindings to change a cell's appearance based on a specific condition. You can use the GroupRowIndex and
GroupColumnIndex arguments to identify group indexes (for instance, to define the background color for odd and even rows).

Expressions are evaluated when a report is previewed. The calculated appearance settings have the highest priority. They override
a cell's appearance settings and style settings.





Use Gauges and SparklinesUse Gauges and Sparklines
The topics in this section describe how to add graphical content to your reports:

Add Gauges to a Report
Add Sparklines to a Report



Add Gauges to a ReportAdd Gauges to a Report
Gauge Overview
The Gauge control provides you with the capability to embed graphical gauges into your report.

To add this control to the report, drag the Gauge item from the Toolbox and drop it onto the report.

Use the Toolbar's Gauge Tools contextual tab to select a gauge's appearance.

View

Specifies the type of the displayed gauge. The following view types are available:

Linear

Supported view styles: Horizontal and Vertical.

Circular

Supported view styles: Full, Half, Quarter Left, Quarter Right and Three Fourth.

Theme

Specifies the gauge's color theme. The Flat Light and Flat Dark view themes are supported.



The following properties allow you to customize the gauge scale and specify its displayed values.

Actual Value - specifies the value displayed by a gauge.
Target Value - specifies the position of the target value marker.
Maximum - specifies the gauge's maximum value.
Minimum - specifies the gauge's minimum value.

Bind a Gauge to Data
To bind the gauge's displayed value to data, click the control's smart tag and in the invoked actions list, expand the Expression
drop-down list for the Actual Value property and select the required data field.

In the same way, you can bind the Target Value, Minimum and Maximum properties to data. To do this, expand the
Expression drop-down list for the corresponding property and select the required data field.

Clicking the Expression option's ellipsis button invokes the Expression Editor, in which you can construct a complex binding
expression involving two or more data fields.



Add Sparklines to a ReportAdd Sparklines to a Report
Sparkline Overview
The Sparkline control displays a compact chart that is commonly used to illustrate the data flow for every row in a report.

To add this control to the report, drag the Sparkline item from the Toolbox and drop it onto the report.

Bind the Sparkline to Data
You can connect the sparkline to individual data without accessing a report's data source. Click the control's smart tag, expand the
Data Source drop-down list and select the required data source.

The sparkline uses the report's data source if you do not specify the DataSource property.

After that, specify the Data Member property and set the Value Member property to a data field that provides point values for
the sparkline.

To create a new data source for a sparkline, open the Toolbar's Sparkline Tools contextual tab and click the Add Data Source
button. This invokes the Data Source Wizard that allows you to set up a required data source.

Adjust the Sparkline View
You can select the sparlkline's view type in the Sparkline Tools toolbar tab's View gallery.

Alternatively, you can click the sparkline's smart tag and select the required view type in the View drop-down list.

The sparkline supports the Line, Area, Bar and WinLoss view types.



The View property provides access to options that change the sparkline's appearance.

Each view type has properties that define the extreme values' visibility:

Highlight Start Point and Highlight End Point;
Highlight Min Point and Highlight Max Point.

Specific properties differ between view types, such as the Highlight Negative Points setting that is available only for the Bar
sparkline.

The following image illustrates a table report containing sparklines that provide maximum and minimum value indicators in their
data range:





Draw Lines and ShapesDraw Lines and Shapes
The topics in this section describe how to draw various lines and shapes in a report:

Draw Lines
Draw Shapes
Draw Cross-Band Lines and Boxes



Draw LinesDraw Lines
The Line control draws a line in a specified direction, style, width, and color. You can use it to decorate and visually separate a
report's sections.

To add a line to a report, drag the Line item from the Toolbox onto the report's area.

The actions list of the line's smart tag provides the main control properties:

Line Direction

Enables you to draw a line horizontally, vertically, and across the rectangle the line occupies from one corner to another
(Horizontal, Vertical, Slant and Back Slant types).

Line Style

You can select the solid (by default), dashed, dotted, or mixed line style.

Line Width

Specifies the line width in pixels as a floating point value.

Anchor Vertically

Specifies the vertical anchoring style, so that after page rendering a control stays attached to the top control, bottom control,
or both.
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The Line control cannot span several bands. See Draw Cross-Band Lines and Boxes to learn about drawing lines through several
bands.



Draw ShapesDraw Shapes
The Shape control allows you to draw various shapes in a report.

To add a shape to a report, drag the Shape item from the Toolbox onto the report's area.

Click a control's smart tag and use the Shape property to select the shape type. You can also choose the shape type in the
Toolbar's Shape Tools contextual tab.

The smart tag provides the following main properties common to all shape types:

Fill Color - specifies the the shape's color.
Stretch - specifies whether to stretch a shape to fill its client rectangle area when it is rotated.
Line Width - specifies the width of the line used to draw the shape.
Angle - specifies the shape's rotation angle.

Each shape type provides its own specific set of properties which are detailed below.

Arrow
The image below illustrates the Arrow type's shape.



This shape type has the following additional properties:

Fillet - specifies how the shape's corners are rounded (as a percentage). This value should be between 0 and 100.
Arrow Height - specifies the arrow's relative height (as a percentage). This value should be between 0 and 100.
Arrow Width - specifies the arrow's relative width (as a percentage). This value should be between 0 and 100.

Brace
The image below illustrates the Brace type's shape.

Use the following properties to set up a brace:

Tip's Length - specify the length of a brace's tip.
Fillet - specifies how the shape's corners are rounded (as a percentage). This value should be between 0 and 100.
Tail's Length specify the length of a brace's tail.

Bracket
The following image demonstrates the Bracket type's shape:

The Tip's Length property is specific to this shape type and defines the length of a bracket's tip.

Cross
The image below shows the Cross type's shape.

This shape type has the following properties:

Fillet - specifies how the shape's corners are rounded (as a percentage). This value should be between 0 and 100.
Horizontal Line Height - specifies the relative width of a cross's horizontal line (as a percentage). This value should be
between 0 and 100.
Vertical Line Width - specifies the relative width of a cross's vertical line (as a percentage). This value should be between 0
and 100.



Ellipse
The image below shows Ellipse type shapes.

Line
The following image demonstrates Line type shapes:

Polygon
The image below illustrates the Polygon type's shape:

This shape type has the following properties:

Fillet - specifies how the polygon's corners are rounded (as a percentage). This value should be between 0 and 100.
Number Of Sides - specifies the number of polygon sides.

Rectangle
The image below illustrates Rectangle type shapes.

This shape type's Fillet property specifies the rectangle's relative roundness (as a percentage, between 0 and 100).

Star
The following image shows a Star type shape:



This shape type has the following properties:

Fillet - specifies the relative roundness of the star's points (as a percentage). This value should be between 0 and 100.
Count of Star Points - specifies the number of points that make up the star.
Concavity - specifies the concavity level (as a percentage) between two neighboring start points. This value should be
between 0 and 100.



Draw Cross-Band Lines and BoxesDraw Cross-Band Lines and Boxes
Cross-band controls allow you to draw lines and rectangles through several report bands.

The Report Designer provides the following two cross-band controls:

The Cross-Band Line control draws vertical lines that can span multiple report bands. You can use this control to
emphasize a report area that consists of different bands.
The Cross-Band Box control draws rectangles through several report bands. You can use this control to encompass a
report section that includes multiple band areas.

To add a cross-band control to a report, select the corresponding item in the Toolbox and draw a rectangle across required bands.

The following properties define a cross-band control's location in a report:

Start Band - determines the band from which the control starts to draw;
Start Point - specifies the exact coordinates (measured in report units) within the start band where the control starts to
draw;
End Band - determines the band where the cross-band control stops to draw;
End Point - specifies the exact coordinates (measured in report units) within the end band where the control finishes to
draw.

The following image illustrates how the Report Explorer reflects cross-band controls:





Shape Report DataShape Report Data
The topics in this section describe the data shaping features reports support:

Filter Data
Group and Sort Data
Shape Data (Expression Bindings)
Shaping Data (Data Bindings)
Use Calculated Fields
Use Report Parameters



Filter DataFilter Data
The topics in this section describe different approaches to filtering data in your reports:

Filter Data at the Report Level

Use the report's settings demonstrated in this tutorial if you want to load the entire dataset and filter it on the client.

Filter Data at the Data Source Level

Filter records at data source level using your data connection query if you are binding to a large data source and want to
speed up the retrieval process.

Limit the Number of Records to Display

Options described in this topic allow you to emulate the Top N feature in a sorted report or increase the Print Preview
performance by rendering only a subset of a report’s data.



Filter Data at the Report LevelFilter Data at the Report Level
This tutorial illustrates how to filter data at the report level, as opposed to the data source level. This approach is useful when
dealing with relatively small data sources, when data load times are acceptable.

1. Create a new report or open an existing one.

2. Bind you report to a required data source. See the Bind to Data section to learn more about providing data to reports.

3. Switch to the Field List and drop the required fields onto the report's Detail band.

4. Click the report's smart tag and click the Filter String property's ellipsis button.

In the invoked FilterString Editor, construct an expression in which the data fields are compared with the required values.

Every filter condition consists of three parts:

A field of a data source to which a report is bound or the name of the calculated field, which exists in this data source
at the same level.
Criteria operator, such as Equals, Is less than, Is between, etc.

A static operand value, another data field or a report parameter. To access parameters, click the icon on the right until



it turns into a question mark.

You can arrange specific conditions into groups with And, Or, Not And, and Not Or operators.

Your report is now ready to be generated. Switch to Print Preview to see the result.



Filter Data at the Data Source LevelFilter Data at the Data Source Level
This tutorial illustrates how to filter data at the report data source level, as opposed to the report level. This approach is
recommended when dealing with comparatively large data sources when the retrieval process is slow.

1. Create a new report or open an existing one.

2. Bind you report to a required data source. See the Bind to Data section to learn more about providing data to reports.

3. Switch to the Field List and drop the required fields onto the report's Detail band.

4. Select the data source in the Report Explorer, expand its Queries collection property in the Property Grid and click the
ellipsis for the Filter String property of the required query.

5. In the invoked Filter Editor, construct an expression where the data fields are compared with the required values as shown
below.

Every filter condition consists of three parts:



A data field name.
Criteria operator, such as Equals, Is less than, Is between, etc.

A static operand value, another data field or a query parameter. See the Use Query Parameters topic to learn about
embedding these parameters into filter conditions.

You can arrange specific conditions into groups with And, Or, Not And, and Not Or operators.

Alternatively, you can specify a filter expression when creating a query using the Query Builder. To invoke the Filter
Editor at this stage, click the Filter... button.

Switch to Print Preview to see the result.



Limit the Number of Records to DisplayLimit the Number of Records to Display
You can filter records displayed in Print Preview using Report Print Options. You can specify them in the Property Grid's
Miscellaneous tab.

Limit the Number of Records
The Detail Count at Design Time property enables you to limit the number of records a report shows in Print Preview
embedded into the Report Designer. This option is also available in the report's smart tag.

Use the Detail Count option to define how many times to print the Detail band when generating a report document to display in
Print Preview.

Print on Empty Data Source
Disable the Print when Data Source is Empty option to avoid generating a report when its data source is empty. You can use
this setting in master-detail reports to hide the detail report if its data source contains no records.

The Detail Count when Data Source is Empty property allows you to specify how many times to print the Detail band when a
report does not have a data source. You can use this property to create static reports that are not connected to a data source and
display the same static content several times.



Group and Sort DataGroup and Sort Data
The following documents describe how to group and sort a report's data:

Sort Data
Group Data
Sort Data by a Custom Field
Group Data by a Custom Field
Sort Groups by a Summary Function's Result



Sort DataSort Data
Sort a Report's Data
Do the following to sort data in your report:

1. Create a new or open an existing data-bound report.

You cannot apply sorting unless your report is bound to a data source.

2. Switch to the Group and Sort panel, click Add a Sort and select the required data field in the invoked drop-down menu.
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See the Sort Data by a Custom Field tutorial to learn how to sort a report's data by a custom field.

This adds a corresponding sort field to the Sort Fields collection. You can access this collection by clicking the Detail band's
smart tag.

3. Back in the Group and Sort panel, you can specify the sort order (ascending or descending).



4. When a report has multiple sort fields, you can change their order by clicking Move Up or Move Down.

5. Drag the corresponding field from the Field List onto the report area and switch to Print Preview to see the result.

Interactive Sorting in Print Preview
You can allow sorting report data directly in Print Preview by clicking a designated element.



See Sort a Report in Print Preview for more information.



Group DataGroup Data
Group a Report's Data
Do the following to group data in your report:

1. Create a new or open an existing data-bound report.

You cannot apply grouping unless your report is bound to a data source.

2. Switch to the Group and Sort panel, click Add a Group and select the required data field in the invoked drop-down menu.
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See the Group Data by a Custom Field tutorial to learn how to group a report's data by a custom field.

This creates an empty Group Header with a corresponding group field added to its Group Fields collection. You can access
this collection by clicking the Group Header's smart tag.

You can use the Group Field Collection Editor to group data by multiple criteria. Click Add to create a new group field
and specify its Field Name property.

Use the up and down arrow buttons to specify the order in which these criteria are applied to the report's data.



3. Back in the Group and Sort panel, you can specify the group fields' sorting order (ascending or descending).

Select None if your groups are already ordered in the data source, and you do not need to sort them in the report.

4. Click Show Footer to create an empty footer for this group.

5. When a report has multiple groups, you can change their order by clicking Move Up or Move Down.

The following images illustrate how a report looks when it is grouped by multiple criteria:
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6. Drag the corresponding field from the Field List and drop it onto the group footer to display the group field's value in the
report.

The resulting report looks as follows:



Specify the Group's Settings
You can use the group band's smart tag to customize the group's layout settings:

Use the Group Union property to keep a group's content on the same page when possible.

Use the Keep Together property to print the Group Header/Footer on the same page as the group's contents.



Use the Repeat Every Page property to print the group band on each page.

Use the Page Break property to start a new page before or after each group.

When you need to display page numbers for individual groups, add the Page Info control to the Group Header or Footer and set
its Running Band property to the Group Header's name.



Accurate page numbering requires that different groups do not appear on the same page. For this reason, you need to set the
Group Header's Page Break property to After Band, or place the Page Break control at the band's bottom.



Sort Data by a Custom FieldSort Data by a Custom Field
This tutorial illustrates how to sort a report against a custom criteria, in particular, sort data by the number of characters in the
data field value.

1. Create a new or open an existing data-bound report.

You cannot apply grouping unless your report is bound to a data source.

2. Create a calculated field. Switch to the Field List, right-click any item inside the data source and select Add Calculated
Field.

3. Select the calculated field, and in the Property Grid, click the Expression property's ellipsis button.

4. In the invoked Expression Editor, select the required date-time function and define the data field's name in [square
brackets]. For example, use the Len([ProductName]) function to return the number of characters extracted from the
ProductName data field.

Click OK to close the editor and save the changes.



5. In the Group and Sort panel, click Add a Sort and select the calculated field from the invoked drop-down menu.

The Sort Order drop-down list allows you to define the sort order within the group (ascending or descending).

6. Drag the corresponding field from the Field List onto the report area and switch to Print Preview to see the result.



Group Data by a Custom FieldGroup Data by a Custom Field
This tutorial illustrates how to group a report against a custom criteria, in particular, group data by days of the week.

1. Create a new or open an existing data-bound report.

You cannot apply grouping unless your report is bound to a data source.

2. Create a calculated field. Switch to the Field List, right-click any item inside the data source and select Add Calculated
Field.

3. Select the calculated field, and in the Property Grid, click the Expression property's ellipsis button.

4. In the invoked Expression Editor, select the required date-time function and define the data field's name in [square
brackets]. For example, use the GetDayOfWeek([OrderDate]) function to return a zero-based index of the day of the
week, extracted from the OrderDate data field.

Click OK to close the editor and save the changes.



5. Use the Group and Sort panel to quickly create a Group Header band associated with the calculated field.

To create a group criteria, click Add a Group and select the calculated field from the invoked drop-down menu.

You can also use this panel to specify whether or not the corresponding Group Footer band should be visible. The Sort
Order drop-down list allows you to define the sort order within the group (ascending or descending) or disable sorting in
grouped data.

6. Switch to the Field List and drop the required data fields onto the report's area.

7. Click the smart tag of the label in the Group Header and set the Format String property to {0:dddd}. This makes the label
only display the day of the week, and not the date.

Switch to Print Preview to see the result.





Sort Groups by a Summary Function's ResultSort Groups by a Summary Function's Result
This tutorial explains how to sort groups by a summary function result, in particular, by the number of records groups contain.

1. Create a new or open an existing data-bound report.

You cannot apply grouping unless your report is bound to a data source.

2. Group the report by the required data field, calculate the record count in each group and construct the required report
layout.

3. Click the Group Header band's smart tag, and click the Sorting Summary property's ellipsis button.

In the invoked Group Sorting Summary Editor, turn on the Enabled option, set the Field option to the data field from the
Detail band, and set the Summary function to Count.

In this editor, you can also define the sorting direction for the group, as well as specify whether or not the Null values
should be ignored.

Click OK to apply the changes and close the dialog.

Switch to Print Preview to see the result.





Shape Data (Expression Bindings)Shape Data (Expression Bindings)
The tutorials in this section illustrate how to solve various tasks related to shaping report data when expression bindings are
enabled in the Report Designer (the Property Grid provides the PropertyName Expression item in the property marker's
context menu).

Format Data
Conditionally Change a Control's Appearance
Conditionally Change a Label's Text
Conditionally Change a Band's Visibility
Conditionally Filter Report Data
Conditionally Suppress Controls
Limit the Number of Records per Page
Calculate a Summary
Calculate a Weighted Average
Calculate an Advanced Summary
Display Row Numbers in a Report, Group or Page
Count the Number of Records in a Report or Group
Count the Number of Groups in a Report

�� N o t eN o t e

Use this section if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Shape Data (Data Bindings) section to learn about an alternative approach.



Format DataFormat Data
This document demonstrates how to specify value formatting for report elements (for instance, format numeric values as a
currency or apply a percent format).

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Format Data topic in the Shape Data (Data Bindings) section to learn about an alternative approach.

After you bound your report to data and specified a bound data field in a report control's Expression property, you can format
data values in a report.

1. Invoke the control's smart tag and click the Format String property's ellipsis button.

2. This invokes the Format String Editor where you can specify the required format.



Alternatively, you can use the FormatString function within the expression you specified for the report control.

When switching to Print Preview, you can view the report control displaying values with the specified format.



You can use the control's Xlsx Format String property to assign a native Excel format that is used for exporting reports to XLSX.



Conditionally Change a Control's AppearanceConditionally Change a Control's Appearance
This document describes how to change a report control's appearance based on a specific condition.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Conditionally Change a Control's Appearance topic in the Shape Data (Data Bindings) section to learn about an alternative
approach.

1. Switch to the Report Explorer and right-click the Styles category to create a new visual style.

2. Right-click the created style and select Edit Styles.

3. In the invoked Styles Editor, customize the created style's appearance settings.



4. Create another style by cloning the existing one.

5. Customize the new style's appearance settings and close the editor.



6. Back in the Report Explorer, select a report element to which you wish to assign the created styles.

7. Open the Property Grid's Appearance tab, click the Style property's marker and select Style Expression in the context
menu.

8. In the invoked Expression Editor, specify the required condition for switching between the created styles.



Switch to Print Preview to view the resulting report.



Conditionally Change a Label's TextConditionally Change a Label's Text
This document describes how to display different values in a report control based on a specified logical condition.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Conditionally Change a Label's Text topic in the Shape Data (Data Bindings) section to learn about an alternative
approach.

After you bound your report to data and specified a bound data field in a report control's Expression property, you can make this
control display different values based on a specified logical condition:

1. Invoke the control's smart tag and click its Expression property's ellipsis button.

2. In the invoked Expression Editor, specify the required expression.



Use the Iif function to define the condition. For example:

Iif([UnitsOnOrder] == 0, 'None', [UnitsOnOrder])

This expression means that if the data field's value is zero, the control's text is set to 'None'; otherwise, it displays the actual
field value.

When switching to Print Preview, you can see the report control displaying the assigned values.



Conditionally Change a Band's VisibilityConditionally Change a Band's Visibility
This topic describes how to change the report band's visibility.

Set a band's Visible property to an expression to conditionally change the band's visibility based on a field's value or a
parameter.

The report created in this tutorial contains two Detail sub-bands with different report controls. These sub-bands are used to
display discontinued and current products.

The steps below demonstrate how to change a band's visibility based on a field's value.

1. Select a band and switch to the Properties panel. Choose Expressions  and click the Visible property's ellipsis button.

2. In the invoked Expression Editor, specify the expression.



Here, the [Discontinued] == false expression is set for the SubBand1 and the [Discontinued] == true expression for
the SubBand2. These expressions specify the Visible property based on the Discontinued data field's value.

The Preview below displays how changes to band visibility influence the Product List. The SubBand1 is used to display products
that have the Discontinued field set to false, and the SubBand2 is used to display discontinued products.



Conditionally Filter Report DataConditionally Filter Report Data
This document describes how to filter a report's data based on a specific condition.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Conditionally Filter Report Data topic in the Shape Data (Data Bindings) section to learn about an alternative approach.

1. Switch to the Field List, right-click the Parameters section and add a new report parameter.

2. Specify the parameter's description in Print Preview and set its type to Number (Integer).



3. Select the report's detail band and switch it to the Property Grid. Navigate to its Behavior tab, click the Visible property's
marker and select Visible Expression in the context menu.

4. In the invoked Expression Editor, specify the required visibility condition. For example:



The expression above enables/disables the Visible property depending on whether the field value is below the specified
parameter value.

Switch to Print Preview to see the result.



Conditionally Suppress ControlsConditionally Suppress Controls
This document describes how to display or hide a report control in a published document based on a specified logical condition.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Conditionally Suppress Controls topic in the Shape Data (Data Bindings) section to learn about an alternative approach.

1. Create a new report or open an existing one and prepare the report layout.

2. Select the required control and switch to the Property Grid. Open the Behavior tab, click the Visible property's marker and
select Visible Expression in the context menu.

3. In the invoked Expression Editor, specify the required expression.



Use the Iif function to define the required condition. For example:

Iif([Discontinued] == False, False, [Discontinued])

This expression means that if the data field's value is False, the control's Visible property is disabled.

When switching to Print Preview, you can view the report control's visibility changes according to the assigned condition.

�� N o t eN o t e

See Hide Table Cells to learn how to conditionally suppress table cells and define the mode for processing them.



Limit the Number of Records per PageLimit the Number of Records per Page
This document describes how to specify the number of data source records displayed on report pages.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Limit the Number of Records per Page topic in the Shape Data (Data Bindings) section to learn about an alternative
approach.

After you bound your report to data and provided content to the report's Detail band, you can limit the number of records each
report page displays. This example demonstrates how to pass the required record count as a parameter value.

1. Switch to the Field List, right-click the Parameters section and add a new report parameter.

2. Specify the parameter's description displayed in Print Preview and set its type to Number (Integer).



3. Drop a Page Break control onto the report's detail band and switch to the Property Grid. Open the Behavior tab, click the
Visible property's marker and select Visible Expression in the context menu.

4. In the invoked Expression Editor, specify the required expression.



For example:

([DataSource.CurrentRowIndex] % ?parameter1 == 0) And ([DataSource.CurrentRowIndex] !=0)

When switching to Print Preview, you can specify how many rows each report page should display by entering the corresponding
parameter value:



Calculate a SummaryCalculate a Summary
This document shows how to use a report control's Expression property to calculate a group summary, as shown in the image
below:

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Calculate a Summary topic in the Shape Data (Data Bindings) section to learn about an alternative approach.

Follow the steps below to calculate a summary:

1. Create a report bound to a data source.

2. Use the Group and Sort Panel to group report data by the key data field and construct a layout like the following:



3. Right-click the report's Detail band and select Insert Band / Group Footer from the context menu.

4. Drop a Label control onto the Group Footer band.

5. Click the label's smart tag, then click the Summary field's ellipsis button to open the Summary Editor form.



6. In the Summary Editor form, use the following options:

Summary running - specifies summary calculation range (the entire report, current report group, or current
document page).
Summary function - specifies a summary function.

Argument expression - specifies a data field or a complex expression.

 T i pT i p

See the Expression Operators, Functions and Constants topic for a complete list of supported summary functions.

7. You can use the Format String property to format the summary value:



Switch to Print Preview mode to see the result:



Calculate a Weighted AverageCalculate a Weighted Average
�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Calculate a Weighted Average topic in the Shape Data (Expression Bindings) section to learn about an alternative
approach.

Use one of the following approaches to calculate weighted average data:

Aggregate Functions
You can create a calculated field and use a standard aggregate function in its expression to evaluate a weighted average at the
report level.

1. Open an existing report or create a new one from scratch.



2. Bind a report to a required data source.

3. Right-click any item in the Field List's data source node, and in the invoked context menu, select Add Calculated Field.

4. Select the created calculated field and switch to the Properties window. Specify the Name property, set the Field Type to
Decimal and click the Expression property's ellipsis button.

5. In the invoked Expression Editor, specify an aggregate expression:

To construct a valid aggregate expression, use the following format:



[<Collection>][<Condition>].<Aggregate>(<Expression>)

<Collection> - Specifies a collection to calculate an aggregated value against. It can be the relationship name for a
master-detail relationship, or a collection property's name exposed by the target class. For example,
[CategoriesProducts][[CategoryId]>5].Count(). Empty brackets [] indicate the root collection.
<Condition> - Specifies a condition that defines which records to use for the aggregate function calculation. To
calculate an aggregated value against all records, delete this logical clause and its square brackets (for example,
[].Count()).
<Aggregate> - Specifies one of the available aggregate functions listed in the Aggregate enumeration.

<Expression> - Specifies the expression to use. For example, [][[CategoryID] > 5].Sum([UnitPrice]*[Quantity]). The
Count function does not require field values to count the records (the round brackets can be empty for this function).

Use the Parent Relationship Traversal Operator ('^') to refer to the processed group (for instance, [][[^.CategoryID]
== [CategoryID]].Sum([UnitPrice])). This allows you to calculate aggregates within groups.

For more information, see Expression Constants, Operators, and Functions.

6. Add the created calculated field to the report as an ordinary data field and format its value.

Data Source Level
Use a sqlDataSource component to calculate summaries at data source level. You can use these summaries as regular data fields
in your report. Then, create a calculated field where your expression uses these fields.

1. When you use the Report Wizard or bind a report to an SQL data source, go to the query customization page and click the 
 button for the Queries category. Then use the Query Builder to create a new query.

To customize a data source, right-click the data source in the Report Explorer or Field List and select Manage Queries in the
context menu.



In the invoked Manage Queries dialog, click the query's ellipsis button.

In the invoked editor page, click the Run Query Builder button.

2. In the Query Builder, add tables to the query. Enable the fields' checkboxes to include them in the query.



3. In the column list under the data source editor, group data by the group fields and apply the Sum aggregate function to the
UnitsInStock field.

4. Click a new column's expression ellipsis button. In the invoked Expression Editor, specify an expression that multiplies the
averaged field and the weight field as in the image below:

5. Apply the Sum aggregate function to the previously created column as well.

The image below shows the created query.



6. Click OK to complete the Query Builder, then click Finish to exit the wizard.

7. Go to the Field List, right-click any item inside the data source node. In the invoked context menu, select Add Calculated
Field.

8. Right-click the created calculated field and select Edit Expression.

9. In the invoked Expression Editor, construct the expression and click OK:



10. Add the created calculated field to the report as an ordinary data field and format its value.



Calculate an Advanced SummaryCalculate an Advanced Summary
This document describes how to calculate an advanced summary for report groups using a built-in summary function and
arithmetical or logical functions.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Calculate a Custom Summary topic in the Shape Data (Data Bindings) section to learn about an alternative approach.

1. Create a new report or open an existing one and bind it to a data source.

2. Switch to the Group and Sort panel and group the report's data by the required field. Display the footer for the created
group.

3. Drop a Label onto the group footer to display the summary result.

Click the label's smart tag and set its Summary property to Group.



4. Click the Expression property's ellipsis button.

5. This invokes the Summary Expression Editor where you can specify a custom expression with the required summary
functions and other logical or arithmetical functions. For example:
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See the Expression Constants, Operators, and Functions topic for a complete list of supported summary functions.

6. You can use the Format String property to format the summary's value.

Switch to Print Preview to see the result.





Display Row Numbers in a Report, Group or PageDisplay Row Numbers in a Report, Group or Page
This document describes how to show the current row number for each data source value displayed in a report.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Display Row Numbers in a Report, Group or Page topic in the Shape Data (Data Bindings) section to learn about an
alternative approach.

A label can display row numbers after binding your report to data and specifying a bound data field in the Label's Expression
property.

1. Click the label's smart tag. In the invoked Label Tasks window, click the Summary property's ellipsis button.

2. In the Summary Editor window:

Set the Summary running property. Select Report to increment the row numbers throughout the entire report, or
select Group or Page to reset the row numbers for every group or page.

Set the Summary function property to Record Number.



3. Back in the Label Tasks window, you can use the FormatString property to format the resulting value:

You can switch to Print Preview to see the record numbers displayed for the specified range.



Count the Number of Records in a Report or GroupCount the Number of Records in a Report or Group
This document describes how to display the number or records in a report or group.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Count the Number of Records in a Report or Group topic in the Shape Data (Data Bindings) section to learn about an
alternative approach.

1. Right-click the report's design surface and add a Report Header or Footer to display the record count for the entire report.

�� N o t eN o t e

Use a Group Header/Footer for displaying record counts for groups, and a Page Header/Footer for displaying record counts
for pages.

2. Switch to the Field List and drop the corresponding data table field onto the created band to create a data-bound label.



3. Click the label's smart tag. In the invoked Label Tasks window, click the Summary field's ellipsis button.

4. In the Summary Editor window:

Set the Summary property. Select Report to count the records throughout the entire report, or select Group or Page
to reset the record count for every group or page.
Set the Summary function property to DCount.

Set the Argument Expression property to the data field you need to count.

5. Back in the Label Tasks window, you can use the Format String property to format the resulting value:



You can switch to Print Preview to see the resulting report.



Count the Number of Groups in a ReportCount the Number of Groups in a Report
This document describes how to count the number of groups in a report.

�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Count the Number of Groups in a Report topic in the Shape Data (Data Bindings) section to learn about an alternative
approach.

1. Switch to the Group and Sort panel and create a new group. Enable the Show Header option to display the Group Header
in the report.

2. Switch to the Field List and drop the group field onto the created Group Header.

3. Right-click the report's surface and add a Report Footer to the report.



4. Drop a label onto the Report Footer and click its smart tag. In the invoked Label Tasks window, click the Summary
property's ellipsis button.

5. In the Summary Editor window:

Set the Summary running property to the Report value.
Set the Summary function property to Count (Distinct).
Set the Argument expression property to the field you group the data by.

1. Back in the Label Tasks window, you can use the Format String property to format the summary's value:



You can see the group count in the report footer when switching to Print Preview.



Shape Data (Data Bindings)Shape Data (Data Bindings)
The tutorials in this section illustrate how to solve various tasks related to shaping report data when expression bindings are not
enabled in the Report Designer (the Property Grid does not provide the PropertyName Expression item in the property
marker's context menu).

Format Data
Conditionally Change a Control's Appearance
Conditionally Change a Label's Text
Conditionally Change a Band's Visibility
Conditionally Filter Report Data
Conditionally Suppress Controls
Limit the Number of Records per Page
Calculate a Summary
Calculate a Weighted Average
Calculate a Custom Summary
Display Row Numbers in a Report, Group or Page
Count the Number of Records in a Report or Group
Count the Number of Groups in a Report

�� N o t eN o t e

Use this section if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding property).

See the Shape Data (Expression Bindings) section to learn about an alternative approach.



Format DataFormat Data
This document demonstrates how to specify value formatting for report elements (for instance, format numeric values as a
currency or apply a percent format).

�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Format Data topic in the Shape Data (Expression Bindings) section to learn about an alternative approach.

After you bound your report to data and specified a bound data field in a report control's Data Binding property, you can format
data values in a report.

1. Invoke the control's smart tag and click the Format String property's ellipsis button.

2. This invokes the Format String Editor where you can specify the required format.



When switching to Print Preview, you can view the report control displaying values with the specified format.

You can use the control's Xlsx Format String property to assign a native Excel format that is used for exporting reports to XLSX.



Conditionally Change a Control's AppearanceConditionally Change a Control's Appearance
This document describes how to change a report control's appearance based on a specific condition.

�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Conditionally Change a Control's Appearance topic in the Shape Data (Expression Bindings) section to learn about an
alternative approach.

1. Click the report's smart tag, and in the invoked actions list, click the Formatting Rule Sheet property's ellipsis button.

2. In the invoked Formatting Rule Sheet Editor, click the plus button to create a new formatting rule and click the Condition
property's ellipsis button.



3. In the invoked Condition Editor, specify the required Boolean condition (which means that its result is either true or false).

Click OK to save the changes and close the dialog.

4. Back in the Formatting Rule Sheet Editor, define the formatting to be applied (e.g. specify the desired font color).



Click Close to save the changes and quit the dialog.

5. Select a required band or control to which the formatting rule should be applied and access its Formatting Rules
collection.

6. In the invoked Formatting Rules Editor, move the rule to the list of active rules on the right using the arrow buttons in the
center of the editor.



In this editor, you can also customize the precedence of formatting rules using the up and down arrow buttons on the right
of the dialog box. The rules are applied in the same order that they appear in the list, and the last rule in the list has the
highest priority.

Switch to Print Preview to view the resulting report.



Conditionally Change a Label's TextConditionally Change a Label's Text
This document describes how to display different values in a report control based on a specified logical condition.

�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Conditionally Change a Label's Text topic in the Shape Data (Expression Bindings) section to learn about an alternative
approach.

1. Create a new report or open an existing one and bind it to a data source.

2. Right-click any of the data fields in the Field List and select Add Calculated Field.

3. Switch to the Property Grid and set the Field Type property to String. Then. click the Expression property's ellipsis button.

4. In the invoked Expression Editor, define the required condition for the calculated field.



Use the Iif function to define the condition. For example:

Iif([UnitsOnOrder] == 0, 'None', [UnitsOnOrder])

This expression means that if the data field's value is zero, the control's text is set to 'None'; otherwise, it displays the actual
field value.

5. Drop the required data fields and the created calculated field from the Field List on the report's Detail band.

When switching to Print Preview, you can see the report control displaying the assigned values.



Conditionally Change a Band's VisibilityConditionally Change a Band's Visibility
This document describes how to change a report band's visibility.

The report created in this tutorial contains two Detail sub-bands with different report controls. These sub-bands are used to
display discontinued and current products.

The steps below demonstrate how to change a band's visibility based on a field's value.

1. Create formatting rule(s).

Select a report and click its smart tag. In the invoked actions list, click the FormattingRules property's ellipsis button.

In the Formatting Rules Editor, click the Edit Rule Sheet... button to invoke the Formatting Rule Sheet Editor.
Click  to create a new formatting rule.



In the tutorial's report, two rules are added.

Specify a condition for the rule. Click the ellipsis button for the rule's Condition property and specify the expression
in the invoked Formatting Rules Editor.

Here, the [Discontinued] == true expression is set for the formattingRule1 and the [Discontinued] == false
expression - for the formattingRule2.

Specify the Visible property for the rule.



Here, the Visible property is set to False for both rules.

2. Apply the rule(s) to the required band(s).

Select a band, invoke the Formatting Rules Editor, and move a rule to the Rules applied to a control section.

Here, the formattingRule1 is applied to SubBand1, and the formattingRule2 to SubBand2.

The Print Preview displays how changes to band visibility influence the Product List. The SubBand1 is used to display products
that have the Discontinuous field set to false, and the SubBand2 is used to display the discontinued products.



Conditionally Filter Report DataConditionally Filter Report Data
This document describes how to filter a report's data based on a specific condition.

�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Conditionally Filter Report Data topic in the Shape Data (Expression Bindings) section to learn about an alternative
approach.

1. Switch to the Field List, right-click the Parameters section and add a new report parameter.

2. Specify the parameter's description in Print Preview and set its type to Number (Integer).



3. Click the Detail band's smart tag, and in its actions list, click the Formatting Rules property's ellipsis button. In the invoked
Formatting Rules Editor, click the Edit Rule Sheet button.

4. In the invoked Formatting Rule Sheet Editor, click the plus button to create a new formatting rule. Set the Visible



property to No and click the Condition property's ellipsis button.

5. In the invoked Condition Editor, specify the required visibility condition.

Click OK to save the changes and close the dialog. Then, click Close to quit the Formatting Rule Sheet Editor.

6. In the Formatting Rules Editor, you can see the created rule (called formattingRule1), which should be moved to the list
of active rules on the right using the arrow buttons in the center of the dialog box.



In this editor, you can also customize the precedence of formatting rules using the up and down arrow buttons on the right
of the dialog box. The rules are applied in the same order that they appear in the list, and the last rule in the list has the
highest priority.

Switch to Print Preview to see the result.



Conditionally Suppress ControlsConditionally Suppress Controls
This document describes how to display or hide a report control in a published document based on a specified logical condition.

�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Conditionally Suppress Controls topic in the Shape Data (Expression Bindings) section to learn about an alternative
approach.

1. Create a new report or open an existing one and prepare the report layout.

2. Select the required control and click its smart tag. In the invoked actions list, click the Formatting Rules property's ellipsis
button.

3. In the invoked Formatting Rules Editor, click the Edit Rule Sheet button.



4. In the invoked Formatting Rule Sheet Editor, click the plus button to create a new formatting rule. Set the Visible
property to No and click the Condition property's ellipsis button.

5. In the invoked Condition Editor, specify the required visibility condition.



Click OK to save the changes and close the dialog. Then, click Close to quit the Formatting Rule Sheet Editor.

6. In the Formatting Rules Editor, you can see the created rule (called formattingRule1), which should be moved to the list
of active rules on the right using the arrow buttons in the center of the dialog box.

In this editor, you can also customize the precedence of formatting rules using the up and down arrow buttons on the right
of the dialog box. The rules are applied in the same order that they appear in the list, and the last rule in the list has the
highest priority.

When switching to Print Preview, you can view the report control's visibility changes according to the assigned condition.





Limit the Number of Records per PageLimit the Number of Records per Page
This document describes how to specify the number of data source records displayed on report pages.

�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Limit the Number of Records per Page topic in the Shape Data (Expression Bindings) section to learn about an alternative
approach.

After you bound your report to data and provided content to the report's Detail band, you can limit the number of records each
report page displays. This example demonstrates how to pass the required record count as a parameter value.

1. Switch to the Field List, right-click the Parameters section and add a new report parameter.

2. Specify the parameter's description displayed in Print Preview and set its type to Number (Integer).



3. Drop a Page Break control onto the report's Detail band. Disable the control's Visible property and click the Formatting
Rules property's ellipsis button.

4. In the invoked Formatting Rules Editor, click the Edit Rule Sheet button.



5. In the invoked Formatting Rule Sheet Editor, click the plus button to create a new formatting rule. Set the Visible
property to Yes and click the Condition property's ellipsis button.

6. In the invoked Condition Editor, specify the required expression.

For example:

([DataSource.CurrentRowIndex] % ?parameter1 == 0) And ([DataSource.CurrentRowIndex] !=0)

Click OK, to save the changes and close the dialog. Then, click Close to quit the Formatting Rule Sheet Editor.

7. In the Formatting Rules Editor, you can see the created rule (called formattingRule1), which should be moved to the list
of active rules on the right using the arrow buttons in the center of the dialog box.



When switching to Print Preview, you can specify how many rows each report page should display by entering the corresponding
parameter value:



Calculate a SummaryCalculate a Summary
This tutorial describes the steps required to calculate one of the built-in summary functions in your report.
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Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Calculate a Summary topic in the Shape Data (Expression Bindings) section to learn about an alternative approach.

1. Create a new report or open an existing one and bind it to a data source.

2. Switch to the Group and Sort panel and group the report's data by the required field. Display the footer for the created
group.

3. Prepare the report layout and drop a required data field onto the group footer to display the summary result.

4. Click the label's smart tag and invoke its Summary Running drop-down list. Select the range for which to calculate a
summary (the entire report, a specific report group or document page).



5. Set the Summary Func property to Sum and use the Format String property to format the summary's value.

Switch to Print Preview to see the result.





Calculate a Weighted AverageCalculate a Weighted Average
�� N o t eN o t e

Use this approach if expressions are enabled in the Report Designer (the Label's smart tag includes the Expression property).

See the Calculate a Weighted Average topic in the Shape Data (Data Bindings) section to learn about an alternative approach.

Follow the steps below to calculate a weighted average:

1. Open an existing report or create a new one from scratch.
2. Bind a report to a required data source.

3. Group the report's data using the Group and Sort Panel and construct a layout like the following:



4. Add the Group Footer band to the report and drop a Label control on this band to display the summary result. Click the
label's smart tag, then click the Summary field's ellipsis button.

5. In the invoked Summary Editor window:

Set the Summary Running property to Group.
Set the Summary Function property to Weighed average.

Set the Argument Expression property to the field to count the weighted average on, and the Weight property to
the field that provides weights.

6. You can also use the control's Format String property to format the summary value. For instance, set this property to
Weighted Average Price: {0:c2}.



Calculate a Custom SummaryCalculate a Custom Summary
This tutorial describes the steps required to calculate a custom summary that is not one of the built-in summary functions.
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Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Calculate an Advanced Summary topic in the Shape Data (Expression Bindings) section to learn about an alternative
approach.

1. Create a new report or open an existing one and bind it to a data source.

2. Switch to the Group and Sort panel and group the report's data by the required field. Display the footer for the created
group.

3. Drop a required data field onto the group footer to display the summary result. Click the label's smart tag and set its
Summary Running property to Group. Set the Summary Func property to Custom and use the Format String property
to format the summary's value.



4. When selecting the Custom option, three more events are added to the label's Scripts list: Summary Get Result,
Summary Reset and Summary Row Changed.

You can handle these events in the following way using the Script Editor.

C#

// Declare a summary and a pack.
double totalUnits = 0;
double pack = 15;

private void OnSummaryReset(object sender, System.EventArgs e) {
    // Reset the result each time a group is printed.
    totalUnits = 0;
}

private void OnSummaryRowChanged(object sender, System.EventArgs e) {
    // Calculate a summary.
    totalUnits += Convert.ToDouble(GetCurrentColumnValue("UnitsOnOrder"));
}

private void OnSummaryGetResult(object sender, 
DevExpress.XtraReports.UI.SummaryGetResultEventArgs e) {
    // Round the result, so that a pack will be taken into account 
    // even if it contains only one unit.
    e.Result = Math.Ceiling(totalUnits / pack);
    e.Handled = true;
}

VB.NET



Switch to Print Preview to see the result.



Display Row Numbers in a Report, Group or PageDisplay Row Numbers in a Report, Group or Page
This document describes how to show the current row number for each data source value displayed in a report.
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Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Display Row Numbers in a Report, Group or Page topic in the Shape Data (Expression Bindings) section to learn about an
alternative approach.

A label can display row numbers after binding your report to data and specifying a bound data field.

1. Click the label's smart tag and invoke its Summary Running drop-down list. Select Report to increment the row numbers
throughout the entire report, or select Group or Page to reset the row numbers for every group or page.

2. Set the Summary Func property to Record Number and use the Format String property to format the summary's value.



You can switch to Print Preview to see the record numbers displayed for the specified range.



Count the Number of Records in a Report or GroupCount the Number of Records in a Report or Group
This document describes how to display the number or records in a report or group.

�� N o t eN o t e

Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Count the Number of Records in a Report or Group topic in the Shape Data (Expression Bindings) section to learn about
an alternative approach.

1. Right-click the report's design surface and add a Report Header or Footer to display the record count for the entire report.
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Use a Group Header/Footer for displaying record counts for groups, and a Page Header/Footer for displaying record counts
for pages.

2. Switch to the Field List and drop the corresponding data table field onto the created band to create a data-bound label.



3. Click the label's smart tag and invoke its Summary Running drop-down list. Select Report to count the records
throughout the entire report, or select Group or Page to reset the record count for every group or page.

4. Set the Summary Func property to Count and use the Format String property to format the summary's value.

You can switch to Print Preview to see the resulting report.





Count the Number of Groups in a ReportCount the Number of Groups in a Report
This document describes how to count the number of groups in a report.
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Use this approach if data bindings are enabled in the Report Designer (the Label's smart tag includes the Data Binding
property).

See the Count the Number of Groups in a Report topic in the Shape Data (Expression Bindings) section to learn about an
alternative approach.

1. Switch to the Group and Sort panel and create a new group. Enable the Show Header option to display the Group Header
in the report.

2. Switch to the Field List and drop the group field onto the created Group Header.

3. Right-click the report's surface and add a Report Footer to the report.



4. Drop the group field onto the Report Footer and invoke its smart tag. Set its Summary Running property to Report.

5. Set the Summary Func property to Count (Distinct) and use the Format String property to format the summary's value.

You can see the group count in the report footer when switching to Print Preview.





Use Calculated FieldsUse Calculated Fields
The topics in this section describe how to add custom fields to a report's data source and use them to perform various
calculations in the report:

Calculated Fields Overview
Calculate an Aggregate Function



Calculated Fields OverviewCalculated Fields Overview
Calculated fields are primarily used in data-aware reports when using both standard data binding and mail merge. Calculated
fields allow you to pre-process a report's input data, based on a certain expression. So, using calculated fields allows you to apply
complex expressions to one or more data fields that are obtained from your report's underlying data source. Moreover, you can
both group and sort your report data based on a calculated field's value.

Calculated Fields Overview
To create a calculated field, switch to the Field List, right-click any item inside the data source and select Add Calculated Field.

Right-click the calculated field in the Field List and select Edit Expression. Alternatively, you can select the calculated field, and in
the Property Grid, click the Expression property's ellipsis button.

In the invoked Expression Editor, construct the required expression. You can use data fields, report parameters, predefined
constants as well as various date-time, logical, math and string functions. See the next document section for more information
about expression syntax.
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The Expression Editor displays only those data fields that are obtained from a data source specified by the calculated field's Data
Source and Data Member property values.

The report's Calculated Fields property provides access to the calculated field collection.

You can click the Add Calculated Field button in the Toolbar's Home tab to invoke the Calculated Field Collection Editor.

You can drag the calculated field from the Field List onto the required band like an ordinary data field.

You can also group and sort your report data based on the calculated field values.

Expression Syntax
A data field is inserted into the expression's text using its name in [square brackets], and parameters are inserted using a question
mark before their names.

A calculated field's expression can evaluate the values of other calculated fields if you make sure to avoid circular references.

�� N o t eN o t e



When creating calculated fields, avoid dots in their names, because reports use them to address data source members.

Date-time constants must be wrapped in hashtags (#) (e.g., [OrderDate] >= #1/1/2009#). To represent a null reference (one that
does not refer to any object), use a question mark (e.g., [Region] != ?). To denote strings, use apostrophes ('), otherwise an error
will occur.

To embed an apostrophe into an expression's text, it should be preceded by another apostrophe (e.g., 'It''s sample text').

The type of a value returned by a calculated field is defined by its Field Type property.

If a calculated field expression involves the use of different types, it is necessary to convert them to the same type (e.g.,
Max(ToDecimal([Quantity]),[UnitPrice]))

Although a value that is returned by a calculated field is usually converted to a string (to be displayed in a text-aware report
control), it can return a value of any kind. For example, if a database field contains an image, you can set a calculated field's
expression to "=...", after which this calculated field can be bound to the Picture Box control.

To construct a valid aggregate expression, use the following format, which consists of four parts.

[<Collection>][<Condition>].<Aggregate>(<Expression>)

<Collection> - Specifies a collection against which an aggregated value should be calculated. It can be the relationship
name in a case of a master-detail relationship, or the name of a collection property exposed by the target class. For example,
[CategoriesProducts][[CategoryId]>5].Count(). Empty brackets [] indicate the root collection.
<Condition> - Specifies a condition defining which records should participate in calculating an aggregate function. To
obtain an aggregated value against all records, delete this logical clause along with square brackets (for example, [].Count()).
<Aggregate> - Specifies one of the available aggregate functions.
<Expression> - Specifies an expression evaluating values to be used to perform calculation. For example, [][[CategoryID] >
5].Sum([UnitPrice]*[Quantity]). The Count function does not require field values to count the records, so leave the round
brackets empty for this function.

You can refer to the currently processed group using the Parent Relationship Traversal Operator ('^'). This allows you to calculate
aggregates within groups using expressions like the following: [][[^.CategoryID] == [CategoryID]].Sum([UnitPrice]).

For more information, see Expression Syntax.

Examples
The following tutorials demonstrate the use of calculated fields in various environments:

Calculate an Aggregate Function
Calculate a Weighted Average Function
Sort Data by a Custom Field
Group Data by a Custom Field



Calculate an Aggregate FunctionCalculate an Aggregate Function
This tutorial describes the steps required to create a report with an aggregate function. In this example, products that are not
discontinued and have a total unit value greater than $500 will be displayed.

1. Create a new or open an existing data-bound report. This tutorial starts with the following report layout:

2. Create a new calculated field and set the field name to "AggregateField".

3. Select the calculated field, switch to the Property Grid and click the Expression property's ellipsis button.

4. In the invoked Expression Editor, double click the [CategoriesProducts] field and choose Functions | Aggregate. Then,
double click the Count() function and insert the following text into the empty square brackets:

"Not[Discontinued]And[UnitTotal] >= 500".

To construct a valid aggregate expression, use the following format, which consists of four parts.

[<Collection>][<Condition>].<Aggregate>(<Expression>)



<Collection> - Specifies a collection against which an aggregated value should be calculated. It can be the relationship
name in a case of a master-detail relationship, or the name of a collection property exposed by the target class. For
example, [CategoriesProducts][[CategoryId]>5].Count(). Empty brackets [] indicate the root collection.
<Condition> - Specifies a condition defining which records should participate in calculating an aggregate function. To
obtain an aggregated value against all records, delete this logical clause along with square brackets (for example,
[].Count()).
<Aggregate> - Specifies one of the available aggregate functions.

<Expression> - Specifies an expression evaluating values to be used to perform calculation. For example, []
[[CategoryID] > 5].Sum([UnitPrice]*[Quantity]). The Count function does not require field values to count the records,
so leave the round brackets empty for this function.

You can refer to the currently processed group using the Parent Relationship Traversal Operator ('^'). This allows you
to calculate aggregates within groups using expressions like the following: [][[^.CategoryID] ==
[CategoryID]].Sum([UnitPrice]).

For more information, see Expression Syntax.

5. Click OK to close the dialog and save the expression.

6. Add three Labels to the Detail Band and customize their content as shown in the following image:

The report is now ready. Switch to Print Preview to see the result.





Use Report ParametersUse Report Parameters
The topics in this section describe how to use parameters in a report:

Parameters Overview

Describes how to create and use report parameters.

Multi-Value and Cascading Report Parameters

Explains how to configure report parameters to accept multiple values and filter a parameter's values based on another
parameter's value.

Date Range Parameters

Describes how to create date range parameters to filter report data by a specific time period.

Request and Pass Report Parameter Values

Illustrates how to assign default and custom values to a report's parameters and describes the editors that are used to
request these values in a Print Preview.

Query Parameters

Explains how to link report parameters to query parameters defined in your report's data source.



Parameters OverviewParameters Overview
You can use report parameters to pass data to a report before it is generated. Parameter values are specified in Print Preview's
Parameters panel.

Add Parameters
Switch to the Field List, right-click the Parameters node and click Add Parameter in the context menu to create a report
parameter.

Alternatively, you can click the Add Parameter button in the Toolbar's Home tab.

This invokes the Add New Parameter dialog where you can configure the created parameter.

The dialog provides the following options:



Name
Specifies the unique name by which you can refer to the parameter.
Description
Specifies the text that appears in Print Preview alongside with the value editor.
Type
Specifies the parameter's value type. A value editor for the specified type is displayed in Print Preview.

Default value
Specifies the parameter's Value. When you change a parameter's value in Print Preview, you can press Reset to return to
the default value.

Expression
Specifies an expression that defines the parameter's value based on specific conditions. Click the Expression property's
ellipsis button and construct an expression in the invoked Expression Editor.

Show in the parameters panel (corresponds to the parameter's Visible property)
Enable this option to request the parameter value in Print Preview. Otherwise, the report takes the default parameter value.

Allow multiple values (corresponds to the parameter's Multi-Value property)



Enable this option to allow a parameter to accept a collection of values.
Allow null value (corresponds to the parameter's Allow Null property)
Enable this option if the parameter's value can be unspecified.
Range Value
Enable this option if the parameter should specify a range with a start and end value. This option applies to Date-type
parameters. See Date Range Parameters for information on how to configure a date range parameter.

Supports the collection of standard values
Applies if the parameter is visible (its value is requested in Print Preview). You can choose a value from a predefined list
which is populated with static values, or specify a data source from where the values are obtained.

Dynamic values

Specify a data source, data adapter, and data member for the parameter values storage. Value Member defines the
data field that provides the parameter's values. Display Member defines the data field that stores values displayed in
Print Preview.

If the data member's value type does not match the parameter type, the validation rejects the value.

Use the Filter String property to filter parameter values and implement cascading parameters.

Specify the Sort Member and Sort Order properties to sort parameter values.

Static values

Switch to this tab to specify a static list of values. Each value should have a description that is displayed in Print
Preview.

Use Parameters
Use report parameters in the following cases:

Filter

Parameters can provide values to a report's Filter String to filter report data.



You can link the report parameter to query parameters used in the SQL string's SELECT statement to filter data at the data
source level.

Bind to Data

You can bind a report control to a parameter and display its value in a report. To create a new label bound to a parameter,
drag the parameter from the Field List and drop it onto a band.

Add a question mark in front of a parameter's name to refer to it in mail merge.

Specify Expressions

Use a question mark (?) in front of a parameter's name to include it in an expression.



Multi-Value and Cascading ParametersMulti-Value and Cascading Parameters
This document describes how to implement multi-value and cascading parameters. Cascading parameters display values that
correspond to other parameters' values.

Multi-Value Parameters
To assign a collection of values to a parameter, enable its Multi-Value property. In the Add New Parameter dialog, this option
corresponds to the Allow multiple values checkbox.

Multi-value parameters are useful when you need to filter report data against a list of values. The following image illustrates a
correct filtering expression that incorporates a multi-value parameter. This expression is assigned to the report's Filter String
property.

The following image demonstrates an editor for a multi-value parameter in a Print Preview.



Cascading Parameters
The list of values available for a parameter in a Print Preview can be filtered based on the current value of another parameter.

To filter the list of parameter values, click the ellipsis button for the parameter's Filter String property in the Add New
Parameter dialog window and specify a filter string that refers to another parameter.

Click the report's smart tag, and in the invoked actions list, click the ellipsis button for the Filter String property. In the invoked
FilterString Editor, construct an expression that uses both parameters:



The following image illustrates cascading parameters.



Date Range ParametersDate Range Parameters
This document describes how to create a date range parameter and filter report data by the specified dates.

Perform the steps below to add a date range parameter to a report.

1. Switch to the Field List and right-click Parameters. Select Add Parameter from the context menu.

2. Specify the options below in the invoked Add New Parameter dialog and click OK.

Name - the parameter's name;
Description - the parameter's description displayed in Print Preview's Parameters panel;
Type - the parameter's data type. Set it to Date to create a date range;

Range Value - enable this option to create a date range.



3. The dateRange parameter appears in the Field List and includes the dateRange_Start and dateRange_End parameters.
Select the dateRange parameter and switch to the Property Grid to specify the parameters' default values.

The Value property allows you to specify a static value. To specify a dynamic value, click the Value property's marker, select
Value Expression and specify an expression in the invoked editor.



4. Use the start and end parameter names in the report's filter string to filter data by the specified date range. Select the report,
click the Filter String property's ellipsis button in the Property Grid and construct a filter string in the invoked FilterString
Editor.
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The start and end parameter values store the selected day's midnight time. For instance, if you choose 10/15/2019, the
value is 10/15/2019 12:00:00 AM. If your date fields include non-midnight time, records for the end date 10/15/2019 are
excluded from a report. Use the GetDate() function in the FilterString Editor to include data for the 10/15/2019 date.

When you switch to Print Preview, the Parameters panel displays the date range parameter. After you submit a start and end
date, a report document is displayed with filtered data.



Request and Pass Report Parameter ValuesRequest and Pass Report Parameter Values
This document illustrates how to assign the default and custom values to a report's parameters and describes the editors that are
used to request these values in a Print Preview.

Requesting Parameter Values in a Print Preview
The parameter's Value property specifies the parameter's actual value. This value must correspond to the parameter's value type
the Type property defines.

A parameter's value is not requested from end-users and is automatically passed to the report when the parameter's Visible
property is disabled. When a report has at least one visible parameter, a Print Preview provides the Parameters panel for
submitting parameter values.

When loading a Print Preview, a report document is not created by default unless values for all visible parameters are submitted.
To create report documents without requesting parameter values (and using their default values instead), disable the report's
Request Parameters property.

Standard Parameter Editors
The parameter's Type property determines which values a parameter can accept. The corresponding value editors are created
automatically for the following standard parameter types:

String
Date
Number

16-bit integer
32-bit integer



64-bit integer
floating point
double-precision floating point
decimal

Boolean
GUID (Globally Unique Identifier)

The following image illustrates the standard editors for parameter values:

Look-Up Parameter Editors
You can list a parameter's values in a lookup editor:

Assign a Static List of Values to a Parameter

A parameter can be provided with a predefined set of static values, without creating a separate data source. Each value is
accompanied by a description that appears in the Print Preview's user interface.

Assign a Dynamic List of Values to a Parameter

A parameter can obtain a list of values from a specified data source.



Assign Multiple Values to a Parameter
A parameter can also be allowed to accept multiple values by enabling its Multi-Value property.

When creating cascading parameters, the list of values available for one parameter is filtered based on another parameter's
current value. See Create Multi-Value and Cascading Report Parameters for more information.



Query ParametersQuery Parameters
This document provides information on query parameters and describes how to use parameterized SQL queries to filter data at
data source level.

Query Parameters Overview
A query parameter holds an external value that is inserted into an SQL statement before query execution. This value can be static
or an associated expression can generate it dynamically.

The query parameter value is inserted into the resulting SQL query string in the "@QueryParameterName" placeholder's position.

Query parameters are used in the following scenarios:

When filtering report data at the data source level using the Query Builder.

The Query Builder helps you construct SQL queries when creating a new data-bound report or binding an existing report to
an SQL data source,

... or when adding queries to an existing SQL data source or editing existing queries.

You can filter the constructed queries using query parameters. Press the Edit Parameters... button to invoke the Query
Parameters dialog.



Press the Filter... button to invoke the Filter Editor and filter data using the created query parameters.

The criteria based on the specified query parameters are added as an SQL statement's WHERE part.

When binding a report to a stored procedure provided by an SQL data source.

The Report Wizard, as well as the Data Source Wizard, include the Create a query or select a stored procedure page. If
you select a stored procedure, the wizard creates a query parameter for each procedure parameter and allows you to
configure the query parameters in the next Configure query parameters and preview the result page.



You can access query parameters using the Parameters property of the query the report's SqlDataSource component exposes.
These parameters include the ones you created within the Query Builder or that were generated for the data source's stored
procedure. You can also access the query’s filter string using the Filter String property. This filter string includes the filter that
you specified in the Query Builder.

You can add new query parameters in the Query Parameters dialog and modify the filter within the Filter Editor.

Configure Query Parameters
The following properties are available for each query parameter:

Name - specifies the parameter's name.



Type - specifies the parameter value's data type.
Expression - determines whether the actual parameter value is static or generated dynamically.
Value - determines the query parameter's actual value. If the Expression option is enabled, the actual parameter value is
produced dynamically by calculating an associated expression. This is useful when you map the query parameter value to
the report parameter value. Refer to the next document section for more information.

Provide the Query Parameter Value
Below, you can see how a value is specified for a query parameter within the Data Source Wizard's page. You can also specify
query parameter values in the Report Wizard or the Query Parameters dialog in the same way.

Specifying a static value

Choose a query parameter's value type and set a static value to the Value property according to the selected type.

Providing a dynamic value

Activate the Expression checkbox for a parameter.

The following three options are used to dynamically calculate the parameter's actual value:

Create a complex expression by expanding the Value property's drop-down list and selecting Expression Editor.

Construct an expression in the invoked Expression Editor.



Map a new report parameter to a query parameter by expanding the Value property's drop-down list and selecting
New Report Parameter.

Specify report parameter settings in the invoked Report Parameter dialog. Remember to specify the report
parameter type according to the type of the corresponding query parameter. Click OK to exit the dialog.

Map a report parameter that already exists in a report to a query parameter by expanding the Value property's drop-
down list and selecting the parameter you want to use. An appropriate expression string is generated automatically.



Pass a Multi-Value Parameter Value to a Query
You can map multi-value parameters to query parameters. For instance, the following query selects the orders whose IDs can be
found within the values the @OrderID query parameter provides.

Pass a Multi-Value Report Parameter Value to a Stored Procedure
You cannot pass a multi-value parameter value to a stored procedure directly. Use one of the following expression functions:

Use the Join() expression function to convert the array of parameter values to a string if you use MS SQL Server, MySQL or
Oracle database systems.



Use the CreateTable() expression function to prepare a table using values of several multi-value parameters.





Lay out Dynamic Report ContentLay out Dynamic Report Content
You can use Print Preview to see what the resulting document looks like because data-aware controls' contents are not available
at design time.

This section contain topics describe how to maintain report elements' correct location in a published document:

Maintain the Band Location on a Page
Keep Content Together
Maintain the Size and Content of Data-Bound Controls
Anchor Controls
Suppress Controls



Maintain the Band Location on a PageMaintain the Band Location on a Page
Use the Group and Report Footer's Print At Bottom property to choose whether these bands should appear at the bottom of a
page or immediately after the previous band.

PR INT AT B OT TOM = NO PR INT AT B OT TOM = YES

Use the Page Header and Footer's Print On property to avoid printing these bands on the same page with a Report Header
and/or Footer.

Print On = All Pages



Print On = Not With Report Header

Use the Group Header and Footer's Repeat Every Page property to repeat these bands on every page.

Repeat Every Page = No



Repeat Every Page = Yes



Keep Content TogetherKeep Content Together
You can choose whether a control's content can be split across several pages using its Keep Together property.

" K EEP TOG E THER"  IS  D IS AB LED " K EEP TOG E THER"  IS  ENAB LED

Enabling this property for a single control makes the same band's controls behave like this option is enabled.

Use the band's Keep Together property to enable this feature for all controls within a specific band.
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This feature is not available for the Chart, Sparkline and Subreport controls.

In a master-detail report, you can print the detail band on the same page as the detail report band using the detail band's Keep
Together With Detail Reports property.



Maintain the Size and Content of Data-Bound ControlsMaintain the Size and Content of Data-Bound Controls
Use the control's Can Grow and Can Shrink properties to make a data-bound control automatically adjust its height to its
contents.

CAN G R OW  = NO CAN G R OW  = YES

CAN S HR INK = NO CAN S HR INK = YES
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This feature does not work with anchoring enabled, as well as for labels that are used to display summary function results.

Use the Auto Width property to make a data-bound Label or Character Comb automatically adjust its width to its content. This
option behavior depends on the control's current horizontal alignment (Text Alignment property value).

Text Alignment = Left

Text Alignment = Right

Text Alignment = Center



The control's Word Wrap property allows you to make a control display its contents in multiple lines when it does not fit into the
control's dimensions.

AU TO W ID TH = NO, W OR D  W R AP = NO AU TO W ID TH = NO, W OR D  W R AP = YES

AU TO W ID TH = YES , W OR D  W R AP = NO AU TO W ID TH = YES , W OR D  W R AP = YES

You can also use the opposite Text Fit Mode property to adjust a label or table cell's font size to fit the control's bounds.

TE X T FIT MOD E =
NONE

TE X T FIT MOD E = G R OW
ONLY

TE X T FIT MOD E = S HR INK
ONLY

TE X T FIT MOD E = S HR INK AND
G R OW

This property is not available in the following cases:

The Can Grow, Can Shrink or Auto Width option is enabled;
The label's Angle property is specified;
The control's Anchor Horizontally or Anchor Vertically property is set to Both.



Anchor ControlsAnchor Controls
You can anchor a control to the top, bottom, or both edges of its parent container using the Anchor Horizontally and Anchor
Vertically properties.

Anchor Horizontally = None

Anchor Horizontally = Right

Anchor Horizontally = Both



Suppress ControlsSuppress Controls
Avoid Duplicated and Empty Values
When identical or null values appear in a report's data source, you can suppress these values in a report using the following
properties:

Process Duplicates Mode

Specifies how to process report controls with identical values (leave them as is, merge, suppress, or suppress and shrink).

Process Null Values

Specifies how to process report controls receiving null values from a data source (leave them as is, suppress, or suppress
and shrink).

Process Duplicates Target

Specifies whether to process duplicate the control's Text or Tag property values.

These properties are available for the following controls:

Bar Code
Label
Character Comb
Rich Text
Table Cell
Picture Box

Conditionally Suppress a Control
You can suppress a control when a specified logical condition is met by specifying the required Visible property expressions as
described in the Conditionally Suppress Controls topic.

In this case, a space remains in the band at the control's location. You can avoid this by placing these controls onto an Panel and
enabling its Can Shrink property.



For this feature to work correctly, consider the following:

Specify the Visible property's expression to the controls in the panel (and not to the panel itself).
Do not assign borders to the panel container. Otherwise, they are printed when the panel's content is suppressed.



Customize AppearanceCustomize Appearance
The topics in this section describe how to customize the report elements' appearance:

Appearance Properties
Report Visual Styles
Report Style Sheets



Appearance PropertiesAppearance Properties
This document describes the purpose and implementation of the appearance properties - a special set of properties that allow
you to customize the appearance of a report or any of its elements.

Properties Overview
Every report element (control or band), and a report itself, has a set of properties that specify its appearance. They are listed in the
following table.

PR OPER T Y NAME D ES CR IPTION

Background Color Gets or sets a background color to a report element and its child controls.

Border Color Gets or sets a border color to a report element and its child controls.

Border Dash Style Gets or sets a border dash style to a report element and its child controls.

Borders Gets or sets borders (top, right, bottom,left), which should be visible for a report element and its child controls.

Border Width Gets or sets a border width to a report element and its child controls.

Font Gets or sets the font options (its name, size, etc.) to a report element and its child controls.

Foreground Color Gets or sets the foreground color to a report element and its child controls.

Padding Gets or sets the indent values which are used to render the contents of a report element and its child controls.

Text Alignment Gets or sets the text alignment to a report element and its child controls.

Access Appearance Properties
Use the Report Designer's Toolbar to access the appearance properties.

More appearance properties are available in the Property Grid's Appearance tab.



Property Value Inheritance
By default, appearance properties for every control or a band are set to empty values, which means that their real values are
obtained from a control's parent, or a parent of its parent and so on.

�� N o t eN o t e

The appearance properties may not be used by all descendants of the current report element for which they are defined. For
example, the Page Break element ignores the Back Color property.

To reset values of these properties, click the property marker in the Property Grid, and select Reset in the invoked menu. Then, the
control's actual appearance will be determined by the appropriate properties settings of its parent.



If a report element has a style assigned to it, the priority of the properties defined by this style is determined by the StylePriority
property. Note that when a conditional formatting is involved, the appearance it defines is of greater priority than the properties
described above.



Report Visual StylesReport Visual Styles
This topic describes how to combine appearance properties into styles and apply them to report elements.

Create a Report Style
Use the following approaches to create a visual style in your report:

Extract a Style

Specify a report control's appearance properties and press Extract Style in the report's toolbar.

Create a new Style

Press the caption button in the toolbar's Styles group to invoke the Styles Editor.



Press the Add a style button and specify the new style's appearance properties. Close the Styles Editor.

The created style is added to the Style gallery. You can access this gallery in the following places:

the Styles group in the report's toolbar;

the Styles group in the Report Explorer.

Assign a Style to a Report Element
Select a report element and press a style in the toolbar's Styles group.



This assigns the style to the report element's Style property.

Assign Odd and Even Styles
You can use the Odd Style and Even Style properties to apply different styles to alternating rows in a report.

Customize a Style



Press the caption button in the toolbar's Styles group to invoke the Styles Editor.

Select a style and modify its property values. All the report elements apply the updated style immediately.

Style Inheritance
Nested elements inherit their parent element's style if they do not have an applied style.

Override Styles
You can specify a different value for a report element's appearance property to override the corresponding property value in the
report element's style.

�� N o t eN o t e

If you apply conditional formatting, its appearance property values have a higher priority than both the individually specified
properties and the style's properties.

Reuse Styles
You can add a style to the Report Gallery and use it across different reports.

In the Report Explorer, right-click a style and choose Add to Gallery.



The styles that the Report Gallery includes are available across reports. Drag a style from the Report Gallery to a report element.

This embeds the style to the report and set's the report element's Style property.

�� N o t eN o t e

You can combine styles into style sheets and reuse them in reports.



Report Style SheetsReport Style Sheets
You can combine report styles into a style sheet and reuse them in reports. This topic explains how to create and use style sheets
in reports.

Save Styles as Style Sheets
Press the caption button in the toolbar's Styles group to invoke the Style Editor.

Press the  button to save the styles as a style sheet (external REPSS file).

Add a Style Sheet to a Report
Do the following to embed a style sheet's styles in a report:

invoke the Styles Editor;

press  and choose a style sheet file in the Open dialog.

All the styles are now available in the report's toolbar and Report Explorer.



Reuse Style Sheets in Reports
You can utilize styles from a style sheet in a report. To do this, specify the path to the style sheet file in the report's Style Sheet's
Path property.

The attached style sheet's styles are now available in the report's toolbar and the Report Explorer. You cannot edit these styles.



Add NavigationAdd Navigation
The topics in this section describe how to use navigation features in your reports:

Add Page Numbers
Add Cross-References and Hyperlinks
Add Bookmarks and a Document Map
Add a Table of Contents

�� N o t eN o t e

See Provide Interactivity to learn how to create drill-down reports.



Add Page NumbersAdd Page Numbers
The tutorial describes how to add page numbers to your reports.

Add Page Numbers
Do the following to add page numbers to a report:

Create a PageFooterBand in your report. To do this, right-click anywhere in the report designer, and in the context menu
point to Insert Band, and then click PageFooter.

Drop the Page Info control from the Toolbox to the PageFooter band.

To change the control's display format, click its smart tag, and in the invoked actions list, specify the Text Format String
property (e.g., Page {0} of {1}, to display the current page number out of the total number of pages).

The following image illustrates the resulting report:



Add Page Numbers for Groups
Do the following to make your report display page numbers for groups or detail reports:

Add the GroupFooter band. To do this, right-click anywhere on the report's surface, and in the invoked menu, point to
Insert Band and click GroupFooter.

�� N o t eN o t e

You can force the group header and/or the group footer to be repeated on each page, using the GroupBand's Repeat Every
Page property.

Next, force each new group to start on a separate page. Otherwise, group page numbers will be calculated incorrectly.

To do this, select the Group Footer, and set its Page Break property to After the Band.



Drop the Page Info control from the Toolbox onto the GroupFooter (or GroupHeader) band.

Select the created control, and set its Running Band property to GroupHeader1.

 T i pT i p

You can use the Text Format String and Page Information properties to adjust the way the control represents its
contents.

The following image illustrates the resulting report:





Add Cross-References and HyperlinksAdd Cross-References and Hyperlinks
This document describes how to make an element navigate to other elements in a report or external resources by clicking it in a
Print Preview.

Add Cross-References
You can improve report navigation using a cross-reference because the link's target is in the same document.

You can add a cross-reference for a report control by setting the following properties:

1. Set the Navigation Target property to _self to specify that the link is in the same document.

2. Set the Navigation URL property to the target control's Name property value.

In this case, the control behaves like a link meaning that the cursor automatically changes to a hand in a report's preview when
hovering the control. You can make a control resemble a link by specifying its appearance properties (for example, change the
text's color to blue and underline it).

The link uses the first occurrence if there are multiple instances of an object marked as a link's target.

 T i pT i p

A report's cross-references are preserved when exporting it to PDF.

Add Hyperlinks



A hyperlink means that a link's target is outside the report.

You can use any control as a link by setting the Navigation Url property to the required target document's URL.

�� N o t eN o t e

Remember to use the "http://" or "https://" prefix when specifying the URL.

You can make a control resemble a link by specifying its appearance properties (for instance, set the underlined text and blue
color).

The cursor automatically changes to a hand when hovering the control in a report's preview.

Use the link's Navigation Target property to specify where to open the target document (in the same preview window, in a new
blank window, etc.).

 T i pT i p

A link's behavior is preserved when exporting a report to most of the available formats (in particular to PDF, HTML, MHT, RTF and
Excel).



Add Bookmarks and a Document MapAdd Bookmarks and a Document Map
This document describes how to use bookmarks for mapping the report elements' hierarchy to the Document Map that is
displayed in a Print Preview, and speeds up the navigation through complex reports.

The example below is based on the following report:

This report displays products that are grouped by the CategoryName field.

The following image illustrates the resulting report with a hierarchical Document Map. Clicking any bookmark navigates the Print
Preview to the document section containing the associated element.

Use the following steps to generate a Document Map in your grouped report:

1. Select the label placed in the Group Header band and switch to the Property Grid's Miscellaneous tab. Click the
Bookmark property's marker and select the Bookmark Expression item. In the invoked Expression Editor, select the
CategoryName data field.



In the legacy binding mode (if the Property Grid does not provide the Bookmark Expression item), you can specify this
property in the Property Grid's Data Bindings category.

2. In the same way, select the label in the Detail band and bind its Bookmark property to the ProductName data field.



Most of the reporting controls (for example, Table, TableCell, CheckBox, etc.) supports the Bookmark property.

3. Set the same label's Parent Bookmark property to the label in the group band. This arranges bookmarks into a parent-
child structure reflecting the report elements' hierarchy in the Document Map.

�� N o t eN o t e

Avoid cyclic bookmarks that occur when you assign two bookmarks as parents to each other. In this scenario, an exception
raises when you attempt to create the report document.

4. Select the report itself and assign text to its Bookmark property to determine the root node's caption in the Document
Map.



The root bookmark displays the report name if you do not specify this property.

�� N o t eN o t e

Duplicated bookmarks are suppressed to prevent adding multiple bookmarks with the same name to a final document. You can
disable the report's Bookmark Duplicate Suppress property to allow duplicated bookmarks.



Create a Table of ContentsCreate a Table of Contents
This tutorial describes the steps to create a report with a table of contents. A table of contents is automatically created based on
the bookmarks existing in a report.

Do the following to create a table of contents in a report:

1. From the Control Toolbox, drop the Table of Contents control onto the Report Header band.

2. Double-click the title of the table of contents and specify its text.

3. To customize the title appearance, use the Level Title option's settings available in the Properties window.

4. To customize the appearance of all other levels, use the Level Default option's settings.



5. To customize a specific level individually, add a corresponding item to the Levels collection of the table of contents and
customize its properties.

The following image demonstrates the result in Print Preview:





Provide InteractivityProvide Interactivity
The documents in this section provide information on the interactive features that enable report customization in Print Preview.

Create Drill-Down Reports
Sort a Report in Print Preview
Content Editing in Print Preview



Create Drill-Down ReportsCreate Drill-Down Reports
This tutorial describes how to create a drill-down report. Clicking a link in such a report displays the previously hidden detailed
information in the same report:

Do the following to create a drill-down report:

1. Create a master-detail report using Detail Report bands.
2. Drop a label onto the report's detail band. Clicking this label should expand or collapse the hidden report details.

3. Select the detail report band by clicking its header and expand the drop-down menu for the band's DrillDownControl
property in the Property Grid.

This menu displays all report controls available on the report band that is one level above the current band in the report
bands' hierarchy. Select the corresponding label in the menu to make the label expand or collapse the detail report's band
when clicked in the Print Preview.



You can also specify the band's Drill Down Expanded property to define whether or not the band is initially expanded.
This property is enabled by default.

4. Click this label's smart tag and select the Expression property.

This invokes the Expression Editor where you can make the label display different text based on the detail report's
DrillDownExpanded property value.





Sort a Report in Print PreviewSort a Report in Print Preview
This tutorial illustrates how to enable sorting report data in Print Preview.

In this tutorial, we will start with the following report displaying products grouped by category names.

You can implement interactive sorting for both the detail data and report groups.

Sort Report Groups
To enable sorting report groups in Print Preview, select the label displaying product category names located in the Group Header
band and switch to the Property Grid.

Expand the label's InteractiveSorting property, and set the TargetBand property to GroupHeader1 and FieldName to
CategoryName.

Switch to the Preview tab to sort report groups by the CategoryName field. When a mouse pointer hovers over the category
name, it changes to a hand indicating the sorting capability. The arrow displayed at the element's right edge indicates the sorting
order.



Sort Detail Data
To enable sorting data in the Detail band, select the table cell displaying the Product Name title and switch to the Property Grid.

Set the TargetBand property to Detail and access the SortField property.

In the invoked collection editor, add a new group field and set its FieldName to ProductName.



Set the table cell's FieldName property to the ProductName field.

On switching to the Preview tab, you can now sort data in the Detail band by the ProductName field.

If you provide interactive sorting to multiple fields, clicking another field clears all the previously applied data sorting. Hold the
SHIFT key while clicking to preserve the existing sorting settings and thus sort against multiple fields.

To disable data sorting against a specific field, hold the CTRL key on its caption click.

�� N o t eN o t e

Reports embedded into the current report using the Subreport control do not support interactive data sorting.



Edit Content in Print PreviewEdit Content in Print Preview
This document describes how to customize field values in a previewed document.

Content Editing Overview
Enable a report control's Edit Options | Enabled property and leave the Edit Options | Read Only property disabled to make
the control's content editable in Print Preview.

Print Preview provides the Editing Fields toolbar button if content editing is enabled for at least one control in the displayed
report. Click this button to highlight all editable fields available in the document.

Use the TAB and SHIFT+TAB keys to navigate between editable fields forward and back.

Click an editable field to invoke an editor and specify a value.

You can enable content editing for data-aware and unbound report controls.

The following report controls support content editing in Print Preview:



TE X T B OOLE AN IMAG E

Label Check Box Picture Box

Table Cell

Character Comb

The sections below provide information about options these controls expose. You can use these options to set up content editing.

Content Editing Limitations
Changes made to a control's content in Print Preview does not effect the document's other parts (for example, summary
results, grouping, sorting, bookmarks and other settings that were processed before the document was generated).
A control's Can Grow setting is ignored for editable fields. The edited area cannot exceed the control's original dimensions.
Multi-line values can only be entered when no mask is applied to an editable field.
Values entered into editable fields are reset after the document is refreshed (for example, when you submit report
parameter values or expand/collapse data in a drill-down report).
It is not possible to edit content in bands if their DrillDownControl property is specified.

The entered values are not preserved in the Top Margin and Bottom Margin bands when the report is exported as a single
file to the following formats:

TXT
CSV
HTML
MHT
RTF
XLS
XLSX
image

Text Editors
Text editors are used to customize the Label, Table Cell and Character Comb report controls' content in Print Preview.

The default text editor is a memo edit.

Specify the Edit Options | Editor Name property to use one of the following text editors:



NU MER IC D ATE- T IME LE T TER S

Integer Date Only Letters

Positive Integer Only Uppercase Letters

Fixed-Point Only Lowercase Letters

Positive Fixed-Point Only Latin Letters

Each editor has a specific mask.

�� N o t eN o t e

If a table cell contains other controls, you cannot edit this cell (they can edit the cell's controls). The following image illustrates this:

Check Box Editor
The check box editor is used to customize the Check Box report control's content in Print Preview.

You can combine several check box editors into a radio group so that you can select only one option within a group at a time. For
this, set the Check Box report controls' Group ID property to the same value.



Image Editors
Image editors are used to customize the XRPictureBox report control's content in Print Preview.

Use the control's Edit Options | Editor Name property to assign one of the following image editors.

Image Editor
Allows you to load an image and specify the image's size options.

Signature Editor
Allows you to specify brush options and draw a signature.

Image and Signature Editor (default)
Allows you to load an image and draw a signature. The image's size options and brush options are available.



All these image editors include the  button. This button allows you to clear the editor's content.



Add Extra InformationAdd Extra Information
The topics in this section describe how to identify your reports by displaying information about their context:

Add Watermarks to a Report
Display the Current Date and Time in a Report
Display the User Name in a Report

�� N o t eN o t e

See Add Navigation to learn how to add page numbers and a table of contents to your reports.



Add Watermarks to a ReportAdd Watermarks to a Report
This tutorial describes how to add watermarks to a report and use preprinted forms.

Add a Watermark to a Report
To add a watermark to a report, do the following.

1. Switch to the toolbar's Page page and press Watermark.

2. In the invoked Watermark dialog, select either the Text Watermark or Picture Watermark tab, depending on the type of
watermark you wish to add.

For a text watermark, specify the text, direction and font options.



For a picture watermark, you need to specify an image. To do this, click the ellipsis button for the Load image option.

In the invoked Select Picture dialog, select the file containing the image that you wish to use as a watermark and click
Open. Next, specify the size mode and alignment options for the picture.

Additionally, for both textual and picture watermarks, you can adjust the transparency, position (in front of or behind the
document content), and the page range in which the watermark will be printed.

�� N o t eN o t e

The Transparency property is unavailable when you specify an SVG image.

Supply a Preprinted Form
You can use a picture watermark as a template, to display an image of the preprinted form on the report's body at design time.

To display a watermark at design time, switch to the toolbar's View page and activate Watermark.



The following image illustrates a report with a watermark shown at design-time that contains a template of a preprinted form.

Place report controls on the report's body according to the layout of the preprinted form.



Display the User Name in a ReportDisplay the User Name in a Report
This tutorial demonstrates how to insert the current user name in a report using the Page Info control.

Do the following to insert the user name into a report:

1. Typically, the user name is displayed within the Report Header band. To add it to the report, right click anywhere on the
report's surface. In the invoked menu, point to Insert Band and click ReportHeader.

2. Drop the Page Info control from the Toolbox onto the ReportHeader band.



3. Set the control's Page Information property to User Name (e.g. using the smart tag).

4. Next, to apply a format string to the control's contents, type Current User: {0} into its Text Format String property.



Display the Current Date and Time in a ReportDisplay the Current Date and Time in a Report
This tutorial demonstrates how to insert the current system date and time into a report using the Page Info control.

Do the following to include information about the current date and time into a report:

1. Typically, the current date and time are displayed within the Report Header band. To add it to the report, right click
anywhere on the report's surface. In the invoked menu, point to Insert Band and click ReportHeader.

2. Drop the Page Info control from the Toolbox onto the ReportHeader band.



3. Set the control's PageInformation property to DateTime (e.g. using the smart tag).

4. To apply a format string to the control's contents, type Created at {0:h:mm tt dd MMMM yyyy} into its
TextFormatString property.



Merge ReportsMerge Reports
You may have report pages that do not fit within an entire report template in the following cases:

Title pages or custom pages at the end of the report;
Charts within a table report;

You can create pages in a separate report and merge them into your base report. This enables you to print and export merged
pages as a single document, and preserve the original report page settings and orientation.



Add a Report to the End/BeginningAdd a Report to the End/Beginning
Follow the steps below to add a separate report to the end of another report and print it as a single job.

1. Right-click the base report and select the Insert Band / Report Footer item in the context menu.

2. Drag a Subreport item from the Toolbox onto the created Report Footer band.



 T i pT i p

To add a report to the beginning of another report (for instance, to add a title page), use the Report Header band instead.

3. Click the subreport's smart tag and specify a report in the Sub-Report Tasks window:

Use the Report Source property to assign a predefined report from the Designer.

Use the Report Source Url property to assign a custom report.

4. Enable the Generate Own Pages option to print the embedded report on separate pages and use its own page settings.

5. Switch to Preview mode to see the combined report.





Use Data-Driven Page SequenceUse Data-Driven Page Sequence
This topic describes how to combine a table report that uses the Portrait page orientation and a chart report that uses Landscape
page orientation.

Follow the steps below to create a combined report:

Create a Chart Report
1. Create a report that shows data in the chart form. Bind the report to a data source. Set the report's Landscape property to

true to enable the Landscape page orientation.

2. Add a parameter to your chart report to identify which data to use for the chart. Right-click Parameters in the Field List
and choose Add Parameter.

3. Select the created parameter and set its Name and Type, and uncheck the Visible option.



4. Click the report's smart tag. Click the Filter String option's ellipsis button. In the invoked FilterString Editor, construct an
expression to compare the key data field to the created parameter. To access the parameter, click the icon on the right until
it turns into a question mark.

5. Save the report.

Create the Base Report
1. Create a report bound to the same data source as the chart report, and arrange a layout like the one shown below:



2. Right-click the base report's Detail band and select the Insert Band / Group Footer item in the context menu.

3. Drag a Subreport item from the Toolbox onto the added group footer band.

4. Click the sub-report control's smart tag and specify the chart report in the Sub-Report Tasks window:

Use the Report Source property to assign a predefined report from the Designer.

Use the Report Source Url property to assign a custom report.



5. Enable the Generate Own Pages option to print the embedded report on separate pages and use its own page settings.

6. Bind the chart report's parameter to the base report's data field. Click the subreport's smart tag and select Edit Parameter
Bindings in the invoked SubReport Tasks window.

7. The Parameter Bindings Collection Editor is invoked. Click Add to add a new binding. In the binding properties list,
specify the data field to bind to and the parameter name to bind.

8. Switch to Preview mode to see the combined report.



Your base report's Table of Contents and Document Map include bookmarks from the embedded report. Use the Parent
Bookmark property to specify the nesting level for the embedded report's bookmarks.



Use ExpressionsUse Expressions
Use expressions to retrieve and format data, create calculated fields and calculate summaries, conditionally shape data and
change a report control's appearance.

Expression Syntax
An expression is a string that is parsed and processed to evaluate a value. Expressions consist of field names, constants, operators,
and functions. Field names are wrapped in square brackets.

"[Quantity] * [UnitPrice] * (1 - [BonusAmount])"

"[FirstName] + ' ' + [LastName]"

"[Country] == 'USA'"

"[OrderDate] > #8/16/1994# AND [Quantity] > 20"

You can use operators, functions, and constants in your expressions.

Expression Editor
The Report Designer's Expression Editor provides functions, operators, data source fields, report elements, constants, and
variables to construct expressions.

The Expression Editor highlights an expression's syntax and supports intelligent code completion (it suggests functions and
available data elements as you type).



The Expression Editor displays all the errors it finds in the specified expression.

FilterString Editor
The Report Designer's FilterString Editor allows you to specify filter criteria for a report, Cross Tab, or Chart's series.

The FilterString Editor provides a visual interface where you can use an unlimited number of conditions and combine them with
logical operators to create filter criteria. You can also switch to the Text mode and type a filter string.

The FilterString Editor highlights an expression's syntax and supports intelligent code completion (it suggests functions and
available data elements as you type).





Expression Constants, Operators, and FunctionsExpression Constants, Operators, and Functions
The table below contains constants, operators, and functions you can use in expressions.

Constants
CONS TANT D ES CR IPTION E X AMPLE

String
constants

Wrap string constants in apostrophes.

If a string contains an apostrophe, double the apostrophe.

[Country] == 'France'

[Name] == 'O''Neil'

Date-time
constants Wrap date-time constants in '#'. [OrderDate] >= #2018-03-22 13:18:51.94944#

True Represents the Boolean True value. [InStock] == True

False Represents the Boolean False value. [InStock] == False

Enumeration Specify an enumeration value using its underlying integer value.

[Status] == 1

You cannot specify an enumeration value using
its qualified name. The following criteria is
incorrect:

[Status] = Status.InProgress

Guid Wrap a Guid constant in curly braces. Use Guid constants in a relational
operation with equality or inequality operators only.

[OrderID] == {513724e5-17b7-4ec6-abc4-
0eae12c72c1f}

Numeric

Specify different numeric constant types in a string form using suffixes:

Int32 (int) - 1
Int16 (short) - 1s
Byte (byte) - 1b
Double (double) - 1.0
Single (float) - 1.0f
Decimal (decimal) - 1.0m

[Price] == 25.0m

?

Represents a null reference that does not refer to any object.

We recommend using the IsNull unary operator (for example, "[Region]
is null") or the IsNull logical function (for example, "IsNull([Region])")
instead.

[Region] != ?

Operators



OPER ATOR D ES CR IPTION E X AMPLE

+ Adds the value of one numeric expression to another or concatenates two strings.
[UnitPrice] + 4

[FirstName] + ' '
+ [LastName]

- Finds the difference between two numbers. [Price1] - [Price2]

* Multiplies the value of two expressions.
[Quantity] *
[UnitPrice] * (1 -
[BonusAmount])

/ Divides the first operand by the second. [Quantity] / 2

% Returns the remainder (modulus) obtained by dividing one numeric expression by another. [Quantity] % 3

|
Performs a bitwise inclusive OR on two numeric expressions. Compares each bit of its first operand to
the corresponding bit of its second operand. If either bit is 1, the corresponding resulting bit is set to 1.
Otherwise, the corresponding resulting bit is set to 0.

[Number] |
[Number]

&
The bitwise AND operator. Compares each bit of its first operand to the corresponding bit of its second
operand. If both bits are 1, the corresponding resulting bit is set to 1. Otherwise, the corresponding
resulting bit is set to 0.

[Number] & 10

^ Performs a bitwise exclusive OR on two numeric expressions. [Number] ^
[Number]

==

=
Returns true if both operands have the same value; otherwise, it returns false. [Quantity] == 10

!= Returns true if the operands do not have the same value; otherwise, it returns false. [Country] !=
'France'

< Less than operator. Used to compare expressions. [UnitPrice] < 20

<= Less than or equal to operator. Used to compare expressions. [UnitPrice] <= 20

>= Greater than or equal to operator. Used to compare expressions. [UnitPrice] >= 30



> Greater than operator. Used to compare expressions. [UnitPrice] > 30

In (,,,) Tests for the existence of a property in an object. [Country] In
('USA', 'UK', 'Italy')

Between
(,)

Specifies a range to test. Returns true if a value is greater than or equal to the first operand and less
than or equal to the second operand.

[Quantity]
Between (10, 20)

And

&&
Performs a logical conjunction on two Boolean expressions.

[InStock] And
([ExtendedPrice]>
100)

[InStock] &&
([ExtendedPrice]>
100)

Or

||
Performs a logical disjunction on two Boolean expressions.

[Country]=='USA'
Or
[Country]=='UK'

[Country]=='USA'
||
[Country]=='UK'

~ Performs a bitwise negation on a numeric expression. ~[Roles] = 251

Not

!
Performs a logical negation on a Boolean expression.

Not [InStock]

![InStock]

+ Returns a numeric expression's value (a unary operator). +[Value] = 10

- Returns the negative of a numeric expression's value (a unary operator). -[Value] = 20

Is Null Returns true if an expression is a null reference, the one that does not refer to any object. [Region] is null

Functions (Basic)
Aggregate FunctionsAggregate Functions

FU NCTION D ES CR IPTION E X AMPLE

Avg(Value) Evaluates the average of the values in the collection. [Products].Avg([UnitPrice])



Count() Returns the number of objects in a collection. [Products].Count()

Exists() Determines whether the object exists in the collection. [Categories][[CategoryID] == 7].Exists()

Max(Value) Returns the maximum expression value in a collection. [Products].Max([UnitPrice])

Min(Value) Returns the minimum expression value in a collection. [Products].Min([UnitPrice])

Single() Returns a single object from the collection. [Accounts].Single() is not null

Sum(Value) Returns the sum of all the expression values in the collection. [Products].Sum([UnitsInStock])
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D ate-time FunctionsD ate-t ime Functions
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AddDays(DateTime, DaysCount) Returns a date-time value that is the specified
number of days from the specified DateTime. AddDays([OrderDate], 30)

AddHours(DateTime, HoursCount) Returns a date-time value that is the specified
number of hours from the specified DateTime. AddHours([StartTime], 2)

AddMilliSeconds(DateTime,
MilliSecondsCount)

Returns a date-time value that is the specified
number of milliseconds from the specified DateTime. AddMilliSeconds(([StartTime], 5000))

AddMinutes(DateTime,
MinutesCount)

Returns a date-time value that is the specified
number of minutes from the specified DateTime. AddMinutes([StartTime], 30)

AddMonths(DateTime,
MonthsCount)

Returns a date-time value that is the specified
number of months from the specified DateTime. AddMonths([OrderDate], 1)

AddSeconds(DateTime,
SecondsCount)

Returns a date-time value that is the specified
number of seconds from the specified DateTime. AddSeconds([StartTime], 60)

AddTicks(DateTime, TicksCount) Returns a date-time value that is the specified
number of ticks from the specified DateTime. AddTicks([StartTime], 5000)

AddTimeSpan(DateTime,
TimeSpan)

Returns a date-time value that is from the specified
DateTime for the given TimeSpan. AddTimeSpan([StartTime], [Duration])

AddYears(DateTime, YearsCount) Returns a date-time value that is the specified
number of years from the specified DateTime. AddYears([EndDate], -1)

DateDiffDay(startDate, endDate) Returns the number of day boundaries between
two non-nullable dates. DateDiffDay([StartTime], Now())

DateDiffHour(startDate, endDate) Returns the number of hour boundaries between
two non-nullable dates. DateDiffHour([StartTime], Now())

DateDiffMilliSecond(startDate,
endDate)

Returns the number of millisecond boundaries
between two non-nullable dates. DateDiffMilliSecond([StartTime], Now())



DateDiffMinute(startDate,
endDate)

Returns the number of minute boundaries between
two non-nullable dates. DateDiffMinute([StartTime], Now())

DateDiffMonth(startDate,
endDate)

Returns the number of month boundaries between
two non-nullable dates. DateDiffMonth([StartTime], Now())

DateDiffSecond(startDate,
endDate)

Returns the number of second boundaries between
two non-nullable dates. DateDiffSecond([StartTime], Now())

DateDiffTick(startDate, endDate) Returns the number of tick boundaries between two
non-nullable dates. DateDiffTick([StartTime], Now())

DateDiffYear(startDate, endDate) Returns the number of year boundaries between
two non-nullable dates. DateDiffYear([StartTime], Now())

GetDate(DateTime) Extracts a date from the defined DateTime. GetDate([OrderDateTime])

GetDay(DateTime) Extracts a day from the defined DateTime. GetDay([OrderDate])

GetDayOfWeek(DateTime) Extracts a day of the week from the defined
DateTime. GetDayOfWeek([OrderDate])

GetDayOfYear(DateTime) Extracts a day of the year from the defined
DateTime. GetDayOfYear([OrderDate])

GetHour(DateTime) Extracts an hour from the defined DateTime. GetHour([StartTime])

GetMilliSecond(DateTime) Extracts milliseconds from the defined DateTime. GetMilliSecond([StartTime])

GetMinute(DateTime) Extracts minutes from the defined DateTime. GetMinute([StartTime])

GetMonth(DateTime) Extracts a month from the defined DateTime. GetMonth([StartTime])

GetSecond(DateTime) Extracts seconds from the defined DateTime. GetSecond([StartTime])

GetTimeOfDay(DateTime) Extracts the time of the day from the defined
DateTime in ticks. GetTimeOfDay([StartTime])

GetYear(DateTime) Extracts a year from the defined DateTime. GetYear([StartTime])

IsApril(DateTime) Returns True if the specified date falls within April. IsApril([OrderDate])

IsAugust(DateTime) Returns True if the specified date falls within August. IsAugust([OrderDate])

IsDecember(DateTime) Returns True if the specified date falls within
December. IsDecember([OrderDate])

IsFebruary(DateTime) Returns True if the specified date falls within
February. IsFebruary([OrderDate])

IsJanuary(DateTime) Returns True if the specified date falls within
January. IsJanuary([OrderDate])
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IsJuly(DateTime) Returns True if the specified date falls within July. IsJuly([OrderDate])

IsJune(DateTime) Returns True if the specified date falls within June. IsJune([OrderDate])

IsLastMonth(DateTime) Returns True if the specified date falls within the
previous month. IsLastMonth([OrderDate])

IsLastYear(DateTime) Returns True if the specified date falls within the
previous year. IsLastYear([OrderDate])

IsMarch(DateTime) Returns True if the specified date falls within March. IsMarch([OrderDate])

IsMay(DateTime) Returns True if the specified date falls within May. IsMay([OrderDate])

IsNextMonth(DateTime) Returns True if the specified date falls within the
next month. IsNextMonth([OrderDate])

IsNextYear(DateTime) Returns True if the specified date falls within the
next year. IsNextYear([OrderDate])

IsNovember(DateTime) Returns True if the specified date falls within
November. IsNovember([OrderDate])

IsOctober(DateTime) Returns True if the specified date falls within
October. IsOctober([OrderDate])

IsSameDay(DateTime) Returns True if the specified date/time values fall
within the same day. IsSameDay([OrderDate])

IsSeptember(DateTime) Returns True if the specified date falls within
September. IsSeptember([OrderDate])

IsThisMonth(DateTime) Returns True if the specified date falls within the
current month. IsThisMonth([OrderDate])

IsThisWeek(DateTime) Returns True if the specified date falls within the
current week. IsThisWeek([OrderDate])

IsYearToDate(DateTime)
Returns True if the specified date falls within the
year-to-date period. This period starts from the first
day of the current year and continues to the current
date (including the current date).

IsYearToDate([OrderDate])

IsThisYear(DateTime) Returns True if the specified date falls within the
current year. IsThisYear([OrderDate])

LocalDateTimeDayAfterTomorrow() Returns a date-time value corresponding to the day
after Tomorrow.

AddDays(LocalDateTimeDayAfterTomorrow(),
5)

LocalDateTimeLastMonth() Returns the DateTime value corresponding to the
first day of the previous month. AddMonths(LocalDateTimeLastMonth(), 5)
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LocalDateTimeLastWeek() Returns a date-time value corresponding to the first
day of the previous week. AddDays(LocalDateTimeLastWeek(), 5)

LocalDateTimeLastYear() Returns the DateTime value corresponding to the
first day of the previous year. AddYears(LocalDateTimeLastYear(), 5)

LocalDateTimeNextMonth() Returns a date-time value corresponding to the first
day of the next month. AddMonths(LocalDateTimeNextMonth(), 5)

LocalDateTimeNextWeek() Returns a date-time value corresponding to the first
day of the following week. AddDays(LocalDateTimeNextWeek(), 5)

LocalDateTimeNextYear() Returns a date-time value corresponding to the first
day of the following year. AddYears(LocalDateTimeNextYear(), 5)

LocalDateTimeNow() Returns a date-time value corresponding to the
current moment in time. AddDays(LocalDateTimeNow(), 5)

LocalDateTimeThisMonth() Returns a date-time value corresponding to the first
day of the current month. AddMonths(LocalDateTimeThisMonth(), 5)

LocalDateTimeThisWeek() Returns a date-time value corresponding to the first
day of the current week. AddDays(LocalDateTimeThisWeek(), 5)

LocalDateTimeThisYear() Returns a date-time value corresponding to the first
day of the current year. AddYears(LocalDateTimeThisYear(), 5)

LocalDateTimeToday() Returns a date-time value corresponding to Today. AddDays(LocalDateTimeToday(), 5)

LocalDateTimeTomorrow() Returns a date-time value corresponding to
Tomorrow. AddDays(LocalDateTimeTomorrow(), 5)

LocalDateTimeTwoMonthsAway() Returns the DateTime value corresponding to the
first day of the following month.

AddMonths(LocalDateTimeTwoMonthAway(),
5)

LocalDateTimeTwoWeeksAway() Returns the DateTime value corresponding to the
first day of the following week. AddDays(LocalDateTimeTwoWeeksAway(), 5)

LocalDateTimeTwoYearsAway() Returns the DateTime value corresponding to the
first day of the following year. AddYears(LocalDateTimeTwoYearsAway(), 5)

LocalDateTimeYearBeforeToday() Returns the DateTime value corresponding to the
day one year ago.

AddYears(LocalDateTimeYearBeforeToday(),
5)

LocalDateTimeYesterday() Returns a date-time value corresponding to
Yesterday. AddDays(LocalDateTimeYesterday(), 5)

Now() Returns the current system date and time. AddDays(Now(), 5)

Today()
Returns the current date. Regardless of the actual
time, this function returns midnight of the current
date.

AddMonths(Today(), 1)
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UtcNow() Returns the current system date and time,
expressed as Coordinated Universal Time (UTC). AddDays(UtcNow(), 7)
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Logical FunctionsLogical Functions
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Iif(Expression1, True_Value1, ...,
ExpressionN, True_ValueN,
False_Value)

Returns one of several specified values depending upon the
values of logical expressions.

The function can take 2N+1 arguments (N - the number of
specified logical expressions):

Each odd argument specifies a logical expression;

Each even argument specifies the value that is returned if
the previous expression evaluates to true;

...

The last argument specifies the value that is returned if
the previously evaluated logical expressions yielded false.

Iif(Name = 'Bob', 1, Name =
'Dan', 2, Name = 'Sam', 3, 4)")

IsNull(Value) Returns True if the specified Value is NULL. IsNull([OrderDate])

IsNull(Value1, Value2) Returns Value1 if it is not set to NULL; otherwise, Value2 is
returned.

IsNull([ShipDate],
[RequiredDate])

IsNullOrEmpty(String) Returns True if the specified String object is NULL or an empty
string; otherwise, False is returned. IsNullOrEmpty([ProductName])

Math FunctionsMath Functions
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Abs(Value) Returns the given numeric expression's absolute, positive value. Abs(1 - [Discount])

Acos(Value) Returns a number's arccosine (the angle in radians, whose cosine is the given float
expression). Acos([Value])

Asin(Value) Returns a number's arcsine (the angle in radians, whose sine is the given float
expression). Asin([Value])

Atn(Value) Returns a number's arctangent (the angle in radians, whose tangent is the given float
expression). Atn([Value])

Atn2(Value1,
Value2) Returns the angle whose tangent is the quotient of two specified numbers in radians. Atn2([Value1], [Value2])

BigMul(Value1,
Value2) Returns an Int64 containing the full product of two specified 32-bit numbers. BigMul([Amount],

[Quantity])



Ceiling(Value) Returns the smallest integer that is greater than or equal to the numeric expression. Ceiling([Value])

Cos(Value) Returns the angle's cosine, in radians. Cos([Value])

Cosh(Value) Returns the angle's hyperbolic cosine, in radians. Cosh([Value])

Exp(Value) Returns the float expression's exponential value. Exp([Value])

Floor(Value) Returns the largest integer less than or equal to the numeric expression. Floor([Value])

Log(Value) Returns a specified number's natural logarithm. Log([Value])

Log(Value, Base) Returns the logarithm of a specified number in a specified Base. Log([Value], 2)

Log10(Value) Returns a specified number's base 10 logarithm. Log10([Value])

Max(Value1,
Value2) Returns the maximum value from the specified values. Max([Value1], [Value2])

Min(Value1, Value2) Returns the minimum value from the specified values. Min([Value1], [Value2])

Power(Value,
Power) Returns a specified number raised to a specified power. Power([Value], 3)

Rnd() Returns a random number that is less than 1, but greater than or equal to zero. Rnd()*100

Round(Value) Rounds the given value to the nearest integer. Round([Value])

Round(Value,
Precision)

Rounds the given value to the nearest integer, or to a specified number of decimal
places. Round([Value], 2)

Sign(Value) Returns the positive (+1), zero (0), or negative (-1) sign of the given expression. Sign([Value])

Sin(Value) Returns the sine of the angle defined in radians. Sin([Value])

Sinh(Value) Returns the hyperbolic sine of the angle defined in radians. Sinh([Value])

Sqr(Value) Returns the square root of a given number. Sqr([Value])

Tan(Value) Returns the tangent of the angle defined in radians. Tan([Value])

Tanh(Value) Returns the hyperbolic tangent of the angle defined in radians. Tanh([Value])

ToDecimal(Value) Converts Value to an equivalent decimal number. ToDecimal([Value])

ToDouble(Value) Converts Value to an equivalent 64-bit double-precision floating-point number. ToDouble([Value])

ToFloat(Value) Converts Value to an equivalent 32-bit single-precision floating-point number. ToFloat([Value])

ToInt(Value) Converts Value to an equivalent 32-bit signed integer. ToInt([Value])
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ToLong(Value) Converts Value to an equivalent 64-bit signed integer. ToLong([Value])
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S tring FunctionsS tring Functions
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Ascii(String) Returns the ASCII code value of the leftmost character in a character expression. Ascii('a')

Char(Number) Converts an integerASCIICode to a character. Char(65) + Char(51)

CharIndex(String1,
String2)

Returns the starting position of String1 within String2, beginning from the zero
character position to the end of a string.

CharIndex('e',
'devexpress')

CharIndex(String1,
String2, StartLocation)

Returns the starting position of String1 within String2, beginning from the
StartLocation character position to the end of a string.

CharIndex('e',
'devexpress', 2)

Concat(String1, ... ,
StringN)

Returns a string value containing the concatenation of the current string with any
additional strings.

Concat('A', ')',
[ProductName])

Contains(String1,
SubString1) Returns True if SubString1 occurs within String1; otherwise, False is returned. Contains([ProductName],

'dairy')

EndsWith(String1,
SubString1)

Returns True if the end of String1 matches SubString1; otherwise, False is
returned.

EndsWith([Description],
'The end.')

Insert(String1,
StartPosition, String2) Inserts String2 into String1 at the position specified by StartPositon Insert([Name], 0, 'ABC-')

Len(Value) Returns an integer containing either the number of characters in a string or the
nominal number of bytes required to store a variable. Len([Description])

Lower(String) Returns String in lowercase. Lower([ProductName])

PadLeft(String, Length) Left-aligns the defined string's characters, padding its left side with white space
characters up to a specified total length. PadLeft([Name], 30)

PadLeft(String, Length,
Char)

Left-aligns the defined string's characters, padding its left side with the specified
Char up to a specified total length. PadLeft([Name], 30, '<')

PadRight(String, Length) Right-aligns the defined string’s characters, padding its left side with empty space
characters up to a specified total length. PadRight([Name], 30)

PadRight(String, Length,
Char)

Right-aligns the defined string’s characters, padding its left side with the specified
Char up to a specified total length. PadRight([Name], 30, '>')

Remove(String,
StartPosition) Deletes all the characters from this instance, beginning at a specified position. Remove([Name], 3)

Remove(String,
StartPosition, Length)

Deletes a specified number of characters from this instance, beginning at a
specified position. Remove([Name], 0, 3)

Replace(String,
SubString2, String3) Returns a copy of String1, in which SubString2 has been replaced with String3. Replace([Name], 'The ', '')



Reverse(String) Reverses the order of elements within String. Reverse([Name])

StartsWith(String1,
SubString1) Returns True if the beginning of String1 matches SubString1; otherwise, False. StartsWith([Title], 'The

best')

Substring(String,
StartPosition, Length)

Retrieves a substring from String. The substring starts at StartPosition and has a
specified Length.

Substring([Description],
2, 3)

Substring(String,
StartPosition) Retrieves a substring from String. The substring starts at StartPosition. Substring([Description],

2)

ToStr(Value) Returns a string representation of an object. ToStr([ID])

Trim(String) Removes all leading and trailing SPACE characters from String. Trim([ProductName])

Upper(String) Returns String in uppercase. Upper([ProductName])
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Functions for Expression Bindings and Calculated Fields
Below is a list of functions that are used to construct expression bindings and calculated fields:
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NewLine() Returns the newline string defined for the current environment.

[CategoryName]+NewLine()+
[Description]

Result:

Beverages

Soft drinks, coffees, teas,
beers and ales.

FormatString(Format,
Value1, ... , ValueN)

Returns the specified string with formatted field values. See Format Data for
details.

FormatString('{0:$0.00}',
[UnitPrice])

Result: $45.60

Rgb(Red, Green,
Blue)

Returns a string defining a color using the Red, Green, and Blue color channel
values.

Rgb(30,200,150)

Result: '30,200,150'

Argb(Alpha, Red,
Green, Blue)

Returns a string defining a color using the Alpha, Red, Green, and Blue color
channel values.

Argb(1,200, 30, 200)

Result: '1,200,30,200'



Join()

Concatenates the multi-value report parameter's values into a string. This
function is useful when you bind a multi-value parameter to a label to display the
parameter's values in a report.

This function has two overloads:

Join(parameter) - concatenates the specified parameter's values using
comma as a separator.
Join(parameter, separator) - concatenates the specified parameter's values
using the specified separator.

Join(?CategoriesParameter)

Result: Beverages,
Condiments

Join(?CategoriesParameter,
newline())

Result:

Beverages

Condiments

Functions for Stored Procedure Binding
The following functions are specific for binding reports to a stored procedure:
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Join()

Concatenates the multi-value report parameter's values into a string. This function can be used
when mapping multi-value report parameters to query parameters generated from a stored
procedure's parameters. Refer to the Query Parameters topic for more information.

This function has two overloads:

Join(parameter) - concatenates the specified parameter's values using comma as a
separator.
Join(parameter, separator) - concatenates the specified parameter's values using the
specified separator.

Join(?
Parameter1)

CreateTable(Column1,
..., ColumnN)

Creates a table from several multi-value parameters' values. This function can be used when
mapping multi-value report parameters to the query parameter that is generated from a stored
procedure's User Defined Table Type parameter. Refer to the Query Parameters topic for more
information.

CreateTable(?
Parameter1,
..., ?
ParameterN)

Functions for Summary Expression Editor
Use the following functions when calculating summaries across a report and its groups:
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sumAvg(Expression) Calculates the average of all the values within the specified summary
region (group, page or report). sumAvg([UnitPrice])

https://docs.microsoft.com/en-us/sql/relational-databases/tables/use-table-valued-parameters-database-engine


sumCount(Expression)

Counts the number of values within the specified summary region
(group, page or report). In a simple scenario, you may not pass a
parameter.

When using this function in a master-detail report's master band and
passing a detail's field as a parameter, it counts the number of records
within the detail's band.

See also: Counting the Number of Records in a Report or Group,
Counting the Number of Groups in a Report

sumCount([UnitPrice])

sumDAvg(Expression) Calculates the average of all the distinct values within the specified
summary region (group, page or report). sumDAvg([UnitPrice])

sumDCount(Expression)
Counts the number of distinct values within the specified summary
region (group, page or report). In a simple scenario, you may not pass a
parameter.

sumDCount([UnitPrice])

sumDStdDev(Expression) Calculates the standard deviation of all the distinct values within the
specified summary region (group, page or report). sumDStdDev([UnitPrice])

sumDStdDevP(Expression) Calculates the standard population deviation of all the distinct values
within the specified summary region (group, page or report). sumDStdDevP([UnitPrice])

sumDSum(Expression) Calculates the total of all the distinct values within the specified
summary region (group, page or report). sumDSum([UnitPrice])

sumDVar(Expression) Calculates the amount of variance for all the distinct values within the
specified summary region (group, page or report). sumDVar([UnitPrice])

sumDVarP(Expression) Calculates the population variance of all the distinct values within the
specified summary region (group, page or report). sumDVarP([UnitPrice])

sumMax(Expression) Calculates the maximum of all the values within the specified summary
region (group, page or report). sumMax([UnitPrice])

sumMedian(Expression)

Finds the middle number within a sequence.

Note that if the total number of elements is odd, this function returns
the value of the middle number in a sequence. If the total number of
elements is even, this function returns the arithmetical mean of the two
middle numbers.

sumMedian([UnitPrice])



sumMin(Expression) Calculates the minimum of all the values within the specified summary
region (group, page or report). sumMin([UnitPrice])

sumPercentage(Expression)
Calculates the percent ratio of the current data row's value to the total
of all the values within the specified summary region (group, page or
report).

sumPercentage([UnitPrice])

sumRecordNumber(Expression)

Returns the current record number in the specified summary region
(group, page or report). This means for instance, if the summary is
calculated for a group, then the record number is calculated only within
that group, and is reset every time a new group is started.

In a simple scenario, you may not pass a parameter.

See also: Displaying Row Numbers in a Report, Group or Page

sumRecordNumber()

sumRunningSum(Expression) Summarizes all the values, which were printed before the current data
row, with the current data row's value. sumRunningSum([UnitPrice])

sumStdDev(Expression) Calculates the standard deviation of all the values within the specified
summary region (group, page or report). sumStdDev([UnitPrice])

sumStdDevP(Expression) Calculates the standard population deviation of all the values within the
specified summary region (group, page or report). sumStdDevP([UnitPrice])

sumSum(Expression) Calculates the total of all the values within the specified summary region
(group, page or report). sumSum([UnitsInStock])

sumVar(Expression) Calculates the amount of variance for all the values within the specified
summary region (group, page or report). sumVar([UnitPrice])

sumVarP(Expression) Calculates the population variance of all the values within the specified
summary region (group, page or report). sumVarP([UnitPrice])

sumWAvg(Expression,
Expression)

Calculates the weighted average of all the values within the specified
summary region (group, page or report). This type of summary returns
the result of the following operation: Sum(Expression1 * Expression2) /
Sum(Expression2).

sumWAvg([UnitPrice])

Report Items In Expressions
A report's elements are displayed in the Report Designer's Report Explorer. You can access these elements and their properties in
expressions. The following example demonstrates how to set a label's BackColor property to the other label's BackColor property
value.



[ReportItems].[xrLabel2].[BackColor]

 T i pT i p

[ReportItems] is a plain list that provides access to all report items at one level.
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You cannot use the ReportItems collection in a Calculated Field's expression.

Images for Picture Boxes
When you construct an expression for the Picture Box's ImageSource property, you can use image Ids from the report's
ImageResources collection.

IIf([MarchSales]>20, [Images.ArrowUp],[Images.ArrowDown])

Variables
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DataSource.RowCount Returns the total amount of
data rows in a data source.

[DataSource.RowCount] != 0

Result: When using this expression for a control's Visible
property, the control is not displayed if there is no data in the
data source.

DataSource.CurrentRowIndex
Returns a zero-based index
of the current data row in a
data source.

Iif([DataSource.CurrentRowIndex] % 2 = 0, 'red', 'green')

Result: When this expression is used for a table row's BackColor
property, odd rows are colored in red and even rows - in green.

DataSource.CurrentRowHierarchyLevel
Returns a zero-based level of
the current row in a
hierarchical report.

Iif([DataSource.CurrentRowHierarchyLevel] == 0,
Rgb(231,235,244), ?)

Result: When this expression is used for the BackColor property
of the Detail band that is printed in tree mode, the root level
rows are highlighted.
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These variables are not valid when the report includes a table or contents.

Report Parameters
Use the following syntax to insert parameters into expressions:

Type a question mark before a parameter's name.

?parameter1

(Obsolete approach) Use the "Parameters." prefix before a report parameter's name.

[Parameters.parameter1]



Collection Elements Verification
Use brackets "[]" to check if a collection contains an element that satisfies a condition. The following expression returns true if the
Accounts collection contains at least one element that satisfies the [Amount] == 100 condition:

[Accounts][[Amount] == 100]

The following expression returns false if the Accounts collection is empty:

[Accounts][]

Refer to the topic to see an example how to use this syntax.

Parent Relating Operator
Use the parent relating operator ('^' character) to refer to a parent in expressions written in the context of a child. You can apply
this operator successively to navigate multiple parent relationships.

You can use this operator to refer to the currently processed report group. This allows you to calculate aggregates within groups
using expressions like the following:

[][[^.CategoryID] == [CategoryID]].Sum([UnitPrice])

Refer to the topic for details.

Grouping Clauses with Brackets
It is important to use brackets to ensure that your expression returns the intended results.

For instance, the following expression for objects of the Customer type returns all of the Customers where an Account exists with
a Date of 8/25/2006 and where an account exists with an Amount of 100:

[Accounts][[Date] == #8/25/2006#] && [Accounts][[Amount] == 100]

Construct the expression as in the following example to search for all Customers that have an Account with both a Date of
8/25/2006 and an Amount of 100:

[Accounts][[Date] == #8/25/2006# && [Amount] == 100]

Operator Precedence
When an expression contains multiple operators, their precedence controls the order in which expression elements are evaluated.

Literal values
Parameters
Identifiers
OR (left-associative)
AND (left-associative)
'.' relationship qualifier (left-associative)
==, !=
<, >, <=, >=
-, + (left-associative)
*, /, % (left-associative)
NOT
unary -
In



Iif
Trim(), Len(), Substring(), IsNull()
'[]' (for set-restriction)
'()'

The default precedence can be changed by grouping elements with parentheses. For instance, the operators are performed in a
default order in the first of the following two code samples. In the second code sample, the addition operation is performed first,
because its associated elements are grouped with parentheses, and the multiplication operation is performed last.

Accounts[Amount == 2 + 48 * 2]

Accounts[Amount == (2 + 48) * 2]

Case Sensitivity
Operators are case insensitive. Although field values’ case sensitivity depends on the data source.

�� N o t eN o t e

A data source affects certain operators' behavior. For instance, by default, the SQL Server Express 2005 is configured as case
insensitive. In this case, the following expression always evaluates to true:

Lower(Name) == Upper(Name)

Escaping Keywords
You can mark a keyword-like field name with an escape character (@ sign). In the expression below, the CriteriaOperator.Parse
method interprets @Or as the field named "Or", not the logical operator OR.

@Or = 'value'

Escape Characters
Use a backslash () as an escape character for characters in expressions. Examples:

\[
\\
\'



Use Report ScriptsUse Report Scripts
This document describes the basic principles of scripting, which can be performed by handling the events of a report, and its
bands and controls.

Scripts are program commands, placed within the event handlers of the required report elements. And, when the corresponding
event occurs (e.g. a mouse click), the script code runs.

You can write scripts for a report or any of its elements (bands and controls), to be executed when the report is being previewed,
printed or exported.

In the Property Grid, expand the Scripts property for the required element. Every report element has an individual set of script
events.

After you click (New) for an event (e.g. the Before Print, which is the most used), the Scripts Tab is switched on, where you can
manage and edit all the report's scripts.

In this tab, for a selected event, a script template is auto-added, in the language specified via the Script Language property of the
report.

This tab contains all scripts written for all report elements, and allows you to quickly navigate through them by choosing the
required report element in the corresponding drop-down list, and specifying one of its available events in another menu.



The script editor supports intelligent code completion that makes it easier and faster for you to write scripts. Context-aware hints
are displayed on typing a dot or pressing CTRL+spacebar.

You can verify that your report's scripts are valid, by clicking Validate. The validation result is then displayed in the Scripts Errors
panel.

To proceed to the line that contains an error, click that error in the Error List panel.

Note that scripts are saved to a file along with the report's layout.



Preview, Print and Export ReportsPreview, Print and Export Reports
Preview a Report
To switch a report to the print preview mode, click the Preview tab. You will see your report populated with data and broken
down into pages, as specified.
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To learn more about the options available in the print preview mode, refer to the Print Preview for WinForms section of this
documentation.

Print a Report
When in the Print Preview mode, you can print out your report using the appropriate menu and toolbar commands.



Export a Report
When in the Print Preview mode, you can export your report to files in different formats. The resulting files can either be saved to
the hard drive or sent by e-mail.

The following documents describe the basics of report exporting and format-specific export options.

Exporting from Print Preview
PDF-Specific Export Options
HTML-Specific Export Options
MHT-Specific Export Options
RTF-Specific Export Options
XLS-Specific Export Options
XLSX-Specific Export Options
CSV-Specific Export Options
TXT-Specific Export Options
Image-Specific Export Options



Report Designer ToolsReport Designer Tools
The topics in this section describe the main tools and features available in the Report Designer:

Report Wizard
Data Source Wizard
Query Builder
Toolbox
Toolbar
UI Panels



Report WizardReport Wizard
The Report Wizard allows you to add a report using one of the following templates:

Blank

Creates a new blank report that is not bound to a data source. Choose this option to design your report without using the
wizard.

Table Report

Allows you to create a table report, connect it to a data source and configure basic report layout settings.

Vertical Report

Allows you to create a vertical report, connect it to a data source and configure basic report layout settings.

Cross-Tab Report

Allows you to create a cross-tab report, connect it to a data source and configure basic report layout settings.

Labels

Allows you to select from different customizable layouts to create labels, badges or price tags.

Template

Enables you to create a new report based on available predefined templates.

Run the Report Wizard
Use one of the following ways to invoke the Report Wizard.



Create a new report

Use the New Report via Wizard command to create a new report based on a Report Wizard template.

Edit an existing report

Click the report's Smart Tag and then the Design in Report Wizard... context link in the invoked actions list.
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The new report layout overrides the initial report layout.



Choose a Report TypeChoose a Report Type
On this wizard page, you can choose the report type you want to create.

The following report types are available.

Blank Report
Table Report
Vertical Report
Labels
Template



Blank ReportBlank Report
This topic describes how to add a new blank report to an application at design time in Visual Studio by using the Report Wizard.

To create an empty report, run the Report Wizard, select Blank and click Finish.

The following image illustrates the default layout of a newly added empty report.

To learn how to connect a report to data and construct the report layout, see the following topic: Bind to Data.



Table ReportTable Report
The topics in this section describe how to create a table report and connect it to data at design time within Visual Studio using the
Data Source Wizard.

To create a new report and connect it to data, run the Report Wizard and select Table Report.

The Report Wizard can include the following pages:

Select the Data Source Type
Choose Fields to Display in a Report
Add Grouping Levels
Specify Summary Options
Specify Report Page Settings
Specify a Report Color Scheme
Set the Report Title



Select the Data Source TypeSelect the Data Source Type
This wizard page allows you to select the required data source type.

Click Next to proceed to the next wizard page, depending on the selected data source type.

Connect to a Database
Connect to an Entity Framework Data Source
Connect to an Object Data Source
Connect to an Excel Date Source
Connect to JSON Data Source
Connect to XPO Data Source
No Data



Choose Fields to Display in a ReportChoose Fields to Display in a Report
This wizard page allows you to select data members for a report and its detail reports as well as choose data fields to display in
these reports.

The list on the left-hand side displays queries and master-detail relationships specified on the previous wizard page. Select
required check boxes to create relevant reports and assign their DataMember property.

In the list on the right-hand side, choose data fields from the selected data members to include into corresponding reports.

After completing the wizard, the report is constructed according to the following:

If you select one query, it assigns to the report's DataMember property. The selected fields with corresponding captions
are automatically added to the report's Detail Band.
If you select two or more queries, this creates the Detail Report Band for each query at the same hierarchical level. The
DataMember properties of these detail reports are assigned to the corresponding queries.
For each selected master-detail relationship, the Detail Report Band with the DataMember property set to this relationship
is created under the corresponding master report.

You can stop the wizard at this step by clicking Finish. The created report looks similar to the image below.

If you want to customize the report further, click Next to go to the Add Grouping Levels page.



Add Grouping LevelsAdd Grouping Levels
This page allows you to group data in your report. If you do not need to group your data, simply click Next on this page to skip
this step.

Nested grouping and grouping against multiple fields are fully supported. The following image illustrates all basic grouping types.

The list on the left-hand side displays data fields that can be used to group data. To apply grouping, do one of the following.

Select columns and click the right arrow button.
Double-click columns.

To remove a grouping field, double-click it in the list on the right-hand side, or select it and click the left arrow button. You can
also change the order of grouping fields using the up arrow and down arrow buttons.

You can stop the wizard on this step by clicking Finish. In this case, your report will look similar to the image below.



If you want to customize your report further, click Next. If data grouping has been applied on this page, you will proceed to the
Specify Summary Options page. If you have not grouped your data, you will skip the summaries step and go to the Specify Report
Page Settings page.



Specify Summary OptionsSpecify Summary Options
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This wizard step is only available if you have applied data grouping in the previous step (Add Grouping Levels). If you have not
grouped data, this step is skipped.

On this wizard page, you can specify summaries to calculate in the selected reports.

Use the drop-down list at the top of the wizard page to choose a required report.

In the Fields table column, you can select an available numerical or date-time field. To specify which functions should be
calculated for the selected field, enable the corresponding check boxes in the Summary functions drop-down.

The specified summaries are displayed in the report footer and after corresponding groups (if you have grouped report data on
the previous wizard page).

If data fields can contain empty values and you do not want to take these values into account when calculating totals, select the
Ignore null values check box. Otherwise, these values are treated as zeros for numeric fields and the earliest system date for
date-time fields.

You can stop the wizard at this step by clicking Finish. The created report looks similar to the image below.



If you want to customize the report further, click Next to proceed to the next wizard page: Set the Report Title.



Specify Report Page SettingsSpecify Report Page Settings
At this step, set up the report's page.

This wizard page allows you to specify the following report properties:

Report Page Size
Unit
Choose between Inch, Millimeter and Pixel to specify size options on this wizard page. After you finish the wizard, the Report
Designer transforms the specified units to HundredthsOfAnInch, TenthsOfAMillimeter or Pixels to provide a more precise
report element alignment.

Width and Height
These properties are read-only until you set the Size option to Custom.

Page Margins
Use the report page preview to drag the margins to a required position.

Page Orientation

You can change these settings after you finish the wizard in the Report Designer's Property Grid.

If you want to customize the report further, click Next to proceed to the next wizard page: Choose a Report Color Scheme.
Otherwise, click Finish to complete report customization.



Choose a Report Color SchemeChoose a Report Color Scheme
This page allows you to choose a base color for report styles.

The wizard creates styles based on the chosen color for the first level report controls and applies styles with more transparent
colors to controls on deeper levels.



Set the Report TitleSet the Report Title
On this page, specify the title for the report and click Finish to exit the wizard.



Vertical ReportVertical Report
The topics in this section describe how to create a vertical report - a table report where record fields are displayed vertically and
data records are printed horizontally.

Run the Report Wizard and select Vertical Report to create a new vertical report and connect it to data.

The Report Wizard can include the following pages (similar to the Table Report type):

Select the Data Source Type
Choose Fields to Display in a Report
Add Grouping Levels
Specify Summary Options
Specify Report Page Settings
Specify a Report Color Scheme
Set the Report Title

After you finish the wizard, it creates a report with vertical bands: Vertical Header, Vertical Detail and Vertical Total.





Cross-Tab ReportCross-Tab Report
Select Cross-Tab Report on the wizard's start page to create a cross-tab report that displays multi-dimensional data.

Click Next and use the Data Source Wizard to set up a report's data source.

Once the data source is configured, you can define the report's layout on the next page. Drop data fields onto the following cross-
tab area:

Rows - defines row headers;
Columns - defines column headers;
Data - defines fields against which to calculate summaries.



You can also select a field from the corresponding drop-down list.
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The field order defines the hierarchy in the resulting cross-tab report. The higher the field on the list, the higher the level in the
field hierarchy.



You can click Finish to stop the Report Wizard. If you want to customize the report further, click Next and proceed to the next
pages:

Specify Report Page Settings
Choose a Report Color Scheme
Set the Report Title

The generated report contains the Cross Tab control that is configured based on the specified settings. The XRCrossTab control
calculates automatic totals and grand totals across row and column fields.



LabelsLabels
This topic describes the steps required to create a report with labels by using the Report Wizard.

Label report creation consists of the following two steps.

Select the Data Source Type
Select the Label Type
Customize the Label Options



Select the Data Source TypeSelect the Data Source Type
This wizard page allows you to select the required data source type.

Click Next to proceed to the next wizard page, depending on the selected data source type.

Connect to a Database
Connect to an Entity Framework Data Source
Connect to an Object Data Source
Connect to an Excel Date Source
Connect to JSON Data Source
Connect to XPO Data Source
No Data



Select the Label TypeSelect the Label Type
This page is intended to select a label type from numerous predefined types.

On this page you can choose the proper setting from the Label Products and the Product Number drop-down lists. The
selected type defines the label's size and layout, as well as the page type, which is default for this label.

Then, click Next to proceed to the Customize the Label Options page.



Customize the Label OptionsCustomize the Label Options
This page is intended to customize the label's options.

On this page you can adjust the label's layout parameters and choose the Page Size.

Click Finish to complete report creation.



TemplateTemplate
The topics in this section describe how to create a report based on available predefined templates in Visual Studio at design time.

Run the Report Wizard and select the Template option on its first page.

Template report creation includes the following steps.

Choose a Report Template
Select the Data Source Type
Map Report Template Fields
Specify Report Template Options



This wizard page allows you to choose one of the predefined report layouts.

Once the wizard finishes, the selected template defines the arrangement of the appropriate elements in a report and their
appearance settings. You can stop the wizard on this page by clicking Finish.

Click Next to provide data to your report and continue report customization.

The next page guides you through the data source setup.

After you configured a data source, proceed to the following wizard page: Map Report Template Fields.



Select the Data Source TypeSelect the Data Source Type
This wizard page allows you to select the required data source type.

Click Next to proceed to the next wizard page, depending on the selected data source type.

Connect to a Database
Connect to an Entity Framework Data Source
Connect to an Object Data Source
Connect to an Excel Date Source
Connect to JSON Data Source
Connect to XPO Data Source
No Data



Map Report Template FieldsMap Report Template Fields
On this wizard page, you can specify the relationships between the data source's fields and predefined template fields, or provide
static values for the template fields.

The tree on the left-hand side displays data source fields. The grid on the right-hand side contains two columns with available
template fields and their values divided into categories.

Drag and drop the required data field from the tree onto the corresponding template field to map these fields.

You can also select the necessary data field from the Template Field Value drop-down list.



Select None in the drop-down list to delete a mapping.

You can also manually enter a static field value in the Template Field Value column.

If you do not provide values to specific template fields, the corresponding elements are added to the resulting report anyway.

You can stop the wizard at this step by clicking Finish or click Next to proceed to the following wizard page: Specify Report
Template Options.



Specify Report Template OptionsSpecify Report Template Options
The following wizard page allows you to specify currency formatting options and the discount/tax options.

In the Currency section, select the currency symbol and format for displaying price values.

In the Discount and Tax section, you can specify the following settings.

Range - Defines whether the discount/tax value should not be taken into account (None), or should be used for individual
items (Unit) or for the entire order (Total).
Value - Specifies the discount/tax value that can be static or bound to the data source field.
Type - Specifies the type of the discount/tax value (flat, fixed or percentage).
Inclusive (for the tax only) - Indicates whether the tax value is included into product prices.

Click Finish to complete the wizard and get the resulting report.



Data Source WizardData Source Wizard
The Data Source Wizard enables you to configure a data source and retrieve the required data. It supports the following data
source types:

Database

Obtains data from all major data providers (Microsoft SQL Server, XML data, Microsoft Access, Oracle, etc.).

Entity Framework

Supports binding to a Microsoft ADO.NET Entity Framework data source.

Object Binding

Connects to a data object.

Excel File

Obtains data from Microsoft Excel workbooks (XLS, XLSX or XLSM files) or CSV files.

JSON

Connects to JSON-formatted data.

XPO

Allows you to bind to XPO data.

No Data

Allows you design a report that is not bound to a data source.



The Data Source Wizard allows you to do the following:

Add a new data-bound report to your application using the Report Wizard, which contains the Data Source Wizard pages.

Bind an existing report or its Detail Report band to data. To invoke this Wizard, click Add Data Source on the Ribbon's
Home page.

Alternatively, click the report's smart tag, expand the DataSource property's drop-down menu and click Add Report Data
Source.



Connect the Chart, Cross Tab and Sparkline report controls to individual data sources.

You can invoke the Data Source Wizard using the Add Data Source command on the Chart | Design contextual page.

You can invoke the Data Source Wizard using the DataSource property in the chart's smart tag.



Connect to a DatabaseConnect to a Database
The topics in this section describe the steps required to connect a report to a database.

This task includes the following steps.

Select a Data Connection
Specify a Connection String
Save the Connection String
Create a Query or Select a Stored Procedure
Configure Query Parameters



Select a Data ConnectionSelect a Data Connection
On this page, you can either select one of the currently available data connections from the list or create a new one.

Click Next to proceed to the next wizard page, depending on the selected option.



Specify a Connection StringSpecify a Connection String
On this page, define a custom connection string or select one of the supported data source types.

The following data source types are supported.

Amazon Redshift
Firebird
Google BigQuery
IBM DB2
Microsoft Access 2007
Microsoft Access 97
Microsoft SQL Server
Microsoft SQL Server Compact Edition
MySQL
Oracle
Pervasive PSQL
PostgreSQL
SAP Sybase Advantage
SAP Sybase ASE
SAP Sybase SQL Anywhere
SQLite
Teradata
VistaDB
VistaDB5
XML file

Depending on the data provider selected, it may be necessary to specify additional connection options (such as authentication
type and database name) on this page.

Click Next to proceed to the next wizard page, depending on whether or not the created connection uses server authentication.

Save the Connection String - if server authentication is required, this page allows you to specify whether or not you want to
save the user credentials along with the connection string.
Create a Query or Select a Stored Procedure - if server authentication is not required, the page above does not appear, and
you will proceed to constructing the query.



Save the Connection StringSave the Connection String
On this page, you can specify whether or not to save the user credentials along with the connection string.

Click Next to proceed to the next wizard page: Create a Query or Select a Stored Procedure.



Create a Query or Select a Stored ProcedureCreate a Query or Select a Stored Procedure
On this wizard page, you can choose which tables, views and/or stored procedures from your data source to display in the report.

Manage Custom Queries
When you are required to shape the query data at the level of a data source, you can create custom queries by expanding the
Queries category and clicking the  button. This will invoke the Query Builder where you can create complex queries by joining
multiple tables, filtering, sorting and grouping their data, as well as calculating various aggregate functions.

The Query Builder can also be used to specify custom SQL, if this functionality is enabled by your software provider.

To customize an existing query using the Query Builder, click the  button.



To delete a query, click the  button.

On finishing the wizard, each of the selected data items will be included into a separate query.

Specify Master-Detail Relationships
To define master-detail relationships between two or more queries, click Manage Relations.

To create a new relationship, connect the required key fields using drag and drop.

To edit an existing relationship, double-click the corresponding arrow or right-click it, and select the Edit Relation command in
the invoked context menu.



This will invoke the Edit Relation editor that provides a different UI to manage the data relationships.

On finishing the wizard, the specified data relationships will appear in the Field List.

If selected queries or stored procedures contain any parameters, you will be required to define their values on the next wizard
page: Configure Query Parameters.



Configure Query ParametersConfigure Query Parameters
On this wizard page, you can manage parameters that are used in queries and/or stored procedures selected on the previous
wizard page, as well as specify parameter values.

Specify Parameter Values
A parameter value can be specified in one of the following ways.

Parameters can be assigned static values (according to the specified parameter type), which is illustrated in the following
image.

Alternatively, you can link a query or stored procedure parameter to a report parameter, whose value can be requested each
time before the report document is to be previewed or exported. To do this, enable the Expression check box and select an
existing report parameter of the corresponding type or create a new one.



Another option is to calculate a parameter value based on an expression. To do this, enable the Expression check box and
run the Expression Editor.

Manage Parameters
To delete a specific parameter, select it on this wizard page and click Remove.

To execute a specific query with the specified parameter values, click Preview and select a query.

When previewing a query or stored procedure result, only 1000 first data rows are displayed. If a query contains a custom SQL,
the entire result set is obtained.

To create a new query parameter, click Add and select a query.



Connect to an Entity Framework Data SourceConnect to an Entity Framework Data Source
The topics in this section describe the steps required to connect a report to an Entity Framework data source:

Select the Data Context
Select a Connection String
Specify a Connection String
Bind to a Stored Procedure
Select a Data Member
Configure Filters



Select the Data ContextSelect the Data Context
On this page, select the required data context from the list of available data contexts.

If the Browse button is available on this page, you can also select a data context from a custom assembly.

Click Next to proceed to the next wizard page: Select a Connection String.



Select a Connection StringSelect a Connection String
On this page, you can specify a connection string using one of the following two options.

Using an existing connection string. To do this, select Yes, let me choose from list. Next, select the required connection
string from the list of the available connection strings.
Specify a connection string manually. To do this, select No, specify a custom connection string.

Click Next to proceed to the next wizard page. If you select the first option, proceed to the Specify a Connection String page. If
you choose one of the available connection strings, go to the Bind to a Stored Procedure or Select a Data Member page,
depending on whether or not the current Entity Framework model provides stored procedures.



Select a Connection StringSelect a Connection String
On this page, you can specify a connection string using one of the following two options.

Using an existing connection string. To do this, select Yes, let me choose from list. Next, select the required connection
string from the list of the available connection strings.
Specify a connection string manually. To do this, select No, specify a custom connection string.

Click Next to proceed to the next wizard page. If you select the first option, proceed to the Specify a Connection String page. If
you choose one of the available connection strings, go to the Bind to a Stored Procedure or Select a Data Member page,
depending on whether or not the current Entity Framework model provides stored procedures.



Bind to a Stored ProcedureBind to a Stored Procedure
This wizard page allows you to add stored procedures to the data source, configure their parameters and preview the results of a
stored procedure’s execution.

To bind to a stored procedure, do the following.

1. Click Add. Then, in the invoked window, select a required stored procedure and click OK.

2. Configure the parameters to be passed to the selected stored procedure. Make sure that the value of the passed parameter's
Type property corresponds to the actual type of the stored procedure parameter.

Click Next to proceed to the next wizard page. If you have added more than one stored procedures on this page or if the current
Entity Framework model additionally provides data tables, go to the Select a Data Member page.



Select a Data MemberSelect a Data Member
On this page, select the required data member from the list of available data members.

Click Next to proceed to the next wizard page: Configure Filters.



Configure FiltersConfigure Filters
This wizard page allows you to define any number of filter criteria for your data source.

The Filter Editor is displayed after choosing an entity on this wizard page.

Use this editor to define the selected entity's filter criteria. The filter string can also reference report parameters.



Connect to an Object Data SourceConnect to an Object Data Source
The topics in this section describe the steps required to connect a report to an object data source.

This task includes the following steps.

Select an Assembly
Select a Data Source Type
Select a Data Source Member
Specify the Member Parameters
Select the Data Binding Mode
Select a Data Source Constructor
Specify the Constructor Parameters



Select an AssemblySelect an Assembly
On this page, select an assembly that contains the class type definition of the data source. To exclude irrelevant assemblies from
the list, select the Show only highlighted assemblies check box.

Click Next to proceed to the next wizard page: Select a Data Source Type.



Select a Data Source TypeSelect a Data Source Type
On this wizard page, select a required data source type. To exclude irrelevant classes from the list, select the Show only
highlighted classes check box.

Click Next to proceed to the next wizard page: Select a Data Source Member.



Select a Data Source MemberSelect a Data Source Member
On this wizard page, specify whether you want to bind to the entire object or to its public member (method or property). To
exclude irrelevant members from the list of available members, select the Show only highlighted members check box.

Click Next to proceed to the next wizard page depending on the selected option.

Specify the Member Parameters
Select the Data Binding Mode



Specify the Member ParametersSpecify the Member Parameters
On this wizard page, specify the member parameters.

To specify the member parameter's value, use the Value column. Enable the check box in the Expression column to make it
possible to specify the parameter expression using the Expression Editor. In this case, you can pass an existing report parameter
to the member or even create a new report parameter using the in-place editor.

Click Next to proceed to the next wizard page: Select the Data Binding Mode.



Select the Data Binding ModeSelect the Data Binding Mode
On this wizard page, you can choose one of the following two binding modes.

Retrieve the data source schema - Select this option to retrieve only the data source schema from the specified object
and edit the report layout without having access to the actual underlying data.
Retrieve the actual data - Select this option to automatically create an instance of the data source type and obtain its
actual data.



Select a Data Source ConstructorSelect a Data Source Constructor
On this page, select one of the available data source constructors. To exclude irrelevant constructors from the list, select the Show
only highlighted constructors check box.

Click Next to proceed to the next wizard page: Specify the Constructor Parameters.



Specify the Constructor ParametersSpecify the Constructor Parameters
On this wizard page, specify the constructor parameters.

To specify the constructor parameter's value, use the Value column. Enable the check box in the Expression column to make it
possible to specify the parameter expression using the Expression Editor. In this case, you can pass an existing report parameter
to the constructor or even create a new report parameter using the in-place editor.



Connect to an Excel Data SourceConnect to an Excel Data Source
The topics in this section describe the steps required to connect a report to an Excel data source.

This task includes the following steps.

Select an Excel Workbook or CSV File
Specify Import Settings
Select a Worksheet, Table or Named Range
Choose Columns



Select an Excel Workbook or CSV fileSelect an Excel Workbook or CSV file
On this wizard page, select a required Microsoft Excel Workbook (the XLS, XLSX and XLSM formats are supported) or CSV file. To
do this, click the ellipsis button and locate the source file or enter the full path to this file.

Click Next to proceed to the next wizard page: Specify Import Settings.



Specify Import SettingsSpecify Import Settings
On this wizard page, you can specify required import settings. This page provides access to different settings depending on
whether you have selected an Excel Workbook or CSV file.

Import Settings for an Excel Workbook
The following settings are available if an Excel workbook has been selected.

Use values of the first rows as field names - Specifies whether values of the first row should be imported as field names.
If this option is disabled, values of the first row will be imported as data and field names will be generated automatically.
Skip empty rows - Specifies whether or not to include empty rows to the resulting data source.
Skip hidden rows - Specifies whether or not to include hidden rows to the resulting data source.
Skip hidden columns - Specifies whether or not to include hidden columns to the resulting data source.

Click Next to proceed to the next wizard page: Select a Worksheet, Table or Named Region.

Import Settings for a CSV file
The following settings are available if a CSV file has been selected.



Use values of the first rows as field names - Specifies whether or not values of the first row should be imported as field
names. If this option is disabled, values of the first row will be imported as data and field names will be generated
automatically.
Skip empty rows - Specifies whether or not to include empty rows to the resulting data source.
Trim Blanks - Specifies whether or not to delete all leading and trailing empty spaces from each value in the source CSV
file.
Encoding - Specifies the character encoding in the source CSV file. If the corresponding Detect automatically check box
is enabled, this setting's value is automatically determined.
Newline type - Specifies the line break type in the source CSV file. If the corresponding Detect automatically check box
is enabled, this setting's value is automatically determined.
Value separator - Specifies a character used to separate values in the source CSV file. If the corresponding Detect
automatically check box is enabled, this setting's value is automatically determined.
Culture - Specifies culture information used to import data from the source CSV file.
Text Qualifier - Specifies the character that encloses values in the source CSV file.

Click Next to proceed to the next wizard page: Choose Columns.



Select a Worksheet, Table or Named RegionSelect a Worksheet, Table or Named Region
On this wizard page, select one of the available worksheets, tables or named regions.

Click Next to proceed to the next wizard page: Choose Columns.



Choose ColumnsChoose Columns
On this wizard page, you can select required columns and specify their settings.

To select a column, enable the corresponding Selected check box. Use Name to specify the custom column name and Type to
choose the column type.

This page also allows you to preview resulting data by clicking the Preview... button.



Connect to a JSON Data SourceConnect to a JSON Data Source
The topics in this section describe the steps required to connect a report to JSON-formatted data.

This task includes the following steps:

Specify JSON Data Location
Specify Request Parameters
Select Data Fields
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The Report Designer's Data Source Wizard provides the JSON option if the application has a reference to the open-source
Newtonsoft.Json library.



Specify JSON Data LocationSpecify JSON Data Location
This wizard page allows you to specify the location of the JSON-formatted data:

Web Service Endpoint URI

File Name



String with JSON Content



Specify Request ParametersSpecify Request Parameters
This page allows you to specify request parameters for the Web Service Endpoint you specified on the previous page.

You can use this page to provide authentication parameters for the requested JSON data.
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This page is available when an end user chooses the Web Service Endpoint option on the Specify JSON Data Location page.



Select Data FieldsSelect Data Fields
On this page, the wizard shows the specified JSON data's structure. You can choose all nodes or a subset of nodes.

Uncheck the data fields that your report does not require.

You can rename data fields if necessary.



Connect to an XPO Data SourceConnect to an XPO Data Source
The topics in this section describe the steps required to connect a report to XPO data.

This task includes the following steps:

Choose an Entity Type
Select a Data Connection
Specify a Connection String
Save the Connection String



Choose an Entity TypeChoose an Entity Type
This wizard page lists your application project's persistent object classes. Choose one entity type and proceed to the next page.



Select a Data ConnectionSelect a Data Connection
On this page, specify whether you want to use an existing data connection or create a new data connection.

Click Next to proceed to the next wizard page, depending on the selected option.

Specify a Connection String
Save the Connection String



Specify a Connection StringSpecify a Connection String
This page allows you to specify connection string parameters or define a custom connection string.

The following data source types are supported.

Amazon Redshift
Firebird
Google BigQuery
IBM DB2
Microsoft Access 2007
Microsoft Access 97
Microsoft SQL Server
Microsoft SQL Server Compact Edition
MySQL
Oracle
Pervasive PSQL
PostgreSQL
SAP Sybase Advantage
SAP Sybase ASE
SAP Sybase SQL Anywhere
SQLite
Teradata
VistaDB
VistaDB5
XML file

Depending on the data provider selected, it may be necessary to specify additional connection options (such as authentication
type and database name) on this page.

Click Next to proceed to the next wizard page.

Define a Custom Connection String
Select Custom connection string and specify the connection string.



Use the XpoProvider parameter to identify a data source provider. For example, XpoProvider=MSSqlServer;Data Source=
(local);User ID=username;Password=password;Initial Catalog=database;Persist Security Info=true

Click Next to proceed to the next wizard page: Save the Connection String.



Save the Connection StringSave the Connection String
On this page, select whether or not to save the created connection string to the application's configuration file.

If the data connection uses server authentication, you can also choose to save the user credentials along with the connection
string.



Connect to a Federated Data SourceConnect to a Federated Data Source
�� N o t eN o t e

This data source type is available in the Data Source Wizard only if a report contains at least one data source.

Choose Data Federation to combine multiple data sources and specify unions, joins or master-detail relationships between data
source queries.

Click Next to go to the Create a Federated Query page.



Create a Federated QueryCreate a Federated Query
On this wizard page, you can create federated queries based on data from other data sources.

Note that initial data sources can contain data at the root level (e.g., an Excel data source) or have one or more queries (e.g., a SQL
data source).

Include Data into Separate Queries
Enable check boxes for data fields, queries and/or entire data sources.

The selected items are included in data federation as separate queries based on initial data source queries.

The wizard specifies query names as follows:

If the initial data source contains one or more queries (such as in a SQL data source), the federated query name consists of
the data source name and query name separated by an underscore.
If the initial data source contains data at the root level (such as in an Excel data source), federated query name is equivalent
to the data source name.

Combine Data into a Single Query
To combine data from multiple data sources into a single query, click Add Query.



This invokes the Query Builder adapted to federated data sources. Specify the query type.

Join

Drag and drop items onto the design surface, and specify join relationships in the Join Editor.

Enable check boxes for the data fields you want to include in the query result set.



Union and Union All

Double-click the data sources you want to combine into a single query. The query includes only fields that have identical
names and types in the origin sources.

Rename fields.

 T i pT i p

When you use the Union mode, duplicate data from the origin data sources is removed from the query result set. Use the
Union All mode to include all data.



The created query appears on the wizard page in the Federated Queries category. The federated query's default name is
equivalent to the main table name.

You can click the  button to customize the query or the  button to remove the query.

Once you finish the wizard, it creates a federated data source that includes a single query.

Specify Master-Detail Relationships
Click Manage Relations to define master-detail relationships between two or more queries.

In the invoked editor, drag and drop the key field from the master query to the detail query.



Once the wizard is complete, you can see the master-detail hierarchy in the Field List.



No DataNo Data
Choose No Data not to bind to a data source.



Query BuilderQuery Builder
The Query Builder provides a visual interface for constructing SQL queries used to access database tables and views.

�� N o t eN o t e

The Query Builder is not available for object, Entity Framework and Excel data sources.

Run the Query Builder
You can invoke the Query Builder from the query customization page of the Report Wizard. On this page, click the  button for
the Queries category to create a new query using the Query Builder.

You can use the Query Builder to add queries to an existing SQL data source, as well as to edit existing queries. To do this, right-
click the data source in the Report Explorer or Field List, and select Manage Queries... in the context menu.



In the invoked Manage Queries dialog, click Add to add a new query. To edit an existing query, click the ellipsis button for it.

Finally, click the Run Query Builder... button in the invoked Query Editor.

Select Tables
You can add a specific data table or view to a query by dragging the corresponding item from the list of available tables and
dropping it onto the list of data tables to be used.



Enable check boxes for the table fields that you want to include in the query result set.

Each table provides the context menu, which allows you to rename the table or remove it from the query.

Click the list of available tables on the left and press CTRL+F to search for a specific table or view.



Join Tables
You can join multiple tables within the same query. The Query Builder automatically highlights tables related to any of the
previously added tables. Drag-and-drop a subordinate table in the same way you added a main table to include it in a query and
automatically create an inner join relation based on a key column.

Alternatively, you can join tables by clicking the plus button  in a row corresponding to a key column.

You can customize the relationship by right-clicking it on the diagram and selecting Edit Relation in the invoked context menu.
Use the Join Editor to select the join type (Left Outer or Inner), apply a logical operator (Equals to, Is less than, etc.) and
column key fields.

A left outer join returns an inner join’s values, along with all the values in the "left" table that do not match the "right" table,
including rows with NULL (empty) values in the key field.



When the left outer join is selected, the relationship line displays an arrow pointing to the "right" table.

You can manually join tables if they do not have a relationship at the database level. In this case, when you drag-and-drop a table
onto the list of tables, the Join Editor is automatically invoked allowing you to construct a custom join relationship.

After executing the query, it returns a "flat" table composed of data records selected based on the specified join options.

�� N o t eN o t e

Although joining different tables within a single query may be required in some scenarios, creating hierarchical data sources
generally results in better performance (in general, master-detail reports are generated faster than similar-looking reports created
by grouping "flat" data sources).

Edit Parameters
Click the Edit Parameters button to invoke the Query Parameters dialog, which allows you to add and remove query
parameters as well as specify parameter settings.

For each query parameter, the following properties are available.

Name - specifies the name used to refer a parameter.
Type - specifies the data type of the parameter's value.
Expression - determines whether the actual parameter value is static or generated dynamically.
Value - specifies the actual value of a query parameter. If the Expression option is enabled, the actual parameter value is
produced dynamically by calculating an associated expression, which is particularly useful when you need to map the query
parameter value to the value of a report parameter.

The created parameters will be then available on the Configure Query Parameters wizard page.

For general information on query parameters and ways of providing parameter values, see Query Parameters.



Filter Data
To specify filter criteria, click the Filter... button in the Query Builder. This invokes the Filter Editor, which provides the following
capabilities.

Filter Tab

The editor contains the Filter tab allowing you to specify filter conditions for resulting data. Filter criteria can be assigned
query parameters or bound to report parameters.

Group Filter Tab

The Group Filter tab allows you to specify filter conditions for grouped and aggregated data. If data is not grouped, the
second tab is disabled.

Other Options

Using this editor, you can limit the number of resulting data rows. If data is sorted, you can specify how many rows to skip
before retrieving the specified number of rows.

�� N o t eN o t e

Depending on the selected data provider, it can be impossible to take into account the skip setting in the provider-specific
SQL string.

Another option enables you to include only distinct values into the resulting set.

Shape Data
The Query Builder displays the column list under the data source editor, which provides various shaping options:



Column

Specifies the selected column.

You can choose a column from the drop-down list or create a column expression by clicking the corresponding column's
ellipsis button.

Table

Specifies the table containing the selected column.

This option indicates (All Tables) if you created an expression for the corresponding column.

Alias

Specifies a custom column name (alias).

This option is available only for columns that you included in a query.

Output

Specifies whether to include the column in the query's resulting set.

Sorting Type

Specifies whether to preserve the original data record order within the column or sort them (ascending or descending).

�� N o t eN o t e

When binding to XML files, the Query Builder does not support sorting by aggregate functions, DISTINCT and SELECT ALL
statements, and custom SQL.

Sort Order

This option becomes available after applying sorting to the data column records.

It defines the priority in which sorting is applied to multiple columns (a lower number has a higher priority).

For example, if column A has the sort order set to 1 and column B has it set to 2, the query is first sorted by column A and
then by the column B.

Changing this setting for one column automatically updates other columns’ sorting order to avoid conflicting priorities.



Group By

Specifies whether to group the query's resulting set by this column.

Aggregate

Specifies whether to aggregate the column's data records.

The following aggregate functions are supported:

Count
Max
Min
Avg
Sum
CountDistinct
AvgDistinct

SumDistinct

Applying any of these functions to a column discards individual data records from the query result set, which only
includes the aggregate function result.
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You should apply aggregation/grouping to either all columns or none of them.

Preview Results
You can preview the query execution's result in a tabular form by clicking the Preview Results button.

This opens the Data Preview window displaying the query result set (limited to the first 1000 data records).



Control ToolboxControl Toolbox
The Control Toolbox lists all available controls and allows you to add them to your report.

Available Controls
The available report controls can be divided into the following categories:

G eneral ContentG eneral Content

The following controls are most commonly used to display data in a report.

Bar Code Check Box Gauge Label Character Comb Picture Box Rich Text Table

Extended D ataExtended D ata

The following controls are connected to data individually, without accessing a report's data source.

Chart Pivot Grid Sparkline

Repor t LayoutRepor t Layout

The following controls allow you to draw shapes in a report and customize the report layout.

Cross-Band Line Cross-Band Box Line Page Break Panel Shape Subreport

D ocument S tat ist icsD ocument S tat ist ics

The dynamic content of the following controls is not obtained from a data source.

Page Info Table of Contents



Add a Control to a Report
To add a control from the Toolbox, do one of the following.

Double-click an item in the Toolbox for the appropriate control, which will be created at the Detail band's top left corner.

Drag and drop an item from the Toolbox onto the required location within a report.

Select an item in the Toolbox, and then click the required location within a report.

Select an item in the Toolbox, and then indicate the bounding rectangle by holding the left mouse button.

Select the  Pointer item when you need to perform selection, re-positioning or resizing operations. It is automatically selected
after you drop a control onto a report.



ToolbarToolbar
The Report Designer Toolbar includes the Home, Layout, Page, and View tabs for general commands as well as contextual tabs
for commands relating to the selected report controls.

Home Tab

Use commands in this tab to

add new reports, load and save report layouts;
add data sources, calculated fields, and report parameters;
delete the selected report elements, place them on the clipboard and paste them onto report bands;
customize font, color, formatting and alignment settings;
create new styles based on the selected control's appearance settings and then apply the created styles to other controls.

Layout Tab

This tab provides commands that

align report elements to each other or the snap grid;
change the report element size relative to other report elements and to fit the snap grid or the parent container;
change the stacked elements' order;
select the snapping mode.

Page Tab

These commands allow you to

set the page margins, orientation, and paper size;
specify the page's background color;
add watermark text to a report or turn a picture into a report's background.

View Tab



This tab enables you to

turn on/off export and printing warnings to highlight intersecting controls and controls placed outside page margins;
display the document's watermark on the design surface;
specify whether to draw the snap grid;
zoom the design surface;
manage the Report Designer panels' visibility.

Contextual Tabs
Contextual tabs are visible whenever you select a specific report element and provide commands applicable to the selected
element's type.

The following image demonstrates the table cell's available tabs:



UI PanelsUI Panels
The Report Designer includes the following panels:

Report Explorer
Field List
Report Gallery
Property Grid
Group and Sort Panel



Report ExplorerReport Explorer
The Report Explorer shows a report structure in a tree-like form and provides access to components assigned to a report (such
as its data sources).

Report Bands and Controls
Bands and controls are listed in a hierarchical tree-like structure.

Select an element and invoke the context menu to access the available actions.

Select an element and navigate to the Property Grid to edit the element's options.



Data-bound controls are marked with a yellow database icon.

Drag elements to change their location.

Check the following topics for more information on how to manipulate report elements:

Manipulate Bands
Manipulate Report Controls
Manipulate Table Elements

Report Styles
Drop a style onto a report element. This applies the selected style to the element.



You can select all report elements with a specific style.

Report Components
The Components node lists all data sources configured for the report. Right-click a data source to customize its settings or add it
to the Report Gallery.



Field ListField List
This panel displays the schema of a report's data sources. You can right-click a data source item to access its settings. For
example, you can add a data source to the Report Gallery to later re-use it in other reports.

The Field List enables you to perform the following actions.

Bind controls to data
Dropping a field onto a report's surface creates a new report control bound to a corresponding field.

Dropping a field onto an existing control binds this control to a corresponding field.

You can preserve data bindings of an existing control by holding down the CTRL key when dropping a data field on this control.
This creates a new report control on top of the existing control.



Create specific controls
To create a data-bound control of a specific type, do any of the following:

Hold down the SHIFT key and drop a data field onto a report's surface.
Right-click a corresponding data field and drop it onto a report's surface.

This invokes a context menu enabling you to select which control to create.

Create tables
Dropping an entire data table onto a report creates a table with its columns bound to fields contained in the data table.

To select multiple fields, click them with holding the CTRL or SHIFT key. Dropping these fields onto a report creates a new table
with its cells bound to the corresponding fields.

To create column headers, right-click the required fields with holding the CTRL or SHIFT key and drop them onto a report surface.



This creates a new table with its cells displaying the field names.

Data shaping operations
In addition, the Field List can help you solve the following tasks:

Add calculated fields to data columns for performing various calculations in a report.

Manage the collection of report parameters.



Report GalleryReport Gallery
The Report Gallery allows you to store and reuse reports and their elements.

Do not confuse the Report Gallery with the Report Explorer that has a similar user interface. The Report Gallery stores shared
templates. The Report Explorer displays the current report structure.

Reports
The Report Gallery displays report layout templates in the Reports category.

To create a new template, right-click an empty area around the design surface and select Add To Gallery in the context menu.
The report's Name property value defines the template name.

Do one of the following to apply a template to the current report:

Right-click the template in the Report Gallery and select Apply Layout to Report.



Drag and drop the template from the Report Gallery onto the report.

The following dialog warns you that the template overrides the current layout:

When you apply the report template, all the associated styles and components are added to the current report as well.

Bands
The Report Gallery's Bands category contains band templates.

To create a new template, right-click a report band and choose Add To Gallery in the context menu. The band's Name property
value defines the template name.

Use the following ways to apply a band template:

Drag and Drop

Drag and drop the template from the Report Gallery onto the band of the same type to replace the band's content.



To create a new band, move the mouse cursor to the delimiter between bands and drop the template.

You can always create new Detail Report bands and Group Headers/Footers. You can add the Report Header/Footer or Page
Header/Footer only if the report does not contain this band.

Gallery Context Menu

Right-click a template in the Report Gallery and choose Apply Layout to Band in the context menu.

This action's behavior depends on the template's band type and the selected report band.

TEMPL ATE' S  B AND  T YPE ACTION R ES U LT

Detail Band, Vertical Detail Band, Top Margin,
Bottom Margin

Replaces the corresponding band's content independently from the
selected band type.

Group Header, Group Footer, Detail Report Band If the same band is selected in the report, replaces the band's content.
Otherwise, adds a new band to the deepest hierarchy level.

Report Header, Report Footer, Page Header, Page
Footer, Vertical Header, Vertical Footer

If the same band exists in the report, replaces the band's content.
Otherwise, adds a new band.

Note that the template stores settings related to the band and its controls (binding information, appearance options, etc). All these



settings are restored when you apply the template.

Controls
You can combine report controls from the same band into a template. Hold down SHIFT or CTRL and select controls. Then, right-
click the selection and choose Add To Gallery in the context menu.

This adds a new template to the Controls section. The template name consists of control names separated by commas.

To apply a control template, drag and drop it from the Report Gallery onto a band.

All the control settings are restored when you apply the template.

Styles
Right-click a style in the Report Explorer and select Add To Gallery to create a new template in the Styles category.



Use the following ways to apply a style template:

To add the style to the report's style sheet, right-click the style in the Report Gallery and select Add to Report Style Sheet.

You can also use the same action in the Styles node's context menu to add all the styles available in the Report Gallery.

To apply the style to a specific report control, drag and drop this style from the Report Gallery onto this control. This also
adds the selected style to the report style sheet if it does not already contain this style.

Components
Right-click a data source in the Report Explorer and select Add To Gallery to create a new template in the Components
category.



Do one of the following to apply a data source template:

Right-click the template in the Report Gallery and select Add to Report Components in the context menu.

Drag and drop the template from the Report Gallery onto the report.

Rename Templates
To change the template name, select Rename in the template's context menu and type a new name.

Group Templates
Right-click a root Gallery node and select Add New Folder in the context menu.



Specify the folder name. Move templates to this folder to combine them into a group.

Import and Export Templates
You can import gallery items from an XML file. Right-click the Import toolbar button, locate a file in the invoked Open dialog and
click OK.

To save gallery templates to an XML file, click the Export toolbar button and select a target file in the Save dialog.



Property Grid (Tabbed View)Property Grid (Tabbed View)
The Property Grid allows you to access and customize report/report element settings.

See the Property Grid (Non-Tabbed View) topic if your Property Grid does not display tabs.

Select a Report Element
Perform one of the following actions to select an element and show its properties in the Property Grid:

Select an element in the drop-down list at the top of the Property Grid.



Click an element in the design surface.

Select an element in the Report Explorer.

Property Grid Tabs
The Property Grid displays properties in tabs. The active tab is activated at the application's next start.

Favorite Properties
The Favorites tab displays favorite or most frequently used properties.



Click the Edit Favorite Property List context menu item to set up the favorite properties. Enable check boxes for the controls'
properties in the invoked Favorite Properties Editor to include these properties into the favorite list.

Change Property Values
The Property Grid adds a green property marker to properties if their default value changes.



Right-click a property's editor to reset the value.

Set Color Properties
You can use the Magnifier to set color properties.



Do the following to use the Magnifier:

Click the Magnifier button.

Move the invoked Magnifier on the screen to find the color you want to set.

You can use the Magnifier to zoom out. Use one of the following options to do this:

Hold Ctrl and press + / -
Scroll the mouse wheel

Click to set the color property to the selected color.



Right click or press Esc to cancel the Magnifier mode.

Specify Expressions
If expression bindings are enabled, the Property Grid allows you to specify expressions that can include two or more data fields
and various functions. Click a property's marker to see whether the invoked context menu has the PropertyName Expression
item.

Click this item to specify an expression in the invoked Expression Editor.



The Property Grid highlights properties that have an assigned expression.

Click a property's marker and choose Reset to reset the property value.

�� N o t eN o t e

The Reset command resets both the expression and the value you specified using the property editor.

Search Properties
The Property Grid's search box allows you to search for a property. When you type within the search box, the Property Grid
automatically creates a search criteria based on the entered text and filters the list of available properties.





Property Grid (Non-Tabbed View)Property Grid (Non-Tabbed View)
The Property Grid allows you to access and customize report/report element settings.

See the Property Grid (Tabbed View) topic if your Property Grid arranges properties in tabs.

Select a Report Element
Perform one of the following actions to select an element and show its properties in the Property Grid:

Select an element in the drop-down list at the top of the Property Grid.



Click an element in the design surface.

Select an element in the Report Explorer.

Categorized and Alphabetical Modes
You can switch between categorized and alphabetical modes.

In the categorized mode, properties are listed in a tree-like form.

In the alphabetical mode, all properties are displayed in a single list and are sorted alphabetically by name.



Favorite Properties
The Favorites tab displays favorite or most frequently used properties.

Click the Edit Favorite Property List context menu item to set up the favorite properties. Enable check boxes for the controls'
properties in the invoked Favorite Properties Editor to include these properties into the favorite list.



Change Property Values
The Property Grid adds a green property marker to properties if their default value changes.

Right-click a property's editor to reset the value.



Set Color Properties
You can use the Magnifier to set color properties.

Do the following to use the Magnifier:

Click the Magnifier button.

Move the invoked Magnifier on the screen to find the color you want to set.



You can use the Magnifier to zoom out. Use one of the following options to do this:

Hold Ctrl and press + / -
Scroll the mouse wheel

Click to set the color property to the selected color.

Right click or press Esc to cancel the Magnifier mode.

Specify Expressions
If expression bindings are enabled, the Property Grid allows you to specify expressions that can include two or more data fields
and various functions. Click a property's marker to see whether the invoked context menu has the PropertyName Expression
item.



Click this item to specify an expression in the invoked Expression Editor.

The Property Grid highlights properties that have an assigned expression.

Click a property's marker and choose Reset to reset the property value.
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The Reset command resets both the expression and the value you specified using the property editor.

Search Properties
The Property Grid's search box allows you to search for a property. When you type within the search box, the Property Grid
automatically creates a search criteria based on the entered text and filters the list of available properties.



Group and Sort PanelGroup and Sort Panel
The Group and Sort Panel allows you to quickly apply grouping and sorting to your report data.

To create a new grouping or sorting criterion, simply click Add a Group or Add a Sort.

Then, to control whether the corresponding Group Header or Footer band should be displayed, use the Show Header and Show
Footer check boxes.

The Sort Order drop-down list allows you to specify a sorting mode (ascending or descending) or disable sorting.

You can change the order in which multiple grouping and sorting criteria are to be performed, using the Move Up and Move
Down buttons.

To remove a grouping or sorting criterion, select it, and click Delete.

�� N o t eN o t e

If the Group and Sort Panel is hidden, you can enable it To do this, select in the Windows | Group and Sort on the Toolbar's
View page.



Report Designer for WPFReport Designer for WPF
This guide contains information about the basic principles of creating reports with the Report Designer.

The Report Designer allows you to create new reports from scratch, bind them to data and fully customize them. In addition to
report editing capabilities, it allows you to display a report's Print Preview, send its outputs to a printer or export it to various
formats.

Different aspects of using the Report Designer are covered in the following documentation sections.

Creating Reports

The tutorials in this section provide step-by-step instructions on both basic and advanced report customization.

Report Types

The documents in this section describe how to create reports of different types with the Report Designer.

Report Elements

The topics in this section provide information about report controls and bands used in the Report Designer.

Interface Elements

The documents in this section are dedicated to the elements of the Report Designer user interface.

Report Wizard

This documentation section describes the Report Wizard, which allows you to create reports based on built-in templates.

Document Preview



The topics in this section describe the capabilities provided by the Print Preview.



Report TypesReport Types
The tutorials in this section provide detailed instructions on how to create reports of different types with the Report Designer.

Static Report
Table Report
Label Report
Multi-Column Report
Master-Detail Report
Cross-Tab Report
Parametrized Report
Chart with Static Series
Chart with Dynamic Series



Static ReportStatic Report
This tutorial describes the steps needed to create a static report, which means that the report is not bound to a data source. This
example demonstrates how to create a report with the one-page content repeated 20 times.

To create a static report, do the following.

1. Create a new report.

2. Drop the Rich Text control from the Toolbox onto the Detail band.

3. Right-click the created control and select Load File... in the invoked context menu.

4. In the invoked dialog, use the drop-down list to define the file's extension (.rtf, .docx, .txt, .htm or .html), select the file, and
click Open.

5. Select the report, and in the Properties Panel, expand the Report Print Options property. Make sure that the Print when
Data Source is Empty option is enabled, i.e., the report is allowed to be printed when it has no data source. To repeat the
created report 20 times, set the Detail Count when Data Source is Empty property to 20.

6. To print the report content on separate pages, set the band's Page Break property to After the Band.



The static report is now ready. Switch to the Print Preview tab and view the result.



Table ReportTable Report
This tutorial describes how to create a table report, which means that the report's data is arranged into a table-like layout. This
feature should not be confused with the master-detail report or cross-tab report.

To create a table report, follow the steps below.

1. Create a new report and bind it to a data source.

2. To add a Page Header to the report, right-click on the report's surface, and in the invoked context menu, select Insert Band
and then Page Header.

3. Next, add two Table controls to the report's Page Header and Detail band.

To do this, drag the Table control from the Toolbox and drop it onto the Page Header Band. Then, add a table to the Detail
band in the same way.

One table will be used as a header, and the other one - for the report's detail information.

4. Type the headers into the upper table's cells. Then, bind the corresponding cells in the detail section to the appropriate data
fields by expanding the Data Bindings option and setting the Text property.



5. Finally, you can customize various properties of the tables to improve their appearance. For example, in the Properties
Panel, you can define the Borders property, as well as the Background Color property. To customize cell text options,
specify the Font property.

A noteworthy feature is the capability to specify odd and even styles for the detail table.

The table report is now ready. Switch to the Print Preview tab, and view the result.



Label ReportLabel Report
This tutorial describes the steps required to create a label report containing employee badges.

To accomplish this task, do the following.

1. Click the New button on the Toolbar or the plus button next to the report tab headers to create a new report.
2. The invoked Report Wizard will guide you through the process of creating a label report. For detailed instructions on wizard

steps, refer to Label Report.

3. After performing the above steps you will see that the report's Detail band is divided into three different areas. The first area
at the left-hand side indicates the actual available band area for controls to be placed within it. The gray area at the right-
hand side is intended for the columns in which labels will be displayed, so it cannot be occupied by controls. Finally, the
white area specifies an indent between the available and reserved areas.

4. Bind a report to a data source containing information about employees.

5. Then, drop the required fields from the Field List onto the available Detail band's area, and adjust the layout.

The label report is now ready. Switch your report to the Print Preview tab and view the result.





Multi-Column ReportMulti-Column Report
This tutorial describes the steps to create a multi-column report, meaning that each page of the report document is laid out in a
specified number of columns.

To demonstrate the multi-column feature, use a report with grouping, similar to the one created in the following tutorial:
Grouping Data.

1. Select the Detail band, and in the Properties Panel, expand the Multi-Column Options section.

Set the required Mode, which determines whether the number of columns is manually specified or if it depends on the
fixed column width.

2. Then, if you've chosen to Use Column Count, set the Column Count to 2, and Column Spacing to 10.

The Layout property determines the order in which records of the same group are processed.

3. Now, on the Detail band's surface, a gray area appears, delimiting the available column's width. Adjust the control width, so
that they fit within the effective borders.

The multi-column report is now ready. Switch to the Print Preview tab and view the result.





Master-Detail ReportMaster-Detail Report
A report is usually called Master-Detail if it is used to display data from a hierarchical data source.

There are two main approaches for creating a master-detail report. The first approach is based on using the Detail Report band.
The second approach is to create two different reports and incorporate the detail report into the master report as a subreport.

To see a detailed step-by-step demonstration of how detail report bands and subreports are used to create a master-detail report,
refer to the following tutorials.

Master-Detail Report (Detail Report Bands)
Master-Detail Report (Subreports)



Master-Detail Report (Detail Report Bands)Master-Detail Report (Detail Report Bands)
This tutorial describes the steps needed to create a master-detail report with hierarchically linked data using the Detail Report
band. For an alternative approach, refer to Master-Detail Report (Subreports).

To start with this tutorial, create a new report and bind it to a data source. For this tutorial, in the Report Wizard, select the table
that will be used as the principal table in the master-detail relation.

The topic consists of the following sections.

Provide a Report Data Source with a Master-Detail Relation
Design a Master-Detail Report
View the Result

Provide a Report Data Source with a Master-Detail Relation
This section of the tutorial describes how to provide an SQL data source with a master-detail relation. If you are using an Entity
Framework data source that contains data members with master-detail relations between them, the existing relations will be used
automatically. In this case, you can skip this section of the tutorial and proceed to the next section: Design a Master-Detail Report.

To add a master-detail relation to an SQL data source, do the following.

1. Add a detail table to the report data source. To do this, right-click the data source in the Report Explorer, and select Manage
Queries... in the invoked context menu.

2. In the invoked Manage Queries dialog, click Add.

3. Then, in the invoked Data Source Wizard, click Run Query Builder....



4. Add the detail table to the query and click OK.

5. Click Finish to exit the Data Source Wizard. Then, click OK to exit the Manage Queries dialog.

6. Next, specify the relation between the data source tables. To do this, right-click the data source in the Report Explorer, and
select Manage Relations... in the invoked context menu.



7. In the invoked Master-Detail Relation Editor, click the plus button next to the master query to add a new relation. Specify
a relation condition as shown in the following image and click OK to exit the dialog.

8. The Field List will be updated to reflect the added relation.

Design a Master-Detail Report
To create the layout of a master-detail report, do the following.

1. Allocate parts of a master report on the report's Detail band.

 

For the master report to be generated properly, the report's Data Member should be set to the master query. If you added
the master query first, this property is set to the required value automatically. Otherwise, you should manually specify the
data member (for instance, in the Properties Panel).



2. To add a detail report band, right-click anywhere on the report's surface, and in the invoked context menu, select Insert
Detail Report. When the report's data source contains a data relationship, it is displayed in the context menu.

3. Then, drop the required data fields from the Field List onto the Detail Report band.

Note that you should drop items from the relation node (in this example it is the CategoriesProducts section) for the detail
report to be generated correctly.

View the Result
The master-detail report is now ready. Switch to the Print Preview tab and view the result.





Master-Detail Report (Subreports)Master-Detail Report (Subreports)
This tutorial describes the steps needed to create a master-detail report with hierarchically linked data using the Subreport
control. For an alternative approach, refer to Master-Detail Report (Detail Report Bands).

To create a master-detail report using the subreport controls, do the following.

Create a Master Report
Create and Customize a Detail Report
Embed the Subreport
Get the Result

Create a Master Report
1. Create a new report and bind it to a data source. This report will be used as the master report.

2. Drop the required fields from the Field List panel onto the Detail band. In this example, the following report layout is used.

3. Drag the Subreport control from the Toolbox and drop it onto the Detail band.

Create and Customize the Detail Report
1. Next, add one more blank report and bind it to the same data source. It will be used as a detail report.

2. Drop the required fields from the Field List panel onto the Detail band. This tutorial uses the following layout for the detail
report.

3. To add a parameter to the report, right-click the Parameters section in the Field List and choose Add Parameter in the
invoked context menu.



4. In the invoked Add New Parameter dialog, specify its options as shown in the image below.

5. Select Edit... in the report's context menu. Then, in the Edit dialog, click the ellipsis button for the Filter String property.

In the invoked Filter String Editor, construct an expression where the Category ID data field is compared to the CatID
parameter. To access the parameter, click the icon on the right until it turns into a question mark.



6. To save the detail report, click the Save As  button in the Toolbar. Then, in the invoked standard Save dialog, specify the
folder and file name.

Embed the Subreport
1. Next, switch back to the master report. Right-click the subreport and select Edit... in the invoked context menu. In the Edit

dialog, click the ellipsis button for the Report Source URL property and select the previously saved detail report.

2. Then, bind the subreport's CatID parameter used as a filtering criterion to the master report's CategoryID data field, which
will serve as a source of the parameter value. To do this, select Edit Parameter Bindings... in the subreport's context menu.

This will invoke the Parameter Binding Collection Editor. Click Add to add new binding. In the binding properties list,
specify the data field to which you want to bind a subreport parameter and the name of the parameter that you want to
bind.

Get the Result
The master-detail report is now ready to be generated. You can view the result by switching to the Print Preview tab.





Cross-Tab ReportCross-Tab Report
This tutorial describes the steps needed to create a cross-tab report using the Pivot Grid control. This feature should not be
confused with the master-detail report or table report. Additionally, the document demonstrates how to visualize data displayed
in the Pivot Grid by linking it with the Chart control.

Create a Cross-Tab Report
To create a cross-tab report, do the following.

1. Create a new empty report.

2. Drop the Pivot Grid control from the Toolbox onto the report's Detail band.

3. To bind the Pivot Grid to a data source, right-click it and select Edit... in the context menu. In the invoked dialog, expand the
Data Source drop-down and click the Add New button.

4. The invoked Data Source Wizard will guide you through the process of assigning a data source to the grid. For detailed
instructions on the Wizard's steps, refer to Binding a Report to Data, as this process is similar.

After the data source is created, it is assigned to the pivot grid's Data Source property. Its Data Member property defines
from which table or view of the data source the grid obtains its data.
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Since you have placed a Pivot Grid in the Detail band, the report's Data Source property should not be set. Otherwise, the
Pivot Grid will be repeated at the preview as many times as there are records in the data source.

5. Once again, right-click the Pivot Grid and select Run Designer... in the invoked context menu.

6. In the invoked PivotGrid Designer, click Retrieve Fields.

7. Then, switch to the Layout section in the navigation bar on the left.

Drag and drop the required fields to the Row Fields, Column Fields and Data Items areas.



Click Apply and close the editor.

8. In the last step, you can set your report's Vertical Content Splitting option to Smart. This will split the grid's columns
precisely by their borders in the Print Preview.

The cross-tab report is now ready. Switch to the Print Preview tab and view the result.



Integrate with a Chart Control
The next step is to visualize data displayed in the Pivot Grid using a Chart control. To accomplish this, perform the following steps.

1. Drop the Chart control from the Toolbox onto the report's Detail band below the Pivot Grid. After you drop the Chart, the
Chart Designer is automatically invoked.

2. In the Designer, remove an already existing series by clicking the corresponding button.

3. Then, go to the Data tab at the right of the Designer's window and choose the Pivot Grid in the dedicated drop-down list.

4. After this, all the Chart's binding and layout settings are automatically adjusted. Make sure that Series, Argument and
Value cells have been automatically filled with the corresponding fields. Note, values for these fields are generated based
on the Pivot Grid's columns, rows and data items, respectively.



5. To avoid the overlapping of series labels, select the auto-generated series in the chart elements tree, and in the Options tab,
disable the Labels Visibility check box.

6. If required, you can customize various settings that determine the common behavior for a bridged Chart and Pivot Grid pair.
To do this, use the Chart's Pivot Grid Data Source Options property. This property, in turn, is linked to the Options Chart
Data Source property of the associated Pivot Grid.

7. Finally, reset the report's Vertical Content Splitting option and switch to the Preview Tab to see the result.





Parametrized ReportParametrized Report
This tutorial describes the steps needed to create a report with parameters. In this example, two date-time parameters are created
to filter out orders that don't fall in the specified range from the report.

To create report parameters, follow the steps below.

1. Create a new report and bind it to a data source.

2. In the Field List panel, right-click the Parameters section and in the invoked menu, click Add Parameter.

3. In the invoked Add New Parameter dialog, set the created parameter's Name and Description properties and make sure
to set its Type to an appropriate value. To display this parameter in the Print Preview, enable the Show in the parameters
panel option.

4. To assign a list of values to this report parameter, enable the Supports the collection of standard values option.

In the Dynamic values tab, you can specify a parameter's data source, data member, value member and display member.
The value member defines a data field that provides values to the parameter. The display member defines a data field that
provides display names for parameter values, i.e., how these values appear in the user interface available in a Print Preview.

In the Static values tab, you can manually fill the list of parameter values. Each parameter value has an individual
description specifying how this value appears in the Parameters Panel.



5. Then, repeat the previous steps to create the second parameter, so that every time your report is previewed, you will be
asked to specify two dates.

6. Next, use parameters to filter your report's data. Select report, and in the Properties Panel, click the ellipsis button for the
Filter String property. Then, in the invoked Filter String Editor, construct an expression where a data field is compared
with the created parameters. To access parameters, click the icon on the right until it turns into a question mark.

The Parametrized report is now ready. Switch to the Print Preview tab, define the required values in the Parameters panel and
click Submit.





Chart with Static SeriesChart with Static Series
This document describes how to create a report with a Chart control bound to data, so that a particular series has its own data
source, and other settings. To simplify the example, both series obtain their data from the same data source. However, different
data sources can be used for different series, if necessary.

This example describes how to construct a chart of products and their prices for a chosen category.

To adjust a Chart by manually creating its series, do the following.

1. Create a new blank report.

2. Drop the Chart control from the Toolbox onto the report's Detail band.

After you drop the Chart, the Chart Designer is automatically invoked. At this step, click Cancel to close the Designer, it will
be used later.

3. To bind the Chart to a data source, right-click it and select Edit... in the context menu. Then, in the invoked dialog, expand
the Data Source drop-down and click Add New.

The invoked Data Source Wizard will guide you through the process of assigning a data source to the Chart. For detailed
instructions on the Wizard's steps, refer to Binding a Report to Data, as this process is similar.

After the data source is created, it is assigned to the Chart's Data Source property. Its Data Member property defines from
which table or view of your data source the Chart obtains its data.



�� N o t eN o t e

Since you have placed the Chart in the Detail band, the report's Data Source property should not be set. Otherwise, the
Chart will be repeated at the preview as many times as there are records in the data source.

4. Once again, right-click the Chart and select Run Designer... in the context menu.

5. The invoked Chart Designer already contains one series of the Bar view type. To populate the series with points, select it in
the tree and switch to the Data tab at the right of the designer's window. Choose an existing data source in the dedicated
drop-down list. Then, drag-and-drop the required data fields to the Argument and Value cells to define the coordinates for
series points.



6. Go to the Properties tab to see that the Argument Data Member and Value Data Members settings are automatically
assigned to the corresponding fields.

In addition, you can filter the series data. To do this, click the ellipsis button for the Data Filters property, and in the invoked
dialog, create and adjust the filtering criteria.

To save the changes and quit the dialog, click Close.

7. Create one more series with the same settings, but select the Point view type. To do this, locate the Series element in the
chart elements tree and click the plus button. In the invoked list of series types, select the required type.



8. Finally, to improve your Chart's appearance, you can make the following adjustments.

Remove the Chart's legend as it shows the same data for both series. To do this, select the Legend in the chart
elements tree, and in the Options tab, set the Visibility property to No.
The point labels for Series 1 are unnecessary, so select the Label node under this series and disable the Labels
Visibility check box.

Rotate the X-axis labels for better readability. To do this, select the Axis X item, and in the Properties tab, adjust
settings for labels using the Label property. For instance, set the Angle property to 20 and the Antialiasing property
to Yes.

If required, it is possible to customize many other properties for the Chart, which are not described here.

The chart is now ready. Switch to the Print Preview and view the result.





Chart with Dynamic SeriesChart with Dynamic Series
This document describes how to create a report with a Chart control bound to data, so that all series are auto-created based on a
common template, which specifies universal options for all series. This is possible when data for all series (their names, along with
point arguments and values) is stored in the same data table.

Note that in this scenario, the view type and certain other settings will be the same for all series.

To adjust a Chart with automatically created series, do the following.

1. Create a new empty report.

2. Drop the Chart control from the Toolbox onto the report's Detail band.

After you drop the Chart, the Chart Designer is automatically invoked. At this step, click Cancel to close the Designer, it will
be used later.

3. To bind the Chart to a data source, right-click it and select Edit... in the context menu. Then, in the invoked dialog, expand
the Data Source drop-down and click Add New.

The invoked Data Source Wizard will guide you through the process of assigning a data source to the Chart. For detailed
instructions on the Wizard's steps, refer to Binding a Report to Data, as this process is similar.

After the data source is created, it is assigned to the Chart's Data Source property. Its Data Member property defines from
which table or view of your data source the Chart obtains its data.
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Since you have placed a Chart in the Detail band, the report's Data Source property should not be set. Otherwise, the Chart
will be repeated at the preview as many times as there are records in the data source.

4. Once again, right-click the Chart and select Run Designer... in the context menu.

5. When the chart is added to the report, a new static series is created automatically. In the invoked Chart Designer, remove
this series by clicking the corresponding button.



6. Then, go to the Data tab at the right of the Designer's window. Choose an existing data source in the dedicated drop-down
list and drag-and-drop the required data fields to the corresponding cells.

The Series cell specifies the data field, which should provide data for the series names, so that a new series is created for
each record in that data field. Use the Argument and Value cells to define from where data for point arguments and values
is obtained.

7. Switch to the Properties tab and expand the Series Template option. As you can see, the Argument Data Member and
Value Data Members properties have been automatically assigned to the corresponding data fields. Make sure that the
Argument Scale Type and Value Scale Type properties are set to appropriate values.



8. At this point, the chart's data options are completely defined, so in this step, certain additional customization capabilities are
described.

Adjust the Series Name Template

By default, the name for every auto-created series is obtained directly from an appropriate data field in the bound data
source. However, you can add some text to the beginning or to the end of every series name using the Chart's Series
Name Template property. For instance, set the Begin Text property to "GSP in ".

Customize Series Labels

To avoid the overlapping of series labels, expand the Chart's Series Template property and set the Labels Visibility
property to No.

If required, it is possible to customize many other properties for the Chart, which are not described here.

The chart is now ready. Switch to the Print Preview tab and view the result.





Creating ReportsCreating Reports
With the Report Designer, you can edit existing reports, as well as create your own reports from scratch. The following sections
contain tutorials providing step-by-step instructions on both basic and advanced report customization.

Basic Operations

The topics in this section cover the basics of working with reports in the Report Designer.

Providing Data

The documents in this section describe how to connect reports to various kinds of data sources and provide data to report
elements.

Shaping Data

The topics in this section detail various data shaping tasks that you can perform with your reports.

Appearance Customization

The topics in this section describe how to customize the appearance of a report or any of its elements using specific
appearance options, visual styles and conditional formatting.

Report Navigation and Interactivity

The tutorials in this section cover the navigation-related features of the Report Designer.

Adding Details about a Report

The documents in this section describe how to add technical information about a report to a generated document.

Scripting

This topic provides basic information about scripting and contains an example of using scripts to customize a report.



Basic OperationsBasic Operations
The topics in this section cover the basics of working with reports in the Report Designer.

This section consists of the following topics.

Create a New Report
Change Measurement Units of a Report
Create and Delete Report Elements
Adjust the Layout of Report Elements
Control Positioning
Adjust Page Layout Settings
Back Up the Report Layout



Create a New ReportCreate a New Report
This topic explains how to create a new report in the Report Designer.

To create a new report, do one of the following depending on the Report Designer's View.

In the Classic View, click the New button in the Toolbar.

In the Browser View, click the plus button located inside the tab panel next to report headers.

As a result, the Report Wizard is automatically invoked allowing you to create the required report based on built-in templates.



Change Measurement Units of a ReportChange Measurement Units of a Report
For your report, you can choose its global Measure Units, which can be Hundredths of an Inch, Tenths of a Millimeter or
Pixels.

To specify the Measure Unit property, do one of the following.

Right-click the report and select Edit... in the context menu. In the invoked dialog, set this property to the required value.

Select the report and switch to the Properties Panel. Expand the Measure Units drop-down and select the required value.

This defines the basic measurement unit for all the unit-related options of a report and its bands and controls (such as location,
size, border width, etc.) as well as the measurement unit of the report's Snap Grid.



Create and Delete Report ElementsCreate and Delete Report Elements
This document describes how to add and delete report controls and bands in the Report Designer.

The topic consists of the following sections.

Creating Report Controls
Creating Report Bands
Deleting Controls and Bands

Creating Report Controls
All available controls are listed in the Control Toolbox. To add a control to the currently opened report, you can drag and drop it
onto an appropriate report band.

Report controls of appropriate types are created automatically, after you drag items from the Field List and drop them onto the
report surface.

Creating Report Bands
To add a new band of a particular type, use the context menu of the report or bands. Right-click a report on the design surface or
in the Report Explorer, and select a band to be inserted in the report.



Deleting Controls and Bands
To delete a report control or band, select it on the design surface or Report Explorer, and then do one of the following.

Press the DELETE key.

Right-click the report element, and in the invoked context menu, select Delete.

Click the Delete  button on the Toolbar.

Note that certain elements cannot be deleted (such as the Detail band).



Adjust the Layout of Report ElementsAdjust the Layout of Report Elements
This document describes how to customize the report elements layout and consists of the following sections.

Selecting Report Elements
Moving Report Elements
Resizing Report Elements

Selecting Report Elements
To select a report control or band, click it. To select the next element in the tab order, press TAB. To select the previous element in
the tab order, click SHIFT + TAB.

To select multiple elements, do one of the following.

Click report elements while holding down the CTRL or SHIFT key.

Click on a blank space and drag the mouse to create a selection frame. When the mouse button is released, all controls
within the selection frame's boundaries will be selected. In this case, the previous selection is cleared.

Moving Report Elements
To move a report control, select it and drag to the new location. To move it using the keyboard, press the arrow keys.

You can also move multiple selected report controls in the same way as individual controls.

The report controls can be precisely aligned to each other using the Snap Gird and/or Snap Lines. For details on this, refer to
Control Positioning .

Resizing Report Elements
To resize a control using the mouse, select it and then drag a rectangle drawn on its edge or corner.

You can also select multiple controls and resize them in the same way as individual controls.

To resize a report band, drag its bottom border.





Control PositioningControl Positioning
This document describes how to easily construct professionally looking reports by precisely aligning their elements to each other.
These are useful when creating new reports from scratch or when fixing cluttered report layouts with dozens of randomly
scattered controls.

To select an appropriate alignment mode for report elements, use a report's Snapping Mode.

Snap Grid
When a report is being edited in the Report Designer, it is lined up by the snap grid. This helps to establish the distance between
report elements and align them to each other.

In the Snap to Grid mode, a report control that is being relocated using the mouse or the ARROW keys is automatically aligned
with the nearest grid cell. When resizing the report control, its size is discretely changed by one grid cell. You can temporarily
ignore snapping to the grid when moving and resizing controls. For this, hold down the CTRL key when using the mouse and the
ALT key when using the keyboard.

You can select whether the snap grid should be drawn over a report surface by setting the Draw the Grid option in the Properties
Panel.

You also can adjust the Snap Grid Size, which is measured in the measurement units set for your report.

Snap Lines
If the Snap Lines mode is selected, report elements are aligned using snap lines. These are special guide lines, which appear
around the report control that is being moved or resized and indicate this control's bounds and the distance to other report
elements (controls and bands).



To disable snapping using snap lines for controls being relocated or resized, additionally hold down the ALT key.

Snap Lines and Snap Grid
The Snap to Grid and Snap Lines mode enables snapping to both the snap grid and snap lines.

No Snapping
To disable snapping in your report, set the Snapping Mode property to None. In this case, report controls are moved and
resized by one measurement unit defined by the Report Unit property.



Adjust Page Layout SettingsAdjust Page Layout Settings
In the Report Designer, page settings of a report can be specified in one of two ways. The first approach forces the default printer
settings to be used when the report is printed, while the other one enables you to alter page settings independently.

Using Settings of the Default Printer
For the orientation, margins and paper size, you can specify a requirement that applies the corresponding printer settings instead
of the report's. This may be useful when the report is printed in several places with different printers and printer settings. To do
this, go to the Properties Panel, expand the Using Settings of the Default Printer property and enable required options.

Specify the Report's Page Settings
While designing the report, you can specify the page settings using the Properties Panel.

You can select one the predefined paper sizes or specify a custom paper size. To create your own paper size, set the Paper Kind
property to Custom, and then specify the Page Width and Page Height properties. You can also use the Paper Name property
to select a custom paper that is used in the printer that the document is going to be printed on.

To modify page margins, specify the Margins property. The margin values are expressed in the report's measurement units. In
addition, you can set the page orientation using the Landscape property and specify whether the document is supposed to be
printed on roll paper.



You can also modify the paper size, orientation and margins in the Page Setup dialog, which can be invoked by clicking the Page

Setup  button on the Toolbar.



Back Up the Report LayoutBack Up the Report Layout
To guarantee that you will be able to revert your report to its original state, you can to create a backup copy. Then, you can apply
changes without worrying that it will be hard to restore your report, in case something breaks.

To save a copy of your report, click the Save As button in the Toolbar.

Then, in the invoked standard Save dialog, specify the folder and file name.

To save the current layout of your report, click the Save button in the Toolbar, or press CTRL+S. When you click this button
for the report for the first time, it invokes the Save dialog, which allows you to specify where the report should be saved.
The subsequent clicking of this button for the same report will silently save the report to the previously specified file.

To load a previously saved report, click the Open button in the Toolbar or press CTRL+O. This invokes the standard Open
dialog, which allows you to locate and open report files.



Providing DataProviding Data
The topics in this section describe the basic concepts of providing data for reports and their elements in the Report Designer.

Binding a Report to Data
Binding Report Controls to Data
Using Mail Merge
Report Parameters
Query Parameters
Calculated Fields



Binding a Report to DataBinding a Report to Data
The Report Designer is primarily designed to work with data-aware reports, meaning that a report obtains its general dynamic
data from an external data source.

The documents in this section describe how to connect reports to various kinds of data sources.

Bind a Report to a Database
Bind a Report to an Entity Framework Data Source
Bind a Report to an Object Data Source
Bind a Report to an Excel Data Source



Bind a Report to a DatabaseBind a Report to a Database
This document describes the steps required to connect a report to a database.

To bind a report to a database, do the following.

1. Create a new report.

2. Right-click the report and select Edit... in the context menu. In the invoked dialog, expand the Data Source drop-down and
click the Add New button.

3. The first page of the invoked Data Source Wizard allows you to specify the data source type. Select Database and click
Next to proceed.

4. On the next page, specify the data connection to be used. If it is absent in the list containing existing connections, select No,
I'd like to specify the connection parameters myself and click Next.



5. On the next wizard page, define a custom connection string, or select from the supported data source types. Depending on
the data provider selected, it may be necessary to specify additional connection options (such as authentication type and
database name) on this page.

Click Next to proceed.

6. If server authentication is required for the selected database type, the next page will prompt you to specify whether or not
you want to save the user credentials along with the connection string.

Select the required option and click Next.



7. On the next page, you can construct an SQL query to obtain data from the database, or select a stored procedure.

To construct an SQL query, click Run Query Builder...

8. In the invoked Query Builder window, select an item from the list of available tables on the left and drop it onto the list of
data tables to be used.



9. Enable the check box near the added table to include all of its fields in the data view.

Click OK to exit the Query Builder. Click Finish to exit the Data Source Wizard.

The newly created SQL data source will be displayed in the Components node of the Report Explorer. Additionally, the
hierarchy of the data source will be reflected by the Field List.



Bind a Report to an Entity Framework Data SourceBind a Report to an Entity Framework Data Source
This document describes the steps required to connect a report to data provided by an Entity Framework data context.

To bind a report to an Entity Framework data source, do the following.

1. Create a new report.

2. Right-click the report and select Edit... in the context menu. In the invoked dialog, expand the Data Source drop-down and
click the Add New button.

3. The first page of the invoked Data Source Wizard allows you to specify the data source type. Select Entity Framework
and click Next to proceed.

4. On the next page, select the required data context from the list of available data contexts and click Next.



5. Select a connection string to be used to establish a data connection.

Click Next to proceed to the next page.

6. The following wizard page is available only if the current entity data model contains stored procedures. To bind to a stored
procedure, click Add. Then, in the invoked window, select a required stored procedure and click OK.



7. Configure the parameters to be passed to the selected stored procedure. Be sure to specify the correct parameter Type.
Click Finish to exit the wizard.

The newly created Entity Framework data source will be displayed in the Components node of the Report Explorer. Additionally,
the hierarchy of the data source will be reflected by the Field List.





Bind a Report to an Object Data SourceBind a Report to an Object Data Source
This document describes the steps required to connect a report to an object data source.

To bind a report to an object data source, do the following.

1. Create a new report.

2. Right-click the report and select Edit... in the context menu. In the invoked dialog, expand the Data Source drop-down and
click the Add New button.

3. The first page of the invoked Data Source Wizard allows you to specify the data source type. Select Object Binding and
click Next to proceed.

4. Next, select an assembly that contains the class type definition of the data source. To exclude irrelevant assemblies from this
list, select the Show only highlighted assemblies check box.



5. On the following wizard page, select a data source type. To exclude irrelevant classes from this list, select the Show only
highlighted types check box.

6. On the next wizard page, select whether you need to retrieve the actual data from the data source or obtain the data source
schema (enabling you to edit the report layout without having access to the actual underlying data). Select the second
option and click Next to proceed.



7. The following page allows you to select a data source constructor to be used to create an instance of the data source. To
exclude irrelevant constructors from the list, select the Show only highlighted constructors check box.

8. On this wizard page, you can specify the parameters for the selected constructor. To specify the constructor parameter's
value, use the Value column. Enable the check box in the Expression column to make it possible to specify the parameter
expression using the Expression Editor. In this case, you can pass an existing report parameter to the member or even
create a new report parameter using the in-place editor.



Click Finish to exit the wizard.

The newly created object data source will be displayed in the Components node of the Report Explorer. Additionally, the
hierarchy of the data source will be reflected by the Field List.



Bind a Report to an Excel Data SourceBind a Report to an Excel Data Source
This document describes the steps required to connect a report to data obtained from a Microsoft Excel workbook.

To bind a report to an Excel data source, do the following.

1. Create a new report.

2. Right-click the report and select Edit... in the context menu. In the invoked dialog, expand the Data Source drop-down and
click the Add New button.

3. The first page of the invoked Data Source Wizard allows you to specify the data source type. Select Excel File and click
Next to proceed.

4. On the next wizard page, select a required Excel workbook. To do this, click the ellipsis button and locate the source file or
enter the full path to this file. The XLS, XLSX and XLSM formats are supported.



Click Next to proceed to the next wizard page.

5. The next wizard page allows you to specify import settings.

Enable the first check box to use values of the first row as field names. If you disable this option, values of the first row will
be imported as data and field names will be generated automatically. You can also specify whether to include empty rows to
the result data source, and whether to skip hidden rows and columns.

Specify required settings and click Next.

6. On the next wizard page specify from which part of the workbook to extract data. All worksheets, tables and named regions
existing in the workbook are listed here.



7. The next wizard page allows you to select required columns and specify their settings.

To select a column, enable the corresponding Selected check box. Use Name to specify the custom column name and
Type to choose the column type.

On this page, you can also preview the resulting data by clicking the Preview... button.



Click Finish to complete the wizard.

The newly created data source will be displayed in the Components node of the Report Explorer. Additionally, the hierarchy of
the data source will be reflected by the Field List.



Binding Report Controls to DataBinding Report Controls to Data
Report controls can either display static information or dynamic data obtained from the bound data source.

Data-bound controls are indicated by a yellow database icon, both on the Design Surface and in the Report Explorer.

To embed dynamic information to a report, if this information is contained in the report data source, you can use one of the
following approaches.

Using the Field List
Using the Context Menu
Using the Properties Panel

After a control is bound to data, you can employ additional features that are listed in the Special Capabilities section of this
document.

Using the Field List
The Report Designer allows you to create a data-aware element using the Field List. To do this, switch to the Field List panel, click
the desired field item and drop it onto the report band. This automatically creates a control bound to the selected data field.

Using the Context Menu
Right click an existing report control, and in the invoked context menu, click the Edit... link.



In the invoked Edit dialog, expand the Data Binding drop-down and select the required data field.

To unbind a control's property, expand the Data Binding drop-down and click the Clear button.

Using the Properties Panel
Select a control (e.g., on the Design Surface) and switch to the Properties Panel. Expand the Data Bindings option and specify a
data field for the required property (e.g., Text).



To unbind a control's property, expand the corresponding drop-down and click the Clear button.

Special Capabilities
After a control is bound, you can apply formatting to its dynamic content (e.g., for it to be treated as currency, or date-time
content). For details on this, refer to Formatting Data.

It is possible to force a control to display a result of a summary function calculated across the data field to which it is bound. For
more information, see Calculating Summaries.

Another noteworthy option is to combine both static and dynamic content within the same control (e.g., to append some text
prefix or postfix to a value obtained from a database), or even bind a control to multiple data fields at one time. This is detailed in
Using Mail Merge.

If you are required to perform pre-calculations over the data field to which a control is bound, you can do so by creating a
calculated field, and binding the control to it. This is detailed at Calculated Fields.

In turn, a calculated field may contain both dynamic and static parameters, which can be requested each time a report is being
previewed. For more information, refer to Report Parameters.



Using Mail MergeUsing Mail Merge
The mail merge feature allows you to combine both static and dynamic content within the same report control. For instance, you
can append some text prefix or postfix to a value obtained from a database, or even bind a control to multiple data fields at one
time.

Mail merge is available for the following controls.

Label
Table Cell
Check Box
Bar Code
Zip Code

To embed dynamic data into a control's static content, type in data field names surrounded by [square brackets]. If this field is
valid in the current data context, it will be replaced with an appropriate data value when a report is previewed or exported. Since
this data field is inserted into a label's text, you may also use any prefix or postfix. Moreover, you can insert several embedded
fields into the Text of a single control, and all these embedded fields should be processed correctly.

To embed a parameter's value into a control's content, use the Parameters.ParameterName syntax.



Report ParametersReport Parameters
This document describes the main concepts of using parameters in the Report Designer and provides information on how to
create parameters and pass their values.

The document consists of the following sections.

Using Parameters
Creating Parameters
Passing Parameter Values

Using Parameters
Report parameters provide the capability to pass data of a certain type to a report and can be used in different ways listed below.

Filtering

You can use a report parameter to filter report data according to the current parameter value by specifying the report's
Filter String. For more information, see the Filtering Data topic.

Data Binding

To show a parameter's value in a report, drag the parameter from the Field List panel and drop it onto the required band.
This creates a Label bound to the parameter, as with an ordinary data field.

For more information, see the Binding Report Controls to Data topic.

Calculated Fields and Conditional Formatting

Parameters can participate in constructing expressions for calculated fields and formatting rules, as well as standard data
fields. The only difference is that a parameter is inserted into the expression's text using the "Parameters." prefix before its
name.



Cascading Parameters

You can filter parameter values by specifying the filtering expression that can also include other parameter values. To
construct this filtering expression, set the parameter's Look-Up Settings Type property to StaticList or DynamicList and
then specify its Filter String property.

Multi-Value Parameters

If a parameter is bound to a collection of standard values, it is possible to store more than one value in it. To do this, enable
the parameter's MultiValue property.

Multi-value parameters are useful when you need to filter report data against a list of values. The image below



demonstrates a correct filtering expression that incorporates a multi-value parameter.

The following image demonstrates an editor for a multi-value parameter in a Print Preview.

Creating Parameters
To create report parameters, follow the steps below.

1. Create a new report and bind it to a data source.

2. In the Field List panel, right-click the Parameters section and in the invoked menu, click Add Parameter.

3. In the invoked Add New Parameter dialog, set the created parameter's Name and Description properties and make sure
to set its Type to an appropriate value. To display this parameter in the Print Preview, enable the Show in the parameters
panel option.



4. To assign a list of values to this report parameter, enable the Supports the collection of standard values option.

In the Dynamic values tab, you can specify a parameter's data source, data member, value member and display member.
The value member defines a data field that provides values to the parameter. The display member defines a data field that
provides display names for parameter values, i.e., how these values appear in the user interface available in a Print Preview.

In the Static values tab, you can manually fill the list of parameter values. Each parameter value has an individual
description specifying how this value appears in the Parameters Panel.

5. Then, repeat the previous steps to create the second parameter, so that every time your report is previewed, you will be



asked to specify two dates.

6. Next, use parameters to filter your report's data. Select report, and in the Properties Panel, click the ellipsis button for the
Filter String property. Then, in the invoked Filter String Editor, construct an expression where a data field is compared
with the created parameters. To access parameters, click the icon on the right until it turns into a question mark.

Passing Parameter Values
To view the resulting report in the Report Designer, switch to the Print Preview tab. For a report containing at least one visible
parameter, the dedicated Parameters Panel is automatically created in the Preview. This panel provides appropriate editors based
on parameter types. To pass parameter values to the report, specify the required values and click Submit.



Query ParametersQuery Parameters
A query parameter holds an external value that is inserted into an SQL statement before query execution. This value can be either
static or dynamically generated by an associated expression.

In the Report Designer, query parameters are typically used in the following scenarios.

Passed as criteria to the WHERE part of an SQL statement to perform data source level filtering. The query parameter's
value is inserted into the resulting SQL query string in the position of the corresponding placeholder, which has the
"@QueryParameterName" form.
Passed as actual parameters to a stored procedure. See the Customize the Query topic to learn more.

To create and configure query parameters to filter report data, do the following.

1. When creating a new data-bound report using the Report Wizard or binding an existing one to an SQL data source, go to
the query customization page.

To open this page to customize an existing data source, right-click this data source in the Report Explorer and select
Manage Queries in the context menu.

Then, in the invoked Manage Queries dialog, click the ellipsis button for the required query.

2. In the invoked Data Source Wizard, click the Run Query Builder... button.



3. In the Query Builder, construct the query, and then, click the Filter... button.

4. In the invoked Filter Editor, construct a filtering expression that will be used to filter resulting data at the data source level.
To access parameters, click the icon on the right until it turns into a question mark. Then, click the parameter placeholder
and select Create Query Parameter.



5. In the invoked Query Parameter Editor, specify the parameter's name and appropriate value type, and click OK.

Close the Filter Editor, and then, complete the Query Builder.

6. Now, the newly constructed SQL query appears in string form on this wizard page. The query parameter is passed to the
WHERE part of the SQL string and has the "@QueryParameterName" form.

Then, click Next to proceed to the next wizard page.



7. The next wizard page provides access to query parameters and allows you to add, configure and remove it. On this page,
specify the actual value (either static or dynamic) for a query parameter.

Specifying a static value

To specify a static value for a query parameter, select the parameter's value type, and then specify its actual value in
the Value column according to the selected type.

Specifying a dynamic value

To use a dynamically generated value, do the following.

First, activate the Expression check box for the required parameter. This allows you to use an expression to
dynamically calculate the parameter's actual value.

To map the query parameter to a new report parameter, click the plus button for the Value property, and in the
invoked dialog, specify the required report parameter settings. Be sure to specify the report parameter type according
to the type of the respective query parameter.

Then, expand the drop-down list for the Value property and select the created report parameter. This list also contains
report parameters that already exist in a report.



You can also create a complex expression for a query parameter. To do this, click the ellipsis button for the Value
property and construct the required expression in the invoked Expression Editor.

8. Click Finish to exit the wizard.



Calculated FieldsCalculated Fields
This document demonstrates how to add a calculated field to a report. The main purpose of calculated fields is to perform pre-
calculations of virtually any level of complexity over data fields based on a specific expression.

In the Report Designer, a calculated field is similar to an ordinary data field (e.g., you can bind controls to it, and group, sort and
filter your report against it).

To add a calculated field to your report, follow the instructions below.

1. To create a calculated field, in the Field List, right-click any item inside the data source, and in the invoked menu, select Add
Calculated Field.

2. In the Field List, select the created field and switch to the Properties Panel. Make sure to change the Field Type property to
an appropriate value.

3. Then, create an expression for the calculated field.

Click the ellipsis button for the Expression property to invoke the Expression Editor. You can also invoke this dialog by
right-clicking the calculated field within the Field List and selecting Edit Expression...



Click Fields to see the field list. To add a data field or report parameter to this expression, double-click the required name. A
data field is inserted into the expression's text using its name in [square brackets], and parameters are inserted using the
"Parameters." prefix before their names. Use the toolbar to add operators between field names.

To close the dialog and save the expression, click OK.

4. Finally, drag the calculated field from the Field List onto the required band like an ordinary data field.

The report with a calculated field is now ready. Switch to the Print Preview tab and view the result.





Shaping DataShaping Data
The topics in this section illustrate how to shape data in reports in various ways using the Report Designer.

Grouping Data
Sorting Data
Filtering Data
Calculating Summaries
Formatting Data



Grouping DataGrouping Data
This document demonstrates how to group report data. Grouping allows you to split data into groups based on identical values in
a field or fields. Note that data grouping can be performed only if a report is bound to a data source.

To group records in a report, do the following.

1. Create a new report and bind it to a data source. This tutorial starts with the following report.

2. Next, switch to the Group and Sort Panel, and click Add a Group. In the invoked drop-down list, select a data member
across which the report is to be grouped.

3. After this, the Group Header band is added to the report with the specified data member set as its grouping criterion.

Drop the data field, which is specified as the grouping criterion, from the Field List panel onto the Group Header band. This
data field will be displayed as a header for each group.

4. In addition, you can enable the corresponding Group Footer band by enabling the Show Footer option in the Group and
Sort Panel.



Use the Sort Order drop-down list to manage the sorting order of the group's items (ascending or descending) or to
disable sorting in grouped data. If multiple groups are created, you can specify the priority for each group by selecting it in
the Group and Sort Panel and using the Move Up and Move Down buttons.

5. Then, you can calculate a total across the group by placing a Label onto the Group Footer band and specifying its Summary
properties in the following way.

Note also that value formatting is applied to a summary independently of the general formatting, and has a greater priority.

The report is now ready. Switch to the Print Preview tab and view the result.



Sorting DataSorting Data
This document demonstrates how to sort report data. Note that as with data grouping, sorting can be performed only if a report is
bound to a data source. This example uses the report created in the following tutorial: Grouping Data.

To sort records in a data-aware report, do the following.

1. Switch to the Group and Sort Panel, and click Add a Sort. In the invoked drop-down list, choose a data field across which
the report is to be sorted.

2. To manage the sorting order, use the Sort Order drop-down list.

If multiple sorting criteria are specified, you can define the priority for each one by selecting it in the Group and Sort Panel
and using the Move Up and Move Down buttons.

The report is now ready. Switch to the Print Preview tab and view the result.



Filtering DataFiltering Data
If a report is bound to a data source that contains far more data rows than are necessary for processing report creation, you can
exclude excessive or undesired data. To accomplish this, construct a filtering expression using single or multiple data fields.

This document describes two approaches to filtering data in the Report Designer.

Filter Data at the Report Level
Filter Data at the Data Source Level

Filter Data at the Report Level
To filter a report's data, do the following.

1. Right-click the report and select Edit... in the context menu. In the invoked dialog, click the ellipsis button for the Filter
String property.

2. Then, in the invoked Filter String Editor, specify the filtering expression.

When creating a filter criteria, you can create and edit logical expressions, and also join the expression groups with And, Or,
NotAnd, and NotOr operators. In every filter condition, the left part contains either the data field name, or the name of the
calculated field, which exists in this data source at the same level. The right part of the condition contains either a certain
numerical or string value, or the name of the report parameter.

To access parameters, click the icon on the right, until it turns into a question mark.



To quit the dialog and save the changes, click OK.

Filter Data at the Data Source Level
To filter data before it has been supplied to a report, you can modify a query of an SqlDataSource assigned to the report's Data
Source property. To do this, perform the following steps.

1. Invoke the Manage Queries dialog using one of the following ways.

Switch to the Report Explorer and right-click the data source item under the Components node. In the invoked
context menu, select the Manage Queries... command.

Select a data source, and in the Properties Panel, click the ellipsis button for the Queries property.

2. In the invoked dialog, click the ellipsis button corresponding to the required query.



3. Next, in the invoked Data Source Wizard, click the Run Query Builder... button.

4. In the Query Builder, click the Filter... button.

5. In the invoked Filter Editor, construct a filtering expression that will be used to filter resulting data at the data source level.



Note that it is possible to embed query parameters into the expression.



Calculating SummariesCalculating Summaries
With the Report Designer, you can force a data-bound control to calculate one of the standard summary functions (Average,
Sum, Count, Max, Min, etc.).

To calculate summaries (totals) within a report, follow the instructions below.

1. Create a new report and bind it to a data source. This tutorial starts with the following report layout.

2. To display a summary at the bottom of the report, add the Report Footer band. To do this, right-click the report's area and in
the invoked context menu, select Insert Band, and then Report Footer.

3. Switch to the Field List panel, select the field for which a summary will be calculated and drop it onto the created Report
Footer band.

4. Right-click the newly created Label and select Edit... in the context menu. In the invoked dialog, click the ellipsis button for
the Summary property.



5. In the invoked Summary Editor, specify the summary options. In the Summary function drop-down, select Sum. Note
that in addition to a simple summary, you can choose among numerous built-in functions (such as Count and Average).

The Summary Running option is set to Report to ensure that all values from the specified data field are taken into
account. You can also define a summary function's Format string. Note that value formatting is applied to a summary
independent of general formatting and has a greater priority.

The Ignore NULL values option would not affect the result in this example, since NULL values are treated like zeros by
default. This option makes sense for functions like Count or Average, because the number of elements counted will
depend on this option.

To save the settings and close the dialog, click OK.

Switch your report to the Print Preview tab to view the result.





Formatting DataFormatting Data
This topic describes how to change value formatting of report elements in the Report Designer. For instance, you can format a
numeric value as a currency, display a date/time value in one of the standard forms depending on the culture, etc.

To apply value formatting for a data-bound control's content, do the following.

1. Right-click the control, and select Edit... in the context menu. In the invoked dialog, click the ellipsis button for the Format
String property.

2. In the invoked Format String Editor, select one of the predefined standard formats or specify a custom one.

To quit the dialog and apply the changes, click OK.

In a similar way, you can apply formatting to a control's Bookmark, Navigation URL and Tag properties using the Properties
Panel. Note that the set of bindable properties depends on the control type.



When a summary function is applied to a control's dynamic content, value formatting is specified separately as described in the
Calculating Summaries document.

Independently from general and summary value formatting, you can specify a native XSLX format string, which is preserved when
the report is exported to XLSX. You can do this using a control's Xlsx Format String property.



Appearance CustomizationAppearance Customization
The topics in this section describe how to customize the appearance of a report or any of its elements using specific appearance
options, visual styles and conditional formatting.

This section consists of the following topics.

Understanding Style Concepts
Use Odd and Even Styles
Conditionally Change a Control's Appearance
Conditionally Hide Bands
Conditionally Change a Label's Text



Understanding Style ConceptsUnderstanding Style Concepts
This document describes how you can provide a professional look to your reports by effectively adjusting the appearance of its
elements.

This document consists of the following sections.

Appearance Properties
Visual Styles
Styles Priority

Appearance Properties
In the Report Designer, a report and each of its elements (bands and controls) has a complete set of appearance options (such as
Background Color, Borders, Font, Foreground Color, Text Alignment, etc.). By default, these properties are not specified,
meaning that their real values are obtained from a control's (or band's) parent, which is the report itself. So, the appearance
specified for a report is distributed to all its child elements. Similarly, the appearance of a band is translated to the controls it
contains.

In turn, a control's appearance can be adjusted independently from its parent.

Visual Styles
In addition to the capability to specify appearance property values for every control and band, you can create comprehensive
global styles (which are stored in the report's style sheet), and then assign them to individual report elements.

Click the ellipsis button for the report's Style Sheet property to invoke the Styles Editor, which allows you to manage a report's
style sheets, customize them, save them to a file and load from it.



You can also invoke the Styles Editor by right-clicking the report and selecting Edit Style Sheet... in the context menu.

To assign a particular style to a control, invoke the drop-down list for its Style property. Then, select one of the styles stored in a
report's sheet collection or click the plus button to create a new style sheet.

Note that if a style is assigned to a band, it is applied to all controls that the band contains.

You can also use the Report Explorer to access the style collection. Commands of the context menu allow you to add, edit, clone or
delete a style.



Styles Priority
A style defines the same appearance properties that are defined by a control's (or band's) appearance properties. When both
styles and individual appearance settings are assigned to an element, you can control the priority of their options using an
element's Style Priority property.

By default, most of the Style Priority's options (Use Background Color, Use Border Color, etc.) are set to Yes. This means that
if any style is assigned to a control, its properties will have a higher priority than the appearance properties of this element or its
parent. You can assign a higher priority to an element's appearance property by disabling the corresponding Use* property.

The following image demonstrates how the Style Priority property works.

The same principles are applied to the odd-even styles feature, which allows you to alternate the appearance of consecutive data
rows in your report. For details on this, refer to Use Odd and Even Styles.

�� N o t eN o t e

When conditional formatting is applied to an element, its appearance definition has the highest priority.



Use Odd and Even StylesUse Odd and Even Styles
This tutorial describes how to apply odd and even styles to report controls, e.g., to alternate the background color for each record.

To utilize odd and even styles, do the following.

1. Create a table report.

2. In the Properties Panel, click the ellipsis button for the report's Style Sheet property.

3. In the invoked Styles Editor, click the plus button to add a new style. Then, adjust the required options, e.g., set the
Background Color.

Click OK to apply changes and quit the dialog.

4. Select the detail table, and in the Properties Panel, expand its Styles option. Invoke the drop-down list for the Even Style
property and select the created style.

If required, perform the same steps to create and assign an odd style.

Switch to the Print Preview tab and view the result.





Conditionally Change a Control's AppearanceConditionally Change a Control's Appearance
This tutorial describes how to conditionally change a control's appearance (e.g., make a Label's text red if its value exceeds a
certain threshold). Thanks to the formatting rules feature, no scripts are required to complete this task, so you should not have to
write any code.

To conditionally change a control's appearance, do the following.

1. Create a new report and bind it to a data source.

2. Right-click the report and select Edit Formatting Rule Sheet... in the invoked context menu.

3. In the invoked Formatting Rule Sheet Editor, create a new formatting rule using the plus button, and then, click the
ellipsis button for its Condition property.

4. In the invoked Expression Editor, define the required Boolean condition (which means that its result is returned as either
true or false). This tutorial demonstrates how to format fields if the UnitPrice value is greater than 30.



To save the condition and close the dialog, click OK.

5. Return to the Formatting Rule Sheet Editor and define the formatting to be applied, e.g., specify the desired foreground
color.

To save the changes and quit the dialog, click OK.

6. Finally, select the band or control to which the formatting rule should be applied (in this example, it is the Detail band), and
select Edit Formatting Rules... in the context menu.



7. In the invoked Formatting Rules Editor, move the rule from left to right using the right arrow button so that you can apply
the rule for this band.

If multiple rules are applied, it is possible to customize their precedence using the up and down arrow buttons. So, the rules
are applied in the same order that they appear in the list, and the last rule in the list has the highest priority.

Switch your report to the Print Preview tab and view the result.





Conditionally Hide BandsConditionally Hide Bands
This tutorial describes how to hide bands if a certain logical condition is met. Note that no scripts are required to accomplish this
task.

To demonstrate this feature, use a report with grouping similar to the one created in the following tutorial: Grouping Data.

To conditionally hide bands in a report, do the following.

1. Right-click the Group Header and select Edit Formatting Rules... in its context menu.

2. In the invoked Formatting Rules Editor, click the Edit Rule Sheet... button.

3. Then, in the invoked Formatting Rule Sheet Editor, click the plus button to create a new rule. Set its Visible property to
No, and click the ellipsis button for the Condition property.



4. Construct the required logical expression (e.g., [CategoryID] < 2), and click OK.

To quit the Formatting Rule Sheet Editor and save changes, click OK.

5. Return to the Formatting Rules Editor and move the created rule to the dialog's right section using the right arrow button
to make it active.



6. Apply the same formatting rule to the report's Detail band.

Switch to the Print Preview and view the result. In this example, you can see that the first category is not shown. So, the
conditional formatting was applied properly.



Conditionally Change a Label's TextConditionally Change a Label's Text
This tutorial demonstrates how to change a label's text if a certain condition is met. No scripts are required to accomplish this
task.

To conditionally change a label's text, do the following.

1. Create a new report and bind it to a data source.

2. Next, add a calculated field. To do this, in the Field List, right-click any item inside the created data source, and in the invoked
context menu, select Add Calculated Field.

3. Select the calculated field, and in the Properties Panel, set its Field Type to String. Then, click the ellipsis button for the
Expression property.

In the invoked Expression Editor, specify the required logical condition for the calculated field (e.g., Iif([UnitsOnOrder]
== 0, 'None', [UnitsOnOrder]), which means that if the UnitsOnOrder data field's value is equal to 0, the control's text
will be replaced with None).

To save the changes and close the dialog, click OK.

4. Finally, drop the required data fields and the created calculated field from the Field List onto the report's Detail band.



The report is now ready. Switch to the Print Preview tab and view the result.



Report Navigation and InteractivityReport Navigation and Interactivity
The topics in this section explain how to establish navigation through a report in different ways and enable editing reports in Print
Preview.

This section consists of the following topics.

Add Bookmarks
Create a Table of Contents
Create Hyperlinks
Add a Cross-Reference
Enable Content Editing in Print Preview



Add BookmarksAdd Bookmarks
This tutorial describes the steps to create a report with bookmarks (a so-called Document Map). This feature allows you to easily
navigate through the report during print preview.

To demonstrate the Document Map feature, use a report with grouping, similar to the one created in the following tutorial:
Grouping Data.

To create a report with bookmarks, do the following.

1. Select the label placed in the Group Header band, and in the Properties Panel, expand the Data Bindings property. As this
control is bound to data, bind its Bookmark property to the same data field (in this example, CategoryID).

Note that as with other bindable properties, you can also apply value formatting to the Bookmark property (e.g., Category:
{0}).

2. In the same way, select the label in the Detail band and set its Bookmark property to the ProductName data field.

3. Then, for the same label, set the Parent Bookmark property to the Group Header's label to define the Document Map's
hierarchy.



4. Finally, select the report itself and assign text to its Bookmark property, which determines the caption of the root node of
the Document Map.

The report with bookmarks is now ready. Switch to the Print Preview tab and use the Document Map Panel to navigate through
the report.



Create a Table of ContentsCreate a Table of Contents
This tutorial describes how to create a report with a table of contents, which is automatically created based on the bookmarks
existing in a report.

To insert a table of contents into a report, do the following.

1. Drop the Table Of Contents control from the Toolbox onto the Report Header Band.

Alternatively, you can double-click the control in the Toolbox. In this case, if the report does not contain a Report Header, it
will be created automatically, so that the table of contents can be added to it.

2. Double-click the title of the table of contents and specify its text.

3. To customize the title's appearance, use the Level Title option's settings available in the Properties Panel.

4. To customize the appearance of all other levels, use the Level Default option's settings.



5. To customize a specific level individually, add a corresponding item to the Levels collection of the table of contents.

After adding a new level, you can access and customize its properties.

The table of contents are now ready. Switch to the Print Preview and view the result.



Create HyperlinksCreate Hyperlinks
This tutorial demonstrates how to embed a hyperlink into your report. In this case, a label behaves as a hyperlink in a report's
Print Preview, and when the report is exported to PDF, HTML, MHT, RTF, XLS and XLSX formats.

To insert a hyperlink into your report, do the following.

1. Create a new report.

2. Drop a Label onto the report, and in the Properties Panel, change its Text to the one required for the link.

3. Then, set the Navigation Target to the required value (_blank, _parent, _search, _self, or _top), and define the required
Navigation URL.

4. In addition, to make the label look like a typical link, you can change its appearance appropriately (e.g., make it blue and
underlined).

The hyperlink is now ready. Switch to the Print Preview tab and view the result.



Add a Cross-ReferenceAdd a Cross-Reference
This tutorial demonstrates how to add a cross-reference to your report. A cross-reference is a link whose target is located within
the current document and which allows you to establish easy navigation through a report. In this example, a link is placed at the
bottom of each group, leading to the beginning of the report.

To demonstrate this feature, use a report with grouping similar to the one created in the following tutorial: Grouping Data.

To create a report with cross-references, do the following.

1. Drop a label onto the created Report Header band, which will serve as the report's headline. Click the label to type the
desired contents into it. Then, in the Properties Panel, set its Name property to reportTop.

2. To accompany the existing Group Header with the corresponding Footer, in the Group and Sort Panel, enable the Show
Footer option.

3. Then, drop a label onto the Group Footer band. Change the label's Text to Top of Report and apply the desired formatting
to it (e.g., the blue color and underlined text).

Set its Navigation Target property to _self. Then, if you click the drop-down list of the Navigation URL property, you can
see the controls available in your report. Choose the one named reportTop.

The report with cross-references is now ready. Switch to the Print Preview tab and view the result.





Enable Content Editing in Print PreviewEnable Content Editing in Print Preview
This document describes how to enable editing the content of specific controls in Print Preview.

This topic consists of the following sections.

Text Editing
Check Box Editing

Text Editing
The Label, Table Cell and Character Comb report controls can be assigned editors to customize their content in Print Preview.

To demonstrate this feature, use the report similar to one created in the following tutorial: Grouping Data.

To enable content editing, do the following.

1. Select one or more controls that you want to become editable in Print Preview (to select multiple controls, click them while
holding down CTRL or SHIFT).

Switch to the Properties Panel, expand the Edit Options property and select the check box for the Enabled property.

2. To provide a mask for editing decimal values of the UnitPrice field, set the Editor Name property to Fixed-Point Positive
to assign the required editor with a corresponding mask.

Switch to the Print Preview tab. To highlight all editing fields available in the document, click the Editing Fields  button in the
Print Preview toolbar.

Clicking a field will invoke the appropriate editor. To apply the entered values and navigate between editing fields, use the TAB



and SHIFT+TAB keys.

Check Box Editing
In addition to editing text, you can enable switching Check Box states in Print Preview. When two or more check boxes have
identical Group ID values, the corresponding editors belong to a single logical group (i.e., only one option can be selected within
a group at a time).
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The changes made to a control's content in Print Preview have no effect on other parts of the document (e.g., the related summary
results, grouping, sorting, bookmarks and other settings that have already been processed before generating the document).



Adding Details about a ReportAdding Details about a Report
This document lists topics that describe how to add technical information about a report to a generated document. This
information includes the report's creation date, the author's name, as well as text and/or image watermarks.

This section consists of the following examples.

Add Page Numbers and System Information to a Report
Create or Modify Watermarks of a Report



Add Page Numbers and System Information to a ReportAdd Page Numbers and System Information to a Report
This document describes how to insert page numbers or other system information (e.g., current date and time, user name, etc.)
into a report.

Generally, this information is displayed within the Page Header and Footer or Page Margin bands. To add page numbers or
system information to a report, drop the Page Info control from the Control Toolbox onto a band.

Then, follow the instructions below for your specific task.

Add Page Numbers
Add System Date and Time
Add the User Name

Add Page Numbers
To insert page numbers in a report, do the following.

1. Right-click the Page Info control, and in the context menu, click the Edit... link. Then, in the invoked dialog, specify the
Page Information property.

You can choose one of the following formats for displaying page numbers.

Number - displays the current page number only.
Number of Total - displays the current page number with total pages.
Rom Low Number - the current page number is written in lowercase Roman letters.
Rom Hi Number - the current page number is written in uppercase Roman letters.
Total - displays the total number of pages.

2. To format the control's text, in the Edit dialog, specify the required format (e.g., Page {0} of {1}).



3. You can also specify the Start Page Number and Running Band properties. For instance, the latter is available when there
are groups in a report, and you are required to apply independent page numbering for them.

The result is shown below.

Add System Date and Time
To insert the current system date and time into a report, perform the steps below.

1. Right-click the Page Info control and select Edit... in the context menu. In the invoked dialog, expand the Page
Information drop-down and select Date Time.

2. To format the control's text, you can either type it in the Format property, or click its ellipsis button and use the Format
String Editor.



The result is shown below.

Add the User Name
To display the current user name in a report, do the following.

1. Right-click the Page Info control and select Edit... in the context menu. In the invoked dialog, expand the Page
Information drop-down and select User Name.



2. To format the control's text, in the Edit dialog, specify the required format (e.g., Current User: {0}).

The following image demonstrates the result.



Create or Modify Watermarks of a ReportCreate or Modify Watermarks of a Report
This document describes how to add a text watermark in a report, or turn a picture into a report's background. Note that
watermarks are visible only in the Preview mode.

To create a new watermark in a report (or to modify the existing one), do the following.

1. Right-click the report, and in the invoked context menu, click the Watermark... link.

2. In the Text Watermark tab of the invoked Watermark dialog, enter the watermark's text and specify the required
properties such as the Direction, Transparency, Color, etc.

3. Then, switch to the Picture Watermark tab to load the image to be used as a watermark. To do this, click the ellipsis button
for the Image property. In the invoked dialog, select the file containing the image that you wish to load and click Open.



4. Next, define the picture's properties, such as the Size mode, Alignment , Transparency, etc.

5. In addition, you can select a watermark position behind or in front of the document, and specify the page range in which the
watermark will be printed.

As you can see, it is possible to use both textual and image watermarks simultaneously.

The report with watermark is now ready. Switch to the Print Preview tab and view the result.





ScriptingScripting
This document describes the basic principles of scripting, which can be performed by handling the events of a report, and its
bands and controls.

This documents consists of the following sections.

Scripting Overview
Maintaining Scripts
Example: Custom Summary

Scripting Overview
Scripts are program commands, placed within the event handlers of the required report elements. And when the corresponding
event occurs (e.g., a mouse click), the script code runs. Scripting is made available to extend the standard functionality as far as
may be required.

You can write scripts for a report or any of its elements (bands and controls) to be executed when the report is being previewed,
printed or exported.

The Report Designer allows you to write scripts using the Script Editor. This editor supports C# and Visual Basic .NET scripting
languages. This means that the scripting language is independent from the language used to create the report. The language is
specified by the Script Language property of a report. The selected scripting language must be the same for all scripts used in a
report.

Maintaining Scripts
Each report element has its own set of events, which are individual for each element type. To handle an event of a report element,
do one of the following.

Select the required report element (e.g., on the Design Surface). In the Properties Panel, expand the Scripts property and
click the plus button for the event.



Click the Scripts button ( ) in the Toolbar to display the Script Editor. Choose the required report element in the
dedicated drop-down list at the left top of the Script Editor. Then, select one of the available events in another list at the right
top.

After the event is specified, a code template is automatically generated in the current scripting language and added in the Script
Editor.

To check for errors in the report's script, click the Validate button. The validation result is displayed in the errors panel at the
bottom of the Script Editor. Double-click the error item in the panel's list to go to the corresponding line of code. If all scripts are
valid, the errors panel is empty.

Example: Custom Summary
This example demonstrates how to display the total number of product unit packs in a group.

To perform this, execute steps similar to the ones described in Calculating Summaries, except that for the summary field, you
should set the Function property to Custom.



Then, the additional events are added to the label's Scripts property.

You can handle these events in the following way.

C#

// Declare a summary and a pack.
double totalUnits = 0;
double pack = 15;

private void label1_SummaryReset(object sender, System.EventArgs e) {
    // Reset the result each time a group is printed.
    totalUnits = 0;
}

private void label1_SummaryRowChanged(object sender, System.EventArgs e) {
    // Calculate a summary.
    totalUnits += Convert.ToDouble(GetCurrentColumnValue("UnitsOnOrder"));
}

private void label1_SummaryGetResult(object sender, 
DevExpress.XtraReports.UI.SummaryGetResultEventArgs e) {
    // Round the result, so that a pack will be taken into account 
    // even if it contains only one unit.
    e.Result = Math.Ceiling(totalUnits / pack);
    e.Handled = true;
}

VB.NET

Finally, switch to the Print Preview tab and view the result.





Report ElementsReport Elements
In the Report Designer, a report is built from controls (text labels, images, zip codes, charts, etc.) spread across report sections
called bands (various headers, footers, and content sections).

To learn more about these report elements, see the following documents.

Report Controls
Report Bands



Report ControlsReport Controls
In general, report controls allow you to present information of different kinds (e.g., simple or formatted text, pictures, tables, etc.)
in your static and dynamic reports, and to adjust your report's layout (by organizing controls within panels, and inserting page
breaks at the required positions).

The following table lists the available controls (in the same order as in the Toolbox).

ICON D ES CR IPTION

The most basic Label control is intended to display static or dynamic text or both in your report. In addition, it can be used to
calculate standard summary functions across a data field.

The Check Box control is intended to display True/False or Checked/Unchecked/Indeterminate states in a report by displaying (or
not) a check mark, which can be accompanied by a text description.

The Rich Text control allows you to display formatted text in your report. It can display static or dynamic text or both. You can also
load content to the Rich Text from an external TXT or RTF file (which can contain images).

The Picture Box control is intended to display images of numerous formats in a report. An image can be loaded from an external
file, from a bound data source, or from a web location using the specified URL.

The Panel control is a container that frames separate report controls to allow them to be easily moved, copied and pasted, and
visually unite them in the report's preview (with borders or a uniform color background).

The Table control is designed to arrange information in a tabular layout. It may contain any number of rows comprised of
individual cells. Both rows and cells can be selected and customized individually. In most aspects, a cell is similar to a Label, but can
also contain other controls (e.g., Picture Box or Rich Text).

The Character Comb control displays text so that each character is printed in an individual cell.

The Line control draws a line of a specified direction, style, width and color. It can be used for both decoration and visual separation
of report sections. The Line cannot cross report bands, as opposed to the Cross-band Line control.

The Shape control allows you to embed simple graphic objects into your report. You can choose one of the multiple predefined
shapes (e.g., rectangles, ellipses, arrows, polygons, crosses and brackets of various kinds).

The Bar Code control transforms its content into a bar code of the specified type. Multiple standard bar code types are supported.

The Zip Code control renders a numeric postal code that is used to identify the mail address in some countries. This control is not
related to the Zone Improvement Plan (ZIP) code used by the United States Postal Service.

The Chart is a sophisticated control used to embed graphs into your report. It graphically represents a series of points using
numerous 2D or 3D chart types. A Chart can be populated with points both manually (by specifying arguments and values for each
point) and dynamically (by connecting it to the report's data source or binding it to a separate one). See Chart with Static Series and
Chart with Dynamic Series for more information.

The Gauge control provides you with the capability to embed graphic gauges into your report.

The Sparkline control displays a compact chart that is commonly used to reflect the flow of data for every row in a report.



The Pivot Grid control represents dynamic data (obtained from an underlying data source) in a cross-tabulated form to create
cross-tab reports, similar to Pivot Tables in Microsoft Excel®. Column headers display unique values from one data field, and row
headers - from another field. Each cell displays a summary for the corresponding row and column values. By specifying different
data fields, you can see different totals. This allows you to get a compact layout for a complex data analysis.

The Subreport control allows you to include other reports in your current report. To learn more, see Master-Detail Report
(Subreports).

The Table Of Contents control generates a table of contents based on bookmarks specified for report elements.

The Page Info control is intended to add page numbers and system information to a report (the current date and time or the
current user name) into your report. As with many other controls, you can format this control's content.

The Page Break control's sole purpose is to insert a page delimiter at any point within a report.

The Cross-band Line control allows you to draw a line through several report bands. This can be useful if you need to visually
emphasize a section consisting of multiple band areas. In other aspects, it is similar to a regular Line.

The Cross-band Box control allows you to draw a rectangle through several report bands. This can be useful if you need to visually
encompass a section consisting of multiple band areas.
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To learn how to create report controls and change their layout, refer to Create and Delete Report Elements and Adjust the Layout
of Report Elements.



Report BandsReport Bands
A Report Band is a specific area on a report page, used to define how to render report controls that belong to it, their rendering
order and how many times they are rendered. In the Report Designer, every report consists of a number of bands, each of a
different type.

This document consists of the following sections.

Available Bands
Band Positions
Editing Bands

Available Bands
The following table lists all available band types.
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Top
Margin
Band

Located on the top margin of every page, above the Page Header and Report Header. This band is intended for displaying
page numbers or certain supplementary information (e.g., current system time or the user name).

Report
Header
Band

Located at the beginning of a report. This band is intended to display some introductory information, e.g., the report's name,
company logo, date of creation and user name, etc.

Page
Header
Band

Located at the top of every page, below the Top Margin and Report Header. This band is the best place for information that
should be printed on every page. For example, use it to display the header of a table which is continued from the previous page.

Group
Header
Band

Located at the beginning of every group or at the top of the page in case it is split across pages. This band specifies grouping
criteria and is used to display information at the beginning of a group of records. To learn more, refer to Grouping Data.

Detail
Band

Located in the central part of a report between all other bands. This band cannot be deleted since the present report structure
includes the Detail band in its core. This band displays a single record at a time from the bound data source, or simply holds
unbound controls if there is no data source assigned to a report. For more information on data binding, refer to Providing Data.

Detail
Report
Band

Located below the Detail band and used to incorporate one report into another in master-detail reports. It is quite different
from the Detail band, since it holds the whole detail report in a master-detail report layout, and therefore can contain other
types of bands within it. To learn more about detail reports, refer to Master-Detail Report (Detail Report Bands).

Group
Footer
Band

Located at the end of every group or at the bottom of the page if its group is split across pages. This band is primarily intended
to show summary information for a group. To learn more, refer to Grouping Data.

Report
Footer
Band

Located at the end of the report, before the Page Footer and Bottom Margin on the report's last page. This band is intended
to display some final information, e.g., report totals.

Page
Footer
Band

Located at the bottom of every page, below the Report Footer and above the Bottom Margin. This band is intended to display
page numbers or a table footer, which is continued on the following page.



Bottom
Margin
Band

Located on the bottom margin of every page, below the Page Footer. This band is intended for displaying page numbers or
certain supplementary information (e.g., current system time or the user name).

Sub-
Band

This band provides a functional copy of the source band below which it is located. A sub-band's behavior, as well as its position
within the report band hierarchy, is dictated by the source band type. Any number of sub-bands can be added to the report
band of any type except for the Top Margin and Bottom Margin bands and the sub-band itself. Using sub-bands, it is possible
to create multiple versions of a band within a single report and choose an appropriate version later based on a specific condition.
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Band Positions
The following image illustrates the relative positions of different band types, and how many times they are rendered in a report.

The Page Header, Page Footer, Top Margin and Bottom Margin bands are rendered in the report preview on every page.

The Report Header and Report Footer bands are rendered in the report preview only once.

The Group Header and Group Footer bands are rendered for every group of records in a report.

The number of times the Detail band is rendered in a report depends upon the number of records returned from the bound data
source - one band per record.

Editing Bands
The following image shows the default report layout. It is divided into three basic bands (Top Margin, Detail and Bottom
Margin bands) that provide space for placing different report controls on them.



To add a new band of a particular type, use the context menu of the report or bands. Right-click a report on the design surface or
in the Report Explorer, and select a band to be inserted in the report.

For more information on adding and removing bands in the Report Designer, refer to the Create and Delete Report Elements
document. To learn how to change the band layout, see Adjust the Layout of Report Elements.



Interface ElementsInterface Elements
The topics in this section describe the main elements that make up the user interface of the Report Designer.

This section consists of the following topics.

Toolbar
Control Toolbox
Field List
Report Explorer
Group and Sort Panel
Properties Panel
Design Surface
Script Editor
Query Builder



ToolbarToolbar
The Toolbar allows you to easily perform various report commands, which are divided into the following sections.

Report Commands
Edit Commands
Font Commands
Arrange Commands
Editors Commands

Report Commands
Use these commands to save and load report layouts.
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New Creates a new report using the Report Wizard.

Open Invokes the Open dialog that allows you to select the report layout to be opened.

Save Saves the current report to the default file.

Save as Invokes the Save dialog that allows you to select a file to which the current report layout should be saved.

Edit Commands
Use the following commands to delete the selected report elements, place them to the clipboard, paste them onto report bands
and cancel previous actions.
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Delete Deletes the selected report elements.

Cut Cuts the selected report elements to the clipboard.

Copy Copies the selected report elements to the clipboard.

Paste Pastes the contents of the clipboard to the selected report band.

Undo Cancels the last change made to the report.

Redo Reverses the results of the last undo action.



Font Commands
Use these commands to easily customize font, color, formatting and alignment settings.
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Font Name Specifies the font name of the selected elements.

Font Size Specifies the font size of the selected elements.

Foreground Color Specifies the foreground color of the selected elements.

Background Color Specifies the background color of the selected elements.

Bold, Italic, Underline,
Strikeout

Applies/removes bold formatting, italic formatting, underlining and strike through
to/from the selected elements.

Left, Center, Right,
Justify Specifies the horizontal text alignment of the selected elements.

Top, Center, Bottom Specifies the vertical text alignment of the selected elements.

Arrange Commands
These commands allow you to change the order of stacked elements.
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Bring to
Front

Brings the selected elements to the front of a group of stacked elements or moves the selected elements one step
closer to the front.

Send to
Back

Sends the selected elements to the back of a group of stacked elements or moves the selected elements one step
toward the back.

Editors Commands
Use the following commands to invoke the Watermak dialog, Page Setup dialog or Script Editor.
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Watermark Invokes the Watermark dialog that allows you to add a text watermark to a report or turn a picture into a report's
background.

Page Setup Invokes the Page Setup dialog that allows you to modify the paper size, orientation and margins.

Scripts Shows or hides the Script Editor that allows you to write code for specific event handlers.



Control ToolboxControl Toolbox
The Control Toolbox contains all available report controls and allows end-users to add them to the report being edited. Report
controls can display both static and dynamic information of different kinds (simple or formatted text, pictures, tables, etc.) and
adjust a report layout (organize controls within panels, insert page brakes, etc.)

The available report controls can be divided into the following categories.

General Content
ExtendedData
Report Layout
Document Statistics

To learn how to add a control from the Toolbox to a report, see the Adding Controls to a Report section.

General Content
The following controls are most commonly used to display data in a report.
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Label

Check Box

Rich Text

Picture Box

Table

Character Comb

Bar Code

Zip Code

Gauge

Extended Data
The following controls are connected to data individually, without accessing a report's data source.
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Chart

Pivot Grid

Sparkline

ICON CONTR OL NAME

Report Layout
The following controls allow you to draw shapes in a report and customize the report layout.
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Line

Shape

Page Break

Cross-Band Line

Cross-Band Box

Panel

Subreport

Document Statistics
The dynamic content of the following controls is not obtained from a data source.

ICON CONTR OL NAME

Page Info

Table Of Contents

Adding Controls to a Report
To add a control from the Toolbox to a report, do one of the following.

Double-click an item in the Toolbox to create the corresponding control at the default position.



Drag-and-drop an item from the Toolbox onto the required position within a report.

Select an item in the Toolbox, and then indicate the bounding rectangle by holding down the left mouse button.

If you need to perform selection, re-arranging or resizing operations, select the Pointer item ( ).



Field ListField List
The Field List panel is intended to display the structure of the data source to which a report is currently bound. This panel can
also be used to create new bound report controls, manage calculated fields and parameters.

This document consists of the following sections.

Creating Bound Report Elements
Managing Calculated Fields
Managing Report Parameters

Creating Bound Report Elements
After binding a report to data, the Field List shows the structure of the report's data source assigned to the Data Source property.
Then, the Field List can be used to add new bound controls.

To add a new bound report element, click a desired field item in the Field List, and then drag-and-drop it onto the report band.
This creates an appropriate control bound to the selected data field.

Managing Calculated Fields
The Field List allows you to create calculated fields by building expressions based on the values of data fields, report parameter
values, etc.

To add a calculated field to a report, right-click any item inside the data member node, and in the invoked context menu, select
Add Calculated Field.



To edit settings of the created calculated field, select them and go to the Properties Panel. You can also right-click the calculated
field and use commands available in the context menu.

Manging Report Parameters
The Field List shows existing report parameters and allows you to add new ones to the report.

To create a parameter, right click the Parameters node or any of its sub-nodes, and in the context menu, select Add Parameter.

You can customize report parameters using the Properties Panel or commands available in the context menu in the same way as
you customize calculated fields.



Report ExplorerReport Explorer
The Report Explorer reflects a report's structure in a tree-like form providing easy access to report elements. Additionally, the
Report Explorer contains the Components node, which displays non-visual report components such as data objects created
when binding a report to a data source. You can also use the Report Explorer to manage styles and formatting rules available for a
report.

To access and edit settings of a report element or component, select it in the Report Explorer and switch to the Properties Panel.
You can also right-click elements and components to invoke their context menu.

In the Report Explorer, data-aware controls are marked with a special database icon.

You can manage styles and formatting rules using commands available in context menus. To invoke a context menu, right-click
the corresponding root node or its sub-node.





Group and Sort PanelGroup and Sort Panel
The Group and Sort Panel allows you to quickly apply grouping and sorting to report data.
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If a report is not bound to a data source, the Group and Sort Panel is inactive.

To create a new sorting or grouping criterion, click the Add a Sort or Add a Group buttons, respectively. Then, select the desired
data source field in the invoked drop-down list.

After adding the grouping criterion, the Group Header band is automatically created. You can manually specify whether to display
the corresponding Group Header and Group Footer using the Show Header and Show Footer check boxes.

You can choose the sorting mode (ascending or descending) or disable sorting in the Sort Order drop-down list.

The Group and Sort Panel also allows you to change the precedence of multiple grouping and sorting criteria using the Move
Up and Move Down buttons.

To remove a grouping or sorting criterion, select it and click the Remove button.



Properties PanelProperties Panel
The Properties panel allows you to access and customize settings of a report and its elements.

This document describes different aspects of using the Properties panel and consists of the following sections.

Selecting a Report Element
Display Modes
Changing Property Values
Searching for Properties

Selecting a Report Element
To select an element and show its properties in the Properties panel, do one of the following.

Select a required element in the drop-down list at the top of the Properties panel.

Click a required element in the Report Design Surface.
Select a required element in the Report Explorer.

Display Modes
The Properties panel can display element properties in alphabetical flat order or combine them into categories depending on their
purposes. To switch between these display modes, use the dedicated buttons.



Changing Property Values
In the Properties panel, each row consists of two cells: the header cell showing the property caption and the value cell. To set a
property value, locate the property and specify its value using the corresponding cell editor. Specific properties contain nested
properties, which can be accessed by clicking the expand button for the property captions.

Searching for Properties
The Properties panel includes the search box that allows you to search for a required property. When you type within the search
box, the Properties panel automatically creates a search criteria based on the entered text and filters the list of available
properties.

If you type two substrings separated by the space character, these substrings are considered as individual conditions combined by
the OR logical operator. To find properties that contain both substrings (i.e., to use the AND logical operator), type "+" before the
second substring. Similarly, type "-" to exclude properties that contain a specific substring. To search for a property that contains a
space character, enclose the entered string in quotation marks. You can also combine several logical operators and quotation
marks.



Design SurfaceDesign Surface
The Design Surface displays a report that is currently being edited in the Report Designer.

The Design Surface includes the following principal elements.

Rulers
Band Captions
Context Menus
In-place Editors

Rulers
The horizontal and vertical rulers display tickmarks in the measurement units specified for a report. Click an element to evaluate
its size and location using the rulers.

The vertical ruler also allows you to change the band height by moving its top and bottom sliders.

Band Captions
In the Report Designer, each report band carries a caption, tab title and color, which depend on the band kind. These captions are
not printed in the resulting report document and are only visible at design time.



To access band properties, select the band by clicking its caption, and then switch to the Properties Panel.

Context Menus
The context menu provides quick access to the most commonly used actions that depend on the element for which it is invoked.
For example, it allows you to insert new bands, cut/copy/paste/delete report controls, etc. For certain report controls, the context
menu also includes the Edit... option, which invokes the dialog with complex settings (such as data binding settings, formatting,
etc.) To invoke this menu, right-click a report element or the report editing surface.

In-place Editors
An in-place editor allows you to edit the content of a text-oriented control (Bar Code, Check Box, Label, Table Cell or Zip Code) by
double-clicking it.

To learn how to use the in-place editor to supply dynamic data to a control, see Using Mail Merge.



Script EditorScript Editor
The Script Editor allows you to write code for specific event handlers in the Report Designer to adjust the behavior of report
controls, bands or the report itself.

This topic describes the basics of using scripts, the Script Editor interface and shows how to use scripting in a report. The
document consists of the following sections.

Scripting Overview
Maintaining Scripts

Scripting Overview
The Script Editor provides you with the capability to write and execute scripts at runtime when a report is generated. Scripting is
made available to extend the standard functionality as far as may be required.

The Script Editor supports C# and Visual Basic .NET scripting languages. This means that the scripting language is independent
from the language used to create the report. You can specify the language using the Script Language property. The selected
scripting language should be the same for all scripts used in a report.

Maintaining Scripts
Each report element has its own set of events, which are individual for each element type. To handle an event of a report element,
do one of the following.

Select the required report element (e.g., on the Design Surface). In the Properties Panel, expand the Scripts property and
click the plus button for the event.



Click the Scripts button ( ) in the Toolbar to display the Script Editor. Choose the required report element in the
dedicated drop-down list at the left top of the Script Editor. Then, select one of the available events in another list at the right
top.

After the event is specified, a code template is automatically generated in the current scripting language and added in the Script
Editor.

To check for errors in the report's script, click the Validate button. The validation result is displayed in the errors panel at the
bottom of the Script Editor. Double-click the error item in the panel's list to go to the corresponding line of code. If all scripts are
valid, the errors panel is empty.



Query BuilderQuery Builder
The Query Builder provides a visual interface for constructing SQL queries and enables you to solve a variety of tasks.

�� N o t eN o t e

The Query Builder is not available for object, Entity Framework and Excel data sources.

The document consists of the following sections.

Run the Query Builder
Select Tables
Join Tables
Edit Parameters
Filter Data
Shape Data
Enable Custom SQL Editing
Preview Results

Run the Query Builder
You can invoke the Query Builder from the query customization page of the Report Wizard when creating a new data-bound
report or when binding an existing one to a database. To do this, select the Query item and click the Run Query Builder button.



You can also use the Query Builder to add queries to an existing SQL data source, as well as to edit existing queries. To do this,
right-click the data source in the Report Explorer and select Manage Queries in the context menu.

In the invoked Manage Queries dialog, click Add to add a new query. To edit an existing query, click the ellipsis button.

Finally, click the Run Query Builder button in the invoked Data Source Wizard.

Select Tables
To add a specific data table or view to a query, drag the corresponding item from the list of available tables and drop it onto the
list of data tables to be used.



Enable check boxes for the table fields that you want to include in the query result set.

Each table provides the context menu, which allows you to rename the table or remove it from the query.

To search for a specific table or view, click the list of available tables on the left and start typing the search name.



Join Tables
You can join multiple tables within the same query. The Query Builder automatically highlights tables related to any of the
previously added tables. Drag-and-drop a subordinate table in the same way as a principal table to include it in a query and
automatically create an inner join relation based on a key column.

Another way to join tables is to click the  button in a row corresponding to a key column.

To customize the relationship, click the corresponding ellipsis button. Use the Join Editor to select the join type (Left Outer or
Inner), applied logical operator (Equals to, Is less than, etc.) and column key fields.

A left outer join returns all the values from an inner join along with all values in the "left" table that do not match to the "right"
table, including rows with NULL (empty) values in the key field.

If tables do not have a relationship at the database level, you can manually join tables. In this case, when you drag-and-drop the
required table onto the list of tables to be used, the Join Editor is automatically invoked allowing you to construct a custom join
relationship.

After executing the query, it will return a "flat" table composed of data records selected based on the specified join options.
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Although joining different tables within a single query may be required in some scenarios, creating hierarchical data sources
generally results in better performance (in general, master-detail reports are generated faster than similar-looking reports created
by grouping "flat" data sources).

Edit Parameters
Click the Edit Parameters button to invoke the Query Parameters dialog, which allows you to add and remove query
parameters as well as specify parameter settings.

For each query parameter, the following properties are available.

Name - specifies the name used to refer a parameter.
Type - specifies the data type of the parameter's value.
Expression - determines whether the actual parameter value is static or generated dynamically.
Value - specifies the actual value of a query parameter. If the Expression option is enabled, the actual parameter value is
produced dynamically by calculating an associated expression, which is particularly useful when you need to map the query
parameter value to the value of a report parameter.

The created parameters will be then available on the Configure Query Parameters wizard page.

For general information on query parameters, see Query Parameters.

Filter Data
To specify filter criteria, click the Filter... button in the Query Builder. This invokes the Filter Editor, which provides the following
capabilities.

Filter Tab



The editor contains the Filter tab allowing you to specify filter conditions for resulting data. Filter criteria can be assigned
query parameters or bound to report parameters.

Group Filter Tab

The Group Filter tab allows you to specify filter conditions for grouped and aggregated data. If data is not grouped, the
second tab is disabled.

Other Options

Using this editor, you can limit the number of resulting data rows. If data is sorted, you can specify how many rows to skip
before retrieving the specified number of rows.
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Depending on the selected data provider, it can be impossible to take into account the skip setting in the provider-specific
SQL string.

Another option enables you to include only distinct values into the resulting set.

Shape Data
The Query Builder displays the column list under the data source editor, which provides various shaping options.

The following options are available.

Column

Specifies the selected column.

You can choose a required column in the drop-down list or create a column expression by clicking the ellipsis button for the
corresponding column.

Table



Specifies the table containing the selected column.

This option indicates (All Tables) if an expression is specified for the corresponding column.

Alias

Specifies a custom column name (alias).

This option is available only for columns that are included in a query.

Output

Specifies whether or not the column is included into the query’s resulting set.

Sorting Type

Specifies whether to preserve the original order of data records within the column, or sort them (in ascending or
descending order).
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When binding to XML files, the Query Builder does not support sorting by aggregate functions, DISTINCT and SELECT ALL
statements, and custom SQL.

Sort Order

This option becomes available after applying sorting to the data column records.

It defines the priority in which sorting is applied to multiple columns (the less this number is, the higher the priority).

For example, if column A has the sort order set to 1 and column B has it set to 2, the query will be first sorted by column A
and then by the column B.

Changing this setting for one column automatically updates the sort order of other columns to avoid a conflict of priorities.

Group By

Specifies whether or not the query’s result set should be grouped by this column.

Aggregate

Specifies whether or not the column's data records should be aggregated.

The following aggregate functions are supported.

Count
Max
Min
Avg
Sum
Count Distinct
Avg Distinct

Sum Distinct

Applying any of these functions to a column will discard individual data records from the query result set, which will
only include the aggregate function result.
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You should apply aggregation/grouping to either all columns or to none of them.



Enable Custom SQL Editing
If custom SQL editing is enabled by your software provider, the Query Builder contains the Allow Edit SQL check box. Selecting
this option disables the visual features of the Query Builder and allows users to specify the custom SQL string manually.

Preview Results
You can preview the result of the query execution in the form of a tabular data sample by clicking the Preview Results button.

This opens the Data Preview window displaying the query result set limited by the first 1000 data records.



Report WizardReport Wizard
The Report Wizard is a powerful tool that allows you to easily create reports based on built-in templates. It is automatically
invoked when adding a new report in the Report Designer.

The Report Wizard provides three different ways to setup your report.

Empty Report

Choose this option to create a new blank report that is not bound to data and doesn't contain any report controls.

Data-bound Report

This option allows you to easily create a report bound to a desired data source (database, Entity Framework, object data
source or excel data source) and generate its layout from scratch. While setting up the report, you can group and sort data,
add totals, apply one of the predefined report style, etc.

Label Report

Select this report type if you need to print out labels. In the Label Report Wizard, choose a required paper supplier and label
type, and the report will be adjusted automatically. After completing the wizard, you get an empty report that clearly
indicates label boundaries and properly positions labels within paper sheets.



Empty ReportEmpty Report
The Report Wizard allows you to create reports of three kinds: empty reports, data-bound reports and label reports. To create a
new blank report, select Empty Report and click Finish.

The created report is not bound to a data source and doesn't contain any report controls. The following image demonstrates the
default layout of this report.

You can then bind the report to a required data source and construct the report layout.



Data-bound ReportData-bound Report
The Report Wizard allows you to create three kinds of reports : empty reports, data-bound reports and label reports. To create
a data-bound report and generate its layout, select Databound Report.

Click Next to proceed to the next wizard page: Select the Data Source Type.

After completing the Data-bound Report Wizard, you get a tabular banded report. Depending on how many wizard steps you
complete, you can apply data grouping, display totals, select one of the predefined style sheets, etc.



Connect to a DatabaseConnect to a Database
The topics in this section describe the steps required to connect a report to a database using the Report Wizard.

This task includes the following steps.

Select a Data Connection
Specify a Connection String
Save the Connection String
Customize the Query
Configure Query Parameters



Select a Data ConnectionSelect a Data Connection
On this page, you can choose whether to use one of the existing data connections or create a new one.

Click Next to proceed to the next wizard page. If you select one of the available connections from the list, go to the Customize the
Query page. Otherwise, proceed to the Specify a Connection String page to create a custom connection string and manually
specify its parameters.



Specify a Connection StringSpecify a Connection String
On this page, define a custom connection string or select one of the supported data providers.

Select the provider type in the Provider drop-down list. Next, specify the connection options required for the selected provider
type (e.g., authentication type and database name).

The following data source types are supported.

Microsoft SQL Server
Microsoft Access 97
Microsoft Access 2007
Microsoft SQL Server CE
Oracle
Amazon Redshift
Google BigQuery
Teradata
Firebird
IBM DB2
MySQL
Pervasive PSQL
PostgreSQL
SAP Sybase Advantage
SAP Sybase ASE
SQLite
VistaDB
VistaDB5
XML file

Click Next to proceed to one of the next wizard pages, depending on whether or not the created connection uses server
authentication.

Save the Connection String - if server authentication is required, this page allows you to specify whether or not to save user
credentials along with the connection string.



Customize the Query - if server authentication is not required, proceed to constructing the query.



Save the Connection StringSave the Connection String
If the data connection uses server authentication, this wizard page allows you to choose whether to save the user credentials
along with the connection string.

Click Next to proceed to the next wizard page: Customize the Query.



Customize the QueryCustomize the Query
On this page, you can construct an SQL query to obtain data from the database or select a stored procedure.

Construct a Query
Select a Stored Procedure

Construct a Query
To construct an SQL query, do the following.

1. Select the Query option and click the Run Query Builder button.

2. In the invoked Query Builder window, select an item from the list of available tables on the left and drop it onto the list of
data tables to be used.

3. Enable the check box near the added table to include all of its fields in the data view.



Click OK to exit the Query Builder.

For more information on the Query Builder, refer to the Query Builder document.

Select a Stored Procedure
To use a stored procedure, choose the Stored Procedure option and then select the required stored procedure from the list.

If the selected query or stored procedure contains any parameters, you will be required to define their values on the next wizard
page: Configure Query Parameters.

Otherwise, clicking Next will open the next Report Wizard page: Choose Columns to Display in a Report.



Configure Query ParametersConfigure Query Parameters
On this wizard page, you can manage parameters that are used in queries and/or stored procedures selected on the previous
wizard page, as well as specify parameter values.

Click Next to proceed to the next wizard page: Choose Columns to Display in a Report.



Connect to an Entity Framework Data SourceConnect to an Entity Framework Data Source
The topics in this section describe the wizard steps required to connect a report to data provided by an Entity Framework data
context.

This task includes the following steps.

Select the Data Context
Select the Connection String
Specify a Connection String
Bind to a Stored Procedure
Select a Data Member



Select the Data ContextSelect the Data Context
This page allows you to select a required Entity Framework data context that will provide data to a report.

On this page, select a data context from the list of existing data contexts. You can also populate this list with data contexts from a
separate assembly. To do this, click Browse..., and in the invoked Open dialog, select the required assembly.

Click Next to proceed to the next wizard page: Select the Connection String.



Select the Connection StringSelect the Connection String
This page allows you to specify a connection string to be used to establish a data connection.

The following two options are available.

No, specify a custom connection string - Select this option to specify a connection string manually.
Yes, let me choose from the list - Select this option to use one of the existing connection strings from the list.

Click Next to proceed to the next wizard page. If you select the first option, proceed to the Specify a Connection String page. If
you choose one of the available connection strings, go to the Bind to a Stored Procedure or Select a Data Member page,
depending on whether or not the current Entity Framework model provides stored procedures.



Specify a Connection StringSpecify a Connection String
On this wizard page, specify a connection string. Additionally, this page requires you to specify whether or not to store the
connection string in the application configuration file.

Click Next to proceed to the next wizard page. If the current Entity Framework model provides stored procedures, go to the Bind
to a Stored Procedure page; otherwise, proceed to the Select a Data Member page.



Bind to a Stored ProcedureBind to a Stored Procedure
This wizard page allows you to add stored procedures to the data source and configure their parameters. Note that this page is
available only if the current Entity Framework model provides at least one stored procedure.

To add a stored procedure, click Add and in the invoked dialog, select the required stored procedure from the list of available
procedures.

Next, specify stored procedure parameter values, which can be either static or generated by appropriate expressions.

Click Next to proceed to the next wizard page. If you have added more than one stored procedures on this page or if the current
Entity Framework model additionally provides data tables, go to the Select a Data Member page. Otherwise, proceed to the
Choose Columns to Display in a Report page.



Select a Data MemberSelect a Data Member
This wizard page allows you to select one of the available data members that will provide data to your report.

Click Next to proceed to the next wizard page: Choose Columns to Display in a Report.



Connect to an Object Data SourceConnect to an Object Data Source
The topics in this section describe the wizard steps required to connect a report to an object data source.

This task includes the following steps.

Select an Assembly
Select a Data Source Type
Select a Data Source Member
Specify the Member Parameters
Select the Data Binding Mode
Select a Data Source Constructor
Specify the Constructor Parameters



Select an AssemblySelect an Assembly
On this wizard page, select an assembly that contains the class type definition of the data source.

To exclude irrelevant assemblies from the list, select the Show only highlighted assemblies check box. If you disable the check
box, all available data source types will be shown.

Click Next to proceed to the next wizard page: Select a Data Source Type.



Select a Data Source TypeSelect a Data Source Type
On this wizard page, select a required data source type.

To exclude irrelevant classes from the list, select the Show only highlighted types check box. If you disable this check box, all
available data source types will be shown.

Click Next to proceed to the next wizard page: Select a Data Source Member.



Select a Data Source MemberSelect a Data Source Member
This wizard page allows you to select whether you want bind to the entire object or to its public member (method or property).

Select the Show only highlighted members check box to exclude irrelevant members from the list. Otherwise, all available
members will be shown.

Click Next to proceed to the next wizard page. If you select binding to the entire object, proceed to the Select the Data Binding
Mode page. If you choose one of the available public members, go to the Specify the Member Parameters page.



Specify the Member ParametersSpecify the Member Parameters
On this wizard page, you can specify the member parameters.

To specify the member parameter's value, use the Value column. Enable the check box in the Expression column to make it
possible to specify the parameter expression using the Expression Editor. In this case, you can pass an existing report parameter
to the member or create a new one using the in-place editor.

Click Next to proceed to the next wizard page: Select the Data Binding Mode.



Select the Data Binding ModeSelect the Data Binding Mode
On this wizard page, you can choose one of the following data binding modes.

Retrieve the data source schema - Select this option to retrieve only the data source schema from the specified object
and edit the report layout without having access to the actual underlying data.
Retrieve the actual data - Select this option to automatically create an instance of the data source type and obtain its
actual data.

Click Next to proceed to the next wizard once you select the data binding mode.

Choose Columns to Display in a Report - if you select the first option, go to choosing columns to display in a report.
Select a Data Source Constructor - this page allows you to choose a required constructor to create an instance of the data
source.



Select a Data Source ConstructorSelect a Data Source Constructor
On this wizard page, select a data source constructor to be used to create an instance of the data source.

Enable the Show only highlighted constructors check box to exclude irrelevant constructors from the list. Otherwise, all
available constructors will be shown.

Click Next to proceed to the next wizard page: Specify the Constructor Parameters.



Specify the Constructor ParametersSpecify the Constructor Parameters
On this wizard page, you can specify the constructor parameters.

To specify the constructor parameter's value, use the Value column. Enable the check box in the Expression column to make it
possible to specify the parameter expression using the Expression Editor. In this case, you can pass an existing report parameter
to the constructor or create a new one using the in-place editor.

Click Next to proceed to the next wizard page: Choose Columns to Display in a Report.



Connect to an Excel Data SourceConnect to an Excel Data Source
The topics in this section describe the wizard steps required to connect a report to an Excel data source.

This task includes the following steps.

Select an Excel Workbook or CSV file
Specify Import Settings
Select a Worksheet, Table or Named Region
Choose columns



Select an Excel Workbook or CSV fileSelect an Excel Workbook or CSV file
On this wizard page, select a required Microsoft Excel workbook (the XLS, XLSX and XLSM formats are supported) or CSV file. To
do this, click the ellipsis button and locate the source file, or enter the full path to this file.

Click Next to proceed to the next wizard page: Specify Import Settings.



Specify Import SettingsSpecify Import Settings
On this wizard page, you can specify required import settings. This page provides access to different settings depending on
whether you have selected an Excel Workbook or CSV file.

Import Settings for an Excel Workbook
The following settings are available if an Excel workbook has been selected.

Use values of the first rows as field names - Specifies whether values of the first row should be imported as field names.
If this option is disabled, values of the first row will be imported as data and field names will be generated automatically.
Skip empty rows - Specifies whether or not to include empty rows to the resulting data source.
Skip hidden rows - Specifies whether or not to include hidden rows to the resulting data source.
Skip hidden columns - Specifies whether or not to include hidden columns to the resulting data source.

Click Next to proceed to the next wizard page: Select a Worksheet, Table or Named Region.

Import Settings for a CSV file
The following settings are available if a CSV file has been selected.



Use values of the first rows as field names - Specifies whether or not values of the first row should be imported as field
names. If this option is disabled, values of the first row will be imported as data and field names will be generated
automatically.
Skip empty rows - Specifies whether or not to include empty rows to the resulting data source.
Trim Blanks - Specifies whether to delete all leading and trailing empty spaces from each value in the source CSV file.
Encoding - Specifies the character encoding in the source CSV file. If the corresponding Detect automatically check box
is enabled, this setting's value is automatically determined.
Newline type - Specifies the line break type in the source CSV file. If the corresponding Detect automatically check box
is enabled, this setting's value is automatically determined.
Value separator - Specifies a character used to separate values in the source CSV file. If the corresponding Detect
automatically check box is enabled, this setting's value is automatically determined.
Culture - Specifies culture information used to import data from the source CSV file.
Text Qualifier - Specifies the character that encloses values in the source CSV file.

Click Next to proceed to the next wizard page: Choose columns.



Select a Worksheet, Table or Named RegionSelect a Worksheet, Table or Named Region
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This wizard page appears only if you selected a Microsoft Excel Workbook on the previous page.

This wizard page allows you to select one of the available worksheets, tables or named regions that will provide data for a report.

Click Next to proceed to the next wizard page: Choose columns.



Choose columnsChoose columns
On this wizard page, you can select required columns and specify their settings.

To select a column, enable the corresponding Selected check box. Use Name to specify the custom column name and Type to
choose the column type.

This page also allows you to preview the resulting data by clicking the Preview... button.

Click Next to proceed to the next wizard page: Choose Columns to Display in a Report.



Select the Data Source TypeSelect the Data Source Type
This wizard page allows you to select the required data source type.

Click Next to proceed to the next wizard page once you select the data source type.

Connect to a Database
Connect to an Entity Framework Data Source
Connect to an Object Data Source
Connect to an Excel Data Source



Choose Columns to Display in a ReportChoose Columns to Display in a Report
This wizard page allows you to select fields (attributes) whose data will be displayed in a report.

The list on the left-hand side shows all available fields (attributes). To select the required fields to be displayed in the report, move
them to the right-hand side. Use the dedicated arrow buttons to move fields back and forth.

The selected fields and corresponding captions will be automatically added to your report and arranged one under another.

You can stop the wizard at this step by clicking Finish. In this case, the report will look similar to the image below.

If you want to customize your report further, click Next to proceed to the next wizard page: Add Groping Levels. Note that you



should select at least one field to continue creating the report.



Add Groping LevelsAdd Groping Levels
This wizard page allows you to group data in a report. If you don't need to group your data, click Next to skip this step.

Nested grouping and grouping against multiple fields are fully supported. The following image illustrates all basic grouping types.

The list on the left-hand side displays data fields that can be used to group data. To apply grouping, select the required field and
click the right arrow button. To group data against multiple columns, use the  button.

To remove a grouping field, select it in the list on the right-hand side and click the left arrow button. You can also change the
order of grouping fields using the up and down arrow buttons.

You can stop the wizard on this step by clicking Finish. In this case, the report will look similar to the one in the image below.



If you want to customize your report further, click Next. If data grouping has been applied on this page, proceed to the Specify
Summary Options page. If you haven't grouped your data, skip the Summaries step and go to the Choose a Report Layout page.



Specify Summary OptionsSpecify Summary Options
This wizard page allows you to specify totals for each data group or for the entire report. The specified totals will be displayed
after corresponding groups and in the report footer.

The page displays all available numerical and date-time fields that are not used to group data. You can select desired functions
using the check box table.

There are instances when data fields contain empty values. If you don't want to take these values into account when calculating
totals, select the Ignore NULL values check box. Otherwise, these values will be treated as zeros for numeric fields and the
earliest system date for date-time fields.

You can stop the wizard at this step by clicking Finish. If you do so, your report will look similar to the one in the image below.



If you want to further customize your report, click Next to proceed to the next wizard page: Choose a Report Layout.



Choose a Report LayoutChoose a Report Layout
This page allows you to specify the layout of elements in your report. If you haven't applied data grouping, you can specify how
data field values are arranged - into a table, one under another, etc. If report data is grouped, you can choose one of the available
indentation styles for nested elements.

Additionally, this page allows you to specify the page orientation for your report.

The following options are available if data grouping has been applied.

If data hasn't been grouped, you will see the following report layout options.

You can stop the wizard at this step by clicking Finish. If you want to customize your report further, click Next to proceed to the
next wizard page: Choose a Report Style.



Choose a Report StyleChoose a Report Style
On this wizard page, you can specify one of the predefined visual styles for the report.

You can stop the wizard at this step by clicking Finish. If you want to customize your report further, click Next to proceed to the
next wizard page: Enter the Report Title.



Enter the Report TitleEnter the Report Title
On this page, specify the title for the report and click Finish to exit the wizard.



Label ReportLabel Report
The Report Wizard allows you to create reports of three kinds: empty reports, data-bound reports and label reports. To
generate a label report, select Label Report and click Next.

After completing the Label Report Wizard, you will get a blank report that generates labels of a specifc size. The report designer
will indicate the label boundaries and properly position labels within paper sheets. You can then populate the label area with the
required content and print out your labels.

Label creation consists of the following two steps.

Select the Label Type
Customize the Label Options



Select the Label TypeSelect the Label Type
This wizard page is intended to select one of the numerous predefined label types.

On this page, you can choose the proper supplier from the Label product combo box and a particular product from the Product
number list. The selected type defines the label's size and layout, as well as the default page type for this label.

Click Next to proceed to the next wizard page: Customize the Label Options.



Customize the Label OptionsCustomize the Label Options
This wizard page is intended to manually adjust label settings that were automatically specified in the previous step based on the
selected supplier and product.

Editors on this page allow you to choose the Page Size and freely customize label parameters. The pane on the right-hand side
provides a label dimensions preview.

Click Finish to complete report creation.



Document PreviewDocument Preview
To display a preview for the report currently being opened in the Report Designer, switch to the Print Preview tab. You will see
the report populated with data and divided into pages.

The document preview allows you to check the print output of a report and customize its additional options using the Preview
Toolbar. The report can be then exported to different third-party formats, sent using e-mail or printed.

Different elements of the Report Designer's preview are covered in the following documents.

Preview Toolbar
Export Document Dialog
Parameters Panel
Search Panel
Document Map Panel
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To learn more about the options available in the preview mode, refer to the Print Preview for WPF section of this documentation.



Preview ToolbarPreview Toolbar
The Preview Toolbar provides quick access to commands related to report viewing, editing and publishing.

All available commands can be divided into the following sections.

File Command
Print Commands
Navigation Commands
Zoom Commands
Export Commands
Document Commands

File Command
Use the following command to save a report to the file.

ICON COMMAND D ES CTIPTION

Save Invokes the Save As dialog allowing you to save a report document to a file.

Print Commands
The following commands allow you to change a report page's settings and print a report document.

ICON COMMAND D ES CR IPTION

Print Invokes the Print dialog allowing you to specify the necessary settings and print a report document.

Quick Print Prints a report document using the default settings.

Page Setup Invokes the Page Setup dialog allowing you to adjust report page settings.

Scale Invokes the Scale dialog allowing you to stretch or shrink report content to a percentage of its normal size or the
number of pages.

Navigation Commands
Use these commands to navigate through a report document.

ICON COMMAND D ES CR IPTION

First Page Switches to the first report page.



Previous Page Switches to the previous report page.

Next Page Switches to the next report page.

Last Page Switches to the last report page.

ICON COMMAND D ES CR IPTION

Zoom Commands
Use these commands to zoom a report document.

ICON COMMAND D ES CR IPTION

Zoom Out Decreases a report document's current zoom factor.

Zoom In Increases a report document's current zoom factor.

Zoom Zooms a report document to a specific zoom factor from the drop-down list.

Export Commands
Use these commands to export a report document to one of the supported third-party formats.

ICON COMMAND D ES CR IPTION

Export Invokes the Export Document dialog allowing you to export a report document into one of the supported third-
party formats and save the resulting file on a hard drive.

Send
Invokes the Send via E-Mail dialog allowing you to export a report document into one of the supported third-party
formats, save the resulting file on a hard drive and attach this file to a new empty message in the default mail
program.

Document Commands
Use these commands to change the visibility state of the Designer's panels and dialogs.

ICON COMMAND D ES CR IPTION

Parameters Shows/hides the Parameters Panel where you can specify report parameters before report preview generation is
started.

Document
Map Shows/hides the Document Map Panel, which reflects a report document's structure in a tree-like form.

Thumbnails Shows/hides report thumbnails used to quickly navigate between document pages.



Editing Fields Highlights all editing fields to quickly discover which of the document elements are editable.

Search Shows the Search Panel, which allows you to find a specified text throughout a report document.

Watermark Invokes the Watermark dialog that allows you to add a text watermark to a report or turn a picture into a
report's background.

ICON COMMAND D ES CR IPTION



Export Document DialogExport Document Dialog
The Print Preview allows you to view and edit various format-specific options, and then export a report to one of the supported
third-party formats. There are two options for exporting a document. The first way is to export a document to a file on disk using
the Export Document dialog.

Another approach is to utilize the Send via E-Mail dialog to export a document and send the resulting file via e-mail.

To invoke these dialogs, click the arrow for the Export...  or Send...  button, respectively, and choose the required format
from the drop-down list. If you simply click one of these buttons, the dialogs will provide settings for the PDF format. Then, you
can always change the export format directly in the dialogs using the dedicated Export Format drop-down lists.

The following third-party export formats are supported.

PDF (Portable Document Format)
HTML (HyperText Markup Language)
MHT (Web archive, single file)
RTF (Rich Text Format)
XLS (Microsoft® Word® 97 - 2003 document)
XLSX (Office® Open XML document)
CSV (Comma-Separated Values file format)
TXT (Plain text)
Image (BMP, GIF, JPEG, PNG, TIFF, EMF or WMF format)

In the dialogs, you need to specify the path where the resulting file should be saved. The Export Document dialog additionally
prompts you to choose whether or not to open the file after exporting.

The dialogs also allow you to specify advanced export options for the selected format. To access and customize these format-
specific options, click the More Options link.



Specify the required options and click OK to initiate the export of a report and save the resulting file. After closing the Send via E-
Mail dialog, the saved file will be attached to a new empty message in the default mail program.



Parameters PanelParameters Panel
The Parameters panel allows you to specify report parameters before generating a report preview.

Specify values of the required report parameters using the corresponding parameter editors and click Submit to view the
resulting report preview. After changing the current values, you can revert back the previously selected values by clicking Reset.

If a report contains at least one visible parameter, this panel is displayed by default. To manually change the panel's visibility state,

click the Parameters button  in the Toolbar. If a report doesn't contain any visible parameters, the Parameters panel cannot
be shown.



Search PanelSearch Panel
The Search panel allows you to find specific text throughout a report document.

To invoke the Search panel, click the Search button  in the Toolbar or press CTRL+F.

In the search box on the left, input the text to find. Click the Settings button to invoke the dedicated submenu allowing you to
specify whether or not to use case-sensitive search, and whether you are required to match the whole word during the search.

To start searching, or search down again, click Next, or press ENTER or CTRL+G. To search backward, click Previous or press
CTRL+SHIFT+G.



Document Map PanelDocument Map Panel
The Document Map panel is an interactive table of contents, which reflects a report's structure in a tree-like form and provides
quick navigation through its bookmarks.

If a report contains at least one control with a specified bookmark, the Document Map is displayed by default. You can then

toggle this panel's visibility state using the Document Map button  in the Toolbar. If a report does not contain bookmarks,
this panel cannot be shown.

Click a bookmark in the Document Map to navigate the Print Preview to the corresponding element in a report document.

Note that after exporting a report to the PDF format, the Document Map is exported as well.



RibbonRibbon
The Ribbon organizes commands into a tabbed interface, providing quick and intuitive access to these commands.

 

Topics in this section:

Frequently Used Ribbon Commands
Minimize Ribbon
Invoke Ribbon Commands



Frequently Used Ribbon CommandsFrequently Used Ribbon Commands
Frequently used commands are typically displayed within the Quick Access Toolbar, at the top of the Ribbon:

To add any command to the Quick Access Toolbar, right-click the command and select Add to Quick Access Toolbar:

To add a group of commands to the Quick Access Toolbar, right-click the group's caption and select Add to Quick Access
Toolbar:

To remove any command from the Quick Access Toolbar, right-click the command and select Remove from Quick Access
Toolbar:



Minimize RibbonMinimize Ribbon
To minimize the Ribbon, right-click any command and select Minimize the Ribbon:

To restore the Ribbon, right-click any command or page and uncheck the Minimize the Ribbon option:

You can also minimize and restore the Ribbon by double-clicking any tab page header.



Invoke Ribbon CommandsInvoke Ribbon Commands
To select a specific command, you can click it with the mouse or invoke it via its shortcut. See below for more information.

Shortcuts are associated with each page and command in the Ribbon. To see the shortcuts, press ALT or F10. Shortcuts will
appear next to the corresponding tab pages and commands:

Shortcuts can be composed of one, two or three symbols. If a shortcut is represented by one symbol, you can invoke the
command by pressing this symbol. If a shortcut is represented by two or three symbols, to invoke the command, press the
symbols one after another.

Initially, when pressing ALT or F10, shortcuts are displayed for commands within the Quick Access Toolbar (at the top of the
Ribbon) and for tab pages. To access shortcuts for commands within a specific tab page, you need to press the shortcut associated
with this page.

For example, to display shortcuts for commands within the Home page (see the image above), press H:



Rich Text EditorRich Text Editor
This section describes the capabilities provided by the Rich Text Editor.

Text Editor UI
Editor Elements
Toolbars
Ribbon Interface

File Operations
Create a New Document
Load a Document
Save a Document
Print a Document

Document Layout and Page Setup
Divide a Documents into Sections
Adjust Page Settings
Lay Out Text in Columns
Add Line Numbers
Change Page Background Color

View and Navigate
Navigate through a Document
Switch Document Views
Zoom a Document

Edit Text
Select Text
Delete Text



Find and Replace Text
Use a Clipboard
Check Text Spelling
Undo and Redo Last Operations

Formatting
Format Text
Format Paragraphs
Apply and Modify Styles

Pictures and Text Boxes
Insert a Picture
Insert, Select, Copy or Delete a Text Box
Add, Change or Delete a Border for a Picture or Text Box
Add, Change or Delete a Text Box Fill
Rotate a Picture or Text Box
Move a Picture or Text Box
Wrap Text around a Picture or Text Box
Resize a Picture or Text Box

Lists
Numbered Lists
Bulleted Lists
Multilevel Lists

Tables
Insert a Table
Add and Remove Table Borders
Customize a Style of Cell Borders
Select a Cell, Row or Column
Insert a Cell, Row or Column
Delete a Cell, Row or Column
Merge or Split Cells
Align Text in Table Cells
Set Background Color of Cells

Header and Footer
Header and Footer

Embed Fields (Mail Merge)
Mail Merge

Table of Contents
Create a Table of Contents
Create Table of Contents for Special Cases
Update Table of Contents



Track Changes
Turn On Track Changes
Accept and Reject Changes

Protect Documents
Protect and Unprotect a Document
Edit a Protected Document

Miscellaneous
Insert a Bookmark
Insert a Hyperlink
Insert a Comment
Insert a Page Break
Insert Page Numbers
Insert a Symbol
Set Document Properties



Editor ElementsEditor Elements
The Rich Text Editor can contain the following visual elements:

Command UI

The Rich Text Editor can be provided with a Ribbon or with a set of toolbars. Each command bar type enables end users to
perform basic operations (format and edit text, create lists, add headers and footers, work with tables, etc.).

Views



The Rich Text Editor is able to display documents in three different ways depending on the applied View. You can change the
active view and control the visibility of the editing surface elements.

Rulers

The Rich Text Editor's editing surface is provided with horizontal and vertical rulers. The rulers help end you align text, shapes,
tables and other elements.

Scrollbars

The document view can display horizontal and vertical scrollbars if a page does not fit into the control's display area.

Reviewing Pane

The Reviewing Pane displays all comments contained in the document and allows you to navigate throughout the comments and



modify them.

Pop-up Menus

When you clicks different visual objects, a specific pop-up menu appears. The Rich Text Editor provides several pop-up menu
types.



ToolbarsToolbars
The Rich Text control can be accompanied by a set of toolbars that provide a comprehensive functionality for the Rich Editor.

Common

Create a New Document
Load a Document
Save a Document
Print a Document
Undo and Redo Last Operations

Info

Set Document Properties

Clipboard

Use a Clipboard

Font

Format Text

Paragraph

Format Paragraphs

Editing



Find and Replace Text

Styles

Apply and Modify Styles

Pages

Insert a Page Break

Tables

Insert a Table

Illustrations

Insert a Picture

Text

Insert, Select, Copy or Delete a Text Box

Links



Insert a Bookmark
Insert a Hyperlink

Header & Footer

Header and Footer
Insert Page Numbers

Symbols

Insert a Symbol

Page Setup

Adjust Page Settings
Lay Out Text in Columns
Insert a Page Break
Divide a Documents into Sections
Add Line Numbers

Background

Change Page Background Color

Mail Merge



Mail Merge

Document Views

Switch Document Views

Show

Show Rulers

Zoom

Zoom a Document

Navigation

Header and Footer

Options

Header and Footer

Close

Header and Footer



Table Styles

Add and Remove Table Borders

Table Style Options

Add and Remove Table Borders

Borders&Shadings

Customize a Style of Cell Borders
Set Background Color of Cells

Table

Select a Cell, Row or Column
Set Table Properties

Rows & Columns

Insert a Cell, Row or Column
Delete a Cell, Row or Column

Merge

Merge or Split Cells



Cell Size

Adjust Column Width

Alignment

Align Text in Table Cells

Protect

Protect and Unprotect a Document

Proofing

Check Text Spelling

Table of Contents

Create a Table of Contents
Create Table of Contents for Special Cases
Update Table of Contents

Captions

Create Table of Contents for Special Cases



Shape Styles

Add, Change or Delete a Border for a Picture or Text Box
Add, Change or Delete a Text Box Fill

Arrange

Wrap Text around a Picture or Text Box
Move a Picture or Text Box

Comment

Insert a Comment

Tracking

Insert a Comment



Ribbon InterfaceRibbon Interface
The comprehensive functionality for the Rich Text control can be provided via set of Ribbon tabbed pages. Ribbon pages are
structurally and visually split into logical groups. Each of these groups includes commands that have some common features.

File

Create a New Document
Load a Document
Save a Document
Print a Document
Undo and Redo Last Operations
Set Document Properties

Home

Use a Clipboard
Format Text
Format Paragraphs
Apply and Modify Styles
Find and Replace Text

Insert

Insert a Page Break
Insert a Table
Insert a Picture
Insert a Bookmark
Insert a Hyperlink
Header and Footer
Insert Page Numbers
Insert, Select, Copy or Delete a Text Box
Insert a Symbol



Page Layout

Adjust Page Settings
Lay Out Text in Columns
Insert a Page Break
Divide a Documents into Sections
Add Line Numbers
Change Page Background Color

References

Create a Table of Contents
Create Table of Contents for Special Cases
Update Table of Contents

Mail Merge

Mail Merge

Review

Check Text Spelling
Protect and Unprotect a Document
Insert a Comment
Enable Track Changes
Accept and Reject Changes

View



Switch Document Views
Show Rulers
Zoom a Document

Header & Footer Tools / Design

Header and Footer

Table Tools / Design

Select a Cell, Row or Column
Set Table Properties
Insert a Cell, Row or Column
Delete a Cell, Row or Column
Merge or Split Cells
Adjust Column Width
Align Text in Table Cells

Table Tools / Layout

Add and Remove Table Borders
Customize a Style of Cell Borders
Set Background Color of Cells



Picture Tools / Format

Add, Change or Delete a Border for a Picture or Text Box
Add, Change or Delete a Text Box Fill
Wrap Text around a Picture or Text Box
Move a Picture or Text Box



Create a New DocumentCreate a New Document
To create a new empty document, on the File tab, in the Common group, use the New button, or the CTRL+N keyboard shortcut.



Load a DocumentLoad a Document
To load a document, on the File tab, in the Common group, click the Open button, or use the CTRL+O keyboard shortcut.

The Open dialog appears, allowing you to select a file.

The Rich Editor enables you to open documents of the following types:

Rich Text Format (*.rtf)
Text Files format (*.txt)
Hyper Text Markup Language format (*.htm, *.html)
web page archive format (*.mht)
Microsoft Word 97-2003 format (*.doc)
WordML (*.xml)
Open Office XML format (aka Office 2007 or *.docx)
Open Document Format (*.odt)
Electronic Publication (*.epub)



Save a DocumentSave a Document
To save a document, on the File tab, in the Common group, click the Save button or use the CTRL+S keyboard shortcut. This
allows you to save a document using the save parameters that were previously set.

If you want to save a document using another file name or to modify other parameters (e.g. file format or location), on the File
tab, in the Common group, click the Save As button or press the F12 key.

After that, the Save As dialog will appear. Note that the same dialog appears if you click the Save button to save a document,
which has been never saved before.

In this dialog you can specify document name, document format and the location to which the document should be saved. The
Rich Text Editor allows you to save documents in the following formats:

Rich Text Format (*.rtf)
Text Files format (*.txt)
Hyper Text Markup Language format (*.htm, *.html)
web page archive format (*.mht)
Microsoft Word 97-2003 format (*.doc)
WordML (*.xml)
Open Office XML format (aka Office 2007 or *.docx)



Open Document Format (*.odt)
Electronic Publication (*.epub)
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When saving a document in HTML format, in-line pictures are saved in the %FileName%_files folder, where %FileName% is the
name of the document file. Image files are named "imageN.png", where N is the picture index starting from the beginning of the
document.



Print a DocumentPrint a Document
Preview a Document Before Printing
To display the document as it will look when printed, on the File tab, in the Common group, click the Print Preview button.

Print a Document
1. On the File tab, in the Common group, click the Print button...

...or press CTRL+P.

The Print dialog will be invoked.



2. In the Print dialog, specify all required settings and click Print.

Print a Document Using Default Settings
To send a document directly to the default printer without customizing print settings, on the File tab, in the Common group, click
the Quick Print button.



Divide a Documents into SectionsDivide a Documents into Sections
You can divide your document into sections to specify parts of a document that have different page settings (page margins, page
orientation, paper size), column layouts, line numbering and headers and footers.

Insert Section Breaks
To divide a document into sections, insert section breaks.

1. Click where you want to inset a section break within a document.

2. On the Page Layout tab, in the Page Setup group, click the Breaks button and select one of the following types of section
breaks.

Column - starts a new section on the next column on the page.
Next Page - inserts a section break and starts a new section on the next page.
Continuous - starts the new section on the same page.
Even Page - inserts a section break and starts a new section on the next even-numbered page.
Odd Page - inserts a section break and starts a new section on the next odd-numbered page.

To show the section break mark, press CTRL+SHIFT+8 or on the Home tab, in the Paragraph group, click the Show/Hide
Paragraph button.

In a document, section breaks are marked as illustrated below.



Change Section Break Type
You can change the type of the section break that has been inserted to start a section. To do this, follow the instructions below.

1. Click the section following the section break that you wish to change.

2. Invoke the Page Setup dialog by clicking the dialog box launcher.

3. Change the Section start property on the Layout tab as required.



Adjust Page SettingsAdjust Page Settings
When changing page layout settings (such as page margins, page orientation, paper size), you can apply them to the whole
document or set specific page layout settings for each individual section if your document is divided into sections.

Change Page Margins
1. Click within a section whose page margins you wish to set.

2. On the Page Layout tab, in the Page Setup group, click the Margins button and select the margin sizes to be set for the
current section from the invoked list...

... or specify page margins for the current section or the whole document via the Page Setup dialog. To invoke the dialog,
click the Page Setup dialog box launcher.

Change Page Orientation
1. Click within a section for which you wish to specify page orientation.

2. On the Page Layout tab, in the Page Setup group, click the Orientation button and select Portrait or Landscape from
the invoked list...



... or set the page orientation for the current section or the whole document on the Margins tab of the Page Setup dialog.

Change Paper Size
1. Click within a section for which you wish to set the paper size.

2. Click the Size button on the Page Layout tab and select one of the standard paper sizes from the invoked list...

... or specify the paper size for the current section or the entire document on the Paper tab of the Page Setup dialog.



Lay Out Text in ColumnsLay Out Text in Columns
To split a text into columns, follow the steps below.

1. Click within a section which you wish to lay out in several columns.

2. On the Page Layout tab, in the Page Setup group, click the Columns button and select the number of columns into which
the text should be split...

... or click More Columns to invoke the Columns dialog where you can adjust columns layout of the text in a more flexible
way for the current section or the whole document.

To move the text to the next column (if the text in the current section is laid out into multiple columns), insert a column break.

1. Click within a document where you wish to insert a column break.

2. On the Page Layout tab, in the Page Setup group, click the Breaks button and select Column from the invoked list...



... or press CTRL+SHIFT+ENTER.

To show the column break mark, press CTRL+SHIFT+8 or click the Show/Hide Paragraph button on the File tab.

In a document, column breaks are marked as illustrated below.



Add Line NumbersAdd Line Numbers
1. To add line numbers to a whole document, select the entire document if your document is divided into multiple sections. If

your document consists of one section only, simply click anywhere within a document.

To add line numbers to a particular section or multiple sections, click a section or select multiple sections.

2. On the Page Layout tab, in the Page Setup group, click Line Numbers and select one of the available line numbering
types from the invoked list...

...or click Line Numbering Options to invoke the Line Numbers dialog that you can use to adjust line numbering options
in a more flexible way (specify the value to be used for the first line - Start at, increment value for line numbering - Count
by, distance between line number and the start of the text line - From text).



Change Page Background ColorChange Page Background Color
On the Page Layout tab, in the Background group, click Page Color and select the required color for the background of the
document pages.



Navigate through a DocumentNavigate through a Document
You can navigate through a document in the following ways:

Use the mouse device to click anywhere in the document;
Use the mouse device to drag the scroll box to move through the document;
Rotate the wheel button to scroll up and down the document;
Use keyboard shortcuts.

The following table lists the default keyboard shortcuts to navigate through a document.

K EYB OAR D  S HOR TCU T EFFECT

LEFT ARROW Moves the cursor to the previous character.

RIGHT ARROW Moves the cursor to the next character.

UP ARROW Moves the cursor to the previous line.

DOWN ARROW Moves the cursor to the next line.

HOME Moves the cursor to the start of the current line.

END Moves the cursor to the end of line.

PAGE UP Moves the cursor backward by the number of lines in the current control's window, minus one.

PAGE DOWN Moves the cursor forward by the number of lines in the current control's window, minus one.

CTRL+LEFT ARROW Moves the cursor to the previous word.

CTRL+RIGHT ARROW Moves the cursor to the next word.

CTRL+UP ARROW Moves the cursor to the beginning of the previous paragraph.

CTRL+DOWN ARROW Moves the cursor to the beginning of the next paragraph.

CTRL+HOME Moves the cursor to the start of the document, and scrolls the document to show the cursor position.

CTRL+END Moves the cursor to the end of the document, and scrolls the document to show the cursor position.

CTRL+PAGE UP Moves the cursor to the beginning of the previous page.

CTRL+PAGE DOWN Moves the cursor to the beginning of the next page.



Switch Document ViewsSwitch Document Views
The Rich Edit control provides a number of document views that you can switch depending on what you want to do.

Simple View
A simple view shows a document without a page layout. This view can be useful when you want to concentrate on text editing.

To enable this view, on the View tab, in the Document Views group, click the Simple View button.

Draft View
The draft view is a view without pagination. It does not display complex formatting features that are most appropriate to the page
layout. You can use it for the simplest representation of the document, as well as quick text editing.

To enable this view, on the View tab, in the Document Views group, click the Draft View button.



In draft view the horizontal ruler is available. To show or hide it, click Horizontal Ruler on the View ribbon tab.

Print Layout View
The print layout view is intended to display all formatting in the document, including complex formatting, and can be used to
preview the document printout.

To enable this view, on the View tab, in the Document Views group, click the Print Layout button.



When the print layout view is active, the horizontal and vertical rulers are available. To show or hide horizontal and vertical rulers,
on the View tab, in the Show group, click the Horizontal Ruler and Vertical Ruler buttons, respectively.



Zoom a DocumentZoom a Document
You can zoom in and out of a document in the following ways:

On the View tab, in the Zoom group, click the Zoom In and Zoom Out buttons.

 

Hold the CTRL button and rotate your mouse wheel.



Select TextSelect Text
To select text in the Rich Editor, use the following mouse actions and keyboard shortcuts.

Selecting one character

To select only one character, click before the character, hold down the Shift key and click the Right Arrow once.

Selecting one word

To select one word in a document, place the cursor anywhere in the word (or just before it) and double-click with the left
mouse button. Another method is to place your cursor at the beginning of the word, hold down the Shift and Ctrl keys, and
click the Right Arrow.

Selecting one paragraph

Selecting one paragraph is similar to selecting one word. Place the cursor in the paragraph and click three times with the
left mouse button. Another method is to place the cursor in the left margin and click twice to highlight the whole
paragraph.

Selecting entire document

Click three times on the left side of the page in the margin area, and the entire document will be highlighted. Also, the
CTRL+A keyboard shortcut can be used to highlight the entire document.

Selecting one line

The cursor in the margin will highlight one line with one click. Another method is to place the cursor at the beginning of the
line, and use the SHIFT+END keyboard shortcut to extend selection to the end of the line. Similarly, at the end of the line
the SHIFT+HOME keyboard shortcut can be used.

The following table lists the default keyboard shortcuts used for selecting text in the Rich Editor.

SHIFT+LEFT ARROW Extends the selection to the previous character.

SHIFT+RIGHT ARROW Extends the selection to the next character.

SHIFT+UP ARROW Extends the selection to the previous line.

SHIFT+DOWN ARROW Extends the selection one line down.

SHIFT+HOME Extends the selection to the beginning of the line.

SHIFT+END Extends the selection to the end of the current line.

SHIFT+PAGE UP Extends selection to the previous screen.

SHIFT+PAGE DOWN Extends the selection to the next screen.

CTRL+SHIFT+LEFT ARROW Extends the selection to the previous word.

CTRL+SHIFT+RIGHT ARROW Extends the selection to the next word.

CTRL+SHIFT+UP ARROW Extends the selection to the previous paragraph.



CTRL+SHIFT+DOWN ARROW Extends the selection to the next paragraph.

CTRL+SHIFT+HOME Extends the selection to the beginning of the document.

CTRL+SHIFT+END Extends the selection to the end of the document.

CTRL+SHIFT+PAGE UP Extends the selection to the previous page.

CTRL+SHIFT+PAGE DOWN Extends the selection to the next page.

CTRL+A Selects the entire document.

CTRL+NUM 5 Selects the entire document.



Delete TextDelete Text
The Backspace key deletes one character to the left of the caret. The Delete key deletes one character to the right of the caret.

To delete more than just a few characters, select text and press the Delete key.

The following table lists the default keyboard shortcuts used for deleting text.

BACKSPACE Moves the cursor backwards and erases the character in that space.

CTRL+BACKSPACE Deletes the previous word in the text.

DELETE Deletes the selected text.

CTRL+DELETE Deletes the next word in the text.

SHIFT+DELETE Cuts the selected text and places it on the clipboard.

CTRL+X Cuts the selected text and places it on the clipboard.



Find and Replace TextFind and Replace Text
Find Text
To search for every occurrence of a specific word or phrase:

1. On the Home tab, in the Editing group, click the Find button...

... or press CTRL+F.

The Find and Replace dialog will be invoked.

2. In the Find what box, type the text to search for.
3. Select other search options that you want and click Find Next.
4. To cancel a search, click Cancel or press ESC.

Find and Replace Text
To automatically replace text:

1. On the Home tab, in the Editing group, click the Replace button...

... or press CTRL+H.

The Find and Replace dialog will be invoked.



2. In the Find what box, type the text to replace.
3. In the Replace with box, type the replacement text.
4. Select other search options that you want and click Find Next, Replace or Replace All.

Use Regular Expressions to Find and Replace Text
You can use regular expressions to search for specific text containing a particular pattern:

1. On the Home tab, in the Editing group, click Find or Replace...

 

... or press CTRL+F or CTRL+H.

The Find and Replace dialog will be invoked.

2. Select the Regular expression check box.

3. In the Find what box, enter the regular expression pattern using a list of specific characters:



4. If you want to replace the found text, click the Replace tab and enter the replacement text in the Replace with box.
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You can tag various parts of a regular expression to use them in replacement expression (for example, to rearrange the
parts of the expression). A regular expression may have up to 9 tagged expressions, numbered according to their order in
the regular expression. To enter a tagged expression in the Replace with box, enter its index after the symbol $ or select it
from the list of tagged expressions:

5. Click Find Next, Replace or Replace All.



Use a ClipboardUse a Clipboard
The Rich Text Editor allows you to move and copy text and images using the Clipboard.

To move or copy a text or image, follow the steps below.

1. Select the text or image you wish to move or copy.

2. Depending on what you want, do one of the following.

To move the selection, on the Home tab, in the Clipboard group, click the Cut button , or press CTRL+X, or press
SHIFT+DELETE. This cuts the selection from the document and places it on the Clipboard.

To copy the selection, on the Home tab, in the Clipboard group, click the Copy, or press CTRL+C, or press
CTRL+INSERT. This copies the selection and places it on the Clipboard.

3. Point to the position where you want to insert the contents from the Clipboard.

4. On the Home tab, in the Clipboard group, click the Paste  button, or press CTRL+V, or press SHIFT+INSERT. This
pastes the contents of the Clipboard into the document.

You can also choose the format for data contained in the Clipboard and paste it into the document as if that data is
imported from the specified format. To do this, on the Home tab, in the Clipboard group, click the Paste Special, or press
CTRL+ALT+V, ...

... and select the required data format from the invoked Paste Special dialog.





Check Text SpellingCheck Text Spelling
The Rich Text Editor supports spell-check. All misspelled words in your document (words that are not found within the available
dictionaries in the Spell Checker) are underlined. You can work with misspelled words via the context menu, invoked when right-
clicking the underlined word.

In the context menu, you can do one of the following:

Select one of the suggested corrections for the misspelled word to correct it;
Ignore the current occurrence of the word;
Ignore all occurrences of the word;
Add the word to the dictionary in the Spell Checker.

To perform spell check word-by-word, select the Check Spelling item from the context menu, or on the Review tab, in the
Proofing group, click the Spelling button ...

... or press F7.

The Spelling dialog will be invoked.



In this dialog, select what to do with the misspelled word, click corresponding button, and you will jump to the next misspelled
word.



Undo and Redo Last OperationsUndo and Redo Last Operations
The Rich Editor allows you to undo and redo the last operation using the special buttons (Undo and Redo) on the File tab.

The Undo command reverses the most recent action you have performed. To undo an action, on the File tab, in the Common
group, click the Undo button, or press CTRL+Z, or press ALT+BACKSPACE.

You can execute multiple Undo operations. To return the document to its previous state, just keep performing Undo.

The Redo command enables you to take back the last action you've undone. To redo an action, click the Redo button, or press
CTRL+Y, or press ALT+SHIFT+BACKSPACE.



Format TextFormat Text
To format text, first select it and then use the Font page group on the Home tab to change the font family, size, color, etc.

Also, you can modify the font using the Font dialog. Select the text that you want to format, right-click it and choose the Font
item from the context menu.

The Font dialog appears as illustrated below.

In this dialog, you can specify all required font parameters, and apply them to the selected text.

In addition, the Rich Editor provides a list of default keyboard shortcuts for text formatting:

CTRL+B Toggles the bold style on the selection.

CTRL+I Toggles the italic style on the selection.

CTRL+U Toggles the underline style on the selection.



CTRL+D Invokes the Font dialog that allows you to change the font, size and style of the selected text.

CTRL+PLUS Toggles the subscript style on the selection.

CTRL+CLOSEBRACKETS
(]) Increases the font size of the selected text by one point.

CTRL+OPENBRACKETS
([) Decreases the font size of the selection by one point.

CTRL+SHIFT+PERIOD Increases the font size of the selection to the closest larger predefined value.

CTRL+SHIFT+COMMA Decreases the font size of the selection to the closest smaller predefined value.

CTRL+SHIFT+D Toggles the double underline style on the selection.

CTRL+SHIFT+PLUS Toggles the superscript style on the selection.

CTRL+SHIFT+H Toggles between the normal and hidden text mode for the selection. To view the hidden text, press
CTRL+SHIFT+8.

CTRL+SPACE Clears formatting of selected text - resets it to default.



Format ParagraphsFormat Paragraphs
To format a paragraph, first click anywhere within it or select the paragraph, and then use the Paragraph page group on the
Home tab to change line spacing, indentation, alignment and styles.

Also, you can use the Paragraph dialog to format the paragraph. To invoke this dialog, right-click the paragraph and select the
Paragraph item from the context menu.

The Paragraph dialog appears, as illustrated below.

In this dialog, you can change different parameters for the paragraph (Indents and Spacing tab) and pagination (Line and Page
Breaks tab).

The Rich Editor provides a list of the default keyboard shortcuts to format paragraphs.



CTRL+1 Formats a current paragraph with single line spacing.

CTRL+2 Formats a current paragraph with double line spacing.

CTRL+5 Formats a current paragraph with one and a half line spacing.

CTRL+E Toggles centered paragraph alignment on and off.

CTRL+J Toggles justified paragraph alignment on and off.

CTRL+L Toggles left paragraph alignment on and off.

CTRL+R Toggles right paragraph alignment on and off.



Apply and Modify StylesApply and Modify Styles
To format a text or a paragraph you can apply styles. A style is a group of formatting characteristics. All these characteristics are
applied to a text or a paragraph at once when you apply a style. Thus, styles allow you to change text and paragraph appearance
quicker than setting all formatting characteristics separately (Format Text, Format Paragraphs).

A character based style includes characteristics to format text within a paragraph (e.g., font type and size, bold and italic formats,
etc.)

A paragraph based style affects paragraph formatting characteristics such as text alignment, line spacing, etc. It can also include
character formatting characteristics.

Apply a Style
To apply a style, do the following.

1. Select text or a paragraph that you want to format.

2. On the Home tab, in the Styles group, click or type a required style name in the Quick Styles box .

Modify a Style
You can modify an existing style via the Modify Style dialog.

To invoke the dialog, do the following:

1. On the Home tab, in the Styles group, click the Modify Style button:

2. The Modify Style dialog enables you to change the base style for the current style (to specify how the styles cascade), the
style which should be used for the following paragraph, and basic characteristics of the style, such as Font, Paragraph and
Tab Stops.





Insert, Select, Copy or Delete a Text BoxInsert, Select, Copy or Delete a Text Box
Insert a Text Box
To insert a text box into your document, position the caret to the desired location and on the Insert tab, in the Text group, click
the Text Box button.

A floating text box enables you to specify fill color, outline width and color and apply formatting to the box content.

Select a Text Box
To select a text box, click a border of the text box.

�� N o t eN o t e

If the caret is placed inside the text box, you can modify the text box content, but it is impossible to move, copy, delete the text box
or specify such attributes as fill color, outline color and weight, text wrapping, position, etc. In this case, the text box is not
considered as selected, the Picture Tools / Format tab and corresponding items of the text box's context menu are unavailable.



Copy a Text Box
1. Select a text box to be copied.
2. On the Home tab, in the Clipboard group, click Copy, or select it from the context menu, or press CTRL+C, or press

CTRL+INSERT.
3. Position the caret to the location where you want to insert the copy of the selected text box.
4. On the Home tab, in the Clipboard group, click Paste, or select it from the context menu, or press CTRL+V, or press

SHIFT+INSERT.

Delete a Text Box
1. Select a text box that you wish to remove.
2. Press DELETE.



Insert a PictureInsert a Picture
You can insert graphics in the document, and convert it to inline or floating.

The Rich Text Editor supports the following graphic types:

Bitmap (*.bmp, *.dib)
JPEG File Interchange Format (*.jpg, *.jpeg)
Portable Network Graphics (*.png)
Graphics Interchange Format (*.gif)
Tagged Image Format (*.tif, *.tiff)
Microsoft Enhanced Metafile (*.emf)
Windows Metafile (*.wmf)

To insert a picture into your document, position the caret to the desired location and on the Insert tab, in the Illustrations group,
click the Picture button.

The Open dialog appears, allowing you to locate a file with graphics.

The inserted picture has an In Line with Text wrapping style which you can change later.





Add, Change or Delete a Border for a Picture or Text BoxAdd, Change or Delete a Border for a Picture or Text Box
You can specify the color and weight of the outside border of a floating picture or text box, or fully delete the border.

Set the Color of a Picture or Text Box Border
1. Select the floating picture or text box whose outline border color you wish to specify.

2. On the Picture Tools / Format tab, in the Shape Styles group, click Shape Outline and select the required color.
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By default, a floating picture is inserted with no border. To specify a colored outline border for a picture, a border weight must be
set.

Set the Weight of a Picture or Text Box Border
1. Select a floating picture or text box whose outline border weight you wish to specify.

2. Select the required border weight from the Shape Outline Weight list accessed on the Picture Tools / Format tab, in the
Shape Styles group.

Remove a Picture or Text Box Border
1. Select a floating picture or text box whose outline border you wish to remove.



2. On the Picture Tools / Format tab, in the Shape Styles group, click Shape Outline button and select No Outline.



Add, Change or Delete a Text Box FillAdd, Change or Delete a Text Box Fill
Specify a Text Box Fill

1. Select a text box whose background you wish to color.

2. On the Picture Tools / Format tab, in the Shape Styles group, click Shape Fill button and select the required color.

Delete a Text Box Fill
1. Select a text box whose fill you wish to remove.

2. On the Picture Tools / Format tab, in the Shape Styles group, click Shape Fill button and select No Fill.



Rotate a Picture or Text BoxRotate a Picture or Text Box
1. Click the floating picture or text box that you wish to rotate.

2. Do one of the following.

Click the round arrow that appears over the selected floating picture or text box and drag it in the direction to which
you wish to rotate the object.

To rotate an object by 15 degree angles, drag the round arrow at the top of the object while holding down the SHIFT
key.

Right-click a picture or text box to be rotated and select the More Layout Options... item from the context menu.
Switch to the Size tab in the invoked Layout dialog and set the required value of the angle to rotate the object in the
Rotation box.



Move a Picture or Text BoxMove a Picture or Text Box
Move a Picture or Text Box

1. Select the floating picture or text box that you wish to move.
2. Drag the object to the new location.

Move a Picture or Text Box Forward or Backward
When you add floating objects into a document, they are automatically inserted in particular layers. Objects can overlap. In this
case the top object covers lower objects (in full or in part). You can move particular objects up and down in a stack one layer at a
time, or move them to the top or bottom of a stack in one click.

1. Select the floating picture or text box that you wish to move up or down in the stack.

2. Select the required item from the floating object's context menu ...

... or Picture Tools / Format tab.

To move the selected floating object one layer forward to the front, click Bring to Front -> Bring Forward.
To move the selected floating object in front of the text layer and any other floating objects, Bring to Front -> Bring
to Front.
To move the selected floating object in front of the text layer, click Bring to Front -> Bring in Front of Text.
To move the selected floating object one layer forward to the back, click Send to Back -> Send Backward.
To move the selected floating object behind the text or any other floating object, click Send to Back -> Send to Back.
To move the selected floating object behind the text layer, click Send to Back -> Send Behind Text.



Wrap Text around a Picture or Text BoxWrap Text around a Picture or Text Box
Wrap Text around Picture or Text Box

1. Select a picture or a text box.

2. To specify a way text wraps around the selected object, do one of the following.

On the Picture Tools / Format tab, in the Arrange group, click Wrap Text and select the required type of text
wrapping around the selected object from the invoked list.

Right-click the selected floating object, and select the required type of the text wrapping from the Wrap Text sub-
menu of the invoked context menu.

Right-click the selected floating object, and select the More Layout Options... item from the context menu. Switch to
the Text Wrapping tab of the invoked Layout dialog and specify the required text wrapping settings for the floating
object.



Position a Picture or Text Box within a Document
1. Select a picture or text box whose location you want to specify.

2. Specify an object location in one of the following ways.

On the Picture Tools / Format tab, in the Arrange group, click the Position button and select the required position
of the object from the invoked list.

Right-click the object to be positioned and select the More Layout Options... item from the context menu. On the
Position tab of the invoked Layout dialog, specify the required position for the floating object.





Resize a Picture or Text BoxResize a Picture or Text Box
To resize a picture or text box, shrink or stretch an object in the following way.

1. Click a floating picture or text box to be resized.

2. Drag a sizing handle towards or away from the object center until a required size is reached.

To keep object proportions when resizing it, check the Lock aspect ratio option (it is accessed via the Layout dialog that is
invoked when selecting the More Layout Options... item from the context menu of the floating object). In this case when you
change a width of the object by dragging a corner sizing handle, the object's height will be automatically changed to maintain
exact proportions of the object and vice-versa.

To specify an exact height and width of the object, clear the Lock aspect ratio check box.



Numbered ListsNumbered Lists
Create a Numbered List as You Type

1. Point to the position within a document from which you want to begin your list.

2. On the Home tab, in the Paragraph group, click the Numbering  button.

3. Type the text.
4. Press ENTER to create the next item of the list.
5. To finish the list, press ENTER twice.

Make a Numbered List from the Selected Text
You can add numbers to existing lines of text in two ways. The first one is to use the Paragraph toolbar:

1. Select the text lines that you want to transform into a list.

2. On the Home tab, in the Paragraph group, click the Numbering  button.

Another way to do the same thing is to use the context menu:

1. Select the text to be transformed into a list.

2. Right-click within the document and select the Bullets and Numbering item from the appeared context menu.

3. In the invoked Bullets and Numbering dialog, click the Numbered tab and choose the list style that you want to apply.



Create Your Own List Style
You can create your own style for a numbered list on the basis of one of the existing list styles, by changing different list
parameters.

1. Select the numbered list (or text to be transformed into the numbered list) to which you want to apply your own style.

2. Right-click within the document and select the Bullets and Numbering item from the resulting context menu. The Bullets
and Numbering dialog will be displayed.

3. Click the Numbered tab, choose one of the existing styles and click Customize.... The Customize Numbered List dialog
will be invoked.
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The Customize... button is disabled if the None item of the Bullets and Numbering dialog is selected.

4. In this dialog, change different list parameters to create your own list style.

For instance, if you specify list parameters in the following way,...

...you will get the list style as illustrated below.



Bulleted ListsBulleted Lists
Create a Bulleted List as You Type

1. Point to the position in a document from where you want to begin your list.

2. On the Home tab, in the Paragraph group, click the Bullets  button .

3. Type the text.
4. Press ENTER to create the next item of the list.
5. To finish the list, press ENTER twice.

Make a Bulleted List from the Selected Text
You can add bullets to existing lines of text in two ways. The first method is to use the Home ribbon tab:

1. Select the text lines that you want to transform into a list.
2. On the Home tab, in the Paragraph group, click the Bullets button.

Another way to do the same thing is to use the context menu:

1. Select the text to be transformed into a list.

2. Right-click within the document and select the Bullets and Numbering item from the invoked context menu.

3. In the invoked Bullets and Numbering dialog, click the Bulleted tab and choose the list style that you want to apply.



Create Your Own List Style
You can create your own style for a bulleted list on the basis of one of the existing list styles, by changing various list parameters.

1. Select the bulleted list (or text to be transformed into the bulleted list) to which you want to apply your own style.

2. Right-click within the document and select the Bullets and Numbering item from the resulting context menu. The Bullets
and Numbering dialog will be displayed.

3. Click the Bulleted tab, choose one of the existing styles and click Customize.... The Customize Bulleted List dialog will be
invoked.
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The Customize... button is disabled if the None item of the Bullets and Numbering dialog is selected.

4. In this dialog, change different list parameters to create your own list style.

For instance, if you specify list parameters in the following way,...

...you will get the list style as illustrated below.



Multilevel ListsMultilevel Lists
Create a Multilevel List as You Type

1. Point to the position within a document from which you want to begin your list.

2. On the Home tab, in the Paragraph group, click the Multilevel list  button.

3. Type the text.
4. To change levels of the list, press TAB and SHIFT+TAB, or, on the Home tab, in the Paragraph group click the Increase

Indent  and Decrease Indent  buttons. Press ENTER to create the next item on the current level.
5. To finish the list, press ENTER twice.

Make a Multilevel List from the Selected Text
You can make multilevel list from existing lines of text in two ways. The first one is to use the Paragraph toolbar:

1. Select the text lines that you want to transform into a list.

2. On the Home tab, in the Paragraph group, click the Multilevel list  button.

3. Use TAB and SHIFT+TAB, or the Increase Indent  and Decrease Indent  buttons to change levels.

Another way to do the same thing is to use the context menu:

1. Select the text to be transformed into a list.

2. Right-click within the document and select the Bullets and Numbering item from the invoked context menu.



3. In the invoked Bullets and Numbering dialog, click the Outline Numbered tab and choose the list style that you want to
apply.

4. Use TAB and SHIFT+TAB, or the Increase Indent  and Decrease Indent  buttons of the Paragraph toolbar to
change levels.

Create Your Own List Style
You can create your own style for a multilevel list on the basis of one of the existing list styles, by changing different list
parameters.

1. Select the multilevel list (or text to be transformed into the multilevel list) to which you want to apply your own style.

2. Right-click within the document and select the Bullets and Numbering item from the resulting context menu. The Bullets



2. Right-click within the document and select the Bullets and Numbering item from the resulting context menu. The Bullets
and Numbering dialog will be displayed.

3. Click the Outline Numbered tab, choose one of the existing styles and click Customize.... The Customize Outline
Numbered List dialog will be invoked.
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The Customize... button is disabled if the None item of the Bullets and Numbering dialog is selected.

4. In this dialog, change different list parameters to create your own list style.

For instance, if you specify list parameters in the following way,...



...you will get the list style as illustrated below.

5. Use TAB and SHIFT+TAB, or the Increase Indent  and Decrease Indent  buttons of the Paragraph toolbar, to
change levels.



Insert a TableInsert a Table
Insert a Table

1. Click the position within a document where you want to insert a table.

2. Click the Table button on the Insert tab.

3. In the invoked Insert Table dialog, select the required number of table rows and columns.

4. Alternatively, you can select the required table size in the drop-down control box:

Insert a Table inside Another Table
Tables that are located inside other tables are called nested tables.

To insert a nested table:

1. Point to the position within a table cell where you want to insert a table.
2. Insert a table.



Add and Remove Table BordersAdd and Remove Table Borders
Add Borders

Add Borders to the Whole Table

1. Select a table.

2. On the Table Tools/Layout tab, in the Borders&Shadings group, click the Borders button and select one of the
available border sets.

Add Borders to Specified Cells Only

1. Display gridlines to view boundaries of the table cells and select cells to be provided with borders.

2. On the Table Tools/Layout tab, in the Borders&Shadings group, click the Borders button and select the border
that you want to apply to cells.

Remove Table Borders
Remove Borders from the Whole Table

1. Select a table.

2. On the Table Tools/Layout ribbon tab in the Borders&Shading group, click the Borders button and select No
Borders from the invoked list.



Remove Borders from Specified Cells Only

1. Display gridlines to view boundaries of the table cells and select cells from which you want to remove borders.

2. On the Table Tools/Layout tab, in the Borders&Shading group, click the Borders button and select No Borders
from the invoked list.

Show or Hide Gridlines
Gridlines show boundaries of a table cells when no borders are applied. Unlike borders, gridlines are shown on screen only and
never printed.

To show or hide table gridlines, on the Table Tools/Layout tab, in the Borders&Shading group, click the View Gridlines
button.





Customize a Style of Cell BordersCustomize a Style of Cell Borders
Before you add borders to table cells, you can specify a style to be applied to borders.

To set a style for cell borders, do the following:

1. Select a table or specific cells whose borders you want to customize.

2. On the Table Tools/Layout tab, in the Borders&Shading group, change required options (Line Style, Line Weight, Pen
Color).

3. Add borders using the Table Styles group of the Table Tools / Design tab.



Select a Cell, Row or ColumnSelect a Cell, Row or Column
Select a Cell
You can select a table cell in one of the following ways.

Double-click a cell.

Click the left edge of a cell.

Click a cell to be selected. Then on the Table Tools/Layout tab, in the Table group, click the Select button and choose
Select Cell from the invoked list.
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To select multiple cells, click the left edge of a cell and then drag it across other cells.

Select a Row
To select a table row you can do one of the following.

Click to the left of a row.

Click a cell included into a row to be selected. Then on the Table Tools/Layout tab, in the Table group, click the Select
button and choose Select Row from the invoked list.

Select a Column
To select a table column you can do one of the following.

Click the top edge of a column.



Click a cell included into a column to be selected. Then on the Table Tools/Layout tab, in the Table group, click the Select
button and choose Select Column from the invoked list.

Select a Table
Click any cell of a table. Then on the Table Tools/Layout tab, in the Table group, click the Select button and choose the Select
Table item from the invoked list.



Insert a Cell, Row or ColumnInsert a Cell, Row or Column
Insert a Cell

1. Click a cell located directly to the right or below where you want to insert a cell, and then on the Table Tools\Layout tab, in
the Rows & Columns group, click the Insert Cells button...

2. ...or right-click a cell relative to which you want to add a new cell, select the Insert item from the context menu and click
Insert Cells.

3. In the invoked Insert Cells dialog choose one of the available options:



OPTION D ES CR IPTION E X AMPLE

Shift
cells
right

Insert a new cell just to the left of the selected cell and move the selected cell and all other cells
following this cell in that row to the right.

Shift
cells
down

Insert a new cell in the selected cell's place and move other cells in that column down one row each.
A new row will be added at the bottom of the table to include the last existing cell. Remaining cells
in this new row will be empty.

Insert
entire
row

Insert a new row just above the row containing the selected cell.

Insert
entire
column

Insert a new column just to the left of the column containing the selected cell.

Insert a Row
1. Click a cell located directly below or above where you want to insert a new row.

2. Do one of the following:

To add a new row just above the row containing the selected cell, on the Table Tools\Layout tab, in the Rows &
Columns group, click the Insert Rows Above button.

To add a new row just below the row containing the selected cell,on the Table Tools\Layout tab, in the Rows &
Columns group, click the Insert Rows Below button.

...or right-click a cell relative to which you want to insert a row, click the Insert item in the context menu and select
Insert Rows Above or Insert Rows Below.



Insert a Column
1. Click a cell located directly to the right or left of where you want to insert a new column.

2. Do one of the following:

To add a new column just to the left of the column containing the selected cell, on the Table Tools\Layout tab, in the
Rows & Columns group, click the Insert Columns to the Left button.

To add a new column just to the right of the column containing the selected cell,on the Table Tools\Layout tab, in
the Rows &Columns group, click the Insert Columns to the Right button...

... or right-click a cell relative to which you want to insert a column, click the Insert item in the context menu and select
Insert Columns to the Left or Insert Columns to the Right.





Delete a Cell, Row or ColumnDelete a Cell, Row or Column
Delete a Cell

1. Click a cell to be deleted and then on the Table Tools/Layout tab, in the Rows & Columns group, click the Delete button
and select Delete Cells from the invoked list...

2. ...or right-click a cell to be deleted and select Delete Cells... from the context menu.

3. In the invoked Delete Cells dialog choose one of the available options:

OPTION D ES CR IPTION E X AMPLE



Shift cells left Delete the selected cell and move all other cells in the row
to the left.

Shift cells up Delete the selected cell and move all other cells in the
column up.

Delete entire row Delete a row containing the selected cell.

Delete entire
column Delete a column containing the selected cell.
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Delete a Row
1. Select a row to be deleted or click on one cell included into that row.

2. On the Table Tools/Layout tab, in the Rows & Columns group, click the Delete button and select Delete Rows from the
invoked list...

3. ...or select a row to be deleted, right-click it and select Delete Rows from the invoked context menu.



Delete a Column
1. Select a column to be deleted or click on one cell included into that column.

2. On the Table Tools/Layout tab, in the Rows & Columns group, click the Delete button and select Delete Columns from
the invoked list...

3. ...or select a column to be deleted, right-click it, and select Delete Columns from the invoked context menu.





Merge or Split CellsMerge or Split Cells
Merge Cells

1. Select cells that you wish to merge. For example, you can select multiple cells, a whole row or column.

2. On the Table Tools/Layout tab, in the Merge group, click the Merge Cells button.

–You can also:

Right-click cells to be merged and select Merge Cells from the context menu.
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The Merge Cells button becomes available, after you have selected the table cells to be merged.

Split Cells
1. Click a cell or select multiple cells that you wish to split.

2. On the Table Tools/Layout tab, in the Merge group, click the Split Cells button.



2. On the Table Tools/Layout tab, in the Merge group, click the Split Cells button.

–You can also:

If you wish to split a single cell, right-click this cell and select Split Cells from the context menu.
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The Split Cells... item of the context menu is available, if you right-click one cell of a table only.

3. In the invoked Split Cells dialog, set the number of columns and rows into which the selected cells should be split.

If multiple cells are selected, you can first merge these cells and then spit the newly created cell into the specified number of
columns and rows (select the Merge cells before split check box in the dialog) ...



... or each of the selected cells can be split (clear the Merge cells before split check box).

Split Table
1. Click any cell included into a row relative to which you wish to split a table. This row will be the first row of the second table.

2. On the Table Tools/Layout tab, in the Merge group, click the Split Table button.



Align Text in Table CellsAlign Text in Table Cells
By default, text is aligned to the top left corner of a table cell. You can change both the vertical and horizontal alignment of text in
a table cells.

1. Click a cell or select multiple cells containing text that you want to align.

2. Click one of the available buttons on the Table Tools/Layout tab, in the Alignment group.

3. Right-click the cells, point to the Cell Alignment item and select the desired options from the invoked list.



Adjust Column WidthAdjust Column Width
Automatically Change Column Width to Fit Entered Data

1. Click within a table.

2. On the Table Tools/Layout tab, in the Cell Size group, click the AutoFit button and select AutoFit Contents.

Automatically Change Table Width to Fit Page Margins
1. Click within a table.

2. On the Table Tools/Layout tab, in the Cell Size group, click the AutoFit button and select AutoFit Window.

Fix a Specific Width for Each Column in a Table
1. Specify a width for each column in a table (for example, by using the mouse or via the Table Properties dialog).

2. On the Table Tools/Layout tab, in the Cell Size group, click the AutoFit button and select Fixed Column Width.



Set Background Color of CellsSet Background Color of Cells
1. Select a table or specific cells whose background color you want to set.

2. Click the Shading arrow and select a color to fill-in the background of the selected cells.



Set Table PropertiesSet Table Properties
To change settings of table rows, columns, particular cells or whole tables, use the Table Properties dialog. To invoke this dialog,
click within a table whose properties you wish to specify, and on the Table Tools/Layout tab, in the Table group, click the
Properties button.

–You can also:

Right-click within a table to be modified and select Table Properties... form the context menu.

The Table Properties dialog includes several tabs.

On the Table tab you can set table properties, such as the preferred width for an entire table and table alignment (position
of the table relative to the margins of the page).



The Options... button invokes the Table Options dialog that allows you to set default cell margins (spacing between cell
borders and text within each cell), specify whether the additional space should be between cells, set the amount of this
space, and set whether or not table columns should be automatically expanded to accommodate cell content.

The Row tab allows you to set the height of the table row, enable or disable the row to break across pages, and specify
whether or not the row should be the first row on each page in case the table is more than one page.

On the Column tab, you can set the preferred width for the table column.



Options on the Cell tab allow you to set the preferred width of the table cell and select a vertical alignment of the text within
the cell.

The Options... button invokes the Cell Options dialog allowing you to customize cell margins (space between cell borders
and cell content) and specify whether or not the text within the cell should be wrapped and fitted.



Header and FooterHeader and Footer
Headers and footers are the areas at the bottom or the top of each page in a document. You can insert text or graphics into
headers and footers (for example, page numbers, a company logo, the document title or file name, the author's name).

Insert a Header or Footer
1. On the Insert tab, in the Header&Footer group, click the Header or Footer button.

2. Type text or insert graphics in the header or footer area.

3. To switch between the header and footer areas, use the Go to Header and Go to Footer buttons of the Header & Footer
Tools / Design ribbon tab.

 

4. If necessary, you can align and format text in the header and footer areas, as required.

5. To finish, double-click anywhere in the document, or on the Header & Footer Tools / Design tab, in the Header&Footer
group, click Close Header and Footer.

Create a Different Header or Footer for the First Page
You can skip the header or footer on the first page, or create a unique header or footer for the first page of the document.

1. Double-click the header or footer area on the first page of the document.

2. On the Header & Footer Tools / Design tab, in the Options group, click the Different First Page button.



3. If necessary, click the Show Next and Show Previous buttons on the Header & Footer Tools / Design tab to activate the
First Page Header and First Page Footer areas.

4. Change the contents of the header or footer on the first page (or delete the contents of the header or footer to use no
header or footer on the first page of the document).

Create a Different Header or Footer for Odd and Even Pages
1. On the Insert tab, in the Header&Footer group, click the Header or Footer button.

2. On the Header & Footer Tools / Design tab, in the Options group, click the Different Odd & Even Pages button.

3. If necessary, click the Show Next and Show Previous buttons on the Header & Footer Tools / Design tab to move into
the header or footer areas of odd or even pages.

4. Create the header or footer for odd pages in the Odd Page Header or Odd Page Footer areas and create the header or



footer for even pages in the Even Page Header or Even Page Footer areas.

Use Specific Headers and Footers for Each Section
If your document is divided into sections, you can specify different headers and footers for each section.

1. Click the first section from the document beginning whose headers and footers you wish to change.

2. Click the Header or Footer button on the Insert tab.

3. On the Header & Footer Tools / Design tab, in the Navigation, click Link to Previous group to break the connection
between the current section and the previous section.

4. Modify the existing header or footer as required, or create a new header or footer for the current section.

5. Repeat the previous two steps for the next sections for which you want to set specific headers and footers. Use the Show
Next button on the Header & Footer Tools / Design ribbon tab to navigate to header or footer areas of the next sections.



Mail MergeMail Merge
The Mail Merge feature enables you to use the text retrieved from a data source for filling in the fields in a document template.
This feature is useful for letters, catalogs, mailing labels, and for personalizing any kind of a document.
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If the data source provides formatted text to insert in the merge field, its formatting will not be recognized and properly
processed.

To merge data fields in a Rich Text Editor document, perform the following steps.

Prepare a Data Source

To perform a mail merge, you need a template and a data source. The template is a document containing fields
(placeholders for the information that will be merged). The data source contains data that will be merged into the fields in
the document template to create merged documents.

 

Create a Template for Mail Merge (Insert Fields)

When an application runs with the mail merge data source attached to the Rich Text Editor, you can create a template for
mail merge. To do this, create a new document, type the mail content and insert merge fields into this document. To insert
fields, on the Mail Merge tab, in the Mail Merge group, click the Insert Merge Field button.

The drop-down list or a dialog window containing field names will be shown.

Choose the required field and click Insert. The field is inserted at the cursor position.

 

Preview Field Values

The Show All Field Codes button on the Mail Merge tab displays field codes for all fields in the document.



The Show All Field Results button on the Mail Merge ribbon tab displays field placeholders if the View Merged Data
button is switched off. If this button is switched on, then the current record of the data source is displayed in place of the
field.

The merge field code looks like the following:

{MERGEFIELD "field name" [* MERGEFORMAT]}

The optional * MERGEFORMAT switch, which you can add manually, retains formatting applied to the field.

 



Create a Table of ContentsCreate a Table of Contents
Create a TOC Using Built-In Heading Styles
The easiest way to create a TOC is to use built-in heading styles.

Mark TOC EntriesMark TOC Entries
1. Select the text (heading) that you want to appear in a TOC.

2. Click the Add Text button on the References tab and then select the required level (for example, if you want the selected
text to be displayed as the main heading in the TOC, click Level 1, etc.). If you change your mind and decide not to include
the selected text in the TOC, click Do Not Show in Table of Contents.

[

After you have applied levels in a newly created document once or if you have opened a document with specified TOC
entires by using heading styles, the corresponding heading styles (Heading 1, Heading 2, etc.) are automatically added to
the list of available styles accessed via the Styles page group. In this case you can mark TOC entries by choosing these
heading styles.

B uild a TOCB uild a TOC

After you have specified all required TOC entries, everything is ready to generate a TOC.

1. Click within the document where you want to insert a TOC.

2. In the Table of Contents group, click Table of Contents.



This will automatically generate a TOC that consists of entries marked by using heading styles.

If you click the Show All Field Codes button on the Mail Merge toolbar, you will see the TOC field code. By default, it is {
TOC \h }. The \h switch inserts all TOC entires as hyperlinks.

Create a TOC Using Paragraph Outline Levels
If you wish to include some text in a TOC without changing the text appearance, you can use outline levels. Unlike heading styles,
outline levels applied to text do not affect text formatting characteristics.

Mark TOC EntriesMark TOC Entries
1. Select the text that you wish to appear in the TOC.
2. Right-click the selected text and choose Paragraph from the context menu. The Paragraph dialog will invoked.

3. In this dialog, use the Outline level combo box to specify the outline level for the selected text. If you change your mind
and decide not to include the selected text to the TOC, click Body Text.

B uild a TOCB uild a TOC

After you have specified all required TOC entries, everything is ready to generate a TOC.

1. Click within the document where you want to insert a TOC.
2. Press CTRL+F9 to create an empty field wherein you can manually enter a field code to insert a TOC.
3. In this field, write the { TOC \u } field code. Use the \u switch to include text marked with outline levels in the TOC.
4. To show the result TOC, place the cursor in the TOC field, right-click it and select the Update Field item from the context

menu, or click the Update Table button on the References tab.

Create a TOC Using Fields



Along with built-in heading styles and outline levels, there is another way to label text to include it in a TOC - via TC fields.
Sometimes it can be quicker and easier to add TC fields to mark TOC entries, rather than format the document using heading
styles or outline levels. TC fields can be also helpful if you want to capture a portion of a long heading that should not be entirely
included in the TOC and include only that portion in the TOC. In addition, if your document needs two or more TOCs showing
different entries, you can mark entries for a particular TOC using TC fields with an identifier, which is specific for each TOC.

Mark TOC EntriesMark TOC Entries
1. Click within a document where you want to add a TC field (for example, right below an abstract heading).
2. Press CTRL+F9 to create an empty field wherein you can manually enter a field code (TC in this case) and set required

switches.

3. Write the following.

{TC "Entry Text" \f A \l 1 }

This will add the "Entry Text" first-level item (the \l switch sets the level of the TC entry) to the TOC with an \f switch and the
A identifier. The \f switch of the TC field is used to include the TC field in the corresponding TOC. A TC field identifier (A in
this case) must exactly match the text in the argument of the TOC field's \f switch. For example, the {TOC \f A} table of
contents will be created from TC fields like {TC "Entry Text" \f A}.

�� N o t eN o t e

TC fields display no result in the document. To view field codes, click Show All Field Codes on the Mail Merge tab.

B uild a TOCB uild a TOC
1. Click within the document where you want to insert a TOC.
2. Press CTRL+F9 to create an empty field wherein you can manually enter a field code to insert a TOC.

3. Write the following:

{TOC \f A}

The \f switch collects the TC field entries in the TOC. This switch's field-argument (A in this case) specifies which TC fields



should be included in the TOC (TC fields with the same identifier - A).

4. To show the resulting TOC, place the cursor in the TOC field, right-click it and select the Update Field item from the context
menu, or click the Update Table button on the References ribbon tab.



Create Table of Contents for Special CasesCreate Table of Contents for Special Cases
A table of contents (TOC) in a document is represented by a special TOC field. There is set of TOC field switches that you can
combine to create TOCs of different types. This document describes how to create the following TOCs.

TOC for the Specified Portion of a Document
TOC Including Paragraphs with Specified Outline Levels
Table of Figures (Tables, Equations)

TOC for the Specified Portion of a Document
To build a TOC consisting of titles (marked with built-in heading styles) from a specified portion of a document only, follow the
steps below.

1. Mark entries to be included in the TOC by using built-in heading styles (Heading 1, Heading 2, etc.).
2. Mark a portion of a document whose headings you want to include in the TOC with the "Chapter1" bookmark.
3. Insert an empty field (CTRL+F9) and enter a TOC field code with the \b switch and bookmark name: {TOC \b Chapter1}.

TOC Including Paragraphs with Specified Outline Levels Only
To generate a TOC from Heading 1, Heading 2 and Heading 3 entries only (or paragraphs with outline levels 1 through 3), use the
\o switch in the TOC field code.

{TOC} {TOC \O "1 -3 " }

Table of Figures (Tables, Equations)
The following step-by-step instructions describe how to create a TOC from items numbered by a SEQ field (for example, table of
figures), add sequence numbers (figure numbers) before page numbers in the table of contents, and specify the separator
between sequence and page numbers.

1. Specify captions for figures that you want to include in the table of figures. To do this, click the Insert Caption button on
the References tab and select Figures Caption...



... or add the {SEQ Figure} field code (via CTRL+F9).

2. Click within a document where you wish to insert the table of figures.

3. Click Insert Table of Figures on the References ribbon tab and select Table of Figures.

If you click the Show All Field Codes button on the Mail Merge ribbon tab, you will see the TOC field code - { TOC \h \c
"Figure" }. The \c switch is used to build a TOC from items that are numbered by a SEQ field.

4. To add figure numbers before page numbers in the table of figures and insert the => separator between figure and page
numbers, use the \s and \d switches of the TOC field - { TOC \h \c "Figure" \s Figure \d => }.

5. Resulting table of figures will look like the following.

In the same way you can sequentially number tables and equations in a document, and built a table of tables or equations.

�� N o t eN o t e



If you add, remove or modify captions, you can quickly update the table of figures by using the References button on the
Captions ribbon tab or by selecting the Update Field item from the context menu.



Update Table of ContentsUpdate Table of Contents
If you have added, removed or modified TOC entries in your document, you can quickly update the TOC in one of the following
ways.

Place the cursor in the TOC and press F9.
Place the cursor in the TOC and click the Update Table button on the Table of Contents toolbar.
Select Update Field from the context menu.

�� N o t eN o t e

Note that if the Table of Contents contains hyperlinks (TOC is created using the {TOC \h} field code), you should position mouse
pointer at the upper left corner of the table to have an effect on entire TOC rather than on a particular hyperlink.



Enable Track ChangesEnable Track Changes
The Track Changes feature allows you to keep track of the changes.

Turn On Track Changes
On the Review tab, in the Tracking group, click the Track Changes button.

When Track Changes is turned on, red lines in the margin indicate the changes.

When you turn of Track Changes, the Rich Text Editor does not mark changes but displays the lines in the document.

View Changes
Use the Display for Review drop-down list to specify how to display changes in the document. On the Review tab, in the
Tracking group, open the Display for Review list.

Select one of the following modes:

All Markup - displays revisions in details.



Simple Markup - displays revisions indicated by a red line in the margin.

No Markup - displays the document without any visible revisions (as if all revisions are accepted).

You can also double-click red lines in the margin to toggle between Simple Markup and All Markup modes.

�� N o t eN o t e

Rich Text Editor does not display changes in the Reviewing Pane or in balloons.

Use Next and Previous buttons on the Changes ribbon group to switch between changes.

V iew Changes from Specific AuthorsV iew Changes from Specific Authors

On the Review tab, in the Tracking group, open the Show Markup list. Select users whose changes you wish to display in the
Reviewers list.

Lock Tracking



You can set a password that prevents users from disabling Track Changes. In the Tracking group on the Review tab, click Lock
Tracking in the Track Changes drop-down list.

Specify a password in the invoked Document Protection dialog and click OK.

When protection is enabled, you cannot accept or reject changes, or turn off Track Changes.



Accept and Reject ChangesAccept and Reject Changes
Accept Changes
Accept A  Specific ChangeAccept A  Specific Change

Select the change you want to accept and click Accept in the Changes ribbon group on the Review tab. This accepts the change
and moves the cursor to the next change.

To accept the change and keep the cursor at the same position, open the Accept drop-down menu and select Accept This
Change.

You can also accept a change from the context menu.



Accept A ll ChangesAccept A ll Changes

All the changes can be accepted simultaneously. In the Changes ribbon group on the Review tab, open the Accept drop-down
menu and select one of the following options:

Accept All Changes - Accept all changes and keep Track Changes on;
Accept All Changes and Stop Tracking - Accept all changes and disable Track Changes;
Accept All Changes Shown - Accept all visible changes (available if changes from specific authors are displayed).

Reject Changes
Reject A  Specific ChangeReject A  Specific Change

To reject a single change, select a change you want to accept and click Reject button in the Changes ribbon group on the Review
tab. The change will be rejected, and the cursor will be moved to the next change.



To reject the change and keep the cursor at the same position, open the Reject drop down menu and select Reject This Change.

You can also reject a change from the context menu.

Reject A ll ChangesReject A ll Changes

You can reject all changes at once. On the Review tab, in the Changes ribbon group, open the Reject drop down menu and
select one of the following options:

Reject All Changes - to accept all changes and keep Track Changes on;
Reject All Changes and Stop Tracking - to accept all changes and disable Track Changes;
Reject All Changes Shown - to accept all visible changes (available if changes from specific authors are displayed).





Protect and Unprotect a DocumentProtect and Unprotect a Document
Protect a Document
Follow the steps below to protect a document with a password.

1. On the Review tab, in the Protect group, click the Protect Document button.

2. Specify a protection type in the invoked Document Protection dialog. Select No changes (Read-only) to restrict all
actions, Comments - to allow leaving comments only, Tracked Changes - to prevent other users from creating untracked
changes.

3. Type a password in the Enter new password (optional) box and confirm it in the Reenter password to confirm box.

You can also allow particular users to change certain parts of a document.

Give Users Permission to Edit Certain Document Parts
Before adding protection to a document, you can specify certain parts of the document where you want to remove the restriction
and allow a particular user or group of users to modify these parts.

1. Select a part of a document to be available.

2. On the Review tab, in the Protect group, click the Range Editing Permissions button.



3. In the invoked Editing Permissions dialog, select a user or group of users to be allowed to edit the selected part of a
document.

4. Editable ranges will be highlighted and enclosed in brackets.

5. Continue to select the document regions and give users permission to edit them.
6. After specifying all required parts, enable protection.

Remove Protection from a Document
1. On the Review tab, in the Protect group, click the Unprotect Document button.

2. In the invoked Unprotect Document dialog, type the password.





Edit a Protected DocumentEdit a Protected Document
When a document is protected, it is read-only except for specific unrestricted parts. You can modify a document part if you have
been given permission to make changes to this part. Editable document regions can be easily recognized - they are highlighted
and enclosed in brackets.



Insert a BookmarkInsert a Bookmark
A Bookmark exposes a document range with a name. The range can have a zero length. The name should start with a letter and
can include numbers.

To create a new bookmark, place the caret at the chosen location, or select the text to mark, and on the Insert tab, in the Links
group, click the Bookmark button...

...or choose the Bookmark... item from the context menu.

In the invoked Bookmark dialog, specify the bookmark name and click Add.

After you insert a bookmark in a document, you can insert a hyperlink to make a cross-reference to this bookmark.



Insert a HyperlinkInsert a Hyperlink
The Hyperlink marks the document range as a hot spot in the document. It can be activated by clicking or pressing ENTER, to
navigate the specified external URL, file or bookmark within the same document.

To create a new hyperlink, select a range to mark and on the Insert tab, in the Links group, click the Hyperlink button...

...or select the Hyperlink... item from the context menu ...

... or use the CTRL+K keyboard shortcut.

The Edit hyperlink dialog will appear.



Insert a CommentInsert a Comment
The Rich Text Editor supports comments- notes that can be added to a document. They make a document more understandable
by providing additional context for the data it contains. Comments are displayed in the Reviewing Pane or in a balloon that
appears in the document margins.

You can add,edit, filter and delete comments.

Add a New Comment
1. Select the text to which you wish to add a note, and in the Comment group, click the New Comment button to add a

comment.

To edit a comment, click within the comment's body and start editing.

2. You can also reply to the existing comment. Place the cursor within the comment text and click the New Comment button.
The new comment will appear under the main comment.



View Comments
1. On the Review tab in the Tracking group, click the View Comments button to display comments.

2. Document comments can also be displayed in the Reviewing Pane. To display them, on the Review tab in the Tracking
group, click the Reviewing Pane button.



3. Use the Next and Previous buttons in the Comment group to switch between comments.

Filter Comments
On the Review tab in the Tracking group, click the Show Markup button. Select the user whose comments you wish to
display from the Reviewers drop-down list, or select All Authors to see all added comments.

Delete Comments
To delete a selected comment, comments of particular reviewers or all comments, click the Delete button in the Comment



group and select the appropriate option from the drop-down list.



Insert a Page BreakInsert a Page Break
Insert Page Break
You can insert a page break in your document anywhere you want. To do this, follow the steps below.

1. Point to the position within a document where you want to insert a page break.

2. On the Insert tab, in the Pages group, click the Page break button ...

... or on the Page Layout tab, in the Page Setup group, click the Breaks button and select Page from the invoked list...

... or press CTRL+ENTER.

To show the page break mark, press CTRL+SHIFT+8 or on the Home tab, in the Paragraph group, click the Show/Hide button.

In a document, page breaks are marked as illustrated below.



Keyboard Shortcuts to Insert Breaks
You can use the following keyboard shortcuts to insert breaks of different types:

S HOR TCU T D ES CR IPTION

CTRL+SHIFT+ENTER Inserts a column break in a document.

CTRL+SHIFT+SPACE Inserts a non-breaking space.

CTRL+ENTER Inserts a page break.

ENTER Inserts a paragraph break.

SHIFT+ENTER Inserts a line break.

TAB Inserts a tab



Insert Page NumbersInsert Page Numbers
Insert a Page Number

1. On the Insert tab, in the Header&Footer group, click the Header or Footer button . For more information, see Header and
Footer.

2. Point to anywhere in the header or footer area where you want to insert the page number.

3. To add page numbers, on the Insert tab, in the Header&Footer group, click the Page Number button.

Insert a Page Count
1. On the Insert tab, in the Header&Footer group, click the Header or Footer button. For more information, see Header and

Footer.

2. Point to anywhere in the header or footer area where you want to insert the number of pages.

3. To add the number of pages, on the Insert tab, in the Header&Footer group, click the Page Count button.



Insert a SymbolInsert a Symbol
The Rich Text Editor allows you to insert symbols that are not on your keyboard, such as copyright symbols, trademark symbols,
paragraph marks.

To insert a symbol, do the following:

1. Point to the position within the document where you want to insert a symbol.

2. On the Insert tab, in the Symbol group, click the Symbol button.

The Symbol dialog will be invoked.

3. Select the symbol to be inserted and click OK, or double-click the symbol.

In addition, some symbols can be inserted in the document using default keyboard shortcuts:

S HOR TCU T D ES CR IPTION

CTRL+ALT+C Inserts the copyright (©) symbol.

CTRL+ALT+OEMPERIOD Inserts the ellipsis (…) symbol.

CTRL+ALT+R Inserts the registered trademark (®) symbol.

CTRL+ALT+- Inserts the em dash (—) symbol.

CTRL+ALT+T Inserts the trademark sign (™) symbol.

CTRL+- Inserts the en dash (-) symbol.



Set Document PropertiesSet Document Properties
You can add details about your document (title, author name, keywords, etc.) by setting the document properties. You can set the
default properties, as well as create and specify custom ones.

Change Default Properties
1. On the File tab, in the Info group, click the Document Properties button to invoke the Document Properties Dialog.

2. To change the default document properties, such as Title, Subject, Author, Category, Keywords and Comments, switch to the
Summary tab. Enter the required document information and click OK to save changes.

Create and Set Custom Properties
1. On the File tab, in the Info group, click the Document Properties button to invoke the Document Properties Dialog.

2. Switch to the Custom tab to create a new document property.



3. Enter the property's name in the Name box or select one of the presets from the list. Set the property type by selecting the
required item from the Type list and enter the value in the field below.

If you selected the "Yes or no" type, click the required radio button to set the value. Click Add to finish creating the property.

4. The newly created item will appear in the Properties list. You can select the property in there and change its value, type or
name the same way. Click the Modify button to save changes. To remove the property, click Delete.





SchedulerScheduler
This section describes the capabilities provided by the Scheduler, which is used for scheduling/calendar activities.

Scheduler UI

Toolbars
Ribbon Interface

Appointment Management

Create Appointments
Edit Appointments
Manage Reminders
Delete Appointments
Restrictions for Operations with Appointments

Layout Customization

Switch Scheduler Views
Scheduler Grouping
Zoom the Scheduling Area

Selection and Navigation

Navigate Dates in the Scheduler
Navigate Scheduler Resources
Navigate Scheduler Time Cells
Scheduler Navigation Buttons
Scheduler 'More' Buttons



Printing

Printing



Scheduler UIScheduler UI
This section describes the command interface of the Scheduler.

Topics in this section:

Toolbars
Ribbon Interface



ToolbarsToolbars
A scheduler can be accompanied by a set of toolbars that provide you with a comprehensive functionality to perform basic
operations in a scheduler (navigate through dates, change active view, create, edit and delete appointments, select a type for
grouping scheduler data, etc.) via a Bar interface.

Common

Import and export data in the iCalendar format.

Print

Print scheduler data

Appointment

Create Appointments

Navigate

Navigate Dates in the Scheduler
Zoom the Scheduling Area

Arrange



Switch Scheduler Views

Group By

Scheduler Grouping

Active View

Switch Scheduler Views

Time Scale

Specify time scales.

Layout

Customize the active view layout.

Actions



Edit Appointments
Delete Appointments

Options

Edit Appointments
Manage Reminders



Ribbon InterfaceRibbon Interface
A scheduler can be accompanied by a set of of Ribbon tabbed pages that provide you with a comprehensive functionality to
perform basic operations in a scheduler (navigate through dates, change active view, create, edit and delete appointments, select a
type for grouping scheduler data, etc.) via a Ribbon interface. Ribbon pages are structurally and visually split into logical groups.
Each of these groups includes commands that have certain common features.

File

Import and export data in the iCalendar format.
Print scheduler data

Home

Create Appointments
Navigate Dates in the Scheduler
Switch Scheduler Views
Scheduler Grouping

View

Switch Scheduler Views
Customize the active view layout.

Appointment



Edit Appointments
Manage Reminders



Appointment ManagementAppointment Management
This section describes how to modify appointments.

Topics in this section:

Create Appointments
Edit Appointments
Manage Reminders
Delete Appointments
Restrictions for Operations with Appointments



Create AppointmentsCreate Appointments
Context Menu
The following items are available in the context menu, invoked when you right-click any region of the Scheduler (except for areas
covered by appointments).

1. New Appointment

Invokes the Edit Appointment dialog.

The Start time and End time values are initially set to the lower and upper boundaries of the current date and time
selection.

Fill in other fields, if necessary. For example, use the large text box at the bottom of the dialog to enter text, which will be
shown as an appointment's description in a Day or a Work Week views.

You can also select the Reminder check box to enable appointment notifications (see Manage Reminders).

2. New All Day Event

Invokes the Edit Event dialog, which is used to create a new all-day appointment (also called 'all-day event'). The dialog is
identical to Edit Appointment (shown above), except that in this case, the All day event option is checked, its time range
is measured in days (not hours) and marked as Free. The appointment can be transformed into an all-day event and vice-
versa by checking this box.

3. New Recurring Appointment



All appointments maintained by the scheduler can either be simple (non-recurring - i.e., they happen only once), or
recurring - occurring multiple times within a specified time interval.

Selecting this menu item invokes the Edit Appointment dialog, used to create a new appointment, and also invokes the
Appointment Recurrence dialog, which allows the recurrence pattern to be specified for the new appointment.

4. New Recurring Event

Selecting this menu item invokes the Event editor dialog used to create a new all-day appointment, and also invokes the
Appointment Recurrence dialog, which allows the recurrence pattern to be specified for the new event.

Bar or Ribbon Interface
If a scheduler is provided with the Bar or Ribbon interface, you can create new appointments (simple and recurring) using the
New Appointment and New Recurring Appointment buttons on the Appointment toolbar or Ribbon page group. These
buttons invoke the Edit Appointment and Appointment Recurrence dialogs respectively.

CR E ATE A NE W  APPOINTMENT V IA B AR INTER FACE CR E ATE A NE W  APPOINTMENT V IA R IB B ON INTER FACE

Keyboard Shortcuts and Mouse Operations



ACTION D ES CR IPTION

An
alphanumeric
key or ENTER

Pressing an alphanumeric key or ENTER invokes an in-place editor where you can type the subject of a new appointment
occupying the currently selected area. Once you have typed your appointment's subject, you can either create and save the
appointment by pressing ENTER or changing the focus, or cancel the operation by pressing ESC. The type of the created
appointment depends on the selected time cell(s). When typing is done in Day or Work-Week view, the appointment is
created with the time interval starting with the earliest time of the selected cells and ending with the latest, and the time is
marked as Busy. If an all-day area is selected, then an all-day appointment is created with the time marked as Free. When
the scheduler display mode is Week or Month view, the appointment is created with the start time set to 12 AM of the
first selected day, and the end time is set to 12 AM of the day following the last selected day.

Double-click Double-clicking within a scheduler view's time cell that does not contain any appointments invokes the Edit Appointment
dialog described above.

CTRL+N Pressing CTRL+N invokes the Edit Appointment dialog. Then this dialog can be used to create a new appointment.

Dragging an
appointment
while holding
CTRL

This action creates a copy of the selected appointment and moves it, leaving the original appointment intact.



Edit AppointmentsEdit Appointments
You can modify existing appointments in the following ways:

using the appointment context menu
using the built-in dialogs
using the in-place editor
via the Bar or Ribbon interface
via keyboard shortcuts and mouse operations

�� N o t eN o t e

Access to some operations may be restricted.

Context Menu
After an appointment has been right-clicked, the appointment context menu is invoked. The Show Time As and Label As items
are used to alter an appointment. They allow for the changing of basic visual characteristics of an appointment - status and label.

CHANG E THE APPOINTMENT S TATU S CHANG E THE APPOINTMENT L AB EL

Edit Appointment and Appointment Recurrence Dialogs
Edit a Simple Appointment

You can edit properties of a simple (non-recurring) appointment via the Edit Appointment dialog that can be invoked via
the appointment context menu, Bar or Ribbon interface, keyboard shortcuts and mouse operations.

CONTE X T
MENU TOOLB AR R IB B ON PAG E G R OU P

K EYB OAR D  S HOR TCU TS  AND
MOU S E OPER ATIONS

INVOK ED  ED IT APPOINTMENT
D IALOG

Double-click the appointment to be
edited or select an appointment,
and then press ENTER or CTRL-O.



Edit a Particular Occurrence in a Series

The same dialog is used to edit a particular occurrence in the series of recurring appointments (recurring appointments are
marked with a  sign). If you select a recurring appointment, and click Open in the appointment context menu or the
Open Occurrence button on the Action toolbar or Ribbon page group, the Edit Appointment dialog is invoked to allow
for the editing of the current appointment only, but not its entire series.

CONTE X T
MENU TOOLB AR R IB B ON PAG E G R OU P

K EYB OAR D  S HOR TCU TS  AND
MOU S E OPER ATIONS

INVOK ED  ED IT APPOINTMENT
D IALOG

Double-click an appointment to be
edited or select an appointment,
and then press ENTER or CTRL-O.

The appointment with changed properties still belongs to the series, but is marked with an "exception". The visual indicator
of an exception is the crossed recurrence sign . To replace an exceptional appointment with the regular occurrence in the
chain of recurring appointments, click the Restore Default State item in the appointment's context menu.

Edit a Series of Recurring Appointments

To edit an entire series of recurring appointments (a pattern appointment), it is necessary to select a recurring appointment,
and click Edit Series in the appointment context menu or select the Open Series item from the Open drop-down list on
the Actions toolbar or Ribbon page group. In this instance, the Edit Appointment dialog is shown with a different window
icon. Time fields are inaccessible.

CONTE X T
MENU TOOLB AR R IB B ON PAG E G R OU P INV OK ED  ED IT APPOINTMENT D IALOG

The recurrence pattern can be edited via the Appointment Recurrence dialog. You can invoke it by clicking the
Recurrence button of the Edit Appointment dialog, or using the Recurrence button on the Options toolbar or Ribbon
page group.



ED IT APPOINTMENT D IALOG TOOLB AR R IB B ON PAG E G R OU P
INVOK ED  APPOINTMENT
R ECU R R ENCE D IALOG

In-place Editing
A single mouse click within an appointment, or pressing F2, invokes the in-place editor, which you can use to edit the selected
appointment's Subject. It is illustrated in the following picture.

By default, you can close the editor by pressing Enter (to save modifications) or Escape (to cancel modifications).

Bar or Ribbon Interface
If a scheduler is provided with the Bar or Ribbon interface, you can modify appointment properties (status, label, recurrence and
reminder) using the Options toolbar or Ribbon page group, which is active when an appointment is selected.

MOD IFY AN APPOINTMENT V IA THE B AR
INTER FACE MOD IFY AN APPOINTMENT V IA THE R IB B ON INTER FACE

Keyboard Shortcuts and Mouse Operations



ACTION D ES CR IPTION

Click an appointment Selects an appointment.

Right-click an appointment Selects an appointment and invokes the context menu for the selected
appointment.

Click appointments while holding the CTRL key pressed Enables you to select multiple appointments.

ENTER or CTRL+O Invokes the Edit Appointment dialog for the selected appointment.

Double-click an appointment Invokes the Edit Appointment dialog.

F2 Invokes the in-place editor to modify the selected appointment.

Drag appointment edges Resizes the rectangle representing an appointment. Results in changing its
start/end times.

Click and drag an appointment with the left mouse
button

Moves the appointment across time cells, changing its Start time and End
time properties.

Click and drag an appointment with the right mouse
button

Invokes the context menu allowing you to select between moving the
appointment, copying it or canceling the operation.

Press and hold the CTRL key, click and drag an
appointment(s) with the left mouse button

Creates a copy of the selected appointment(s) when the mouse button is
released.



Manage RemindersManage Reminders
What is a Reminder?
An appointment can have one or more reminders. They are responsible for sending alerts at specified time periods before an
appointment's start time. If an appointment has a reminder, the bell  image is displayed.

Specifying Reminders
A reminder can be created for a particular appointment with the help of the appointment's editing form, demonstrated below.
Select the Reminder check box and enter the amount of time before the appointment when you want the reminder to occur. You
can select a predefined value in a drop-down list, or just type it in. The duration editor recognizes digits as the number of minutes
if an "h" postfix is added - as hours, "d" - days.

If a scheduler is provided with the Bar or Ribbon interface, you can specify reminders by selecting the required value from the
Reminder drop-down list on the Options toolbar or Ribbon page group, which is active when an appointment is selected.



D ELE TE AN APPOINTMENT V IA B AR INTER FACE D ELE TE AN APPOINTMENT V IA R IB B ON INTER FACE

How Does It Work?
When the time has come for the reminder alert, it invokes the notification dialog, as illustrated below.

You can switch the reminders off by clicking the Dismiss or Dismiss All buttons.

Another option is to shift the alert time by selecting the time interval in the combo box and clicking the Snooze button. Then, the
notification will be postponed for a specified time frame.



Delete AppointmentsDelete Appointments
Context Menu
You can delete the selected appointment using the Delete item of the context menu, which is invoked when an appointment is
right-clicked.

Selecting this item removes the current appointment. If the current appointment is recurring, then the Confirm Delete dialog is
invoked.

Edit Appointment Dialog
When the appointment is being edited via the Edit Appointment dialog, in order to delete the corresponding appointment (or
series of recurring appointments) click the Delete button of this dialog.

Bar or Ribbon Interface
If a scheduler is provided with the Bar or Ribbon interface, you can delete appointments (simple and recurring) using the Delete



button on the Actions toolbar or Ribbon page group. If the appointment to be deleted is recurring, clicking this button invokes
the drop-down list allowing you to decide whether the whole series of recurring appointments should be deleted or just a
particular occurrence.

D ELE TE AN APPOINTMENT V IA B AR INTER FACE D ELE TE AN APPOINTMENT V IA R IB B ON INTER FACE

Keyboard Shortcuts
The DELETE key or the CTRL+D keyboard shortcut can be used to delete the selected appointment(s).



Restrictions for Operations with AppointmentsRestrictions for Operations with Appointments
Access to several operations may be restricted. You may find that you're not able to perform the following operations due to
restrictions applied by your application vendor or administrator.

Create new appointments.
Edit appointments.
Invoke the appointment editing form.
Activate an in-place editor for an appointment.
Change the time boundaries of appointments.
Drag and drop appointments to another time slot or date.
Drag and drop appointments between resources.
Copy appointments.
Delete appointments.
Select more than one appointment simultaneously.

Share the scheduled time between two or more appointments.

When you drag an appointment to relocate it, it may conflict with another. This situation is visually indicated as illustrated
below:



Layout CustomizationLayout Customization
This section describes how to change the scheduler layout.

Topics in this section:

Switch Scheduler Views
Scheduler Grouping
Zoom the Scheduling Area



Switch Scheduler ViewsSwitch Scheduler Views
Change Active View
The scheduler is intended to display appointment data using one of the standard Views. The currently active view used by the
scheduler can be either selected intentionally or changed according to the scheduler's internal logic.

To change the active view, use the corresponding item of the scheduler's context menu. This menu is invoked when you
right-click any region of the scheduler (not occupied with an appointment).

�� N o t eN o t e

Depending on the application vendor, some options may be unavailable in your application.

While navigating through dates via the Go To Date dialog, you can specify a view type to display a new time interval.

The scheduler selects a view mode automatically, according to the date range selected in the date navigator, combined with
a scheduler.

If a scheduler is provided with the Bar or Ribbon interface, you can use the Active View and Arrange toolbars or Ribbon
page groups.

CHANG E THE ACTIVE V IE W  V IA B AR INTER FACE CHANG E THE ACTIVE V IE W  V IA R IB B ON INTER FACE



CHANG E THE ACTIVE V IE W  V IA B AR INTER FACE CHANG E THE ACTIVE V IE W  V IA R IB B ON INTER FACE

Available View Types
Day View

This view provides the most detailed view of appointments for a certain day(s).

Work-Week View

This view displays appointments for the working days in a particular week.

Week View

This view displays appointments for any given week.

Month (also called Multi-Week) View

The month view is the least detailed of the views, and is designed to allow browsing and long-term plan analysis. This view
positions the days one after another horizontally, so that they form weeks, while weeks are placed one under the other.

Timeline View

This view plots appointments as horizontal bars along the timescales, and provides a clearer overview for scheduling
purposes.

Gantt View

This view displays appointments as horizontal bars along the timescales, shows the current schedule status using percent-
complete shadings and displays dependency relationships between appointments.

Agenda View

This view displays appointment as a chronological list grouped by day.



Scheduler GroupingScheduler Grouping
The appointment data displayed within the scheduler can be grouped either by resources or by dates to enhance visual
representation. The following pictures illustrate the appearance of the scheduler in different grouping modes.

APPOINTMENTS  AR E G R OU PED  B Y R ES OU R CES APPOINTMENTS  AR E G R OU PED  B Y D ATES

If a scheduler is provided with the Bar or Ribbon interface, you can specify the type of grouping appointments using the Group
By toolbar or Ribbon page group.

G R OU P APPOINTMENTS  V IA B AR INTER FACE G R OU P APPOINTMENTS  V IA R IB B ON INTER FACE

See also the Navigate Scheduler Resources topic.



Zoom the Scheduling AreaZoom the Scheduling Area
You can zoom in the scheduler view to display its content in greater detail, or zoom out for a more general view. Zooming is
implemented by adjusting the time scales (in the Day, Work-Week or Timeline views) or changing the number of visible weeks (in
the Month view).

ZOOMING  IN ZOOMING  OU T

Zooming operations are available for you via the CTRL+PLUS SIGN, CTRL+MINUS SIGN or CTRL+MOUSE WHEEL key
combinations.

If a scheduler is provided with the Bar or Ribbon interface, you can zoom in and zoom out the scheduler area using the
corresponding buttons on the Navigate toolbar or Ribbon page group.

ZOOM S CHED U LER  V IA B AR INTER FACE ZOOM S CHED U LER  V IA R IB B ON INTER FACE



Selection and NavigationSelection and Navigation
This section describes how to navigate the schedule.

Topics in this section:

Navigate Dates in the Scheduler
Navigate Scheduler Time Cells
Zoom the Scheduling Area
Scheduler Navigation Buttons
Scheduler 'More' Buttons



Navigate Dates in the SchedulerNavigate Dates in the Scheduler
Context Menu
Right-clicking within the main area of the scheduler opens the context menu, which contains items for navigating through dates.

VIE W MONTH V IE W

Go to This Day

Only available in the Month View. This item is active when only one day is selected, and when activated, displays the target
day in the Day View mode.

Go to Today

Moves focus to the current date, preserving the existing view mode.

Go to Date...

Invokes the Go To Date dialog to select the date and view type. The date can be selected either by using the calendar or by
entering a string with the placeholders. To select the desired view type, use the Show In drop-down box.



Date Navigation Bar
You can navigate through dates using Date Navigation Bar. Clicking its navigation arrows moves backward and forward by the
time frame. The current time interval is indicated near the arrows.

Date Navigator
If the scheduler is accompanied by the date navigator, you can use it to navigate through dates. The common look of the date
navigator is illustrated in the following picture.

You can select either a particular date, or a range of dates in the date navigator, and the scheduler will display your selection using
a Day View. The table below details how you can select dates in different ways.

ACTION EFFECT

Click a date A single date is selected and the scheduler displays it using the Day View. If the
currently active view is of another type, it is automatically changed to Day View.

Click and drag across multiple dates, or click a start
date, hold down the SHIFT key and click an end date

The continuous range of dates is selected. The scheduler displays it using the Day
View, irrespective of the size of the selected range.

Hold down the CTRL key and click several dates A set of dates is selected. The scheduler displays it using the Day View, irrespective
of the size of the selected range.



Click a week number A corresponding week-long range is selected. The scheduler displays it using the
Day View.

ACTION EFFECT

Bar or Ribbon Interface
If a scheduler is provided with the Bar or Ribbon interface, you can navigate through dates within a scheduler using the
Backward, Forward and Go to Today buttons of the Navigate toolbar or Ribbon page group.

NAVIG ATE THR OU G H D ATES  V IA B AR INTER FACE NAVIG ATE THR OU G H D ATES  V IA R IB B ON INTER FACE



Navigate Scheduler ResourcesNavigate Scheduler Resources
When appointment data is grouped (either by resources or by dates), the number of resources shown on the screen within the
Scheduler at once can make it difficult to see all the scheduled data. To make the Scheduler's layout more readable, it is possible
to limit the number of visible resources, and then scroll between them. There is an embedded Resource Navigator control,
which allows you to scroll between resources.

The Resource Navigator control is composed of a scrollbar and a set of buttons. It may be shown horizontally (on the bottom
line of the Scheduler control, with buttons in the right corner) or vertically (on the right side, buttons at the bottom). The position
of the control is chosen automatically. It is vertical in Day and Week views, if appointments are grouped by dates, and horizontal
in other view modes.

The mode of operation is rather straightforward - you can click the buttons to move back and forth through the list of resources;
one by one, or straight to the first or last one on the list. The buttons with plus and minus signs increase or decrease the number
of displayed resources by one.



Navigate Scheduler Time CellsNavigate Scheduler Time Cells
The following table contains the typical navigation operations:

ACTION EFFECT

Clicking a cell Moves focus to the clicked cell, selects it.

UP ARROW;
DOWN ARROW

Day View, Work Week View - Moves focus to the previous or next time cell within the current day. Week View -
Moves focus to the previous or next day. Month View - Moves focus to the same day of the week for the previous
or next week.

LEFT ARROW;
RIGHT ARROW

Day View, Work Week View - Moves focus to the corresponding time cell of the previous or next day. Week
View - Moves focus to the left or right of the corresponding cell of a column. The view is scrolled to the previous or
next week if necessary. Month View - Moves focus to the previous or next day.

PAGE DOWN Moves the row focus one page down, preserving the column focus.

PAGE UP Moves the row focus one page up, preserving the column focus.

HOME Day View, Work-Week View - Moves focus to the start of Work Time within the current day. Week View, Month
View - Moves focus to the first day shown in the current week.

END Day View, Work-Week View - Moves focus to the end of Work Time within the current day. Week View, Month
View - Moves focus to the last day shown in the current week.

CTRL+HOME Day View, Work-Week View - Moves focus to the first cell of the day's visible time span. Week View, Month
View - Moves focus to the first day shown in the current week.

CTRL+END Day View, Work-Week View - Moves focus to the last cell of the day's visible time span. Week View, Month
View - Moves focus to the last day shown in the current week.

TAB
Switches to appointments navigation. Focus shifts to the next time appointment within the time span shown.
Pressing the key repeatedly iterates through the appointments in the following way - appointments with a definite
duration are followed by all-day appointments.

SHIFT+TAB
Switches to appointments navigation. Focus shifts to the previous time appointment within the time span shown.
Pressing the key repeatedly iterates through the appointments in the following way - appointments with a definite
duration are followed by all-day appointments.

ALT+UP ARROW;
ALT+DOWN ARROW

Day View, Work-Week View, Month View - Moves focus one week before or after. Week View - acts like the
LEFT(RIGHT) ARROW keys.

ALT+PAGE UP;
ALT+PAGE DOWN Day View, Week View, Month View - Moves focus to the start or end of a current month.

ALT+HOME Day View, Work-Week View - Moves focus to the beginning of a current week.

ALT+END Day View, Work-Week View - Moves focus to the end of a current week.

�� N o t eN o t e

When appointments are grouped, only ARROW keys can move focus to another resource group.



Scheduler Navigation ButtonsScheduler Navigation Buttons
The Navigation Buttons are used to scroll to the previous or next appointment. This is helpful when there is a significant time
interval between scheduled appointments.

Navigation buttons are displayed if there are no currently visible appointments within the Scheduler control area. If there are
appointments that refer to a previous or successive date, the Previous Appointment and Next Appointment navigation
buttons provide the capability to navigate to the corresponding date. If there are no appointments in a specific direction, the
corresponding navigation button is disabled.

Note that if the Scheduler control currently displays appointments for multiple resources, navigation buttons are displayed
independently for each resource.



Scheduler 'More' ButtonsScheduler 'More' Buttons
The "More" buttons indicate that more appointments exist on a particular date. Click these buttons to see all appointments in a
more detailed view, or to simply scroll to the next appointment.

D AY V IE W MONTH V IE W



PrintingPrinting
If a scheduler includes a Bar or Ribbon interface, you can use the Print toolbar or Ribbon page group.

PR INT V IA THE B AR INTER FACE PR INT V IA THE R IB B ON INTER FACE

Page Setup
Click the Page Setup command button to invoke the Page Setup dialog. The Page Setup dialog consists of the Format, Paper
and Resources tab pages, as illustrated in the images below.



Print Preview
Click the Print Preview button to invoke the Print Preview dialog, which provides a preview of the page to be printed.



This dialog allows you to print the page, or save it to a file as a PDF or an image (e.g., BMP, EMF, WMF, GIF, JPEG, PNG or TIFF).

Print
Click the Quick Print command button to send the scheduler content to the default printer using the current page and printer
settings.



Snap Reporting EngineSnap Reporting Engine
This guide provides information on the basic principles of creating reports with Snap.

Snap is a WYSIWYG reporting engine that provides a user interface that allows for a quick creation of standard reports with the
capabilities of data shaping (grouping, sorting and filtering), hierarchical data representation (master-detail reports), mail merge
and much more.

The following sections are available in this guide.

Graphical User Interface
Connect to Data
Create a Report Layout
Manage Documents and Files



Graphical User InterfaceGraphical User Interface
The topics in this section describe various aspects of the Snap graphical user interface (GUI).

Snap Application Elements
Main Toolbar



Main ToolbarMain Toolbar
The topics in this section describe all ribbon tab and bar commands available in the toolbar of a Snap application.

After executing a command in a Snap application, the corresponding field codes are automatically added to the document
markup.

Main Reporting Commands
Data Tools: Field
Data Tools: Group
Data Tools: List
Data Tools: Mail Merge
Data Tools: Appearance

Additional Reporting Commands
General Tools: File
General Tools: Insert
General Tools: View
General Tools: References
Table Tools: Design
Table Tools: Layout

Word-Processing Commands
General Tools: Home
General Tools: Page Layout
General Tools: Review
Chart Tools: Design
Header and Footer Tools: Design
Picture Tools: Format



Data Tools: FieldData Tools: Field
This toolbar is context sensitive, and becomes active after selecting a Snap field in the document.

The commands available in the Field toolbar of the Data Tools category are divided into the following sections.

Data Shaping
Element

Data Shaping
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Group By Field
Groups a Snap list by the selected field. All groupings added to a Snap report are
displayed as nodes in the Report Explorer. Using this command, you can apply
multiple grouping criteria. Every group can have a header and/or footer. To
customize report groups, use the tools provided by the Data Tools: Group toolbar.

Sort Ascending
Sorts a Snap list by the selected column in ascending order. To manage the sort
levels in a mail merge document, use the Sort command of the Data Tools: Mail
Merge toolbar.

Sort Descending
Sorts a Snap list by the selected column in descending order. To manage the sort
levels in a mail merge document, use the Sort command of the Data Tools: Mail
Merge toolbar.

Summary
Calculates a summary for a selected field. Summary results are shown in the list
footer. The following summary functions are available: Count; Sum; Average; Max;
Min.

Quick Filter
Allows you to select which values of a selected field to show.This command is not
applicable to nested lists of a master-detail report. To apply complex filtering criteria
to a Snap list, use the Filter command of the Data Tools: List or Data Tools: Mail
Merge toolbar.

Element
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Properties Shows the list of properties for a selected field. The set of available properties depends on
the element type.



Data Tools: GroupData Tools: Group
This toolbar is context sensitive, and becomes active after placing the text cursor in a group header or footer.

To create a new group, use the Group By Field command of the Data Tools: Field toolbar.

The following commands are available in the Layout section of the Group toolbar.

COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Header Adds or removes a group header. Removing both the group header and group footer
removes grouping from the Snap List.

Footer Adds or removes the group footer. Removing both the group header and group footer
removes grouping from the Snap List.

Group
Fields Invokes a dialog allowing you to add or remove grouping criteria for the selected group.

Arrange
Groups

Invokes the Groups Order Editor, which allows you to set the order in which groupings
are applied to a Snap list.

Separator
Inserts the selected separator between groups in a Snap list. The following separators are
available: Page Break; Section (Next Page); Section (Even Page); Section (Odd
Page);Empty Paragraph; Empty Row; None.



Data Tools: ListData Tools: List
This toolbar is context sensitive, and becomes active after selecting a Snap list in the document.

The commands available in the List toolbar of the Data Tools category are divided into the following sections.

Layout
Commands
Editor Row Limit

Layout
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Header Adds or removes the header of a selected Snap list.

Footer Adds or removes the footer of a selected Snap list.

Separator Inserts the selected separator between the rows of a Snap list.

Commands
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Filter
Invokes the FilterString Editor, which allows you to define complex filtering criteria for a
selected Snap list. To select which data records to display for a specific field, use the Quick
Filter command from the Data Tools: Field toolbar.

Convert to
Paragraphs

Removes the table layout of a Snap list. The content of the removed table columns is
presented as separate paragraphs. There is no reverse action to convert paragraphs back
to a tabular representation.

Delete List Removes the selected list from a document.

Editor Row Limit
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Editor Row
Limit none none

Allows you to define the maximum number of rows to be shown in a selected Snap list.
The Editor Row Limit setting does not affect the number of records shown in the Print
Preview, which shows the final presentation of the document with all Snap fields replaced
with actual data.



Data Tools: Mail MergeData Tools: Mail Merge
The commands available in the Mail Merge section of the Data Tools toolbar are divided into the following categories.

Data
Current Record
Publish

Data
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Data
Source

Enables mail merge for a connected data source. After enabling this mode, the data
source icon is displayed in green in the Data Explorer. There is no functionality for
disabling mail merge once it has been implemented.

Filter Invokes the FilterString Editor to filter data in a mail merge document.

Sort Invokes the Sort dialog to sort data in a mail merge document.

Current Record
COMMAND ICON D ES CR IPTION

Current
Record

Allows you to navigate through records in a mail merge document. You can navigate to the Next Page, the
Previous Page, the First Page or the Last Page.

Publish
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Finish & Merge

Finalizes a mail merge document by supplying actual values to data elements added
to a document template. This command invokes a drop-down menu to select the
publishing format of a document. The following options are available:Export - exports
the created document to a selected third-party format; Print - invokes the print
dialog to adjust the page options of the document before sending it to a printer; Print
Preview - displays the created document in a print preview window that provides
options to navigate, print and/or export the document.

After selecting the document's output format, the Export Range dialog is invoked to specify the range of data records that the
document should include.



In this dialog, you can choose from the following separators to isolate different data records:

None;
Page Break;
Section (Next Page);
Section (Even Page);
Section (Odd Page);
Paragraph.



Data Tools: AppearanceData Tools: Appearance
This Appearance toolbar contains predefined report styles. After selecting a style, it is applied to all Snap Lists throughout the
document.

The following command is available in the Report Themes section of this toolbar.

COMMAND D ES CR IPTION

Sets the style to be applied to all Snap lists throughout the document. The style's icon indicates the colors that will be applied
to the following report elements (the colors are described from up to down): 1 - First-level report headers and footers; 2 -
First-level group headers and footers; 3 - Second-level report headers and footers; 4 - Second-level group headers and
footers. Apart from colors, a visual theme applied to a report may affect the alignment of report elements, their padding and
font settings, as well as other appearance properties. A visual theme does not affect elements for which the appearance is
defined manually, and only changes their default property values. For example, a theme will not change the background color
of a table cell for which the background color has already been specified. Clicking the arrow button invokes the drop-down
menu, containing the following commands for managing report theme: Save the Current Theme to a File...; Load a
Theme from a File...; Restore the Default Document Styles.



General Tools: FileGeneral Tools: File
The File toolbar contains the basic file management and printing commands.

These commands are divided into the following categories.

Common
Data

Common

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

New Creates a new Snap document.

Open Opens an existing document.

Save Saves a document template to an SNX file. When saving a document for the first time, the Save As
dialog will appear.

Save As Saves a document template to a new SNX file. This command invokes the Save As dialog, allowing
you to specify a name and location for the new file.

Export... Exports a document into one of the supported third-party formats (DOC, DOCX, HTML, PDF, RTF,
Image, etc.).

Quick Print Sends a document to the default printer with default printing options.

Print Invokes the Print dialog, allowing you to select a printer and specify the printing options.

Print
Preview

Retrieves all data required to populate the report fields to assemble and preview a document before
publishing, ignoring the current Editor Row Limit setting. Calling this command for a mail-merge
document renders only one page of the document. To render a mail-merge document for a specified
range of data records, use the Finish & Merge option in the Data Tools: Mail Merge tab.

Undo Cancels the last change made to the document.

Redo Reverses the results of the last undo.

Data
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Add New
Data
Source

Invokes the Create Data Source wizard, allowing you to connect the document to a
new data source and specify its data connection options (e.g., data provider, login
information and connection name). A data table selected with the wizard is included in the
data source. To add more tables and specify their data relations, use the Query Designer.



General Tools: InsertGeneral Tools: Insert
The Insert toolbar contains elements that can be inserted into a document.

These elements are divided into the following categories.

Pages
Tables
Illustrations
Toolbox
Links
Header & Footer
Text
Symbols

Pages

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Page Break Inserts a page break at the carriage position. A page break cannot occur within tables, lists, or
document headers and footers.

Tables

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Table Inserts a table with a specified number of rows and columns at the carriage position. To customize the
table layout, use the commands available in the Table Tools: Design and Table Tools: Layout tabs.

Illustrations

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Inline
Picture

Inserts an inline picture at the carriage position. In a document, the inline picture behaves like an
ordinary text symbol.

Picture Inserts a picture into a document. You can adjust the picture's outline, wrap text, position, and order
using commands from the Picture Tools: Format tab.

Toolbox

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Bar Code Inserts a bar code at the carriage position. After adding a bar code, specify its symbology, data
binding and other options using the Properties command in the Data Tools: Field tab.

Check Box
Inserts a check box at the carriage position (e.g., to display Boolean values from a data source). To
customize the check box state or bind it to external data, use the Properties command in the Data
Tools: Field tab.



Chart Inserts a chart at the carriage position.

Sparkline Inserts a sparkline at the carriage position.

Row Index Inserts a row index at the carriage position.

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Links

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Bookmark Invokes the Bookmark dialog to add a new bookmark at the carriage position, or navigate to an
existing bookmark.

Hyperlink Invokes the Insert Hyperlink dialog to create a hyperlink and specify its text, screen tip and
destination. A hyperlink's destination may be a web page, file, or specific position within a document.

Header & Footer

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Header

Allows editing the page header. In a published document, the content added to the header will appear
at the top of each page. To quickly switch to this mode, double-click the page header area. To quit
page header editing, press ESC, double click the document area, or click Close Header and Footer
on the Header & Footer tab. To make the first page header display unique content, or make odd- and
even-numbered pages carry different headers, use the options available on the Header and Footer
Tools: Design tab.

Footer

Activates the page footer edit mode. In a published document, the content added to the footer will
appear at the bottom of each page. To quickly switch to this mode, double-click the page footer area.
To quit page footer editing, press ESC, double click the document area, or click Close Header and
Footer on the Header & Footer tab. To make the first page footer display unique content, or make
odd- and even-numbered pages carry different footers, use the options available on the Header and
Footer Tools: Design tab.

Page
Number

Inserts the number of the current page at the carriage position. The page statistics can only be added
to a page header or footer.

Page
Count

Inserts the total page count at the carriage position. The page statistics can only be added to a page
header or footer.

Text

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION



Text Box
Inserts a text box into a document. A text box is a floating container that is capable of displaying
virtually any kind of content (including the most elaborate lists), posing no restrictions on its size and
location within a document.

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Symbols
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Symbol Invokes the Symbol dialog, to insert characters that are not available on the keyboard.



General Tools: ViewGeneral Tools: View
The View toolbar contains commands that control the presentation of document elements on the Design Surface.

These commands are divided into the following categories.

Document Views
Show
Zoom
View
Fields

Document Views

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Simple view Shows a document without the page layout.

Draft View Shows a document in a draft view that ignores certain document elements such as page breaks,
and headers and footers.

Print
Layout Shows a document as it will appear on the printed page.

Show
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Horizontal Ruler Shows or hides the horizontal ruler at the top of the Design Surface.

Vertical Ruler Shows or hides the vertical ruler to the left of the Design Surface.

Zoom
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Zoom Out Zooms the document out.

Zoom In Zooms the document in.

View

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION



Windows Shows or hides the Snap application windows (i.e., Data Explorer and Report Explorer).

Highlight Highlights the boundaries of a list element after it receives input focus. The invoked frame displays
the type of element that is highlighted.

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Fields

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Show All
Field Codes Toggles to show the field codes of all elements that provide dynamic content in a document.

Show All
Field
Results

Switches back to the default mode, which displays the actual values fetched by Snap fields supplying
dynamic content to a document. To effectively handle incoming data, only a portion of data is shown
during real-time editing of a document. This restriction does not apply to a document created for
print preview, and the report requests all data after it is set for publishing. When a document is being
edited, only the first 20 rows from each data column are shown by default. To modify or disable this
limit, use the Editor Row Limit option in the Data Tools: List tab.

Highlight
Fields

Highlights the data fields that have been added to a document from an external data source to
distinguish these fields from the rest of the document content.



General Tools: ReferencesGeneral Tools: References
The References toolbar contains commands that provide different kinds of references to a document, such as a table of contents
and table captions.

These commands are divided into the following sections.

Table of Contents
Captions

Table of Contents

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Table of
Contents Inserts a table of contents at the carriage position.

Update
Table Updates the table of contents to ensure that all entries in it refer to the correct page numbers.

Add Text
Adds the current paragraph as an entry to the specified level of the table of contents. If a data field is
added to the table of contents, a separate table of contents entry is created for each data row in the
Snap list.

Captions

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Insert
Caption

Inserts sequentially numbered captions for different types of objects at the carriage position. The
following caption types are available: Figures Caption (automatically referenced by the table of
figures); Tables Caption (automatically referenced by the table of captions); Equations Caption
(automatically referenced by the table of equations).

Insert Table
of Figures

Creates a table of figures, table of tables, or table of equations, containing page numbers for objects
of the corresponding types.

Update
Table Updates the table of figures so that all entries refer to the correct page numbers.



Table Tools: DesignTable Tools: Design
This toolbar is context sensitive, and becomes active after placing the text cursor in a document table.

The commands available in the Design toolbar of the Table Tools category are divided into the following sections.

Table Style Options
Table Styles
Cell Styles
Borders & Shadings

Table Style Options
Commands from this category allow you to activate special formatting options for different table parts.

Special formatting options available for a table are defined in its table style. To create a new table style or modify an existing one,
use the tools provided by the Table Styles section of this category.

The following commands are available in the Table Style Options category.

COMMAND D ES CR IPTION

Header Row Enables formatting of the first row in a table.

First Column Enables special formatting for the first column in a table.

Total Row Enables special formatting for the last row in a table.

Last Column Enables special formatting for the last column in a table.

Banded Rows Enables special formatting for odd and even rows in a table.

Banded Columns Enables special formatting for odd and even columns in a table.

Table Styles
COMMAND IMAG E D ES CR IPTION

Table Styles
Sets a table style for the selected table. Creating a new table style or modifying an existing one invokes the
Modify Style dialog, allowing you to specify a style name and adjust table formatting options (including special
formatting options for different table parts). You can enable special formatting using commands from the Table
Style Options section within this toolbar category.

Cell Styles
COMMAND IMAG E D ES CR IPTION

Cell Styles Sets a cell style for the selected table cell. Creating a new table cell style or modifying an existing one invokes the
Modify Style dialog, allowing you to specify a style name and adjust cell formatting options.

Borders & Shadings



COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Line Style none none Sets the style of a line that is used to draw borders.

Line Weight none none Sets the width of the line that is used to draw borders.

Pen Color Sets the color that is used to draw borders.

Borders Draws the specified borders for selected cells.

Shading Specifies the background color for the selected cells.



Table Tools: LayoutTable Tools: Layout
This toolbar is context sensitive, and becomes active after placing the text cursor in a document table.

The commands available in the Layout toolbar of the Table Tools category are divided into the following sections.

Table
Rows & Columns
Merge
Cell Size
Alignment

Table

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Select Allows you to select a cell, row, column or table.

View
Gridlines

Shows or hides table gridlines. This command is useful when working with tables that contain invisible
borders. These lines are only displayed in the Design Surface - they do not appear in a published
document.

Properties Invokes the Table Properties dialog for the selected table. This dialog allows you to adjust the size
and alignment properties of the current table cell, row, column or table.

Rows & Columns

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Delete
Deletes the specified cells or the currently selected row, column or table. To delete a single table cell,
the Delete Cells dialog is invoked that allows you to select the "shift" mode for replacing the deleted
cell. To remove individual rows from a Snap List, use the Quick Filter command of the Data Tools:
Field toolbar.

Insert
Above Inserts a new row above the selected row.

Insert
Below Inserts a new row below the selected row.

Insert Left Inserts a new column to the left of the selected column.

Insert Right Inserts a new column to the right of the selected column.

Merge



COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Merge
Cells Merges selected cells. The content of merged cells is converted to paragraphs of an output cell.

Split Cells Splits the selected cell into a specified number of rows and columns. The content of the source cell
is placed in the top-left output cell.

Split Table Splits the table into two tables. The selected row becomes the first row of the new table.

Cell Size

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

AutoFit
Sets the auto fit mode of the selected table. The following auto fit modes are available: AutoFit
Contents (table cells occupy the minimum width possible to fit content), AutoFit Window (the table
occupies the entire width of the page), and Fixed Column Width (column width is fixed and can only
be changed manually).

Alignment

COMMAND
L AR G E
ICON

S MALL
ICON D ES CR IPTION

Alignment none none Sets the text alignment for selected cells.

Cell
Margins

Invokes the Table Options dialog, allowing you to set the default cell margins for the
selected table cells.



General Tools: HomeGeneral Tools: Home
The Home toolbar contains text formatting and alignment commands.

These commands are divided into the following categories.

Clipboard
Font
Paragraph
Styles
Editing

Clipboard
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Paste Pastes the content of the clipboard into a carriage position.

Cut Cuts the selected content and places it in the clipboard.

Copy Copies the selected content and places it in the clipboard.

Paste Special Invokes the Paste Special dialog, allowing you to paste the content of the clipboard
with a specified formatting.

Font
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Font none none Specifies a font for the selected text.

Font Size none none Specifies a font size for the selected text.

Grow Font Increases the font size of the selected text.

Shrink Font Decreases the font size of the selected text.

Change Case Changes the case of the selected text to uppercase or lowercase.

Bold Makes the selected text bold.

Italic Italicizes the selected text.

Underline Draws a line under the selected text.



Double Underline Draws a double line under the selected text.

Strikethrough Draws a line through the middle of the selected text.

Double
Strikethrough Draws a double line through the middle of the selected text.

Superscript Makes the selected text smaller and places it above the line of the text.

Subscript Makes the selected text smaller and places it below the line of the text.

Font Color Specifies a color for the selected text.

Text Highlight Color Specifies a highlight color for the selected text.

Clear Formatting Removes all formatting from the selection, leaving only plain text.

Font none none Invokes the Font dialog, allowing you to adjust different font options for the
selected text.

COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Paragraph
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Bullets Converts the selected paragraphs into a bulleted list, or inserts a new bulleted list at
the carriage position.

Numbering Converts the selected paragraphs into a numbered list, or inserts a new numbered
list at the carriage position.

Multilevel List Converts the selected paragraphs into a multilevel list, or inserts a new multilevel list
at the carriage position.

Decrease Indent Decreases the indent level of the paragraph or the hierarchical level of the multilevel
list's items.

Increase Indent Increases the indent level of the paragraph or the hierarchical level of the multilevel
list's items.

Show/Hide ¶ Shows or hides paragraph marks and other non-printable characters.

Align Text Left Aligns the current paragraph to the left.

Center Centers the selected paragraphs.



Align Text Right Aligns the selected paragraphs to the right.

Justify Aligns the text of the selected paragraphs to both the left and right margins, adding
extra space between words as necessary.

Line Spacing Changes the spacing between the lines of the selected paragraphs. The amount of
space added before and after the paragraphs can also be specified.

Shading Specifies a background color for the selected paragraphs.

Paragraph none none Invokes the Paragraph dialog, allowing you to adjust different layout options for the
selected paragraphs.

COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Styles
COMMAND D ES CR IPTION

Quick
Styles

Applies a style to the selected text. A style is a group of formatting options. All options are applied to text or a paragraph at
once when you apply a style. Styles allow you to change text and paragraph appearance quicker than setting each formatting
option individually.

Modify
Style Invokes the Modify Style dialog, allowing you to change the formatting options of the selected style.

Editing
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Find ' Invokes the Find and Replace dialog that allows you to find the specified text in a
document.

Replace Invokes the Find and Replace dialog that allows you to find the specified text in a
document and replace it with other text.



General Tools: Page LayoutGeneral Tools: Page Layout
The Page Layout toolbar contains page layout options that include paper kind, margins and orientation.

These options are divided into the following categories.

Page Setup
Background

Page Setup
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Margins
Sets the size of page margins for the current document section.You can select from a
list of predefined margins, or invoke the Page Setup dialog and adjust the margin size
manually.

Orientation Sets the page orientation for the current document section.

Size
Sets the page size for the current document section. You can select one of the
predefined page sizes from the list, or specify a custom page size in the Page Setup
dialog.

Columns Sets the number of columns for all pages in the current document section.You can also
invoke the Columns dialog for more customization options.

Breaks Inserts one of the available breaks (e.g., page break, column break or section break) at
the carriage position.

Line Numbers
Displays line numbers in the current document section.You can select one of the
predefined line numbering types from the list, or invoke the Line Numbers dialog to
define custom line numbering.

Background
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Page Color Sets a page color for the entire document.



General Tools: ReviewGeneral Tools: Review
The Review toolbar contains tools related to proofreading.

The following command is available in the Proofing section of this toolbar.

COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Spelling
Checks the spelling of the document text. On detecting misspelled words, the spell
checker invokes the Spelling dialog to type in the correct version, or select the correctly
spelled word from the list of suggestions.



Chart Tools: DesignChart Tools: Design
This toolbar is context sensitive, and becomes active after selecting a chart in the document.

The commands available in the Design toolbar of the Chart Tools category are divided into the following sections.

Chart Type
Appearance
Wizard

Chart Type
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Column Changes the type of the selected chart to one of the available column chart types.
Column charts are used to compare values across categories.

Line Changes the type of the selected chart to one of the available line chart types. Line
charts are used to display trends over time.

Pie Changes the type of the selected chart to one of the available pie chart types. Pie charts
display the contribution of each value to a total.

Bar
Changes the type of the selected chart to one of the available bar chart types. Bar charts
summarize and display categories of data, allowing you to compare the contribution of
each value to the total across categories.

Area Changes the type of the selected chart to one of the available area chart types. Area
charts are used to display trends over time.

Other Charts Changes the type of the selected chart to a point, funnel, financial, radar, polar, range, or
Gantt chart.

Appearance
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Palette Specifies the color palette for the selected chart.

Appearance none none Applies a specified appearance to the selected chart. The collection of style presets
available for a chart depends on the chart's palette.

Wizard
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Run Chart Wizard... Invokes the Chart wizard, which allows you to adjust the main chart settings in a
single user interface.



Header and Footer Tools: DesignHeader and Footer Tools: Design
This toolbar is context sensitive, and becomes active after double-clicking the page header or footer in a document.

To add a page header or footer, use the appropriate commands of the General Tools: Insert toolbar.

The commands available in the Design toolbar of the Header & Footer Tools category are divided into the following sections.

Navigation
Options
Close

Navigation
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Go to Header Allows you to switch to the page header of the current document section when
editing a page footer.

Go to Footer Allows you to switch to the page footer of the current document section when
editing a page header.

Show Next Allows you to navigate to the header or footer of the next document section.

Show Previous Allows you to navigate to the header or footer of the previous document section.

Link to Previous Makes the header or footer display the content of the header or footer of the
previous document section.

Options
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Different First Page Creates a unique header and footer for the first page.

Different Odd & Even Pages Allows you to specify different headers and footers for odd-numbered
and even-numbered pages.

Close
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Close Header and
Footer

Exits the header and footer edit mode. You can also do this by double-clicking the
document area, or by pressing ESC.



Picture Tools: FormatPicture Tools: Format
This toolbar is context sensitive, and becomes active after selecting a picture in a document.

The commands available in the Format toolbar of the Picture Tools category are divided into the following sections.

Shape Styles
Arrange

Shape Styles
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Shape Fill Fills the selected shape with a specified color.

Shape Outline Applies the specified color to the outline of the selected shape.

Shape Outline Weight none none Specifies a width for the outline of the selected shape.

Arrange
COMMAND L AR G E ICON S MALL ICON D ES CR IPTION

Wrap Text Specifies the way in which text wraps around a selected object. The text wrap modes are
as follows: Square; Tight; Through; Top and Bottom; Behind Text; In Front of Text.

Position Specifies the position of the selected object on a page.

Bring to
Front

Moves the selected object forward. This command invokes a drop-down menu that
contains the following actions: Bring Forward (moves the selected object one layer
forward); Bring to Front (moves the selected object to the front of all other objects in a
document); Bring in Front of Text (places the selected object in front of the text).

Send to
Back

Moves the selected object backward. This command invokes a drop-down menu that
contains the following actions: Send Backward (moves the selected object one layer
backward); Send to Back (moves the selected object behind all other objects in a
document); Send Behind Text (moves the selected object behind the text).



Snap Application ElementsSnap Application Elements
The topics in this section describe the main elements that make up the user interface of a Snap application.

This section consists of the following topics.

Snap User Interface Overview
Main Toolbar
Design Surface
Data Explorer
Report Explorer
Print Preview



Snap User Interface OverviewSnap User Interface Overview
This document lists the essential elements of the Snap user interface, and provides links to specific topics that describe these
elements in more detail.

The main elements of the Snap user interface are as follows.

Main Toolbar

The Main Toolbar in a Snap application provides quick access to the available document editing tools. The following
toolbar styles are available:.

1. Ribbon

Tools are organized in various sections, contained in different tabs.

2. Bars

Tools are organized in separate toolbars.

Design Surface

The body of a report in the designer. In this region, you can design your report layout and immediately view the result.

Data Explorer

Reflects the structure of available data, allowing you to manage a report's data sources. You can add the data shown in this
pane to your report via drag-and-drop.



Report Explorer

Reflects the hierarchy of the elements of a Snap document.



Main ToolbarMain Toolbar
The Main Toolbar in a Snap application provides quick access to the available document editing tools. The following toolbar
styles are available:

1. Ribbon

Tools are organized in various sections, contained in different tabs.

2. Bars

Tools are organized in separate toolbars.



Design SurfaceDesign Surface
This document describes the design surface of a Snap application.

The design surface is the primary working area of a Snap application, which contains the document and allows you to modify its
layout.

It can display rulers that define the horizontal and vertical alignment of a report's elements, as well as a scroll bar that allows you
to browse different pages of a document.

Right-clicking the design surface invokes the context menu, which displays a specific set of commands based on the element that
is clicked.

The WYSIWYG nature of Snap allows you to view document content on the design surface in the same way it will appear on
paper. However, the complete document (as it appears in a Print Preview) may differ from the document layout shown in the



design surface. For example, setting the List | Editor Row Limit toolbar option limits the total number of processed data records
while the document layout is being designed.

The View toolbar contains the commands that allow you to switch the document presentation mode (Simple View, Draft View,
Print Layout), as well as maintain the visibility of rulers and the document zoom factor.



Data ExplorerData Explorer
This topic describes how to use the Data Explorer in Snap.

This topic consists of the following sections.

Overview
Data Type Reference

Overview
The Data Explorer is essential for managing data in Snap applications. It allows you to add new data sources to a Snap
document, access their structure and run the Query Builder to customize a data source.

Using the Data Explorer, you can also manage a report's parameters, as well as the calculated fields supplied to the data source
tables.

You can create a Snap report layout by dropping the data members from the Data Explorer onto a document's design surface. The
data members correspond to the columns created on the design surface, and the data member names are displayed in the
column headers.



To display data in a chart, drop data fields from the Data Explorer onto the corresponding chart areas.

When a data field is added to your document, its data type determines what element is created (e.g., text, chart, or bar code).

Data Type Reference
In the Data Explorer, different icons are assigned to various data objects. These icons are explained in the following table.



R EG U L AR
D ATA
S OU R CE

MAIL
MER G E
D ATA
S OU R CE D ES CR IPTION

Designates an individual data source. When expanded, shows the hierarchy of its tables and/or views.

Designates a data table or view within a data source. When expanded, shows the hierarchy of its data fields. You
can drag a data table and drop it onto the document surface, after which the entire table structure will be
presented in the report in a tabular form.

Parameters. Lists the report parameters. You can include parameters in a document's filtering expression or
calculated fields, or you can use them directly in your reports, (e.g., by dropping them onto the document
surface).

For every table or view, the Data Explorer lists the available data fields. Depending on the data type, it will automatically assign
one of the following icons.

R EG U L AR D ATA S OU R CE MAIL MER G E D ATA S OU R CE D ATA T YPE D IS PL AYED  CONTENTS

Boolean Check Box, plain text

Byte Bar Code, Picture

Date-time Plain text

Numeric Plain text, Bar Code

String Plain text, Bar Code

Calculated field Determined by the result of the calculation.



Report ExplorerReport Explorer
Report Explorer reflects the hierarchy of fields in a Snap document, to quickly navigate through its data levels. It displays the
order of document lists, and lists their active groups in a tree format.

Clicking a node in the Report Explorer activates the corresponding document element that is closest to the currently displayed
page.



Print PreviewPrint Preview
This document describes the Print Preview window, which displays published documents in a Snap application.

Print Preview Elements
Invoke a Print Preview

Print Preview Elements
The Print Preview displays a report document as it will appear on paper.

The user interface of the Print Preview window consists of the following elements.

Ribbon - contains the document management and navigation commands divided into logical groups;

Document Pages Area - displays a report document and provides vertical and horizontal scroll bars to navigate through
the report.



Status Bar - displays the page number of the currently selected page (out of a total number of pages), shows the progress
bar while a document is being loaded, and enables document zooming.

Invoke a Print Preview
To assemble and preview a tabular report, click Print Preview in the General Tools: File toolbar.

Using the option above to preview a mail merge report will only display the document obtained from the first data source
record.

To assemble and preview a mail merge report, click Finish & Merge in the Data Tools: Mail Merge toolbar and select Print
Preview in the invoked drop-down menu.



In the invoked Export Range dialog, specify the required range of data records and click OK.



Connect to DataConnect to Data
The topics in this section describe the various aspects of providing data to a Snap document.

Connect a Document to a Data Source
Create a Master-Detail Data Source
Filter Data
Format Data
Group Data
Sort Data
Pass Parameter Values
Use Calculated Fields
Use the Query Builder



Connect a Document to a Data SourceConnect a Document to a Data Source
This tutorial describes the steps required to connect a Snap document to data by using the Data Source Wizard and Query
Builder.

1. Click Data | Add New Data Source on the Snap application's ribbon toolbar.

Alternatively, right-click anywhere in the Data Explorer and click Add Data Source in the invoked menu.

The Data Source Wizard is invoked. Proceed with the following steps in the wizard.

1. On the first page of the invoked Data Source wizard, specify a name for the new data source and click Next.

2. On the next page, select a data source type (Database) and click Next.



3. If a data connection has already been specified in the application, the next wizard page allows you to select whether to
use one of the existing connections, or create a new one.

4. On the next page, select a data provider, specify the required connection settings and click Next.



On this page, you can define a custom connection string, or select from the following supported data source types.

Microsoft SQL Server
Microsoft Access 97
Microsoft Access 2007
Microsoft SQL Server CE
Oracle
Amazon Redshift
Google BigQuery
Teradata
Firebird
IBM DB2
Firebird
IBM DB2
MySQL
Pervasive PSQL
PostgreSQL
SAP Sybase Advantage
SAP Sybase ASE
SQLite
VistaDB
VistaDB5

XML File

Depending on the selected data provider, it may be necessary to specify additional connection options (such as
authentication type and database name) on this page.

To proceed to the next wizard page, click Next.

5. On the next page you are prompted to save the connection string including or excluding the user name and a
password. Choose any option and click Next.

6. This page allows you to select a query or a stored procedure.

Click Run Query Builder... to invoke the Query Builder window.



7. In the invoked Query Builder window, double-click the Categories item in the list of available tables on the left to
add it to the tables included into the query.

Enable the check box for the Categories table, to include all of its fields in the view.

Click OK to close the Query Builder and return to the Data Source Wizard.

8. When the query is ready, click Finish to save it.



2. After the data source has been added to the report, the hierarchy of its data members is reflected in the Data Explorer.

The Snap report is now connected to data. Drag-and-drop the CategoryName and Description data fields from the Data
Explorer onto the document's body to create a simple data-aware report.



Create a Master-Detail Data SourceCreate a Master-Detail Data Source
This tutorial describes how to add a master-detail relation to the document's data source.

Prior to the following steps, connect a Snap document to data as shown in the Connect a Document to a Data Source tutorial.

1. Right-click the NWind Data Source node in the Data Explorer window and select Manage Queries... in the invoked
context menu.

2. The Manage Queries dialog is displayed. It lists the available queries and allows you to edit them, delete or add a new
query. Click the ellipsis to the right of the query name to invoke the Query Editor dialog for the selected query.

3. Click Run Query Builder.. to invoke the Query Builder window.



4. Double-click the Products item in the list of available tables on the left to include it in the list of data tables to be used.

Enable the check box for the Products table, to include all of its fields in the view.

Click OK to close the Query Builder. Click Finish to close the Query Editor. Click OK to close the Manage Queries window
which contains now two queries.

5. Right-click the NWind Data Source node in the Data Explorer window and select Manage Relations... in the invoked
context menu.



6. In the invoked Master-Detail Relation Editor window select the CategoryID item in the Categories table and drag it to
item of the same name in the Products table.

7. The relation is created as illustrated in the following image.



Next, click OK to apply changes to the data source and exit.

8. The content of the Data Explorer will be updated to reflect the new structure of the document data source.



Filter DataFilter Data
This document describes how to filter dynamic data within a Snap document.

The document consists of the following sections.

Filter Data on the Design Surface
Filter Data at the Data Source Level
Filter Snap List Data
Filter Mail Merge Document Data

Filter Data on the Design Surface
To improve performance, the Snap Design Surface displays only the first 20 data rows while the document layout is being
designed. To change the number of data rows displayed, specify the Editor Row Limit option, which is located in the List tab of
the main toolbar.

This setting does not affect the final document.

Filter Data at the Data Source Level
Filtering data at the data source level is useful when dealing with large data sources because it reduces data retrieval time, and
thus speeds up document generation.

To filter data at the data source level, use the Query Builder.

Filter Snap List Data
To select which data records to include in the document, click the Quick Filter command in the Field tab of the contextual Data
Tools toolbar category. In the invoked drop-down menu, select the required records and click OK to apply the filtering.



To specify the filtering criteria for Snap list data, do the following.

1. Place the text cursor inside the Snap list that you wish to filter and click the Filter command in the List tab of the contextual
Data Tools toolbar category.

2. In the invoked FilterString Editor, construct the required filter expression and click OK to apply the filtering.

Filter Mail Merge Document Data



Filtering a mail merge document defines which data entries will appear as pages of the final document.

To filter a mail merge document, do the following.

1. Switch to the Mail Merge tab of the contextual Data Tools toolbar category, and click the Filter command.

2. In the invoked FilterString Editor, construct the required expression and click OK to apply the filtering.

3. To view the result, click the Finish & Merge button in the Mail Merge tab of the contextual Data Tools toolbar category,
and select Print Preview... in the drop-down menu. In the invoked Export Range dialog, select All records and click OK.



The following image illustrates a print preview for a filtered mail merge document.



Format DataFormat Data
This document describes how to format dynamic textual data in a Snap document.

To format report data, do the following.

1. Select the Snap field that you wish to format. It must be a field displaying textual information (e.g., a Text field or a Row
Index field). This will activate the Field tab in the contextual Data Tools toolbar category.

2. In the Field tab, click the Properties button.
3. In the invoked drop-down menu, click the ellipsis button for the Format String property.

4. Specify the required formatting in the invoked FormatString Editor, and click OK to exit the dialog.

Snap supports both standard and custom .NET format strings.

http://msdn.microsoft.com/en-us/library/ee372286.aspx
http://msdn.microsoft.com/en-us/library/ee372287.aspx


Group DataGroup Data
This document describes how to group data in a Snap document.

To group dynamic data within a Snap list, select the field that you wish to group. This automatically activates the contextual Data
Tools: Field tab in the main toolbar. In this tab, click the Group By Field button.

The Snap list will be updated to reflect the applied grouping.

A group header and a group footer are automatically created for the new grouping. By default, the group header displays the
value of the field by which to group, and the group footer displays the total count of entries in the group (evaluated by the Count
summary function).

To add or remove group headers and footers, use the corresponding commands in the Group tab of the main toolbar.

The following image illustrates a Snap list with grouping applied.



All groupings added to a report are displayed in the Report Explorer as child nodes of the Snap list to which they are applied.



Sort DataSort Data
This document describes how to sort dynamic data within a Snap document.

The document consists of the following sections.

Sort Snap List Data
Sort Mail Merge Document Data

Sort Snap List Data
To apply sorting to a Snap list, do the following.

1. Select the Snap field that you wish to use as filter criteria. The field must be located inside a Snap list. This automatically
activates the contextual Field tab in the main toolbar.

2. In the Field tab, click the Sort Ascending or Sort Descending button, depending on the required sort order. The Snap list
will automatically be updated to reflect the sorting applied.

Sort commands are also available in the context menu.

You can specify multiple sort criteria for a Snap list. In this case, sort levels are applied in the order that they are added.

Sort Mail Merge Document Data
Sorting a mail merge document defines the order in which data entries will appear as pages of the final document.

To sort a mail merge document, do the following.

1. Switch to the Mail Merge tab of the main toolbar and click the Sort command.



2. Click the Add Level button in the invoked Sort dialog. Specify the sort criteria and sort order for the additional sort level.

To change the order in which sort levels are applied to the document, use the arrow buttons.

Click OK to exit the dialog.

3. To view the result, click the Finish & Merge button in the Mail Merge tab of the main toolbar, and select Print Preview...
in the invoked drop-down menu. In the invoked Export Range dialog, select All records and click OK.



The following image demonstrates a print preview for a sorted mail merge document.



Pass Parameter ValuesPass Parameter Values
This document describes the main concepts for using parameters in Snap, and provides examples of their use in various tasks.

The document consists of the following sections.

Create Parameters
Pass Parameter Values

Create Parameters
You can manage the report parameters available for a Snap document using the Parameters dialog.

To invoke the Parameters dialog, right-click the Parameters node (or any of its sub-nodes) in the Data Explorer and select Edit
Parameters... in the invoked drop-down menu.

The Parameters dialog allows you to add and remove parameters using the corresponding buttons. Alternatively, you can add or
remove a parameter by right-clicking the parameter in the Data Explorer and selecting the required action in the invoked drop-
down menu.

Select the newly added parameter and specify its properties in the properties grid. Be sure to specify the proper parameter type
based on the parameter's intended use.

Pass Parameter Values
After a parameter is created, it can be used in different ways during report generation. Below is a list of tasks that can be
accomplished using parameters.

Data Binding

To display a parameter's value in a report, drag the parameter from the Field List and drop it onto the Design Surface.



Filtering

You can use a report parameter as part of a filtering expression to filter the Snap document data at either the report level or
the data source level.

To filter the Snap document data at the data source level, do the following.

1. Invoke the Query Builder for the data source that you wish to filter.

2. In the Query Builder, click the Filter button to invoke the Filter Editor.

3. In the Filter Editor, construct an expression where the parameter's value is used as a filtering criterion. To access the
parameter, click the icon on the right. It will turn into a question mark.



Click OK to exit the dialog.

The SQL query generated by the query designer will be updated to reflect the specified filtering.

In a similar way, you can use the Filter Editor to filter the Snap document data at the report level. In this case, to
invoke the Filter Editor, click the Filter button that resides on the List tab of the contextual Data Tools toolbar
category.

Calculated Fields

In addition to standard data fields, parameters can be used in expressions for calculated fields. The only difference is that the
data field is inserted into the expression's text using its name in [square brackets], while a parameter is inserted using the
"Parameters." prefix before its name.





Use Calculated FieldsUse Calculated Fields
This document describes how to use calculated fields to evaluate custom expressions based on external data, and embed the
results into a Snap document.

Use calculated fields to perform additional calculations on dynamic data and embed the results into a published document.

To create a calculated field and access its collection, invoke the context menu in the Data Explorer.

A calculated field's expression can include conditional, date-time, mathematical and other formulas. It can also evaluate the values
of other calculated fields, data source fields and parameters.

The Expression Editor is invoked by right-clicking a calculated field and choosing the Edit Expression… item in the invoked
popup menu.



After a calculated field is inserted into a document, its value is evaluated each time the document is set to be published.



Use the Query BuilderUse the Query Builder
This topic describes how to use the Query Builder to manage data tables and their relations in a Snap data model (e.g., to create
master-detail data sources), filter incoming data and specify a custom SQL string.

The Query Builder displays the structure of a connected data source along with its associated Snap data model. When designing a
report, this data model is reflected in the Data Explorer.

This topic includes the following sections.

Run the Query Builder
Manage Data Tables and their Relations
Shape Data

Run the Query Builder
An option to invoke the Query Builder is provided on the last page of the Data Source Wizard. The Data Source Wizard is
invoked at connecting a Snap document to a Data Source. Click the Run Query Builder... button to invoke the Query Builder
window.

Alternatively, you can run the Query Builder by right-clicking a data source in the Data Explorer and selecting the Manage
Queries... item in the invoked menu.



Manage Data Tables
Double-click table names in the rightmost column to add them to the query being edited. To include a particular field in the query,
enable the corresponding check box.

The Query Builder automatically highlights the tables of an external data source that are related to the tables of a Snap data
model by one or more primary keys.

When the related table is added to the query being edited, the corresponding primary keys are automatically connected.

Shape Data
To assign a custom name to the selected data column, specify its Alias in the column list displayed in the lower part of the
window.

To specify the filter criteria applied to source data, click the Filter button, which invokes the Filter Editor.





Create a Report LayoutCreate a Report Layout
Topics in this section provide information on creating reports with different layouts in Snap.

Create a Mail-Merge Report
Create a Master-Detail Report
Create a Table Report
Create a Multi-Column Report
Create a Side-by-Side Report
Create a Parameterized Report
Create a Chart-Based Report
Create a Combined Report Layout



Create a Mail-Merge ReportCreate a Mail-Merge Report
This tutorial illustrates the steps required to create and publish a mail merge report with Snap.

The tutorial contains following sections.

Add Dynamic Content
Preview and Publish the Document

Add Dynamic Content
To create a Snap report using a document template, do the following.

1. Add a new Snap document and provide it with a master-detail data connection.

2. Next, specify which data source will be used for mail merge. To do this, click the Data Source button on the Data Tools: Mail
Merge tab and select the required data source in the invoked drop-down list.

Alternatively, right-click the required data source in the Data Explorer and select Use For Mail Merge in the invoked drop-
down menu.

3. To insert data bound fields into the document, drag-and-drop data fields from the Data Explorer onto the Design Surface.



Activate the Highlight Fields option from the View tab of the main toolbar to highlight all mail merge fields in a document.
This allows you to easily distinguish between dynamic and static content.

4. To insert a detail report section, drag-and-drop fields from a subordinate node of the data source. Fields of a nested level of
a mail-merge data source are inserted into a template as columns of a table.



Preview and Publish the Document
The Snap mail merge document is now ready. To view the result, click the Finish & Merge button in the Mail Merge tab, and
select Print Preview... in the invoked drop-down menu. In the invoked Export Range dialog, select All records and click OK.

The following image illustrates a print preview for the final document.





Create a Master-Detail ReportCreate a Master-Detail Report
This document will guide you through the process of creating a master-detail report. Reports of this type are built upon
hierarchical data sources, so to be able to create a master-detail report, you need to provide a report data source with a master-
detail relation.

To get started with this tutorial, create a new Snap document and add a master-detail relation to it.

Perform the following steps to create a master-detail report.

1. Create a master report. To do this, drag-and-drop data fields of the master data table from the Data Explorer to the design
surface. You can use any type of layout.

2. To create a detail report, drag-and-drop data fields of the detail data table from the Data Explorer onto the lower border of
the master report's data row, as shown in the image below.

3. The master-detail report is now ready. Click the Print Preview button in the General Tools: File tab of the main toolbar to
view the preview.





Create a Table ReportCreate a Table Report
This tutorial will guide you through the process of creating a Table Report, and printing and saving it to your hard drive. The
table report is a data-aware Snap report with a tabular master-detail layout.

To get started with this tutorial, create a new Snap document and provide a hierarchical data source for it, as described in the
Create a Master-Detail Data Source topic.

To create a master-detail Snap document layout, do the following.

1. Create a simple tabular report by selecting the data fields that you wish to include in the report in the Data Explorer and
dragging them to the Design Surface. When you drop data fields onto the empty space in the document body, they are
added as columns of a table. You can select multiple data fields by pressing CTRL or SHIFT.

To improve performance, Snap shows only the first 20 data rows of a Snap list by default. To change this setting, use the
Editor Row Limit option, which is located on the List tab of the main toolbar.

2. To convert the layout of a Snap list to a paragraph presentation, select the Snap list you wish to convert and click the
Convert to Paragraphs command in the List tab of the contextual Data Tools toolbar category. Note that there is no
reverse action allowing you to convert a Snap list back to the tabbed form.

The report should now appear as shown in the following image.



To remove a list header, select the Snap list, click the Header command in the List tab of the main toolbar, and select
Remove Header in the invoked drop-down menu.

3. To create a detail report, drag data fields from the child data table in the Data Explorer onto the lower border of the master
report's data row, as shown in the image below.

The added detail part will have a tabular form by default.



4. To preview your Snap document click the Print Preview button in the General Tools: File tab of the main toolbar.



Create a Multi-Column ReportCreate a Multi-Column Report
This tutorial guides you through the creation of a Multi-Column Report. A multi-column report is a report which represents its
data in multiple columns or rows (depending upon the current multi-column settings).

To create a multi-column report, do the following.

1. In a new Snap document, create a simple table report, as described in the Create a Table Report topic.

2. In the main toolbar, switch to the General Tools: Page Layout tab, click Columns, and select the required number of
columns in the drop-down menu.

To define more than three columns, click More Columns. In the invoked Columns dialog, customize the report layout to
meet your requirements.

The following image illustrates the result.





Create a Side-by-Side ReportCreate a Side-by-Side Report
This tutorial describes the steps used to create a side-by-side report to compare different items within the report.

Follow these steps to create a side-by-side report.

1. Create a new Snap document and bind it to the required table as described in the Connect a Document to a Data Source
topic.

2. To add a new table to the report, switch to the Insert tab in the main toolbar and click Table. Then, move the cursor over the
grid to select the required number of rows and columns.

You can set table borders by clicking the Borders button on the Design tab.

3. Then, drop the fields that will be compared from the Data Explorer on the table's corresponding columns.



4. To filter each table column so that it shows only a single record, select a field on the left column and in the activated Field
tab in the main toolbar, click Quick Filter. In the invoked menu, select the required field and click OK.

Finally, repeat the same procedure for the right column, so that it displays a different field to compare it with.





Create a Parameterized ReportCreate a Parameterized Report
This tutorial illustrates the steps required to create a parameterized report. In this tutorial, we will create a parameter and pass it
to the report's filtering expression. You are not limited by the number of parameters you can create, or the data type (e.g., string,
date-time, Boolean, integer and double). Parameters can be used in other ways such as data binding and calculated fields.
Tasks that can be solved using parameters are described in the Pass Parameter Values topic.

Follow these steps to create a report with parameters.

1. Create a new Snap document and bind it to the required table.

2. To create a layout for your report, drop the required data fields from the Data Explorer to the Design Surface.

3. To create a parameter, switch to the Data Explorer window, right-click the Parameters section and choose Add Parameter.

4. Right-click the created parameter and select the Edit Parameters... action in the invoked popup menu.



5. In the invoked editor, define the parameter name and assign an appropriate type to it. This type corresponds to the value
that a parameter can receive (e.g., you cannot assign a string value to a numeric parameter).

Next, assign a default static value to the parameter.

If required, you can easily modify the parameter value in the same way described in steps 4 and 5.

6. Now, switch to the List tab in the main toolbar and click the Filter button.

In the invoked FilterString editor, define a filtering expression (e.g., UnitPrice data field is greater than or equal to the
Starting Price parameter).

To access the parameter, click the icon on the right until it turns into a question mark, and then select your parameter from
the drop-down list.

The parameterized report is now ready, and its data is filtered based on the specified expression that uses the parameter value to
shape the report's data.

To view how your report will look on paper, switch to the File tab in the main toolbar and click the Print Preview button.





Create a Chart-Based ReportCreate a Chart-Based Report
This tutorial describes the steps used to add a chart to your Snap report. Snap supports many chart types, as well as multiple
visual appearance settings and chart palettes.

Snap also provides the Chart Wizard, which allows you to quickly create and customize complex charts. However, when advanced
charting functionality is not required, Snap provides an even easier way to create and customize your charts.

Do the following steps to create a chart-based report.

1. Create a new Snap document and bind it to the required table.

2. Click the Chart command in the Insert tab of the main toolbar.

3. In the created chart, the blue circles correspond to the values and arguments of the chart. Drop one field from the Data
Explorer onto the "arguments" region in the chart...

...and the other onto the "values" region.



4. You can change the default chart type to one that best meets your requirements by selecting the chart and switching to the
Design tab of the main toolbar.

In the same tab, you can also run Chart Wizard and select the chart's palette and visual appearance.

5. The Snap report with a chart is now ready. To view the result, switch to the File menu of the main toolbar and click the Print
Preview button.



Create a Combined Report LayoutCreate a Combined Report Layout
Snap allows you to create a single combined report, incorporating features of different report layout types. There is no limits on
how many reports you can combine.

In this tutorial, we will create a combined report that uses the features of mail-merge and chart-based reports.

The tutorial consists of the following sections.

Add Mail-Merge Report Functionality
Add Chart-Based Report Functionality
View the Result

Add Mail-Merge Report Functionality
In this section, we will create a simple Mail-Merge Report.

1. Create a new Snap document and provide it with a master-detail data connection.

2. Specify which data source will be used for mail merge by right-clicking the required data source in the Data Explorer and
select Use For Mail Merge in the invoked drop-down menu.

3. Insert a master report part. To do this, drag-and-drop data fields from the Data Explorer onto the Design Surface.

4. To insert a detail report part, drag-and-drop fields from a subordinate node of the data source.



The added detail part will have a tabular form by default.

For more information on the creation mail-merge report, see the tutorial Create a Mail-Merge Report.

Add Chart-Based Report Functionality
In this section we will add a Chart to the Snap document.

1. Click the Chart command in the Insert tab of the main toolbar.

2. In the created chart, the blue circles correspond to the values and arguments of the chart. Drop one field from a subordinate
node of the data source onto the "values" region in the chart...



...and the other onto the "arguments" region.

For more information on the creation of a chart-based report, see the tutorial Create a Chart-Based Report.

View the Result
The Snap mail merge document is now ready. To view the result, click the Finish & Merge button in the Mail Merge tab,
and select Print Preview... in the invoked drop-down menu. In the invoked Export Range dialog, select All records and
click OK.



The following image illustrates a print preview for the final document.



Manage Documents and FilesManage Documents and Files
The tutorials in this section will assist you in solving the most elementary and essential tasks that relate to managing and storing
Snap documents.

This section includes the following tutorials.

Create a New Report
Storing Reports
Save a Report
Open an Existing Report
Export a Report



Create a New ReportCreate a New Report
To create a new Snap report, click the New button on the File tab of the Snap application's ribbon toolbar.

A new Snap report will be created and opened in the editor.



Storing ReportsStoring Reports
Snap provides the capability to store a report to a file and restore it. To retain all Snap-specific features, save your report in the
Snap native document format (.SNX). You can also export your report to one of file formats listed below, but in this case, Snap
fields will be replaced with their values and data connection information will be removed.

Supported document formats for export:

DOC (Microsoft® Word® 97 - 2003 document);
DOCX (Office® Open XML document);
HTML (HyperText Markup Language);
MHTML / MHT (Web archive, single file);
PDF (Portable Document Format);
RTF (Rich Text Format);
TXT (Plain text);
ODT (OpenDocument text format);
XML (Microsoft® Word® XML document);
Image (BMP, EMF, WMF, GIF, JPEG, PNG or TIFF format).



Save a ReportSave a Report
To save a report to a file, click the Save button on the File tab of the Snap application's ribbon toolbar.

If you are saving a new report, the Save As dialog will be invoked. In the invoked dialog, specify the name and directory for the
new report file and click Save.

To save a changed copy of an existing report to a separate file, click the Save As button in the File tab of the ribbon toolbar.



Open an Existing ReportOpen an Existing Report
To open an existing report, click the Open button on the File tab of the Snap application's ribbon toolbar.

In the invoked Open dialog, select a file and click Open.



Export a ReportExport a Report
In addition to native .snx file format, Snap allows you to export reports into the one of the wide variety of third-party formats, (e.g.,
PDF, HTML or DOCX).

To export a Snap report in a third-party format, do the following.

1. Click the Export Document button on the File tab of the Snap application's ribbon toolbar.

2. In the invoked Save As dialog, select a directory in which you want to save, specify the name and format of the exported file,
and click Save to export the report and exit the dialog.



SpreadsheetSpreadsheet
This section describes the capabilities provided by the Spreadsheet.

Spreadsheet UI

Ribbon Interface
Spreadsheet Elements

File Operations

Create a Workbook
Load a Workbook
Create a Worksheet
Rename a Worksheet
Delete a Worksheet
Save a Workbook
Import and Export Text Files
Print a Workbook
Adjust Page Settings
Undo and Redo Last Actions

Viewing and Navigating

Hide and Display Worksheets
Zoom a Worksheet
Hide Gridlines and Headings
Freeze Columns and Rows

Editing Cells

Select Cells or Cell Content
Copy and Paste Cell Content



Fill Data Automatically
Find and Replace
Insert a Comment
Insert a Symbol

Cell Formatting

Format Cells
Format Cell Content
Wrap Text and Merge Cells
Number Formatting
Conditional Formatting
Clear Cell Formatting

Columns and Rows

Insert and Delete Columns and Rows
Show and Hide Columns and Rows
Specify Column Width and Row Height

Tables

Create a Table

Pivot Tables

Create a Pivot Table
Modify a Pivot Table
Refresh the PivotTable Data
Change the PivotTable Layout
Apply a Predefined Style to a Pivot Table
Change the PivotTable Layout
Subtotal and Total Fields in a Pivot Table
Group Items in a Pivot Table
Sort Items in a Pivot Table
Filter a Pivot Table
Insert a Calculated Field and Calculated Item

Data Analysis and Presentation

Outline Data
Subtotal Data
Sort Data
Filter Data

Protection

Protect a Workbook
Protect a Worksheet
Protect Worksheet Ranges
Encrypt a Workbook with the Password

Data Validation

Validate Data in Cells

Formulas



Create a Simple Formula
Cell References
Defined Names
Using Functions in Formulas
Supported Functions
Create an Array Formula
Error Types in Formulas

Charting

Charting Overview
Creating a Chart
Changing a Chart Type
Applying a Predefined Chart Layout and Style
Modifying a Chart Manually
Creating a Chart Sheet

Mail Merge

Mail Merge Overview
Data Source Wizard
Query Builder
Parameters Panel

Pictures and Hyperlinks

Insert a Picture
Move, Rotate and Resize a Picture
Insert and Delete Hyperlinks
Shortcuts to Work with Pictures

Keyboard Shortcuts

File Operations
Navigation inside Worksheets
Work with Selections
Copy, Paste and Edit the Cell Content
Cell Formatting
Work with Columns and Rows
Sort and Filter
Work with Formulas



Ribbon InterfaceRibbon Interface
The comprehensive functionality of the Spreadsheet is provided by a set of Ribbon pages. Ribbon pages are divided into logical
groups that include commands with common features. Use the Ribbon interface to perform basic operations in the Spreadsheet
(load, create and save workbooks, add or remove worksheets, format cells, insert rows and columns, etc.).

File Tab

Create a Workbook
Load a Workbook
Save a Workbook
Print a Workbook
Undo and Redo Last Actions
Encrypt a Workbook with the Password

Home Tab

Copy and Paste Cell Content
Format Cells
Format Cell Content
Wrap Text and Merge Cells
Number Formatting
Conditional Formatting
Clear Cell Formatting
Insert and Delete Columns and Rows
Show and Hide Columns and Rows
Specify Column Width and Row Height
Fill Data Automatically
Find and Replace

Insert Tab



Create a Pivot Table
Create a Table
Insert a Picture
Move, Rotate and Resize a Picture
Insert and Delete Hyperlinks
Charting Overview
Creating a Chart
Changing a Chart Type
Applying a Predefined Chart Layout and Style
Modifying a Chart Manually
Insert a Symbol

Page Layout Tab

Adjust Page Settings

Formulas Tab

Create a Simple Formula
Cell References
Defined Names
Using Functions in Formulas
Supported Functions
Create an Array Formula
Error Types in Formulas

Data Tab



Sort Data
Filter Data
Validate Data in Cells
Outline Data
Subtotal Data

Review Tab

Insert a Comment
Protect a Workbook
Protect a Worksheet
Protect Worksheet Ranges

View Tab

Zoom a Worksheet
Hide Gridlines and Headings
Freeze Columns and Rows

Mail Merge Tab

Mail Merge Overview
Data Source Wizard
Query Builder
Parameters Panel



Spreadsheet ElementsSpreadsheet Elements
The Spreadsheet can include the following elements:

Ribbon

Formula Bar

Spreadsheet Control

Status Bar

Ribbon
A ribbon contains multiple tabs with grouped commands that enable you to perform basic operations in the Spreadsheet control:
create, load, modify, save, and print spreadsheet documents.



Formula Bar
The Formula Bar displays an active cell's value and allows you to view, enter, and edit formulas and cell data in the Spreadsheet
control.

The Name Box is a part of the Formula Bar that displays a reference to an active cell or a name for the selected cell range (if
specified), picture or chart. The Name Box also enables you to create named ranges, and quickly navigate to cells by their
references and names.



Spreadsheet Control
WorksheetWorksheet

A worksheet is a single page within a document. A worksheet is represented by a grid of cells and is used to store and edit data in
the Spreadsheet control. The default Spreadsheet application contains one blank worksheet.

Rows and ColumnsRows and Columns

Each worksheet is divided into 1,048,576 rows and 16,384 columns. Each row is numbered (1, 2, 3, ...) and each column is lettered
(A, B, C, ...) or numbered (1, 2, 3, ...), depending on the reference style applied.

CellsCells

All worksheet data is stored in cells. All cells have faint borders, or gridlines, around them.



You can double-click a cell, press F2 or start typing to edit a cell value. You can enter a numeric] or text value, or insert a formula
to calculate a cell's value dynamically.

SelectionSelection

The Spreadsheet control enables you to select cells, cell ranges, rows, and columns in a worksheet. The selected cell used to enter
data is called an active cell. When a cell range is selected, the active cell is usually the top left cell of this range.

Sheet Tab SelectorSheet Tab Selector

The Sheet Tab Selector displays all worksheets in a workbook. It enables you to add new worksheets, move between the existing
worksheets, rename, hide or delete them.

Ver tical and Horizontal Scroll B arsVer t ical and Horizontal Scroll B ars

The horizontal and vertical scroll bars allow you to navigate through the current worksheet.



Context MenusContext Menus

When you right-clicks anywhere on a worksheet (that is, a cell, row or column header, picture or chart), a context menu appears. It
contains basic commands used to work with the current object.

Status Bar
A status bar appears at the bottom of the Spreadsheet application and displays the following elements:

Summary data: the average, count, numerical count, min, max, and sum of selected cells.

The zoom level and zoom slider.



Create a WorkbookCreate a Workbook
To create a blank workbook, select the File tab, and click the New button in the Common group (or press CTRL+N).



Load a WorkbookLoad a Workbook
To load a workbook, select the File tab, and click the Open button in the Common group (or press CTRL+O).

In the invoked Open dialog box, select the file you wish to open.

The Spreadsheet supports the following file formats.

Excel Workbook (*.xlsx)
Excel Macro-Enabled Workbook (*.xlsm)
Excel 97-2003 Workbook (*.xls)
Excel Template (*.xltx)
Excel Macro-Enabled Template (*.xltm)
Excel 97-2003 Template (*.xlt)
Tab-delimited Text File format (*.txt)
Comma-separated Values File format (*.csv)



Create a WorksheetCreate a Worksheet
To create a new worksheet within the current workbook, do one of the following.

Click the New Sheet button (which looks like a plus sign) at the right edge of the Sheet tab bar.

To insert a worksheet in front of the existing worksheet, go to the Home tab, and then in the Cells group, click the Insert
button and select the Insert Sheet item from the drop-down list or press SHIFT+F11.

On the Sheet tab bar, right-click the sheet tab of the existing worksheet and select the Insert item from the invoked menu.



Rename a WorksheetRename a Worksheet
When a new worksheet is created, the Spreadsheet assigns it a generic name, such as Sheet1, Sheet2, etc.

To rename a worksheet, double-click its sheet tab on the Sheet tab bar to invoke the Rename Sheet dialog box, or ...

... right-click the sheet tab of the worksheet and select the Rename item from the invoked menu. Rename the worksheet and click
OK.

The Spreadsheet sets the following rules for a valid worksheet name.

The maximum length of a worksheet name is 31 characters.
A worksheet name must not be an empty string.
A worksheet name must not include the following characters: \, /, ?, :, **, *[, ].
A worksheet name must not start or end with a single quote.
A worksheet name must not be equal to a name of another existing worksheet.



Delete a WorksheetDelete a Worksheet
To delete an existing worksheet, follow the instructions below.

1. Switch to the worksheet you want to delete.

2. Do one of the following.

On the Home tab, in the Cells group, click the Delete button and select the Delete Sheet item from the drop-down
list.

Right-click the sheet tab of the worksheet, and then click the Delete item from the context menu.



Save a WorkbookSave a Workbook
To save a workbook, go to the File tab, and then click the Save as button in the Common group, or press F12 instead of these
steps.

After that, the Save as dialog box is invoked.

Specify the location and the file format in which to save the workbook.

The available file formats in the Save as dialog box are the following.

Excel Workbook (*.xlsx)
Excel Macro-Enabled Workbook (*.xlsm)
Excel 97-2003 Workbook (*.xls)
Excel Template (*.xltx)
Excel Macro-Enabled Template (*.xltm)
Excel 97-2003 Template (*.xlt)
Tab-delimited Text File format (*.txt)
Comma-separated Values File format (*.csv)

To save the active workbook with its current file format and location, go to the File tab, and then click the Save button in the
Common group, or press CTRL+S instead. If you click the Save button to save a newly created workbook, the Save as dialog is
invoked.



Import and Export Text FilesImport and Export Text Files
The Spreadsheet provides the capability to save a workbook as a text file (.txt or .csv) or load data from text files.

Save a Workbook as a Text File
1. To save a workbook as a text file, go to the File tab, and in the Common group, click the Save As button.

2. In the Save As dialog box that is invoked, select the Text (Tab-delimited) or CSV (Comma-delimited) item from the
Save as type drop-down list.

The main features of the tab-delimited and comma-delimited file formats are described below.

Tab-delimited text files

This file format uses the TAB character to separate each field of text. Note that the Spreadsheet only saves the active
worksheet as a text (.txt) file. The columns are separated by the tab characters and each row ends with a carriage return
character. The values and text in cells are saved as they are displayed in a worksheet. If a cell contains a comma, the cell
contents are enclosed in double quotation marks. All formatting options applied to the cell, pictures and objects (such as
hyperlinks) are lost.

Comma-delimited text files

This file format uses the comma character to separate each field of text. Note that the Spreadsheet only saves the active
worksheet as a CSV (.csv) file. Columns are separated by commas, and each row ends with a carriage return character. Cell
text and values are saved as they are displayed in a worksheet. If a cell contains a comma, cell contents are enclosed in
double quotation marks. All formatting options applied to the cell, pictures and objects (such as hyperlinks) are lost.

Load Data from Text Files
1. To load data from text files (.txt or .csv), go to the File tab, and in the Common group, click the Open button.



2. In the Open dialog box that is invoked, locate the text file you wish to open and click Open.



Print a WorkbookPrint a Workbook
This document includes the following sections:

Preview a Workbook before Printing
Print a Workbook
Print a Workbook Using the Default Settings
Print Gridlines and Headings
Print Comments
Change Print Resolution and Quality
Set a Print Area
Set Print Titles
Add Headers and Footers to a Worksheet Printout

Preview a Workbook Before Printing
To view your workbook as it will be printed, select the File tab and click the Print Preview button in the Common group.

At the bottom of the Preview window, the Spreadsheet indicates how many pages the workbook will require when printed, and
the number of the page you are currently viewing.

Print a Workbook
To print a document, click the Print button in the Common group or press CTRL+P.



In the invoked Print dialog box, specify the required settings and click Print.

Print a Workbook Using the Default Settings
To send a workbook directly to the default printer without setting print options, click the Quick Print button in the Common
group.

Print Gridlines and Headings
To print worksheet gridlines or row/column headings, on the Page Layout tab, in the Print group, check the Gridlines and
Headings boxes...



...or click the Dialog Box Launcher. In the invoked Sheet tab of the Page Layout dialog, check the Gridlines and Row and
column headings boxes.

Print Comments
The SpreadsheetControl doesn't print comments by default. To enable printing comments, do the following.

On the Page Layout tab, in the Print group, click the Dialog Box Launcher.

In the invoked Sheet tab of the Page Setup dialog, click the Comments drop-down menu and select As displayed on
sheet. To print the comments on a separate sheet of paper, select At end of sheet.



Change Print Resolution and Quality
Depending on the used printer, you can change the resolution settings to a lower or higher dpi (dots-per-inches) setting. Invoke
the Page Setup dialog by clicking the Dialog Box Launcher in the Page Setup group.

On the Page tab, select the desired resolution from the Print Quality box.



Additionally, you can print your worksheet without graphics (this is useful when it is necessary to accelerate printing and save
toner). To do that, switch to the Sheet tab and check Draft quality box.

Set a Print Area
If you need to print only a specific part of the worksheet, you can define the target cell range as a print area. To do that, do the
following:

1. Select the cells you wish to print.

2. On the Page Layout tab, in the Page Setup group, click the Print Area button and select Set Print Area in the invoked
drop-down menu.



3. ... or click the Page Setup box launcher to invoke the Page Setup dialog, switch to the Sheet tab and specify the print area
in the Print area box. You can type the cell reference or define the range directly in a worksheet by clicking the Collapse
Dialog  button.

4. When you specify the print area, the cell range that it comprises gets a thin dashed outline and the _xlnm.Print_Area name
is added to the collection of the defined names contained in the workbook.

5. To extend the print area, select the select the cell range you wish to add and click Print Area | Add to Print Area in the



Page Setup group. Note that if the print area consists of non-adjacent cell ranges, each range will be printed as a separate
page.

6. To clear the print area and print the entire worksheet, on the Page Layout tab, in the Page Setup group, click Print Area |
Clear Print Area.

Set Print Titles
If a worksheet occupies more than one page, you can repeat specific row or column (print titles) on every printed page to make
the document easier to read. To define print titles, follow the steps below.

1. On the Page Layout tab, in the Page Setup group, click the Print Titles button...

2. ... or to invoke the Page Setup dialog and switch to the Sheet tab.

3. Specify the reference to the row/column containing labels that should be repeated in the Rows to repeat at top and/or
Columns to repeat at left boxes of the Print titles section. You can select the target row or column directly in a worksheet
by clicking the collapse dialog  button.



Add Headers and Footers to a Worksheet Printout
You can set a header and footer for a worksheet printout by doing the following.

1. On the Page Layout tab, in the Page Setup group, click the Page Setup box launcher.

2. In the invoked Page Setup dialog, switch to the Header/Footer tab.

3. Select one of the predefined options in the Header or Footer drop-down list.



4. To specify custom header and/or footer, click the Custom Header/Footer... button to invoke the Header and Footer
dialog.

5. Click in the Left, Center or Right section box and type the desired text. Use the buttons located between the header and
footer sections to insert specific codes that enable including dynamic information into a header or footer, such as a page
number, current date and time, filename, worksheet name, etc.

To insert a picture to the worksheet header or footer, click the Insert Picture  button and select the desired file in the

invoked Open dialog. To format the image so it fits the header/footer area, click the Format Picture  button.





Adjust Page SettingsAdjust Page Settings
Before you print a worksheet, you can change page layout settings such as page margins, page orientation, paper size and scaling.

Set Page Margins
1. Click the worksheet for which you wish to set the page margins.

2. In the Page Setup group within the Page Layout tab, click the Margins button and select the margin sizes to be set for the
current worksheet.

3. To specify custom margins, select Custom Margins... in the drop-down list...

4. ... or click the Page Setup Dialog Box Launcher and switch to the Margins tab in the invoked dialog.

5. Specify desired margin sizes in the corresponding dialog boxes. To center worksheet data on a printed page, check the
corresponding Center on page section boxes.



Set Page Orientation
1. Click the worksheet for which you wish to specify page orientation.

2. In the Page Setup group within the Page Layout tab, click the Orientation button and select Portrait or Landscape from
the invoked drop-down list...

3. ... or invoke the Page Setup dialog by clicking the Page Setup box launcher and select the desired page orientation.



Change Paper Size
1. Click the worksheet for which you wish to set the paper size.

2. In the Page Setup group within the Page Layout tab, click the Size button and select one of the predefined paper sizes
from the invoked drop-down list.

3. Click More Paper Sizes... to set more advanced paper size settings.



Scale a Worksheet
If your worksheet has a lot of columns, you can scale it to reduce the size of the worksheet to better fit the printed page.

On the Page Layout tab, in the Page Setup group, click the Dialog Box Launcher.

In the invoked dialog, in the Scaling section, click Adjust to and specify the percentage of the original size that you wish to use.

To accommodate the worksheet to a specific number of pages, select Fit to: and specify the number or pages wide and tall.





Undo and Redo Last ActionsUndo and Redo Last Actions
The Spreadsheet allows you to undo or redo your last performed action.

To undo an action, select the File tab, and click the Undo button in the Common group (or press CTRL+Z or ALT+BACKSPACE).

To redo an action that you undid, click the Redo button in the Common group (or press CTRL+Y or ALT+SHIFT+BACKSPACE).



Hide and Display WorksheetsHide and Display Worksheets
The Spreadsheet provides the capability to hide worksheets in a workbook. It can be useful if you want to remove a worksheet
from the Sheet tab bar without deleting it. By default, all worksheets are displayed on the Sheet tab bar.

Hide Worksheets
1. Switch to a worksheet you want to hide. To hide multiple worksheets, hold down CTRL and then click the sheet tabs of the

worksheets you wish to hide on the Sheet tab bar.

2. Do one of the following:

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Hide Sheet. Note that this
command is disabled when a workbook includes only one worksheet.

Right-click the selected sheet tabs and select the Hide item from the context menu.

Display Hidden Worksheets
1. Do one of the following:

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Unhide Sheet...;



Right-click any visible sheet tab, and select the Unhide item from the context menu.

2. In the Unhide dialog box that is invoked, select the name of the worksheet you want to display and click OK. Note that you
can hide multiple worksheets at once, but you can display only one worksheet at a time.



Zoom a WorksheetZoom a Worksheet
To zoom in or out of a worksheet, do one of the following:

In the Zoom group within the View tab, click the Zoom In or the Zoom Out button. Click the Zoom 100% button to
restore the worksheet to normal size.

Use zoom slider and zoom level on the status bar. Click zoom level to invoke the Zoom dialog. The dialog allows you to
select a percentage of magnification, or enter a custom percentage.

Hold the CTRL button and rotate your mouse wheel.



Hide Gridlines and HeadingsHide Gridlines and Headings
The Spreadsheet allows you to hide gridlines and headings that are displayed on a worksheet by default.

In the Show group within the View tab, uncheck the Gridlines check box to hide gridlines on a worksheet.

To hide the column and row headers, uncheck the Headings check box.

To display gridlines and headers, select the Gridlines and Headings check boxes, respectively.



Freeze Columns and RowsFreeze Columns and Rows
To keep specific columns and rows of the worksheet visible while scrolling through the rest of the worksheet, lock them in place
using the Freeze Panes options of the Spreadsheet.

To freeze specific row(s) or column(s), follow the instructions below.

1. Depending on what you wish to freeze, do one of the following.
To lock a row(s), select the row below the row(s) you wish to freeze.
To lock a column(s), select the column to the right of the column(s) you wish to freeze.
To lock a row(s) and column(s) simultaneously, click the cell below the row(s) and to the right of the column(s) you
wish to freeze.

2. In the Window group within the View tab, click the Freeze Panes button's drop-down.

Select one of the following.

Freeze Panes - lock multiple columns and/or multiple rows simultaneously.
Freeze Top Row - lock the first row only.

Freeze First Column - lock the left column only.

A black border appears beneath the frozen row(s) and to the right of the frozen column(s).

3. To unfreeze a row(s) or column(s), click the Unfreeze Panes item from the Freeze Panes button's drop-down list. This
unlocks all frozen rows and columns in the worksheet.



Select Cells or Cell ContentSelect Cells or Cell Content
Selecting Cells
To select cells in the Spreadsheet, use the following mouse actions and keyboard shortcuts.

1. To select a single cell, click the cell or press the arrow keys to move to the required cell.
2. To select a range of cells, do one of the following.

Click the first cell in the range and drag it to the last cell.
Hold down the SHIFT key, and then press the arrow keys to extend the selection.
Click the first cell in the range, hold down the SHIFT key, and then click the last cell in the range.

3. To select the entire worksheet, click the Select All button at the intersection of the column and row headings, or press
CTRL+A.

4. To select nonadjacent cells, hold down the CTRL key, and then select other cells.

5. To select an entire row or column, click the row or column heading.

6. To select multiple columns or rows, drag across the row or column headings.

7. To select several nonadjacent rows or columns, click the heading of the first row or column in the selection, hold down
CTRL, and then click the headings of other rows or columns you wish to select.

The following table lists the default keyboard shortcuts used for selecting cells in the Spreadsheet.

CTRL+RIGHT ARROW Selects the last cell in a row.

CTRL+LEFT ARROW Selects the first cell in a row.

CTRL+DOWN ARROW Selects the last cell in a column.

CTRL+UP ARROW Selects the first cell in a column.

CTRL+HOME Selects the first cell on a worksheet.



CTRL+END Selects the last cell that contains data or formatting on a worksheet.

CTRL+A Selects the entire worksheet.

CTRL+SHIFT+END Extends the selection to the last used cell on a worksheet.

CTRL+SHIFT+HOME Extends the selection to the beginning of the document.

Selecting Cell Content
To select the cell content, do one of the following:

Double-click the cell, and then drag across the cell content you wish to select.
Press F2, and then drag across the contents of the cell you wish to select, or press SHIFT+LEFT ARROW to select the cell
content.
Click the cell, and then drag across the cell content you wish to select in the Formula Bar.



Copy and Paste Cell ContentCopy and Paste Cell Content
The Spreadsheet allows you to copy and paste entire cells, or only their contents, using the Clipboard.

To move or copy cell content, follow the steps below.

1. Select the cells that you wish to move or copy.

2. In the Clipboard group within the Home tab, do one of the following.

To move the selected cells, click the Cut button (or press CTRL+X or SHIFT+DELETE).

To copy the selected cells, click the Copy button (or press CTRL+C or CTRL+INSERT).

3. Click the upper-left cell in the area where you wish to paste the copied cells.

4. In the Clipboard group within the Home tab , click the Paste button (or press CTRL+V or SHIFT+INSERT).

To choose special options when you paste cells, in the Clipboard group within the Home tab, click the Paste Special
button (or press CTRL+ALT+V).

In the invoked Paste Special dialog box, select one of the following options.

All - paste all cell content and formatting.
Formulas - only paste formulas, as entered in the Formula Bar.
Values - only paste cell values.
Formats - only paste cell formatting.
Comments - only paste the comments added to the cells.
All except borders - paste cell content and formatting without cell borders.
Column widths - paste the column widths of the copied cells to another range of columns.
Formulas and number formats - only paste formulas and number formatting options from the copied cells.



Values and number formats - only paste values and number formatting options from the copied cells.
Skip blanks - avoid replacing values in the paste area when the copy area includes blank cells.



Fill Data AutomaticallyFill Data Automatically
The Spreadsheet provides the capability to fill adjacent cells with data automatically.

To fill a selected cell or a range of cells with the data contained in adjacent cells, do the following.

1. Select the cell (or range of cells) adjacent to the cell (or range of cells) of the data you wish to repeat.

2. In the Editing group within the Home tab, click the Fill button and select one of the following items from the drop-down
list.

Fill Down (or press CTRL+D) - pastes the contents of the cell that is above the selected cell, or pastes the contents of
the topmost cell in the selected range to the cells below.
Fill Up - pastes the contents of the cell below the selected cell, or pastes the contents of the lowermost cell in the
selected range to the cells above.
Fill Right (or press CTRL+R) - pastes the contents of the cell or cell range to the left of the selected cell(s).
Fill Left - pastes the contents of the cell or cell range to the right of the selected cell(s).



Find and ReplaceFind and Replace
The Spreadsheet allows you to search for specific data in the current worksheet. To perform a search, on the Home tab, in the
Editing group, click the Find & Select button. The button's drop-down menu will be displayed.

Next, do one of the following.

Click Find in the Find & Select drop-down menu (or press CTRL+F) to perform a search in the active worksheet. The Find
and Replace dialog (with the Find tab activated) will be invoked.

In the Find what field, enter the text or number you wish to find, and click the Find Next button to start the search. To
define the direction of the search, in the Search field, select the By Rows or By Columns drop-down item. In the Look in
field, select Values (to search cell values only) or Formulas (to search cell values and formula expressions, excluding the
calculated results). To perform a case-sensitive search, select the Match Case check box. To restrict the search to the entire
cell content, select the Match entire cell contents check box.

Click Replace in the Find & Select drop-down menu (or press CTRL+H) to search for a text string and optionally replace it
with another value. The Find and Replace dialog (with the Replace tab activated) will be invoked.



To replace a value, enter the search term in the Find what field and the replacement text for this search term in the Replace
with field, and then click the Find Next button to find the first occurrence of the search term. Next, click the Replace button
to replace only the value of the selected matching cell, or Replace All to replace all occurrences of the search term. Note
that the Replace tab provides the same search options as the Find tab, with one exception: you can only select the
Formulas drop-down item in the Look in box, so only the underlying formulas (not the calculated results) will be examined
when searching for matches to your search term.



Insert a CommentInsert a Comment
The Spreadsheet allows you to attach notes to individual cells by using comments. Comments are extremely useful when you
need to provide additional information, such as reminders, notifications, or feedback in a document without modifying cell
content.

Comments are displayed in a yellow box anchored to a cell. A cell containing a comment has a red triangular indicator in the
corner.

You can add new comments, edit existing comments, copy comments to other cells, move and resize the comment box, hide or
delete comments if they are no longer needed.

Add a Comment
To insert a new comment, select the cell where you wish to place the comment, and do one of the following.

On the Review tab, in the Comments group, click the New Comment button.

Right-click the cell and select the Insert Comment item in the context menu.

Press SHIFT+F2.

The new comment will be anchored to the cell. Type the desired text within the comment box. By default, the comment is
accompanied by the user name of the person who created the comment. If you wish to change the default name, delete it and
type a new name.

Edit a Comment
1. Select the cell that contains the comment you wish to edit.



2. Do one of the following.

On the Review tab, in the Comments group, click the Edit Comment button...

... or right-click the cell and select the Edit Comment item in the context menu.

The comment will be activated and the cursor will be positioned within the comment box. Change the comment text as
needed.

Click inside the comment box, and start editing the comment text.
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If the comment is hidden, click the Show/Hide Comment button to display the comment.

Copy Comments Only
1. Select the cell(s) containing the comment(s) you wish to copy.
2. On the Home tab, in the Clipboard group, click Copy, or press CTRL+C.
3. Select the top-left cell of the destination area where you wish to insert the copied comment(s).

4. On the Home tab, in the Clipboard group, click the Paste Special button, or press CTRL+ALT+V.

5. In the invoked Paste Special dialog, click Comments, and then click OK.

Move and Resize a Comment
1. Select the cell that contains the comment you wish to move or resize.
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If the comment is hidden, click the Show/Hide Comment button to display the comment.



2. Click the comment box border to display the sizing handles (small rectangles at the corners and sides of the comment
box).

3. Do one of the following.

To move a comment, hover the mouse over the comment border so that the four-way resize arrow appears, and drag
the comment to a new location.

To resize a comment, click one of the sizing handles and drag the edge of the comment box.

Display or Hide a Comment
1. Select the cell that contains the comment you wish to display or hide.

2. Do one of the following.

On the Review tab, in the Comments group, click the Show/Hide Comment button.

Right-click the cell and select the Show/Hide Comment item in the context menu.

Remove a Comment
To delete the existing comment, do the following.

1. Select the cell that contains the comment you wish to delete.

2. Do one of the following.

On the Review tab, in the Comments group, click the Delete button.



Right-click the cell and select the Delete Comment item in the context menu.



Insert a SymbolInsert a Symbol
The Spreadsheet allows you to insert symbols and special characters that are not on your keyboard, such as ASCII or Unicode
characters, fractions (¼), copyright symbol (©), trademark symbols (®, ™), paragraph mark (¶), etc.

To insert a symbol, follow the instructions below.

1. Move to the cell where you wish to insert a symbol.

2. On the Insert tab, in the Symbols group, click the Symbol button.

The Symbol dialog will be invoked.

3. Select the symbol you wish to insert and click Insert, or double-click the symbol.



Format CellsFormat Cells
The Spreadsheet provides the capability to format cells and the data they contain. It includes many predefined styles that you can
use.

To format a cell or a range of cells, follow the instructions below.

Using Predefined Styles
1. Select the cells you wish to format.

2. In the Styles group within the Home tab, select the style that you wish to apply to the selected cells.

Applying Specific Formatting
If you are not satisfied with the predefined styles, specify your own formatting options.

1. Select the cells you wish to format.

2. To add borders to the selected cells, do one of the following.

In the Font group within the Home tab, click the Borders button's drop-down menu and select the border type. This
menu also allows you to select the line style and line color of borders.



Click the Font dialog box launcher to invoke the Format Cells dialog box. Click the Border tab and specify all
required parameters. Then click OK.

3. To set the background color of the selected cells, do one of the following.

In the Font group within the Home tab, click the Fill Color button's drop-down menu and select the desired color.



Click the Font dialog box launcher, and in the invoked Format Cells dialog box, open the Fill tab. Specify all required
parameters and click OK.



Format Cell ContentFormat Cell Content
The Spreadsheet provides the capability to set font style, size, color and text alignment in a cell.

To format cell content, follow the steps below.

1. Select a cell or a cell range that you wish to format.

2. To change the font, use the Font group within the Home tab to specify the font family, size, style, color, etc.

You can also modify cell font using the Font tab of the Format Cells dialog box. To invoke this dialog, click the arrow in the
bottom right corner of the Font group. In the Font tab, you can specify the required font characteristics and apply them to
the selected cells.

3. To position text within a cell so that it is centered, aligned to the left or aligned to the right, select the appropriate alignment
options in the Alignment group within the Home tab.

To specify additional alignment options, click the arrow in the bottom right corner of the Alignment group. The dialog box
launcher invokes the Format Cells dialog. In the Alignment tab, specify all required parameters and click OK to apply them
to the selected cells.



4. To undo the formatting options you applied before, select the text. In the Editing group within the Home tab, click the
Clear drop-down and select the Clear Formats item.



Wrap Text and Merge CellsWrap Text and Merge Cells
If text is too long to be displayed in a single cell, the Spreadsheet allows you to wrap the text to make it display on multiple lines
in the cell, or merge cells to combine two or more adjacent cells into a single larger/longer cell.

Merging Cells
To merge cells, follow the instructions below.

1. Select the cells that you wish to merge.
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Make sure that the data you wish to display in the merged cell is contained in the upper-left cell of the selected range,
because only the contents of this cell will remain in the merged cell. The data in the other cells will be deleted.

2. In the Alignment group within the Home tab, click the Merge Cells button's drop-down arrow and select one of the
following items.

Merge & Center - merge the selected cells and center the text in a merged cell.
Merge Across - merge each row of the selected cell range into larger cells.

Merge Cells - merge the selected cells into a single cell.

3. If you change your mind and wish to split a merged cell, select this cell and click the Unmerge Cells item in the Merge
Cells button's drop-down menu. The data of the merged cell appears in the upper-left cell of the range of split cells.

Wrapping Text in a Cell
To wrap text in a cell, do the following.

1. Select a cell or a range of cells containing the text you wish to wrap.
2. In the Alignment group within the Home tab, click the Wrap Text button. The text is displayed on multiple lines within the

cell.
3. To unwrap the text, click the Wrap Text button again. The text is displayed in the same way as it was before the wrap option

was applied.



Number FormattingNumber Formatting
The Spreadsheet allows you to format numbers in cells to make them easier to read and understand. For example, you can
display numbers as monetary values or dates. The default format for cell content is the General style. Notice that number
formatting does not change the value you enter, it only influences the way the number is displayed in a cell. Number formatting
options are available in the Number group within the Home tab.

To apply the number format to a cell value, select the required format in the number format list at the top of the Number group,
or use buttons at the bottom of the group, such as Accounting Number Format, Percent Style or Comma Style.

If you wish to set more formatting parameters, click the Number dialog box launcher to invoke the Format Cells dialog box.
Select the desired number format, and then specify formatting options in the right pane of the dialog box.

You can use the following shortcuts to quickly apply the specified number format.

CTRL+SHIFT+1 Applies the Number format with two decimal places.

CTRL+SHIFT+2 Applies the Time number format.

CTRL+SHIFT+3 Applies the Date format.

CTRL+SHIFT+4 Applies the Currency format.

CTRL+SHIFT+5 Applies the Percentage format.

CTRL+SHIFT+6 Applies the Scientific number format.



Conditional FormattingConditional Formatting
The Spreadsheet allows you to apply conditional formatting to a range of cells. Conditional formatting changes the
appearance of individual cells based on specific conditions. It helps to highlight critical information, or describe trends within cells
by using data bars, color scales and built-in icon sets. To create a conditional format, select the cell range to which you wish to
apply a conditional formatting rule. On the Home tab, in the Styles group, click the Conditional Formatting button to display a
drop-down list of available conditional formats. You can do one of the following.

Format Cells that are Less than, Greater than or Equal to a Value
Format Cells that Contain Text or a Date
Format Unique or Duplicate Cells
Format Top or Bottom Ranked Values
Format Cells whose Values are Above or Below the Average
Format Cells Using Data Bars
Format Cells using Color Scales
Format Cells using Icon Sets
Edit Conditional Formatting Rules
Clear Conditional Formatting Rules

Format Cells that are Less than, Greater than or Equal to a Value
To highlight cells whose values meet the criterion represented by a relational operator (=, <, >), do the following.

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Highlight Cells Rules, and then select one of the
following items: Greater Than..., Less Than..., Between... or Equal To...

In the invoked dialog, specify the threshold value, and select formatting options to be applied to cells that meet the
condition. Note that you can also use a formula to specify the threshold value. If you enter a formula, start it with an equal
sign (=). If a formula returns an error, formatting options will not be applied.



If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home
tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.

In the invoked New Formatting Rule dialog, select Format only cells that contain from the Select a Rule Type list.

In the Edit Rule Description section, select the target relational operator from the drop-down menu and specify the
threshold values.

To set the formatting options to be applied to cells that meet the condition, click the Format button to invoke the Format
Cells dialog. When the formatting options are defined, the resulting cell appearance is displayed in the Preview box.



Format Cells that Contain Text or a Date
To highlight cells that contain the specified text string or time period, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Highlight Cells Rules, and then click Text that
Contains... or A Date Occurring....

In the invoked dialog, specify the text string (if you selected Text that Contains...) or time period (if you selected A Date
Occurring...) to be highlighted, and select the formatting options to be applied to cells that meet the condition.

Note that for the Text that Contains... rule, you can also specify a formula that returns text. If you enter a formula, start it
with an equal sign (=). If a formula returns an error, formatting options will not be applied.

If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home



tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.

In the invoked New Formatting Rule dialog, select Format only cells that contain from the Select a Rule Type list.

In the Edit Rule Description section, select the target cell content, set the format operator and the text string (if you
selected Specific Text) or specify the time period (if you selected Dates Occurring).

To set the formatting options to be applied to cells that meet the condition, click the Format button to invoke the Format
Cells dialog. When the formatting options are defined, the resulting cell appearance is displayed in the Preview box.



Format Unique or Duplicate Cells
To find unique or duplicate values in a range of cells, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Highlight Cells Rules | Duplicate Values...

In the invoked dialog, specify whether you wish to highlight unique or duplicate values, and select the formatting options to
be applied to cells that meet the condition.

If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home
tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.



In the invoked New Formatting Rule dialog, select Format only unique or duplicate values from the Select a Rule
Type list.

In the Edit Rule Description section, specify whether you wish to highlight unique or duplicate values. To set the
formatting options to be applied to cells that meet the condition, click the Format button to invoke the Format Cells dialog.
When the formatting options are defined, the resulting cell appearance is displayed in the Preview box.

Format Top or Bottom Ranked Values
To highlight only the top or bottom ranked values in a range of cells, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Top/Bottom Rules, and then select one of the
following items: Top 10 Items..., Top 10%..., Bottom 10 Items... or Bottom 10%...



In the invoked dialog, specify the number or percentage of the rank value (depending on the selected rule), and select the
formatting options to be applied to cells that meet the condition.

If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home
tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.



In the invoked New Formatting Rule dialog, select Format only top or bottom ranked values from the Select a Rule
Type list.

In the Edit Rule Description section, specify whether you wish to highlight top or bottom values and enter the rank value
number. To convert the number to percentage, check the % of the selected range box.

To set the formatting options to be applied to cells that meet the condition, click the Format button to invoke the Format
Cells dialog. When the formatting options are defined, the resulting cell appearance is displayed in the Preview box.

Format the Cells whose Values are Above or Below the Average
To highlight values that are above or below the average in a range of cells, do the following:

Select the cell range to which you wish to apply a conditional format.

On the Home tab, in the Styles group, select Conditional Formatting | Top/Bottom Rules, and then click Above
Average... or Below Average...



In the invoked dialog, select the formatting options to be applied to cells that meet the condition.

If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home
tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.



In the invoked New Formatting Rule dialog, select the Format only values that are above or below average type for
the new rule from the Select a Rule Type list.

In the Edit Rule Description section, select the format operator from the Show values that are: list.

To set the formatting options to be applied to cells that meet the condition, click the Format button to invoke the Format
Cells dialog. When the formatting options are defined, the resulting cell appearance is displayed in the Preview box.

Format Cells using Data Bars
The data bar conditional formatting rule draws a shaded bar in the background of each cell in the range to which the rule is
applied. The length of the data bar represents the cell value. A longer bar represents a higher value, and a shorter bar represents a
lower value. For example, the image below shows the markup magnitude using solid light-green data bars.

To apply a data bar conditional formatting rule, do the following:



On the Home tab, in the Styles group, choose Conditional Formatting | Data Bars, and then select the desired color for a
gradient or solid data bar.

If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home
tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.

In the invoked New Formatting Rule dialog, select the Format cells based on their values type from the Select a Rule
Type list.
In the Edit Rule Description section, select Data Bar from the Format style: list.



Specify the minimum and maximum thresholds type and value (if necessary). To disable showing values in the cells to
which the formatting rule is applied, check the Show bar only box.

Customize the bar appearance by setting the fill type, fill color, border type and color in the Bar Appearance: section. The
resulting data bar appearance is displayed in the Preview box.

To specify the negative bar and axis appearance settings, click the Negative Value and Axis... button. The invoked
Negative Value and Axis Settings dialog allows you to set the negative bar fill and border color, specify axis color and
position within the cell.



Format Cells using Color Scales
Color scales compare values using a gradation of two or three colors. The shade of the color represents higher, middle and lower
values in the cell range to which the rule is applied. For example, the image below shows a price distribution using a gradation of
three colors. Red represents the lower values, yellow represents the medium values and sky blue represents the higher values.

To create a color scale, do the following:

On the Home tab, in the Styles group, choose Conditional Formatting | Color Scales, and then select one of the
predefined color combinations.



If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home
tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.

In the invoked New Formatting Rule dialog, select the Format cells based on their values type from the Select a Rule
Type list.

In the Edit Rule Description section, select 2- or 3-Color Scale from the Format style: list.

Specify the type of the minimum, midpoint (if the 3-color scale style is selected) and the maximum threshold, enter their



values (if necessary) and select the corresponding colors. The resulting cell appearance is displayed in the Preview box.

Format Cells using Icon Sets
An icon set conditional format classifies data in a range into three to five categories. The Spreadsheet divides the range into
equal parts based on the number of icons in the selected set and applies an icon to each cell depending on its value. For example,
the image below shows the value ranking. A filled star represents values that are greater than or equal to 67 percent, a half-filled
star represents values that are less than 67 percent and greater than or equal to 33 percent, and an empty star shows values that
are less than 33 percent.

To apply an icon set conditional formatting rule, do the following:

On the Home tab, in the Styles group, choose Conditional Formatting | Icon Sets, and then select the desired icon set
from the gallery.



If none of the built-in formatting options meet your requirements, you can create a custom formatting rule. On the Home
tab, in the Styles group, select Conditional Formatting | New Rule...

...or select Conditional Formatting | Manage Rules... and click the New Rule... button in the invoked Conditional
Formatting Rules Manager.

In the invoked New Formatting Rule dialog, select the Format cells based on their values type from the Select a Rule
Type list.
In the Edit Rule Description section, select Icon Sets from the Format style: list.



You can select the whole icon set in the Icon Style list or select each icon individually in the Icon section. Check Show Icon
Only box to disable showing cell values. To show icons in the reverse order, click Reverse Icon Order button.

Select the minimum and maximum threshold type and change values if necessary in the corresponding Value boxes. The
resulting rule is shown in the Display each icon according to these rules: section.

Edit the Conditional Formatting Rule
You can modify existing conditional formatting rules by doing the following:

On the Home tab, in the Styles group, click Conditional Formatting | Manage Rules...

In the invoked Conditional Formatting Rules Manager, select the part of the document whose formatting rules should
be displayed by selecting one of the available areas from the Show formatting rules for: drop-down list.



To edit the desired rule, select it within the list and click Edit Rule... button.

To apply the selected formatting rule to another cell range, type the cell reference in the Applies to column cell or select the
cell range directly in the worksheet by clicking the Collapse Dialog

 button.

The formatting rules are shown in order of precedence. A new formatting rule is automatically added to the top of the list
and has the highest precedence. To change the precedence of a desired formatting rule, use Up and Down buttons.

You can disable applying the formatting rules lower in precedence if the current rule condition is true. To do that, check the
Stop if True box. Note that this options is unavailable for the rules that format cells using data bars, color scales or icon
sets.

Clear Conditional Formatting Rules
To delete a conditional formatting rule, do one of the following:

Select the range that contains the conditional formatting rules you wish to clear. On the Home tab, in the Styles group,
select Conditional Formatting | Clear Rules | Clear Rules from Selected Cells to delete the rules applied to the selected
range.
Invoke the Conditional Formatting Rules Manager, select the rule you wish to clear and click Delete Rule button.
To clear all conditional formatting rules on a worksheet, select Conditional Formatting | Clear Rules | Clear Rules from
Entire Sheet.



Clear Cell FormattingClear Cell Formatting
To remove all formatting from cells, do one of the following.

1. In the Editing group within the Home tab, click the Clear button, and select Clear Formats from the drop-down menu.

2. In the Styles group within the Home tab, select the Normal style, to restore the default settings.



Insert and Delete Columns and RowsInsert and Delete Columns and Rows
The Spreadsheet provides the capability to insert and delete columns and rows in a worksheet.

Insert Rows
1. To insert a single row, select the entire row by clicking the row heading, or click a cell in the row above the position in which

you wish to insert a new row. To insert multiple rows, select the number of rows you wish to insert. For example, if you wish
to insert three rows, select three rows by clicking the row headings.

2. Do one of the following.

In the Cells group within the Home tab, click the Insert button and select the Insert Sheet Rows item from the drop-
down list.

Right-click a cell within the selected row(s) and click the Insert item in the invoked menu. The new row(s) will be
inserted above the selected row(s).

Insert Columns
1. To insert a single column, select the entire column by clicking the column heading, or by clicking a cell in the column to the

left of where the new column will be inserted. To insert multiple columns, select the number of columns you wish to insert.
For example, to insert three columns, select three columns by clicking column headings.

2. Do one of the following:

In the Cells group within the Home tab, click the Insert button and select the Insert Sheet Columns item from the
drop-down list.



Right-click a cell within the selected column(s) and click the Insert item in the invoked menu. The new column(s) will
be inserted to the left of the selected column(s).

Delete Rows and Columns
1. Select the column(s) or row(s) you wish to delete by clicking its heading.

2. Do one of the following.

In the Cells group within the Home tab, click the Delete button and select the Delete Sheet Rows or Delete Sheet
Columns item from the drop-down list.

Right-click a cell within the selected column(s) or row(s), and then click the Delete item in the invoked menu. The
specified column(s) or row(s) will be deleted.



Show and Hide Columns and RowsShow and Hide Columns and Rows
The Spreadsheet provides the capability to display and hide columns and rows in a worksheet.

Hide and Unhide Columns
1. Select the column to be hidden.

2. Do one of the following:

Set the column width to zero. To do this, drag the boundary of the column heading until the column is hidden;

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Hide Columns;

Right-click the selected column and select the Hide item from the context menu.

3. To show the column you hid, select the columns adjoining to either side of the hidden column, and then do one of the
following:

On the Home tab, in the Cells group, click the Format button, and then select Hide & Unhide | Unhide Columns;

Right-click the selected columns and select the Unhide item from the context menu.

Hide and Unhide Rows



1. Select the row to be hidden.

2. Do one of the following:

Set the row height to zero. To do this, drag the boundary of the row heading until the row is not displayed;

On the Home tab, in the Cells group, click the Format button and select Hide & Unhide | Hide Rows;

Right-click the selected row and select the Hide item from the context menu.

3. To display the row you hid, select the rows that are above and below the hidden row, and then do one of the following:

On the Home tab, in the Cells group, click the Format button, and then select Hide & Unhide | Unhide Rows;

Right-click the selected rows and select the Unhide item from the context menu;

Display all hidden columns and rows
1. Click the Select all button at the intersection of the column and row headings, or press CTRL+A.
2. Do one of the following:

On the Home tab, in the Cells group, click the Format button, and then select Hide & Unhide | Unhide Rows or
Unhide Columns;
Right-click the selection and select the Unhide item from the context menu.



Specify Column Width and Row HeightSpecify Column Width and Row Height
Setting the column width
In the Spreadsheet, the column width can vary from 0 to 255 characters of the default font specified by the predefined Normal
style. The default column width is 8.43 characters. If you set the column width to 0, the column will be hidden.

To change the column width, do one of the following.

1. Drag the right boundary of the column header to resize a column’s width. To set the width of multiple columns, select these
columns, and then drag the right boundary of one of the selected columns.

2. To set the column width to a specific value, select the column whose width you wish to change, and on the Home tab, in the
Cells group, click Format | Column Width...

Type the required width value in the invoked Column Width dialog.

3. To change the column width to automatically fit the contents, select the column and do one of the following.

On the Home tab in the Cells group, click the Format button and select the AutoFit Column Width item from the
drop-down list.

Double-click the right boundary of the selected column.

4. To match one column’s width to another column, do the following.

Select the column whose width you want to copy.
On the Home tab, in the Clipboard group, click the Copy button or press CTRL+C.

Click the cell in the column that is to be resized, and then click the Paste Special button in the Clipboard group. In
the Paste Special dialog box that is invoked, select the Column widths item.



5. To change the default width for all columns in a worksheet, on the Home tab in the Cells group, click the Format button
and select the Default Width... item from the drop-down list.

In the invoked Standard Width dialog, type a new number for the default column width.

Set the row height
In the Spreadsheet, the row height should be between 0 and 409 points. The default row height is 12.75 points. If you set the row
height to 0, the row is hidden.

To change the row height, do one of the following.

1. Drag the lower boundary of the row header until the row reaches your desired height. To set the height of multiple rows,
select them, and then drag the lower boundary of any selected row.

2. To set the row height to a specific value, select the row whose height you wish to change, and on the Home tab in the Cells
group, click Format | Row Height...

Type the required height value in the invoked Row Height dialog.

3. To change the row height to automatically fit the contents, select the row and do one of the following.

On the Home tab in the Cells group, click the Format button and select the AutoFit Row Height item from the
drop-down list.



Double-click the lower boundary of the selected row.



Create a TableCreate a Table
The Spreadsheet allows you to insert a new table in a worksheet, or convert an existing range to a table.

Create a Table
Convert a Table to a Data Range
Delete a Table

Create a Table
To insert a table, select the cell range to be included in the table.

Then, do one of the following.

To create a table with the default style, on the Insert tab, in the Tables group, click the Insert Table button.

To create a table with one of the predefined styles, on the Home tab, in the Styles group, click the Format As Table button
and select the desired style from the gallery.

In the invoked Create Table dialog, verify that the range in the Where is the data for your table? field reflects your selection,
and then specify whether or not the table has headers.



Note that after you create a table, the Table Tools contextual tab becomes available. Use this tab to provide some extra settings
for the created table.

Convert a Table to a Data Range
To convert an existing table to a normal range of cells, do the following.

Click the table to display the Table Tools contextual tab.

On the Design tab, in the Tools group, click the Convert To Range button.

Note that after you delete a table, the table formatting persists. However, the Table Tools contextual tab is no longer available,
and table features are lost. For example, you cannot use structured references (references that use table names) in formulas.

Delete a Table
To delete an existing table, select it and do one of the following.

On the Home tab, in the Editing group, click Clear | Clear All.

Press DELETE.



Create a Pivot TableCreate a Pivot Table
A pivot table represents a summary table used to explore, analyze and aggregate large amounts of data in a worksheet. It helps
divide your data into categories and subcategories, and automatically calculates subtotals and grand totals using the most
suitable summary function from a predefined list.

To create a PivotTable report, follow the steps below.

1. On the Insert tab, in the Tables group, click the PivotTable button.

2. In the invoked Create PivotTable dialog, specify the source data and the location of the new pivot table, and click OK.

�� I m p o r t an tI m p o r t an t

Before creating a pivot table, make sure that the source data is organized in a tabular format, has column headings in the
first row and does not include blank rows or columns.

3. An empty report is created and the Field List pane is invoked.



4. To fill the pivot table with data, select the desired field in the Field List pane and drop it to the one of the following areas at
the pane bottom.

Rows Area - contains fields used to group report data by rows.
Columns Area - contains fields used to break report data into categories by columns.
Values Area - contains fields against which summaries are calculated. As a rule, value fields contain numeric values,
which are summarized with the Sum function, but you can change the calculation type by selecting one of the
predefined functions (Count, Average, Min, Max, Product, Count Numbers, StdDev, StdDevp, Var, or Varp).

Filters Area - contains fields used to filter the entire PivotTable report to display data for the selected items.

All the changes are automatically reflected in the report.

5. To postpone the report update, select the Defer Layout Update check box at the bottom of the pane. The table will be



updated only after clicking the Update button.

6. To clear the PivotTable report, on the PivotTable Tools | Analyze tab, in the Actions group, click the Clear PivotTable
button and select the Clear All item from the drop-down list.

7. To remove the pivot table completely, select the entire PivotTable range and press DELETE.



Modify a Pivot TableModify a Pivot Table
The following topic describes how to modify the existing pivot table. Select the task you wish to perform.

Rearrange the PivotTable Fields
Change the PivotTable Data Source
Move the Pivot Table

Rearrange the PivotTable Fields
To reorganize the pivot table structure, use the Field List pane. It invokes automatically when you select any cell in the report.

If you closed the pane, you can re-invoke it from the ribbon menu. To do that, on the PivotTable Tools | Analyze tab, in the
Show group, click the Field List button.

In the Field List pane, you can rearrange fields within the report by dragging them between the area sections at the bottom of the
pane. To remove the field from the report, drag it outside the pane. All changes will be applied immediately.

Additionally, you can reorder fields or specific field items within the area. To do that, right-click the required cell in the report and
select the appropriate Move command from the context menu.



Change the PivotTable Data Source
To change the data source of the pivot table report, on the PivotTable Tools | Analyze tab, in the Data group, click the Change
Data Source button.

The invoked dialog allows you to select the new source range for the pivot table.

Move the PivotTable
To move the entire report, on the PivotTable Tools | Analyze tab, in the Actions group, click the Move PivotTable button. The
invoked dialog allows you to move the report to another cell range within the existing worksheet or to a new worksheet.





Refresh the PivotTable DataRefresh the PivotTable Data
You can update (refresh) the PivotTable data manually (while generating the report) or automatically (when you open the
workbook with the pivot table). The steps below provide more detailed information about how to accomplish these tasks.

1. To update the pivot table manually, on the PivotTable Tools | Analyze tab, in the Data group, click Refresh and select the
Refresh item from the invoked drop-down menu. To update all pivot tables of the current workbook, select Refresh All.

2. To refresh the pivot table when opening the file, use the PivotTable Options dialog. To invoke it, on the PivotTable Tools
| Analyze tab, in the PivotTable group, click PivotTable Options.

3. Switch to the Data tab. In the PivotTable Data section, select the Refresh data when opening the file check box.

4. To preserve the PivotTable display and formatting settings during the update operation, switch to the dialog's Layout &



Format tab. Here you can specify whether to auto-fit the column widths or preserve cell formatting when updating the
report. To do that, select the required options in the last section of the dialog.



Change the Value Field SettingsChange the Value Field Settings
By default, when you add a numeric field to the Values area, its data is summarized by the Sum function. For a text field or field
containing blank cells, the Count function is used as the default summary function.

However, you can change how summary values are calculated and displayed within the PivotTable report. To do this, follow the
steps below.

1. Select any cell in the value field you wish to modify. On the PivotTable Tools | Analyze tab, in the Active Field group,
click the Field Settings button.

2. The invoked Value Field Settings dialog allows you to provide the custom name for the value field and change the
aggregate function used to summarize its values. On the Show Values As tab, you can configure how calculation results
should be displayed in cells.

3. To change the default number format applied to the value field, click the Number Format button. In the invoked Format
Cells dialog, select the desired format type, specify the corresponding settings and click OK.



4. The result is shown in the image below.



Apply a Predefined Style to a Pivot TableApply a Predefined Style to a Pivot Table
You can change the appearance of a pivot table using one of the predefined pivot table styles. Select the desired style from the
PivotTable Styles gallery on the PivotTable Tools | Design tab and it will be automatically applied to the report.

Additionally, you can specify whether to apply style formatting to the row and column headers or to show the banded rows and
columns. To do that, on the PivotTable Tools | Design tab, in the PivotTable Style Options group, select or clear the
corresponding check box.



Change the PivotTable LayoutChange the PivotTable Layout
This topic describes how to specify the layout options for the entire PivotTable report or a specific row field only.

Change the PivotTable Layout
1. To change the PivotTable layout, on the PivotTable Tools | Layout tab, in the Layout group, click the Report Layout

button.

2. The invoked drop-down menu allows you to apply one of the following layout forms.

Compact Form - the default layout. The report is compressed to prevent data from spreading horizontally off the
screen.

Outline Form - the report data is outlined.



Tabular Form - the pivot table is shown in the table format.

3. For the outline and tabular forms, you can enable repeating item labels in the outer row fields. To do that, select the Repeat
All Item Labels item in the Report Layout drop-down menu. To disable repeating, select Do Not Repeat Item Labels.

4. You can also specify whether to show/hide subtotals and grand totals in the PivotTable report, or insert the blank line after
each item in the outer row fields. To do that, on the PivotTable Tools | Layout tab, in the Layout group, click the
Subtotals, Grand Totals or Blank Rows button, respectively, and select the desired action from the drop-down menu.

5. The advanced layout options can be specified using the Layout & Format tab of the PivotTable Options dialog. To invoke
it, click the PivotTable Options button in the PivotTable group.



Change the Field Layout
You can change the layout options for the specific row fields only. To do that, select a row field and on the PivotTable
Tools | Analyze tab, in the Active Field group, click the Field Settings button.

In the invoked Field Settings dialog, switch to the Layout & Print tab.



To show field items in tabular or outline form, select the corresponding option in the Layout section. To display field items
in compact form, select Show item labels in outline form and then click the Display labels from the next field in the
same column (compact form) check box.

The Field Settings dialog also allows you to specify whether to repeat item labels for an outer field, insert the blank line after
each field item, or show items with no data. To do that, select the corresponding check boxes in the Layout section.



Subtotal and Total Fields in a Pivot TableSubtotal and Total Fields in a Pivot Table
The following topic describes how to manage the subtotals and grand totals in a pivot table.

Subtotal Row and Column Fields
1. Click the target row or column field within the report and on the PivotTable Tools | Analyze tab, in the Active Field

group, click the Field Settings button.

2. On the Subtotals & Filters tab of the invoked Field Settings dialog, select one of the following options and click OK to
apply changes.

Automatic - to calculate the subtotals using the default summary function.
Custom - to use one or multiple custom functions for subtotal calculation. Note that if the target row or column field
contains calculated items, the custom function(s) cannot be used.

None - to remove subtotals.



3. To specify the subtotal display settings, on the PivotTable Tools | Design tab, in the Layout group, click the Subtotals
button. The invoked drop-down menu allows you to display the subtotals at the top or bottom of each item in the outer row
fields in compact or outline form, or hide subtotals.

4. As a result, the pivot table will appear as follows.



Show or Hide Grand Totals
1. To show or hide the grand totals for a pivot table, on the PivotTable Tools | Design tab, in the Layout group, click Grand

Totals. In the invoked drop-down menu, select one of the available options. You can hide/show the grand totals for the
entire report or for the rows or columns only.

2. To specify the default settings for displaying grand totals, use the PivotTable Options dialog. To invoke it, on the
PivotTable Tools | Analyze tab, in the PivotTable group, click the PivotTable Options button.

3. Switch to the Totals & Filters tab. To show or hide the grand totals for rows, columns or the entire PivotTable report, select
or clear the corresponding check box(es) in the Grand Totals section.





Group Items in a Pivot TableGroup Items in a Pivot Table
Grouping can help you get a clearer view of data and show only data you want to analyze. The following topic describes how to
group dates, numbers or selected items in a pivot table.

Group a Pivot Table by Date
1. Right-click a cell within a row or column field containing dates and select Group...

...or on the PivotTable Tools | Analyze tab, in the Group group, click the Group Field button.

2. The Grouping dialog is invoked. Type the first and last date or time you want to group by, select one or more date or time
intervals for grouping and click OK.



3. As a result, the date field will be grouped as shown in the image below.

Group a Pivot Table by Numbers
1. Right-click a cell within a row or column field containing numeric values and select Group...

...or on the PivotTable Tools | Analyze tab, in the Group group, click the Group Field button.



2. The Grouping dialog is invoked. Type in start value, end value, interval and click OK.

3. The result is shown in the image below.

Group Selected Items
1. Select the items that you want to group.

2. Right-click the selected range and select the Group item from the context menu...



...or on the PivotTable Tools | Analyze tab, in the Group group, click the Group Selection button.

3. As a result, the selected range will be combined into a single group. To rename the group, select the group header, press F2
and type the required name.

4. You can also enable or disable displaying the subtotal for the created group. To do that, right-click the group header and
select the Subtotal 'Field Name' item.



5. The resulting report is shown in the image below.

Ungroup Data
To ungroup data in a pivot table, do one of the following.

Right-click the grouped field and select Ungroup... from the context menu.



Select any cell in the grouped field and on the Pivot Table Tools | Analyze tab, in the Group group, click the Ungroup
button.

Note that ungrouping a numeric or date and time field will remove all groups for that field. If you ungroup a group of selected
items, only the selected items will be ungrouped.



Sort Items in a Pivot TableSort Items in a Pivot Table
The following topic describes how to sort items in the PivotTable fields by labels and summary values.

Sort Item Labels
Item labels in a PivotTable field can be sorted by text (A to Z or Z to A), numbers (smallest to largest or largest to smallest), or
dates and times (oldest to newest or newest to oldest). To apply sorting, do the following.

1. Click the arrow  in the Row Labels or Column Labels cell. If there are multiple fields in the area, select the row or
column field you wish to sort.

2. In the invoked drop-down list, select the Sort A to Z item to use ascending order, or click Sort Z to A to sort in descending
order. As a result, items in the filtered field will be reordered correspondingly. The tiny arrow  appears in the row or
column label to indicate that data in the report is sorted.

Sort Items By Summary Values
Besides sorting item labels, you can also sort items in a row or column field based on data in the Values area of the PivotTable
report. To do this, follow the steps below.

1. Click the arrow  in the Row Labels or Column Labels cell. In the invoked drop-down list, select the row or column field
you wish to sort (if there are multiple fields in the area), and then click the More Sort Options... item.



2. In the invoked dialog box, select the desired sort order and the value field to sort by. Click the More Options... button.

3. In the More Sort Options dialog, click Grand Total or select a row/column in the Values area to sort by and click OK.

4. The result is shown in the image below. The tiny arrow  appears in the row or column label to indicate that data in the
corresponding field is sorted.



Filter a Pivot TableFilter a Pivot Table
The Spreadsheet provides numerous ways to apply filtering to the PivotTable fields to display only data that meets specific
criteria. Select the task you wish to perform.

Use a Report Filter
Filter Row or Column Items
Use a Label Filter
Use a Date Filter
Use a Value Filter
Use Multiple Filters per Field
Remove a Filter

Use a Report Filter
A report filter allows you to filter the entire PivotTable report to show data for specific items. To use a report filter, follow the steps
below.

1. Click the arrow  in the report filter field.

2. In the invoked dialog, click the Uncheck All button to deselect the values. Then, select the check box for the item you wish
to display. To select multiple items, select the Select Multiple Items check box at the pane bottom. Click OK to apply
changes.



3. The resulting report is shown in the image below. The Filter button  appears in the report filter field to indicate that the
filter is applied.

Filter Row or Column Items
1. Click the arrow  in the Row Labels or Column Labels cell. If there are multiple fields in the area, select the row or

column field you wish to filter.

2. In the drop-down menu, select Item Filter...



3. In the invoked dialog, click the Uncheck All button to deselect the values. Then, select the item(s) you wish to display and
click OK.

4. The resulting report is shown in the image below. The Filter button  appears in the row or column label to indicate that
the filter is applied.

Use a Label Filter
1. Click the arrow  in the Row Labels or Column Labels cell. If there are multiple fields in the area, select the row or

column field you wish to filter.

2. Point to the Label Filters item and select one of the built-in comparison operators.



3. In the invoked dialog, specify the filter criteria and click OK.

4. The resulting report is shown in the image below. The Filter button  appears in the row or column label to indicate that
the filter is applied.

Use a Date Filter



1. Click the arrow  in the header of the row or column field containing dates.

2. Point to the Date Filters item and select one of the built-in dynamic filter types to display dates that fall within a specified
time period (next, this or last week, month, year, etc.) or select the Before, After, Equals or Between item to find dates that
are before, after or equal to the specified date, or between two dates.

3. In the invoked Date Filter dialog, specify the date(s) to filter by and click OK.

4. The resulting report is shown in the image below. The Filter button  appears in the row or column label to indicate that
the filter is applied.



Use a Value Filter
A value filter allows you to filter items in a row or column field based on summary values. To use a value filter, follow the steps
below.

1. Click the arrow  in the Row Labels or Column Labels cell. If there are multiple fields in the area, select the row or
column field to which a filter should be applied.

2. Point to the Value Filters item and select one of the built-in comparison operators.

3. In the invoked dialog, specify the filter criteria and click OK. Note that the filtering will be applied to the filtered field's Grand
Total values.

4. The resulting report is shown in the image below. The Filter button  appears in the row or column label to indicate that
the filter is applied.



Use Multiple Filters per Field
To enable the capability to apply multiple filters to a single row or column field, do the following.

On the PivotTable Tools | Analyze tab, in the PivotTable group, click the PivotTable Options button.

In the invoked PivotTable Options dialog, switch to the Totals & Filters tab and check the Allow multiple filters per
field box.

Remove a Filter
To remove a filter, do the following.

To remove a filter from a specific field, click the Filter button  and select the Clear Filter From 'Field Name' item in the
drop-down menu.



To clear all filters applied to the PivotTable fields at once, on the PivotTable Tools | Analyze tab, in the Actions group,
click Clear PivotTable | Clear Filters.



Insert a Calculated Field and Calculated ItemInsert a Calculated Field and Calculated Item
If the predefined aggregation functions or the Show Values As calculation options do not meet your requirements, you can
create your own formulas to calculate values in a PivotTable report by inserting calculated fields and calculated items.

Insert a Calculated Field
Calculated fields can perform calculations using the contents of other fields in the report. A calculated field's formula should
conform to the common syntax rules and contain only supported elements.

In the formula, you can use constants and refer to other fields in the pivot table. The calculation will be performed on the
sum of the underlying data for any fields in the formula. When you reference a field in your formula, you can enclose its
name in apostrophes or omit them.
You cannot create formulas that use a cell reference, defined name, circular references and arrays.
The formula cannot refer to the PivotTable’s subtotals, totals and Grand Total value.

To insert a calculated field, do the following.

1. Select a cell within the PivotTable report and on PivotTable Tools | Analyze tab, in the Calculation group, click the Fields,
Items, & Sets button. In the drop-down menu, select the Calculated Field... item to invoke the Insert Calculated Field
dialog.

2. In the dialog window, specify the name and formula for the calculated field. To use data from another field in the formula,
click the required field in the Fields box, and then click Insert Field.

3. Click Add, and then click OK. As a result, the new field will be automatically added to the Values area of the PivotTable
report.



4. To delete a calculated field, invoke the Insert Calculated Field dialog, select the required field from the Name drop-down
list and click Delete.

Insert a Calculated Item
A calculated item is a custom item in a PivotTable field whose value is produced based on values of other items in the same
field. Before inserting a calculated item, take into account the following restrictions.

You cannot add a calculated item to a page field. Also, you cannot move a row or column field containing calculated items to
the page area of the PivotTable report.
You cannot add a calculated item to a grouped field. Ungroup the field before inserting the calculated item.
You cannot add multiple copies of a field containing calculated items to the data area.
You cannot add a calculated item to a PivotTable report that uses the Average, StdDev, StdDevp, Var or Varp aggregation
function in the data area.

To insert a calculated item, follow the steps below.

1. Select a cell in the field to which the calculated item should be added. On the PivotTable Tools | Analyze tab, in the
Calculations group, click the Fields, Items, & Sets item and select the Calculated Item... item from the drop-down menu.



2. In the invoked Insert Calculated Item dialog, specify the name and formula for the calculated item. To use a value of
another item in the formula, click the required item in the Items list, and then click Insert Item. Note that you can use only
items from the same field as the calculated item.

3. Click Add, and then click OK. As a result, the new item will be added to the field.

4. To delete a calculated item, invoke the Insert Calculated Item dialog, select the required item from the Name drop-down
list and click Delete.



Create a List of the PivotTable Formulas
You can automatically create a list of all the calculated fields and items used in the current pivot table. To do that, on the
PivotTable Tools | Analyze tab, in the Calculations group, click the Fields, Items, & Sets item and select the List Formulas
item from the drop-down menu. As a result, the list will be created on a new worksheet and will appear as in the image below.



Outline DataOutline Data
The Spreadsheet provides you with the capability to split a large amount of data into separate groups and display summary
rows and columns for each group. Data grouping is useful when you wish to temporally hide unnecessary rows or columns to
display only significant information.

Select the action you wish to perform.

Group Rows and Columns
Outline Data Automatically
Expand or Collapse Groups
Specify Group Settings

Group Rows and Columns
To group data in a worksheet, do the following.

1. Select the rows or columns you wish to group.

2. On the Data tab, in the Outline group, click the Group button, and select the Group item in the button's drop-down
menu...
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You can also place one group of rows or columns inside another. To do this, repeat the steps above until you create
the required number of groups. Note that the number of nested groups is limited: you can create a maximum of
seven levels of grouping.

To ungroup data in a worksheet, do the following.
1. Select the rows or columns you wish to ungroup.
2. On the Data tab, in the Outline group, click the Ungroup button, and select the Ungroup item in the button's drop-

down menu...

Outline Data Automatically
The Spreadsheet allows you to create an automatic outline of rows and columns based on subtotal and summary formulas
contained in a worksheet.

To create an automatic outline, do the following.

1. Specify the summary rows or columns containing formulas that reference cells to be outlined. If you do not specify
any summary formulas, the data will not be grouped.

2. On the Data tab, in the Outline group, click the Group button, and select the Auto Outline item in the button's drop-
down menu.

To remove an automatic outline, do the following.

On the Data tab, in the Outline group, click the Ungroup button, and select the Clear Outline item in the button's drop-



down menu.

Expand or Collapse Groups
Using the outline symbols

Since the group is created, it is marked by the grouping bar displayed along the grouped rows to the left side of a
worksheet and along the grouped columns at the top of a worksheet. Each grouping bar is accompanied by a plus  or
minus  outline symbol (depending on the group state). To collapse the required group, click the minus sign, which
automatically changes into a plus sign after the group is collapsed, or just click the grouping bar itself. To expand the
collapsed group, click the plus sign.

You can also use the Hide Detail and Show Detail buttons in the Outline group to hide or display the detail rows and
columns for a specific group.

Using the outline buttons

If your data is divided into different grouping levels , you can collapse or expand multiple groups at once using the outline
buttons . The outline buttons for row grouping are displayed above the row headers, while the outline buttons for
column grouping are shown to the left of the column headers. Each outline button has a number that indicates a grouping
level. For example, if you have two levels of grouping, the Spreadsheet displays three outline buttons. Clicking outline
button 1 collapses all the specified groups of rows or columns. Clicking number 2 collapses all the groups in the second
grouping level and lower, except the first level. Clicking the last outline button displays the entire worksheet by expanding
all the specified groups.

Thus, to hide all detail data, click outline button 1. To display all detail data, click the outline button with the largest number.

The number of outline buttons changes depending on the levels of grouping created in a worksheet. The largest number is
8, because you can create a maximum of seven levels of grouping.

Specify Group Settings
You can specify the grouping direction using the Settings dialog. To invoke this dialog, on the Data tab, click the Outline dialog
box launcher.



Select the required check boxes depending on where your summary rows or columns are located. For example, if you inserted
summary rows above detail rows in each group, clear the Summary rows below detail check box.

In this case, the grouping bar changes direction, so that the minus outline symbol is displayed opposite the summary row at the
top of the group.
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Subtotal DataSubtotal Data
The Spreadsheet allows you to automatically group related data in a worksheet and add summary rows to each group using the
SUBTOTAL function.
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Before subtotaling, it is necessary to ensure that the range to be subtotaled contains similar data in each column, has column
headings in the first row and does not include blank rows or columns.

To insert subtotals for the selected range, follow the steps below.

On the Data tab, in the Outline group, click the Subtotal button.

In the invoked Subtotal dialog, specify the required subtotal options.

In the At each change in drop-down list, select the heading of the column by which the data should be grouped.
Each time a value in this column changes, a new subtotal row is inserted. So sorting your data by this column is
recommended to ensure that the same column values will be in one group.
In the Use function drop-down list, select one of the eleven functions available for calculating subtotals: Sum, Count,
Average, Max, Min, etc.
In the Add subtotals to box, select the check boxes corresponding to the columns for which the SUBTOTAL function
should be calculated.
Select the Replace current subtotals check box to replace the existing subtotals with the recently specified subtotals.
If you wish to create more than one level of subtotals (for example, to insert subtotals for the inner groups using
different summary functions), clear this check box.
Select the Page break between groups check box to locate each group on a new page. It can be useful if your
groups contain many detail rows and you wish to separate them while printing.



Select the Summary below data check box to display a summary row below detail rows in each group. Otherwise,
the summary row will be displayed at the top of the group.

Since subtotals are specified, you can change the SUBTOTAL function directly in the cell or formula bar to ignore values in the
collapsed groups. To do this, add 100 to the first numeric function's argument, which specifies the code of the function used in
calculating subtotals. In this case, the hidden values in the collapsed group will not be taken into account during calculations.

To remove subtotals, select a cell in the subtotaled range, invoke the Subtotal dialog and click the Remove All button.



Sort DataSort Data
The Spreadsheet provides the capability to sort data by text (A to Z or Z to A), numbers (smallest to largest or largest to
smallest), dates and times (oldest to newest or newest to oldest) in one column.

To perform sorting, do the following.

1. Select a range in the column you wish to sort.
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If multiple columns are selected, the range will be sorted by the first column.

2. On the Data tab, in the Sort & Filter group, click Sort A to Z to select ascending order, or click Sort Z to A for descending
order.

Sort a Table
To sort data in a table, follow the steps below.

1. Click the arrow  in the header of the column by which data will be sorted.

2. In the drop-down menu, select the Sort A to Z item to select ascending order, or select the Sort Z to A item to select
descending order.

All the records in the table will be reordered accordingly. The tiny arrow  appears in the column header to indicate that data in
the table are sorted by this column.
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You cannot sort a table by more than one column at a time. When you apply a new sort order, it replaces the previous one.



Filter DataFilter Data
The Spreadsheet allows you to use the AutoFilter to arrange large amounts of data by displaying only rows that meet the
filtering criteria.

To enable the filtering functionality, select the required data, and on the Data tab, in the Sort & Filter group, click the Filter
button.

Once filtering is activated, a drop-down arrow  appears on the right side of each column header in the range. Depending on the
data in the column you wish to filter, you can apply one of the following filters: Filter by Values, Text Filter, Number Filter or Date
Filter.
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You can filter your data by multiple columns. Filters are additive: each new filter is applied in addition to the existing filters and
further reduces your data.

Filter by Values
Text Filter
Number Filter
Date and Time Filter
Reapply a Filter
Clear a Filter

Filter by Values
To filter your data by a list of values, do the following.

1. Click the arrow  in the header of the column containing the values you wish to filter.

2. In the drop-down menu, select the Filter by Values item to invoke the AutoFilter dialog.

3. The AutoFilter dialog displays a list of all values in the selected column. Click the Uncheck All button to deselect the
values. Then, select the check boxes for the items you wish to display, and click OK.



Text Filter
To apply the text filter, do the following.

1. Click the arrow  in the header of the column containing text values you wish to filter.

2. Point to Text Filters and select one of the built-in comparison operators, or select Custom Filter to construct your own
filter expression.

3. In the invoked Custom AutoFilter dialog specify the filter criterion.



You can also specify the additional filter criterion using the AND or OR logical operator to combine the conditions.

To make your filter criterion more flexible, use the wildcard characters. The asterisk * matches any number of characters,
while the question mark ? represents a single character. For example, to display all the values that start with the letter "C",
you can either use the Begins With operator as shown in the image above, or select the Equals operator and type "C*" in
the box on the right.
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To filter values containing a specific character, such as the asterisk, question mark or tilde, put the tilde (~) before it.

Number Filter
To apply the number filter, do the following.

1. Click the arrow  in the header of the column containing numeric values you wish to filter.

2. Point to Number Filters and select one of the built-in comparison operators (Equals, Greater Than, Less Than, Between,
Top 10, Above or Below Average, etc.), or select Custom Filter to construct your own filter expression.

3. In the invoked Custom AutoFilter dialog specify the filter criterion.

You can also specify the additional filter criterion using the AND or OR logical operator to combine the conditions.

Date and Time Filter



To apply the date filter, do the following.

1. Click the arrow  in the header of the column containing dates you wish to filter.

2. Point to Date Filters and select one of the built-in dynamic filter types to display dates that fall within a specified time
period (next, this or last week, month, year, etc.)...

... or select the Before, After, Equals or Between item to invoke the Custom AutoFilter dialog and find dates that are
before, after or equal to the specified date, or between two dates.

Reapply a Filter
To reapply a filter after you change your data, click a cell in the range or table to which the filter is applied, and then on the Data
tab, in the Sort & Filter group, click the Reapply button.



Clear a Filter
To remove a filter, do the following.

To remove a filter from a specific column, click the Filter button  in the column header, and then select the Clear Filter
From 'Column Name' item in the drop-down menu.

To clear all the specified filters and display the hidden rows, on the Data tab, in the Sort & Filter group, click the Clear
button.

To disable the filtering functionality, click a cell in the range or table, and then on the Data tab, in the Sort & Filter group, click
the Filter button. The drop-down arrows will disappear from the column headers and all the specified filters will be removed.



Validate Data in CellsValidate Data in Cells
The Spreadsheet allows you to use data validation to impose restrictions on cells to prevent other users from entering incorrect
values in validated cells. For example, you can create a drop-down list of allowed values, restrict the number of characters entered
into a cell, validate data using spreadsheet formulas, display an error message, provide an input message explaining what values
can be entered into cells, etc.

Data validation settings are located on the Data tab in the Data Tools group.

To configure data validation settings, use the Data Validation dialog, which can be invoked by clicking the Data Validation
button and selecting the Data Validation item in the drop-down menu.

Select the action you wish to perform.

Restrict data entry to predefined items from a drop-down list
Restrict data entry to a whole or decimal number within a specified range
Restrict dates and times to values within a certain time interval
Limit the number of text characters
Validate data based on formulas or values in other cells
Create an input message
Create an error message
Circle invalid data
Remove data validation

Restrict Data Entry to Predefined Items from a Drop-Down List
1. Select the cell or cell range you wish to validate.
2. Invoke the Data Validation dialog.
3. On the Settings tab, in the Allow list, select the List item.

4. Enter a reference to the list of valid entries in the Source box. You can use a list of comma-separated values, define a name



for the cell range of valid entries, or select this cell range directly in the worksheet by using the Collapse Dialog button .

If you use a defined name or cell reference, precede it with an equal sign (=).

5. Verify that the In-cell dropdown check box is selected to display the drop-down menu in validated cells.
6. Select or clear the Ignore blank check box to specify whether or not to validate cells with empty values.
7. Click OK to close the dialog and apply the specified validation criterion.

As a result, the drop-down arrow appears to the right of a validated cell. Click the arrow to display the cell's drop-down list and
select the required value.

Restrict Data Entry to a Whole or Decimal Number within a Specified
Range

1. Select the cell or cell range you wish to validate.
2. Invoke the Data Validation dialog.
3. On the Settings tab, in the Allow list, select the Whole number or Decimal item.
4. Select the desired comparison operator in the Data list.

5. Depending on the selected operator, enter the required threshold values in the Minimum, Maximum or Value boxes.
Note that you can also use a formula that returns a numeric value to calculate the threshold value. If you enter a formula,
start it with an equal sign (=).



6. Click OK to close the dialog and apply the specified validation criterion.

Restrict Dates and Times to Values within a Certain Time Interval
1. Select the cell or cell range you wish to validate.
2. Invoke the Data Validation dialog.
3. On the Settings tab, in the Allow list, select the Date or Time item.
4. Select the desired comparison operator in the Data list.

5. Depending on the selected operator, provide the required values for the Start date, End date or Date boxes, if the Date
option is selected (or for the Start time, End time or Time boxes in case of the Time option). Note that you can also use a
formula that returns a date or time value to calculate the threshold value. If you enter a formula, start it with an equal sign
(=).

6. Click OK to close the dialog and apply the specified validation criterion.

Limit the Number of Text Characters
1. Select the cell or cell range you wish to validate.
2. Invoke the Data Validation dialog.
3. On the Settings tab, in the Allow list, select the Text length item.
4. Select the desired comparison operator in the Data list.

5. Depending on the selected operator, enter the minimum, maximum, or particular text length in the Minimum, Maximum



or Length boxes, respectively. Note that you can also use a formula that returns a numeric value to specify the allowable
text length. If you enter a formula, start it with an equal sign (=).

6. Click OK to close the dialog and apply the specified validation criterion.

Validate Data Based on Formulas or Values in Other Cells
1. Select the cell or cell range you wish to validate.
2. Invoke the Data Validation dialog.
3. On the Settings tab, in the Allow list, select the Custom item.

4. In the Formula box, enter a formula you wish to use as a validation criterion. Note that this formula should return a logical
value: TRUE for valid values and FALSE for incorrect values. Your formula may also contain cell references, so that you can
calculate the allowable values based on the content of other cells.

For example, to restrict data entry for an Employee ID to a five-digit number, use the following formula:
=AND(ISNUMBER(B3),LEN(B3)=5).

5. Click OK to close the dialog and apply the specified validation criterion.

Create an Input Message
Once you apply data validation to cells, you can create an input message, which represents a descriptive message explaining what
values can be entered into validated cells. Each time a validated cell is selected, a yellow text box appears near the cell displaying



the input message.

To create an input message, do the following.

1. Invoke the Data Validation dialog.
2. Switch to the Input Message tab.
3. Verify that the Show input message when cell is selected check box is selected.

4. Specify the message title in the Title box, and enter the detailed message text in the Input Message box.

5. Click OK to close the dialog and add the specified input message to validated cells.

Create an Error Message
In addition to an input message, you can also specify an error message that will be displayed when a user enters an incorrect
value into a validated cell.

There are three types of error messages.



Stop - specifies that users are not allowed to enter invalid data in a validated cell. The Stop message contains two buttons:
the Retry button enables users to edit the invalid entry, while the Cancel button rejects it and rolls back to the previous cell
value.
Warning - allows users to enter an incorrect value in a validated cell, but warns them that the specified value is invalid. The
Warning message contains three buttons: clicking Yes allows users to accept the invalid value, No enables them to edit the
invalid entry, and Cancel rolls back to the previous cell value.
Information - informs users that they entered an incorrect value and allows them to accept this value by clicking OK, or
reject it by clicking Cancel.

Unless you specify the error message, the Spreadsheet will use the Stop error alert with the default text. To customize the error
text and provide other users with a more informative message, do the following.

1. Invoke the Data Validation dialog.
2. Switch to the Error Alert tab.
3. Verify that the Show error alert after invalid data is entered check box is selected.
4. Select the type of the error message in the Style list.

5. Specify the caption for the error alert window in the Title box, and enter the error description in the Error Message box.

6. Click OK to close the dialog.

Note that if you use error messages that do not prevent the entry of incorrect values (Warning or Information), you can identify
invalid data in your document by displaying validation circles.

Circle Invalid Data
The Spreadsheet allows you to highlight invalid values entered into validated cells. To do this, on the Data tab, in the Data Tools
group, click Data Validation | Circle Invalid Data.

As a result, red circles will appear around cells containing incorrect values.



Once you identified invalid values, you can hide validation circles again. Do one of the following.

Enter a value that meets the validation criterion in the cell. In this case, the validation circle will disappear automatically.
On the Data tab, in the Data Tools group, click Data Validation | Clear Validation Circles.

Remove Data Validation
To remove data validation criteria, perform the steps below.

1. Select the cells which you wish to stop validating.
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To quickly select all cells to which data validation is applied, on the Home tab, in the Editing group, click Find & Select |
Data Validation.

2. Invoke the Data Validation dialog.

3. Do one of the following.

If you are prompted to erase current validation settings and continue, click OK, and then click OK in the invoked Data
Validation dialog.

In the invoked Data Validation dialog, on the Settings tab, click the Clear All button.





Create a Simple FormulaCreate a Simple Formula
The Spreadsheet allows you to perform calculations on data in cells using formulas. A formula is a string expression that starts
with the equal sign ("="). Formulas can contain constants, math operators, functions, cell references, etc.

The Spreadsheet provides the capability to use the Formula Bar, which is the bar at the top of a worksheet, to enter and edit
formulas.

For example, if you wish to add 1 to the product of 2 and 5, type the following formula in the cell in which you wish to insert the
formula or in the Formula Bar.

=2*5+1

Press ENTER. The result appears in the cell in which you inserted the formula.



Cell ReferencesCell References
The A1 Reference Style
If you want to change data in a worksheet without changing formulas that use this data for evaluation, you can use cell
references. A cell reference defines cell location in a worksheet. It is a combination of column letters (A, B, C, etc.) and row
numbers (1, 2, 3, etc.). For example, A1 refers to a cell at the intersection of column A and row 1.

To add values in cells A1 and A2, and divide the result by the value in cell A3, type the following formula (use parentheses to
determine the order of operations):

=(A1+A2)/A3=(A1+A2)/A3

You can also use a reference to a cell located in another worksheet. For example, to multiply a value in cell B1 by the value in cell
B1 in Sheet 2, enter the following formula:

=B 1*Sheet2!B 1=B 1*Sheet2!B 1

To prevent data from changing when the formula is copied, use the absolute reference. Absolute references have a dollar sign
($) before column and/or row references.

The following example demonstrates how to use a constant value in cell B1 in calculations:

=A1*$B $1=A1*$B $1

The R1C1 Reference Style
The Spreadsheet supports the R1C1 reference style where both rows and columns are labeled with numbers. Cell location is
indicated by an "R" letter followed by a row number and a "C" letter followed by a column number.

You can use absolute and relative R1C1 references. An absolute R1C1 reference always refers to a cell in a specific location.

The example below demonstrates how to create a formula that adds values in cells A1 through A5 using the absolute R1C1
reference style:

=S UM(R1C1:R5C1)=S UM(R1C1:R5C1)

A relative R1C1 reference refers to a cell location in relation to an active cell.

The image below illustrates a relative reference to a cell one row above and one column to the left of the active cell.

The following example demonstrates how to create a formula that adds values in cell range A1:A5 using the relative R1C1
reference style in cell B1:

=S UM(R C[-1] :R [4]C [-1] )=S UM(R C[-1] :R [4]C [-1] )



Defined NamesDefined Names
The Spreadsheet allows you to define a descriptive name for an individual cell, cell range, function, or constant value to make it
easier to understand the information contained in worksheet formulas.

Defined Name Overview
Defined Name Scope
Syntax Rules for Names
Create a Name Using the Name Box
Create a Name Using the New Name Dialog
Create Names from Selection
Mange Names Using the Name Manager Dialog
Use Names in Formulas
Delete Names

Defined Name Overview
A defined name is a meaningful shorthand name that describes the meaning of an individual cell, cell range, function, or constant
value. Each defined name contains the following information.

Name

Indicates an individual cell, range of cells, formula or constant. Usually, a name explains the purpose of an object to which
this name refers, making it easier to find and use this object.

When specifying a name, you must take into account special syntax rules.

Refers To

A string specifying a reference to a cell or cell range, formula or constant associated with the defined name. For example:

"=Sheet1!$D$20" - refers to the D20 cell located on the Sheet1 worksheet;

"=Sheet1!$A$1:$C$10" - refers to the A1:C10 range of cells located on the Sheet1 worksheet;

"=SUM(Sheet1!$B$1:$B$10)" - refers to the formula that calculates the sum of values contained in the B1:B10 range of cells
located on the Sheet1 worksheet;

"=10.5" - refers to a constant value.

By default, defined names use absolute cell references, including worksheet names.

Comment

An explanation or additional information accompanying the defined name. The comment length cannot exceed 255
characters.

Defined Name Scope
Each defined name has a scope - an area (individual worksheet or entire workbook) where the name is recognized and can be
used without qualification. For example, a defined name (cellName) whose scope is the first worksheet of a workbook (Sheet1) is
recognized without qualification in this worksheet only (e.g., =5+cellName). To use this defined name in other worksheets,
precede it with the name of the worksheet to which the defined name belongs (e.g., "=5+Sheet1!cellName"). If the scope of a
defined name (cellName_global) is an entire workbook, this name is recognized in any worksheet of this workbook (e.g.,
"=5+cellName_global").
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Each name must be unique in its scope.

If the defined name is not found, the cell that uses this name displays the #NAME? error.

Syntax Rules for Names
When you create or modify a defined name, follow these rules.

Start a name with a letter, an underscore symbol ("_") or a backslash (""). Other characters in the name can be letters,
numbers, periods and underscore symbols.

Note that the single letters "C", "c", "R", or "r" cannot be used as defined names.

A name cannot contain a cell reference (for example, "A1", "$M$15", etc.).
A name cannot contain spaces (use underscore symbols and periods to separate individual words in a name).
A name cannot be an empty string.
The length of a name cannot exceed 255 characters.
Names are case-insensitive, so that you are not allowed to create the Products and PRODUCTS names in one scope.

Create a Name Using the Name Box
1. Select a cell or a range of cells for which you wish to define a name.

2. Type the name you want to use to refer to the selection in the Name Box located to the left of the Formula Bar. Press
ENTER.

Now you can quickly select the defined cell range by its name. To do this, click the drop-down arrow to the right side of the
Name Box, and select the required name from the drop-down list.

Create a Name Using the New Name Dialog
The New Name dialog gives you more flexibility for naming parts of your document. Using this dialog, you can name cell ranges,
formulas and constants, and provide additional information for created names.

1. To invoke the New Name dialog, on the Formulas tab in the Defined Names group, click the Define Name button.



2. In the invoked dialog in the Name box, type a name to be associated with a cell or cell range, formula or constant.

3. In the Scope drop-down list, select the scope of the defined name: specify whether a name should be accessible within an
entire workbook or an individual worksheet only.

4. In the Comment box, enter a descriptive text for your defined name (optionally).

5. In the Refers to box, type a cell reference, formula or constant for which you wish to define a name.

By default, when you invoke the New Name dialog, the current selection is displayed in the Refers to box. However, you
can enter another cell range by selecting it directly in the worksheet. To do this, click the Collapse Dialog button ( ) to
minimize the dialog and access the worksheet, select the appropriate cell range, and then click the Expand Dialog button (

) to restore the dialog's initial state.

6. Click OK to finish creating the name.

Create Names from Selection
The Create Names from Selection dialog allows you to automatically generate names for rows and columns in the selected
range using the row and column labels.

To create a name from a selection, do the following.

1. Select a cell range to be named, including the row or column labels to be used for generating names.

2. On the Formulas tab in the Defined Names group, click the Create from Selection button, or press CTRL+SHIFT+F3.



3. In the invoked Create Names from Selection dialog, specify which row (top or bottom) or column (left or right) contains
labels that should be used for generating names, and click OK.
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Names generated using this approach do not include the row and column labels and refer only to the cells containing values.

Mange Names Using the Name Manager Dialog
The Name Manager dialog lists all the defined names specified in a workbook and allows you to create new names, edit and
delete existing names.

To invoke the Name Manager dialog, on the Formulas tab in the Defined Names group, click the Name Manager button.



Create a name

To define a new name, at the top of the Name Manager dialog, click the New... button. In the invoked New Name dialog,
specify all necessary parameters for a new defined name.

Edit a name

To modify the existing name, select this name in the Name list, and at the top of the Name Manager dialog click the Edit...
button, or double-click the name. In the invoked Edit Name dialog, modify the name itself, change the cell reference,
formula or constant to which the name refers, or enter a new comment. Only the scope of the defined name cannot be
changed.

If you wish to modify only the current reference for a name, you can do it directly in the Name Manager dialog. To do this,
select the desired name in the Name list and type a new value in the Refers to box, or...

... click the Collapse Dialog button ( ) and select the desired range directly in the worksheet.

Use Names in Formulas
To insert an existing defined name into a formula, type the required name directly in the formula or select it from the Use in
Formula list on the Formulas tab in the Defined Names group.



Delete Names
To remove a defined name, do the following.

1. On the Formulas tab, in the Defined Names group, click the Name Manager button.

2. In the invoked Name Manager dialog, select the name you wish to delete.

3. Click the Delete button, or press DELETE.



Using Functions in FormulasUsing Functions in Formulas
The Spreadsheet provides the capability to use a set of predefined functions in formulas to perform simple or complex
calculations.

To create a formula containing functions, follow the instructions below.

1. Click the cell in which you want to insert the formula.
2. Type the equal sign "=". This is required to interpret the cell content as a formula. Skip this action if you insert the function

in a cell which already contains a formula.
3. Type the function's name, or insert the required function from the Function Library.
4. Enter the arguments between the function's parentheses.
5. Press ENTER. The result appears in the cell in which you inserted the formula.

Insert a Function
If you do not remember the name of the function you want to use, you can insert the desired function quickly using one of the
following approaches.

Using the Function Library group

On the Formulas tab, in the Function Library group, click the button corresponding to the category to which your function
belongs, and select this function from the button's drop-down list.
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Frequently used functions such as Sum, Average, Count Numbers, Max and Min are also listed under the AutoSum
button on the Home tab in the Editing group.

For example, if you wish to add all numbers in the range E4:E8, in the Function Library group, select the SUM function
from the AutoSum (or Math & Trig) button's drop-down list. Type "E4:E8" in the function's parentheses, or select the cell
range directly in the worksheet, and press ENTER.

Using the **Insert Function dialog**

1. To invoke the Insert Function dialog, click the Insert Function button on the Formula Bar, or press SHIFT+F3.



2. At the top of the dialog, select a category to which the desired function belongs, and then select this function in the
sorted list below. Note that at the bottom of the dialog, the selected function's syntax and description are shown. Click
OK.

3. In the invoked Function Arguments dialog, enter the required function's arguments (that are marked in bold font) in
the corresponding editors. A function argument can be a data value, cell reference, defined name, another function,
etc.

If your function uses a cell reference as an argument, you can select the desired cell range directly in the worksheet. To
do this, click the Collapse Dialog button ( ) to the right of the argument editor (to minimize the dialog and access
the worksheet), select the appropriate cell range, and then click the Expand Dialog button ( ) to restore the dialog's
initial state and continue specifying other function arguments.

After all the function's arguments are specified, click OK to finish building your formula and see the calculated result
in the cell.

�� N o t eN o t e



If you start the formula with a function, the Spreadsheet automatically adds the equal sign to your formula.

Nested functions
You can create a formula with a function that uses another function as one of the arguments. A function that is used as an
argument is called a nested function. A formula can contain up to 64 levels of nesting.

Examples of formulas with nested functions are detailed in the table below.

FOR MU L A D ES CR IPTION

=ROUND(SUM(A1:A5),2) Round the sum of the values contained in the cell range A1:A5 to two decimal places.

=SQRT(AVERAGE(A1:A5)) Returns the square root of the average value of the numbers in the cell range A1:A5.

=IF(A5<1000, POWER(A5,2)) Square the value in cell A5 if it is less than 1000.



Supported FunctionsSupported Functions
The Spreadsheet supports the following functions to be used in formulas.

Mathematical Functions - used to perform common mathematical operations: addition (SUM), multiplication (PRODUCT),
exponentiation (POWER), extraction of the square root (SQRT), evaluation of trigonometric functions (e.g., SIN, COS or TAN),
etc.
Financial Functions - used to perform various types of financial operations: calculation of interest rates (RATE), calculation
of interest payments (IPMT), etc.
Logical Functions - used to perform logical operations such as AND, OR, NOT, etc.
Text Functions - used to provide operations with text data in cells, such as string concatenation (CONCATENATE),
replacement of part of a string with another string (REPLACE), etc.
Date and Time Functions - used to work with dates: to calculate the number of days, months, or years between two dates
(e.g., DATEIF or DAYS360), or to add various components of a specified time to a worksheet (e.g., SECOND, MINUTE or
HOUR).
Lookup and Reference Functions - used for searching specific data in a worksheet: to look up values in vectors, arrays or
references (e.g., LOOKUP or MATCH)
Statistical Functions - used for data analysis: to find the average of a list of values (AVERAGE), to evaluate the covariance
between two data sets (COVAR), to find the smallest or the largest value in a list of arguments (MAX, MIN), etc.
Engineering Functions - used to work with special functions (e.g., BESSELI or BESSELJ), complex numbers (e.g., COMPLEX
or IMAGINARY) and various numeral systems (e.g., DEC2BIN or BIN2DEC).
Information Functions - used to provide information about the formatting, location or content of cells (e.g., CELL, INFO or
ISTEXT).
Compatibility Functions - replaced by new functions in Microsoft® Excel® versions 2010 and higher. These functions can
be used to provide compatibility with earlier versions of Microsoft® Excel®.
Web Functions - used to return a URL-encoded string (ENCODEURL).

All of the functions described above are available in the Function Library group within the Formulas tab.



Create an Array FormulaCreate an Array Formula
An array formula is a formula that performs calculations on sets of cell ranges, so that you do not need to re-enter formulas for
each calculation. Create an array formula and specify the columns or rows that the array formula must fill. Array formulas are
used to perform actions on two or more sets of values, which are called arguments. Each array argument must have the same
number of rows and columns. The result of an array formula can either be a single value or multiple values.

To create an array formula, do the following.

1. Select the cell in which you wish to insert the array formula. If the formula calculates multiple results, select the cell range
for which you wish to create the array formula.

2. Enter the array formula in the Formula Bar.

3. Press CTRL+SHIFT+ENTER. The Spreadsheet automatically adds a pair of curly braces to the formula to indicate that it is
an array formula.

�� N o t eN o t e

Any time you edit the array formula, you must press CTRL+SHIFT+ENTER to save changes and convert the formula into an array
formula.

The example below demonstrates how to create a formula that multiplies three arrays of values (quantity, price and discount) to
get an array of amount values for each product item without entering a separate formula for each row.

=C4:C8D4:D8(1-E4:E8)



Error Types in FormulasError Types in Formulas
If a formula in a cell cannot be calculated correctly, it means that the cell contains an error. The error appears because the
formula's syntax is incorrect, or the formula uses unexpected arguments or data types.

Errors that occur in formulas are detailed in the following table:

ER R OR D ES CR IPTION E X AMPLE

##### The column is not wide enough to display the cell content.

#DIV/0! Division by zero. =A1/B1 (where the value in cell B1 is equal to zero, or
cell B1 is blank).

#NAME? The formula refers to a name that doesn't exist or is spelled
incorrectly.

=SUM(Values) (the cell range named "Values" does not
exist).

#N/A The referenced value is not available to the formula. =SUM(A1:A5*B1:B3) (the array formula has
arguments consisting of different numbers of elements).

#NULL! An incorrect range operator is used in the formula, or the specified
intersection includes two ranges that do not intersect.

=SUM(A1 A3) (a colon is missing in the cell range
reference).

#NUM! There are invalid numeric values in the formula. =SQRT(-4) (the square root of a negative number
cannot be calculated).

#REF! The cell reference is not valid. =SUM(A1, B1) (column B has been deleted).

#VALUE! The formula uses values of the wrong data type. =SUM(5, "Text") (the SUM function requires numeric
arguments).



Charting OverviewCharting Overview
The Spreadsheet provides the capability to summarize worksheet data visually using a variety of charts. Charts display data
series visually to make data interpretation easier, and show the relationship between different data series. To create a chart, click
the chart type you wish to insert in the Charts group within the Insert tab.

The following chart types are currently available in the Spreadsheet:

Column Charts

Column charts are used to display series as sets of vertical bars (or columns) that are grouped by category. The bar lengths
are proportional to the values that they represent. Column charts are typically used to compare values in different
categories. Some column graphs display series as individual columns, grouped by category, and others show columns
divided into subparts to show a cumulative effect (stacked column graphs). You can select column charts of different shapes,
such as cylinder, cone or pyramid.

Line Charts

Line charts display information as a series of data points connected by line segments. This chart type is useful when you
need to show trends for several series on the same diagram, and to compare values of several series for the same point
argument.



Pie Charts

Pie and doughnut charts are used to compare the percentage values of different point arguments in the same series. These
charts may be useful to determine which point value is the most significant, or which values in the point series are the most
significant. A doughnut chart is functionally identical to a pie chart. The main difference is the shape of the doughnut chart,
and that it can contain more than one data series.

Bar Charts

Bar charts are identical to column charts with one exception: bar charts use horizontal bars instead of vertical bars to
compare values across categories. Some bar graphs display series as individual bars grouped by category, and others show
bars divided into subparts to show a cumulative effect (stacked bar graphs). You can select bar charts of different shapes,
such as cylinder, cone or pyramid.



Area Charts

Area charts display series as filled areas in a diagram, with each data point displayed as a peak or valley in the area. This
chart type is useful when you need to show trends for several series on the same diagram, and also show the relationship of
the parts to the whole. The area chart is based on the line chart, with the area below the plotted line filled with color.

Scatter Charts

Scatter charts are used to plot data points on the horizontal and vertical axis to show the relationship between two sets of
data. This chart type combines data values into single data points and displays them in uneven intervals (or clusters).

Bubble charts allow you to visually represent data that has a third dimension, expressed in the bubble's size. You map two
dimensions along the horizontal and vertical axes, and then the third dimension is displayed as a filled circle at the data
point.



Stock Charts

Stock charts are used to show variation in stock prices over the course of a day. In the High-Low-Close chart type, the
High and Low prices are represented by the top and bottom values of the vertical line that is shown at each point, and the
Close prices are represented by the right tick marks. In the Open-High-Low-Close chart type, the High and Low prices are
shown in the same way as in the High-Low-Close charts, but the Open and Close prices are represented by the bottom
and top borders of a rectangle. If the stock closes higher than its opening price, the rectangle is hollow. And if the stock
closes lower than its opening price, the rectangle is filled.

Radar Charts

Radar charts are used when it is necessary to display series as an area on a circular grid that has multiple axes along which
data can be plotted, so values are shown relative to a center point.





Creating a ChartCreating a Chart
The Spreadsheet allows you to create charts quickly using the Charts group of the Insert tab.

To create a chart, select the table that contains the data you wish to use for the chart. Note that the Spreadsheet only allows you
to create charts for data series representing a contiguous cell range.

In the Charts group within the Insert tab, select the required chart type. In the example below, a line chart is created. To insert a
line chart, click the Line button, and then select the Line with Markers chart subtype.

The chart is added to the worksheet. You can move the chart to the desired location and resize it for a better fit.



Changing a Chart TypeChanging a Chart Type
The Spreadsheet allows you to change the type of the existing chart. To do this, click the chart to display the Chart Tools
contextual tab.

Click the Change Chart Type button in the Type group within the Design tab...

... or right-click the chart and select the Change Chart Type... item in the context menu.

In the invoked Change Chart Type dialog, select a new chart type and click OK.

The following image illustrates the chart with the Radar with Markers chart type applied.





Applying a Predefined Chart Layout and StyleApplying a Predefined Chart Layout and Style
The Spreadsheet allows you to change the appearance of the existing chart by applying one of the predefined layouts and styles.

To change a chart style or layout, click the chart you wish to format, to display the Chart Tools contextual tab.

Apply a Predefined Chart Layout
In the Chart Layouts group within the Design tab, select the required chart layout. For example, select Layout 10, which
positions the chart legend to the right of the chart area, and adds the chart and axis titles.

To enter the chart title, right-click the chart and select the Change Chart Title... item in the context menu.

In the invoked Change Chart Title dialog box, enter a title and click OK.

To provide horizontal or vertical axis titles, right-click the chart and select the Change Horizontal Axis Title... or Change
Vertical Axis Title... item in the context menu. Type a new title in the invoked dialog box.

The image below shows the result.



Apply a Predefined Style
In the Chart Styles group of the Design tab, click the chart style you wish to apply.

The image below shows a chart with Style 22 applied.



Modifying a Chart ManuallyModifying a Chart Manually
After you create a chart, you can choose whether to apply one of the predefined chart layouts or specify your own layout. The
Spreadsheet provides the capability to add axis titles and chart titles, show the chart legend, display gridlines and data labels, etc.

To modify a chart, click it to display the Chart Tools contextual tab.

Add a Chart Title
To add a title to your chart, click the Chart Title button in the Labels group within the Layout tab, and then select where to
position the chart title. For example, click the Above Chart button to display the title at the top of the chart.

The image below illustrates the result.

To change the default text in the title, right-click the chart and select the Change Chart Title... item in the context menu. Specify a
new chart title in the invoked Change Chart Title dialog box.

Add Axis Titles
To display horizontal and vertical axis titles, click the Axis Titles button in the Labels group within the Layout tab and do the
following.



To add a horizontal axis title, select the Primary Horizontal Axis Title item, and then click the Title Below Axis button.

To add a vertical axis title, select the Primary Vertical Axis Title item, and then select the type of axis title (rotated, vertical
or horizontal) you wish to display.

To change the default text in the axis title, right-click the chart and select the Change Horizontal Axis Title... or Change
Vertical Axis Title... item in the context menu. Type a new title in the invoked dialog box.

Add a Chart Legend
To add a legend to the chart, click the Legend button in the Labels group within the Layout tab, and then select where to
position the legend.



For example, click the Show Legend at Top button to display the legend above the plot area.

Display Data Labels
To display data values on the chart, click the Data Labels button in the Labels group within the Layout tab, and then select
where to position the data labels.

Add Gridlines
To display chart gridlines, click the Gridlines button in the Axes group within the Layout tab and do one of the following:

To add horizontal gridlines, select the Primary Horizontal Gridlines item, and then select the type of gridlines you wish to



display.

To add vertical gridlines, select the Primary Vertical Gridlines item, and then select the type of gridlines you wish to
display.

A chart with horizontal and vertical gridlines is shown below.



Creating a Chart SheetCreating a Chart Sheet
The Spreadsheet allows you to create two chart types: an embedded chart inserted into an existing worksheet and a standalone
chart placed on a separate sheet in a workbook - a chart sheet. Chart sheets are useful when you need to show or print a chart on
a page without any worksheet data.

Select the action you wish to perform:

Insert a New Chart Sheet
Move an Existing Chart to a Chart Sheet
Remove a Chart Sheet

Insert a New Chart Sheet
1. On the Sheet tab bar, right-click an existing worksheet's tab and select Insert... in the context menu.

2. Select Chart in the invoked dialog and click OK.

As a result, an empty chart sheet with a default name is added to the document.

3. Select the chart data by clicking Select Data in the Data group, on the Chart Tools | Design tab...

... or by right-clicking an empty chart area and clicking Select Data... in the context menu.



4. In the invoked Select Data Source dialog, enter a reference to the cell range containing the chart data. You can use the
Collapse Dialog button  to select this range directly in a worksheet.

The Spreadsheet creates a clustered column chart by default.

5. To change the default chart type, click Change Chart Type in the Type group, on the Chart Tools | Design tab...

... or right-click a chart and select Change Chart Type... in the context menu.

6. In the invoked Change Chart Type dialog, select a new chart type and click OK.



Use other options on the Chart Tools contextual tab to fine-tune chart settings like applying a chart style and adjusting the
chart's layout.

Move an Existing Chart to a Chart Sheet
To move an existing chart from a worksheet to a separate chart sheet, follow the steps below:

1. Click Move Chart in the Location group, on the Chart Tools | Design tab...

... or right-click the chart and select Move Chart... in the context menu.

2. In the invoked dialog, select New Sheet and then enter a chart sheet name. Click OK to create a chart sheet with the
specified chart.



Remove a Chart Sheet
To delete a chart sheet, right-click its tab on the Sheet tab bar, and then click Delete in the context menu.

If you want to preserve a chart located on a chart sheet, you can move the chart back to the worksheet containing the source data
or place it on another worksheet. Click Move Chart in the Location group, on the Chart Tools | Design tab to invoke the Move
Chart dialog. Select the necessary worksheet from the Object in list and click OK.

As a result, the Spreadsheet removes the chart sheet and moves its chart to the specified worksheet. You can change the chart's
location and resize it.



Mail Merge OverviewMail Merge Overview
The Spreadsheet supports the Mail Merge functionality, which allows you to automatically generate a set of documents based
on a common template, and include unique data values retrieved from a data source in each document. Use mail merge to
generate personalized letters and a variety of professional reports.

Add a Data Source
Create a Template
Generate a Merged Document

Add a Data Source
To perform a mail merge, you need a template and a data source from which the data is retrieved. You can specify a data source
at runtime using the Data Source Wizard. Once created, the data source configuration will be stored in the XLS/XLSX
spreadsheet file, so there is no need to re-configure the data source again.

To invoke the wizard, click Add Data Source in the External Data Sources group of the Mail Merge tab.

The wizard allows you to select the data source type. You can choose between an external database, the Entity Framework, an
object data source or an Excel workbook.

For more information on data source configuration, review the following documents:

Data Source Wizard
Query Builder
Parameters Panel



Create a Template
A template is a workbook with one worksheet containing mail merge fields that will be filled with unique data values from a
bound data source.

As a rule, a template includes detail, header and footer ranges that reflect the structure of a merged document. To highlight
template ranges, on the Mail Merge tab, in the Design group, click the Mail Merge Design View button.

A detail range contains information from a data source. To create a detail range, select the range of the required size and do one
of the following:

On the Mail Merge tab, in the Template Ranges group, click the Detail button.

Assign the "DETAILRANGE" defined name to the selected range.

A detail range includes mail merge fields. Real data values retrieved from a data source will be displayed in a merged document
instead of these fields. To create a mail merge field, use the FIELD function.



FU NCTION S YNTAX D ES CR IPTION

FIELD FIELD("data_field_name") Retrieves a data value from the corresponding field of a data source.

A mail merge field is displayed as the name of the specified data field enclosed in square brackets. If a mail merge field is used in
a cell formula as one of its elements, the entire formula is displayed in the cell.

You can also create a multi-level report by adding nested levels within a detail range. To create the next data level, select a range
within an existing detail range, and then click Master-Detail | Detail Level in the Template Ranges group. Click Master-Detail
| Data Member to invoke the Data Member dialog and bind the specified detail level to a data member from a data source.

Header and footer ranges are displayed above and below all detail ranges in the resulting worksheet if all data records are
merged into a single worksheet. In other mail merge modes, the header and footer are repeated for each detail range. To create a
header or footer range, select the range you wish to use as a header or footer, and do one of the following:

On the Mail Merge tab, in the Template Ranges group, click the Header or Footer button.

Assign the "HEADERRANGE" or "FOOTERRANGE" defined name to the selected range.



Note that you can create a header or footer range only if the template already contains a detail range. If you do not set a detail
range, the entire template will be copied for each record of the data source.

At the template creation stage, you can access the range into which the specified cell in a template will be expanded after a mail
merge is performed. To do this, use the RANGE function.

FU NCTION S YNTAX D ES CR IPTION

RANGE RANGE(abs_cell_reference) Obtains the specified range of a merged document.

If you no longer wish to use the specified range as a detail range, header or footer, you can reset it by clicking the Reset button.

Generate a Merged Document
A mail merge supports three modes for generating a resulting document, as listed in the table below:

MOD E D ES CR IPTION

Multiple Documents Inserts the merged range for each record of the data source into a separate workbook.

Multiple Sheets Inserts the merged range for each record of the data source into a separate worksheet of a single document.

Single Sheet Inserts all merged ranges into a single worksheet, retaining the structure of the template document.

Document Orientation Specifies the direction in which the detail range will be repeated.

To select the desired mode, on the Mail Merge tab, in the Mode group, click Multiple Documents, Multiple Sheets or Single
Sheet. Document Orientation option can be useful for the Single Sheet mode only.





Data Source WizardData Source Wizard
The Data Source Wizard allows the user to create a new data source, configure it, and if there is more than one data source
available, to select the one that is required for a particular task. Once created, the data source configuration will be stored in the
XLS/XLSX spreadsheet file, so the user does not have to re-configure the data source again.

To invoke the wizard, click Add Data Source in the External Data Sources group of the Mail Merge tab.

Next, proceed with the following steps in the wizard.

1. On the first page, specify the name for the new data source and click Next.

2. On the next page, select the data source type and click Next. The following steps assume that a Database is selected.



3. If a data connection has already been specified in the application, the next wizard page allows you to select whether to use
one of the existing connections, or create a new one.

4. When creating a new connection, you can specify the connection parameters on the next page.



On this page, you can define a custom connection string, or select from the following supported data source types.

Microsoft SQL Server
Microsoft Access 97
Microsoft Access 2007
Microsoft SQL Server CE
Oracle
Amazon Redshift
Google BigQuery
Teradata
Firebird
IBM DB2
MySQL
Pervasive PSQL
PostgreSQL
SAP Sybase Advantage
SAP Sybase ASE
SQLite
VistaDB
VistaDB5

XML File

Depending on the selected data provider, it may be necessary to specify additional connection options (such as
authentication type and database name) on this page.

To proceed to the next wizard page, click Next.

5. On this page, you are prompted whether to save the user name and password in a connection string.



Click Next to proceed to the next page.

6. This page allows you to select a query or a stored procedure.

Click Run Query Builder... to invoke the Query Builder window.

7. The Query Builder window allows you to select tables and columns to include in the result. The joins are created
automatically, however you can modify them using the Join Editor.



Click OK to close the Query Builder dialog and return to the Data Source Wizard.

8. The data source is created and configured.

Now you can click Finish to quit the Data Source Wizard.

If the Spreadsheet is accompanied with the Field List Panel, the fields from the bound data source are immediately
displayed within that panel. It allows you to drag and drop the required data field onto a worksheet used as a mail merge
template.



To modify the query used in the data source, click Manage Relations -> Manage Queries in the External Data Sources
group to invoke the Query Builder.

 T i pT i p

The data source configuration is stored in .xls or .xlsx file. You can save the workbook after creating the data source. Subsequently,
you can start a mail merge immediately after the XLSX/XLS file is loaded into the Spreadsheet control.



Query BuilderQuery Builder
When the data source is configured, you can use the built-in Query Builder dialog to select required data.

To invoke the Query Builder window, select the Manage Queries item from the Manage Relations drop-down menu.

In the Manage Queries dialog, click the ellipsis button in the query list to edit the selected query.

The Query Editor window appears.



To modify the query, invoke the Query Builder window by clicking the Run Query Builder... button.

To add a data table to the query, drag the required table from the list of available tables on the left and drop it onto the list of data
tables to be used. Select the check box near the field to include this field in the query. A green plus symbol near the field indicates
that you can join tables using this field.

Click Preview Results... to invoke a dialog displaying the first 1000 records of the resulting table.



Click the Filter... button in the Query Builder to invoke the Filter Editor window that allows you to specify a filtering criterion or
create a parametrized query.

For more information on parameters, review the Parameters Panel document.

When all the necessary changes are made, click OK to close the window and save the query in the document.

 T i pT i p

All queries are stored in an .xls or .xlsx file. You can save the workbook after creating the data source. Subsequently, you can start
performing a mail merge immediately after the XLSX/XLS file is loaded into the Spreadsheet control.



Parameters PanelParameters Panel
The Spreadsheet can be accompanied with the Parameters panel. It displays parameters used in a query to retrieve data and
allows you to modify them. The following picture illustrates how to specify the order ID for data used in the mail merge template.

The resulting report for order ID 10300 is shown below.

To add a parameter to a query, invoke the Query Builder and click the Filter... button to display the Filter Editor window.

The Filter Editor window allows you to specify a filtering criterion to be applied to the source data.

Click the icon on the right side of the Filter Editor to switch between a value, another field and a parameter.



Click OK to close the Filter Editor dialog and click Next in the Query Editor window to navigate to the page that allows you to
configure query parameters. This page is shown in the image below.

Select the check box in the Expression column to specify an expression to calculate the parameter value. Map the query
parameter to a new spreadsheet parameter. To do this, expand the drop-down list for the Value column and select the New
Spreadsheet Parameter... item.

In the invoked Spreadsheet Parameter dialog, specify the required parameter settings (its name, type and initial value).



After closing the Query Builder window, you will see the newly created parameter in the Parameters panel as shown in the
picture at the beginning of this document.



Insert a PictureInsert a Picture
The Spreadsheet allows you to insert pictures in a worksheet.

You can insert graphics of the following type.

Bitmap (*.bmp, *.dib)
JPEG File Interchange Format (*.jpg, *.jpeg)
Portable Network Graphics (*.png)
Graphics Interchange Format (*.gif)
Tagged Image Format (*.tif, *.tiff)
Microsoft Enhanced Metafile (*.emf)
Windows Metafile (*.wmf)

To insert a picture, follow the instructions below.

1. On the Insert tab, in the Illustrations group, click the Picture button.

2. In the Open dialog box that is invoked, locate the folder that contains the picture you want to insert. Click Open. The picture
will be inserted into the worksheet.



Move, Rotate and Resize a PictureMove, Rotate and Resize a Picture
Move a Picture

1. Click the picture you wish to move.
2. Drag the picture to a new location.

Rotate a Picture
1. Click the picture you wish to rotate.

2. Click the rotation handle (the round arrow that appears over the selected picture) and drag it in the direction in which you
wish to rotate the object.

3. To rotate a picture in 15-degree increments, drag the rotation handle while holding down the SHIFT key.

Resize a Picture
1. Click the picture to be resized.

2. Drag the sizing handle away from the center (or towards the center) of the picture, and release it once the desired size is
reached.

When you change the width of the object by dragging a corner sizing handle, the object's height will automatically be changed to
maintain the aspect ratio of the object, and vice-versa.



Insert and Delete HyperlinksInsert and Delete Hyperlinks
The Spreadsheet allows you to insert, edit and delete hyperlinks. A hyperlink is a link from a worksheet to another file or Web
page that can be opened when you click the hyperlink text or image.

Insert a Hyperlink
1. Click the cell in which you wish to insert a hyperlink.

2. Do one of the following.

In the Links group within the Insert tab, click the Hyperlink button.

Right-click the cell and select Hyperlink... from the context menu.

Press CTRL+K.

3. In the invoked Edit Hyperlink dialog box, select whether you wish to insert a hyperlink to an existing file, a Web page, a
location within the current workbook, or an email address. Depending on your choice, provide all required options in the
right pane of the dialog box.



Delete a Hyperlink
1. To delete a hyperlink along with its text, do one of the following.

In the Editing group within the Home tab, click the Clear button, and select Clear Contents from the drop-down list.

Right-click the cell that contains the hyperlink and select Clear Contents from the invoked context menu.

2. To delete a hyperlink while maintaining its text with hyperlink formatting, in the Editing group within the Home tab, click
Clear, and select Clear Hyperlinks from the drop-down list.

3. To delete a hyperlink while maintaining its text with default formatting, do one of the following.

In the Editing group within the Home tab, click the Clear button, and select Remove Hyperlinks from the drop-
down list.



Right-click the cell that contains the hyperlink and select Remove Hyperlinks from the invoked context menu.



Shortcuts to Work with PicturesShortcuts to Work with Pictures
The Spreadsheet allows you to move, resize or rotate pictures quickly using keyboard shortcuts.

To work with pictures, use the default shortcuts listed in the table below.

S HOR TCU T D ES CR IPTION

DELETE Deletes the selected picture.

BACKSPACE Deletes the selected picture.

ARROW KEYS Move the selected picture in a worksheet.

ALT+LEFT ARROW KEY Rotates the selected picture counterclockwise by 15 degrees.

CTRL+ALT+LEFT ARROW KEY Rotates the selected picture counterclockwise by 1 degree.

ALT+RIGHT ARROW KEY Rotates the selected picture clockwise by 15 degrees.

CTRL+ALT+RIGHT ARROW KEY Rotates the selected picture clockwise by 1 degree.

SHIFT+RIGHT ARROW KEY Increases the width and height of the selected picture by 10%.

SHIFT+UP ARROW KEY Increases the width and height of the selected picture by 10%.

CTRL+SHIFT+RIGHT ARROW KEY Increases the width and height of the selected picture by 1%.

CTRL+SHIFT+UP ARROW KEY Increases the width and height of the selected picture by 1%.

SHIFT+LEFT ARROW KEY Decreases the width and height of the selected picture by 10%.

SHIFT+DOWN ARROW KEY Decreases the width and height of the selected picture by 10%.

CTRL+SHIFT+LEFT ARROW KEY Decreases the width and height of the selected picture by 1%.

CTRL+SHIFT+DOWN ARROW KEY Decreases the width and height of the selected picture by 1%.

CTRL+A Selects all pictures in a worksheet.

TAB Selects the next picture in a worksheet.

TAB+SHIFT Selects the previous picture in a worksheet.



Protect a WorkbookProtect a Workbook
Workbook protection prevents users from changing a workbook’s structure (by moving, deleting, adding, hiding or displaying a
hidden worksheet) or window position (by freezing or unfreezing panes).

You can protect a worksheet by using the following dialog:

To invoke this dialog, on the Review tab, in the Changes group, click Protect Workbook.

In a protected workbook, this button displays the "Unprotect Workbook" caption, which invokes a simple dialog that prompts
for a password or unlocks the workbook if an empty password was set.



Protect a WorksheetProtect a Worksheet
Worksheet protection locks the cells so that you can only perform a specific (restricted) set of actions.

By default, all cells in the worksheet are locked. When protection is applied to the worksheet, these cells become read-only.
However, you can specify certain actions which can be performed with the locked cells in a protected worksheet.

To protect a worksheet, use the following dialog:

To invoke this dialog, on the Review tab, in the Changes group, click the Protect Sheet button.

In a protected sheet, this button displays the "Unprotect Sheet" caption, which invokes a simple dialog that prompts for a
password or unlocks the sheet if an empty password was set.



Protect Worksheet RangesProtect Worksheet Ranges
In a protected worksheet, all locked cells are read-only. However, you can unlock certain ranges for users who provide the correct
password. You can also specify user accounts and groups who can edit specific ranges without a password.

To accomplish this task, invoke the Allow Users to Edit Ranges dialog. On the Review tab, in the Changes group, click Allow
Users to Edit Ranges.

The Allow Users to Edit Ranges dialog is shown in the picture below.

Click the New... button to display a dialog to specify the worksheet range and password, as illustrated below.

The Permissions... button allows you to specify Active Directory users and groups.



After all required permissions and password-protected ranges are specified, apply protection to the worksheet to activate
permissions as described in the Protect a Worksheet document.

When attempting to edit a cell content in a protected range for which a permission is specified, you will be prompted for a
password if your user account is not listed in the Permissions dialog for that range or if the account does not belong to the user
group listed in that dialog.



Encrypt a Workbook with the PasswordEncrypt a Workbook with the Password
You can encrypt your document with a password to prevent unauthorized people from opening or modifying your workbooks. To
do that, follow the steps below.

1. In the Info group on the File tab, click the Encrypt with Password button.

2. In the invoked dialog, specify the encryption password. Then, re-enter the password again and click OK.

3. Save the workbook to apply changes. The next time the workbook will be opened, a simple dialog that prompts for a
password will be invoked.

4. To remove the password encryption, in the Info group on the File tab, click the Encrypt with Password button. In the
invoked window, clear the contents of the Password box. Save the document to apply changes.



ShortcutsShortcuts
The Spreadsheet provides the capability to perform common commands quickly using keyboard shortcuts.

All supported shortcuts are divided into the following groups:

File Operations
Navigation inside Worksheets
Work with Selections
Copy, Paste and Edit the Cell Content
Cell Formatting
Work with Columns and Rows
Sort and Filter
Work with Formulas



File OperationsFile Operations
The key combinations used to perform file operations are listed in the table below.

S HOR TCU T D ES CR IPTION

CTRL+N Creates a blank workbook.

CTRL+O Invokes the Open dialog box to open a new file.

CTRL+S Saves changes in the current workbook.

F12 Invokes the Save as dialog box to save a workbook in the specified file format to a new location.

SHIFT+F11 Inserts a new worksheet in front of the existing worksheet within the current workbook.

CTRL+P Invokes the Print dialog box.



Navigation inside WorksheetsNavigation inside Worksheets
The key combinations that allow you to navigate through a worksheet are listed in the table below.

S HOR TCU T D ES CR IPTION

LEFT ARROW KEY Moves the active cell one cell to the left in a worksheet.

RIGHT ARROW KEY Moves the active cell one cell to the right in a worksheet.

UP ARROW KEY Moves the active cell one cell up in a worksheet.

DOWN ARROW KEY Moves the active cell one cell down in a worksheet.

ENTER Moves the active cell one cell down in a worksheet.

SHIFT+ENTER Moves the active cell one cell up in a worksheet.

TAB Moves the active cell one cell to the right in a worksheet.

SHIFT+TAB Moves the active cell one cell to the left in a worksheet.

CTRL+ARROW KEYS Move the active cell to the edge of the current data region in a worksheet.

HOME Moves the active cell to the beginning of a row in a worksheet.

CTRL+HOME Moves the active cell to the beginning of a worksheet.

CTRL+END Moves the active cell to the last cell in a worksheet (the last edited row of the rightmost edited column).

PAGE DOWN Moves the active cell one screen down in a worksheet.

PAGE UP Moves the active cell one screen up in a worksheet.

CTRL+F Invokes the Find and Replace dialog (with the Find tab activated).

CTRL+H Invokes the Find and Replace dialog (with the Replace tab activated).

CTRL+PAGE DOWN Moves to the next worksheet in the current workbook.

CTRL+PAGE UP Moves to the previous worksheet in the current workbook.



Work with SelectionsWork with Selections
The key combinations that allow you to work with selections are listed in the table below.

S HOR TCU T D ES CR IPTION

ENTER Moves the active cell one cell down in the selection.

SHIFT+ENTER Moves the active cell one cell up in the selection.

TAB Moves the active cell one cell to the right in the selection.

SHIFT+TAB Moves the active cell one cell to the left in the selection.

CTRL+PERIOD (.) Moves the active cell clockwise to the next corner of the selection.

CTRL+ALT+LEFT/RIGHT ARROW KEY Switches between multiple selected ranges of cells.

SHIFT+BACKSPACE Selects only the active cell in the selected cell range.

CTRL+SPACEBAR Selects an entire column in a worksheet.

SHIFT+SPACEBAR Selects an entire row in a worksheet.

CTRL+A Selects the entire worksheet or the data region to which the active cell belongs.

CTRL+SHIFT+SPACEBAR Selects the entire worksheet or the data region to which the active cell belongs.

SHIFT+ARROW KEYS Extend the selection by one cell.

CTRL+SHIFT+ARROW KEYS Extend the selection to the last nonblank cell in a row or column.

SHIFT+HOME Extends the selection to the first column.

CTRL+SHIFT+HOME Extends the selection to the beginning of the document.

CTRL+SHIFT+END Extends the selection to the previously used cell in a worksheet.

SHIFT+PAGE DOWN Extends the selection one screen down in a worksheet.

SHIFT+PAGE UP Extends the selection one screen up in a worksheet.



Copy, Paste and Edit the Cell ContentCopy, Paste and Edit the Cell Content
The key combinations used to work with cell content are listed below.

S HOR TCU T D ES CR IPTION

F2 Turns on the edit mode for the active cell and positions the cursor at the end of the cell content.

SHIFT+LEFT ARROW KEY In the cell edit mode, selects or deselects one character to the left.

SHIFT+RIGHT ARROW KEY In the cell edit mode, selects or deselects one character to the right.

CTRL+SHIFT+LEFT ARROW KEY In the cell edit mode, selects or deselects one word to the left.

CTRL+SHIFT+RIGHT ARROW KEY In the cell edit mode, selects or deselects one word to the right.

SHIFT+HOME In the cell edit mode, selects from the cursor current position to the beginning of the cell.

SHIFT+END In the cell edit mode, selects from the cursor current position to the end of the cell.

ALT+ENTER Starts a new line in the same cell.

CTRL+ENTER Completes a cell entry and stays in the same cell.

ENTER Completes a cell entry and selects the cell below.

SHIFT+ENTER Completes a cell entry and selects the cell above.

TAB Completes a cell entry and selects the cell to the right.

SHIFT+TAB Completes a cell entry and selects the cell to the left.

ESC Cancels an entry in a cell or Formula Bar.

BACKSPACE In the cell edit mode, deletes a character to the left of the cursor.

DELETE Removes the cell content without affecting the cell formatting.

CTRL+DELETE In the cell edit mode, deletes all characters from the cursor current position to the end of the line.

CTRL+Z or ALT+BACKSPACE Performs the Undo command to reverse the last action or to delete the last entry you typed.

CTRL+Y or ALT+SHIFT+BACKSPACE Repeats the last action.

CTRL+C or CTRL+INSERT Copies the selected cell in the clipboard.

CTRL+V or SHIFT+INSERT Inserts the contents of the clipboard in the specified cell and replaces any selection.

CTRL+ALT+V Invokes the Paste Special dialog box to specify the paste options.

CTRL+X or SHIFT+DELETE Cuts the selected cells.



CTRL+D Performs the Fill Down command to copy the contents of the topmost cell to the cells below.

CTRL+R Performs the Fill Right command to copy the contents of the leftmost cell to the cell to the right.

CTRL+K Invokes the Insert Hyperlink dialog box to create a new hyperlink.

SHIFT+F2 Adds a comment to the active cell.

S HOR TCU T D ES CR IPTION



Cell FormattingCell Formatting
The key combinations that allow you to apply formatting options quickly are listed in the following table.

S HOR TCU T D ES CR IPTION

CTRL+SHIFT+F Invokes the Format Cells dialog (with the Font tab activated).

CTRL+B or CTRL+2 Applies or removes bold formatting.

CTRL+I or CTRL+3 Applies or removes italic formatting.

CTRL+U or CTRL+4 Applies or removes underlining.

CTRL+5 Applies or removes strikethrough.

CTRL+SHIFT+7 Applies the outline border to the selected cell or cell range.

CTRL+SHIFT+MINUS (-) Removes the outline border from the selected cell or cell range.

CTRL+SHIFT+1 Applies the Number format with two decimal places.

CTRL+SHIFT+2 Applies the Time format.

CTRL+SHIFT+3 Applies the Date format.

CTRL+SHIFT+4 Applies the Currency format.

CTRL+SHIFT+5 Applies the Percentage format.

CTRL+SHIFT+6 Applies the Scientific number format.



Work with Columns and RowsWork with Columns and Rows
The key combinations that allow you to display, hide or group columns and rows in a worksheet are listed in the following table.

S HOR TCU T D ES CR IPTION

CTRL+9 Hides the selected rows.

CTRL+SHIFT+9 Displays the hidden rows.

CTRL+0 Hides the selected columns.

CTRL+SHIFT+0 Displays the hidden columns.

ALT+SHIFT+RIGHT ARROW KEY Groups the selected rows or columns.

ALT+SHIFT+LEFT ARROW KEY Unroups the selected rows or columns.



Sort and FilterSort and Filter
The key combinations that allow you to activate the filtering functionality for a worksheet range or table are listed in the table
below.

S HOR TCU T D ES CR IPTION

CTRL+SHIFT+L Toggles between enabling and disabling the AutoFilter functionality.

CTRL+ALT+L Reapplies a filter.



Work with FormulasWork with Formulas
The key combinations used to create formulas quickly are listed in the table below.

S HOR TCU T D ES CR IPTION

CTRL+SHIFT+ENTER Creates an array formula.

CTRL+ENTER Creates a shared formula.

ALT+PLUS (+) Inserts the SUM function in the active cell.

SHIFT+F3 Invokes the Insert Function dialog.

CTRL+ ` Toggles between displaying cell values and formulas on a worksheet.

CTRL+SHIFT+U Toggles between expanding and collapsing the Formula Bar.

F4 Cycles through all the various types of cell references, when a cell reference is selected or edited directly in the cell
or Formula Bar.

F9 Calculates the entire workbook.

SHIFT+F9 Calculates the active worksheet.

CTRL+ALT+F9 Calculates the entire workbook, regardless of whether its data has changed since the last calculation.

CTRL+ALT+SHIFT+F9 Calculates the entire workbook, regardless of whether its data has changed since the last calculation, and rebuilds
the dependencies.

CTRL+F3 Invokes the Name Manager dialog to define a name.

CTRL+SHIFT+F3 Creates names from row and column labels.



Toolbars and MenusToolbars and Menus
This section describes the capabilities provided by toolbars and menus.

 

Layout Customization

Open Toolbar Customization Window
Finish Toolbar Customization
Hide and Display Toolbars
Hide and Display Bar Commands
Rearrange Toolbars and Menus
Rearrange Bar Commands
Restore the Default Layout of Bar Commands

 

Navigation

Keyboard Navigation in Menus and Toolbars

 

Select Commands

Invoke Toolbar and Menu Commands



Open Toolbar Customization WindowOpen Toolbar Customization Window
Opening the Customization window activates the customization mode where you can:

Rearrange, hide and display bar commands.
Change display options of bar commands.
Hide bars, etc

To open the Customization window, do one of the following:

Right-click any bar or the empty space, and select Customize...

Click the dropdown button displayed at the right edge of any bar. Then select Add or Remove Buttons and then
Customize...

Double-click the empty space, not occupied by any bar.

The Customization window will be opened, containing three tabs:

The Toolbars tab allows you to hide specific bars and display hidden ones.

The Commands tab allows you to access bar commands and add them to bars.



The Options tab allows you to control options affecting the display of menus and bar commands.



Finish Toolbar CustomizationFinish Toolbar Customization
To finish customization, click the Customization window's Close button:



Hide and Display ToolbarsHide and Display Toolbars
Use the Quick Customization Menu
Right-click any bar, and check or uncheck the required toolbars.

Use the Customization Window
Open the Customization window. Under the Toolbars tab, check or uncheck the required toolbars.



Hide and Display Bar CommandsHide and Display Bar Commands
Temporarily Hide and Display Bar Commands
You can temporarily hide bar commands, and then restore hidden commands within a specific bar as follows:

1. Click the dropdown button displayed at the right edge of the bar:

2. Select Add or Remove Buttons, and then select the name of the clicked bar displayed at the top of the submenu. A check
list of bar commands displayed within the bar will be displayed:

3. To hide specific commands, uncheck corresponding items via mouse click. To display hidden commands, check the
corresponding items.

If a specific command is not available in a bar's command list, you can still access this command in customization mode, and add
this command to the bar. See below, to learn more.

Hide and Display Bar Commands in Customization Mode
First, open the Customization window.

To add a specific bar command to a bar, do the following:

1. Switch to the Commands tab page and locate the required command in the Commands list. Typically, commands are
grouped into categories, so you can first select a category to quickly locate the command.



2. Drag the bar command from the Commands list onto a bar or menu. Note that you can put bar commands into nested
menus. Menus will automatically open when you drag a bar command over their parent menu items.

To remove a bar command from a bar, drag the bar command away from the bar, and drop it when the mouse cursor changes its
image to 'x':

�� N o t eN o t e

You can cancel drag and drop while dragging an item by pressing ESC.



Rearrange Toolbars and MenusRearrange Toolbars and Menus
To move a bar docked to a form to a new position, drag it via its drag widget.

To move a floating bar, drag it by its caption.

To dock a bar to any of the four edges of the form, drag the bar to this edge.

To make a docked bar floating, drag the bar away from the form's edges.



Rearrange Bar CommandsRearrange Bar Commands
To rearrange bar commands, do the following:

1. Open the Customization window.

2. Drag a bar command to a new position:

To copy a bar command, press CTRL while dragging.

�� N o t eN o t e

You can move commands even when the customization window is closed. For this purpose, hold down the ALT key when
dragging a bar command.



Restore the Default Layout of Bar CommandsRestore the Default Layout of Bar Commands
You can customize the layout of bar commands within a bar by hiding and rearranging them. Subsequently, you can revert to the
default layout of bar commands. This topic describes two ways to do this.

Restore the Default Layout Using Quick Customization
1. Click the dropdown button displayed at the right edge of any bar:

2. Select Add or Remove Buttons, and then select the name of the clicked bar displayed at the top of the submenu. Then,
select Reset Toolbar.

Restore the Default Layout in Customization Mode
1. Open the Customization window.

2. Select a bar in the list whose layout is to be restored.

3. Click Reset.





Keyboard Navigation in Menus and ToolbarsKeyboard Navigation in Menus and Toolbars
Navigate between Toolbar and Menu Items
To switch focus to the main menu, press ALT or F10. The following shortcuts allow you to navigate through bars and bar items.
They are in effect when a bar/menu is focused.

ACTION D ES CR IPTION

CTRL+TAB Moves focus to another bar.

ARROW keys Moves focus to the next command in the corresponding direction.

TAB or SHIFT+TAB Moves focus to the next/previous command.

ESC Moves focus away from the currently focused bar.

Open and Close Menus
To open a sub-menu displayed within a bar, do one of the following:

Focus the sub-menu (using one of the methods described above) and press the ENTER or DOWN ARROW.
If the sub-menu's name contains an underscored letter, then:

if the bar is focused, press the underscored letter.
if the bar is not focused, hold the ALT key down and then press the underscored letter.

To open a menu displayed within another menu, do one of the following:

Focus the sub-menu and press the RIGHT ARROW.
If the menu's name contains an underscored letter, press the underscored letter.

To close the currently opened menu, press ESC.



Invoke Toolbar and Menu CommandsInvoke Toolbar and Menu Commands
To invoke a specific bar or menu command, do one of the following:

Click the command with the mouse
Focus the command and then press ENTER.
If a command is visible and it contains an underscored letter in its name, then:

if the bar or menu that contains this command is focused, then press this underscored letter.
if the bar or menu that contains this command is not focused, hold the ALT key down and then press this underscored
letter.

Press the shortcut assigned to the command.

If a command is displayed within a menu, its shortcut is displayed next to the command's name (if assigned).

Shortcuts for toolbar buttons are typically displayed in hints.



Tree ListTree List
This section describes the capabilities provided by a multi-column tree view, which displays hierarchical data, supports data
editing, sorting, summary calculation and many other features:

 

Data Editing

Edit Cells in a Tree List

 

Data Presentation

Sort Tree List Nodes

 

Data Analysis

Filter TreeList Data
Show Summaries (Totals) in a Tree List
Apply Cell Conditional Formatting

 

Layout Customization

Expand and Collapse Nodes in a Tree List
Hide and Display Tree List Columns
Reorder Tree List Columns
Resize Tree List Columns

 

Selection and Navigation

Navigation in a Tree List
Select Tree List Nodes



Edit Cells in a Tree ListEdit Cells in a Tree List
Activate Cell Editor
Do one of the following:

Click a cell.
Focus a cell (for instance, via the keyboard), and press ENTER or F2.
Focus a cell and press any alpha-numeric key. The editor will be invoked and its contents will be replaced with the pressed
character.

Select and Deselect Cell Text
Press F2 or CTRL+A.

Close Cell Editor and Accept Changes Made
Do one of the following:

Press ENTER.
Click any other grid cell.
Focus any other control.

Discard Changes
To discard changes made in a cell, press ESC.

To discard changes made in all cells within a node, press ESC twice.

Open Cell Editor's Dropdown
Do one of the following:

Activate a cell editor and press ALT+DOWN ARROW or F4.

Click the editor's dropdown button:

Close Cell Editor's Dropdown
For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with the keyboard
and pressing ENTER.

Change Values
Change Date/Time Values

You can edit these cell values without opening the dropdown calendar. Position the caret at the portion of a date/time value that
needs to be changed. To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.



Change Numeric Values

To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Values of Cells That Provide Dropdown Items

To select the previous value, press CTRL+UP ARROW. To select the next value, press CTRL+DOWN ARROW.

Note: this feature is not applicable to all editors.

Edit Images

To copy, cut, paste, load and save images in image editors, right click the image and select the required command via the context
menu:



Sort Tree List NodesSort Tree List Nodes
To sort nodes by a column's values and replace existing sort conditions that are applied to the current or other columns, click the
target column's header, until an Up or Down Arrow icon is displayed within the header. The Up and Down Arrows indicate
ascending and descending sort orders respectively.

To sort nodes by a column's values while preserving existing sort conditions, do one of the following:

Click a column header while holding the SHIFT key down, until an UP or Down Arrow icon is displayed within the header.

Right-click a column header and select Sort Ascending or Sort Descending from the context menu that will appear.

To remove sorting by a column, click a column header while holding the CTRL key down.



Filter TreeList DataFilter TreeList Data
Invoking the Filter Dropdown List
Hover over the column header and click the filter button  that appears.

Creating a Simple Filter Condition
To select records that contain a specific value in a specific column, do the following.

1. Invoke the filter dropdown list containing available filter values.

By default, if filtering is applied, the filter dropdown will only display the values which match the current filter criteria. If the
SHIFT key is pressed while opening the filter dropdown, all values will be listed (not only those that match the current filter
criteria).

2. Select the required filter value in the filter dropdown list.

The filter dropdown list will be immediately closed, and the control will display the records that contain the specified value
in the specified column.

If the filter dropdown list provides check boxes to the left of filter values, multiple values can be selected (checked)
simultaneously.

In this mode, click the OK button to close the filter dropdown list and apply the filter.

For date-time columns, the filter dropdown list is displayed as a calendar. To apply the filter, select the desired date.



The control will immediately display records which contain the selected date in the appropriate column. To hide the filter
dropdown list, click the close button .

Using the Advanced Filter Editor Dialog
To invoke an advanced Filter Editor dialog, do one of the following.

Right-click any column's header and select Filter Editor.

If the Filter Panel at the bottom of the TreeList control is visible, click the Edit Filter button.

To learn how to work with the Filter Editor, refer to Filter Data via the Filter Editor.

Using the Auto Filter Row
If the Auto Filter Row is displayed at the top of the TreeList control, you can type text within this row. A filter condition is
automatically created based on the entered value, and the filter is applied to the focused column.



Clearing the Filter
To clear the filter applied to a specific column, do one of the following.

Invoke the filter dropdown list (see above), and then choose between clicking (All) or selecting (Select All) or choosing
(Show All,) depending on the dropdown list type.

Right-click the column header and select the Clear Filter menu item.

To clear all filter criteria, click the Close Filter Button within the Filter Panel.

Disabling/Enabling the Filter
Click the Enable Filter Button within the Filter Panel.



Show Summaries (Totals) in a Tree ListShow Summaries (Totals) in a Tree List
To change the type of summary for a specific column or apply a summary, do the following:

1. Right-click a region within a group footer or grid footer under a specific column. A context menu displaying a list of
supported summary types will be displayed.

2. Select the required option from the context menu.

To calculate summaries against all nodes, ensure that the All Nodes menu check item is checked. To calculate summaries against
root nodes only, uncheck the All Nodes check item.



Apply Cell Conditional FormattingApply Cell Conditional Formatting
You can highlight certain column cells that meet a specific condition using the Conditional Formatting menu. To invoke this
menu, right-click the column to which a formatting rule should be applied and select Conditional Formatting.

Available format rules are displayed when expanding the Conditional Formatting menu. Different options are supported for
different columns (depending on the type of data a clicked column displays).

Highlighting Cells that Meet a Specific Condition
Choose the Highlight Cell Rules menu item.

Select the condition type. You can use one of the predefined conditions (the Greater Than..., Less Than.., Between... and
Equal To... menu items), provide a custom condition (the Custom Condition.. item) or format cells that contain the
specified text (Text that Contains...) or refer to a certain date interval(s) (A Date Occurring...).

Based on the selected condition type, an appropriate dialog window is invoked. You need to either enter a constant to be
compared with the column's values, or select desired check boxes related to dates, or construct a custom condition in the
dedicated editor. After that, choose a format style in the dropdown list, and click the OK button. To apply formatting to an
entire row instead of a single cell, select the corresponding check box.



Highlighting Top or Bottom Cell Values
Choose the Top/Bottom Rules menu item.

Select the rule type. You can highlight cells that contain the highest or lowest values (the Top 10%..., Bottom 10%..., Top
10 Items... and Bottom 10 Items... menu items), and values that are above or below the column's average (Above
Average and Below Average).

According to the selected rule type, an appropriate dialog window is invoked. Enter a cutoff value (where required), choose a
format style in the dropdown list, and click the OK button. To apply formatting to an entire row instead of a single cell, select
the corresponding check box.

Highlighting Unique or Duplicate Cell Values
Choose the Unique/Duplicate Rules menu item.

Select the rule type.

In the invoked dialog window, choose a format style in the dropdown list, and click the OK button. To apply formatting to an
entire row instead of a single cell, select the corresponding check box.



Highlighting Cells Using Data Bars
A data bar fills a cell according to the ratio of the cell's value to the highest and smallest column values. A longer bar corresponds
to a higher value, and a shorter bar corresponds to a lower value.

To apply a data bar format, do the following:

Choose the Data Bars menu item.

Select the bar style format. Solid bars and bars with gradient fills are available in various colors.

Applying Color Scales
This format shows data distribution and variation using color scales. A cell is filled with the background color that is calculated
according to the ratio of the cell's value to the highest and smallest column values. A two-color scale specifies two colors, which
represent the minimum and maximum column values. Cell values residing between the minimum and maximum values are
painted using a shade of these colors. A three-color scale additionally defines a color for the middle value and so, uses a gradation
of three colors.

Choose the Color Scales menu item.

Select one of the predefined two or three-color scales.

Highlighting Cells Using Predefined Icons
Icon sets allow you to classify column values into several ranges separated by threshold values, and display a specific icon in a
column cell according to the range to which this cell value belongs. In the Positive/Negative group, the available icon sets divide
column values into three ranges: positive values, negative values and values equal to zero.

Other icon sets divide column values into three, four or five ranges, displaying a specific icon for each range. If an icon set
contains three icons, the ranges are as follows: [0%-33%), [33%-67%) and [67%-100%], where 0% corresponds to the smallest



column value and 100% corresponds to the largest column value. The icon sets with four icons classify column values into four
ranges: [0%-25%), [25%-50%), [50%-75%) and [75%-100%]. For the icon sets that contain five icons, the target ranges are: [0%-
20%), [20%-40%), [40%-60%), [60%-80%) and [80%-100%].

Choose the Icon Sets menu item.

Select one of the predefined icon sets.

Deleting Rules
If you have already applied one or more rules to columns, the additional Clear Rules item is displayed at the second level of the
Conditional Formatting menu.

You can do one of the following.

To delete conditional formatting rules from the target column, click the Clear Rules from This Column menu item. If the
column has no rules applied to it, this item is not shown.

or

To delete formatting rules from all columns, click the Clear Rules from All Columns menu item .



Expand and Collapse Nodes in a Tree ListExpand and Collapse Nodes in a Tree List
Expand and Collapse Nodes
Do one of the following:

Focus the node and then press PLUS on the keyboard to expand the node, and MINUS to collapse the node:

Click the node's expand button.

Double-click the indicator cell corresponding to the node.

Expand Nodes Recursively
To expand a node and all its child nodes that have nested nodes, focus the node and press MULTIPLY on the keyboard.



Hide and Display Tree List ColumnsHide and Display Tree List Columns
Hide Columns
Do one of the following:

Click a column header and drag it outside the header panel, until the cursor changes its image to the big 'X'. Then drop the
header.

Drag and drop a column header onto the Customization Form if it's open (see below).

Display Hidden Columns
1. Open the Customization Form by right-clicking a column header and selecting Column Chooser.

The Customization Form will be displayed listing hidden columns (if any).

2. Drag the required column from the Customization Form onto the column header panel and drop it at the required position.





Reorder Tree List ColumnsReorder Tree List Columns
To reorder columns, drag and drop a column header to a new position.



Resize Tree List ColumnsResize Tree List Columns
To resize columns, drag the right edge of the target column header:

To change a column's width so that it displays its contents compactly in their entirety, do one of the following:

Double-click the right edge of the column header.

Right-click the column's header and select Best Fit.

To change the widths of all columns so that they display their contents in the best possible way, right-click the header of any
column and select Best Fit (all columns).



Navigation in a Tree ListNavigation in a Tree List
ACTION D ES CR IPTION

Clicking a data cell Moves focus to the clicked cell.

ARROW keys Moves focus to the next cell in the corresponding direction.

HOME Moves focus to the first cell within the focused node.

END Moves focus to the last cell within the focused node.

PAGE UP Moves focus one page up.

PAGE DOWN Moves focus one page down.

CTRL+HOME Moves focus to the first cell within the first node.

CTRL+END Moves focus to the last cell within the last node.

TAB or CTRL+TAB Moves focus away from the TreeList to the next control, in tab order.

SHIFT+TAB Moves focus away from the TreeList to the previous control, in tab order.

CTRL+RIGHT ARROW Expands the focused node.

CTRL+LEFT ARROW Collapses the focused node.

You can also click node indicator cells to move focus to the corresponding row while preserving column focus.



Select Tree List NodesSelect Tree List Nodes
Change Focused Node
To focus a node and clear the existing selection, do one of the following.

Click the node's indicator cell or any of its data cells.

Select the node using the ARROW keys.

Select Multiple Nodes
To select a node while preserving the current selection, click the node's indicator cell or any of its data cells, while holding the
CTRL key down.

To toggle the focused node's selected state, do one of the following.

Press CTRL+SPACE.
Click the node while holding the CTRL key down.

To move focus between nodes while preserving the current selection, use CTRL+ARROW keyboard shortcut.



Vertical GridVertical Grid
This section describes the capabilities provided by Vertical Grids (Property Grids).

 

Data Editing

Edit Cells in Vertical Grids

 

Layout Customization

Expand and Collapse Rows in Vertical Grids
Resize Rows and Columns in Vertical Grids

 

Navigation

Navigation in Vertical Grids



Edit Cells in Vertical GridsEdit Cells in Vertical Grids
Activate Cell Editor
Do one of the following:

Click a cell.
Focus a cell (for instance, via the keyboard), and press ENTER or F2.
Focus a cell and press any alpha-numeric key. The editor will be invoked and its contents will be replaced with the pressed
character.

Select and Deselect Cell Text
Press F2 or CTRL+A.

Close Cell Editor and Accept Changes Made
Do one of the following:

Press ENTER.
Click any other grid cell.
Focus any other control.

Discard Changes
To discard changes made in a cell, press ESC.

Open Cell Editor's Dropdown
Do one of the following:

Activate a cell editor and press ALT+DOWN ARROW or F4.

Click the editor's dropdown button:

Close Cell Editor's Dropdown
For all editors providing a dropdown, you can close the dropdown by pressing ALT+DOWN ARROW.

If the calculator is displayed in the dropdown, it can be closed via CTRL+ENTER.

Dropdowns displaying lists of items can be closed by clicking an item with the mouse, or by selecting an item with the keyboard
and pressing ENTER.

Change Values
Change D ate/T ime ValuesChange D ate/T ime Values

You can edit these cell values without opening the dropdown calendar. Position the caret at the portion of a date/time value that
needs to be changed. To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Numeric ValuesChange Numeric Values



To increment the value, press CTRL+UP ARROW. To decrement the value, press CTRL+DOWN ARROW.

Change Values of Cells That P rovide D ropdown I temsChange Values of Cells That P rovide D ropdown I tems

To select the previous value, press CTRL+UP ARROW. To select the next value, press CTRL+DOWN ARROW.

�� N o t eN o t e

This feature is not applicable to all editors.

Edit ImagesEdit Images

To copy, cut, paste, load and save images in image editors, right click the image and select the required command via the context
menu:



Expand and Collapse Rows in Vertical GridsExpand and Collapse Rows in Vertical Grids
Expand and Collapse Data Rows
Do one of the following:

Focus the row and then press PLUS on the keyboard to expand the row, and MINUS to collapse the row:

Double-click the row's header.

Click the row's expand button.

Expand and Collapse Category Rows
Do one of the following:

Focus the row and press PLUS on the keyboard to expand the row, and MINUS to collapse the row.

Double-click the row.

Click the row's expand button.

Expand Rows Recursively
To expand a row and all its child rows that have nested rows, focus the row and press MULTIPLY on the keyboard.



Resize Rows and Columns in Vertical GridsResize Rows and Columns in Vertical Grids
Resize Rows
To resize a row, drag the row header's bottom edge vertically.

Resize Columns
To resize data columns, drag a separator between data columns horizontally.

To resize the header column, do one of the following.

Drag the header column's right edge.

Press CTRL+LEFT ARROW to decrease the header column's width. Press CTRL+RIGHT ARROW to increase the header
column's width.
To resize headers to the minimum width while making sure all content is visible, double-click a header's right edge.



Navigation in Vertical GridsNavigation in Vertical Grids
ACTION D ES CR IPTION

Clicking a data cell Moves focus to the clicked cell.

Clicking a row header Moves focus to the corresponding row while preserving column focus.

ARROW keys Moves focus to the next cell in the corresponding direction.

TAB, SHIFT+TAB Moves focus to the next/previous cell.

HOME, END Moves focus to the first/last cell within the current row.

PAGE UP, PAGE DOWN Moves focus one page up or down.

CTRL+HOME Moves focus to the first cell of the grid control.

CTRL+END Moves focus to the last cell of the grid control.

CTRL+TAB Moves focus away from the control to the next control, in tab order.
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